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Using this Manual
This manual is for use with the Eos Ti, Gio, Gio @5, Ion Xe, Ion Xe 20, and Element 2 control
systems.

In order to be specific about where features and commands are found, the following naming and
text conventions will be used:

• Browser menus and commands are indicated in bold text. For example, in the File menu,
click Open.

• Alphanumeric keyboard buttons are indicated in all CAPS. For example, ALT or CTRL.
• Face panel buttons are indicated in bold [brackets]. For example, [Live] or [Enter].
• Optional keys which don't have to be pressed are indicated in <angle brackets>. For

example, <Cue> or <0>.
• Keys which are intended to be pressed or held simultaneously are indicated with the

“and” symbol. For example, [Load] & [Timing Disable].
• Softkeys, direct selects, and other selectable buttons are indicated in bold {braces}. For

example, {Address}.
• Links to other manual topics are indicated in underlined blue. For example, Introduction

(on the previous page). Click on the reference to jump to that section of the manual.

Note: Notes indicate useful information supplemental to the main text.

Example: Examples indicate the syntax or actions necessary to achieve the desired
result.

CAUTION: Cautions indicate situations where there may be undefined or
unwanted consequences of an action, potential for data loss, or an equipment
problem.

WARNING: Warnings indicate situations where damage may occur, people
may be harmed, or there are serious or dangerous consequences of an
action.

Please email comments about this manual to TechComm@etcconnect.com.

Register Your Console
Registering your console with ETC ensures that you will be notified of software and library
updates, as well as any product advisories.

Registering your console requires a MyETC account. Log in or register at
etcconnect.com/MyETC/.

Once signed in, you can manage your registered products at etcconnect.com/MyETC/Account-
Management/My-Registered-Products.aspx.

Online Eos Family User Forums
You are encouraged to visit and participate in the ETC Eos Family User Forum, accessible from
the ETC website, etcconnect.com. This gives you access to an online community of Eos Family
users where you can read about other users’ experiences, suggestions, and questions regarding
the product as well as submit your own.

mailto:TechComm@etcconnect.com
https://www.etcconnect.com/MyETC/
https://www.etcconnect.com/MyETC/Account-Management/My-Registered-Products.aspx
https://www.etcconnect.com/MyETC/Account-Management/My-Registered-Products.aspx
https://www.etcconnect.com/
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To register for the ETC Family User Forum:

1. Go to ETC’s community website, community.etcconnect.com.
2. You may register for the forum by clicking the “Join” link in the upper right corner of the

page.
3. Follow the registration instructions provided by the community page.

Help from ETC Technical Services
If you are having difficulties and your problem is not addressed by this document, try the ETC
support website at support.etcconnect.com or the main ETC website at etcconnect.com. If none
of these resources are sufficient, contact ETC Technical Services directly at one of the offices
identified below. Emergency service is available from all ETC offices outside of normal business
hours.

When calling for help, take these steps first:

• Prepare a detailed description of the problem
• Go near the equipment for troubleshooting
• Find your notification number if you have called in previously

Please have the following information handy:

• Product model and serial number (located on the product label)
• DMX or network control source used for system-wide control
• System components (architectural and/or power control, fixtures, control stations, etc)

ETC, Inc.
Americas

Technical Services Department
3031 Pleasant View Road
Middleton, WI 53562
800-775-4382 (USA, toll-free)
+1-608 831-4116
service@etcconnect.com

ETC GmbH
Germany, Austria, Switzerland,
Eastern Europe, and Russia

Technical Services Department
Ohmstrasse 3
83607 Holzkirchen, Germany
+49 (80 24) 47 00-0
techserv-germany@etcconnect.com

ETC Austin
High End Systems Products

Technical Services Department
2105 Gracy Farms Lane
Austin, TX 78758 USA
800-890-8989 (USA, toll-free)
+1-512 836-2242
hesservice@etcconnect.com

ETC France
France

Zone Urbaparc -
Bâtiment E
6 Boulevard de la Libération
Saint-Denis, 93200
+33 1 4243 3535
techservfrance@etcconnect.com

ETC Ltd
Europe, Middle East, and Africa

Technical Services Department
26-28 Victoria Industrial Estate
Victoria Road,
London W3 6UU England
+44 (0)20 8896 1000
techservltd@etcconnect.com

ETC Asia
Asia

Technical Services Department
Room 1801, 18/F
Tower 1, Phase 1 Enterprise Square
9 Sheung Yuet Road
Kowloon Bay, Kowloon, Hong Kong
+852 2799 1220
techserv-asia@etcconnect.com

https://community.etcconnect.com/
https://support.etcconnect.com/
http://www.etcconnect.com/
mailto:service@etcconnect.com
mailto:techserv-germany@etcconnect.com
mailto:HESService@etcconnect.com
mailto:techservfrance@etcconnect.com
mailto:techservltd@etcconnect.com
mailto:techserv-asia@etcconnect.com
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Other Reference Materials

Help System
A key help system is contained within your system. To access help, press and hold [Help] and
press any key to see:

• the name of the key
• a description of what the key enables you to do
• syntax examples for using the key (if applicable)
• links to topics in the manual

Note: Key help is included on most buttons on your Eos Family console. This includes
most softkeys and touchbuttons as well as the hard keys on the keypad.

Show Control Resources
The chapter on show control in this manual is intended to provide basic information specific to
the Eos Family show control system. You may want to explore additional resources to learn more
about show control.

The following resources are recommended:

• John Huntington, Show Networks and Control Systems, (Brooklyn, NY:Zircon Designs
Press, 2012)

• ETC Support Articles, available at support.etcconnect.com/ETC.

Important Concepts
Before using your console, you should read and familiarize yourself with the concepts defined
below. These concepts are important for understanding both how your console functions, as well
as how you will interact with your system.

Jump to a concept using the list below:

• Channel (below)
• Address (on the facing page)
• Syntax Structure (on the facing page)
• Parameters and Parameter Categories (on page 6)
• Record Targets (on page 6)
• Cues (on page 6)
• Tracking vs. Cue Only (on page 6)
• Move Instruction (on page 8)
• Manual Data (on page 8)
• Move Fade (on page 8)
• Cue List Ownership (on page 8)
• Block vs. Assert (on page 9)
• Live and Blind (on page 9)
• HTP vs. LTP (on page 9)

Channel
A channel is a single numerical name that is used by your console to control a dimmer, a group
of dimmers, a dimmer and a device, or a complete automated fixture.

https://support.etcconnect.com/ETC
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Fixtures
A fixture is defined as a group of related addresses that together control a device. An example
of a fixture would be an ETC Revolution. This automated fixture contains 31 parameters that
together allow you to perform various functions such as pan and tilt. Each of these attributes is
addressed by a different output.

Eos family consoles treat fixtures and channels as one and the same, assigning each fixture a
single channel number. Individual parameters are then associated with that channel as
additional lines of channel information.

When you select a channel number, all of the controllable properties or parameters of that
channel are available through the keypad, level wheel, encoders, or Moving Light (ML) Controls
(Tab5).

Note: Multicell fixtures are handled differently. They are fixtures made up of multiple
channels and addresses. See Patching Multicell Fixtures (on page 135) and Multicell
Fixtures (on page 208) for more information.

Address
Addresses are numerical identifiers set on the actual dimmers, automated fixtures, or other
devices you want to control. To connect addresses to channels, you will need to use the Patch
function. For more information, About Patch (on page 126).

Note: You can patch more than one address to a single channel, but you cannot
patch multiple channels to a single address.

Syntax Structure
Most instructions can be entered into your console through the command line. The command
line expects instructions to be entered in a specific structure, or syntax.

Generally speaking, the order of syntax can be described as:

1. What are you trying to affect? (Channel, group, etc)
2. What do you want it to do? (Change intensity, focus, pan/tilt, etc)
3. What value do you want? (Intensity at full, Iris at 50, etc)

Naturally other commands will be used in the course of programming your show, but most other
functions are modifiers of these three basic steps: modifying the channel(s) you are working
with, determining what parameters of those channels you are impacting, and what value you
want them to assume. When working with Record Targets (on the next page) , the syntax is
similar.

Note: Not all actions must be entered from the command line, although many will
result in a command line instruction. Other actions bypass the command line entirely.

Enter
Since the command line can receive multiple edits and instructions at once, it is necessary to let
your console know when you have completed your instruction in the command line. This is done
with the [Enter] key.

There are some commands which are self-terminating, and therefore do not require [Enter] to
be pressed. Some (but not all) of these commands are:
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• Out
• +%
• -%
• Level
• Actions from the direct selects

Parameters and Parameter Categories
Eos family consoles divide fixture parameters into four major parameter categories: Intensity,
Focus, Color, and Beam.

These are the parameters in each category:

• Intensity - Intensity
• Focus - Pan and Tilt
• Color - All color parameters (such as color wheel, CMY, scrollers, and so on).
• Beam - Any parameter not covered in the other categories.

Note: Throughout this manual, non-intensity parameters will be referred to as "NPs."

Record Targets
A record target is any data location that you can store data using a [Record] command.
Examples of record targets are cues, palettes, and macros.

Note: Throughout this manual, the word "target" is used to refer to any container of
data.

Cues
A cue is a record target comprised of channels with associated parameter data, discrete
(channel/parameter level) timing, cue timing, and cue attributes (such as preheat, follow or
hang instructions).

Tracking vs. Cue Only
Eos family consoles are, by default, tracking consoles. This means two things. First, tracking
relates to how cue lists are created. Once data is in a cue list, it will remain a part of that cue
list, at its original setting, until a new instruction is provided or until it is removed from the cue
list using filters or null commands.

Secondly, tracking relates to how changes to cue data are handled. Unless otherwise instructed
by a Cue Only command, changes to a parameter in a cue will track forward through the cue list
until a move instruction (or block command) is encountered.

It is possible to change the default setting of your console to “Cue Only” in About Setup (on
page 168). This prevents changes from tracking forward into subsequent cues, unless overridden
with a track instruction. See Tracking (on page 177) for more information.

Eos family consoles also have a [Cue Only/Track] button that allows you to record or update a
cue as an exception to the default setting. Therefore, if the console is set to Tracking, the button
acts as Cue Only. If console is set to Cue Only, it behaves as a Track button.
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Tracking Mode
When you create a new cue, any unchanged channel parameter data from the previous cue is
tracked into the new specified cue. Any changes in this new cue will also track forward into
subsequent cues until a move instruction or a block flag is encountered. In the example below,
the gray boxes indicate tracked values and the white boxes indicate move instructions.

When in tracking mode, edits made to an existing cue will track forward through the cue list
until a move instruction is encountered. Changes made to cue 3 will affect the cue list as shown
below in bold.

Cue Only Mode
The [Cue Only/Track] key is an exception to this behavior. [Cue Only/Track] button combined
with [Record] or [Update] modifies standard tracking behavior. When you record a cue in the
middle of the cue list, using the [Q Only] button will prohibit new information from tracking into
the subsequent cue, and will protect the previously tracking levels by adding a move instruction
into the next cue for those levels. When you rerecord or update a cue, the modifications will not
track forward. Using [Record] <Cue> [3] [Q Only] [Enter] would affect the cue list as shown
below.

Using Trace
{Trace} works just like Tracking mode, except it allows changes to be tracked backwards though
the cue list, until it sees a move instruction. In the example below, the channel levels have been
adjusted while cue 3 is live on stage. Using Trace will take those adjusted levels and update
them into the cues as follows: channel 1's new level is recorded into cue 2, channel 2's level is
recorded into cue 1, and channel 3's level is recorded into cue 3. This is because the move
instruction for those channels are contained in those cues. In the case of channels 1 and 2, their
new level will track into cue 3.Using [Record] <Cue> [3] {Trace} [Enter] would affect the cue
list as shown below in bold.
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To force that channel’s new value to go backward in the cue list, {Trace} {Trace} can be used.

For information on using [Update] and {Trace}, See Using Trace (on page 283).

Move Instruction
A move instruction is any change to a parameter from its previous stored value, such as changes
to a channel’s intensity, pan or tilt, color mixing, etc.

Manual Data
Manual data is any value set for a channel via the command line. Manual data will remain at its
value until a move instruction is provided for it.

Move Fade
Move fade is a lighting control philosophy which determines how cues are played back on Eos
family consoles.

In a move fade system, parameters do not change from their current setting until they are
provided a move instruction in a cue or are given a new instruction manually.

Move fade systems allow for fade-within-fade behavior. Fade-within-fade means that you can
start a long fade in one cue, and the following cues will not affect the long fade as long as none
of the following cues contain move instructions for the channels in the long fade cue. A blocked
value is considered a move instruction. Additionally, manual changes to channels will not be
removed by pressing [Go] unless the incoming cue contains a move instruction for those
channels.

Example:
In cue 1, channel 1 has been given an intensity value of 50%. This value does
not change until cue 20, where channel 1 is moved to 100%. Therefore,
channel 1 has a tracked intensity value of 50% in cues 2-19. If the user applies
a manual intensity value of 25% while sitting in cue 5 (for example), that
channel will stay at 25% until Cue 20 is recalled - because 20 is the next cue in
which channel 1 has a move instruction.

Cue List Ownership

Note: Multiple cue lists are not available on Element 2 and Element Classic.

Most Eos family consoles are capable of running multiple cue lists. Cue list ownership is
determined by the cue from which a channel is currently receiving its value. In Live, a parameter
is considered to be “owned” by a cue list when it is receiving its current value from that cue list.

When alternating between cue lists in sequential playback, an active cue list does not
necessarily own a channel unless that list has provided the last move instruction for that
channel. For example, assume a channel is owned by cue list 1 and is at a tracked value. If a cue
from another cue list is executed and provides a move instruction for the channel in the new
cue, the channel is now owned by the second cue list. It will not return to cue list 1 until that cue
list provides a move instruction for the channel.

Assert may be used to override this default behavior, allowing a cue list’s control over a channel
to resume, even when the channel’s data is tracked.
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This rule is not followed when executing an out-of-sequence cue. An out-of-sequence cue is any
cue that is recalled via [Go To Cue], a Link instruction, or manually changing the pending cue.
In general applications, the entire contents of the cue (both moves and tracks) will be asserted
on an out-of-sequence cue.

Block vs. Assert

Note: Assert is not available on Element 2 and Element Classic.

Blocked channel data is an editing convention only, and it prohibits tracked instructions from
modifying the associated data. Blocked data has no impact on playback; the channels will
continue to play back as though they were tracks. Assert is used to force playback of a tracked/
blocked value.

Live and Blind
Live and Blind are methods to view and edit data in your show files. When you press the [Live]
key, the screen will show you the live display. When you press [Blind], you will see the blind
display. In either case, you may use the [Format] key to alter how the data is displayed (see
Using [Format] (on page 71)).

When in Live, the data displayed represeabout-snts the data being sent from the console at that
moment. In other words, the parameter data that is “live” on stage. When you edit data in live,
those changes will become active and visible on stage as soon as the command line is
terminated.

When in Blind, the data displayed represents data from the record target you choose to view
(cues, presets, palettes, and so on). When you edit data in Blind, changes will not automatically
appear on stage, since the data you are modifying is not live. This is true even if the record
target you are modifying is active on stage. It is possible to play a cue in Live, then switch to
Blind and edit that cue in blind without affecting levels on stage. Edits in Blind do not require a
[Record] command to be stored. They are considered stored when the command line is
terminated. Any display that is not the Live display is considered Blind, and the Blind LED will be
illuminated. For example, if you open patch, the blue LED on [Blind] will be lit to show that you
are in a Blind display.

HTP vs. LTP
HTP (Highest-Takes-Precedence) and LTP (Latest-Takes-Precedence) are terms used to define
the output of a channel parameter that is receiving data from multiple sources. Cue lists can
operate as HTP or LTP for intensity parameters only. Non-intensity parameters (NPs) are always
LTP. Submasters can operate as HTP or LTP for intensity. The default is HTP. The default cue list
setting for intensity is LTP.

HTP
HTP is only applicable to the intensity of a channel. HTP channels will output the level that is the
highest of all inputs. HTP channels are also referred to as “pile-on”, because as control inputs
are added (for example - you may bring up cues and multiple submasters that all have the same
channel recorded at various levels), the system calculates which input has the highest level for
that channel and outputs that level for the channel. As control inputs are removed (you pull
some of the submasters down to zero), the console will adjust the channel level, if required, to
the highest remaining level.
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LTP
LTP is applicable to any parameter of any channel. LTP output is based on the most recent move
instruction issued to the channel parameter. Any new values sent to the channel will supersede
any previous values, regardless of the level supplied.

Eos family consoles determine the LTP value for a channel, which is overridden by any HTP input
values that are higher than the LTP instruction. This is then finally modified by manual control.
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Eos Titanium (Ti) Overview
This page provides an overview of the physical layout, components, and capacities of the Eos Ti
console.

Ti Layout

Ti Components

Power Button
The power button on the front of the console is used to power up or power down. A separate
hard power switch, located on the rear panel, can be used to disconnect power from the
console’s internal components.

CAUTION: It is recommended that you safely power down the console via
Displays > Power Off Device before disconnecting power from the console.

WARNING: Before servicing your console, you must switch off the power
on the rear panel and disconnect the power cord completely.

Fuse

A fuse is included for additional protection. Fuse ratings can be found on the rear panel of your
console.

USB Ports
One USB port is provided on the front of the console to connect any USB storage device.
Additional USB ports on the rear panel (and in the keyboard tray, when present) of the console
connect peripherals such as an alphanumeric keyboard, pointing device, or touchscreen control
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for external monitors.

CAUTION: The USB ports cannot be used for charging devices.

Internal Touchscreens
Eos Ti is designed with three internal touchscreen displays.

• The two main touchscreens may be used to display and control show data. They may also
be used as a variety of other virtual controls and displays.

• The encoder touchscreen offers additional touch-based controls for encoder parameters.

The touchscreen angle can be adjusted by pushing the button in the center top of the display
and moving the panel up or down.

Touchscreen brightness can be controlled via the Brightness Settings (on page 182)

External Monitors
Eos Ti and Gio support up to three external Windows 7-compatible Display Port or DVI monitors.

Gio @ 5, Ion Xe, and Element 2 support up to two external Windows 7 compatible Display Port
monitors.

Display Port can use an active adapter to VGA, DVI, or HDMI. DVI-I can be converted to VGA
with a passive adapter.

Note: Output to 4K resolution monitors may affect console performance. ETC
recommends an external monitor resolution of 1024 or lower.

For monitor configuration, see Monitor Arrangement (on page 516).

Hardkeys

Backlit hardkeys are provided on the face panel. The brightness level for those keys can be
adjusted in the Brightness Settings (on page 182).

When your console has been idle for 10 minutes, the backlights will fade down by 10%. Any key
press on the face panel keypad or an external keyboard, a move of the mouse, or an interaction
with a touchscreen will return the keys to their set brightness level.

The hardkeys are divided into several sections based on their functionality.
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Keypad (1)

The numeric keypad allows you to type numbers for channel or target selection via the
command line, along with modifier keys to alter your selection.

Level Controls (2)

The level controls provide options for altering the intensity levels of channels, along with a
number of other non-intensity parameters / targets.

Targets (3)

The target controls provide options for altering a variety of record targets, as well as shortcuts to
various Blind displays.

Display & Navigation (4)

The display and navigation keys provide quick access to common displays, formatting, paging,
and navigation within displays.

Encoder Categories (5)

The encoder category buttons allow expanded control of a variety of fixture parameters, along
with additional softkey options where applicable.

Fader Control Buttons (6)

The fader control buttons provide additional options for easy local control of fader behavior.

Additional Targets & Functions

The remaining hardkeys provide options for a variety of common console functions and shortcuts
to various Blind displays.

Level Wheel
The level wheel adjusts intensity up or down for any selected channels. With channels selected,
roll the wheel up to increase intensity, or down to decrease it.

The level wheel can also provide additional functions when combined with various other console
keys. See Face Panel Shortcuts (on page 637) for more information.

Rate Wheel
The rate wheel can be used to provide dynamic rate adjustments for multiple playbacks.

Master Playbacks
The master playback fader pair, located to the left of the control keypad, is a split cross-fader
pair.

The button or buttons located directly above the playbacks load content to the playbacks. The
two buttons below control the [Go] and [Stop/Back] functions.

Encoders
Haptic-feedback encoders and an associated touchscreen for control of non-intensity
parameters are provided on the lower right of the console. The two larger encoders at the
bottom are dedicated pan and tilt controls.

The remaining four encoders on the right side of the console are pageable controls. By default,
these encoders are populated on the touchscreen with the parameters used in your show. They
can also be custom mapped.
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Six hardkeys are also available for encoder control. These encoder paging keys control intensity,
focus, color, shutter, image, and form. Pressing any of these will change the parameters
controlled by the encoders. To view other available encoder pages, simply press the encoder
paging keys to advance the pages.

Customizable Hardkeys
Eos Ti has twenty one customizable hardkeys. Twenty are located between the two main
touchscreens, and default to macros 801-820. The other is between [Label/Note] and [About]
on the face panel, and defaults to macro 821.

Functionality for the hardkeys can be defined in ECU > Buttons > Ti Face Panel Buttons. See
Buttons (on page 530) for configuration instructions.

Load Buttons
Load buttons, located directly above each fader, are used to load a specified target to the
associated fader, or to place special conditions on that fader.

Element 2, Element Classic, and classic fader wings lack dedicated load buttons, and instead
use a combination of both bump buttons beneath the faders.

See Assigning Faders Manually (on page 325) for more information.

Motorized Faders
In addition to the master playbacks, ten slots of configurable motorized faders are provided. The
faders may be configured as playbacks, submasters, grandmasters, timing masters, effects
masters, targets, or target lists. One hundred virtual pages of 10 faders each are provided.

DMX Ports
In order to output control levels from your console, you can use the DMX ports on the back of
the console and/or you may connect a gateway or node. If your device receives Net3 or ETCNet2
directly, no gateway or node is required.

To output, connect one 5 pin XLR cable per port. The first port will default to outputting the first
universe of DMX, addresses 1-512, the second port to the second universe, outputting addresses
513-1024, and so on.

SeeOutput (on page 175)Output (on page 175) for information on reconfiguring the DMX ports.

Ethernet Ports
Ethernet ports are for connecting to a network switch, network gateways, and accessory
devices. Each port is on a separate NIC, and can be configured to directly output network-based
lighting control protocols, such as sACN or ArtNet.

See Network Settings (on page 518) for more information.

Task Lights
Littlites®

You may connect Littlites to the back of your console.
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Dimming Task Lights

Task lights can be dimmed from within Eos, under Setup > Device > Brightness Settings. The
{Desk Lamp} slider has a range of 0% (dimmest) to 100% (brightest). The default setting is 0%.
The console will set the desk lamp to this setting on startup of the application. See Brightness
Settings (on page 182) for more information.

Task lights can also be controlled by holding down [Displays] and rolling the level wheel.

Ti Capacities

Output Parameters
• 4,096 (Min)
• 24,576 (Max)

Channel Counts
• 32,768 channels (can be any number from 1 to 99,999)

Cues and Cue List
• 999 cue lists
• 10,000 cues

Record Targets
• 10,000 Groups
• 10,000 x 4 Palettes (Intensity, Focus, Color and Beam)
• 10,000 Presets
• 10,000 Effects
• 99,999 Macros
• 10,000 Snapshots
• 10,000 Curves
• 10,000 Color Paths

Faders
• 1 dedicated motorized Master Playback pair, with Go and Stop/Back

• 10 motorized fader slots configurable as playbacks, submasters, grandmasters, timing
masters, effects masters, targets, or target lists

• 100 virtual pages of 10 faders each
• 200 configurable cue playbacks, with Go and Stop /Back
• 999 configurable submasters, with Bump and Assert/ channel select

WARNING: This device contains a lithium battery. Battery may explode if
mistreated. Do not recharge, disassemble or dispose of in fire.



Console Overview 17

CAUTION: Power cord must be connected using an earth ground
connection.

CAUTION: For continued protection against risk of fire, replace only with
same type and rating of fuse.

VORSICHT: Um weiterhin gegen Brandrisiko geschützt zu sein, ersetzen Sie
die Sicherung nur mit einer Sicherung gleichen Typs und den gleichen
Nennwerten.

ATTENTION: Pour ne pas compromettre la protection contre les risques
d’incendie, remplacer par un fusible de même type et de mêmes
caractéristiques nominales.
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Gio Overview
This page provides an overview of the physical layout, components, and capacities of the Gio
console.

Gio Layout

Gio Components

Power Button
The power button on the front of the console is used to power up or power down. A separate
hard power switch, located on the rear panel, can be used to disconnect power from the
console’s internal components.

CAUTION: It is recommended that you safely power down the console via
Displays > Power Off Device before disconnecting power from the console.

WARNING: Before servicing your console, you must switch off the power
on the rear panel and disconnect the power cord completely.

Fuse

A fuse is included for additional protection. Fuse ratings can be found on the rear panel of your
console.
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USB Ports
One USB port is provided on the front of the console to connect any USB storage device.
Additional USB ports on the rear panel (and in the keyboard tray, when present) of the console
connect peripherals such as an alphanumeric keyboard, pointing device, or touchscreen control
for external monitors.

CAUTION: The USB ports cannot be used for charging devices.

Internal Touchscreens
Gio is designed with two internal touchscreen displays. Each touchscreen may be used to
displayand control show data. They may also be used as a variety of other virtual controls and
displays.

The touchscreen angle can be adjusted by pushing the button in the center top of the display
and moving the panel up or down.

Touchscreen brightness can be controlled via the Brightness Settings (on page 182)

External Monitors
Eos Ti and Gio support up to three external Windows 7-compatible Display Port or DVI monitors.

Gio @ 5, Ion Xe, and Element 2 support up to two external Windows 7 compatible Display Port
monitors.

Display Port can use an active adapter to VGA, DVI, or HDMI. DVI-I can be converted to VGA
with a passive adapter.

Note: Output to 4K resolution monitors may affect console performance. ETC
recommends an external monitor resolution of 1024 or lower.

For monitor configuration, see Monitor Arrangement (on page 516).

Hardkeys

Backlit hardkeys are provided on the face panel. The brightness level for those keys can be
adjusted in the Brightness Settings (on page 182).

When your console has been idle for 10 minutes, the backlights will fade down by 10%. Any key
press on the face panel keypad or an external keyboard, a move of the mouse, or an interaction
with a touchscreen will return the keys to their set brightness level.
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The hardkeys are divided into several sections based on their functionality.

Keypad (1)

The numeric keypad allows you to type numbers for channel or target selection via the
command line, along with modifier keys to alter your selection.

Level Controls (2)

The level controls provide options for altering the intensity levels of channels, along with a
number of other non-intensity parameters / targets.

Targets (3)

The target controls provide options for altering a variety of record targets, as well as shortcuts to
various Blind displays.

Display & Navigation (4)

The display and navigation keys provide quick access to common displays, formatting, paging,
and navigation within displays.

Encoder Categories (5)

The encoder category buttons allow expanded control of a variety of fixture parameters, along
with additional softkey options where applicable.

Fader Control Buttons (6)

The fader control buttons provide additional options for easy local control of fader behavior.

Additional Targets & Functions

The remaining hardkeys provide options for a variety of common console functions and shortcuts
to various Blind displays.

Level Wheel
The level wheel adjusts intensity up or down for any selected channels. With channels selected,
roll the wheel up to increase intensity, or down to decrease it.

The level wheel can also provide additional functions when combined with various other console
keys. See Face Panel Shortcuts (on page 637) for more information.

Rate Wheel
The rate wheel can be used to provide dynamic rate adjustments for multiple playbacks.

Master Playbacks
The master playback fader pair, located to the left of the control keypad, is a split cross-fader
pair.

The button or buttons located directly above the playbacks load content to the playbacks. The
two buttons below control the [Go] and [Stop/Back] functions.

Encoders
Haptic-feedback encoders are provided above the control keypad. The four encoders are
pageable controls, which are populated with the parameters used in your show. Current encoder
mapping is indicated at all times, and the [Encoder Display] button opens full control on the
screen.
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Six hardkeys are also available for encoder control. These encoder paging keys control intensity,
focus, color, shutter, image, and form. Pressing any of these will change the parameters
controlled by the encoders. To view other available encoder pages, simply press the encoder
paging keys to advance the pages.

Customizable Hardkeys
Gio has nine customizable hardkeys. Eight are located between the two main touchscreens, and
default to macros 801-808. The other is between [Label/Note] and [About] on the face panel,
and defaults to macro 821.

Functionality for the hardkeys can be defined in ECU> Buttons> Gio Face Panel Buttons. See
Buttons (on page 530) for configuration instructions.

Load Buttons
Load buttons, located directly above each fader, are used to load a specified target to the
associated fader, or to place special conditions on that fader.

Element 2, Element Classic, and classic fader wings lack dedicated load buttons, and instead
use a combination of both bump buttons beneath the faders.

See Assigning Faders Manually (on page 325) for more information.

Motorized Faders
In addition to the master playbacks, ten slots of configurable motorized faders are provided. The
faders may be configured as playbacks, submasters, grandmasters, timing masters, effects
masters, targets, or target lists. One hundred virtual pages of 10 faders each are provided.

DMX Ports
In order to output control levels from your console, you can use the DMX ports on the back of
the console and/or you may connect a gateway or node. If your device receives Net3 or ETCNet2
directly, no gateway or node is required.

To output, connect one 5 pin XLR cable per port. The first port will default to outputting the first
universe of DMX, addresses 1-512, the second port to the second universe, outputting addresses
513-1024, and so on.

SeeOutput (on page 175)Output (on page 175) for information on reconfiguring the DMX ports.

Ethernet Ports
Ethernet ports are for connecting to a network switch, network gateways, and accessory
devices. Each port is on a separate NIC, and can be configured to directly output network-based
lighting control protocols, such as sACN or ArtNet.

See Network Settings (on page 518) for more information.

Task Lights
Littlites®

You may connect Littlites to the back of your console.
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Dimming Task Lights

Task lights can be dimmed from within Eos, under Setup > Device > Brightness Settings. The
{Desk Lamp} slider has a range of 0% (dimmest) to 100% (brightest). The default setting is 0%.
The console will set the desk lamp to this setting on startup of the application. See Brightness
Settings (on page 182) for more information.

Task lights can also be controlled by holding down [Displays] and rolling the level wheel.

Gio Capacities

Output Parameters
• 4,096 (Min)
• 24,576 (Max)

Channel Counts
• 32,768 channels (can be any number from 1 to 99,999)

Cues and Cue List
• 999 cue lists
• 10,000 cues

Record Targets
• 10,000 Groups
• 10,000 x 4 Palettes (Intensity, Focus, Color and Beam)
• 10,000 Presets
• 10,000 Effects
• 99,999 Macros
• 10,000 Snapshots
• 10,000 Curves
• 10,000 Color Paths

Faders
• 1 dedicated motorized Master Playback pair, with Go and Stop/Back

• 10 motorized fader slots configurable as playbacks, submasters, grandmasters, timing
masters, effects masters, targets, or target lists

• 100 virtual pages of 10 faders each
• 200 configurable cue playbacks, with Go and Stop /Back
• 999 configurable submasters, with Bump and Assert/ channel select

WARNING: This device contains a lithium battery. Battery may explode if
mistreated. Do not recharge, disassemble or dispose of in fire.
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CAUTION: Power cord must be connected using an earth ground
connection.

CAUTION: For continued protection against risk of fire, replace only with
same type and rating of fuse.

VORSICHT: Um weiterhin gegen Brandrisiko geschützt zu sein, ersetzen Sie
die Sicherung nur mit einer Sicherung gleichen Typs und den gleichen
Nennwerten.

ATTENTION: Pour ne pas compromettre la protection contre les risques
d’incendie, remplacer par un fusible de même type et de mêmes
caractéristiques nominales.
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Gio@5 Overview
This page provides an overview of the physical layout, components, and capacities of the Gio@5
console.

Gio@5 Layout

Gio@5 Components

Power Button
The power button on the front of the console is used to power up or power down. A separate
hard power switch, located on the rear panel, can be used to disconnect power from the
console’s internal components.

CAUTION: It is recommended that you safely power down the console via
Displays > Power Off Device before disconnecting power from the console.

WARNING: Before servicing your console, you must switch off the power
on the rear panel and disconnect the power cord completely.
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Fuse

A fuse is included for additional protection. Fuse ratings can be found on the rear panel of your
console.

USB Ports
One USB port is provided on the front of the console to connect any USB storage device.
Additional USB ports on the rear panel (and in the keyboard tray, when present) of the console
connect peripherals such as an alphanumeric keyboard, pointing device, or touchscreen control
for external monitors.

CAUTION: The USB ports cannot be used for charging devices.

Internal Touchscreen
Gio @ 5 is designed with a single internal touchscreen display. The touchscreen may be used to
display and control show data. It can also be used as a variety of other virtual controls and
displays.

The touchscreen angle can be adjusted by pushing the button in the left side top of the display
and moving the panel up or down.

Touchscreen brightness can be controlled via the Brightness Settings (on page 182)

External Monitors
Eos Ti and Gio support up to three external Windows 7-compatible Display Port or DVI monitors.

Gio @ 5, Ion Xe, and Element 2 support up to two external Windows 7 compatible Display Port
monitors.

Display Port can use an active adapter to VGA, DVI, or HDMI. DVI-I can be converted to VGA
with a passive adapter.

Note: Output to 4K resolution monitors may affect console performance. ETC
recommends an external monitor resolution of 1024 or lower.

For monitor configuration, see Monitor Arrangement (on page 516).

Hardkeys

Backlit hardkeys are provided on the face panel. The brightness level for those keys can be
adjusted in the Brightness Settings (on page 182).
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When your console has been idle for 10 minutes, the backlights will fade down by 10%. Any key
press on the face panel keypad or an external keyboard, a move of the mouse, or an interaction
with a touchscreen will return the keys to their set brightness level.

The hardkeys are divided into several sections based on their functionality.

Keypad (1)

The numeric keypad allows you to type numbers for channel or target selection via the
command line, along with modifier keys to alter your selection.

Level Controls (2)

The level controls provide options for altering the intensity levels of channels, along with a
number of other non-intensity parameters / targets.

Targets (3)

The target controls provide options for altering a variety of record targets, as well as shortcuts to
various Blind displays.

Display & Navigation (4)

The display and navigation keys provide quick access to common displays, formatting, paging,
and navigation within displays.

Encoder Categories (5)

The encoder category buttons allow expanded control of a variety of fixture parameters, along
with additional softkey options where applicable.

Fader Control Buttons (6)

The fader control buttons provide additional options for easy local control of fader behavior.

Additional Targets & Functions

The remaining hardkeys provide options for a variety of common console functions and shortcuts
to various Blind displays.

Level Wheel
The level wheel adjusts intensity up or down for any selected channels. With channels selected,
roll the wheel up to increase intensity, or down to decrease it.

The level wheel can also provide additional functions when combined with various other console
keys. See Face Panel Shortcuts (on page 637) for more information.

Rate Wheel
The rate wheel can be used to provide dynamic rate adjustments for multiple playbacks.

Master Playbacks
The master playback fader pair, located to the left of the control keypad, is a split cross-fader
pair.

The button or buttons located directly above the playbacks load content to the playbacks. The
two buttons below control the [Go] and [Stop/Back] functions.

Encoders
Haptic-feedback encoders are provided above the control keypad. The four encoders are
pageable controls, which are populated with the parameters used in your show. Current encoder
mapping is indicated at all times, and the [Encoder Display] button opens full control on the
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screen.

Customizable Hardkeys
Gio @ 5 has twenty one customizable hardkeys. Twenty are located to the left of the main
touchscreen, and default to macros 801-820. The other is between [Label/Note] and [About] on
the face panel, and defaults to macro 821.

Functionality for the hardkeys can be defined in ECU> Buttons> Gio @ 5 Face Panel Buttons.
See Buttons (on page 530) for configuration instructions.

Load Buttons
Load buttons, located directly above each fader, are used to load a specified target to the
associated fader, or to place special conditions on that fader.

Element 2, Element Classic, and classic fader wings lack dedicated load buttons, and instead
use a combination of both bump buttons beneath the faders.

See Assigning Faders Manually (on page 325) for more information.

Motorized Faders
In addition to the master playbacks, five slots of configurable motorized faders are provided.
The faders may be configured as playbacks, submasters, grandmasters, timing masters, effects
masters, targets, or target lists. One hundred virtual pages of 10 faders each are provided.

The fader bank has a dedicated LCD display for local status of playback content.

DMX Ports
In order to output control levels from your console, you can use the DMX ports on the back of
the console and/or you may connect a gateway or node. If your device receives Net3 or ETCNet2
directly, no gateway or node is required.

To output, connect one 5 pin XLR cable per port. The first port will default to outputting the first
universe of DMX, addresses 1-512, the second port to the second universe, outputting addresses
513-1024, and so on.

SeeOutput (on page 175)Output (on page 175) for information on reconfiguring the DMX ports.

Ethernet Ports
Ethernet ports are for connecting to a network switch, network gateways, and accessory
devices. Each port is on a separate NIC, and can be configured to directly output network-based
lighting control protocols, such as sACN or ArtNet.

See Network Settings (on page 518) for more information.

Task Lights
Littlites®

You may connect Littlites to the back of your console.
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Dimming Task Lights

Task lights can be dimmed from within Eos, under Setup > Device > Brightness Settings. The
{Desk Lamp} slider has a range of 0% (dimmest) to 100% (brightest). The default setting is 0%.
The console will set the desk lamp to this setting on startup of the application. See Brightness
Settings (on page 182) for more information.

Task lights can also be controlled by holding down [Displays] and rolling the level wheel.

Gio@5 Capacities

Output Parameters
• 4,096 (Min)
• 24,576 (Max)

Channel Counts
• 32,768 channels (can be any number from 1 to 99,999)

Cues and Cue List
• 999 cue lists
• 10,000 cues

Record Targets
• 10,000 Groups
• 10,000 x 4 Palettes (Intensity, Focus, Color and Beam)
• 10,000 Presets
• 10,000 Effects
• 99,999 Macros
• 10,000 Snapshots
• 10,000 Curves
• 10,000 Color Paths

Faders
• 1 dedicated motorized Master Playback pair, with Go and Stop/Back

• 5 motorized fader slots configurable as playbacks, submasters, grandmasters, timing
masters, effects masters, targets, or target lists

• 100 virtual pages of 10 faders each
• 200 configurable cue playbacks, with Go and Stop /Back
• 999 configurable submasters, with Bump and Assert/ channel select

WARNING: This device contains a lithium battery. Battery may explode if
mistreated. Do not recharge, disassemble or dispose of in fire.
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CAUTION: Power cord must be connected using an earth ground
connection.

CAUTION: For continued protection against risk of fire, replace only with
same type and rating of fuse.

VORSICHT: Um weiterhin gegen Brandrisiko geschützt zu sein, ersetzen Sie
die Sicherung nur mit einer Sicherung gleichen Typs und den gleichen
Nennwerten.

ATTENTION: Pour ne pas compromettre la protection contre les risques
d’incendie, remplacer par un fusible de même type et de mêmes
caractéristiques nominales.
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Ion Xe Overview
This page provides an overview of the physical layout, components, and capacities of the Ion Xe
and Ion Xe 20 consoles.

Ion Xe Layout

Ion Xe 20 Layout
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Ion Xe Components

Power Button
The power button on the front of the console is used to power up or power down. A separate
hard power switch, located on the rear panel, can be used to disconnect power from the
console’s internal components.

CAUTION: It is recommended that you safely power down the console via
Displays > Power Off Device before disconnecting power from the console.

WARNING: Before servicing your console, you must switch off the power
on the rear panel and disconnect the power cord completely.

Fuse

A fuse is included for additional protection. Fuse ratings can be found on the rear panel of your
console.

USB Ports
One USB port is provided on the front of the console to connect any USB storage device.
Additional USB ports on the rear panel (and in the keyboard tray, when present) of the console
connect peripherals such as an alphanumeric keyboard, pointing device, or touchscreen control
for external monitors.

CAUTION: The USB ports cannot be used for charging devices.

External Monitors
Eos Ti and Gio support up to three external Windows 7-compatible Display Port or DVI monitors.

Gio @ 5, Ion Xe, and Element 2 support up to two external Windows 7 compatible Display Port
monitors.

Display Port can use an active adapter to VGA, DVI, or HDMI. DVI-I can be converted to VGA
with a passive adapter.

Note: Output to 4K resolution monitors may affect console performance. ETC
recommends an external monitor resolution of 1024 or lower.

For monitor configuration, see Monitor Arrangement (on page 516).
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Hardkeys

Backlit hardkeys are provided on the face panel. The brightness level for those keys can be
adjusted in the Brightness Settings (on page 182).

When your console has been idle for 10 minutes, the backlights will fade down by 10%. Any key
press on the face panel keypad or an external keyboard, a move of the mouse, or an interaction
with a touchscreen will return the keys to their set brightness level.

The hardkeys are divided into several sections based on their functionality.

Keypad (1)

The numeric keypad allows you to type numbers for channel or target selection via the
command line, along with modifier keys to alter your selection.

Level Controls (2)

The level controls provide options for altering the intensity levels of channels, along with a
number of other non-intensity parameters / targets.

Targets (3)

The target controls provide options for altering a variety of record targets, as well as shortcuts to
various Blind displays.

Display & Navigation (4)

The display and navigation keys provide quick access to common displays, formatting, paging,
and navigation within displays.

Encoder Categories (5)

The encoder category buttons allow expanded control of a variety of fixture parameters, along
with additional softkey options where applicable.

Additional Targets & Functions

The remaining hardkeys provide options for a variety of common console functions and shortcuts
to various Blind displays.

Level Wheel
The level wheel adjusts intensity up or down for any selected channels. With channels selected,
roll the wheel up to increase intensity, or down to decrease it.
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The level wheel can also provide additional functions when combined with various other console
keys. See Face Panel Shortcuts (on page 637) for more information.

Rate Wheel
The rate wheel can be used to provide dynamic rate adjustments for multiple playbacks.

Master Playbacks
The master playback fader pair, located to the left of the control keypad, is a split cross-fader
pair.

The button or buttons located directly above the playbacks load content to the playbacks. The
two buttons below control the [Go] and [Stop/Back] functions.

Encoders
Haptic-feedback encoders are provided above the control keypad. The four encoders are
pageable controls, which are populated with the parameters used in your show. Current encoder
mapping is indicated at all times, and the [Encoder Display] button opens full control on the
screen.

Load Buttons
Load buttons, located directly above each fader, are used to load a specified target to the
associated fader, or to place special conditions on that fader.

Element 2, Element Classic, and classic fader wings lack dedicated load buttons, and instead
use a combination of both bump buttons beneath the faders.

See Assigning Faders Manually (on page 325) for more information.

DMX Ports
In order to output control levels from your console, you can use the DMX ports on the back of
the console and/or you may connect a gateway or node. If your device receives Net3 or ETCNet2
directly, no gateway or node is required.

To output, connect one 5 pin XLR cable per port. The first port will default to outputting the first
universe of DMX, addresses 1-512, the second port to the second universe, outputting addresses
513-1024, and so on.

SeeOutput (on page 175)Output (on page 175) for information on reconfiguring the DMX ports.

Ethernet Ports
Ethernet ports are for connecting to a network switch, network gateways, and accessory
devices. Each port is on a separate NIC, and can be configured to directly output network-based
lighting control protocols, such as sACN or ArtNet.

See Network Settings (on page 518) for more information.

Task Lights
Littlites®

You may connect Littlites to the back of your console.
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Dimming Task Lights

Task lights can be dimmed from within Eos, under Setup > Device > Brightness Settings. The
{Desk Lamp} slider has a range of 0% (dimmest) to 100% (brightest). The default setting is 0%.
The console will set the desk lamp to this setting on startup of the application. See Brightness
Settings (on page 182) for more information.

Task lights can also be controlled by holding down [Displays] and rolling the level wheel.

Ion Xe Capacities

Output Parameters
• 2,048 (Min)
• 12,288 (Max)

Channel Counts
• 32,768 channels (can be any number from 1 to 99,999)

Cues and Cue List
• 999 cue lists
• 10,000 cues

Record Targets
• 10,000 Groups
• 10,000 x 4 Palettes (Intensity, Focus, Color and Beam)
• 10,000 Presets
• 10,000 Effects
• 99,999 Macros
• 10,000 Snapshots
• 10,000 Curves
• 10,000 Color Paths

Faders
• 1 dedicated Master Playback pair, with Go and Stop/ Back
• 20 faders with 40 configurable buttons (Ion Xe 20 only)
• 200 configurable cue playbacks, with Go and Stop /Back
• 999 configurable submasters, with Bump and Assert/ channel select

WARNING: This device contains a lithium battery. Battery may explode if
mistreated. Do not recharge, disassemble or dispose of in fire.
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CAUTION: Power cord must be connected using an earth ground
connection.

CAUTION: For continued protection against risk of fire, replace only with
same type and rating of fuse.

VORSICHT: Um weiterhin gegen Brandrisiko geschützt zu sein, ersetzen Sie
die Sicherung nur mit einer Sicherung gleichen Typs und den gleichen
Nennwerten.

ATTENTION: Pour ne pas compromettre la protection contre les risques
d’incendie, remplacer par un fusible de même type et de mêmes
caractéristiques nominales.
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Element 2 Overview
This page provides an overview of the physical layout, components, and capacities of the
Element 2 console.

Element 2 Layout

Element 2 Components

Power Button
The power button on the front of the console is used to power up or power down. A separate
hard power switch, located on the rear panel, can be used to disconnect power from the
console’s internal components.

CAUTION: It is recommended that you safely power down the console via
Displays > Power Off Device before disconnecting power from the console.

WARNING: Before servicing your console, you must switch off the power
on the rear panel and disconnect the power cord completely.

Fuse

A fuse is included for additional protection. Fuse ratings can be found on the rear panel of your
console.

USB Ports
One USB port is provided on the front of the console to connect any USB storage device.
Additional USB ports on the rear panel (and in the keyboard tray, when present) of the console
connect peripherals such as an alphanumeric keyboard, pointing device, or touchscreen control
for external monitors.
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CAUTION: The USB ports cannot be used for charging devices.

External Monitors
Eos Ti and Gio support up to three external Windows 7-compatible Display Port or DVI monitors.

Gio @ 5, Ion Xe, and Element 2 support up to two external Windows 7 compatible Display Port
monitors.

Display Port can use an active adapter to VGA, DVI, or HDMI. DVI-I can be converted to VGA
with a passive adapter.

Note: Output to 4K resolution monitors may affect console performance. ETC
recommends an external monitor resolution of 1024 or lower.

For monitor configuration, see Monitor Arrangement (on page 516).

Hardkeys

Backlit hardkeys are provided on the face panel. The brightness level for those keys can be
adjusted in the Brightness Settings (on page 182).

When your console has been idle for 10 minutes, the backlights will fade down by 10%. Any key
press on the face panel keypad or an external keyboard, a move of the mouse, or an interaction
with a touchscreen will return the keys to their set brightness level.

The hardkeys are divided into several sections based on their functionality.

Keypad (1)

The numeric keypad allows you to type numbers for channel or target selection via the
command line, along with modifier keys to alter your selection.

Level Controls (2)

The level controls provide options for altering the intensity levels of channels, along with a
number of other non-intensity parameters / targets.

Targets (3)

The target controls provide options for altering a variety of record targets, as well as shortcuts to
various Blind displays.
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Display & Navigation (4)

The display and navigation keys provide quick access to common displays, formatting, paging,
and navigation within displays.

Softkeys (5)

The softkey buttons allow physical control of the onscreen softkey options, which change
dynamically based on the command line and active tab to offer additional commands not
available on hardkeys.

Additional Targets & Functions

The remaining hardkeys provide options for a variety of common console functions and shortcuts
to various Blind displays.

Level Wheel
The level wheel adjusts intensity up or down for any selected channels. With channels selected,
roll the wheel up to increase intensity, or down to decrease it.

The level wheel can also provide additional functions when combined with various other console
keys. See Face Panel Shortcuts (on page 637) for more information.

Master Playbacks
The master playback fader pair, located to the left of the control keypad, is a split cross-fader
pair.

The button or buttons located directly above the playbacks load content to the playbacks. The
two buttons below control the [Go] and [Stop/Back] functions.

Load Buttons
Load buttons, located directly above each fader, are used to load a specified target to the
associated fader, or to place special conditions on that fader.

Element 2, Element Classic, and classic fader wings lack dedicated load buttons, and instead
use a combination of both bump buttons beneath the faders.

See Assigning Faders Manually (on page 325) for more information.

DMX Ports
In order to output control levels from your console, you can use the DMX ports on the back of
the console and/or you may connect a gateway or node. If your device receives Net3 or ETCNet2
directly, no gateway or node is required.

To output, connect one 5 pin XLR cable per port. The first port will default to outputting the first
universe of DMX, addresses 1-512, the second port to the second universe, outputting addresses
513-1024, and so on.

SeeOutput (on page 175)Output (on page 175) for information on reconfiguring the DMX ports.

Ethernet Ports
Ethernet ports are for connecting to a network switch, network gateways, and accessory
devices. Each port is on a separate NIC, and can be configured to directly output network-based
lighting control protocols, such as sACN or ArtNet.

See Network Settings (on page 518) for more information.
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Task Lights
Littlites®

You may connect Littlites to the back of your console.

Dimming Task Lights

Task lights can be dimmed from within Eos, under Setup > Device > Brightness Settings. The
{Desk Lamp} slider has a range of 0% (dimmest) to 100% (brightest). The default setting is 0%.
The console will set the desk lamp to this setting on startup of the application. See Brightness
Settings (on page 182) for more information.

Task lights can also be controlled by holding down [Displays] and rolling the level wheel.

Element 2 Capacities

Output Parameters
• 1,024 (Min)
• 6,144 (Max)

Channel Counts
• 32,768 channels (can be any number from 1 to 99,999)

Cues and Cue List
• 1 cue list
• 10,000 cues

Record Targets
• 1,000 Groups
• 1,000 x 4 Palettes (Intensity, Focus, Color and Beam)
• 1,000 Presets
• 1,000 Effects
• 99,999 Macros
• 1,000 Snapshots
• 1,000 Curves
• 1,000 Color Paths

Faders
• 1 dedicated Master Playback pair, with Go and Stop/ Back
• 40 faders with 80 configurable buttons
• 999 configurable submasters, with Bump and Assert/ channel select
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WARNING: This device contains a lithium battery. Battery may explode if
mistreated. Do not recharge, disassemble or dispose of in fire.

CAUTION: Power cord must be connected using an earth ground
connection.

CAUTION: For continued protection against risk of fire, replace only with
same type and rating of fuse.

VORSICHT: Um weiterhin gegen Brandrisiko geschützt zu sein, ersetzen Sie
die Sicherung nur mit einer Sicherung gleichen Typs und den gleichen
Nennwerten.

ATTENTION: Pour ne pas compromettre la protection contre les risques
d’incendie, remplacer par un fusible de même type et de mêmes
caractéristiques nominales.
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Ion Classic Overview
This page provides an overview of the physical layout, components, and capacities of the Ion
Classic console.

Ion Classic Layout

Ion Classic Components

Power Button
The power button on the front of the console is used to power up or power down. A separate
hard power switch, located on the rear panel, can be used to disconnect power from the
console’s internal components.

CAUTION: It is recommended that you safely power down the console via
Displays > Power Off Device, before disconnecting power from the console.

WARNING: Before servicing your console, you must switch off the power
on the rear panel and disconnect the power cord completely.

USB Ports
One USB port is provided on the front of the console to connect any USB storage device.
Additional USB ports on the rear panel (and in the keyboard tray, when present) of the console
connect peripherals such as an alphanumeric keyboard, pointing device, or touchscreen control
for external monitors.
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CAUTION: The USB ports cannot be used for charging devices.

External Monitors
Eos Ti and Gio support up to three external Windows 7-compatible Display Port or DVI monitors.

Gio @ 5, Ion Xe, and Element 2 support up to two external Windows 7 compatible Display Port
monitors.

Display Port can use an active adapter to VGA, DVI, or HDMI. DVI-I can be converted to VGA
with a passive adapter.

Note: Output to 4K resolution monitors may affect console performance. ETC
recommends an external monitor resolution of 1024 or lower.

For monitor configuration, see Monitor Arrangement (on page 516).

Hardkeys

Backlit hardkeys are provided on the face panel. The brightness level for those keys can be
adjusted in the Brightness Settings (on page 182).

When your console has been idle for 10 minutes, the backlights will fade down by 10%. Any key
press on the face panel keypad or an external keyboard, a move of the mouse, or an interaction
with a touchscreen will return the keys to their set brightness level.

The hardkeys are divided into several sections based on their functionality.

Keypad (1)

The numeric keypad allows you to type numbers for channel or target selection via the
command line, along with modifier keys to alter your selection.
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Level Controls (2)

The level controls provide options for altering the intensity levels of channels, along with a
number of other non-intensity parameters / targets.

Targets (3)

The target controls provide options for altering a variety of record targets, as well as shortcuts to
various Blind displays.

Display & Navigation (4)

The display and navigation keys provide quick access to common displays, formatting, paging,
and navigation within displays.

Encoder Categories (5)

The encoder category buttons allow expanded control of a variety of fixture parameters, along
with additional softkey options where applicable.

Softkeys (6)

The softkey buttons allow physical control of the onscreen softkey options, which change
dynamically based on the command line and active tab to offer additional commands not
available on hardkeys.

Additional Targets & Functions

The remaining hardkeys provide options for a variety of common console functions and shortcuts
to various Blind displays.

Level Wheel
The level wheel adjusts intensity up or down for any selected channels. With channels selected,
roll the wheel up to increase intensity, or down to decrease it.

The level wheel can also provide additional functions when combined with various other console
keys. See Face Panel Shortcuts (on page 637) for more information.

Master Playbacks
The master playback fader pair, located to the left of the control keypad, is a split cross-fader
pair.

The button or buttons located directly above the playbacks load content to the playbacks. The
two buttons below control the [Go] and [Stop/Back] functions.

Encoders
Haptic-feedback encoders and an associated LCD for control of non-intensity parameters are
provided at the top center of the console. The four encoders are pageable controls, which are
populated on the LCD with the parameters used in your show.

LCD

This display accompanies the CIA as an additional user interface. This LCD offers you softkeys,
encoder information, and an additional view of the command line. To adjust the brightness and
contrast levels of the LCD, go to Setup > Desk > Brightness Settings > Ion Display. See
Brightness Settings (on page 182) for more information.

Load Buttons
Load buttons, located directly above each fader, are used to load a specified target to the
associated fader, or to place special conditions on that fader.
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Element 2, Element Classic, and classic fader wings lack dedicated load buttons, and instead
use a combination of both bump buttons beneath the faders.

See Assigning Faders Manually (on page 325) for more information.

DMX Ports
In order to output control levels from your console, you can use the DMX ports on the back of
the console and/or you may connect a gateway or node. If your device receives Net3 or ETCNet2
directly, no gateway or node is required.

To output, connect one 5 pin XLR cable per port. The first port will default to outputting the first
universe of DMX, addresses 1-512, the second port to the second universe, outputting addresses
513-1024, and so on.

SeeOutput (on page 175)Output (on page 175) for information on reconfiguring the DMX ports.

Ethernet Ports
Ethernet ports are for connecting to a network switch, network gateways, and accessory
devices. Each port is on a separate NIC, and can be configured to directly output network-based
lighting control protocols, such as sACN or ArtNet.

See Network Settings (on page 518) for more information.

Task Lights
Littlites®

You may connect Littlites to the back of your console.

Dimming Task Lights

Task lights can be dimmed from within Eos, under Setup > Device > Brightness Settings. The
{Desk Lamp} slider has a range of 0% (dimmest) to 100% (brightest). The default setting is 0%.
The console will set the desk lamp to this setting on startup of the application. See Brightness
Settings (on page 182) for more information.

Task lights can also be controlled by holding down [Displays] and rolling the level wheel.

Ion Classic Capacities

Output Parameters
• 1,024 (Min)
• 6,144 (Max)

Channel Counts
• 16,000 channels (can be any number from 1 to 99,999)
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Cues and Cue List
• 999 cue lists
• 10,000 cues

Record Targets
• 1,000 Groups
• 1,000 x 4 Palettes (Intensity, Focus, Color and Beam)
• 1,000 Presets
• 1,000 Effects
• 99,999 Macros
• 1,000 Snapshots
• 1,000 Curves
• 1,000 Color Paths

Faders
• 1 configurable Grandmaster, with Blackout and Blackout Enable
• 1 dedicated Master Playback pair, with Go and Stop/ Back
• 200 configurable cue playbacks, with Go and Stop /Back
• 999 configurable submasters, with Bump and Assert/ channel select

WARNING: This device contains a lithium battery. Battery may explode if
mistreated. Do not recharge, disassemble or dispose of in fire.

CAUTION: Power cord must be connected using an earth ground
connection.
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Element Classic Overview
This page provides an overview of the physical layout, components, and capacities of the
Element Classic console.

Element Classic Layout

Element Classic Components

Power Button
The power button on the front of the console is used to power up or power down. A separate
hard power switch, located on the rear panel, can be used to disconnect power from the
console’s internal components.

CAUTION: It is recommended that you safely power down the console via
Displays > Power Off Device, before disconnecting power from the console.

WARNING: Before servicing your console, you must switch off the power
on the rear panel and disconnect the power cord completely.

USB Ports
One USB port is provided on the front of the console to connect any USB storage device.
Additional USB ports on the rear panel (and in the keyboard tray, when present) of the console
connect peripherals such as an alphanumeric keyboard, pointing device, or touchscreen control
for external monitors.

CAUTION: The USB ports cannot be used for charging devices.

External Monitors
Eos Ti and Gio support up to three external Windows 7-compatible Display Port or DVI monitors.
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Gio @ 5, Ion Xe, and Element 2 support up to two external Windows 7 compatible Display Port
monitors.

Display Port can use an active adapter to VGA, DVI, or HDMI. DVI-I can be converted to VGA
with a passive adapter.

Note: Output to 4K resolution monitors may affect console performance. ETC
recommends an external monitor resolution of 1024 or lower.

For monitor configuration, see Monitor Arrangement (on page 516).

Hardkeys

Backlit hardkeys are provided on the face panel. The brightness level for those keys can be
adjusted in the Brightness Settings (on page 182).

When your console has been idle for 10 minutes, the backlights will fade down by 10%. Any key
press on the face panel keypad or an external keyboard, a move of the mouse, or an interaction
with a touchscreen will return the keys to their set brightness level.

The hardkeys are divided into several sections based on their functionality.

Keypad (1)

The numeric keypad allows you to type numbers for channel or target selection via the
command line, along with modifier keys to alter your selection.

Level Controls (2)

The level controls provide options for altering the intensity levels of channels, along with a
number of other non-intensity parameters / targets.

Targets (3)

The target controls provide options for altering a variety of record targets, as well as shortcuts to
various Blind displays.
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Display & Navigation (4)

The display and navigation keys provide quick access to common displays, formatting, paging,
and navigation within displays.

Softkeys (5)

The softkey buttons allow physical control of the onscreen softkey options, which change
dynamically based on the command line and active tab to offer additional commands not
available on hardkeys.

Additional Targets & Functions

The remaining hardkeys provide options for a variety of common console functions and shortcuts
to various Blind displays.

Level Wheel
The level wheel adjusts intensity up or down for any selected channels. With channels selected,
roll the wheel up to increase intensity, or down to decrease it.

The level wheel can also provide additional functions when combined with various other console
keys. See Face Panel Shortcuts (on page 637) for more information.

Master Playbacks
The master playback fader pair, located to the left of the control keypad, is a split cross-fader
pair.

The button or buttons located directly above the playbacks load content to the playbacks. The
two buttons below control the [Go] and [Stop/Back] functions.

Load Buttons
Load buttons, located directly above each fader, are used to load a specified target to the
associated fader, or to place special conditions on that fader.

Element 2, Element Classic, and classic fader wings lack dedicated load buttons, and instead
use a combination of both bump buttons beneath the faders.

See Assigning Faders Manually (on page 325) for more information.

DMX Ports
In order to output control levels from your console, you can use the DMX ports on the back of
the console and/or you may connect a gateway or node. If your device receives Net3 or ETCNet2
directly, no gateway or node is required.

To output, connect one 5 pin XLR cable per port. The first port will default to outputting the first
universe of DMX, addresses 1-512, the second port to the second universe, outputting addresses
513-1024, and so on.

SeeOutput (on page 175)Output (on page 175) for information on reconfiguring the DMX ports.

Ethernet Ports
Ethernet ports are for connecting to a network switch, network gateways, and accessory
devices. Each port is on a separate NIC, and can be configured to directly output network-based
lighting control protocols, such as sACN or ArtNet.

See Network Settings (on page 518) for more information.
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Task Lights
Littlites®

You may connect Littlites to the back of your console.

Dimming Task Lights

Task lights can be dimmed from within Eos, under Setup > Device > Brightness Settings. The
{Desk Lamp} slider has a range of 0% (dimmest) to 100% (brightest). The default setting is 0%.
The console will set the desk lamp to this setting on startup of the application. See Brightness
Settings (on page 182) for more information.

Task lights can also be controlled by holding down [Displays] and rolling the level wheel.

Element Classic Capacities

Output Parameters
• 1,024

Channel Counts
• 250 or 500 channels (any number from 1 to 99,999)

Cues and Cue List
• Up to 10,000 cues
• 1 Active Playback
• 1 Cue List

Record Targets
• 1,000 Groups
• 1,000 Presets
• 1,000 x 4 Palettes (Intensity, Focus, Color and Beam)
• 1,000 Curves
• 1,000 Effects
• 99,999 Macros

Faders
• 1 Grandmaster with Blackout
• 1 Master Playback, with Go and Stop/Back
• 40 or 60 faders with bump buttons
• 999 configurable submasters

• 120 channel faders
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WARNING: This device contains a lithium battery. Battery may explode if
mistreated. Do not recharge, disassemble or dispose of in fire.

CAUTION: Power cord must be connected using an earth ground
connection.
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Cleaning Your Console
Should the exterior of your console require cleaning, you may gently wipe it with a damp (not
dripping), non-abrasive paper towel or soft cloth.

If this does not clean the console sufficiently, you may apply some window cleaner (containing
ammonia is fine) to the cloth and repeat the process until clean.

More information about cleaning your console is available at the ETC Support Site,
support.etcconnect.com.

https://support.etcconnect.com/
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About System Basics
This section explains the base level procedures for setting up, navigating, and understanding
how to operate your console.

Power Up the Console
1. Attach the appropriate power cable to the IEC connector on the rear of the console.
2. Press the I/O switch (I is “on”) next to the IEC connector on the rear of the console to turn

power on. This will provide power to all internal electronics.
3. Press the power button, located on the face panel. The button LED will illuminate blue to

indicate the console is running. The console will boot to the launch screen. The system is
now ready for use.

Note: You can go straight to the welcome screen by adjusting a setting in the ECU.
See Open in Shell E.C.U (on page 513) in the ECU appendix.
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Power Down the Console
1. After saving your show (see Saving the Current Show File (on page 118)), in the browser

menu select Power Off Device. A dialogue box opens asking you to confirm.
2. Confirm this command by pressing {OK} in the dialog box. The console will power down.

Note: These are persistent storage systems. Therefore if you shut down your system
without saving the show file, you will return to the same place in your show when you
reboot.

Note: The console will display an improper shutdown message on the next power up
if the console was not powered down from the browser menu or welcome screen.

The Central Information Area (CIA)
The Central Information Area (CIA) is the lower portion of the screen. By default, the CIA
consists of three primary areas: the command line, the parameter display, and the browser.
Softkeys are also contained within the CIA.

Note: Gio and Gio @ 5 have a mini encoder display as part of their CIA. See Mini
Encoder Display (on page 97) for more information.

CIA Icons
There are three icons located above the CIA.

Favorite CIA Display
You can select a favorite default display for the CIA that will show when [Displays] is pressed.
The standard default display for the CIA is the Browser.

The favorite display will show a gold star icon at the top of the CIA by the arrow and lock icons.
Displays that can be selected as a favorite, but are currently not, will show a gray star at the top
of the CIA. Click on the gray star to make that display your favorite. That display will now be
the new default display for the CIA. Displays that show up in the CIA but cannot be the default
display will not show the star icon.

Collapse/ Expand the CIA
It is possible to collapse the CIA from view. To do this, you can click the arrow icon above the
CIA. The CIA will collapse from view, exposing a larger viewing area of whatever display is
visible above the CIA. The arrow will move to the bottom of the screen.
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To expand the CIA into view again, click the arrow at the bottom of the screen. The CIA will
reopen.

Lock the CIA
You can lock the CIA in place to prevent it from being collapsed or viewed.

To lock the CIA, click on the lock above the browser. The lock will “lock”.

To unlock the CIA, click the sunken lock again.

Note: While locked, the CIA can still be collapsed or expanded by clicking the arrow
icon. You can also use [Displays] & [Page ▲ ] to expand or [Displays] & [Page ▼ ] to
collapse.

The Command Line
This is the area where commands appear when entered. When in Live, this line is bordered in
gold. The command line will display in blue when in Blind.

Note: Press [Clear] to remove commands from a terminated command line. Use
[Shift] & [Clear] to remove commands from a command line that is not terminated.

See Syntax Structure (on page 5) for more information on using the command line.

Command Line Prompt

Note: This feature is only available on Element 2.

Directly above the command line, you will see gold text that will prompt you for an action. The
prompts will change between different displays and actions, and provide useful information to
aid you in programming.

Command line prompts can be disabled in Setup. See Displays (on page 182) for more
information.

Command Line Search
Command line search allows you to search your recorded targets, effects, and channels. The
search window will display the object, it's number, and any label you have given it.

Press the Search icon at the end of the command line or use [Shift] & [About] to open the
command line search window.
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Parameter Display
This display shows the parameters available for patched channels. It is also where you can select
which parameters to view in the Live and / or Blind displays, or select parameters for command
line control. The parameter display will dynamically change depending on the channel (fixture)
selected and its applicable parameters.

For more information on using the parameter display, see Using the Parameter Display (on
page 194).

Parameter Category Button Labels
These labels correspond to the six parameter categories; Intensity, Focus, Color, and the three
Beam categories (Form, Image, and Shutter).

Collapsing the Parameter Display
The parameter display can be collapsed when working with some displays that use the CIA, such
as About and Query. A collapse/ expand arrow will display in the last column where this option
is available.

When collapsed, only the {All NPs}, {All Speed}, and {Expand Arrow} buttons will be displayed.

Labeling
[Label] is used to attach an alphanumeric label to an object such as cues, channels, submasters,
etc.

[Label] [Label] when appended to a record target command, clears the current label. This
includes show file labels.

Editing Labels
The page arrow keys on the console or an external alphanumeric keyboard can be used to move
the cursor within a label to aid in editing.

• [Page Up] - takes the cursor to the beginning of the label
• [Page Down] - takes the cursor to the end of the label
• [Page Left] - moves the cursor to the left
• [Page Right] - moves the cursor to the right

Browser
The browser is the interface for numerous functions including saving a show, loading a show,
opening displays, and many other functions. Press [Displays] to open the browser. See Using the
Browser (below).

To learn more about saving and loading a show file, see About Managing Show Files (on
page 112) for more information.

Using the Browser
To use the browser, you must first draw focus to it by touching anywhere in the browser area of
the CIA. If the browser is not visible, pressing [Displays]>{Browser} will bring up the browser.

When focus is on the browser, the window border highlights in gold. The paging keys will now
control selection in the browser.
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• Use the page arrow keys to move the selection bar up and down the list. You may also use
the level wheel to scroll through the list.

• When the bar highlights the desired menu, press [Page Right] to open the menu.
• Continue pressing [Page Right] to open submenus.
• Scroll to the item you wish to open using [Page Up] or [Page Down], or select the item by

clicking or tapping. Press [Enter], [Select] , or double-click to open.
• If you wish to close a submenu scroll to that item and press [Page Left].
• Additional presses of [Displays] will minimize or restore the CIA.
• To draw focus to the browser at any time, press any area within it or press the [Displays]

button.

Note: File folders display with a folder icon beside their name.

Note: Previous versions of a showfile will be displayed in dark gray text. To see
previous versions of a showfile, you must click on the arrow to the left of the showfile
name or use [Page u] .

Note: The [Select] key can be used to confirm a choice in the browser.

Browser Color Coding
The following color coding for selected items is used in the browser:

• Save - green
• Save As - green
• Open - red
• Merge - yellow
• New -red
• Clear -red

Clear Functions
You can access the various clear options from the browser by selecting {Clear} from the main
browser menu. The clear functions window will open in the CIA.
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From this menu you can select one of the available clear options by clicking on the desired
button in the CIA. Eos will ask you for a confirmation before performing the selected clear. For
{Clear Targets}, Eos will allow you to choose which record targets you want to clear.

CAUTION: Clear functions cannot be undone by using the Undo option.

From the {Clear Targets} screen you can select which record targets you wish to clear. The
buttons at the center of the CIA represent all of the record targets that you can choose to clear.
By default all components are selected (gray) and will be cleared. To withhold any targets from
being cleared, simply deselect them in the CIA by clicking the respective button. To deselect all
of the targets, click the {Deselect All} button.

To reselect all targets, click the {Select All} button and all buttons will return to gray (selected).
To stop the process, click the {Cancel} button.

When you have selected or deselected all of the record targets you require, click {OK}.

After clearing, the CIA will return to the browser. If you want to perform additional clear
functions, you must select {Clear} from the browser again.

To exit the clear functions screen without clearing, press the [Displays] key at any time or select
a clear button and then select {Cancel} from the confirmation screen.

Reset System vs Clear Show
Using {Reset System} will open a new show file and reset the Setup options to their defaults.
Using {Clear Show} will only open a new show file.

Patch 1 to 1 vs Clear Patch
Using {Patch 1 to 1} will clear your patch and set it to a 1-to-1 patch. Using {Clear Patch} will
only clear out the patch.
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Locking the Face Panel
It is possible to lock out the face panel, which prevents any actions from the command line or
CIA. To lock out the face panel, press [Shift] & [Escape]. To unlock the face panel, press [Shift]
& [Escape] again.

Note: This will also lock any wings or USB connected peripherals.

Softkeys
Some of the features and displays of your Eos family console are accessible from the softkeys,
which are located under the Browser. Softkeys are indicated in documentation with bold
{braces}.

The softkeys are context sensitive, therefore they repaint to display softkeys relevant to the
display or command you are working with. The white labels on the bottom row indicate the
active softkeys. The gray labels in the top row indicate the second page of available softkeys,
available by pressing the [More SK] button.

On Element 2, those softkeys correspond to buttons [S1] - [S6] and [More SK] on the face
panel.

Example:
With a channel on the command line, pressing [More SK] & [Intensity] will post
Make Manual on the command line.

Changing Softkey Pages
When there are more relative softkeys than the six available buttons, both gray and white
softkey labels will be visible. The white labels on the bottom row of the label window indicate
the active softkeys. The gray labels in the top row indicate the second page of softkeys.

To access the second page of softkeys, press [More SK]. To access the previous softkeys, press
[More SK] again.

Displays
There are several terms that are useful to know when discussing the displays on your console:

• Monitors - refers to any physical monitor or touchscreen device connected to your
console. The monitor number will display in the upper left corner of the screen.

• Workspaces - offers independent display control on all of your connected monitors. Every
monitor can have up to three workspaces.

• Frames - offers layout options to your workspaces.
• Tabs - offers the ability to view multiple displays in one frame.
• Displays - are the individual views or tools available for use in programming your console.

They are viewed in tabs.

Eos has the ability to have one of three different workspaces active on individual monitors, as
well as to have up to four frames in use in any workspace. Each frame can hold multiple tabs.
Each tab contains one display.
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Workspaces
Workspaces offer independent display control on all of your connected monitors. Every monitor
can have up to three workspaces, identified by the workspace icons in the upper left corner of
any monitor.

You can use [Tab] & [Page Up] and [Tab] & [Page Down]to cycle through the workspaces. This
will increment or decrement the current workspace and will then force all of the other
workspaces to match the current workspace’s number (1, 2, or 3). This is so you can quickly step
through the workspaces.

Workspaces 1, 2, and 3

These three monitor icons are used to switch between each monitor’s available workspaces.
Each can be set up to include any of the desired layout, displays, and controls options offered on
the Home Screen. Double-clicking on any of the icons will jump all connected monitors to that
workspace number.

Workspace Access from the Command Line
A {Workspace} softkey is available by pressing [Displays]. Hold {Workspace} and type 1, 2, or 3
to go to that workspace.

Note: From an alphanumeric keyboard, hold down either of the bracket buttons
([ or ]) and type in the number of the workspace you wish to view. For example, hold
down [ and press 2 to view workspace 2.
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Frames
Each workspace can have up to four frames in its layout. The number of frames in a workspace
layout is determined by choosing the layout options offered in the Home Screen.

Tabs
Any frame can have multiple tabs open. Tabs are broken down into two categories: Control and
Display. Control tabs are the virtual control options, such as the color picker and the virtual
keyboard. Display tabs are the various displays available on the console, such as the playback
status display and the park display.

You can open or close tabs using the Display Icons, Control Icons, or typing the [Tab] & the tab
number. Pressing [Shift] & [Tab] once will clear all tabs on the selected monitor but tabs in
locked frames will remain. Pressing [Shift] and tapping [Tab]twice will clear all tabs on all
monitors but tabs in locked frames will remain. Tapping [Tab] a third time will clear all tabs on
all monitors including those in locked frames.

Tabs can be reordered by dragging the tab to its new location.

White text in the tab indicates a Display Tab, and magenta text indicates a Control Tab.

All Display and Control Tabs have fixed Tab Numbers under which they open (for example,
“Live” opens under Tab 1, “Patch” under Tab 12, and “Color Picker” under Tab 27).

These numbers are identified on the Home Screen in each icon. For multiple instances of the
same display, the tab number will be followed with a decimal number. Additional tabs will start
their numbering with n.2. When you press [Tab], active focus will move numerically through all
open tabs on active workspaces.

Note: Single clicking on a Controls Tab will bring it to the front of the frame but will
not move focus to that tab unless the tab’s frame already has focus. Double clicking on
a Controls Tab will bring it to the front and grab focus. Single clicking on a Display Tab
will bring it to the front and grab focus.

Tab Numbers
1. Live / Blind
2. Playback Status Display
3. Magic Sheet
4. Direct Selects
5. ML Controls
6. Effect Status
7. Virtual Keyboard
8. Effect Channels
9. Pixel Maps

10. Pixel Preview
11. Show Control
12. Patch
13. Effects
14. Magic Sheet List
15. Submaster List
16. Cue List
17. Groups
18. Macros
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19. Snapshots
20. Park
21. Curves
22. Intensity Palettes
23. Focus Palettes
24. Color Palettes
25. Beam Palettes
26. Presets
27. Color Picker
28. Virtual Faders
29. About
30. Command History
31. Lamp Controls
32. Channels In Use
33. Color Path

35. Fader List Display
36. Fader Configuration
37. sACN Output Viewer
38. Augment3d
39. Custom Direct Select
40. Encoder Mapping

99. Diagnostics
100. User Manual

Display Tabs
The following displays can be selected, and they will open in a new tab in the selected frame:

The following displays can have multiple instances open:

• Channel (Summary)
• Channel (Table)
• Playback Status Display
• Magic Sheet Display
• Effect Channels
• Park

For multiple instances of the same display, the tab number will be followed with a decimal
number. Additional tabs will start their numbering with #.2. If you have only one instance, there
will be no decimal number.
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Control Tabs
You can select from the following list of virtual controls, and they will open in a new tab in the
selected frame:

Tab Tools
Every frame has a tab tools menu gear icon in the lower left corner of the frame. Selecting this
icon will open the tab tools menu, which provides options for opening and closing tabs in that
frame.

You can double-click or right-click a tab in focus to also see this menu.

The following is a list of menu options. Not all options are available for every tab.

• Close Tab - closes the selected tab.
• Replace Tab - allows you to close the current tab and choose from the Home Screen

which display to replace it with. Pressing escape will return you to the previously selected
tab.

• Close All Tabs But This - closes all of the tabs except the selected one.
• Close All Tabs - closes all of the tabs including the selected one.
• Reset Columns - resets all of the column widths in the selected tab to Eos defaults. This

option will only be available for displays with columns.
• Lock Frame - prevents any additional tabs from being opened in the selected frame,

unless intentionally added with the display picker.
• Open New Tabs In This Frame - specifies that any new tabs opened will automatically

open in the specified frame. Only one frame can have this option selected at a time.
• Zoom Out and Zoom In - zooms the selected tab.
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Note: If the selected display has a configuration menu, it can be accessed from the
tab tools menu.

Display Control and Navigation

Opening and Closing Displays
Displays can be opened and closed in different ways, depending on the display. Many displays
are accessible from the browser, while other displays are accessible from the softkeys. The blind
displays of record targets (also called “lists”) can be quickly accessed by double pressing the
record target button (for example, [Cue] [Cue] opens the cue list index).

The Live/Blind display is open as tab 1. The playback status display is always open as tab 2.
Neither of these displays can be closed. Multiple instances of Live/Blind and PSD can be opened.

Every display has an assigned tab number. Tab numbering is useful for navigating to views. See
Tab Numbers (on page 61) for a list of displays and their tab numbers.

From the Home Screen
The Workspace Layout Menu (on the facing page) shows all of the available displays for quick
selection. Click on the {+} button by the tabs to access the home screen.

From the Browser
Open and navigate the browser as described in Using the Browser (on page 56) . You can open
record target lists, such as the preset list or cue list index, by navigating to Browser>
Record Target Lists.

Note: Any time you wish to return to the browser, simply press [Displays].

From the Hardkeys
You can open list views of any record target by double-pressing the key for the desired record
target (for example, [Cue] [Cue] opens the cue list index).

From the Softkeys
To open any displays accessible from the softkeys, press [Displays]. The softkeys will repaint to
display:

• Effect Status
• Color Picker
• Patch
• Setup
• Browser
• Magic Sheet
• Workspace
• Command History
• Curves
• Pixel Maps
• Show Control
• Mirror

Any of these softkeys will open the associated display with a single press.
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Closing Displays
To close any tab display, select the display by using the [Tab] key or other means of navigation.
When the desired display is active, press [Escape] to close it.

To close a display in the CIA, press the [Displays] key and the browser will reappear.

To close all displays except for the live/blind display and the playback status display (tabs 1 and
2), press [Shift] & [Tab].

You can also close tabs by using the Tab Tools. See Tab Tools (on page 63) for more
information.

Workspace Layout Menu
Upon start up or creation of a new show file, any connected monitor that is not already
displaying the Live (Tab 1) or Playback Status Displays (Tab 2) will show the Workspace Layout
Menu. This screen will also display when a new tab is opened.

This screen consists of four general areas, each offering different display-related options.

Display and Control Icons
Clicking on an icon will open the appropriate display or control in a new tab.

Display Tabs

Control Tabs

Layout Options
These tools offer you greater flexibility in the number of tabs you can view in any given
workspace. A workspace can have up to four frames. Selecting a layout icon will assign the
frame layout identified in the icon. Once a layout is assigned, you can select which displays and
controls will be in which frames.

This screen also offers options for opening and closing tabs as well as resizing and resetting the
monitor(s).
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Resize Frames In This Workspace

Select this icon to resize frames in any of the workspaces on the monitor. After selecting,
resizing tools will appear between frames of the workspace and you can select and drag the
resize tool icons to adjust sizing as needed.

Monitor Mapping

Select this icon to arrange your monitors without having to go into the ECU. This function allows
you better control of your snapshots (About Snapshots (on page 398)).

Click on a monitor to display the available numbers, and then click on the number to assign it.

Note: On-board touchscreens are locked, and their arrangement cannot be changed.

Close All Tabs In This Workspace

Select this icon to close all of the tabs in the active workspace on this monitor only.

Reset This Workspace

This icon will close all of the tabs and frames and will reset the layout for the active workspace
to a single frame displaying theWorkspace Layout Menu, from which you can select new tabs to
open.
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Reset ALL Monitors & Workspaces

This icon will close all of the tabs and frames on all monitors, reset all layouts to a single frame,
and return their workspaces to the Workspace Layout Menu, from which you can select new
tabs to open.
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Single Monitor Snapshots
The snapshots displayed here are single monitor-only snapshots recorded for the visible
workspace. For information about snapshots, see About Snapshots (on page 398). These
snapshots can be recalled from any selected monitor from the Workspace Layout Menu. You
can recall a monitor-only snapshot from the command line by using the syntax [Snapshot] [n]
[Enter]. When recalled from the command line, the selected snapshot will only affect the
monitor from which it was originally recorded.

To record a monitor-only snapshot, press the {New Snapshot} button on the Display Controls
menu screen. [Delete] [Snapshot] [n] [Enter] [Enter] will delete a monitor-only snapshot.

All snapshots can be viewed on the snapshot list display, which can be opened by pressing
[Snapshot] [Snapshot] or from the Workspace Layout Menu.

Updating a Single Monitor Snapshot

A single monitor snapshot can be updated or deleted by right-clicking on its icon in the Snapshot
area of the Workspace Layout Menu.

Using Expand With Displays
[Expand] allows you to quickly create additional frames on a monitor.

• To add frames, press [Expand] & [Page Right] or [Expand] & [Page Down].
• To collapse frames, press [Expand] & [Page Left] or [Expand] & [Page Up].

This button will expand the Live / Blind tab from one display screen to other screens as well. This
doubles the number of channels visible on any tab. Live, Blind, and Playback Status tabs may be
expanded.

• To expand the Live / Blind tab to up to two additional monitors, press [Expand] & [Page
Right]. Once you are in an expanded mode, hitting [Expand] contracts the tab by one
monitor.

• To remove all displays from the monitor, press [Expand] & [Page Left].

Scrolling within a Display
By default the page keys will advance / retreat a display by one page per press. However, to
activate scroll lock and scroll through displays, you may press [Shift] & [Stage]. SCROLL LOCK
will appear above the CIA when in scroll lock mode.

Scroll lock is a toggle state. When scroll lock is first pressed:

• [Page Up] - scrolls table, spreadsheet and channel views up
• [Page Down] - scrolls table, spreadsheet and channel views down
• [Page Left] - scrolls table and spreadsheet views left
• [Page Right] - scrolls table and spreadsheet views right

Selecting Displays
When a display is selected, the screen is highlighted in a gold border and the display name (such
as “1. Live Channel”) will be in gold as well. When a display is not selected, there is no border
and the tab name is gray.

If a display is already open, it can be selected in the following ways:

• Press [Tab] to change focus between open tabs in numerical order.
• Press [Tab] & [n], where “n” represents the tab number of the desired tab.
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• Press [Live] or [Blind] to automatically bring Live/ Blind into focus. If there are multiple
instances of Live/ Blind, pressing [Shift] & [Live] / [Blind] brings the next Live/ Blind tab
into focus.

• Double press a record target button (such as [Preset] or [Submaster]) to either open the
associated display or select it if it is already open.

Zooming Displays
You may zoom in and out on displays. To do this, press and hold the [Format] button and scroll
the Level Wheel to alter the display. Scrolling the wheel up zooms in. Scrolling the wheel down
zooms out. Zooming the channel summary display when it is in 100 channel mode is not
supported. You can also zoom by holding down the left mouse button and rolling the scroll
wheel on a mouse.

Moving Displays
To move the active display from one monitor to another, press and hold the [Tab] key and use
the page arrow keys to move the display in the direction of the desired screen. One press of the
left or right page keys will move the display to the next screen in that direction. To move it back,
press the opposite arrow key.

Clickable Displays
Several displays have click supported cells. Clicking on a cell will select and place it on the
command line. You can click on multiple cells to select a range of items. Double-clicking a row
header will select that row and deselect any other rows. In-Cell editing must be enabled in
Setup>Device>Displays. See In-Cell Editing (on page 182)

The following displays have clickable support:

• Show Control List
• Cue List
• Playback Status Display
• Palette Lists
• Sub List
• Preset List
• Effect List
• Group List
• Snapshot List
• Curve List
• Partition List
• Pixel Map List
• Magic Sheet List
• Park Address List
• Patch Display
• Spreadsheet Display
• Macro List

Quick Access
Quick Access tools are available at the top of each display.
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There are three icons:

• Wand - pop-up magic sheet
• Automated fixture beams - pop-up ML Controls
• Camera -pop-up Snapshots

Pop-up Magic Sheet
This option allows you to view a favorite magic sheet in a small pop-up window over your
current display. The pop-up magic sheet functions just like a traditional magic sheet and is
interactive. .

Press the wand icon to close the display when opened.

A pop-up magic sheet can be assigned in Setup>User>Displays>Popup Magic Sheet. If a magic
sheet has not been assigned in Setup, when you first click the pop-up magic sheet icon, you will
be able to select a default magic sheet from a list of the available ones.

In Setup>User>Displays>Popup Nav Lock, you can enable or disable the zoom and scroll
navigation for pop-up magic sheets. This option is enabled by default.

See About Magic Sheets (on page 412) for more information

Pop-up ML Controls
This option allows you quick access to the ML controls display in a small pop-up window over
your current display. See Moving Light Controls (on page 100) for more information about this
display.

Press the automated fixture beams icon to close the display when opened.

Pop-up Snapshots
This option displays your favorite snapshots in a small pop-up window for quick access. Select a
snapshot to recall it. Favorite is an option that can be selected or deselected when recording a
snapshot.

Press the camera icon to close the display when opened.

See About Snapshots (on page 398) for more information.

[Time] Key
Holding [About] and pressing [Time] allows you to view discrete timing data behind any channel
parameter. [Time] exposes channel or parameter specific timing for any channels in the current
cue. The first value is the delay time. If “--” is displayed, there is no delay. The value to the right
of the / is the transition time.

You can lock this mode by holding [About] and double tapping [Time]. When in display time
mode, “Display Timing” will display in the upper left of the live display. To exit this mode, press
[About] again.

[Data] Key
Pressing and holding [Data] allows you to view the values behind any referenced or marked
data. [Data] exposes the next lower reference level. So if you view a palette reference and
press [Data], the absolute data will be displayed instead. If you are viewing a preset, absolute or
palette data will be displayed, depending on what is contained in the preset.

You can lock this mode by pressing [Data] twice. When in display reference values mode, “Data
Latched” will display in the upper left of the live display. To exit this mode, press [Data] again
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View Reference Labels
Pressing and holding [About] & [Label] toggles the view to show reference labels or numbers
depending on what display setting is being used. See Show Reference Labels (on page 182)

Live and Blind Displays
The Live/ Blind display is open as tab 1. This display cannot be closed. Multiple instances of Live/
Blind can be opened.

When in Live, the data displayed represents the data being sent from the console at that
moment. In other words, the parameter data that is “live” on stage. When you edit data in live,
those changes will become active and visible on stage as soon as the command line is
terminated, unless auto playback has been disabled in Setup. See Auto Playback (on page 177)
for more information.

When in Blind, the data displayed represents data from the record target you choose to view
(cues, presets, palettes, and so on). When you edit data in Blind, changes will not automatically
appear on stage, since the data you are modifying is not live.

While in blind, the background color of the displays will be blue, the title bar will be bright blue,
and the word “Blind” will display in the top left corner of each monitor. You can click on “Blind”
to go back to live.

For more information on Live and Blind, see Live and Blind (on page 9)

Using [Format]
Live / Blind has multiple formats. When first opened, it opens in its default view, which is the
Table View (on the next page). The default view can be set in the Live and Blind Configuration
Menu (on page 78) . When the default format has been changed, those new settings will be
used whenever the display is changed back to that format.

Press [Format] to rotate through any available formats.

Live and Blind share formatting. When you change from one format to another format, you are
always working with the same format until you change it. The exception to this is Spreadsheet
(Blind Only) (on page 74), which is only available in blind. If you are working in blind
spreadsheet, when you return to live you will be working with the table or summary view, based
on which one you were last using.

Summary View
The summary view displays the largest number of channels of any of the formats. This format is
best used to see large numbers of channels’ intensity data and / or parameter category data.
Individual parameters are not visible in this view.

FCB icons will appear at the bottom of the channel area for channels that have those parameters
patched to them. See Indicators in the Live / Blind Display (on page 75) for more information.
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To collapse the summary view, hold down the [Params] key and press any parameter category
key.

On Element 2, to collapse the summary view, hold down [Data] and any of the parameter
category key in the parameter display (Focus, Color, Image, Shutter, or Form).

When the summary view has been collapsed to show only intensity data, you may include focus,
color, or beam data in the summary view by holding down the [Params] key and pressing any
parameter category key. This displays all categories again. On Element 2, you will need to use
[Data] .

Table View
Table view is available in Live or Blind. Unlike summary view, table view displays the fixture
type associated with channels and details about each channel’s category and parameter levels.
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In Live, table view displays all active channel data being output from Eos. In Blind, it will display
all data for a single record target (cue, preset, palette) depending on what is viewed. In table
view, focus, color, and beam information can be viewed in either a summary of these three
categories or an expanded view to show all parameter data.

To expand a category to show detail, press the [Data] or [Params] key and the associated
parameter key. On Element 2, you will need to use [Data] . For example, [Data] [Color] will
change the color category from a summary view to a detailed one. To collapse a category. press
the [Data] or [Params] key and the associated parameter key. You cannot hide a category from
view.

When a category has been expanded, to hide or reveal only certain parameters, press and hold
[Data] or [Params] and then select the parameter buttons of the appropriate parameters in the
CIA. The parameters will be displayed or suppressed depending on the current view.

Notice that when you hold down the [Data] or [Params] button, the buttons of parameters that
are currently selected for viewing will be highlighted in the CIA.

In the table, a slight space is provided between fixture types, giving a clear delineation between
them. The name of the fixture type is displayed at the top of the section for that fixture.

Channels with only intensity parameters will display the same as in summary view.

Preview Mode in Live
A {Preview} softkey is available when in Live Summary.

Note: {Preview} is not available in Live Table.

{Preview} allows you to display the intensity values for another cue under the current values in
the Live Summary tab. An indicator of what Preview mode you are in will display in the upper
left hand corner of the Live Summary display.

In {Preview} mode, the following softkeys are available:

• {Previous} - previews the last cue run from the selected cue list.
• {Pending} - previews the pending cue from the selected cue list.

The following examples show other functions that are available in Preview:

• {Preview}[Next] will allow you to preview the cue higher than the one currently selected.
If there is no cue already selected in preview mode, [Next] will behave the same as
{Pending}.

• {Preview}[Last] will allow you to preview the cue lower than the one currently selected. If
there is no cue already selected in preview mode, [Last] will behave the same as
{Previous}.

• {Preview}<Cue>[5] will preview cue 5.



74 Eos Ti, Gio, Gio @5, Ion Xe, Ion Xe 20, and Element 2 Operations Manual

Channels in Use
To open the Channels in Use display, click on the {CIU} icon in the home screen or press [Tab] &
[3][2].

A Channels in Use display shows the following information for each channel:

• Number of cue lists the channel appears in.
• Number of cues the channel appears in.
• Number of cue moves from zero.
• Number of submasters that channel appears in.
• Maximum channel level.

Note: Right-click on the CIU tab to limit see which channels are used with a specified
cue list.

Spreadsheet (Blind Only)
Spreadsheet format is available only in blind mode. It is useful for viewing channel data and
trends for multiple cues, submasters, palettes, or presets at one time. Cues/ record targets are
displayed on the vertical axis and channel/ parameter data is visible on the horizontal axis.

Note: Since this is a blind-only view, changes made in this view are immediate and
do not require a record or update.
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As with table view, spreadsheet format allows you to choose exactly which parameters you want
to view. Parameters can be expanded/ suppressed by holding [Params] or [Data] and pressing
the desired parameter buttons in the CIA. Category data is not available in spreadsheet, but you
may hide all parameters of a specific category by holding [Params] or [Data] and pressing the
desired parameter category button. On Element 2, you will need to use [Data] .

To toggle between viewing just the intensity information and other parameters, press [Shift] &
[Format].

The label column can be hidden by checking the Suppress Target Labels option in the Live and
Blind configuration menu. For more information, see Live and Blind Configuration Menu (on
page 78)

Indicators in the Live / Blind Display
This section identifies the conventions used to indicate various conditions in Live and Blind.

This is the Live / Blind summary view. Please note examples of color and text indicators in the
following graphic:

Note: The color and text conventions apply regardless of the format of Live/ Blind
being used (see Using [Format] (on page 71)).

Note: When manual channels are used, there will be an advisory that says "Manual
Channels" in red in the upper left hand corner of any Live display.

Most of the channels in the above image are conventional channels (intensity is the only
available parameter).

Several channels in the image are automated fixtures (possessing more parameters than just
intensity).

Conventionals

Conventions display the channel number, intensity, and any additional data below.
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Automated Fixtures or Multi-parameter Devices

This view also has additional data fields beneath intensity (F, C, B). This information can be
suppressed by pressing [Params] and any parameter category (Focus, Color, or Beam) in the
CIA. Doing so will leave only the intensity field and FCB indicators at the bottom of the channel.

Multicell Devices

Multicell devices display the channel number broken into decimals, based on how many cells
the device has. Multicell fixtures can be controlled as an entire fixture, individual cells, or a
combination of cells. Parameter data can also be suppressed in the same way as automated
fixtures.

You can use flexichannel modes to hide cells or master channels. See Using Flexichannel (on
page 79) for more information.

When in Flexi Cells Off mode, the master channel will display its own information in the normal
font size, and data indicators will be used for the cells. If all of the cells are at the same value,
that value will display. If the majority of the cells are at the same value, that value will be
displayed with a superscript plus sign. If there is not a majority, just a plus sign will be used.

Note: A decimal will display at the end of a master channel when flexi cells off is on.

Color Indicators
Eos uses color to indicate the selection state and information about channel/parameter levels.

Channel Numbers/ Channel Headers

• Gray number Unpatched channel number.
• White number Selected channel number.
• Bright white number Channel is parked.
• Gold number Channel is captured.
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• Gold outline Selected channel.
• Number with no graphic Deleted channel.

Channel/ Parameter Levels
• Bright Red Manual Data (any data that has been set but not yet stored to an active cue or

submaster) on all consoles using the same user ID. When manual channels are used, there
will be an advisory that says "Manual Channels" in red in the upper left hand corner of
any Live display.

• Dark Red Manual Data (any data that has been set but not yet stored to an active cue or
submaster) from other consoles that are using different user IDs.

• Blue The intensity value is higher than in the previous cue.Non-intensity parameters (NPs)
are in blue when any move instruction has occurred. Unmarked.

• Green The intensity value is lower than in the previous cue.Also used in reference
marking to indicate a channel is marked.

• Magenta Value is unchanged from the previous cue (tracked).
• White The value is blocked.
• White with an underscore Value is auto-blocked.
• Gray Default or the value is a null value (from either {Make Null} or a filter). When nulled,

a gray “n” appears next to the value.
• Yellow Data set from a submaster.
• Orange Data set from Staging Mode.

Note: When data is in transition (moving), it will appear in a lighter version of its
color. This includes up/down fades for intensity, non-intensity moves from cues,
submaster, and timed manual changes.

Text Indicators in Live/Blind
Text indicators are used to show additional channel data.

Note: Color indicators also apply to text indicators. For example, red indicates a
manual value that must be stored. See Color Indicators (on the previous page)

• _ Underlined value (white) indicates a system-applied block (also called an auto-block).
• + Found in place of parameter data in summary view. Indicates that not all parameters in

that category are at the same value. This indicator is found only in the summary view or in
table views when the parameters are collapsed into a category view. If a majority of the
values are the same, that value will be displayed along with the indicator. If there is no
majority, just the indicator will be displayed.

• ! Indicates an ACN, RDM, or dimmer warning.
• ? Indicates an ACN, RDM, or dimmer error.
• A Indicates the channel or parameter is asserted.
• B Indicates the channel or parameter is manually blocked. This block must be stored.
• C Captured channel if in yellow. Color Path if in any other color.
• I Channel is controlled by an inhibitive submaster. When displayed in the Block flag, “I”

indicates a cue level intensity block.
• IP, CP, FP, BP Indicates that the value is referenced to a palette (Intensity, Color, Focus,

or Beam). This text is followed by a number, indicating which palette is being referenced.
This can be substituted with the palette label if the “Show Reference Label” setting is
activated (see Show Reference Labels (on page 182)). Holding down [About] & [Label]
will toggle between the palette label and palette number.

• M Indicates a mark is placed, but manual, and must be stored. Is blue when stored.”m”
indicates cue is not marking.
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• MK Indicates the channel is marked for a later cue. The cue number is indicated in the
other categories (see “Q” below).

• ND Indicates that a channel has been patched as a non-dim fixture type.
• N Indicates the value is null (from either {Make Null} or a filter).
• P Indicates the channel is parked.
• Ph Indicates the channel is at a preheat level.
• Pr Indicates that the value is referenced to a preset. This text is followed by a number,

indicating which preset is being referenced. The preset label may also be shown if this
setting is enabled (see Show Reference Labels (on page 182)). Holding down [Shift] &
[Label] will toggle between the preset label and preset number.

• Q Found in the non-intensity categories of a marked channel. The “Q” is followed by a
number indicating which cue the mark is in preparation for.

• t The channel has discrete (parameter/category-specific) timing.
• S Indicates that a channel is stored to a shielded submaster.
• R Indicates a manual reference override. Manual changes have been made that override a

previously stored reference (such as to a palette or preset). Once recorded, the reference
will be broken. If updated, the referenced target will be updated as well, unless otherwise
instructed.

Live and Blind Configuration Menu
The Live/ Blind displays have a configuration menu. The configuration settings are available by
selecting the display tab and then double clicking on the tab to open the menu. With the Live/
Blind display selected, you can also select the gear icon, which is located to the left of the tabs,
to open the configuration menu.

Note: Each instance of Live/ Blind may be configured individually.

The following options are available:

• Suppress Target Status Bar - Hides the target status bar from the display. The target
status bar displays at the bottom of the Live/ Blind displays.

• MC Line Wrap - When enabled, this option keeps all of the cells together of a multicell
fixture when viewing it in Live summary view instead of breaking them up across multiple
rows.

• Suppress Target Labels - Hides the Label column in Blind spreadsheet view.
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• Show Reference Labels - When enabled, referenced record targets (such as presets or
palettes) with labels will have their labels displayed rather than their target type and
number. This setting will only affect the selected instance of Live/ Blind. There is an option
in setup, which determines the default that will be used when tabs are opened. It is
modified from there in the configuration menu. See Show Reference Labels (on
page 182).

Note: [About] & [Label] can be used to temporally toggle between views.

• Group Channels By 5 - When enabled, five channels are grouped together with space
separating each group of five. This setting is enabled by default.

• High Contrast - When enabled, high contrast brightens the magenta used to show tracked
values. This setting is enabled by default.

• Disable 100 Channel Display Mode - Disables 100 Channel Display Mode (default).
• Enable 100 Channel Display Mode - 5x20 - Enables 100 Channel Display Mode, in 5 rows

of 20 channels.
• Enable 100 Channel Display Mode - 4x25 - Enables 100 Channel Display Mode, in 4 rows

of 25 channels.

Default
You can save your settings as a default state for Live/Blind. The default is identified with
parentheses.

• Reset to Default - Will restore the settings to the default state. Live/ blind tabs will
normally default to the settings for Tab 1.0, if no other tab has been assigned as default.

• Set Current as Default - Allows you to set a Live/ Blind tab other than 1.0 as the default.
The default tab will be shown in parentheses , for example (Tab 1).

• Reset to Eos Default - Restores the settings to Eos defaults.

Using Flexichannel
Flexichannel (use of the [Flexi] key) allows you to view only channels meeting a certain criteria
in the Live/ Blind display, therefore removing unwanted data from view. Press and hold [Flexi] to
see and select from a list of available states and modes in the CIA. You can also press [Flexi]
multiple times to cycle through the list of available states.

Flexichannel has several available states which include allowing you to view only:

• All channels
• All patched channels
• Manual channels
• All show channels (any channels that have data stored in a cue or submaster)
• Active channels (channels with intensity above zero or a move instruction)
• In Use Channels (channels with intensities that are above zero or fading to zero, running

effects, non-intensity moves, or marking.)
• Selected channels
• Channels with discrete timing

There are three Flexichannel modes, which can be used along with the Flexichannel states:

• Cells off (displays only the master channels for multicell fixtures. Master channels will
display with a "." after the channel number to indicate that they have cells hidden.)

• Masters Off (displays only the cells for multicell fixtures)
• Partitioned (displays only those channels defined in the current partition)
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Note: The multicell fixture views can be used in combination with other flexichannel
states.

Note: You can use [Flexi] & [.] to quickly toggle cells on and off.

In flexi, selected channels (including the last channel selection) are always included in the view.
Gaps in channel numbers are indicated by a vertical line between the channels where a gap in
numbering occurs.

To change flexi states in the Live/Blind display, press [Flexi] to cycle through the views listed
above. When [Flexi] is held down, the softkeys change to represent all of the available flexi
states and modes. You can select the desired flexi view from those keys.

[Next/Last] can be used to select the next or last channel in the current flexi state.

[Thru] can be used to view only channels in the current flexi state (except for selected channels)
as long as either the first or last channel in the [Thru] range is included in the current flexi state.
To include channels not in the current flexi state, [Thru] [Thru] can be used.

View Channels
You may select specific channels to appear in another flexichannel state called “View
Channels”. This state does not exist until you select channels to view. After view channels is
activated, it will appear in the rotation of flexichannel states when [Flexi] is pressed.

To select channels to view:

1. Select channels on the command line (do not press [Enter]).
2. Press and hold [Flexi].
3. Press {View Chans}. The “View Channels” flexi state will be created and the channels you

selected will be visible in it.

The channels you selected will be visible in this flexi state until you select other channels and
press {View Chans} again. At any time, you can access the last channels you defined for this
state by pressing [Flexi] until this state is visible.

To redefine the selected channels in the state, simply follow the steps above again.

Flexichannel with Timing
You may also engage the “channels with timing” flexichannel state by pressing [Flexi] &
[Time]. This will display all channels that have discrete timing in the current cue and will remove
channels without discrete timing from view.

You may still hold [Time] on Eos or double press [Time] on Eos Ti and Gio to view the discrete
time behind any parameter or category.

The display will remain in this state until you disengage it by pressing [Flexi] again.

About & Display Toggles
While in Live/Blind, you can use the [About] key to view additional information.

When in an [About] mode, the mode type will display in the upper left hand corner of the Live/
Blind display.

The following is a list of the [About] modes available in the Live/ Blind displays:
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Note: Hold [About] and double tap the modifier key to latch the mode.

• [About] & [Live] - displays the DMX levels.
• [About] & [Data] - displays the background level information.
• [About] & [Address] - displays the DMX address for each parameter.
• [About] & [Park] - displays the parked levels.
• [About] & [Part] - displays the cue part number for each parameter.
• [About] & [Cue] - displays the source target type and number. For cues, the cue list and

cue number that contained the last move will display.
• [About] & [Mark] - displays the mark cue used by the channels.
• [About] & [Next]/[Last] - displays the next cue with that the channels move in or the last

cue with that the channels moved in.
• [About] & [Label] - displays the reference labels.
• [About] & [Time] - displays the discrete time.
• [About] & [Path]/{Color Path} - displays the color paths.

Note: To page while in these modes, release the modifier key while keeping [About]
held down.

Playback Status Display
The playback status display (PSD) allows you to view a range of cues in the current cue list, all
cue attributes for those cues, and a view of the fader configurations for 10 pages of 10 faders
each (for a total of 100 visible faders.

On Element 2, the playback status display (PSD) allows you to view a range of cues in the cue
list and all the cue attributes for those cues. Fader information can be viewed in the fader status
display .

The PSD opens on Tab 2. This display cannot be closed, but you can have multiple instances of
the PSD open on different tabs.

Holding down [Time] (the one by [Data]), while a cue is fading, will display the cue category
times counting down in the cue list display area. The default action is to show the total time not
the countdown.

To always show the countdown, a {PSD Time Countdown} option is available in PSD
configuration menu (see Playback Status Display Configuration (on page 85)). When the {PSD
Time Countdown} is enabled, the cue category times will countdown as a cue is fading. To see
the total time, hold down the [Time] key. {PSD Time Countdown} is “disabled” by default.

There are three formats for the playback status display on all consoles except Element 2:

• Expanded Cue List Format (below)
• Split Playback Status Display (on the next page)
• Fader Display Format (on the next page)

By default, it will be an expanded cue list format. When the focus is on the playback status
display, press [Format] to toggle between the formats.

Expanded Cue List Format
Pressing [Format] with the playback status display active will access this format. In expanded
cue list, the view of the active cue list increases to the full size of the display. The current fader
page is visible at the bottom of the screen.
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Fader Display Format
Pressing [Format] with the playback status display active will access this format, which shows a
view of the fader configurations for 10 pages of 10 faders each (for a total of 100 visible faders.

Each fader is color coded based on its assigned target type. Grandmasters and inhibitive
submasters are in red, additive submasters are yellow ,playback faders display in green ,and
presets and palettes are orange.

Split Playback Status Display
Pressing [Format] with the playback status display active will access this format. With the
playback status display split, two different cue lists can be displayed at the same time. This is set
in the configuration menu (see Playback Status Display Configuration (on page 85) for more
information).

Note: The first time you access the split playback status display, you may need to
adjust the splitter bar between the two lists to see the second list.
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Paging the Playback Status Display
[Page ▲ ] or [Page ▼ ] will page the display up or down.

Note: To page the Playback Status Display (PSD) if focus is on a Live/Blind tab, use
[Shift] & [Page ▲ ] or [Shift] & [Page ▼ ].

Note: This action will page the PSD that is showing the currently selected cue list. If
there is no PSD visible showing that cue list, nothing will be paged.

Indicators in the Playback Status Display
This section identifies the color and text conventions used to indicate various playback
conditions.

Color Indicators
Cue List

• Gold - Any item (cue, list, page) highlighted in gold indicates “current”.Outlined in gold
indicates “selected”.

• Red - Cue fade is in progress

Fader Ribbon / Display
• Red - Grandmasters and inhibitive submasters
• Yellow - Additive submasters
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• Green - Playback faders
• Orange - Presets and palettes

Text Indicators
• + (see cue 6) - Indicates that there is discrete timing within the associated cue. Found in

the cue display “Timing” area.
• * (see cue 4) - Indicates the cue has an allfade command. Found in the cue display

“Flags” area.
• * - Indicates a link to a non-existent cue. Found in the cue display "Link" area.
• D - Indicates a dark move, a cue that has any non-intensity parameters moving on

channels whose intensity is at 0. Found in the cue display “Flags” area in the move
column.

• x - Indicates that a mark has been placed, but the mark is broken.
• A or a (see cues 3 & 4) - Indicates an asserted cue. “A” indicates the entire cue is

asserted. “a” indicates a channel or parameter assert only. Found in the cue display
“Flags” area.

• B or b (see cues 2 & 5) - Indicates a blocked cue. “B” indicates the entire cue is blocked.
“b” indicates a channel/ parameter block only. Found in the cue display “Flags” area.

• F1 - F10 - Indicate faders numbered 1 through 10 on the console. Found at the bottom of
the fader display.

• > - Indicates a cue with a follow or hang time. Found to the left of the cue number.
• F5 (see in cue 1) - Indicates a follow time associated with the cue (in this case, 9 seconds).

Found in the cue display.
• H3 (see cue 2) - Indicates a hang time associated with the cue (in this case 4 seconds).

Found in the cue display.
• I - Indicates an intensity blocked cue. Found in the cue display “Flags” area.
• L - Indicates a live move. A “+” is used to show that both types of moves are in that cue.
• M or m (see cue 1) - Indicates a marked cue. “M” indicates an AutoMark or a reference

mark that is used by a subsequent cue. “m” indicates a reference mark that is currently
unused by any subsequent cue (see About Mark (on page 230)). Found in the “Flags”
area.

• P (see cue 3) - Indicates the cue will preheat. Found in the cue display “Flags” area.
• R (see cue 8) - Indicates the source cue which refers back to an earlier mark (see

Referenced Marks (on page 231)). Found in the cue display “Flags” area.
• Number in the FX column (see in cue 1) - Indicates a cue level effects override.
• M1(see in cue 3) - Indicates a linked macro.
• Q2/1 (see in cue 6) - Indicates a linked cue.
• S1 (see in cue 1) - Indicates a linked string. The string will display here.
• Relay 1/1 (see in cue 8) - Indicates a linked relay.

Note: The playback status display will show a red counter for sneak time.

Note: If any show control options are currently enabled in Setup>System>Show
Control, they will display at the top of the Playback Status Display.

For more details on information contained in the playback status display, see Playback Status
Display (on page 81).
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Playback Status Display Configuration
Playback Status Display (PSD) has a configuration menu, which is accessed by double clicking or
right-clicking on the PSD tab, or by selecting the gear icon, and clicking PSD.

The following options are available in the PSD Configuration Menu:

• Target Grid - this option is only available when the PSD is split, and is used along with the
Lock Status option. Target Grid allows you to select either the top or bottom display. Press
[Format] to split the PSD.

• Lock Status - allows you to lock the PSD to a certain cue list. When the PSD is split, you
will use Target Grid to first select top or bottom of the display, and then you can use Lock
Status to select the cue list.

Note: Phantom cue lists will display but cannot be locked to. See Cue List
Properties (on page 291) to learn more about phantom cue lists.

• Display Cue Parts - displays the individual parts of a part cue. When not enabled, the
number of parts for that cue will display as a superscript number beside the cue's number.

• Display Cue Links - displays the Link / Loop information.
• Display Scenes - displays cue scene information.
• Display Follow/ Hang Indicator - displays the Follow/ Hang arrow indicator before the cue

number of any cue that will be triggered by a follow or hang.
• Display PSD Time Countdown - displays the cue category times countdown in the PSD as

a cue is fading.
• Display Master Playback Status - displays the current cue's status information.
• Display Fader Ribbon - displays the fader ribbon, which shows the current fader page

under the Master Playback Status. Not available on Element 2.

• Display Notes - displays the Cue Notes in a horizontal bar at the bottom of the PSD.
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• Display Pending Cue Notes - displays the Cue Notes for the pending cue in a horizontal
bar at the bottom of the PSD.

• Break Link to Live/ Blind - When selecting the Live/ Blind display, the PSD will also come
into view if it is currently hidden. This option allows you to break the link between the PSD
and the Live/ Blind displays so that the PSD will no longer come into view when selecting
Live/ Blind.

Reorder Columns
Reorder columns allows you choose what data displays in the PSD and what order it displays in.
By default, all columns except notes will be displayed. The arrow keys on the right can be used
to move columns around. Columns are moved in groups. To select a column header to move,
click or tap the name. The check boxes suppress or enable. When an item is enabled to display,
a check mark will be in the corresponding box.

Default
You can save your settings as a default state for the PSD. The default PSD is identified with
parentheses.

• Reset to Default - returns the settings to the default state that you created.
• Set Current as Default - uses the current settings to create a default state. The default tab

will be shown in parentheses , for example (Tab 2).
• Reset to Eos Default - returns all settings to the Eos defaults.

Direct Selects
Direct selects utilize lists of existing show file components (targets) and assign them to a highly-
configurable grid of buttons. Direct selects can be used to quickly access those targets, allowing
you to easily interact with them, including placing them on the command line.

To open the direct selects, use the direct selects icon on the Workspace Layout Menu (on
page 65) or [Tab] [4]. Direct selects for specific targets can then be opened using the
corresponding button.

Using Direct Selects
Direct selects can be used to quickly access show file targets, allowing you to easily interact
with them in a variety of ways.

Note: Many buttons referenced in this section can be configured to appear or
disappear from the direct select tab. See Configuring Direct Selects (on page 89) for
more information.

When you first open the direct selects tab, you will be presented with one or more banks that
can be used to control specified targets.
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Targets are specific elements of your show file that can be assigned to direct select buttons.
With the exception of custom direct selects, only one target type can open in a direct select
bank.

Select a target type to open direct select buttons for that target. You can then use the direct
select buttons to select and control the chosen target.

Custom Direct Selects

Custom direct selects allow you to assign multiple target types to the same grid layout. If
{Custom} is selected on the direct selects tab, a popup will appear showing all available custom
direct select lists in your show file.

Once a custom direct select list is open, selecting an empty button will display a popup of the
Target Selection Menu (2) (on page 91), allowing you to quickly assign a target or range of
targets.

Note: While applying a target range will configure multiple buttons, multiple-button-
selection is only available via the custom direct selects editor in Tab 39.

For more information, see Custom Direct Selects (on page 91).

Navigating Direct Selects
To change the direct select type displayed in a bank, press {Select}, and choose the desired
direct select target to display.

If there are more items in a direct select bank than can be viewed at once, you may view
subsequent pages by using the {Page Up} and {Page Down} arrows. The {Jump To...} button can
be used to jump to a specific direct select.

Direct Selects & the Command Line
With the exception of channels and groups, all targets selected via direct selects will post a
terminated command on the command line. To post an unterminated command, hold [Shift] as
you press the direct select. This allows multiple commands to be selected and executed at once,
and an optional sneak time to be entered.

Channels and groups selected via direct selects will post an unterminated command by default.

Recording to Targets Using Direct Selects

You may store a command line selection directly to a target's direct selects by pressing [Record]
and the desired direct select key.
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You can record decimal inserts to a direct select, which will add additional buttons to your direct
select grid. All recorded targets will appear in numerical order in a direct select grid, including
those with decimals in their number.

Example:
Open a color palettes direct select bank with color palette 1 on button 1 and
color palette 2 on button 2. Record color palette 1.5. A direct select button will
be inserted between buttons 1 and 2.

Use the {Increment} setting in the Configuring Direct Selects (on the facing page) to set the
granularity for displaying empty target buttons. Decimal targets will always be displayed,
regardless of increment setting.

Direct Select Button Indication

The appearance of direct select buttons will change depending on what is selected via the
command line.

If a target is on the command line, the corresponding direct select tile will be outlined in gold.

Example:
Open a direct select bank displaying groups. Type [Group[ [1] [Enter]. The
group 1 direct select button will be outlined in gold.

If channels are selected via the command line, and any direct select targets contain all of those
channels, the direct select button(s) will be highlighted.

Example:
Record preset 1, containing channels 1-10. Open a direct select bank displaying
presets. Type [1] [Thru] [10] [Enter]. The preset 1 direct select button will be
highlighted gray.

If channels are selected via the command line, and any direct select targets contain some but
not all of those channels, the direct select button(s) will be highlighted with a gradient.
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Example:
Record beam palette 5, containing channels 10-20. Open a direct select bank
displaying beam palettes. Type [1] [Thru] [20] [Enter]. The beam palette 5
direct select button will be highlighted with a gradient.

Configuring Direct Selects
The appearance of direct selects onscreen is highly customizable.

Direct Selects Configuration Menu
The primary way to configure direct selects is via the direct selects configuration menu. To
access the menu, right-click or tap on the direct selects tab, or use the gear icon on the left of
the tab bar.

The following options are available:

• # of Banks - sets the number of direct select banks that will display in the tab.

If multiple banks are selected, a drop-down menu will appear, allowing you to apply all of the
additional configuration options below to a specific bank, or all open banks. Asterisks next to
any of the additional configuration options indicate functions that are only enabled for specific
banks.

Layout

This section allows you to configure the layout of the direct selects grid.
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Note: If the frame or window is resized, the direct selects grid layout will responsively
change size to fit onscreen.

• {25} / {50} / {100} / {200} - quick-select options to easily set the grid size.
• Rows - allows you to select the number of rows in the banks.
• Columns - allows you to select the number of columns in the banks.

Control Buttons

This section allows you to configure which optional control buttons will appear alongside the
direct selects grid. The checkboxes on the left toggle whether a button appears in the grid. The
buttons that appear on the right allow you to use that function directly from the configuration
menu without having to add the button alongside the direct selects grid.

• Control Button Position - allows you to set the control buttons to display on the left or
right side of the banks.

• Use Record - displays the {Record} button, which posts Record to the command line.
• Use Select - displays the {Select} button, which will display the selected direct select type.

Pressing it will allow you to select a different direct select type.
• Use Flexi - displays the {Flexi} button. See Using Flexi Mode (below)
• Use Expand - displays the {Expand} button, which will temporarily cover all other banks

with the expanded target.
• Use Arrows - displays the page up and down arrows.
• Use Millennium Buttons - displays the century and millennium buttons. These buttons

allow you to jump to pages in the hundreds and thousands.
• Use Jump To... - displays the {Jump To} button, allowing you to jump to specific target

numbers.
• Page - allows you to jump to a specific page of direct selects.

Other
• Increment - all recorded targets will display in numerical order, including those containing

decimals. Increment sets the target granularity of the grid, allowing blank decimal targets
to be shown between whole-number targets.

• Icon Position - configures the location of the icon on the direct select tile. Centered will
apply the icon to the entire tile. See Icons (on page 93) for more information about
assigning icons.

• Icon Opacity - configures the opacity of the icon from 0-100. 75 is the default. Lower
opacities may allow the direct select label to be more visible in front of the icon.

• Skip Empty Flexi Space - removes the empty space between a range of nonsequential
target buttons when in flexi mode.

• Use Color Swatch - displays a triangular color swatch in the lower left corner of a direct
select. Color swatches are available for color palettes, macros, and snapshots only.

• Maximize Button Size - sets the size of the direct select buttons to fill the available space.
• {Reset to Default} - will restore the settings to the default state. If no default state has

been set, the Eos default settings will be used.
• {Set Current as Default} - allows you to set the current settings to be used as a default

state when opening additional direct select tabs.
• {Reset to Eos Default} - restores the settings to Eos defaults.
• {Reset Current Bank} - restores the settings of the currently-selected bank only.

Using Flexi Mode
Direct selects can be placed into a flexi mode. {Use Flexi} needs to be enabled in the direct
selects configuration menu. Once enabled, the {Flexi} button will display alongside the direct
selects grid. This mode removes most of the empty buttons from the grid, but leaves a single
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blank tile between ranges. {Skip Empty Flexi Space} will remove this blank tile.

When in flexi mode, the {Flexi} button will be outlined in gold.

Custom Direct Selects
Whereas direct selects display lists of specific target types, custom direct selects allow you to
create a list with individual targets, regardless of type. The custom direct selects editor allows
you to choose the targets used in these lists, and apply them to a configurable grid.

To open the custom direct selects editor, select the custom direct selects icon on the Workspace
Layout Menu (on page 65), or use [Tab] [3] [9]. You can also choose {Custom} on the direct
selects tab, and then selecting {Open Custom DS Editor}.

The editor is divided into a preview of your custom direct selects grid, a target selection menu
for configuring buttons, and an index of all custom direct select lists in your show file.

Custom direct select lists can be any number between 0.001 and 9999.999.

Preview (1)
This section displays the custom direct select list, laid out on a customizable grid for you to
preview layouts. The options at the top allow you to adjust the number or rows and / or columns
in your custom direct select grid, or choose from preset grid layouts.

Target Selection Menu (2)
This section allows you to configure which direct select targets are assigned to your custom
direct select buttons. All buttons default to empty.

Custom Direct Selects (3)
This section displays an index of all the custom direct select lists in your show file. These lists can
be assigned a label, as well as an icon.
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Note: Custom direct selects created in Eos software prior to v3.1.0 and stored in
snapshots will be automatically converted to a custom direct select list, labeled with the
relevant snapshot number.

Configuring Custom Direct Selects
To assign targets to your custom direct select list, select one or more buttons in the grid.
Multiple buttons can be selected at once by selecting sequentially, or dragging a marquee.

Note: The order in which the buttons are selected will determine the order that
targets are applied to those buttons.

Once the desired buttons are selected, choose a direct select target to assign to those buttons.
You must define a starting number for the selected target. When a single button is selected,
defining an ending number will assign that range of targets to the grid, starting with the selected
button.

Example:
Selecting Button 1 and the Channels target with a range starting at 10 and
ending at 14 will assign Channels 10-14 to Buttons 1-5.

When multiple buttons are selected, the same number of targets as buttons selected will be
assigned. You can define an offset instead of an end to distribute targets evenly across the
selected buttons.

Example:
Selecting Buttons 11-15 and the Presets target starting at 1 with offset 2 will
assign Presets 1, 3, 5, 7, and 9 to Buttons 11-15.

Select {Apply} to assign the specified target(s) to the specified button(s). The specified target(s)
can also be copied to additional buttons in any custom direct select list using {Copy} and
{Paste}. Once {Copy} is selected, the targets to be copied will be noted at the bottom of the
target selection menu.

Checking the "Include Non-Existant Whole Number Targets" box allows you to map buttons for
targets that do not exist yet. If the box is left unchecked, only existing targets will be mapped.
This box is checked by default.

Buttons on Custom Direct Selects

This target, unique to custom direct selects, allows you to place console buttons on your custom
direct select grid. The following options are available:

• Console Button - duplicates the functionality of any console hard key or soft key
• Jump To - a button allowing you to jump to a defineable spot in any custom direct select

list
• Type [#] to jump within the same list, or [#] [/] [#] to jump to a specific custom direct

select list and button number

• Next Page/Prev Page - a button allowing you to jump to the next or previous page in your
current custom direct select list

Assigning Icons

Icons can be assigned via the softkey {Icon}, or by clicking on the Icon field in the target table.
This opens the icon library.
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Any existing icons in your library will appear first, along with stock icons. You can also access
additional default icons using the additional tabs below the icon library. Common fixture icons
are available in the adjacent tab to the right. Select an icon to assign it to the specified target.
To close the icon library, clear the command line, or select Close.

For more information, see Icons (below).

Clearing Custom Direct Selects
You can clear a custom direct select by selecting the button(s) and pressing the {Delete}. You
can also hold down [Escape] and press the direct select that you want to clear.

To delete a custom direct select list, use [Delete] [#] [Enter] [Enter], where [#] is the list
number.

Icons
Icons are images that can be applied in various places throughout Eos to customize your
workspace.

Any targets that can be applied to a direct select (other than channels and scenes) can be
assigned an icon, which can be configured to appear on the direct select button in Direct Selects
(Tab 4) or Custom Direct Selects (Tab 39). See Custom Direct Selects (on page 91) and
Configuring Direct Selects (on page 89).

Icons can also be added and configured as magic sheet objects. See Magic Sheet Icon Library
(on page 424).

Importing Icons
Select the Import button to add new icons to the library. Use the pop-up menu to navigate to the
appropriate folder, select one or more images, and select OK. SHIFT or CTRL can be held to
select multiple consecutive or nonconsecutive images.

Accepted image formats for import are .bmp, .gif, .ico, .jpg, .pbm, .pgm, .png, .ppm, .svg,
.svgz, .tga, .tiff, .xbm, and .xpm. The maximum image size is 1920 x 1920.
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Organizing Icons

Select the Organize button to enable the following additional button options:

• Add Folder - adds a folder to the current icon library directory.
• Delete Unused - deletes any unused icon images across all icon library folders. You can

optionally delete subfolders and empty folders at the same time using the checkboxes.

Icons can be dragged in and out of folders. Selecting an image or folder in organize mode will
enable the following options:

• Replace - images only. Replaces all show file instances of the selected image with a new
image of your choice.

• Rename - changes the name of the selected image or folder.
• Delete - after confirmation, removes the selected image or folder from the icon library.

Deleting a folder will also delete all images inside it.

SVGs

Any SVG (Scalable Vector Graphic) file used as the icon for multiple targets can be given a
unique color per instance. The files must be tagged using the same guidelines for Importing
Fixture Symbols (on page 423).

Encoders
The encoders are one of the ways to control the non-intensity parameters (NPs) of multiple
parameter devices. For more information on using the encoders, see Setting Non-intensity
Parameters with the Encoders (on page 196) .

On Eos Ti, the top four encoders are identified by the encoder touchscreen, just to the left of the
encoders. The bottom two encoders are always in control of pan and tilt respectively from left to
right.

On Gio, Gio @ 5, and Ion Xe, the four encoders are identified in two ways, by the encoder
controls display and the mini encoder status display.

On Element 2, you can access encoder control by using the ML controls display. See Moving
Light Controls (on page 100) for more information.

Encoder Display on Eos and Eos Ti
The encoder display area will show the name of the parameter it controls, display stepped limits
(if any) and also a {Home} button which allows you to set that parameter to its default position.
You can also home any parameter.
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Some buttons that may be available on the touchscreen are:

• Min
• Max
• Next
• Last
• Home
• Mode
• XYZ Format Enable/Disable

Buttons like {Next} and {Last} are used to step through ranges (such as colors in a color scroller)
one step at a time. {Min} and {Max} allow you to send a parameter to its minimum or maximum
limit with one press.

Modes allows you to switch between modes of a parameter (if any exist); for example, a
rotating gobo wheel. If additional modes are available, their softkeys will display near the top of
the encoder display.

Encoders can be switched from course mode into fine by holding down [Shift] while using an
encoder will put it in fine mode for as long as [Shift] is held down. Once [Shift] is released, the
encoder will return to course mode. See Face Panel (on page 180) for encoder options.

Press {Expand} to see all of the information about any device with a frame table. Press again to
collapse to the normal view. You may make selections from the Expand screen. The
colors/images in the device are established in patch (see Using the Scroller/Wheel Picker and
Editor (on page 137)).

{XYZ Format Enable / Disable} toggles between storing position data in pan / tilt format, and
XYZ format for use with Augment3d.

To the left of the encoder touchscreen are six hardkeys (five on Eos) that are for encoder control.
From top to bottom, these encoder paging keys control intensity, focus, color, shutter, image,
and form. Pressing any of these will change the parameters controlled by the encoders. To view
other available encoder pages, simply press the encoder paging keys to advance the pages.
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[Encoder Paging Keys] & [#] will take you directly to a page. [Flexi] & [Encoder Paging Keys]
will toggle the flexi encoder states.

To post a parameter category to the command line, use the parameter category buttons.

To post beam to the command line, double press the shutter, image, or form parameter
category buttons.

Some fixtures have more parameters than can be displayed on one encoder page. The number
of. pages for each category is displayed at the top of the encoder touchscreen. To view the other
pages, simply press the encoder paging button to advance the pages or hold the button and
press a number key to go directly to the page you want to access.

Encoder Controls Display
The encoder controls display is available on Gio, Gio @ 5, and Ion Xe consoles. Press the
[Encoder Display] hardkey to open the encoder controls display.

Directly under the middle two encoders are six hardkeys that are for encoder control. From left
to right, these encoder paging keys control intensity, focus, color, shutter, image, and form.
Pressing any of these will change the parameters controlled by the encoders.

To view other available encoder pages, simply press the encoder paging keys to advance the
pages.

[Encoder Paging Keys] & [#] will take you directly to a page. [Flexi] & [Encoder Paging Keys]
will toggle the flexi encoder states. See Flexi Encoders (on page 98) for more information.

To post a parameter category to the command line, use the parameter category buttons located
in the CIA.

Note: To post beam to the command line, double press the shutter, image, or form
parameter category buttons.

Each encoder’s area will display the name of the parameter it controls, display stepped limits (if
any) and also a {Home} button which allows you to set that parameter to its default position.

The encoder controls display allows you to cycle through parameter steps (if available). You can
also home any parameter. Some buttons that may be available are:

• Min
• Max
• Next
• Last
• Mode
• Expand
• XYZ Format Enable / Disable
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Buttons like {Next} and {Last} are used to step through ranges (such as colors in a color scroller)
one step at a time. {Min} and {Max} allow you to send a parameter to its minimum or maximum
limit with one press.

Modes allows you to switch between modes of a parameter (if any exist); for example, a
rotating gobo wheel. If additional modes are available, their softkeys will display at the top of
the encoder controls display.

Encoders can be switched from course mode into fine by holding down [Shift] while using an
encoder will put it in fine mode for as long as [Shift] is held down. Once [Shift] is released, the
encoder will return to course mode.

Press {Expand} to see all of the information about any device with a frame table. Press again to
collapse to the normal view. You may make selections from the Expand screen. The
colors/images in the device are established in patch (see Using the Scroller/Wheel Picker and
Editor (on page 137)).

{XYZ Format Enable / Disable} toggles between storing position data in pan / tilt format, and
XYZ format for use with Augment3d.

Mini Encoder Display
On Gio, Gio @ 5, Ion Xe, or ETCnomad using a Programming Wing, information on what the
encoders are currently controlling can always be found in the mini encoder status display, even
when the Encoder Controls Display (on the previous page) is closed. This display is found above
the softkeys in the CIA.

Use the Parameter Category hardkeys to choose which parameters are currently available on
the encoders.

Some fixtures have more parameters than can be displayed on one encoder page. The number
of. pages for each category is displayed at the bottom of the Parameter Category softkey. To
view the other pages, simply press the button to advance the pages or hold the button and press
a number key to go directly to the page you want to access.

Encoder Navigation
Use the encoder page buttons (located to the left of the encoder LCD) to choose which
parameters are currently available on the encoders. There are five usable buttons: Color,
Custom, Shutter, Image, and Form. Pressing any of these will change the parameters controlled.

Some fixtures have more parameters than can be displayed on one encoder page. The number
of pages for each category is displayed at the top of the encoder touchscreen. To view the other
pages, simply press the [Color], [Custom], [Shutter], [Image], or [Form] button to advance the
pages or press the button with a number key to go directly to the page you want to access.

Encoders can be switched from course mode into fine by holding down [Shift] while using an
encoder will put it in fine mode for as long as [Shift] is held down. Once [Shift] is released, the
encoder will return to course mode.

Encoders in Blind
The encoders and the level wheel are disabled by default when in the blind display. Pressing an
[Encoder Page Keys], for example [Color], will enable the encoders and level wheel. When the
encoders are disabled, trackball functionality for pan and tilt will also be disabled.
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Flexi Encoders
In Flexi mode, any empty locations for parameters not applicable for selected channels will be
suppressed. By default, the encoder display will be in Flexi mode.

Holding down [Flexi] and an [Encoder Page Keys], for example [Image], can be used to exit or
enter Flexi mode.

Locking the Encoders
It is possible to lock out the encoders. To lock out the encoders, press [Escape] & [Encoder Page
Keys]. To unlock, press any of the [Encoder Page Keys].

Custom Encoder Maps
Custom encoder maps allow you to create and store unique parameter layouts for your fixtures.
A custom map can be assigned as a console-wide default, or applied more selectively to specific
fixtures, groups of channels, or console users.

Custom mode must be enabled to use custom encoder maps, by selecting {Custom}. With
custom mode toggled off, Eos will use the default parameter mapping.

In Snapshots, custom encoder mode, map assignments, and current positions can be stored and
recalled separately or together.

Encoder Maps Editor
To open the custom encoder map editor, select the encoder maps icon on the Workspace Layout
Menu (on page 65) or use [Tab] [4] [0].

Creating Custom Maps

Create a map by entering the map number and pressing [Enter], and select a parameter
category (Intensity, Focus, etc) to customize.

Add parameters to the category by selecting an open encoder slot, and choosing a parameter
from the list to assign to it. You can also search for specific parameters.

To edit parameters that have already been assigned, select the parameter again and choose
from the following options:
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• Clear - removes the parameter assignment from the encoder slot, leaving it blank.
• Delete - removes the parameter assignment from the encoder slot, moving all subsequent

parameters to the left
• Insert Before - inserts a blank slot to the left of the selected parameter
• Insert After - inserts a blank slot to the right of the selected parameter
• Change Parameter - replaces the assigned parameter in that slot

Each parameter category can be given up to 25 pages of custom encoder layouts. If a parameter
category is not assigned any custom encoder layouts, the default Eos parameter mapping for
that category will be used instead.

Defaults
These parameter slots assign default parameters to each encoder in the specified parameter
category. Unless a specific parameter has been chosen for an encoder on a page, the assigned
defaults will track across encoder pages, indicated with the standard Eos tracking colors.If the
defaults are left unassigned, parameters must be assigned on each encoder page individually.

Widgets
Additional fixture control options can be assigned in the Widget column. As with parameters,
widgets can be assigned a default that tracks across all pages in a parameter category, or
assigned on a page-by-page basis.

Softkey Options

The following softkey options are available in the custom encoder maps editor:

• {Filter To Users} - allows you to create a user-specific map
• {Map To Fixture} - allows you to create a fixture-specific map
• {Create From Fixture} - creates a map using the parameter layout of a specified fixture

profile

Custom Map Types
Custom encoder maps can be used in your show file in a variety of ways.

Default Map

A single custom encoder map can be assigned as the default encoder map for all devices in the
show file. When custom mode is enabled, this map will be used for all patched devices.

Assigning a map as the default can be done at the top of the custom encoder map editor, or in
Setup > User > Manual Control.

Note: Default maps are specific to the current user number.

Fixture-Specific Maps

Custom encoder maps can also be created for specific device types, and will only appear when
devices of that type are selected.

Create a new map, and assign it to a device profile via {Map To Fixture}, or by selecting in the
Map To Fixture column. When fixtures with this profile are selected, the custom encoder map
will populate.
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If multiple fixture types are selected at once, encoder maps will stack in the encoder display,
allowing you to select them individually. This includes any default maps for selected fixtures
without custom maps assigned to them.

Multi-Fixture Maps
Maps can also be assigned to more than one device type, which can be useful if two or more
fixtures are often used together. Simply assign additional device profiles when creating a fixture-
specific map. Now when these fixtures are selected, Eos will prioritize the multi-fixture map over
any individual fixture maps or defaults.

User-Specific Maps

Custom encoder maps can also be specified to the user level. When creating or editing a map,
assign it to a specific user number via {Filter To Users}, or by selecting in the Filter To Users
column. As with device profiles, multiple user numbers can be selected. Once specified, only
matching users will have access to that encoder map.

Moving Light Controls
A display tool for controlling the non-intensity parameters (NPs) of multiple parameter devices is
the ML Controls. The ML Controls are on Tab 5.

On Element 2, the display can be opened in the CIA by pressing the [ML Controls] button.

Note: A pop-up window version of the ML Controls can be opened for quick access of
these controls. See Pop-up ML Controls (on page 70)

You will need to have a multi-parameter device selected to properly view this display. The
display will change based on the device selected. If you have a device that only has intensity
and color parameters, the ML Control display will only show intensity and color parameters.

Note: Controls available in this display will change based on the fixture selected.

When there is room, multiple rows of parameters will display, and you can scroll the display
vertically.

There are category shortcut keys on the left side of the ML Controls display. Press a key to
quickly access those controls.
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1. Category button (Clicking this button will put the category on the command line.)
2. Parameter button (Clicking the button will put the parameter on the command line.)
3. Home button allows you to home a specific parameter or attribute of a parameter.
4. Parameter attributes
5. Selects the color picker.
6. Collapses or expands categories.
7. Gives pan and tilt functionality to a mouse or trackball.
8. Virtual encoder (Click and hold close to the center line for slow movement, further away

for faster movement.)
9. Opens the gel picker.

Fader Configuration
The fader configuration display is found on Tab 36 .The Fader List (on page 104), which shows
all of the faders and their assignments, can be found in Tab 35.

At the top of the fader configuration display, you can select the fader page, which has 100
pages of 10 faders each page.

You can configure the master fader pair at the top of the display. See Master Fader
Configuration (on page 104) for more information.

The fader configuration display shows a virtual mockup of each fader and its buttons. The
various parts of the virtual fader can be clicked or tapped to open configuration options.

Each fader is color coded based on its assigned target type. Grandmasters and inhibitive
submasters are in red, additive submasters are yellow, playback faders display in green, and
presets, palettes, global effects, and manual time masters are orange.

On Element 2, playback faders cannot be assigned.
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Fader Configuration Window
Click on the fader header to open the fader configuration window.

Target
This setting allows you to map a cue list, submaster, intensity, focus, color, or beam palette,
preset, global effect fader, manual time master, or grandmaster to a fader.

ID
This sets the number of the target assigned to the fader, such as Cue List 2 or Submaster 5. For a
list of available Target IDs, click or press the {...} button beside ID.

Note: Content can also be loaded to faders from Live, using the command line and
load.

Discrete Instance
This setting defaults to Yes and applies to cue lists. When a fader is discrete, it will track other
faders that are running the same cue list, BUT if a fader that it is tracking manually changes to a
different cue list, a discrete enabled fader will not change its content. When set to No (or
disabled), once a fader is in sync with another fader running the same cue list, it will stay in sync
when content is changed. Discrete disabled is noted in the fader ribbon with a link icon.

Size
A fader can be mapped so its content takes up 1, 2, or 3 faders. 1x will take up 1 fader, 2x will
use 2 faders, and 3x will use three.

Note: If a fader is mapped to 1x, the top button will be locked as a load button.
When mapped to 2x or 3x, the top left button will be locked as a load button.

Buttons & Slider
When set to Default Mapping, the button and fader configuration is drawn initially from the cue
list or submaster list properties for that content. If changes are made to that mapping in Tab 36,
it filters BACK to the cue or submaster list and changes any other instances where that content is
mapped. If set to Local, any changes made in Tab 36 impact only that instance of the content.
See Cue List Properties and Submaster Properties for more information on default mapping.
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Target List
If temporary fader mapping is being used, the list of content will display here. See Temporary
Fader Mapping (on page 261) for more information.

Additional Configuration
Clicking on the configuration box will open additional configuration options that are dependent
on the target type assigned to the fader.

For detailed information on these various options, see the following topics:

• Grandmaster Configuration (on page 105)
• Cue List Properties (on page 291)
• Submaster Properties (on page 369)
• Presets and Palettes Fader Properties (on page 257)
• Global Effects Fader (on page 360)
• Manual Time Master (on page 105)

Indicators in the Element Fader Status Display
Each fader is color coded based on its assigned target type. Channel faders are orange.
Grandmasters and inhibitive submasters are in red, additive submasters are yellow, and presets,
palettes, global effects, and manual time masters are brown.

The fader status display can be disabled in Setup. See Displays (on page 182) for more
information.

1. Orange box indicates a channel fader.
2. Current channel number controlled by fader.
3. Label (channel and target labels will display).
4. Current channel level. (Level will display regardless of control from fader or keypad.)
5. Up arrow indicates that there is a higher level currently set for the channel and that the

fader needs to be raised to match.

1. Palette on a fader.
2. Current submaster number controlled by fader.
3. Red box indicates an inhibitive submaster.
4. Effect on a submaster.
5. Label (channel and target labels will display).
6. Grandmaster on a fader.
7. Up arrow indicates that there is a higher level currently set for the channel and that the

fader needs to be raised to match.
8. Down arrow indicates that there is a lower level currently set for the channel and that the

fader needs to be lowered to match.
9. Level of submaster currently.

10. Global Effects Fader (on page 360)
11. Manual Time Master (on page 105)
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Fader List
The Fader List, which shows all of the faders and their assignments, can be found in Tab 35.

You can also make changes to a fader's configuration while in the fader list display by clicking
on a column. A virtual fader will be displayed. Click on the appropriate area of the fader to
access the configuration options. Selection can be done by clicking in the column or from the
command line.

Range editing is possible in this display by selecting all the needed faders. Changes made to the
configuration will be made to all of the selected faders.

With a fader selected, the CIA will also display a virtual fader and the configuration options for
that fader.

Fader Ribbon
The fader ribbon shows the fader color coding that is used in the fader configuration tools.

Grandmasters and inhibitive submasters are in red, additive submasters are yellow ,playback
faders display in green ,and presets and palettes are orange.

Master Fader Configuration
Click or tap Master Fader to open the master fader configuration window.

Target
This setting allows you to map a cue list to a fader.
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ID
This sets the number of the target assigned to the fader, such as cue list 2. For a list of available
Target IDs, click or press the {...} button beside ID.

Element 2 can only map to cue list 1.

Discrete Instance
This setting default to Yes and applies to cue lists. When a fader is discrete, it will track other
faders that are running the same cue list, BUT if a fader that is tracking manually changes to a
different cue list, a discrete enabled fader will not change its content. When set to No (or
disabled), once a fader is in sync with another fader running the same cue list, it will stay in sync
when content is changed. Discrete disabled is noted in the fader ribbon with a link icon.

Size
Master fader is set to a size of 2 faders and cannot be changed.

Buttons & Slider
You can select to use default mapping for the fader, or you can use local mapping.

Note: When a user first joins a session, the master fader is unmapped. Once a cue list
is established for that user, any other devices joining the user group will have the same
cue list automatically mapped to their master. If a device changes its user ID, the cue
list on the master will be remapped accordingly.

Additional configuration options are available. see Cue List Properties (on page 291) for more
information.

Grandmaster Configuration
When a fader is configured as a grandmaster, you can set the fader itself as a master or disable
it. Fader size is set to 1x, and can not be changed.

The first button is locked as a load button, and cannot be configured. The second button is
disabled and cannot be configured. The third button can be configured as a blackout button or
disabled. When configured as a blackout, both buttons must be pressed to set the grandmaster
to blackout.

Manual Time Master
A fader can be mapped as a manual time master.

Note: Manual Time Master applies to changes made manually, not to playback.
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A manual time master can be used to impact any manual control timing. For a manual time
master, you need to assign a minimum and maximum time settings to the fader. By default, the
minimum is set to 0 seconds when the fader is completely down, and maximum is 5 seconds
when the fader is at full. To change the timing, click on the box and enter the time from the
pop-up number pad.

The fader buttons can be assigned as bump, disabled, or macro (see Submaster Fader and
Button Configuration (on page 373)). It is recommended that the bottom button be set to bump
for turning the fader on/ off. When turned on, the LED will be solid green.

Note: The setting of the manual time master is ignore unless turned on. Changing the
manual timing master will not impact any manual changes already in motion.

The fader ribbon will display the label of M Time to indicate a manual time master fader.

Note: Channel and parameter filters can be assigned to a manual time master.

You can override a manual time master by using a command line entered sneak time.

Master Only
Master Only is a fader option that can be assigned in the fader configuration display (Tab 36) or
in the fader list (Tab 35) for submasters, presets, and palette faders. Submasters can also be
configured in the Submaster List (Tab 15).

Master Only faders are used to set a level for content to fade to. The slider can be used to live
adjust levels when the fader has been activated via the bump button.

Master Only faders default to Full.

To set the fader level from the command line, use [Fader] [n] [At] [level] [Enter].

Note: If content is set to proportional, Master Only fades all content to the setting of
the fader when bumped. If set to I-Master, the fader masters the intensity, but non-
intensity goes to the end state in time when the content is triggered.

Channel and Parameter Filters on Faders
Channel and Parameter Filters can be used to allow only specified data to be played back.
These are playback filters, and do not impact how data is recorded.

Channel and Parameter Filters can be associated with the following targets for playback:

• Cue lists
• Submasters
• Presets
• Palettes

Note: Channel and Parameters filters can also be used with Global Effects Faders.
See Global Effects Fader (on page 360)

Note: For presets and palettes, channel and parameter filters can only be assigned in
the fader configuration display (Tab 36) or in the fader list (Tab 35).

For cue lists and submasters, channel and parameter filters can be set in the following areas:
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• Cue List Index
• Submaster List
• Fader configuration display (Tab 36)
• Fader list (Tab 35)
• In Live using the {Properties} softkey

Tap or click on {Chan Filter} to assign channels or groups. Tap or click on {Param Filter} to open
a list of available parameters that you can filter.

Note: Filters will travel with their assigned cue lists and submasters wherever they are
mapped.

When a filter has been applied, an indicator will display in the fader ribbon. C will display for
channel filter, and F is for parameter filter.

Clearing Channel and Parameter Filters
Press the red [X] to clear the channel or parameter filters listed.

Virtual Fader Module
A virtual fader module can be opened from the home screen by selecting the Faders button or by
pressing [Tab] [2][8].

The virtual fader module has a configuration menu, which is accessed by first selecting the
module tab and then double clicking on the tab to open the menu. With the virtual fader
module selected, you can also select the gear icon, which is located by the tabs, to open the
configuration menu.

The following options are available in this configuration menu:

• Rows - sets the number of rows used for the module. Maximum number of rows is six.
• Columns - sets the number of columns used for the module. Maximum number of columns

is six.
• Slider Format - choose between Faders, which includes the sliders and configurable

buttons, or Buttons, which hides the sliders.
• Display Master Fader Pair - check this box to display the virtual master fader pair.

Unchecked by default.

For information about configuring your faders, see Fader Configuration (on page 101)

Copying Faders Using Attributes Only
When copying faders, you can use {Attrs Only} to copy over all of the fader properties except
levels, effects, and labels.
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• [Fader] [1] [Copy To] [Fader] [4] {Attrs Only} [Enter] [Enter] - copies all of the fader
properties from fader 1 and places it in fader 4. Levels, effects, and labels are not copied
when using the {Attrs Only} softkey.

Virtual Keyboard
It is possible to open a keyboard which mimics the hard keys found on the physical keypad.

To open, you can select the virtual keyboard from the Workspace Layout Menu (on page 65) or
use [Tab] [7].

The virtual keyboard displays the alphanumeric keyboard shortcut for that hardkey in the lower
right hard corner.

sACN Output Viewer
You can open the sACN Output Viewer by pressing [Tab] & [3][7] or selecting the sACN Output
Viewer icon from the home screen.

The sACN Output Viewer is a place to check the current live outputs on a universe by universe
basis.
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The left side of the viewer is the universe grid. It displays 512 address cells. Cells outlined in a
color are currently patched addresses. Each patched cell contains an address number and output
value. Unpatched cells are black and only have an address level.

Output values are 0 through 255. 0 is displayed in black and 255 is in bright red. The red output
value color will grow brighter as the output value increases.

If there is a channel or address selection on the command line, the appropriate address cell will
be outlined in gold. You can also press on a cell to select it but it will not post to the command
line. Information about the selected address will display to the right of the grid.

Any available sACN sources will be displayed in the right panel, and are color coded. The
address cells will use that same color coding to indicate the device it is patched to.

Configuration Options
When the Follow Command Line box is checked, the viewer will follow the command line for
selecting addresses. This is enabled by default.

Press {About} to open the About Address display in the CIA.

Press the left and right arrows to scroll through the available universes, or enter a specific
universe number in the box.
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About Managing Show Files
This section explains how to create, open, and save your show files. Each of these operations
are accomplished through the Browser (on page 56) area in the The Central Information Area
(CIA) (on page 54).

Create a New Show File
To create a new show file, navigate within the browser to File > New and press [Select].

You will be prompted for confirmation that you want to create a new show. Any unsaved show
data will be lost. Press {OK} to confirm or {Cancel} to discontinue the operation.

If you want your Augment3d model to be included in the new show, check the box labeled
"Preserve Augment3d Model." For more information, see Augment3d (on page 433).

Open an Existing Show File
Names of show files may appear in the browser list in normal text or in bold text. Files in normal
text indicate that there is only one show file stored by that name.

Bold show names indicate that there are several versions of the show file stored under that
name, the bold one being the most recent. To access the most recent show file, simply select
the bold name. You may right arrow from the bold name to expand a list of previous versions
beneath it in the browser. Select the desired show from the expanded list.

To open an existing Eos Family show file, navigate within the browser to: File > Open and press
[Select].

Eos provides you with multiple locations to retrieve an Eos Family show file including:

• Show File Archive - This is the default storage location for show files when a show file is
created and saved. Older versions of the show file will be listed under the most current
version.This allows you the ability to open the latest version or an earlier version of a show
file if desired.

• Network Drive- if one is connected. When there is no network drive connected, it will not
display in the Browser.

• USB device - When a USB device is connected and an Eos Family show file is available on
the device, you will notice the USB is displayed in white text and is expandable.

Open the desired location:

• To open a show file from the Show File Archive, navigate within the Browser to: File>
Open> Show File Archive and press [Select].

• To open a show file from the network drive, navigate within the Browser to: File > Open>
Name of Network Drive> and press [Select].

• To open a show file from a USB device, navigate within the Browser to: File> Open>
Name of Drive and press [Select].

Select the specific show file

• Navigate within the specified storage location and select the show file you wish to open,
press [Select].
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• If the selected show has multiple time stamps and you wish to load an older version,
navigate to the desired revision and press [Select].

This will open the partial show loading screen in the CIA.

From this screen you can select which components of the show file you wish to load. The buttons
at the center of the CIA represent all of the show components that you can choose to load. By
default all components are selected (gray) and will be loaded. To withhold any show
components from loading, simply deselect them in the CIA by touching the respective button.

To reselect all show components, press the {Reset} button and all buttons will return to gray
(selected). To stop the show load process, press the {Cancel} button.

When you have selected/deselected all of the show components you require, press the {OK}
button.

Eos loads the selected show to the console.

CAUTION: On a partial show open, if any record targets are not opened,
any existing data of that type will be cleared from the console.To merge show
data, merge should be used. See Merging Show Files (on page 115)

Selective Partial Show Opening
If you select the {Advanced} button in the partial show opening screen, you will have the
opportunity to load partial components from the show file and be able to specify the desired
location of those partial components in the new show file.

CAUTION: On a partial show open, if any record targets are not opened,
any existing data of that type will be cleared from the console. To merge
show data, merge should be used. See Merging Show Files (on page 115) .

For example, you could specify only cues 5-10 from cue list 2 and load them as cues 20-25 in cue
list 7 in the new show. You could also specify only specific palettes, presets, effects, and so on.
To see the complete list of show components, press the {Advanced} key in the partial show
loading screen.

As you specify components, they are added to a table in the CIA. In the table, fields with a dark
background may be edited, fields with a light gray background do not apply to that component.
For each component in the list, you can specify the desired range by pressing the proper area in
the table and entering numbers from the keypad. The columns in the table are:

• List - The list you are taking data from (such as a cue list).
• List Target - The list you are adding the data to.
• Start - The first in a range of components (such as a range of cues).
• End - The last in a range of components.



114 Eos Ti, Gio, Gio @5, Ion Xe, Ion Xe 20, and Element 2 Operations Manual

• Target - The desired location of the components in the new show file (for ranges, this will
be the location in the new show of the first component in the range, the others will follow
in order).

Note: In the {Advanced} view, you can use the [Thru] key to jump to the End column
and [At] to jump to the Target column.

To open only partial components from a show file:

1. From the browser, navigate to the desired show file. See Open an Existing Show File (on
page 112).

2. When the partial show load screen appears, press the {Advanced} button. The partial
components selection screen will appear in the CIA.

3. Select the show components that you wish to load by pressing on their respective buttons
on the left side of the CIA. The components will appear in the list to the right as you select
them.

4. Press any fields for which you want to enter specific numbers. The field (if editable) will
highlight in gold.

5. Enter the numbers using the keypad to specify the desired cues/groups/effects and so on.
6. Press {OK} to load the components to the new show.

You may exit the partial show load screen at any time by pressing the {Cancel} button. This will
return you to the browser.

You may clear all selected components from the table at any time by pressing the {Reset}
button.

You may exit the advanced loading screen at any time by pressing the {Return} button. This will
return you to the general partial show load screen.

Note: Media is imported gobo and magic sheet images, and will be included by
default when you select Patch, Fixtures, or Magic Sheets.

Partial Patch Opening
You have the option to selectively open partial patch information or fixtures into a show file by
selecting the {Advanced} button in the partial show opening screen. Select {Patch} or {Fixtures}.

Note: It is important to remember that on a partial patch open, if any record targets
are not opened, any existing data of that type will be cleared from the console. To keep
that data, merge should be used.

You can specify the desired range by selecting the proper area in the table and entering
numbers from the keypad. The columns in the table that relate to patch are:

• Start - The first in a range of components.
• End - The last in a range of components.
• Target - The desired location of the components in the new show file (for ranges, this will

be the location in the new show of the first component in the range, the others will follow
in order).

Show File Advisory
If the loaded show file exceeds the console’s output capacity, an advisory will display in the CIA.
You will need to dismiss the advisory by pressing {Ok} before continuing. To see the capacity of
the console, press [About].
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Park Buffer
The contents of the Park buffer are saved with show files. By default, the park buffer will not
open with a show file.

You can load the park buffer, but it requires an additional step of confirming that you want to
open the park buffer. You will need to click or press the check box by the text Yes, Include the
Park Buffer.

For more information about park, see About Park (on page 364)

Merging Show Files
All Eos family consoles support the merging of other Eos family show files.

Note: Merging show files is different from opening show files. When you do a partial
open of show components, untouched record targets are cleared. When you do a
merge, those record targets remain.

You have the option of merging show files from the Show File Archive, a File Server (if
connected), or a USB device.

To merge a show file, navigate within the Browser to: File > Merge. Navigate to the desired
storage location and press [Select]. When using merge, Eos displays only the available files.
Navigate to the specific file and press [Select].

This will open the merge screen in the CIA. From this screen you can choose which aspects of
the show file you want to merge. By default all aspects are unselected (black). Selected show
aspects will appear in gray.

Note: Media is imported gobo and magic sheet images, and will be included by
default when you select Patch, Fixtures, or Magic Sheets.

If you select the {Advanced} button in the merge show loading screen, you will have the
opportunity to load partial components from the show file and be able to specify the desired
location of those partial components in the current show file.

For example, you could specify only cues 5-10 and load them as cues 20-25 in the current show.
You could also specify only specific palettes, presets, effects, and so on. To see the complete list
of show components, press the {Advanced} key in the merge show loading screen.

As you specify components, they are added to a table in the CIA. In the table, fields with a dark
background may be edited, fields with a light gray background do not apply to that component.
For each component in the list, you can specify the desired range by pressing the proper area in
the table and entering numbers from the keypad. The columns in the table are:

• List - The list you are taking data from (such as a cue list).
• List Target - The list you are adding the data to.
• Start - The first in a range of components (such as a range of cues).
• End - The last in a range of components.
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• Target - The desired location of the components in the new show file (for ranges, this will
be the location in the new show of the first component in the range, the others will follow
in order).

Note: In the {Advanced} view, you can use the [Thru] key to jump to the End column
and [At] to jump to the Target column.

To merge channels, see Partial Show File Channel Merge (below)

To merge only partial components:

1. From the browser, navigate to the desired show file (see Open an Existing Show File (on
page 112) ).

2. When the merge show load screen appears, press the {Advanced} button. The partial
components selection screen will appear in the CIA.

3. Select the show components that you wish to merge by pressing on their respective
buttons on the left side of the CIA. The components will appear in the list to the right as
you select them.

4. Press any fields for which you want to enter specific numbers. The field (if editable) will
highlight in gold.

5. Enter the numbers using the keypad to specify the desired cues/groups/effects and so on.
6. Press {OK} to load the components to the current show

Partial Patch Merging
You have the option to selectively merge partial patch information or fixtures into a show file by
selecting the {Advanced} button in the partial show merge screen. Select {Patch} or {Fixtures}.

You can specify the desired range by selecting the proper area in the table and entering
numbers from the keypad. The columns in the table that relate to patch are:

• Start - The first in a range of components.
• End - The last in a range of components.
• Target - The desired location of the components in the new show file (for ranges, this will

be the location in the new show of the first component in the range, the others will follow
in order).

Checking the "Only Merge Augment3d XYZ Location" box will merge only the Augment3d
position information of the selected range without merging any additional patch data.

Partial Show File Channel Merge

When Merge Channels is selected, channels from cues, submasters, groups, and other channel
targets will be added to any existing channel targets of that same type.

With Merge Channels not selected, those channels will override any existing channels in the
channel targets of the same type.

Example:
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In a show file 1, group 1 has channels 1 through 5. In show file 2, group 1 had
channels 6 through 10. With Merge Channels and Groups selected for the
merge, show file 2's group 1 will merge with show file 1's group 1. Group 1 will
then have channels 1 through 10. If Merge Channels was not selected, group 1
would just have channels 6 through 10.

Note: It is important to remember that if the same channels exist in both show files,
the data merging in will override the existing data for those channels.

Note: Scenic Element and Scenic Element Movable Channels with nested items in an
Augment3d model will import without their model items if the Augment3d model is not
also merged.

Printing a Show File
Eos provides you with the ability to save a show file or aspects from a show file to a PDF file for
printing. Eos has three locations to save the PDF files including the Show File Archive, the File
Server (if connected), or a USB device (if connected). Saving the PDF file to a USB (F:) device,
allows you to then print the PDF from a personal computer. Printing directly from Eos is not
supported.

In Setup, you can select the page orientation and paper size for these PDF files, see PDF Settings
(on page 184) for more information.

To save a PDF of an Eos Family show file, navigate within the browser to Print.

This will open the printing screen in the CIA. From this screen you can choose which aspects of
the show file you want to save to PDF. By default all aspects are selected (gray) and will be
saved. To withhold any show aspects from printing, simply deselect them in the CIA by touching
the respective button. Deselected show aspects will appear in black.

To reselect all show aspects, press the {Select All} button and all buttons will return to gray
(selected). To stop the show file from being saved to a PDF and return to the browser, press the
{Cancel} button. When you have selected/deselected all of the show aspects you require, press
the {Ok} button to create the PDF file.

There are three additional options on the far right side of this display:

• Tracked Levels - prints all of the moves and tracked values.
• Color Printout - prints the cue data using the same color indicators as the console's

displays use. See Color Indicators (on page 76)
• Summary View - prints cues without non-intensity parameter information.

You can also choose to print specific portions of show aspects. To select this information, press
the {Advanced} button. The buttons at the center of the CIA will again represent all of the show
aspects that you can choose. By default all aspects will be deselected (black).
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As you select aspects, they will be added to the table in the CIA. For each component in the list,
you can specify the desired range by pressing the proper area in the table and entering numbers
from the keypad. The columns in the table are:

• List - The list you are taking data from (such as a cue list).
• Start - The first in a range of components (such as a range of cues).
• End - The last in a range of components.

Note: In the {Advanced} view, you can use the [Thru] key to jump to the End column.

To deselect all show aspects, press the {Reset} button and all buttons will return to black
(deselected).

To return to the main print screen, press the {Return} button. To stop the show file from being
saved to a PDF file and return to the browser, press the {Cancel} button. If you are ready to save
the file, press the {Ok} button. You will be prompted to name the file.

The PDF will have the show name, date and time it was created, and date and times for when
the show file was last saved. It also gives the Eos Family software version information. If multiple
aspects were selected to save to the file, there will be hyperlinks at the top of the PDF so you
can quickly jump to a section.

Note: If you have cues selected, cue notes and scenes will display along with
additional cue information.

Saving the Current Show File
To save the current show data, navigate within the browser to: File>Save> and press [Select]. A
green "Success" message should appear when the file has finished saving. If a red "Failed"
error appears, attempt to save to a different location, or exit and / or restart Eos as soon as
possible.

The Show File Archive is the default storage location for show files when they are saved. The
new time stamp located beneath the show file name on the CIA indicates that the show file has
been saved.

All previous saves are stored in the Show File Archive with the time stamp following the file
name.

Show File Indicator
An asterisk (*) will display beside the show file name to indicate when a show file has been
modified but not saved.

An asterisk beside the word "Augment3d" in parentheses indicates there are unsaved changes
in the Augment3d model.
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Save Show File Warning
If there is unsaved data in the current show file, a save warning will display when you attempt to
open a new or existing show file.

The following options will be available:

• Save - saves the current show file, and opens a new or existing show file.
• Save as - saves the current show file to a different location or with a different name, and

opens a new or existing show file.
• Continue without Saving - opens the new or existing show file without saving any

changes to the current show file. Changes will be lost.
• Cancel - returns to the current show file without saving changes or opening a different

file.

Using Quick Save
To save the current show data to the Show File Archive on the internal drive without having to
navigate to the browser, hold down [Shift] & [Update].

Using Save As
To save an existing Eos Family show file to a different location or with a different name,
navigate within the Browser to: File > Save As > and press [Select].

Eos provides you with three locations to save an Eos Family show file (.esf) including the Show
File Archive, the File Server (if connected) or a USB device (if connected).

Navigate to the desired storage location and press [Select]. When using “Save As” to save the
show file to a specific location, the alphanumeric keypad will display on the CIA. Name the
show file and press [Enter]. The show file will be saved in the specified location with the show
file name you entered with a time stamp suffix.

By default, the current show file name will be used. Pressing [Label] or [Delete] on the console,
or DELETE on an alphanumeric keyboard will remove the default show label when doing a Save
As.
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Note: When using Save As to save to a location outside of the Show File Archive, the
unsaved show indicators and old show file name will still appear. Save into the Show
File Archive to remove these indicators and update the file name displayed.

Show File Formats
The Save and Save As dialogs include a variety of options for saving show files.

ESF3D
This format includes your show data and your Augment3d model, and is only compatible with
Eos versions 3.0.0 and higher.

ESF2
This format excludes Augment3d model, and is only compatible with Eos versions 2.9.0 and
higher.

ESF
This is a legacy format for compatibility with Eos versions prior to 2.9.0.

Importing Show Files
Eos supports the import of a variety of files.

Note: Eos supports ASCII show file import from a number of other control consoles,
including the Congo/Cobalt, Obsession, Expression and Emphasis product lines, as well
as the Strand 500 Series. Please note that all show files must be saved in an ASCII
format prior to importing them into Eos.
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CAUTION: The way data is stored and used is often different between
different consoles. Imported data may not playback exactly the same between
consoles. Not all data (such as effects and macros) may be imported. This
varies by product.

Importing Show Data
You have the option of importing standard USITT ASCII (.asc), .csv, or Lightwright (.txt or .asc)
from the Show File Archive, a File Server (if connected), or a USB device.

Note: .asc file must be imported using the USITT ASCII option, even if it is a
Lightwright file.

To import a show file, navigate within the Browser to: File > Import > (Type of file to import)
and press [Select].

If you are importing an USITT ASCII file, you will have two options, Import as Library Fixtures or
Import As Custom Fixtures.

• Import as Library Fixtures will allow Eos to try to match the fixtures in the file with fixtures
in the Eos library.

• Import as Custom Fixtures will bring the fixtures in as they are in the file.

It is recommended to use Import as Custom Fixtures.

Navigate to the desired storage location and press [Select]. When using import, Eos displays
only the available files. Navigate to the specific file and press [Select].

Note: Not all data is saved to a .csv file. It is recommended that you first export as a
.csv file, modify the file as needed, and then import. See Exporting a Show File (on the
next page) for more information.

Choose the aspects of the file you wish to import (all are selected by default). If "Merge Data" is
not selected, the ASCII data will overwrite your current show data. If "Merge Data" is selected,
the ASCII data will be merged into your current show.

Importing Augment3d Objects
The Import menu also contains options for importing fixture data from Vectorworks as well as
Scenic Models and Scenic Materials for use in Augment3d. For more information, see Importing
Augment3d Objects (on page 475), Materials (on page 441), and Vectorworks Augment3d Plug-
in (on page 477).

Lightwright Import
Once a file has been selected for import, you can proceed with the import, select options, or
map devices.
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Options
The following options are available:

• Starting / Ending Channel - defines a specific range of channels to be imported
• Overwrite - overwrites the data in the show file when enabled, and merges the data when

disabled
• Do not update fixture types - disables the updating of fixture types in the show file
• Only import Augment3d XYZ location - enables import of just Augment3d location data
• Import Text/Notes/Labels/Gels Only - enables import of just the patch database text

Mapping
You can map Eos patch fields to fields in the Lightwright file. Channel and Address must be
mapped for the file import to work. Any other field can be set to ignore if desired. Options can
be selected again for placement in multiple fields.

The text fields in the Patch display and database will rename based off of the Lightwright
imported fields. See Renaming Text Fields in Patch (on page 147) for more information.

Note: Eos does not currently support multiple gels per fixture from Lightwright.

Address Formats

Eos will accept mulitple address formats for importing. Examples of those formats are 2/3, 2.3,
2,3, 2-3. Eos will convert all formats to n/n.

Device Mapping

Devices can also be mapped. Click {Map Devices} to open the following display.

Select the Lightwright device and the match from the Eos column. Multiple Lightwright devices
can be selected at a time. Then click {Link Devices}. The link will appear in the Mapping
column. To unlink a device, select it from the Mapping column, and then press {Unlink Device}.

Device mapping and import fields are saved with the show file.

Importing Custom Gobo Images
Custom gobo images can be imported by going to Browser > Import > Gobo Images and
selecting an image file or folder. If a folder is selected, all image files within the folder will be
imported. All standard image files are supported with the exception of .svg files.

Imported gobo images can be deleted by going into Browser > Import > Gobo Images >
Imported Gobos, selecting the image, and pressing [Delete] [Enter].

Exporting a Show File
Export your Eos Family show file to a standard USITT ASCII, .csv, Focus Track, Moving Light
Assistant (MLA) or Fast Focus Pro show file using the export feature.
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To export your Eos Family show file in ASCII format, navigate within the Browser to: File >
Export > USITT ASCII and press [Select].

You have the option of exporting your show file in ASCII format to the Show File Archive, to a
File Server (if connected) or to a USB device.

Navigate to the desired storage location and press [Select]. The alphanumeric keypad will
display on the CIA. Name the show file and press [Enter]. The file will be saved in the specified
location with the file name you entered with a “.asc” file extension.

You can export Eos Family show files as a .csv format by navigating within the browser to: File>
Export> CSV and select the location for the export, the Show File Archive, a File Server (if
connected), or to a USB device.

Files can be exported in a Focus Track or Fast Focus Pro format by going to File > Export > Fast
Focus Pro or Focus Track and select the location for the export, the Show File Archive, a File
Server (if connected), or to a USB device.

Files can be exported in a Moving Light Assistant (MLA) format by going to File > Export >
Moving Light Assistant.

This will open the export screen in the CIA. From this screen, you can choose which aspects of
the show file you want to export. By default all aspects are selected and will be exported. To
withhold any show aspects from exporting, simply deselect them in the CIA by clicking on the
respective button. Deselected show aspects will appear in black.

You can also choose to export specific portions of show aspects. To select this information, press
the {Advanced} button. In the Advanced screen, all aspects are deselected (black) by default.

To stop the show file from being saved for export, press the {Cancel} button. If you are ready to
save, press {Ok}. You will be prompted to name the file. A .csv file will be created.

Exporting Logs
Logs are useful tools for diagnosing issues. ETC Technical Services may request that you email
logs if they are assisting you with an issue. See Help from ETC Technical Services (on page 3) for
information about contacting Technical Services.

If you are experiencing an issue, press [Displays] & [Record] to put a marker in the log file. This
marker along with any other additional information you provide will assist us in reproducing your
issue.

Note: Logs can also be created from the ECU. If created through the ECU, you will
have the option to add additional information to the file. See Save Logs (on page 526)
for more information.

Logs can be exported by going to the Logs option in the Browser. Select the location for the
export, the Show File Archive, a File Server (if connected), or to a USB device, and press
[Select].

An exporting logs message will appear while the log files are being created.

Deleting a File
Eos provides you with the ability to delete show files from the Show File Archive and the File
Server from within the Browser.
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To Delete a Show File
Navigate within the Browser to: File> Open and press [Select]. Navigate to the desired show file
and press [Delete]. Press [Enter] to confirm or any other key to abort the deletion process.

To Delete a Folder
The folder must first be empty.

Navigate within the Browser to: File> Open and press [Select]. Navigate to the desired folder
and press [Delete]. Press [Enter] to confirm or any other key to abort the deletion process.

File Manager
Eos has a File Manager (on page 527), which also provides a way to manage show files.
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About Patch
Eos treats fixtures and channels as one and the same, meaning each fixture is assigned a single
control channel number. Individual parameters of that fixture, such as intensity, focus, color,
and beam are also associated with that same channel number but as additional lines of channel
information.

The Patch is used to associate a channel with addresses and device types. Once a channel is
patched to an address or addresses, and the output is connected to a device (for example a
dimmer, automated fixture, or accessory), the channel will then control that device.

Patching can be done via two different methods: manually entering a patch and by patching
devices using RDM via the Device List. RDM allows bi-directional communication between the
console and any RDM devices over RDM or Ethernet. See Using Device List (on page 147).

For manual patching, you are required to only enter the simplest data to patch a device and
begin programming your show, such as the channel number, the device type (if needed), and
address. When you provide more information in the patch, you will have more detailed control
and improved function during operation.

One or more devices may be patched to a single channel. For example, you may want to patch a
group of dimmers to the same channel. In addition you may patch multiple devices to the same
channel for building compound or accessorized fixtures. For example, a Source Four® with a
color scroller and a gobo changer may be patched to a single channel. This is referred to as a
compound channel. See Creating Multipart and Compound Channels (on page 132).

When you open a new show file, Element 2 can create a 1-to-1 patch. This means that the patch
will automatically have channel 1 patched to address 1, channel 2 to address 2, and so on up to
the maximum channel count of your console. When outlined in yellow, the {Patch 1 to 1} button
is selected, and a 1-to-1 patch will be created.

Depending on your situation, you may need to create a custom patch, which associates certain
addresses with certain channels.

Note: You can open or merge patch data from other show files, see Partial Patch
Opening (on page 114) and Partial Patch Merging (on page 116) for more information.

A 1-to-1 patch can be created from the Clear display. See Clearing the Patch (on page 152)

Patch Main Display
To begin patching your show, you must first open the patch display. To open the patch display,
press [Address/Patch] twice or press [Displays] and then {Patch}. [Tab] [1][2] can also be used
to open Patch.

The patch display will open in the selected tab, and the CIA will display patch controls.

From within the patch display, you can open the Device List to use RDM to patch any RDM
compatible devices. For more information about Device List, see Using Device List (on
page 147).

For patching fixtures, there are two different patch modes: patch by channel and patch by
address. Eos defaults to patch by channel mode. Pressing [Format] while in the Patch display
will toggle the mode between patch by channel and patch by address.
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The patch screen will display the following information if available:

• Channel - the patched channel number. In patch by address mode, channel will appear
blank if not currently patched.

• Address - the patched output address. In patch by channel mode, address will appear
blank if not currently patched. Pressing [Data] toggles the display from showing address
as patched by the user, output address, and the port/offset. See Using Output Address vs
Port/ Offset (on page 129).

• Type - device, dimmer, or scenic element type that is patched. An asterisk (*) next to the
type indicates that the fixture profile needs to be updated. See Update Profile (on
page 152).

• Label - displays the assigned label of the channel or address. See Labeling (on page 137).
• Interface - displays which interfaces will be used for the device. See {Interface} in Patch

Section (on page 143).
• Output - displays the current live intensity level. Value is displayed as 0 through 255, with

255 being full. 16 bit intensity values will display as 0 through 65535.

Status in the Patch Display
Status flags will display on the far left of the patch display to advise you when a channel or
address requires your attention.

A red “!” or yellow “?” will display when there is an error or warning from an RDM, CEM+,
CEM3, or ACN device. See Errors and Warnings (on page 151).

Flexichannel Views in Patch
In patch by channel mode, [Flexi] can be used to view only those channels that are currently
patched. In patch by address mode, [Flexi] can be used to view only those addresses that are
currently patched. By pressing [Flexi], you can toggle the view between patched
channels/addresses, selected channels, and all channels/addresses.

Holding down [Flexi] will display the following softkeys:

• {Flexi All} - displays all the channels or addresses depending on which view is used.
• {Patch} - displays only the patched channels or addresses.
• {Selected} - displays any selected channels or addresses.
• {View Channels} - displays those channels selected for the View Channels flexichannel

state.
• {Partitioned} - only available when partitioning is enabled. Displays the following options:
• Partitioned Channels
• Partitioned Patched Channels
• Partitioned Selected Channels
• Partitioned View Channels
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Note: Scenic Element and Scenic Element Movable channels use no addresses when
patched, and will appear in the Flexi Patched display. For more information, see Scenic
Elements (on page 474).

Patching Conventional Fixtures
For patching fixtures, there are two different patch modes: Patching By Channel (below) and
Patching By Address (below). Eos defaults to patch by channel mode. Pressing [Format] while in
the patch display will toggle the mode between patch by channel and patch by address.

Note: When working with conventional devices, you can patch in either mode easily.
When working with compound channels or multiple parameter devices, such as
automated fixtures, it is recommended to work in patch by channel.

Patching By Channel
In patch by channel mode, [2] [0] [At] [1] [Enter] patches channel 20 to address 1. Pressing [At]
will post address to the command line while patching by channel.

Additional examples of patch by channel:

• [5] [At] [1][0][0] [Enter] - patches channel 5 to address 100.
• [2][0][3] [At] [1][2] [Enter] - patches channel 203 to address 12.

Range Patching
Range patching using the [Thru] key allows you to quickly patch a group of channels. [1][Thru]
[2][0] [At] [1] [0] [Enter] patches channels 1 through 20 to addresses 10 through 29.

You can also use the [+] and [-] keys. [1] [+] [4] [+] [8] [At] [1] [Enter] patches channel 1 to
address 1, channel 4 to 2, and channel 8 to 3. The [Group] key can also be used if groups have
been created.

Note: Range patching only works with channels. If you try to range patch addresses,
parts for the channel will be created. See Creating Multipart and Compound Channels
(on page 132).

Note: If you try to patch a channel or address that exceeds the console's output, an
error message will display on the command line.

Patching By Address
Pressing [Format] while in the patch display will toggle the mode between patch by channel and
patch by address.
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[2] [0] [At] [1] [Enter] patches address 20 to channel 1. Pressing [At] will post channel to the
command line while patching by address.

Additional examples of patch by address:

• [5] [At] [1][0][0] [Enter] - patches address 5 to channel 100.
• [2][0][3] [At] [1][2] [Enter] - patches address 203 to channel 12.

Note: If, at any point, you try to patch an address that is already in use, Eos will post
an advisory to indicate this, preventing you from duplicating addresses in your patch.

Using Output Address vs Port/ Offset
The output address is the DMX or network DMX (often called EDMX) address. Examples of
output addresses are 510, 1, and 1024.

Port/ offset refers to the DMX universe or port and the offset of the address. For example, since
a single DMX port can transmit 512 addresses (known as a “universe”), the port/ offset for
address 515 would look like 2/3 because address 515 is the 3rd address of universe 2.

An example of patching by port/ offset in patch by address mode is [2][/][1][0] [At] [2][0]
[Enter], which patches universe 2 address 10, or 522, to channel 20.

[At] [/] [n] [Enter] can be used to patch an address on the same universe that was last used.

Note: It is possible to patch by either address or port/ offset. Pressing the [Data] key
will move between showing the patch as it was originally entered, then the output
address values, and last the port/ offset.

Note: An address cannot be assigned to multiple channels, but a channel can have
multiple addresses assigned to it.

Replace
By default, if you patch an address to a channel that is already patched, Eos will create a new
part for the new address. If you want to replace the current address with the new, use
{Replace}:

• [n] {Replace} [n] [Enter] - replaces the address in part 1 of the selected channel.

• [1] [Part] [3] {Replace} [5] [Enter] - replaces the address of part 3 with a new address of
5.

At Next
[At] [Next] [Enter] finds the next available address range large enough to accommodate the
selected device.
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Examples of [At] [Next]:

• [At] [2] [/] [Next] [Enter] - finds the next available address range on universe 2.
• [At] [7] [7] [7] [Next] [Enter] - finds the next available address after 777.

[Address/Patch] [n] [/]
The syntax [Address/Patch] [n] [/] or [At] [n] [/] can be used to select a full universe in patch.

• [channel list] [Address/Patch] [n] [/] [Enter]or [channel list] [At] [n] [/] [Enter] - changes
the addresses of all the selected channels to a new universe while using the same offset.

• [Address/Patch] [2] [/] [Copy To] [Copy To] <Address> [3] [/] [Enter] - moves all
channels with addresses in universe 2 to the same offsets in universe 3.

• [Address/Patch] [n] [/] {Unpatch} - unpatches all patched addresses in the selected
universe.

Dimmer Doubling
You can patch channels in Eos to accommodate for dimmer doubling with Sensor dimmer racks.
This is done using the softkeys available in patch ({No Dim Dbl}, {A}, and {B}).

Example:
Let’s assume you patch 96 channels of dimmers to addresses 1 through 96.

• [1] [Thru] [9] [6] [At] [1] [Enter]

Now you wish to dimmer double 1 through 12 of your Sensor+ rack and you
want these to be channels 97 through 108. To patch this, press:

• [9] [7] [Thru] [1] [0] [8] [At] [1] {B} [Enter]

Channels 97 through 108 are patched to address 1 through 12 B, while
channels 1 through 12 are now patched to address 1 through 12 A.

To remove the dimmer doubling from these addresses, you must first press
[Format] to enter Address mode and then press:

• [1] [Thru] [1] [2] {NoDimDbl} [Enter]

Addresses 1 through 12 have been returned to single dimmer modes and
channels 97 through 108 are now unpatched.

By default, doubled dimmers start with an offset network DMX address value of 20000.
Therefore, in the above example, address 1B (channel 97) is actually controlled by network
DMX address 20001. Address 2B is actually controlled by network DMX address 20002 and so
on. This offset matches the default offset in CEM+ / CEM3 when configuring your Sensor
dimmer rack for dimmer doubling. To change the default offset value, see {Dim. Dbl. Offset} (on
page 169).

Note: For Sensor Classic racks using dimmer doubling, the offset value should be set
to 256.

Note: Dimmer doubling needs to be turned on per DMX port in Browser > Setup >
System Settings > Output. See Output (on page 175).

Note: There is also a Dimmer Doubling setting for Net3 Gateways with DMX outputs.
This is used with Sensor racks that are connected via DMX. The Gateway must be
properly configured.
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Moving and Copying Channels
Channels can be moved from one location to another within patch.

• [1] [Copy To] [Copy To] [2] - moves channel 1's data to channel 2. Channel 2's data is
replaced by channel 1's. Channel 1 is unpatched.

• [1][Copy To] [Copy To] [2][Part][2] - creates a part 2 for channel 2 and moves channel 1's
data to the new part. Channel 2's data remains in part 1. Channel 1 is unpatched.

The second press of the [Copy To] key changes the command from Copy To into Move To.

Note: Move To always impacts the entire show.

The following options are available with [Copy To]:

• [Copy To] - copies a channel to another location within patch.
• [Copy To] {Plus Show} - copies a channel to another location within patch and all record

targets in the show.
• [Copy To] {Only Show} - copies a channel to another location with all record targets in the

show but not the patch data.
• [Copy To] {Only Text} - copies only the notes and keyword fields from one channel to

another.

Swapping Channels
Channels can be swapped for each other in patch:

• [1] {Swap} [2] [Enter]

This syntax will replace channel 1's data with channel 2's and vice versa in patch and
throughout the entire show.

Note: Swap always impacts the entire show.

The following options are available with {Swap}:

• {Swap} - swaps only the patched address
• {Swap} {Plus Show} - swaps all show and patch data
• {Swap} {Only Show} - swaps only the show data and not patch data
• {Swap} {Plus Patch} - swaps addresses and patch data but not show data

Unpatch a Channel
To unpatch a channel while in patch you can press:

• [n] {Unpatch} [Enter]

The {Unpatch} softkey will reset all the properties of the channel to the default. This includes
removing the device type if specified.

To retain all the elements of a channel except its address, you would instead use:

• [n] [At] [0] [Enter]

Using [At] [0] will allow unpatched channels to still be manipulated and have data stored for
them, but they do not output any information (as they are unpatched).
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Deleting Channels
It is possible to delete channels in patch. Deleting channels is different from unpatching in that
deleted channels cannot be manipulated or have data stored for them. When deleted, the
channel numbers will still be visible in the live/blind display, but the channel graphic will be
removed from the display.

Example:
To delete channels in the patch display, press:

• [6] [Thru] [1] [0] [Delete] [Enter] [Enter]

-or-
• [Delete] [1] [Thru] [1] [0] [Enter] [Enter]

CAUTION: If a channel with programmed data is deleted, the recorded data
will be lost.

[Query] {Unpatched}
To quickly delete channels without addresses in the Patch display, you can use the command
[Query] {Unpatched} [Delete]. This will post to the command line all channels without
addresses. By pressing [Enter][Enter] you will delete them.

Using {Offset} in Patch
Using the {Offset} feature in patch allows you to force a numerical offset between the starting
address of channels in patch or for offsetting your channel selection. This feature is useful when
you have configurable devices in your show, such as a Source Four Revolution, which has option
slots for additional addresses (scrollers, indexing pattern wheels, and so on), or when your
devices' start addresses use a known multiplier.

Example:
When patching using a fixture type, this is a two step process because the
command line terminates after a fixture type has been selected.

1. [1] [Thru] [5] {Type} {Source Four Revolution}
2. [At] [1] {Offset} [3] [1] [Enter]

Hitting [At] will reselect the previously selected channels. The channels can
then be patched with an address offset of 31 channels, allowing you to have
additional space within the patch for a given fixture type regardless of
configuration or personality.

Note: For multiple parameter devices, Eos will automatically offset the addresses
based on the fixture type.

For more information about using {Offset}, see Offset (on page 190).

Creating Multipart and Compound Channels
A multipart channel is any channel that has more than one dimmer patched to it. A compound
channel has multiple profiles patched to it that make up one channel, an example would be a
dimmer with a scroller and auto-yoke. By default, Eos will add a part if you are trying to patch to
a channel that has already been assigned an address.

To patch a multipart channel in channel format:
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• [9] [At] [5] [4] [0] [Enter]

Assuming that channel 9 is already patched to an address, this will create a part 2 and address it
at 540.

• [8] [Part] [2] [At] [5] [1] [3] [Enter]

This will create a part 2 for channel 8 and address it at 513. If you wish to patch by address while
in the channel view, press:

• [Address] [5] [1] [3] [At] [8] [Enter]

Assuming channel 8 was previously patched to an address, this will create a part 2 and address it
at 513.

To patch a multipart channel in address format:

• [5] [1] [3] [At] [8] [Enter]

This will perform the same action as the previous example, assuming channel 8 was previously
patched to an address.

To select multiple parts for editing:

• [1] [Part] [1] [Thru] [5]

This is useful for deleting or assigning new addresses to existing parts.

To patch a compound channel in channel format:

• [1] [Part] [2] [At] [5] {Type} <scroller profile>

Creates a part 2 for channel 1 and assigns it the selected scroller profile. See Patch Section (on
page 143) for more information on using {Type}.

Use multiple parts without addresses to assign multiple fixtures in Augment3d positions that
share the same channel.

Patching Automated Fixtures, LEDs, and Accessories
The process of patching automated fixtures requires more detail than patching a dimmer.
Specific information is required for more advanced control of the features offered by automated
fixtures.

Note: It is recommended that when patching automated fixtures, LEDs, and
accessories that you work in patch by channel mode. See Patching By Channel (on
page 128).

After you have entered the channel number, click {Type}. You will then select a device type
from the fixture library.

Notice the softkeys {Show}, {Manfctr}, and {Search} located beneath the CIA.
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{Show} provides you with the option of showing only the library of fixtures or devices that are
already patched in the show, your favorites, and default devices. {Manfctr} shows all fixtures or
devices available in the library sorted by manufacturer.

Press {Manfctr} from the CIA to display the fixture library. The two columns on the left are
pageable and show manufacturer names. Use the arrow buttons to scroll the list of
manufacturers. Selecting a manufacturer repaints the device columns with all devices from that
manufacturer that are available for patching.

Scroll through the device list and make your selection. If a fixture has multiple modes or types, it
will display in blue text. Clicking on its name will open a list of available modes. After the
selection is made, the fixture or device type will be placed on the command line after the
channel number and displayed in the box beneath the {Type} button.

Press {Search} to open the search window. You will need an external alphanumeric keyboard or
you can click the keyboard icon in the search window to open the virtual keyboard. You can also
navigate the list as you would the browser. You can search by manufacturer name, fixture
name, part of a name, and by DMX footprint. For example, if you searched for 31, you would
see all of the fixtures that have a DMX footprint of 31. Double clicking on a fixture name will
patch it.

In the search window, press {Parameters} to view a parameter list for a fixture, or press {Fixture
Notes} to see any notes that exist for it. You can also view this information in the Fixture Editor.

Press [At] and then enter a starting address for the selected channel or group of channels. The
console will automatically offset addresses based on the fixture type selected.

Fixtures can be added to your show list without first patching them. With nothing on the
command line, click {Type}. You can then select a device type from the fixture library, and click
{Add Show} to add to your show list. If you want to delete a fixture or device from the show list,
click {Edit} while in the show display. Select the device you wish to remove and click {Delete}.

To select a device interface (optional), click {Interface}. See Output Protocols (on page 522).

Click the {Attributes} softkey to set detailed automated fixture attributes. The following buttons
may be available on this page depending on the device selected: {Preheat}, {Proportion},
{Curve}, {Fan Curve}, {LD Flags}, {GM Exempt}, {Invert Pan}, {Invert Tilt}, {Swap P/T},
{Color Path}, {Scrollers}, {Gobo Wheels}, {Color Wheels}, and {Effect Wheels}. Additional
buttons maybe available based off of your fixture type. See Attribute Section (on page 144).

If your automated fixture includes parameters such as a color scroller or gobo wheel and you
have custom gels or non-standard patterns installed, use the Scroller/ Wheel Picker and Editor to
modify the device patched. The more specific your patch data (including accurate colors and
patterns), the more detailed programming and operating will be. See Using the Scroller/Wheel
Picker and Editor (on page 137).
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Patching Multicell Fixtures
Fixtures that have multiple same-type parameters can have a multicell profile assigned to them.
The process for patching multicell fixtures is similar to patching automated fixtures. There are a
few differences that are important to understand though.

Note: It is recommended that when patching multicell fixtures that you work in patch
by channel mode. See Patching By Channel (on page 128).

After you have entered the channel number, click {Type}. You will then select a device type
from the fixture library.

Fixtures that have multicell functionality will be listed with a MC in their mode description in the
device list, and in the {Show} list.

Note: When using {Search}, the number of cells for a multicell fixture will also be
displayed.

When these devices are patched, they will patch a master channel with a whole number for a
channel number and the appropriate number of additional cells, which will have point numbers
for their channel numbers.

• [1][0] [At] [5] [Enter] - patches channel 10 and all of its cells starting at address 5.
• [1][0] [.] [1][2] [Thru] [1] [At] [5] [Enter] - patches channel 10's cells 12 through 1

starting with cell 12's address beginning with address 5.

Note: If the master channel has only a virtual intensity over the cells, an address will
not be displayed, as that is a virtual parameter.

In the fixture editor, you can view and edit the personality for your multicell fixture. For creating
a new multicell fixture, see Creating Multicell Fixtures (on page 164).

On the left of the fixture editor, you can see the fixture name, overall DMX footprint and
number of cells. Click on the caret to see the DMX footprint for the master and the cells. The
cells will be grouped with their profile(s).
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On the right, you can see the full personality of the selected multicell fixture. If you have the
whole fixture selected, you will be able to see all of the parameters for each cell and the master
but changes cannot be made here.

See Editing Multicell Fixtures (below) for more information.

Editing Multicell Fixtures
You will need to select the master or cell profile to edit parameters. In this view, you'll be able
to edit parameters, DMX, Home, Snap, and ranges/modes. See Creating a New Fixture (on
page 153) and Range Editing a Parameter (on page 156) for more information.

To change specific cell data such as DMX offset, you will need to use {Edit Multicell}. With a
multicell fixture or a master cell selected in the fixture editor, press {Edit Multicell}. In the Edit
Multicell window, you can edit cell numbers, DMX offset, and mastered cells for each cell.
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Once you are finished editing, press {Save Fixture} to save your changes or {Cancel Edit} to
remove the changes and exit the edit mode.

Labeling
To label a channel or address, press the [Label] key with the channel or address selected on the
command line. You can use the virtual alphanumeric keyboard or an external keyboard to enter
the desired label text.

Note: If you would like your label to word wrap, use || to create a line break between
words.

Using the Scroller/Wheel Picker and Editor
The scroller and wheel picker allows you to choose a specific scroll, color wheel, gobo wheel, or
effect wheel from standard manufacturers and associate them with fixtures. You may also
create customized scrolls/wheels using the editor to match custom devices installed in your
fixture.

Note: Scrollers, color wheels, gobo wheels, and effect wheels can be created without
first selecting or patching a fixture.

Using the Picker
Default color and pattern media for the selected fixture, as determined in the fixture library, is
displayed in the {Attributes} page. Only the media attributes that are available for the selected
fixture will display.

In the image below, the selected channel is a Source Four Revolution® with a color scroller and
two gobo wheels. If the selected channel included other wheels, each device would be
represented in the display with a button.
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The picker displays on the left half of the CIA when you select the specific attribute ({Scroller},
{Color Wheel}, {Gobo Wheel}, or {Effect Wheels}). The picker displayed is specific to the
selected attribute (the scroll picker will display when {Scroller} is pressed, the color wheel picker
will display when {Color Wheel} is pressed, and so on).

The picker displays buttons for the standard scroll or wheel type of the selected channel. The
default selection is the wheel as shipped from the manufacturer (derived from the fixture
library). Displayed to the left of the standard scroll/wheel selection is a list of each color/gobo as
they are installed in the selected device (frame by frame). When the color or pattern image is
available, it will display next to the frame name.

In the above image, {ETC Scroll} is the default scroll for the selected ETC Source Four
Revolution. The list of gel colors as they are installed in the scroll are displayed to the left with a
color chip for easy reference. Selecting any other type, such as {Martin Scroll 2}, updates the
frame list.

The softkeys displayed beneath the picker are {Clear Calib}, {Copy Scroller}, {Clear}, {New},
{Copy}, {Edit}, and {Delete}.

• {Clear Calib} - clears out the calibration data for the whole scroller wheel and returns to
the wheel’s default data.

• {Copy Scroller} - used to copy a scroller wheel and its calibration to another channel. See
Scroller Calibration Column (on page 142).

• {Clear} - clears the selection type from the selected channel in the picker.
• {New} - creates a new scroll or wheel and provides additional softkeys to enable the

Editor. See Using the Editor (below) .
• {Copy} - makes a copy of the currently selected scroll/wheel type, which can then be

edited using the editor. See Using the Editor (below) .
• {Edit} - used to edit an existing scroll or wheel.
• {Delete} - used to remove the selected frame only from a scroll or wheel that you have

created.

Using the Editor
The editor is used to create new or edit copied scrolls and wheels. While in the picker display,
you can create a new scroll or wheel by pressing the {New} softkey or make a copy of an
existing scroll or wheel by selecting the source, then pressing the {Copy} softkey.

The editor does not limit how many frames you can add to the scroll or wheel for the selected
fixtures. Keep in mind that any fixture has its own limitations. For example, if you have created a
custom color scroll with 30 frames, your selected fixture type may only provide you access to the
first 24 frames that you created. This applies to wheels as well.

Note: If you try to select an existing scroll or wheel, the console will display a warning
if it has more frames than are supported by your device.

When using the editor, the following softkeys are available for use:

• {Insert} - inserts a new frame above the selected frame.
• {Delete} - removes the selected frame.
• {Edit} - changes the selected frame.
• {Invert} - reverses the order of the frames.
• {Done} - completes the editing process.
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Creating a New Scroll or Wheel
When you create a new scroll or wheel, {New Wheel n} appears in the wheel list as the selected
button. The frame list will be empty with only “New” displayed in frame 1.

You can label the new wheel by pressing [Label] and typing the desired label on the virtual
keyboard and pressing {Enter}.

To select a color or pattern for the specific frame in the scroll/wheel, select the “NEW” text and
press {Edit} or click the gray box in the C/G column of the frame. The available gel, color, gobo
and effect media selections will be displayed.

The media selection includes the following softkeys:

• {Gel}, {Color}, {Gobo}, and {Effect} - each will display available media selections as they
are cataloged by the associated scroll or wheel manufacturers.

• {Open Frame} - places the frame in Open White. Generallly, the first media frame is
open.

• {Cancel} - cancels the media selection and returns to the frame editor.

When a manufacturer is selected from the list, the catalog selection changes to display only the
selected manufacturer’s offerings. When a specific catalog is selected, the selected media will
display.

When you make a media selection, the display returns to the new wheel frame list where
additional frames can be added to the scroll or wheel by selecting the next frame area to add
more frames.

Note: An {Invert} softkey will display when creating or copying a wheel or scroller.
{Invert} is used to reverse the order of frames.

Note: It is possible to import custom gobo images. See Importing Custom Gobo
Images (on page 122) for more information. To use a custom gobo image, select
{Gobo} and then {Custom}.
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Editing a Copy of a Scroll or Wheel
If a copy has been made of an existing scroll or wheel, the copied scroll or wheel will display as
{New Wheel n} before the standard manufacturer offerings. The frame list will include an exact
duplicate of the copied selection.

To make a change to a frame, first select the frame then press {Edit} or click the gray box in the
C/G column to display the media selection. Or you can insert a new frame above a selected
frame using the {Insert} softkey.

For example, to insert a new frame in between existing frames 2 and 3, select frame 3 and press
the {Insert} key. The media selection will display.

The media selection includes the following softkeys:

• {Gel}, {Color}, {Gobo}, and {Effect} - each will display available media selections as they
are cataloged by the associated scroll or wheel manufacturers.

• {Open Frame} - places the frame in Open White. Generallly, the first media frame is
open.

• {Cancel} - cancels the media selection and returns to the frame editor.

When a manufacturer is selected from the list, the catalog selection changes to display only the
selected manufacturer’s offerings. When a specific catalog is selected, the selected media will
display.

When you make a media selection, the display returns to the new wheel frame list where
additional frames can be edited in the scroll or wheel.

Scroller Fan Curves
Curves can be applied to the scroller fan parameter allowing for the output of the fan to be
controlled by the intensity of the channel. The curves available for this are the same used for
intensity parameters and cues. See Applying a Curve To Scroller Fans (on page 395).

To set a curve to a scroller fan, go to Displays>Patch>Attributes>Fan Curve for each scroller.

Calibrating a Scroller Using the Encoders
You can calibrate the center point of any frame in a scroller using the calibrate feature.
Calibrating a scroller is normally done from the live display. You can also calibrate using the ML
display. See Calibrating a Scroller Using the ML Display (on the facing page).

On Element 2, you will need to use the ML display.
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Note: It is recommended that you calibrate your scroller frames starting with the last
frame and working backward to the first frame. This will help ensure a complete and
accurate calibration.

Note: Calibration may need to be performed when you initially patch a scroller and
may need to be adjusted through the course of operation as spring tension changes in a
color scroller.

To calibrate a scroller:

1. Select the channel of the scroller you wish to calibrate.
2. Press the [Color] encoder button. Multiple presses may be required before the scroller

encoder is visible in the encoder LCD.
3. Use the encoder to move all the way to the last frame of the scroller.
4. Continue adjusting the frame in fine mode until the frame is centered in the desired

position.
5. Press {Calibrate} in the encoder LCD. The new center position is now stored for the

selected channel.
6. Press {Last} in the encoder LCD to move to the center point of the previous frame.
7. Visually verify if the center point of the new frame is accurate. If it is, press {Last} again to

move to the previous frame in the scroll. If not, follow the calibration procedure again.
8. Repeat steps 4 through 8 until you have calibrated all of the frames

Calibrating a Scroller Using the ML Display
You can calibrate the center point of any frame in a scroller using the calibrate feature. This will
ensure that color scroll frames will be centered over the aperture of the fixture when you
advance a color scroll frame-by-frame. You can do this using the ML Controls display. See
Moving Light Controls (on page 100) for more information.

Note: It is recommended that you calibrate your scroller frames starting with the last
frame and working backward to the first frame. This will help ensure a complete and
accurate calibration.

Note: Calibration may need to be performed when you initially patch a scroller and
may need to be adjusted through the course of operation as spring tension changes in a
color scroller.

To calibrate a scroller:

1. In the Live display, select the scroller channel.
2. Open the ML Controls from the home screen or by using [Tab] [5].

On Element 2, you can open the ML Controls by pressing [ML Controls].

The color category will display automatically with the Hue and Saturation and scroller
encoders and a frame picker open. If the scroller encoder isn't open, click the {Scroller ::}
button.

3. To begin calibrating, use the scroller encoder to adjust the centerpoint of a frame. It is
recommended that you start with the last frame in the scroll.

4. When the frame is centered, click {Calibrate}.
5. Repeat for any remaining frames that need to be calibrated.
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Scroller Calibration Column
Calibration information will be displayed in the scroller calibration column. Values in gray are
the default data, and the values in blue are calibrated data.

The displayed calibration information is the DMX level that puts the frame into its center
position. Information in the calibration column can be manually edited by clicking on it and
typing in a new DMX level.

Note: Calibration data will only be applied to scroller wheels that are assigned to a
channel. Data will not be displayed when viewing a wheel with an empty command
line.

Note: Calibration data can be returned to its default by clicking on the data and
pressing [Clear]. If you are entering in new data and hit [Clear], the data will return to
the default and not any previously calibrated data.

Pressing the softkey {Clear Calib} will clear out the calibration data for the whole scroller
wheel, returning it to the default data.

Scroller wheels and their calibration data can be copied to other channels.

• [1] {Copy Scroller} [2] [Enter] - copies the scroller and calibration data from channel 1 to
channel 2.

Scrollers that have calibrated data will display a “~” after their name.

The {Calibrate} button will now only appear on scroller parameters that are currently not at the
center of a frame.

Reordering Shutters
Shutters can be reordered in the Patch {Attributes} page. Press the {Shutter Order} button to
open the shutter order display. The {Shutter Order} button will only display if a channel with
shutters is currently selected.



Patch 143

In this display, you can invert the {Shutter Order} or rotate the order using the arrow buttons.
After you have created the order needed, press {Apply} for your changes to take effect.

Invert Rack
An {Invert Rack} option is available in Patch>Attributes>Scrollers/Wheels. This option will only
display when a fixture with a shutter frame assembly parameter is selected.

The shutter frame assembly parameter allows for the shutter assembly to be turned. When
{Invert Rack} is disabled, a encoder will move the frame assembly from the right. When
enabled, the frame assembly will move from the left.

Patch Section
With patch open, Eos defaults to this section. It provides access to data input fields that you may
use to define devices in your lighting system.

Note: The Art-Net and sACN offset will display here.

• {Channel} - In the patch display, all channels are displayed in numerical order. When
multiple devices are patched to the same channel, the channel number is only displayed in
the first row, additional devices are indicated with part extensions (example P2) on the
next row of the table.

• Select the channel number using the control keypad or the direct selects.

• {Type} - Eos defaults to patching dimmers. To specify a specific device type for the
selected channel, press the {Type} button from the CIA.

• The two columns on the left side of the CIA are pageable and show manufacturer names.
The four columns to the right of the manufacturer’s list are pageable devices that are
available from the selected manufacturer for patching.

• Selecting a specific manufacturer repaints the display with all devices that are available
from that manufacturer. After you select a device, the fixture/ device type appears in the
command line, in the {Type} box in the CIA, and in the “Type” field for that channel in the
patch display.

• {Label} - An optional user-defined label. You can use the [Label] key to display the virtual
PC keyboard on the CIA. Pressing {Label} or [Label], after a label has already been
assigned, will display the label on the command line for editing purposes. Pressing [Label]
[Label] will clear the text.

• [1] [At] [5] [Label] <S4 house right> [Enter] - patches channel 1 to output 5 and labels
channel 1 as “S4 house right”.

• {Address} - Required for DMX control of devices. You may use the either the [At] or
[Address/Patch] key instead of the {Address} button.
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• Use the keypad to define the starting address for the device (from 1 to 32,767,488) or a
port and offset value.You may enter a start address without defining an end address.

• Eos will draw this information from the library data. If you wish to leave a larger output
gap than required by the library, use {Offset}. See Using {Offset} in Patch (on page 132).

• If you specify a start address that conflicts with other channels already patched, the
conflicting channels will be unpatched after a confirmation is provided by the user.

• {Interface} - An optional field used to specify what protocols and interfaces should be used
for the output. When the field is left blank, the default data output is used as selected in
the {Network} section of the ECU and {Outputs} section of Setup. For more information
about setting defaults see Output Protocols (on page 522) and Output (on page 175). The
interface options available are sACN, Net 2- EDMX, ArtNet, Avab UDP, and Local DMX,
depending on what has been enabled for the console. If an output option is not enabled, it
will appear grayed out in the {Interface} list.

• {Preserve Native} - When Preserve Native is enabled, and you make changes to patch,
your cues' real world levels (like pan degrees) will be converted so that the DMX output is
preserved instead of the degrees. This is primarily useful for fixture substitutions.

• {Flash} - will bring a channel or address to full, and then every other second the level will
move to 15%. That will hold for 1 second, and then the level will return to full. The
channel or address will keep flashing until either the command line is cleared or {Flash} is
selected again.

Attribute Section
The Attributes section provides you with optional fields for additional information and details
about the configuration of your rig. Attribute settings include {Preheat}, {Proportion}, {Curve},
{Fan Curve}, {LD Flags}, {GM Exempt}, {Invert Pan}, {Invert Tilt}, {Swap P/T}, and {Color Path}.

With one or more channels selected, Scrollers / Wheels will display only the parameters that
apply to those fixtures will appear. Press the desired attribute button and use the keypad to set
the attribute value.

• {Preheat} - This field allows you to specify an intensity value to preheat incandescent
filaments. When a preheat flag is applied to a cue, any channels that are fading from zero
to an active intensity and have been assigned a preheat value in patch will preheat in the
immediately preceding cue. The preheat flag is applied to a cue as an attribute when the
cue is recorded.

• [1] {Preheat} [0] [3] [Enter] - channel 1 is assigned a patched preheat value of 3%.

• {Proportion} - An attribute to set a modifier for the intensity of the device. For example, if
the proportion is set at 90%, the actual output will always be 10% lower than the
specified intensity parameter, as impacted by the various playbacks or submasters. This
value is set numerically in a range of 0% to 200%.
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• [1] {Attributes} {Proportion} [1] [2] [5] [Enter] -applies a 125% proportion to channel 1.
• [1] {Attributes} {Proportion} [Enter] - removes the applied proportion from channel 1.

• {Curve} - Used to assign a curve to a channel in Patch. In Patch, curves can be applied to
intensity and non-intensity parameters. See About Curves (on page 392) for more
information.

From channel view:

• [1] {Curve} [4] [Enter] - applies curve 4 to the intensity parameter of channel 1.
• [2] [Part] [3] {Curve} [3] [Enter] - applies curve 3 to the intensity assigned to channel 2,

part 3.

From address view:

• [3] {Curve} [3] [Enter] - assigns curve 3 to address 3.
• [3] [/] [2] {Curve} [4] [Enter] - assigned curve 4 to universe 3, address 2.

• {Fan Curve} - Used to assign a curve to the scroller fan parameter, which allows for the
output of the fan to be controlled by the intensity of the channel. Curves available for this
are the same used for intensity parameters and cues.

Note: When {Curve} or {Fan Curve} is pressed, a list of the available curves will be
displayed. Clicking on an available curve will assign it.

• {LD Flags} - This field allows channels to contribute to live and dark move flags in the
playback status display. Disabling will prohibit those channel moves from contributing to
the live and dark move flags. This is enabled by default.

• {GM Exempt} - Used to exempt the intensity of channels from grandmaster, blackout,
rem dim, and go to cue 0 operations.

• {Invert Pan} {Invert Tilt} - An automated fixture attribute used to invert the output of pan,
tilt, or both. Select either the {Invert Tilt} or the {Invert Pan} button on the CIA.

• [2] {Attributes} {Invert Pan} - inverts the output of the pan parameter on channel 2.

• {Swap P/T} - An automated fixture attribute used to exchange pan and tilt levels. Select
the {Swap} button on the CIA.

• [2] {Attributes} {Swap} - swaps the pan and tilt parameters for channel 2.

• {Color Path} - A default Color Path can be assigned at the channel level in Patch. That
color path will be used for all of that channel's color fades unless overridden at the cue
level. Submasters and manual transitions that use that channel will use the default color
path as well. See Color Path (on page 204)

• [1] [Path] [2] [Enter] - will assign color path 2 to channel 1.

• {Scrollers} - An attribute used to change the scroll loaded in a scroller or automated
fixture. Select the {Scrollers} button on the CIA to display the scroller picker and the
scrolls available for your device. See Using the Picker (on page 137)

• [2] {Attributes} {Scrollers} -opens the Scroller Picker in the CIA for scroll selection for
channel 2.

• {Color Wheels} - An attribute used to change the color wheel loaded in an automated
fixture. Select the {Color Wheels} button on the CIA to display the wheel picker with the
options available for your device. See Using the Picker (on page 137) “More” as shown in
the patch display, indicates additional parameter properties are available for the selected
device, such as the color and gobo wheels.

• [4] {Attributes} {Color Select} - selects channel 4 and opens the wheel picker in the CIA
for color wheel selection.
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• {Gobo Wheels} - An attribute used to change the gobo wheel loaded in an automated
fixture. Select the {Gobo Wheels} button on the CIA to display the wheel picker with gobo
options available for your device. See Using the Picker (on page 137)

• [3] {Attributes} {Gobo Select} - selects channel 3 and opens the Wheel Picker in the CIA
for gobo wheel selection.

• {Effect Wheels} - An attribute used to change the effect wheel loaded in an automated
fixture. Select the {Effect Wheels} button on the CIA to display the wheel picker with the
options available for your device. See Using the Picker (on page 137) “More” as shown in
the patch display, indicates additional parameter properties are available for the selected
device, such as the color and gobo wheels.

• [5] {Attributes} {Beam FX Select} - selects channel 5 and opens the wheel picker in the
CIA for effect wheel selection.

Database Section
The Database section provides you with additional fields for entering information that can be
used by the Query function. See Using Query (on page 314). These fields include {Notes} and
{Text 1} through {Text 10}. Clicking on {Text 1} through {Text 10} will open up a display for
selection of keywords. It will display keywords that were already created as well as showing an
option for creating new keywords. Clicking on {New Keyword} will display an alphanumeric
keyboard for entering in a new keyword.

• {Text} - Text fields are used to provide up to ten keywords about any channel or group of
channels. These fields can be anything that you think is important about a channel, such
as its location (FOH), an attribute of it (wash, spot) or other characteristics of the channel
(such as gel R80). Select {New Keyword} and use the virtual keyboard in the CIA, or an
external keyboard, to provide up to 30 characters of key words about the device.

• [5] {Database} {Text 1} < FOH right> [Enter] - adds text to channel 5.
• [5] {Database} {Text 2} [Label]downstage right [Enter] - adds text to channel 5.

• {Notes} - Provides you the ability to attach a text note to a channel or group of channels.
Select the {Notes} button on the CIA to display the virtual keyboard. You may type a label
or any length of note regarding your channel in this space.

• [5] {Database} {Notes} <this fixture is a backup to channel 15 for front of house right /
new lamp installed on 10/4/17> [Enter] - adds a note to channel 5.

• {Gel} - The Gel field is a dedicated location for notes about gels.
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Adding Keywords in Patch
If you plan on being able to query channels based on a keyword association, the keyword must
be defined in patch.

Keywords entered are automatically used by Augment3d as tags on the associated channel /
fixture. Spaces are replaced with an underscore (_). For more information on tags, see Hierarchy
(on page 449).

To enter a keyword for a channel:

1. In Patch > Database, select a channel or range of channels in the command line.
2. Touch one of the {Text (1-10)} touchbuttons in the CIA to specify which keyword you are

entering. A list of previously defined keywords will be posted. Select from these or press
{New Keyword}. A virtual alphanumeric keyboard will appear.

3. Type the keyword or words you wish to use.
4. When finished, press [Enter].

Once keywords have been created, they will appear in the keyword section of the CIA when a
query is performed. For more information on keyword queries see Using Query (on page 314).

Deleting Keywords from the Database
Keywords can be deleted from any of the ten text fields in the database. To delete a keyword
from the entire database, you would use the following syntax:

• [Delete] {Text1} <orange> [Enter] [Enter]

This will delete orange anywhere it was used in any text field of any channel.

To just remove a keyword from a specific channel, you would use the following syntax:

• [1] {Text1} [Enter]

That would remove the text from channel 1's first text field only. If you wanted to clear the
second text field, you would select {Text2} and so on.

Renaming Text Fields in Patch
You can rename the text fields. By default, the text fields are named {Text 1} through {Text 10}.
Text fields 1 through 10 display in the Patch display. Renaming those fields will rename the
columns associated with them in the Patch display.

• {Text 1} [Label] <Position> will rename the text 1 field to Position.

Augment3d Section
The Augment3d section provides you with the patch fields and properties that are specific to
Augment3d. For more information, see Manually Adding Fixtures.

Using Device List
The Device List is used to discover, configure, and monitor compatible Remote Device
Management (RDM) and network devices. RDM allows for bi-directional communication
between a RDM compatible device, such as a lighting fixture, and your console.

Two lists, dimmer and RDM, make up the device list.

The dimmer list is the area of patch that handles setting up dimmer feedback from CEM+,
CEM3, and FDX 2000/ 3000. You can also do some configuration of dimmers from this list.
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The RDM List is the area of patch that handles RDM feedback with devices. You can also do
some configuration of devices from this list. Once RDM compatible devices have been patched,
they keep communicating with the console to allow you to know when things like blown lamps
happen or if a device goes offline for some reason. See RDM Device List (on the facing page)

The Device List displays all discovered devices during the current session and all devices that
have been stored in the show file.

Note: Consoles only support RDM devices that are connected through a Gadget,
Local I/O, or external ACN gateway (running version 5.1 or higher).

Dimmer List for CEM+, CEM3, and FDX 2000/3000

Note: For Dimmer Feedback, these software versions are required: CEM+ v3.0 and
newer, CEM3 v1.3.1 and newer, and FDX v3.4.0 and newer.

To use the Dimmer Feedback area of the Device List, you must first enable feedback. In the
network tab of the ECU, when using CEM+ or CEM3, make sure {Sensor/ FDX3000 Feedback}
is enabled, or when using FDX 2000/ 3000, make sure that {Sensor/ FDX3000 Feedback} or
{FDX2000 Feeback} is enabled. The default setting is disabled for both. See Interface Protocols
(on page 523)

Open the Dimmer Feedback display while in the Patch display by pressing {Device List}>
{Dimmers}. When the dimmer list is opened, the dimmers will be displayed in Patch by Address
mode.

Eos will display the following information that it receives from the dimmers:

• Address
• Channel
• Label
• System
• Rack
• Lug
• Module Type
• Firing Mode
• Control Mode
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• Curve
• Recorded Loads

Note: The System ID number from CEM3 is not currently supported.

Note: Rack numbers and dimmer numbers need to be unique for Eos to properly
recognize them. For CEM+, dimmers also need to be patched to different sACN
addresses.

With a dimmer or dimmers selected, you can edit various dimmer settings in the property view,
which will display in the CIA. Items with a caret (>) are editable. When multiple dimmers are
selected together for editing, an “*” will show for data that is different between the selected
dimmers.

FDX dimmers will not display data for the following:

• Recorded Load
• Actual Load
• Rack Dimmer Source
• Threshold
• Scale Minimum
• Preheat Enable
• Preheat Timing
• AF Enable

Note: When dimmers are discovered, they are not automatically attached to patched
channels in Eos; you must attach a dimmer to a channel. See Patching Discovered
Dimmers and RDM Devices (on page 151)

RDM Device List
Before you can start using the RDM Device List, you must first enable {RDM} for the appropriate
DMX ports in Setup > System > Output, or for the appropriate ethernet ports in the Network
ECU tab. By default RDM is disabled. See Output (on page 175) or Interface Protocols (on
page 523) If using Network RDM, this must be done via an ETC Net3 Gateway and RDM must
also be enabled on the DMX ports of the Gateway. The Gateway needs to be running version
5.1 or newer.

Open the RDM Device List while in the patch display by pressing {Device List}> {RDM}.

You will need to make sure that {Device Discovery} is enabled.
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{Device Discovery} is disabled by default. The {Device Discovery} option will not display if
{RDM} is disabled in the ECU.

Note: {Device Discovery} will automatically disable when you leave the patch
display.

When the RDM device list is opened, the devices will be displayed in Patch by Address mode. At
the top of the list is a RDM indicator. This indicator shows incoming and outgoing RDM traffic.

Eos will display the following information that it receives from the RDM devices:

• Address (a part will be added if multiple devices are discovered with the same address)
• Channel
• Label
• Manufacturer
• Model
• Footprint

Eos will also display what personality from the library the device matches in the Eos Type
column. This information will not display until you first select the device. Once the device has
been selected for the first time, Eos will extract the type information from the device and display
it.

• The following messages may display in the Eos Type column:
• No RDM Data Available - no model specific RDM data has been extracted from the

device.
• Extracting RDM Commands - currently getting the command data from the device.
• Extracting RDM Fixture -currently getting the data required to create a fixture definition

for the device.
• Extracting RDM Sensors - currently getting the sensor definitions from the device.
• Offline - no model specific RDM data has been extracted from the device and it is now

offline.

With a device or devices selected, you can edit various device settings in the property view,
which will display in the CIA. Items with a caret (>) are editable. When multiple devices are
selected together for editing, an “*” will show for data that is different between the selected
devices.

The following buttons will also display in the property view:

• {Device Properties} - opens the properties list for the selected RDM device.
• {Sensors} - displays if the selected device has sensors. Pressing {Sensors} will open the

sensors list.
• {Lamp Controls} - displays if the selected device has lamp controls.Pressing {Lamp

Controls} will open the lamp controls list.
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• {Channel} - channel number of the selected device.
• {Address} - address of the selected device.
• {Device Discovery} - allows for discovery of RDM devices.
• {Ignore Errors} - when enabled, errors messages will not display in the live/blind displays.

They will still display in about and the properties display in patch.
• {Reload RDM Data} - deletes the fixture data from the console and reloads it from the

device.
• {Flash} - triggers the identify function of the RDM device. The identify function may defer

between different manufacturers' devices. For example, Wybron scrollers identify by
wiggling their gel back and forth.

• {!} or {?} - displays if selected device has errors. Pressing {!}/{?} will open the error list.

Patching Discovered Dimmers and RDM Devices
When dimmers/devices are discovered, they are not automatically attached to any patched
channels in Eos. If you want the benefits of dimmer or RDM feedback, you must attach a
dimmer or device to a channel.

If you patch a dimmer/device's address to a channel, while in the device list display, the
dimmer/device will be automatically attached to that channel. However, if you patch outside of
the device list, you will need to {Attach} the device to the channel.

Note: If the dimmer/device's address is not yet used in the patch, it is easiest to patch
the address to a channel in the dimmer list or device list screen.

<Chan> [X] {Attach} or <Address> [X] {Attach} will link that channel/address in patch and the
dimmers/devices at that address.

When a channel number is attached to a dimmer/device, by patching it or using {Attach}, the
channel’s fixture type is changed to the dimmer or device fixture type.

The advantages of attaching a dimmer to a channel are:

• The console warns you when a channel’s attached dimmer has an error or is offline.
• Items that are attached between patch and the device list will display a caret (>) beside

their channel/address in patch.

The advantages of attaching a device to a channel are:

• Its fixture type is copied to the channel.
• The console warns you when a channel’s attached device is offline or has an error.
• The device will always appear in the device list display, even if the device is offline.
• Items that are attached between patch and the device list will display a caret (>) beside

their channel/address in patch.

Errors and Warnings
One of the advantages of using dimmer and RDM feedback is error and warning reporting. If
something happens with a patched and attached dimmer/ device, you will be notified in Live,
Patch, and About with an exclamation mark.

Errors can be viewed in the About Channel and About Address displays.

The notifications you can see are:

• A red “!” means that the dimmer/ device has errors, such as overtemp, breaker trip, and
lamp out.

• Yellow “?” means that the dimmer/ device has a warning message. Warning messages
can include:
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• Multiple devices’ addresses overlap
• Multiple devices or different devices at this address
• Patched fixture type mismatch
• Patched fixture address mismatch
• Offline

Detaching Devices
Pressing {Attach} twice will post the {Detach} command.

<Chan> [X] {Attach} {Attach} or <Address> [X] {Attach} {Attach} will remove the link between
that channel/address and the device at that address.

Clearing the Patch
You can clear the patch entirely by accessing the clear functions from Browser> Clear. The clear
functions window will open in the CIA.

To clear the patch, click {Clear Patch}. A confirmation is required before the patch will be
cleared.

To create a 1-to-1 patch, click {Patch 1 to 1}. This will remove the current patch.

To exit the clear functions screen without clearing, press the [Displays] key at any time or select
a clear button and then select {Cancel} from the confirmation screen.

Update Profile
When a new library is installed on Eos either from a software update or a separate fixture library
file from the ETC website, changes in library data will not automatically update your show files.
This is to prevent library changes from affecting a functional show file.

Using the {Fixtures} softkey in patch will open up the list of fixtures used in the current show file.
In this view, you will be able to tell which fixtures in the currently loaded show file differ from
the console’s fixture library. Fixtures that have either been edited or their profile does not match
the current library will display with an "*" beside their name. For fixtures that have a library
update, the {Update Profile} softkey will display in white, and for fixtures that don’t have an
update, the {Update Profile} softkey will be grayed out.

Note: When updating a fixture in Patch, a warning message will display that includes
what changes will be made to the fixture by updating it. Press {Ok} to update the
profile or {Cancel} to return to the fixture editor.

Note: For multi-console systems, all devices have to use the same fixture library. If
the fixture library is different between devices, a warning will be displayed on the
device trying to connect to the system.
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Fixture Editor
Eos provides you with the ability to create your own fixture type within patch and store it with
your show file. You can name the fixture, assign all necessary parameters, define the address
and operational range of those parameters, see fixture modes and their properties, and set lamp
controls.

Note: Before you create a new fixture, it is helpful to look at a few fixture
personalities of similar fixtures to get an idea of how to set yours up. You may even
want to look at their user manuals to see how their defined DMX footprints look as a
fixture profile. This is especially helpful when creating modes.

The fixture creator is accessible from patch. Once a fixture has been created, it is stored in the
show file. It is not added to the fixture library. If you want to use the created fixture in another
show file, you will need to use merge. See Merging Custom Fixtures into a New Show File (on
page 166)

If you would like to remove any unused fixtures from this list, press {Delete Unused}.

To open the fixture editor:

1. Press [Address/Patch] twice or [Displays]> {Patch} to open the patch display.
2. Press the {Fixtures} softkey. This will open a list on the left displaying those same fixtures

that are currently patched or have been added to the show, and the list on the right are
the parameters for the selected fixture. This is the fixture editor.

Creating a New Fixture
New fixtures are created from the fixture editor. You can either create a new fixture, or copy an
existing fixture to edit. See Copying a Fixture (on page 166)

To create a new fixture, press {New}. A new fixture will be added to the fixture list.

Naming a New Fixture
Once the new fixture appears in the list, it is recommended that you name the fixture you are
about to create.

To name a fixture in the creator list:

1. Use the [Page] keys, mouse, or touchscreen to select the new fixture.
2. Press [Label] or tap on the new fixture. You can press [Label] twice to clear the name. The

virtual keyboard will open in the CIA.
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3. Enter the desired name for the new fixture on the virtual (or attached alphanumeric)
keyboard.

4. Press [Enter]. The name will appear in the “Type” column of the fixture list.

Adding Parameters
After naming the fixture, you can specify which parameters the new fixture contains.

Note: For 16b parameters, LDMX or “low-DMX” is the DMX address for the second
half of any 16-bit channel. If used in Coarse/ Fine determination, the DMX channel
defines the “Coarse” adjustment and the LDMX defines the “Fine” adjustment. Do not
count 16-bit parameters as two parameters, this will be done in a later step.

To add parameters to a new fixture:

1. Use the [Page] keys, mouse, or touchscreen to select the new fixture.
2. Select the parameter list by clicking on it or touching it.

3. Determine the total number of parameters that your fixture has. Do not count 16-bit
parameters as two parameters, this will be done in a later step.

4. Press {New} or {+} to add parameter slots. Repeat this step until you have as many slots as
are required by the number determined in step 3.

Note: When {New} or {+} is pressed, the parameter slot will appear in the list with a
default name in the “Parameter” column. You may disregard these default parameters
as you will redefine the designations in a later step.

5. Use the [Page] keys, mouse, or touchscreen to navigate to any parameter slots that you
wish to alter the default parameter designations for.

6. Click on the slot to open a dropdown list of available parameters.
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7. Click on a category to open the dropdown list to see the parameters, or use the search box
to find the parameter.

8. Press the desired parameter to assign it or press [Enter] when the parameter is selected.
9. Repeat steps 5 through 8 until you have entered all of the required parameters for the new

fixture.

If you are missing a parameter slot: At any point you can use the [Page] keys and {Insert}, to
insert a parameter slot above the selected one.

If you want to remove a parameter: you can use the [Page] keys and {Delete}, to remove a
parameter from the list.

Locked Value

A parameter can be assigned as a locked value. When used, the output address and value will
be locked at the profile level. This option is available under Control in the parameter dropdown
list.

Define Parameters
Once you have added and specified all of the parameters for the new fixture, you can now
define the address requirements, size, and ranges for each of them.

To define the size (8-bit or 16-bit), DMX address, and LDMX address of any parameter:

You can alter the default DMX address assigned to any parameter in the list. This is not the
actual address that will be used when patched, but rather it is the order of address for the
parameter relative to the other parameters in the fixture.

LDMX or “low-DMX” is the DMX address for the second half of any 16-bit channel. If used in
Coarse/ Fine determination, the DMX channel defines the “Coarse” adjustment and the LDMX
defines the “Fine” adjustment.

1. Use the [Page] keys to navigate to any parameter that you wish to alter the size of. The
system defaults to 8-bit for any new parameter.

2. When selected, click Size to choose between 8-bit or 16-bit. If 16-bit is selected, the
system automatically displays a LDMX option. This value can be altered.

3. Enter the desired address for the DMX and/ or LDMX addresses using the keypad.

To alter the Home settings for any parameter:

You can define the value for any parameter’s “home” value.
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1. Click on the “Home” column of the desired parameter.
2. Enter the desired home value (0 through 255 for 8-bit, and 0 through 65535 for 16-bit)

using the keypad.

To enable the Snap setting for parameters:

You can enable snap for parameters to exempt them from cue timing, so they snap to their new
value. For more information about snap, see Snap Parameters (on page 162)

1. Use the [Page] keys to navigate to the “Snap” column of the desired parameter.
2. Click in the ‘Snap” column for the selected parameter to enable.

Range Editing a Parameter
You can enter the operational ranges for specific slots within any specific parameter (such as
color scroller, color wheel, gobo wheel, and so on). You can do this by either defining each
range individually or you can use the quick action tools to define multiple ranges at once.

If a parameter has only one range, the values for that range will display in the range column. If
that parameter has multiple ranges, the number of ranges will be displayed. If a range is used in
a mode, the range will not be in bold.

For example, if the parameter were “Gobo Wheel”, and the fixture included a four-slot gobo
wheel, you can use ranges to determine the minimum/ maximum values for each of those slots.
You can also label the slots and define the minimum/ maximum values that will appear in the
channel display for that parameter.

To define the range values individually for any parameter:

1. Use the [Page] keys to navigate to the parameter that you want to add ranges to.
2. Click on the range. The range window will open.
3. Determine the total number of slots required by the parameter. Be sure to include “open”

slots when needed.
4. Press {New} or {+}to add ranges. Repeat this step until you have as many slots as are

required by the number determined in step 3.
5. Use the [Page] keys to select the range and field you wish to edit. Fields are:

• DMX Min - enter the minimum value (0 through 255) for the range slot you are
defining.

• DMX Home - enter the default value (0 through 255) for the range slot you are
defining.

• DMX Max - enter the maximum value (0 through 255) for the range slot.
• User Min- enter the value that will be displayed to users (for example, what will be

displayed in the live summary view) when the slot is at its minimum value. Value can
range from -32767 to 65535.
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• User Home- enter the value that will be displayed to users (for example, what will be
displayed in the live summary view) when the slot is at its default value. Value can
range from -32767 to 65535.

• User Max- enter the value that will be displayed to users when the slot is at its
maximum value. Value can range from -32767 to 65535.

6. Press {Label} to add a label to any range slots. These will appear in the encoder display
and ML controls when the related parameter is displayed for the new fixture.

7. Press {Patch} when you have finished editing the ranges.

To delete a range value, select it and press {Delete}.

Quick Actions

Quick Actions provides tools that allow for the creation of multiple ranges at once according to
predefined actions.

Note: Quick Actions supports 8bit and 16bit parameters.

Click on Quick Actions to open the menu. In this menu, you select the desired action and the
number of slots needed.

The following actions are available:

• As-Is - This is the initial mode. The ranges are unchanged. This allows you to view the
range as it was.

• User Values - These actions affect the user values. See Range Editing a Parameter for
more information about user values.
• Framed - Enter the number of frames that you would like to have on your collection of

ranges. The console then distributes the DMX values and assigns a user range exactly as
any of the wheel or frame parameters are automatically created. (Frames 1, 2, 3, etc
would be represented as 0.5-1.4, 1.5-2.4, 2.5-3.4, etc)

• Matched - The user values are set to match the DMX values. This is required for a
virtual parameter (one that has no DMX address) and is used as a mode for another
parameter.

• Scaled - Users can enter the minimum and maximum user value to map their DMX
ranges to an arbitrary user range. This is useful when creating pan/tilt ranges (e.g., -180
to 180), or color temperature ranges (e.g., 3000 to 15000). DMX ranges are not
changed and are assumed to be as the user intends. The DMX values are scaled into the
new user range.

• DMX Values- This action affects the DMX values. See Range Editing a Parameter for more
information about DMX values.
• Distribute - Select the number of ranges you wish to create. DMX values are then evenly

distributed as specified.

Quick Labels

Click on Quick Labels to open a dropdown menu with labeling options. These options are
broken down into two categories: units and labels.

• Units
• Degrees
• Percent
• (none)
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• Labels
• Open
• Open/Color N
• Blackout
• Animation
• Animation N
• Color
• Color N
• Color M/N
• Color N/Open
• Effect
• Effect N
• Gobo
• Gobo N
• (clear)

Units are used to add a degree or percentage symbol to the end of a label when it displays in the
encoder display or ML controls. If you want to remove a unit, select (none).

Labels are used to replace the text for all of the ranges. Labels that have an N after them will
display the appropriate number in the encoder display or ML controls. For example, Gobo N will
display the number of the gobo. Select (clear) to remove the labels.

Modes
A mode is a collection of ranges that will display in the encoder display and in ML controls when
the mode's conditions are true. These ranges are part of one DMX address that is used to control
two or more different by related functions, such as gobo index and rotate.

Examples of mode conditions are "When Gobo Mode is Indexed" or "When Strobe Mode is
Random". Multiple conditions can be assigned. An example of this would be "When Gobo
Wheel Mode is Index or Index Scan".

When viewing a fixture profile, the parameters that have modes will display the number of
modes in the ranges column.
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Note: When adding a new mode, you will need to first add the parameter that the
mode needs to be associated with before you will be able to assign the mode. See
Creating Modes (on the next page).

Modes can be edited in the range editor. The following buttons are available for editing modes:

• {New Mode} - adds a new mode.
• {Delete Mode} - deletes the selected mode.
• {Next Mode} - advances your selection to the new mode.
• {Last Mode} - returns your selection to the previous mode.

Clicking a new or existing mode will open the mode selection window.

This window displays all the possible conditions that can be applied to the fixture. The active
ranges for the mode will already be selected with a checkmark.

A condition can only be present on a single mode. Similarly, if a parameter has multiple ranges,
and it is selected as a condition for another parameter, all ranges need to be present on some
modes of the fixture. For example, if gobo wheel has ranges of index, rotate, and shake, and
you place index on a parameter for a mode, rotate and shake must also be used.

Once a parameter is used as a condition, it becomes read only. Only the labels for the ranges
can be added/ edited.

Note: A single range parameter is not useful as a condition so those will not be
available for selection.
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Note: Some fixtures use virtual modes. Those are modes without a DMX address
assigned to them.

Creating Modes

Let's take a look at how to create modes for a gobo wheel. This gobo wheel can be indexed or
rotated.

In the fixture's manual, you will see something similar to this:

16 Gobo Function
Index 0 127

Rotate 128 255

The sixteenth DMX slot for this fixture is gobo function, which has two ranges for index and
rotate.

In the fixture editor, you assign a parameter as gobo wheel mode. Click in the range column to
open the range editor. Use {+} to add a second range slot. Assign the appropriate range values,
and label each range.

Note: For this example, the DMX min and max values were entered and then the
Quick Action of Matched was used so the user values were the same as the DMX ones.

Note: It is important to name your ranges. Without labels, only the range values will
display when selecting conditions, and the mode buttons in the encoder display and
ML controls will be blank.

Back in the fixture editor, assign a parameter as gobo index/speed. Click in the range column to
open the range editor. Press {New Mode} to create two modes.
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Click in the mode cell to open the mode selection window.

This window will display all possible conditions that can be applied to your fixture. In this case,
there are only two possible.

If a parameter has multiple ranges and is selected as a condition for a mode parameter, all the
ranges for that parameter must be used. The fixture editor will allow you to select a condition for
a mode and it will automatically place the other range(s) on the next mode.

Assign the DMX and user values. The range values were used for the DMX values. For index, the
user values were set to 0-360 degrees. The quick label for degree unit was used so the degree
symbol will display in the encoder display. For rotate, the user values were to 0-80 rpms.

Once the modes are created using the index and rotate ranges, the gobo wheel mode
parameter will be read only. The range editor for gobo wheel mode will give an advisory saying
which mode the ranges are used in. If changes are needed to those ranges, press {Remove as
Mode} in the range editor. After the changes are made, you will need to reassign the modes.
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After patching the new fixture, you will be able to check your modes in the encoder display and
ML controls. There are now buttons for the modes, and for index, the degree symbol is displayed
with the user value.

Fixture Lamp Controls
For many devices, their lamp and motor control functions can be controlled remotely using
DMX. These will often require use of a timed sequence of DMX levels to control various
functions such as striking the lamp, resetting the fixture, and other specific actions.

To define the lamp controls for a device:

1. With the fixture selected, press {Lamp Ctrls}. The lamp control display will open.
2. Press {New} or {+} to add as many lamp control options as needed.
3. Click on the name in the lamp control column to name it.
4. Click in the Steps columns (#, Time, DMX, and Level).

• # - the step number. Each step is tied to a time value, and will execute in order of the
step number.

5. Press {New} or {+} to add as many steps needed for the lamp control.
6. Select the time column to change the timing for each step.

• Time (seconds) - Timing is in seconds. The standard time in the Eos Family library is 12
seconds.Hold can be assigned as a timing value.

Note: It is not recommended that you set the time to Hold unless the DMX value
should permanently remain at that level. In order to alter a level set with a time of
Hold, another lamp control to change that DMX value would need to be created.

7. For each step created, click in the DMX column and press {New} or {+} to add as many
DMX addresses and levels as needed. You may setup as many levels as needed for each
step.

Note:  While a step is active, the DMX levels for the channel will be held. When a
step is no longer active, the levels will be released back to their playback levels.

• DMX - the DMX offset of the parameter you wish to control. DMX can be set to All
Offsets, which means that all DMX parameters for the fixture will be held at the
specified level.

• Level - the 0-255 level of the parameter.

Snap Parameters
Certain parameters may not want to be subjected to cue timing. Those parameters can be set to
snap. By default, Eos will snap the parameters listed in the following table:

Beam FX
Index/Speed

Effect Library MSpeed Shutter

Camera IR
Image

Enable Negative Shutter Strobe

Clip Directory File
Object
Directory

Strobe
Mechanism

Color Effect File Type Object File Sync Source

Color Index
Front/Rear
Projection

Output
Command

Text

Color Mix Generator Page Texture

Control
Generic
Control

Position Blink Timeline
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Copy Mod
Image
Movement
Speed

Projector Input
Timeline
Position

Cue
Internal Media
Frame

Relay
Tracking
Object

Dimmer Curve Library Select
Transition
Speed

Edge Blend
Profile

Macro Shape Transition Time

Effect File Mode Shape Library Transition Type

In the [About] channel patch screen, the snap column shows which parameters for that channel
are currently set to snap. These parameters can be edited for any profile using the Fixture Editor.
See Fixture Editor (on page 153)

Save Fixture
Unsaved fixture profiles will have a red background in the fixture editor.

Press {Save Fixture} to store the new profile, or {Cancel Edit} to exit out and not save your
changes.

Note: If you leave the patch display without saving or using {Cancel Edit}, an
advisory will display above the command line letting you know that you have unsaved
data.

Color Calibration
The fixture editor also offers the option to disable generic fixture color calibration by unchecking
the "Use Calibration" box in the fixture editor.

This disables generic color calibration, and simplifies the color calculations being used for that
fixture profile. This can greatly improve fixture performance and speed for use in pixel maps.
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Note: Disabling a fixture's generic color calibration may affect its color matching,
fades, or other functionality.

Creating Multicell Fixtures
Multicell fixtures can be created by using the fixture editor. You can either create a new fixture,
or copy an existing fixture to edit.

To create a new fixture, press {New}. A new fixture will be added to the fixture list.

Naming a New Fixture
Once the new fixture appears in the list, it is recommended that you name the fixture you are
about to create.

To name a fixture in the creator list:

1. Use the [Page] keys, mouse, or touchscreen to select the new fixture.
2. Press [Label] or tap on the new fixture. You can press [Label] twice to clear the name. The

virtual keyboard will open in the CIA.
3. Enter the desired name for the new fixture on the virtual (or attached alphanumeric)

keyboard.
4. Press [Enter]. The name will appear in the “Type” column of the fixture list.

Create Multicell
1. With the new fixture selected, press {Create Multicell}.

2. Press {+} to add cells. This will open a fixture list display. Only fixtures added to your
fixture list will be here.
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3. Select a fixture, a cell profile from an existing multicell fixture, or create a new cell profile
by selecting + Add New Cell Profile.

4. Select the number of cells.
5. Press {Ok} . When selecting a fixture, you will need to select {Make Copy as Cell} or

{Convert to Cell}.
• {Make Copy as Cell} - makes a copy of the existing fixture profile and patches the

copy as a cell. This will break any references to the original profile.
• {Convert to Cell} - converts to the fixture into a cell. This option will not be available

for any library fixture or fixture currently patched in the show file.
6. Make any changes needed to cell numbers, DMX offset, or mastered cells. These settings

can be edited later by selecting the {Edit Multicell} button. See Editing Multicell Fixtures
(on page 136) for more information.

7. Press {Save Fixture} to save your changes or {Cancel Edit} to remove the changes and
exit.

Note: If you need to delete a cell profile that has been accidently selected, select the
cell and set the number of cells to 0.

You can now add or edit parameters as needed. See Editing Multicell Fixtures (on page 136) for
more information.

Editing Fixtures
You can view and edit existing fixtures in the Fixture Editor. Edited fixtures will display with an
"*" beside their name.

With the fixture selected, you can change the name by pressing [Label] or tapping on the
fixture. You can press [Label] twice to clear the name. The virtual keyboard will open in the
CIA. The fixture's name as it is in the library will still display by the new name.

Note: Using [Update Profile] will remove any edits made to existing fixtures. Fixtures
that have been copied will retain any edits. See Copying a Fixture (on the next page)

Physical Data Editor
The Physical Data Editor provides options for editing Augment3d-related fixture information.
The following options are available:

• Fixture Model
• Hang to Focus Offset X
• Hang to Focus Offset Y
• Hang to Focus Offset Z
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Fixture Model allows the selection of the model displayed in Augment3d when the fixture has
position data. Selecting "No model" will tell Eos to use the default fixture model closest to the
fixture type. Practical light emitting objects (like desk lamps) can be found in the Practicals
manufacturer.

Hang to Focus Offset is the XYZ offset from the center of the base to where the fixture will pan /
tilt. It is used when converting between a desired XYZ beam end, and pan / tilt values.

Copying a Fixture
It is possible to copy an existing fixture and edit its parameters. In the fixture editor, there is a
{Copy} button. Pressing {Copy} when a library fixture is selected will create a copy of that fixture
and will assign it a new name.

Merging Custom Fixtures into a New Show File
Custom fixtures are saved with your show file and not in the fixture library. If you want to use
custom fixtures in a different show file, you will need to use the advanced merge function while
in the new show file.

For more information, see Partial Patch Merging (on page 116)

Importing a Custom Fixture
You can import custom fixtures from an ASCII show file, see Importing Show Files (on page 120)
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About Setup
This section describes the processes involved in changing your system, user, and device settings
to meet your preferences.

For more information on settings not found in Setup, see About the Eos Configuration Utility (on
page 510).

To enter the setup screen, press [Displays] > {Setup} or go to the Browser > Setup.

The CIA will repaint to display the setup screen and the softkeys will change to display the
various subcategories of setup. Eos defaults to displaying system settings; if you have changed
the view to another subcategory, Eos will remember the view you were in when you return to
setup.

The setup subcategory softkeys are:

• System (below)
• User (on page 177)
• Device (on page 179)

System
This setup softkey accesses settings for the entire system. Changing these settings will impact
other controllers on the network.

The following buttons are available in System settings:

• System Settings (below)
• Cue Settings (on the facing page)
• Show Control (on page 170)
• Remotes (on page 176)
• Output (on page 175)
• Partitions (on page 176)
• Users (on page 176)
• Recall User Settings (on page 176)
• Augment3d (on page 177)

System Settings
This System button gives you access to system settings.

The following fields will be available to you: {Num of Channels}, {Dim. Dbl. Offset}, {Create
Virtual HSB}, {Display Colors in D65}, {Home Preset}, {Startup Macro}, {Shutdown Macro},
and {Disconnect Macro}.

To change the setting for any of these fields, press the field in the CIA to activate it. If the field
requires data, enter it from the keypad. If the field is a toggle state, one press of the button will
switch the field to its other state.

Changes from this screen are system wide and will impact all consoles and clients connected to
the system.

{Num of Channels}
You may use this field to set the number of channels in your console to the number of channels
in your system. Eos supports a maximum of 99,999 channels. The default is 5,000. Only 32,768
channels can exist in the patch, but they can be distributed throughout the entire 99,999
channel count. Enter the number of channels for your system using the keypad. This entry must
be confirmed with the [Enter] key.
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Note: Every part in a multipart channel will count as an additional channel for the
channel count total.

{Dim. Dbl. Offset}
This allows you to set the address offset for dimmer doubling. The default for this is 20000, to
match the Net2 standard offset, including Sensor dimming software. For dimmer doubling over
Local DMX, this value should be set to 256.

{Create Virtual HSB}
{Create Virtual HSB} allows you to disable creation of virtual hue and saturation parameters.
This option is disabled by default.

When Virtual HSB controls are disabled, the hue and saturation columns will not display in Table
view. You will not be able to record just the Hue or Saturation values into a cue, submaster,
preset, or palette, and you cannot apply an effect to Hue and Saturation. You will still be able to
control Hue and Saturation from the encoders, ML Controls, Color Picker, and the command
line.

{Display Colors in D65}
Displays colors of gels and current light output on the encoder display, color picker, pixel map,
and magic sheet link to channel color using a D65 white point. Enabled by default.

Disabling this option switches Eos back to using a D50 white point, as in software versions prior
to v3.0.0.

{Home Preset}
Allows you to specify a preset that will be used as the home level for all non-intensity
parameters in the preset, instead of the fixture library defaults. This preset will be applied for all
“Go to Cue Out” and home commands. Channels not included in the assigned home preset will
continue to home to their library defaults.

{System Startup Macro}
This field allows you to set up a startup macro that will trigger after the console initialization has
completed.

{System Shutdown Macro}
This field allows you to set up a disconnect macro that will trigger at power off, not when exiting
the application.

{Disconnect Macro}
This field allows you to set up a disconnect macro that will trigger when the primary disconnects
from its backup, or when a backup disconnects from the primary.

Cue Settings
Press {Cue Settings} to enter this category.

Three fields will be available to you: {Auto-Mark}, {Mark Time}, and {Preheat Time}. You can
also set cue default times in this display. {Auto-Mark} is not available on Element 2.

To change the setting for any of these fields, press the field in the CIA to activate it. If the field
requires data, enter it from the keypad. If the field is a toggle state, one press of the button will
switch the field to its other state.
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{Auto-Mark}
This toggles the AutoMark settings between enabled/ disabled (see AutoMark (on page 230) for
more information). AutoMark is “Disabled” by default.

{Mark Time}
This field allows you to set the time that mark instructions will use. When {Mark Time} is
disabled, which is the default, mark instructions will use cue timing unless overridden with
discrete timing.

When you enter a mark time in setup, all NPs that mark (either through referenced marking or
AutoMark) will use this time. The only way to override setup mark time is to use discrete timing.
Clearing the {Mark Time} field sets it back to disabled. Select {Mark Time} and hit [Enter] to
disable the default mark time.

{Preheat Time}
If this option is disabled, the cue’s up intensity time will be used when preheating. The default
setting is “Disabled”.

Cue Default Times
This area allows you to set the default cue times for the parameter categories of your system. To
change a time, touch the parameter category button in the CIA and enter the desired time on
the keypad. To set a time for all categories at once, press {Selection Button} [Thru]. Pressing
[At] selects manual times.

The categories for which you may set default times are:

• Intensity Up
• Intensity Down
• Color
• Focus
• Beam

Show Control
This section allows you to adjust settings for MIDI show control, time code (MIDI or SMPTE),
analog, and serial functions. For more information on using show control with your system, see
About Eos Family Show Control (on page 534)

The following options are available in Show Control setup:

• Device Settings - Local MIDI/SMPTE
• SMPTE
• MIDI
• Contacts
• OSC
• String UDP

Device Settings - Local MIDI/SMPTE

Note: Local Device Settings appears on both the SMPTE and MIDI tabs.

{MIDI/SMPTE Rx}
Enables or disables the console's ability to locally receive MIDI or SMPTE. Defaults to
“Enabled."
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{MIDI Tx}
Enables or disables the console's ability to locally transmit MIDI. Defaults to “Enabled."

{Time Code ID}
Sets the console's local Time Code ID.

{USB MIDI/SMPTE}
Enables or disables local USB connection to supported MIDI or SMPTE devices. This setting must
also be enabled for Virtual MIDI devices.

SMPTE

{SMPTE Time Code Rx}
This button is used to control whether your console can receive SMPTE time code. Choosing
“Disabled” will disable all time code lists that have a SMPTE source. The default for this setting
is “Enabled”.

{Resync Frames}
This button allows you to configure how many frames need to be synced before time code starts
running. Frames can be from 1-30. Default is 2 frames.

MIDI
MSC

{MSC Receive}
This button toggles the setting for receiving MIDI Show Control from an external source between
“Enabled” and “Disabled”. The default setting is “Disabled”.

{MSC Transmit}
This setting, when enabled, allows the console to send MSC messages for actions taken on the
console, such as cue actions, macros firing, and submaster bumps. The default setting is
“Disabled”.

{MSC Rx Device ID}
This setting allows you to choose the devices from which the console will receive MSC. When
set, the console will respond to MSC data from any Net3 gateway that has a matching “ACN
MSC Rx ID.” Gateways will send the MIDI data over an ACN connection. When built-in MIDI
ports are available, the setting needs to match or at least contain the MSC Rx ID.

Example:
• {MSC Rx Source ID} [2] [5] [Enter]
• {MSC Rx Source ID} [1] [Thru] [1][0] [Enter]

{MSC Tx Device ID}
This setting allows you to choose the devices which the console will send MSC to.

{MIDI Cue List}
MIDI Cue List specifies the cue list that the console will use to send MSC data. If left blank and
MSC Tx is enabled, all cue lists will generate MSC events. Otherwise, only the particular list (or
lists) selected will fire MSC events.
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Network

{MIDI Rx Device ID}
Also known as a “device ID” this setting configures the MIDI channel for the console to receive
MIDI Show Control information. Only MSC data with the same device ID will be received. A
device ID can be from 0-126. MSC commands can be sent to ID 127, which is the All Call device
ID. While Eos cannot be set to ID 127, it will respond to commands sent to the All Call device ID.

Example:
• {MSC Rx Device ID} [5] [0] [Enter]

{MIDI Tx Device ID}
Also known as “Device ID” this setting allows you to set the device ID with which your console
will transmit MIDI Show Control information. A device ID can be from 0-127. If set to 127, the
console will transmit MSC data to all devices (All Call).

Example:
• {MSC Tx Device ID} [4] [0] [Enter]

{MIDI Tx Source ID}
This setting allows you to choose the devices through which the console will send MIDI data.
When set, the console will transmit MSC data from any Net3 gateway that has a matching
“ACN MIDI Tx ID.” The console will then send the MIDI data over an ACN connection to the
gateways.

Example:
• {MIDI Tx Source ID} [2][5] [Enter]

SC Event List- MIDI/UDP/OSC

{Network List Receive}
Enables or disables whether the console can receive incoming MIDI, UDP, and OSC. Defaults to
“Enabled."

MTC

{MIDI Time Code Rx}
Enables or disables whether the console can receive MIDI Time Code. Defaults to “Enabled."

Raw MIDI Strings

{MIDI Raw Send}
Enables or disables whether the console can send raw MIDI strings. Defaults to “Enabled."

Contacts

{Analog Inputs}
This is a master setting for receiving analog inputs from a Net3 I/O Gateway or the built-in I/O
port (when available). When disabled, it will no longer trigger any analog input actions on any
event lists. Default is “Enabled”.
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{Relay Outputs}
This is a master setting for triggering external relays from a Net3 I/O Gateway or the built-in I/O
port (when available). When disabled, will no longer affect any external relays normally
triggered from the console via cues, submasters, or macros. The default is “Enabled”.

Contact Closure (remote trigger connector)
Allows you to set the Group and Address In values for the remote trigger input on the back of
your console. The contact closure only reports on/off even though it is considered an analog
input.

Note: The contact closures require DC voltage, which is supplied by the console on
pins 14 and 15. See the diagram below.

Relay Out
Allows you to assign the Relay Out Source ID and the Relay Out Address.

OSC

{OSC RX}
Globally enables receiving OSC.

{OSC UDP RX Port}
This setting specifies the UDP port that the console will listen to for OSC receiving strings.
Multiple ports can be assigned. A space needs to be used to separate the addresses.

Note: ETC recommends using 8000 and 8001 respectively for port numbers.
Remember that when setting port numbers on your external device that they should be
set to the opposite of what Eos is set. For example, if {OSC UDP TX Port} on Eos is set
to 8000, then the RX (incoming) port on your external device needs to be set to 8000,
and vice versa.

{OSC Cue Recv String}
Allows the user to specify a different incoming OSC string format for integration with other
applications. Use %1 in the string format as cue number and %2 as the cue list number.

{OSC TX}
Globally enables transmitting OSC.
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{OSC TX Port Number}
This sets the UDP destination port to which the console will send OSC strings. Multiple ports can
be assigned. A space needs to be used to separate the addresses.

{OSC Cue Send String}
Allows the user to specify a different outgoing OSC string format for integration with other
applications. The following options can be used:

• %1 - cue number

• %2 - cue list number

• %3 - cue whole number

• %4 - cue point number

• %5 - cue label

{OSC TCP Server Ports}
Allows the user to specify custom port numbers for multiple OSC TCP connections.

{OSC TX IP Address}
This sets the destination IP address or addresses to which the console will send OSC strings.
Multiple IP addresses can be entered, separated by either a space, comma, or semicolon.

Note: Be careful when using a network with a DHCP server. If your external device
reboots or is issued a new IP address from a DHCP server, it will no longer receive OSC
strings from Eos until you change this setting to match your new IP address at your
external device.

{OSC USB}
Allows use of OSC USB devices, such as Lighthack. Disabled by default on Mac.

String UDP

{String RX}
This setting will enable receiving strings on all Serial RX formats.

{String RX Source IDs}
This setting allows you to choose the Net3 I/O Gateways through which the console will receive
serial strings. When set, the console will receive serial from any Net3 I/O Gateway that has a
matching “ACN Serial Group ID.” The gateway will send serial data over an ACN connection to
the console. This only affects serial traffic from I/O gateways and not network UDP messages,
ACN strings, or OSC. Source IDs can be from 1-32. Multiple group IDs can be selected by using
[Thru] and [+].

{String RX Source Name}
Allows the user to specify a comma separated list of names for receiving strings, for example,
from Paradigm.

{String RX Port}
This setting specifies the UDP port that the console will listen to for receiving strings. Multiple
ports can be assigned. A space needs to be used to separate the addresses.

{String TX}
This settings will enable sending strings on all Serial TX and OSC formats.
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{String TX Source IDs}
This setting allows you to choose the Net3 I/O Gateways through which the console will transmit
serial string data. When set, the console will transmit serial to any Net3 I/O Gateway that has a
matching “ACN Serial Group ID.” The console will send the serial data over an ACN connection
to the gateways. This only affects serial traffic to I/O gateways and not network UDP messages,
ACN strings, or OSC. Serial Group IDs can be from 1-32. Multiple group IDs can be selected by
using [Thru] and [+].

{String TX Source Name}
Allows the user to specify a list of specific comma-separated names of devices to send strings to
(for example, for use with Paradigm).

{String TX Port}
Setting for the UDP destination port that the console will send strings. Multiple ports can be
assigned. A space needs to be used to separate the addresses.

{String TX IP Address}
Sets the destination IP address or ACN devices supporting the ACN String EPI that the console
will use to send strings. This can contain either an IP address for UDP string destinations or ACN
device names. Multiple IP addresses can be entered, separated by either a space, comma, or
semicolon.

A combination of UDP and ACN devices are not supported. See String Interface for more
specific configuration information.

{String MSC TX}
When enabled, this setting will cause the console to send serial strings when certain actions
happen at the console. See Sending From User Events.

Output
This System button gives you access to Output settings.

Note: Changes to these settings may require a restart. When required, a warning
message indicating a needed restart will display.

Local DMX
The following settings are available:

• Enable - enables DMX output from the local DMX ports.
• Default Output Protocol - enables DMX as a default output.
• Output in Client Mode - allows for output in offline mode for use with a visualization

program.
• Dimmer Doubled Offset - this offset matches the default offset in CEM+ / CEM3 when

configuring your Sensor dimmer rack for dimmer doubling. The default offset is 20,000.
Sensor Classic racks should be set to an offset of 256.

The following settings can be edited within the table by clicking on a cell:

• Address - sets the starting address for the port.
• RDM - enables RDM on the port.
• Doubled - enables dimmer doubling on the port.
• Speed - sets the speed for the ports. Options are: maximum, fast, medium, and slow. The

speed may need to be adjusted for certain devices. The default speed is maximum.
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Remotes
The {Allow Remotes} button is for allowing Net3 RFR, iRFR, and aRFR connections. The default
setting is “Enabled”. For more information see RFR (on page 530).

Partitions
Pressing the {Partitions} button in system setup opens the partition display in the CIA. This
display shows any recorded partitions, including the four pre-existing partitions. For more
information, see Using Partitions (on page 497).

Users
In this display, you can set the User ID for the console by selecting the {User ID} button and
entering a number from the keypad. You can also add or delete users from this display.

For more information on User ID see About User ID (on page 502).

Recall User Settings
When multiple users are in a system, this option allows you to select a user to recall their
settings.

The following settings will be recalled:

• Manual Time
• Sneak Time
• Go to Cue Time
• Back Time
• Assert Time
• Timing Disable Time
• Off Time
• Release Time
• Record Confirm
• Delete Confirm
• Cue Only
• Auto Playback
• Plus %
• Minus %
• Level
• Update Defaults (all)
• Partition
• Highlight
• Lowlight
• Highlight Remdim
• Live Remdim Level
• Preserve Blind
• Encoder Degrees Per Rev
• Encoder Percent Per Rev
• Preserve Native (Patch Setting)
• Gel Match Type (Color Picker Setting)
• Gel Swatch Type (Color Picker Setting)
• Pop-up Magic Sheet
• Pop-up Nav Lock
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Augment3d
In this display, you can set the measurement units for Augment3d to use, enable or disable
Augment3d for your device, see the status of running Augment3d instances, and select which
instance to use.

To select which instance of Augment3d the console uses, highlight the desired instance and
click the {Connect to Server} button. To switch from a tethered computer back to the console,
highlight the Augment3d Tab with an address of Local and click {Connect to Server}.

For more information on Augment3d Tether, see PC / Mac (Tether Mode) (on page 434).

User
This setup softkey accesses settings for a specific user. Changing these settings does not impact
other users on the network.

The following buttons are available in User settings:

• Record Defaults (below)
• Manual Control (on the next page)
• User Displays (on page 179)

Record Defaults
Press {Record Defaults to enter this category.

Eight fields will be available to you: {Tracking}, {Record Confirm}, {Delete Confirm}, {Auto
Playback}, {Update Mode}, {Break Nested}, {Update Last Ref}, and {Emergency Mark}.

Note: {Emergency Mark} is not available on Element 2.

To change the setting for any of these fields, select the button in the CIA to activate it. If the
field requires data, enter it from the keypad. If the field is a toggle state, one press of the button
will switch the field to its other state.

Tracking
This field allows you to switch between tracking and cue only modes (see Tracking vs. Cue Only
(on page 6)). The default is “Tracking”.

Record Confirm
This setting allows you to enable/ disable the confirm action when storing over a previously
recorded target. The default is “Enabled”.

Delete Confirm
This field allows you to enable/ disable a required confirmation before any delete command is
executed. The default is “Enabled”.

Auto Playback
When enabled, this feature automatically plays back cues and submasters as they are stored
and releases manual control. For submasters to automatically play back, the slider must be at
full. This field is a toggle state between “Enabled” and “Disabled”. When auto playback is
“Disabled”, all manual levels are maintained and cues must be loaded and executed on
playbacks. The default is “Enabled”.
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Update Mode
This field allows you to select a default update mode (see Update Dialogue Box (on page 281)).
The default is “Make Absolute”.

Break Nested
This setting allows you to enable/ disable the update modifier break nested. The default is
“Enabled”.

Update Last Ref
This setting allows you to enable/ disable the update modifier update last ref. The default is
“Enabled”.

Emergency Mark
{Emergency Mark} can be used to automatically set a mark flag if you had not previously done
so. If using {Earliest M} and no cue with a mark flag has already been set, {Emergency Mark}
will set a mark flag.

{Emergency Mark} can be set to either Earliest or Latest. Latest is the default setting.

• If set to Earliest, {Emergency Mark} will set the mark flag on the earliest cue after the cue
which fades the intensity out for the selected channel.

• If set to Latest, {Emergency Mark} will not set a mark flag. It will instead create a broken
mark, which will display an x in the previous cue in the Playback Status Display.

Manual Control
This user setting button gives you access to manual control settings.

Manual Time
In this section you may change the default times for manual changes to occur in live. Times can
be set for each parameter category (Intensity Up, Intensity Down, Focus, Color, and Beam). You
may use the [Thru] key to enter a value for all categories.

• {Int Up} [Thru] [9] [Enter]

The default for each of these is 0 seconds.

Manual Control
This section allows you to specify the values for certain buttons or settings used in manual
control. To change any value, touch the appropriate button in the CIA and use the keypad to
enter a new value. Fields are:

• Level - This sets the value for the [Level] key. Any value between 0-100 may be entered.
The default is 80.

• Plus% - This sets the level for the [+%] key, which will increase the selected channel by
the set percentage. You can assign +% to values that have up to five digits. The default is
10%.

• Minus% - This sets the level for the [-%] key, which will decrease the selected channel by
the set percentage. You can assign -% to values that have up to five digits. The default is
10%.

• Highlight Preset - This field is used to specify the preset that will be used for any highlight
commands.

• Lowlight Preset - This field is used to specify the preset that will be used for any lowlight
commands.
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• Highlight Rem Dim - This enables a remainder dim when in highlight mode, thereby
temporarily dimming any channel not participating in the High/Low. An intensity level or a
preset can be assigned in this field. Channels not in highlight or lowlight that are not
included in the preset are not affected.

• Live RemDim Level - This allows you to set the level for all remainder dim commands in
live. The default is 0. An intensity level or a preset can be assigned in this field.
{LiveRemDim Level} [Enter] will disable RemDim, causing [Rem Dim] to return an error
when used in Live.

Default Times
In this section you may change the default times for sneak commands and the respective feature
response times based upon parameter category. The default for these is 5 seconds, except for
back time, which uses a default of 1 second. You can assign separate timing values to the
Release and Off functions.

You can assign [Cue] as a timing value for the {Go to Cue Time} and {Back Time} The syntax,
{Go to Cue Time} [Cue] [Enter] or {BackTime} [Cue] [Enter] will assign cue as the timing value.

When [Go To Cue] [n] [Enter] or [Back] is used, the fade will happen in the time set in the
destination cue.

You can assign a separate time value for [Timing Disable]. When a fader has been set to timing
disable mode, cues will use the time set in Setup. The default time is 0.

Encoder Map
This section allows you to specify a custom encoder mapping to be used as the default for all
fixtures. If left blank, any fixture types without a custom map assigned will use the default Eos
encoder mapping.

For more information on custom encoder maps, please see Custom Encoder Maps (on page 98).

User Displays
This user setting button gives you access to the following display settings:

• {Preserve Blind Cue} - This enables the console to display the last selected cue in blind
when you return to blind. Disabled by default.

• {Blind Next/Last Affects Target} - When enabled, in Blind the Next and Last commands
will always apply to channels, if a channel selection is on the command line. Disabled by
default.

• {Popup Magic Sheet} - assigns a magic sheet as a pop-up magic sheet.
• {Popup Nav Lock} - enables or disables the zoom and scroll navigation for pop-up magic

sheets. This option is enabled by default.

See Pop-up Magic Sheet (on page 70)and About Magic Sheets (on page 412) for more
information.

Device
This setup softkey accesses settings for the specific device. Changing these settings does not
impact other controllers on the network.

The following buttons are available in Device settings:

• Config (on the next page)
• Output (on page 175)
• Face Panel (on the next page)
• Fader Wing Layout (on page 181)
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• Displays (on page 182)
• Brightness Settings (on page 182)
• PDF Settings (on page 184)
• Recall Device Settings (on page 184)

Config
Press {Config} to enter this category.

Two fields will be available to you: {Visible to Remotes} and {Device Name}.

{Visible to Remotes}
{Visible to Remotes} allows your console to be automatically detected by the application. If not
used, you will need to manually configure a connection to your console.

Note: If using {Visible to Remotes}, the application will identify the consoles by their
name and IP address, so it is useful to know the device names and addresses to ensure
that you are connecting to the right one.

{Device Name}

Note: Changes to this setting will require a restart. A warning message indicating a
needed restart will display.

This specifies the name the console will use to identify itself on the network to other devices.
Examples might be Booth Desk and Tech Table.

This setting is also available in the ECU.

Face Panel

Encoders
There are two options available: {Degrees Per Rev}, which is for the pan & tilt encoders, and
{Percent Per Rev}, which is for the other encoders. When a pan or tilt encoder is moved one
revolution, the parameter will change by as many degrees as defined in Setup. The default is
30. When any other encoder is moved one revolution, the parameter will change by the set
percentage of its entire range. The default is 35.

The settings for {Encoder Degrees Per Rev} and {Encoder Percent Per Rev} are stored with the
show file. Starting a new file will reset the two settings to their default values.

Note: Hold down [Shift] while moving the encoder for fine control. Releasing the
[Shift] key will restore the encoder to its default mode.

Input Devices
Trackball Settings

• {Swap Pan/Tilt} - swaps the pan and tilt parameters. Disabled by default.
• {Reverse Pan} - reverses the range of the pan parameter. Disabled by default.
• {Reverse Tilt} - reverses the range of the tilt parameter. Disabled by default.

Auto-Repeat
• {Delay} - sets the delay for keystroke input from an external device.
• {Speed} - sets the keystroke speed from an external device.
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Other Settings
• {Spacebar [Go]} - allows you to enable the spacebar on an external keyboard as the

hotkey for [Go]. Enabled by default.
• {Use Shift as Eos Shift} - allows the SHIFT key on an alphanumeric keyboard to be used as

the console's [Shift] key. If not selected, the Z key on an alphanumeric keyboard will
function as the [Shift] key. Enabled by default.

• {Hide Mouse} - With hide mouse enabled, if the mouse is left idle for 10 seconds, the
cursor will go away. Once the mouse is used again, the cursor will return. Disabled by
default.

Sounds
{Sounds} allows you to enable or disable sounds. When disabled, the volume level controls will
not display.

Fader Wing Layout

Note: This feature is not available on Element 2.

This screen allows you to manually configure the positions of fader wings connected to your
console. The console will default to configuring the wings on its own. To manually configure,
you must click on the {Manual Config. Off} softkey.

Clicking on the {Manual Config. Off} button turns manual configuration on and displays the
Fader Wing Configuration screen.

Clicking{Identify} will display numbers on each wing’s display to aid in configuration. The
numbers do not identify the wings as to their actual order. Order is determined from left to right.
The left most wing will contain the first faders.

Click and drag the wings to match your physical layout. Click {Apply} to save the changes.
Clicking {Reset} will restore to the last saved configuration. Clicking {Manual Config. On} will
turn off manual configuration and will require a restart of the application before the console will
automatically configure the wings.

Wing Paging Groups
This screen allows you to organize both internal and external faders into wing paging groups. All
configuration and navigation settings are applied to any fader wings or banks included in a
group.
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• ID - a unique identifier assigned to all connected internal and external faders, which
appears on the fader bank displays while in this menu.

• Type - information about the connected fader wing or bank.
• Group - select in this column to edit the group number for a wing or bank.

Note: Internal banks default to Group 1. External wings default to Group 2.

When advancing fader pages by group, Group 1 is the default used with [Fader Page] or [+]. To
control a specific group, you can use [Fader Page] [Group] and the paging group number.

Displays
This device setting button gives you access to the following settings. See Live and Blind
Configuration Menu (on page 78) and Playback Status Display Configuration (on page 85) for
additional display settings.

Show Reference Labels
When enabled, referenced record targets (such as presets or palettes) with labels will have their
labels displayed rather than their target type and number. This is disabled by default.

{Show Reference Labels} is a global setting that will affect all displays. For some displays such
as live and blind, {Show Reference Labels} can be enabled at the individual tab level by
accessing the tab's configuration menu. This will override the setting in Setup.

In-Cell Editing
When disabled, this setting prevents changes to be made to the cells in the Live/Blind and
Playback Status Displays. {In-Cell Editing} is enabled by default.

Note: Options in the CIA are not affected by this setting.

DirSel.Dbl Clk
When enabled, double clicking a direct select button will act as [Recall From] [Record Target]
to place the entire contents of that preset, palette, or step-based effect on stage. The default for
this setting is “Disabled”.

Default Display Order
Determines the appearance of the Workspace Layout Menu (on page 65).

Brightness Settings
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This menu allows you to adjust the brightness and contrast settings for your console's face
panel, as well as any internal monitors, supported external monitors, fader wings, and task
lights. All sliders have a range from 0% (dimmest) to 100% (brightest).

At any time, holding [Displays] will display a pop-up of this menu on your console screen.

Main
The Main brightness slider can be used to set an overall limit to the brightness of any other
linked brightness settings, and defaults to 100%. This slider can also be controlled by holding
[Displays] and scrolling the level wheel.

Show All

Brightness sliders not pertinent to your console's hardware setup are disabled and grayed out by
default. {Show All} enables control of all sliders, regardless of your console, allowing you to
record presets for specific hardware.

Presets

Up to three brightness presets can be recorded, containing any combination of brightness levels
from this menu. To record a preset, hold down the preset button you wish to overwrite until it
displays "Hold to Record." Continue holding until the preset button displays "Recorded."

Extinguish

This button instantly sets all brightness settings to 0%, and darkens all console screens and
buttons (excepting the master playback buttons). Click or tap onscreen, or press the [Displays]
key to exit Extinguish mode.

Link to Main

This option allows you to link any combination of sliders to the Main slider. Linked sliders display
a link icon underneath; this space under unlinked sliders is blank.

When {Link to Main} is selected, any linked brightness sliders are outlined in yellow. Unlinked
sliders are not outlined, and display a broken link icon underneath. Click the icon to toggle
between linked and unlinked. LCD Contrast sliders cannot be linked.

Control External Monitors

Enables or disables control of external monitors that support Display Data Channel / Command
Interface (DDC/CI) via Display Port.

Monitors
The Internal slider controls the brightness of any internal console monitors.

If Control External Monitors is enabled, the External slider will control the brightness of any
connected external monitors that support Display Data Channel / Command Interface (DDC/CI)
via Display Port.

Both sliders default to 100%.
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Face Panel
These sliders control the brightness of your console's face panel backlit keys, and any built-in
displays or faders. All default to 50%.

Task Lights
This slider controls the level of any task lights connected to your console, such as Littlites, and
defaults to 50%.

USB Wing Displays
These sliders control the brightness, backlight level, and contrast of the displays of any
connected USB fader wings. Selecting {Invert} will invert the LCD. All sliders default to 55%.

Ion Face Panel
These sliders control the backlight level and contrast of Ion Classic face panel LCD screens. Both
default to 55%.

PDF Settings
This screen allows you to select the orientation and paper type for PDF files.

Recall Device Settings
When multiple devices are in a system, this option allows you to select a device to recall their
settings.

Console Status Display
The Console Status Display (CSD) shows informational, advisory, or warning messages about
your console. The CSD can be opened via Browser > Setup, or through About > Console Status.

The Type column displays the category of the message:

Informational Instructional data that does not impact console functionality.

Advisory Console operation can continue, but with caution.

Warning Urgent issues that require immediate attention.
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The Message column displays the message details, and any applicable suggested actions to help
resolve the issue. The counter in the top-right displays the total quantity of each type of
message.

Possible Status Messages

Hard Drives
• ALERT / Hard Drive / Show Archive

• This device does not have enough available hard drive space to operate safely.
• Minimum amount of free space recommended.
• The show archive is completely full, future saves to the archive will fail.
• Save to an external drive and free space from the archive as soon as possible.

Memory Problems
• Memory Fragmentation / System Memory

• Largest Free Block is under a certain amount.
• RAM usage is at or above a certain amount.
• Application memory usage is at or above a certain amount, which is close to exhausting

addressable memory space.
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About Manual Control
Eos provides a variety of different ways to select and command control channels. This chapter
identifies the many basic ways you can select channels and manipulate show data within Eos.

For additional methods, see About Advanced Manual Control (on page 308).

Using Channel Faders On Element 2
One way to bring up channel levels with Element is using the channel faders. The fader position
switch is used to select between channels 1 through 40, channels 41 through 80, or channels 81
through 120. Element will ship with the fader position switch in channels 1 through 40 mode.

With the fader position switch in channels 1 through 40 mode, channel 1 will be controlled by
the leftmost fader in the first bank of faders. Channel 40 will be controlled by the rightmost
fader in the second bank. When the fader position switch is in channels 41 through 80 mode,
channel 41 will be controlled by the leftmost fader in the first bank of faders. Channel 80 will be
controlled by the rightmost fader in the second bank.

Note: Channel faders will only control the first 120 channels. Channels 121 and
above must be controlled via the keypad. See Selecting Channels (below)

Raising a channel fader will bring up the corresponding channel’s level. This will be reflected on
Element’s live display. The channel intensity level will appear in red to indicate the level is being
set manually. See Color Indicators (on page 76)

Element’s fader status display will also show the channel’s level. For more information, see
Indicators in the Element Fader Status Display (on page 103)

Element’s channel faders are LTP or Latest-Takes-Precedence, which means that you can take
control of a channel simply by moving the fader to match the current output level. Channel
faders, like the keypad and level wheel, can then take levels above or below the current
playback level. See HTP vs. LTP (on page 9).

Holding down [Shift] while moving the channel faders, will allow them to move without
changing the channel levels. This is helpful when you have used your channel faders to record a
cue. This allows you to restore your faders to zero, while leaving the cue values on stage. If you
don’t do this, the LTP behavior will drive the channels toward zero.

Selecting Channels
There are multiple ways to select channels including the control keypad, direct selects, and
groups.

Selected channels are available for manual control through keypad commands, level wheel, and
/ or ML controls.

Channels are deselected when any action is taken on the keypad that is unrelated to manual
control, such as recording groups and cues, or updating a record target, etc. You can also press
[Clear] after a terminated command line to clear the channel selection.

Note: When manual channels are used, there will be an advisory that says "Manual
Channels" in red in the upper left hand corner of any Live display.

Note: Selecting channels from the summary or table displays will start a new
command line.
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Select Channels From the Keypad
The keypad defaults to selecting channels. Channels may be selected on the control keypad
using the [+] and / or [-] and [Thru] keys for consecutive or non-consecutive channel selection.

The following examples illustrate various methods of selecting channels from the control
keypad:

• [5] [Enter] - selects channel 5.
• [5] [+] [7] [Enter] - selects non-consecutive channels 5 and 7.
• [5] [Thru] [9] [Enter]- selects channels 5 through 9.
• [2] [Thru] [8] [-] [5] [Enter] - selects a range of channels 2 through 8, except channel 5.
• [-] [6] [Enter] - removes channel 6 from the current selection list.
• [+] [1] [Enter] - adds channel 1 to the current list of channels.

Note: You may use [+] and / or [-] multiple times to add or remove multiple channels
from the selection. [Thru] lists may be entered in ascending or descending order.

Note: The [Thru] command uses the current flexichannel state. Channels not
included in the flexichannel mode (except selected channels mode) are not collected in
a thru range. [Thru] [Thru] can be used to collect all channels in the range, even if they
are not in the current flexi mode. See Using Flexichannel (on page 79) for more
information.

Modifying a Terminated Channel Selection
It is possible to add or remove channels from a previously terminated command line. You will
need to first press [+] or [-] and then you can add to or remove from your current channel
selection. This includes selecting channels from the direct selects, summary view, and Magic
Sheets.

Using Groups as a Channel Collector
[Group] can be used as a quick way to collect channels from submasters, cues, palettes, or
presets. SeeAbout Groups (on page 220) for more information.

The following actions are possible:

• [Group] [Cue] [1] - selects all the channels in cue 1.
• [Group] [Sub] [3] - selects all the channels in submaster 3.
• [Group] [Int Palette] [5] - selects all the channels in intensity palette 5.

[Next] and [Last]
The [Next] and [Last] buttons increment and decrement channel selection. If only one channel is
selected, [Next] increments the channel selection to the next sequential channel, while [Last]
decrements the channel selection by one.

Example:
Select channel 10 then change the selection to channel 11 using the [Next]
key:

• [1] [0] [Enter]

Channel 10 is selected with a gold outline around the entire channel and the
channel number is indicated in white.



190 Eos Ti, Gio, Gio @5, Ion Xe, Ion Xe 20, and Element 2 Operations Manual

• [Next]

Channel 11 is now selected with a gold outline and white channel number
while channel 10 is no longer selected.

When a group of channels is selected, pressing [Next] or [Last] selects the first or last channel in
the channel list.

Example:
Channels 11 through 20 are selected:

• [Next]

Channels 11 through 20 are still the specified channel list but only channel 11 is
selected for control. You can now sequentially press [Next] or [Last] to cycle
through the list. Press [Select Last] to reselect the entire range.

Note: [Next] and [Last] work with the current flexichannel state. See Using
Flexichannel (on page 79)

Offset
{Offset} can be used to select a range of channels from a broader channel selection prior to
storing groups, submasters, presets, palettes, effects, and using park.

Options
When {Offset} is pressed, a channel distribution display will open.

The following options are available as extensions of {Offset}. Options can be used together.
These extensions can be used to create Subgroups (on page 221). To close the Offset display,
press {Close}.

Direction
• {Reverse} creates a group with the channels in the reverse order that they were selected

in.
• {Mirror In} creates subgroups of channels that mirror inward.

• [1] [Thru] [8] {Mirror In} [Enter] would create 4 subgroups in this order: (1,8) (2,7) (3,6)
(4,5)
Ch 1 Ch 2 Ch 3 Ch 4 Ch 5 Ch 6 Ch 7 Ch 8
X X

X X
X X

X X
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• {Mirror Out} creates subgroups of channels that mirror outward.
• [1] [Thru] [8] {Mirror Out} [Enter] would create 4 subgroups in this order: (4,5) (3,6)

(2,7) (1,8)
Ch 1 Ch 2 Ch 3 Ch 4 Ch 5 Ch 6 Ch 7 Ch 8

X X
X X

X X
X X

• {Random} creates a random order to the channels.

Grouping
• {Chan Per Group} creates a specified cluster of channels.

• [1] [Thru] [1][2]{Chan Per Group} [3] [Enter] would create these 4 subgroups of 3
channels each: (1,2,3) (4,5,6) (7,8,9) (10,11,12).

• {InterLeave} creates a number of distributed sets of channels, that are not clustered
together.
• [1] [Thru] [1][2]{Chan Per Group} [4] {InterLeave} [Enter] would create these 4

subgroups: (1,4,7,10) (2,5,8,11) (3,6,9,12).
• [1] [Thru] [5] [+] [1][1] [Thru] [1][5] [+] [2][1] [Thru] [2][5] {Chan Per Group} [3]

{InterLeave} [Enter] would create these 5 subgroups: (1,11,21) (2,12,22) (3,13,23)
(4,14,24) (5,15,25).

• {Num Groups} creates a specified number of subgroups.
• [1] [Thru] [1][2]{Num Groups} [3] [Enter] would create these 3 subgroups: (1,2,3,4)

(5,6,7,8) (9,10,11,12).

Spacing
• {Jump} is used to skip over a specified number of channels.

• [1] [Thru] [1][2]{Chan Per Group} [3] {Jump} [1] [Enter] would create these 3
subgroups of 3 channels each: (1,2,3) (5,6,7) (9,10,11). Channels 4, 8, and 12 will be
jumped over and will not be in the subgroups.

• {Odd} selects only the odd numbered channels.
• {Even} selects only the even numbered channels.
• {Reorder} is used to reorder the channels of a group into numeric order.

Using Offset
For the offset feature to function, you must first select multiple channels, then press {Offset}.
Choose from the options described above to modify your channel selection.

Example:
• [1] [Thru] [10] {Offset} {Even} [Enter] - selects channels 2, 4, 6, 8, 10.
• [1] [Thru] [2] [0] {Offset} [3] [Enter] - from the selected group, this

syntax would select channels 1, 4, 7, 10, 13, 16, 19 which is an offset of
every third channel from the selection.

• {Group 5} {Offset} {Random} [Enter] - selects all channels in Group 5 and
places them in random order. This selection may be used only temporarily
or it may be recorded to a new Group.

• [1] [Thru] [2] [0] {Offset} {Even} {Random} [Enter] - selects all even
channels within the range and puts them in random order.

• {Group 3} {Offset} {Reorder} [Enter] - reorders the channels in group 3 so
they are in numeric order.
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• {Offset} [4] [Enter] -selects every fourth channel in the current channel
selection.

• [1] [Thru] [2] [4] {Offset} [4] [/] [4] [Enter] - selects channels 4, 8, 12,
16, 20, and 24. You can select to offset by 2/2, 4/4, 3/3 etc.

{Offset} can also be used more than once to apply different offset commands to different
channel selections on one command line.

Example:
• [1] [Thru] [20] {Offset} [Even] [+] [60] [Thru] [80] {Offset} [3] [Enter] -

selects all even channels between 1 and 20, and all odd channels
between 60 and 80.

• [1] [Thru] [10] {Offset} [2] [+] [20] [Thru] [30] {Offset} [Jump] [1] -
channels 1-10 are offset by 2 (1,3,5,7,9) and 20-30 are jump 1 (20, 22,
24, 26, 28 ,30).

Select Channels From the Direct Selects
Direct selects provide one-touch selection of channels, groups, palettes, presets, effects and
macros. You can configure an array of channels on direct select that display with paging buttons
provided for easy scrolling. See Direct Selects (on page 86)

Open a direct select display by selecting {Direct Selects} from the Home Screen and then select
the {Channels} button. When channels are posted to the direct selects, you can select one
simply by pressing the channel’s touchbutton. The command line will show the appropriate
channel and the selected direct select will be outlined in yellow.

Channel selection from the direct selects is an additive process. When a channel is selected, it is
added to the current selection set. To select only one channel and deselect all others, double-
press the channel touchbutton.
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Example:
• If channels [1] [Thru] [5] are selected from the keypad, pressing

{Channel 6} from the direct selects adds channel 6 to the current channel
selection.

• If channels [1] [Thru] [5] are selected from the keypad, pressing
{Channel 6} {Channel 6} deselects channels 1 through 5 and selects
channel 6.

The following examples illustrate the various methods of selecting channels using the direct
selects:

• {Channel 1} - adds channel 1 to the currently selected channels, if not currently selected.
• This is similar to pressing [+] [1] [Enter] from the keypad. However if channel 1 were

currently selected when you pressed {Channel 1}, this would deselect channel 1 from the
channel selection.

• {Channel 5} {Channel 6} - adds channels 5 and 6 to the current channel selection.
• This is similar to pressing [+] [5 [+] [6] [Enter] from the keypad.

• {Channel 5} {Channel 5} - selects channel 5 and deselects all other channels.
• This is similar to pressing [5] [Enter] on the keypad, when the previous instruction is

terminated.

Deselecting Channels
Channels are deselected when any action is taken on the keypad that is unrelated to manual
control, such as recording groups and cues, or updating a record target, etc. You can also press
[Clear] after a terminated command line to clear the channel selection.

Note: [Select Last] is a fast way to regain your last channel selection. See Select Last
(on page 216)

Any manual control action taken while record or update is on the command line will
automatically reselect your last channel selection.

Setting Intensity
Channel intensity may be manually entered from the keypad, set with an intensity palette (if
programmed) or set with a level wheel. Pressing [At] after channel selection assumes an
intensity value will be added to the selected channels. You may also use the [Full] button to
bring the selected channels to their full intensity or you may use the [Out] button to fade the
intensity out.

Use the [Level], [+%], and [-%] keys to affect the intensity value of selected channels. Each of
these keys are set at a specific value established in the Setup (Manual Control (on page 178)).

• [Level] is set by default to 80%.
• [+%] and [-%] are each set by default value of 10 points.

The following examples illustrate the various methods of setting intensity:

• [1] [+] [3] [At] [5] <0> [Enter] - selects channels 1 and 3, and sets an intensity level of
50%.

• [1] [Thru] [5] [-] [4] [Full] [Enter] - selects a range of channels 1 through 5, except
channel 4, and sets the intensity to full.
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• [1] [Thru] [8] [At] [+] [3] <0>[Enter] - adds 30% to all intensities in the channel selection.
If they were at 50, they will now be at 80. If channels 1, 3 and 5, were at 30 and 4 was at
50, they would be 60% and 80% intensity, respectively.

• [5] [Thru] [8] [At] [/] [3] <0> [Enter] - scales the intensities of the selected channels in the
list down 30% of their current values.

• [1] [Thru] [4] [At] [/] [1] [3] [0] [Enter] - scales the intensities of the selected channels in
the list up 30% of their current values. If channels 1 through 4 were at 40% intensity, this
would scale them up by 30% to a value of 52.

• [2] [+] [5] [level wheel] - roll the wheel up for greater intensity or down for less intensity.
• [1] [Level] - selects channel 1 and sets it to the level as established in Setup.
• [Group] [9] [Out] - selects all channels in Group 9 and sets the intensity values for those

channels to zero.
• [1] [0] [At] [At] - selects channel 10 and sets an intensity level as established in Setup.
• [1] [Full] [Full] - selects channel 1 and sets it to full and self terminates the command line.
• [1] [At] [/] [/] [2][3][9] [Enter] - puts channel 1 at DMX value 239.

Example:
• [1] [Thru] [5] [Full] [Enter]

The selected channels are highlighted in gold, with white channel text and red
intensity values (indicating manual data). You may continue to modify channels
1 through 5 since they are still selected and displayed on the command line.

• [-%] [-%]

This command would reduce the intensity of channels 1 through 5 by 20%. This
command is self-terminating.

• [At] [7] [5] [Enter]

You can continue manipulating the selected channels so long as the channels are selected and
displayed on the command line.

Manual Control of Non-intensity Parameters (NPs)
Non-intensity parameters can be set with a variety of controls including the control keypad,
buttons on the central information area (CIA) and the encoders.

Using the Parameter Display
The parameter display in the CIA is populated with only those parameters that are found in the
patched devices. As channels are selected, the parameter display will change to show only
parameters relevant to the selected channels.

The parameters are divided into the following categories: Intensity, Focus, Color and Beam.
Each parameter category is represented with buttons in the parameter tiles. These buttons allow
you to select the entire collection of all parameters within that category. You can also select a
single parameter from a category using that parameter’s button in the parameter display.

Beam has three subcategories which correspond to the way the encoders are mapped. They are
{Form}, {Image}, and {Shutter}. These subcategories are represented with buttons in the CIA.
Pressing these buttons allows you to select all parameters within those subcategories.
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Within the CIA, in the upper left corner, notice the {All NPs} button. When pressed, this collects
all non-intensity parameters for further editing.

Some examples of using parameter touchbuttons are:

• [1] {Iris} [5] [Enter] - Places the iris parameter of channel 1at 50%.
• [Group] [4] {Zoom} {Edge} [Out] [Enter] - Sends any zoom and edge values for all fixtures

in group 4 to their home value.
• [1] [Thru] [3] {All Speed} [At] [2][5][Enter] - Sets all the available speed parameters for

channels 1 through 3 to 25.

Setting Parameters with the Keypad
When the CIA is placed in parameter mode, all parameters of selected channels may be given
numeric values through the keypad.

When no channels are selected, the CIA shows all of the parameters that are available in the
lighting system. When channels are selected, the CIA condenses to show only the parameters
that are appropriate to the selection set. If channels are selected that have different device
types, such as spot and wash lights, the CIA will show all of the available parameters.

The following examples illustrate how to set parameter values with the keypad:

• [5] {Iris} [5] {Zoom} [6] [5] {Edge} [5] [Enter] - sets channel 5 to an iris value of 50%, a
zoom value of 65%, and an edge value of 50%.

Note: Pressing [Shift] & [Encoder Paging Key] will place the associated parameter
onto the command line for numeric entry

Using [At] [/] [/] will place the direct DMX value on the command line. For example, [1] [At] [/]
[/] [2][3][9] [Enter] would put channel 1 at DMX value 239.

You can also set a channel's parameter levels with the DMX value by using [/][/].

• [1] {Pan} [/][/] [2][5] [Enter]

You can add or subtract from the DMX value by using [+] or [-].

• [1] {Pan} [/][/] [+] [5] [Enter]
• [1] {Pan} [/][/] [-] [7][5] [Enter]

Adjusting Parameters Using + and -
[+] and [-] can be used to adjust parameters from the command line. When using [-], you will
need to preface the command with [+] if you want to remove from the current value.
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Example:
• [Channel List] {Pan} [1][0] - sets to 10 degrees.
• [Channel List] {Pan} [+] [1][0] - adds 10 degrees.
• [Channel List] {Pan} [-] [1][0] - sets to -10 degrees.
• [Channel List] {Pan} [+] [-] [1][0] - removes 10 degrees.

Setting Non-intensity Parameters with the Encoders
For more information about the encoders, see Encoders (on page 94) .

Encoders provide a quick method to adjust current values for non-intensity parameters.

On Eos Ti and Eos, the bottom two encoders always control pan and tilt functions. The four
vertical encoders are pageable using the encoder page buttons near the encoder LCD. On Eos,
the five encoder page buttons are: [Custom], [Color], [Shutter], [Image], and [Form]. On Eos
Ti, the six encoder page buttons are: [Custom], [Intensity], [Color], [Shutter], [Image], and
[Form].

On Gio, Gio @ 5, and Ion Xe, the four horizontal encoders are pageable using the encoder page
buttons directing under the encoders. The six encoder page buttons are: [Intensity], [Focus],
[Color], [Shutter], [Image], and [Form].

Form, Image and Shutter are subcategories within the broader parameter category of Beam.

• Custom - includes intensity and intensity MSpeed.
• Color - includes all color mixing controls (CMY, RGB, HS), as well as scrollers, color

wheels, and color effects.
• Form- includes parameters that affect the quality or size of the light output, such as edge,

zoom, iris, IMF, frost, etc.
• Image - includes anything that drops into the gate, such as gobos, effects wheels, etc.
• Shutter - includes all of the framing devices for the luminaire.

Note: Pressing [Shift] & [Encoder Page Key] will post that parameter to the command
line. For example, pressing [Shift] & [Color] would place Color on the command line.

Encoder Display
On Eos and Eos Ti, the encoder display LCD to the left of the encoders indicates the parameters
they control and provides additional information about the current status of those parameters.
For more information, see Encoder Display on Eos and Eos Ti (on page 94)

On Gio, Gio @ 5, and Ion Xe, the mini encoder display indicates the parameters the encoders
control and provides additional information about the current status of those parameters. To see
additional encoder information, use the [Encoder Display] button to open the encoder display.
For more information, see Encoder Controls Display (on page 96)

On Element 2, you can access encoder control by using the ML controls display. See Moving
Light Controls (on page 100) for more information.

Note: For ETCnomad, RPU, and RVI, the encoder display can be accessed by using
CTRL + ALT + \ on an alphanumeric keyboard. ALT + , can be used to change encoder
pages.

Encoder pages populate with parameters relevant to fixtures in the show patch. When you
access a parameter page, controls that are not available for selected channels are suppressed.
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Note: Flexi encoders is used to suppress parameters not applicable to the selected
channels. This is used by default for the encoder display. See Flexi Encoders (on
page 98)

Each encoder has an associated control section that provides visual indication of:

• the parameter it controls.
• the current setting (value) of the parameter.
• and the current mode if the encoder controls more than one function.

Coarse/ Fine

Allows for control of “coarse” (8 bit) or “fine” (16 bit) control. Default is coarse control. You
may toggle between the two by pressing [Shift] while moving the encoder.

• Coarse - provides larger changes for non-segmented parameters and
advances/decrements full frames for segmented parameters. The encoder is clutched in
this mode, meaning you will feel each frame change distinctly.

• Fine - provides unlimited, high granularity control. When used in this mode the encoder is
not clutched, allowing you smooth and detailed control.

Encoder paging

The number of encoder pages for each category will display.

For Eos and Eos Ti, they are displayed in blue at the top of the LCD display.

For Gio, Gio @ 5, and Ion Xe, they are displayed at the bottom of the parameter category
softkeys.

You can go directly to the page required by pressing the encoder page button and a page
number. For example:

• [Form] & [3] - this will take you to the third page of the form category.

Information in the encoder display is only as accurate as the patch information for that channel.
For example, when you are working with color scrollers, the standard manufacturer color frames
will be displayed for scroller controls unless you have created a custom scroll for the selected
channel in patch using the Scroll Editor.

When you have created a new scroll or wheel in patch for any channel and that channel is
selected, that information will be displayed in the associated encoder display. See Using the
Editor (on page 138)

When you access a parameter page, the encoders will automatically load and display the first
page that has a valid parameter for the selected channels.

Encoder Softkeys
A series of buttons are included in each of the four encoders sections of the display including
{Home}, {Last}, and {Next} or {Min} and {Max}, and depending on the type of parameter, a
{Mode}, {Expand}, or {Calibrate} button.

Note: To access these softkeys at any time, press down on an encoder.

Home

Each parameter has an associated {Home} key in the encoder LCD. This accesses any parameter
and returns it to its default position. Additionally, the control keypad has a [Home] key located
below [Sneak]. See Home (on page 207) for more information.
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Min and Max

{Min} and {Max} are displayed when the parameter is linear, such as a shutter. Use these keys
to set a minimum and a maximum setting for a parameter.

Next and Last

{Next} and {Last} are displayed when the parameter is segmented such as a fixed gobo or color
wheel or a color scroller. Use these keys to increment or decrement in full frames.

Mode

The {Mode} key is provided to select different modes for the encoder wheel such as rotate,
index, or special effects.

• When more than two modes are available, the {Mode} key can be pressed repeatedly,
advancing through the various modes. Each mode will display beneath the current
parameter setting.

• When only two modes are available, the alternate mode is indicated instead of a {Mode}
key. Toggling that button switches the encoder wheel to the alternate mode.

Expand

Some parameters will have an {Expand} button, which indicates that this parameter has
“Expanded” functions. When that button is pressed, the display repaints to display all the media
settings available for the specific wheel.

Flip

The {Flip} button, as displayed in the Pan/Tilt section of the encoder LCD, is used to flip the unit
into its exact same position, but from the other direction. Depending on the current values of
pan and tilt, there may be multiple flips.

This allows you to correctly focus a fixture that may be at the end of its pan or tilt range or to
correct a fade that may be moving in an undesired direction.

The following example illustrates the use of {Flip}:

• [channel list] {Flip}

Trackball On/Off

The {Trackball On/Off}, as displayed in the Pan/Tilt section of the encoder LCD, is used to give
pan and tilt functionality to a mouse or trackball device.When this function is turned on, above
the CIA will be a message saying “Cursor as Pan/Tilt”.

Left-clicking the mouse will exit trackball mode.

XYZ Format Enable / Disable

Toggles between storing position data in pan / tilt format and XYZ format for use with
Augment3d.

Form Control
Form (a subcategory of Beam) collects the parameters that affect the quality of the beam,
including the iris, edge, frost, etc. ‘Shutter’ and ‘Image’ are the other two subcategories of
Beam

When the form encoder page button is selected, the LED will illuminate and the encoders
automatically populate with the “Form” parameters as specified in the show patch. If there are
more parameters in the show patch than will fit on the first page of the encoders, press the
[Form] button again to page through the remaining parameters in the category or press [Form]
and a page number to jump to a specific page.

The form parameters may include:



Manual Control 199

• Edge - controls the hard/soft qualities of a spot luminaire. While some fixtures may call
this parameter “focus”, it is always represented as “edge” in Eos, to avoid confusion with
“Focus” which refers to pan and tilt data. These values are set to the system default value
for the selected luminaire, but may be modified as required on a per fixture basis

• Iris, Zoom, Strobe and IMF- each parameter has in/out, narrow/wide, or fast/slow
settings. Iris and Zoom also have programmable limits, called in/out and narrow/wide
respectively. The strobe mode setting varies based on the fixture type.

Image Control
Image is the collection of parameters that affect the contents of the beam (gobo, prism, effects
wheel, etc.).

Shutter Control
Pressing the [Shutter] button displays shutter controls, if there are any fixtures with framing
devices patched.

Note: For Ion, ETCnomad, RPU, and RVI, the encoder display can be accessed by
using CTRL + ALT+ \ on an alphanumeric keyboard. ALT + ,can be used to change
encoder pages.

Shutter Graphic

Tap or click on the shutter graphic to open up the shutter controls window.

The shutter controls window allows you to move individual shutters by holding down one of the
letters inside of the shutter graphic. To rotate the shutters, use the <A>, <B>, <C>, or <D>
buttons around the outside of the shutter graphic.

Encoder Buttons

Note: The encoder buttons are used with the encoders for shutter control. These
buttons do not work with the shutter graphic control.

The following buttons are available for shutter control:

• Angle Home - sets the angle of all of the shutters to their home position.
• Thrust Home - sets the thrust (how far in or out of the beam the shutter travels) of all of

the shutters to their home position.
• Pair AC - pairs the A and C shutters together so they move together.
• Pair BD - pairs the B and D shutters together so they move together.
• Pair All - pairs all of the shutters so they move together.
• Inverse AC - pairs the A and C shutters so they move in the opposite directions from each

other.
• Exceed Limits - ignores the limits angle and thrust place on each other, prioritizing

whichever parameter is adjusted, regardless of the impact on the other.
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• Inverse BD - pairs the B and D shutters so they move in the opposite directions from each
other.

• A>D - sets the encoders to use the custom encoder pages for the shutters. Thrust for all of
the shutters is on one page, Angle for all is on another page.

Color Control
Depending upon the specific device, color can be established manually with the encoders using:

• CMY color-mixing
• Hue and saturation color mixing
• RGB color-mixing
• Selection from a color wheel or scroller
• CIE color picker tool

You may also specify color by using the full color picker on [Tab] [2] [7]. See Using the Color
Picker (on the facing page) for more information.

It is also possible to set non-intensity parameter data with direct entry using the control keypad
and using the parameters on the CIA.

• [1] [At] [4] <0> {Cyan} [5] [5] [Enter]

The first page of the color encoder will provide some scroller control, such as frame selection, on
the top encoder. The next three encoders will control HS, CMY, or RGB color mixing. There will
be buttons on the first page for switching between HS, CMY, and RGB. The HS controls will
include buttons for {Home}, {Min}, and {Max}. The CMY and RGB controls include buttons for
{Home} and {Max} for each of the parameters. No {Min} button will be displayed.

Note: Color scroller data will display on the encoders and displays as frame numbers,
F1, which would be frame 1, F2 for frame 2, etc. F1.5 is halfway between 1 and 2. F2+
will display if the frame is less than 2.5 and F2- if the frame is greater than 1.5. After
the frame number, the gel number will also be displayed. This is also true for color and
gobo wheels.

Note: Frame numbers can be used from the command line. [2]{Scroller}[5][Enter]
will send channel 2’s scroller to frame 5. Frames can also be selected by using the DMX
value for that frame. Pressing [/] twice will post DMX to the command line. [3]
{Scroller} [/][/][2][5][5] [Enter] will send channel 3’s scroller to the frame with the DMX
value of 255.

Note: Dual scroller fixtures are addressed as 0-100% instead of by frame numbers.
You may need to update your fixture before this feature will work. See Update Profile
(on page 152)
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Custom Control
Pressing the {Custom} button enables custom encoder mode. For more information, see Custom
Encoder Maps (on page 98).

Using the Color Picker
The color picker can be opened from the Workspace Layout Menu (on page 65) or by using
[Tab] [2][7].

With the color picker open, you have the choice between six different Color Spaces, a Gel
Picker,Color Path, Tinting Tools, and Spectrum Tools.

These options are found by right-clicking on Color Picker Tab.

Color Spaces
There are six color spaces that you can choose to work in. All of these spaces are connected. So
it doesn't matter which space you wish to work in, the console will translate the information to
work with your fixtures.

When the color picker is first opened, the CIE xy color space and the gel picker will open by
default. You can select other color spaces and tools by clicking on the display configuration tool
(the gear icon) in the bottom left corner of the tab bar, or by right-clicking on the tab.

Note: Multiple color picker tabs with different color spaces can be opened at the
same time. Multiple color spaces can be opened on the same tab.

The available color spaces are:
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Note: When a fixture is in HS mode, the brightness control is not provided. Intensity
controls the brightness.

For the CIE xy (CIE 1931) and CIE uv (CIE 1976), the triangle represents the RGB space as
defined by the PLASA standard E1.54. Fixtures that comply to that standard can achieve any
color within the triangle. The cone represents the color spectrum that we can see.

Controls

Each color space has three virtual encoders, a vertical encoder, a {?} button, and a {^} button.

The encoders will change based on the color space selected. Double tapping in a virtual encoder
will cause it to jump to the location of your finger. Pressing and holding will cause the encoder
to fade toward your finger.

Tapping anywhere in the color space will cause the crosshair to move to that location. Press and
hold, then move your finger to fade the crosshair toward that location.

The {^} button will create the brightest version of the selected color. Press the {?} button to
display labels on all of the controls.

For the RGB and CMY color spaces, you can change which color control is on the vertical
encoder. Touch the label of the virtual encoder to change which color control is located on the
vertical encoder. In the following graphics, Red is on the vertical encoder in the first one and
green is on the vertical encoder in the second one. This is also indicated by the highlighted
encoder name.
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For the HS Wheel and HSB color spaces, the vertical encoder is always brightness.

Gel Picker
When the gel picker is opened up with a color space, dots will display on the color space. These
dots represent the gels in the currently selected gel book. Hovering over a dot with a mouse will
display the gel's name and a color swatch.

The following buttons are also available:

• {Brightest} - determines the color match used. This is helpful when working with fixtures
that have more than three color components, such as RGBA, RGBWm or ETC's fixtures.
Pressing {Brightest} or {Shift} +a gel from the picker will cycle through the three modes.
• {Brightest} - matches to the brightest match of that chromaticity.
• {Spectral} -matches to the best spectral match chromaticity. However, this mode can

remove a lot of the intensity. This is based off of a 575w long life Source Four®.
• {Hybrid} - halfway between the brightest and the best spectral match. In the channel

display, a single dot shows best spectral match, 2 dots indicates hybrid, and no dot
shows brightest.

• {Sort Hue} - takes the selected gel library and sorts it by hue instead of by gel number.
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• {Similar} - will show gels that are in the same selected area of the color picker. Only gels
in the same selected gel book will display. You can switch to another gel book though to
discover gels in that area.

• {Show Gels as Gel Against White Background} displays the raw gel color as it would look
against a white background. This option toggles with {Show Gels as Gel + Lamp Output}.

• {Show Gels as Gel + Lamp Output} displays the gel swatch color as if it was being used
with a tungsten lamp.

• {Show} - displays all of the static gels in the show file. This populates from Patch.
• {Standard Colors} - shows a range of White Point from 2700K to 6500K. Also shown are

colors located around the triangle and variations of those colors at 25% increments.

How the Gel Picker Affects Scroller and Color Wheel

When possible the Gel Picker will select the closest gel as defined in a scroller or color wheel.

Note: Some devices contain manufacturer specified gel mixes, and will only allow
selection from the Gel Picker of the exact gels in their list.

The channel display will show the frame number and the corresponding label that is defined for
that frame.

Tinting Tools
The Tinting Tools option is found by right-clicking on the Color Picker tab (Using the Color Picker
(on page 201)).

Tint allows you to easily adjust color regardless of the color space that you're working in.

You can increase or decrease the saturation and brightness. You can make a color warmer or
cooler, and you can add or remove colors.

Color Path

Note: Color path is only applicable for additive mixing systems.

Color Path is a option for controlling color fades between cues. By default, color fades happen in
the native space of the fixture. If you want a fade that resembles a fade in a different color
space, you can do that using color paths. There are eight preprogrammed color paths, and you
can also record your own . Up to 1000 color paths are supported.
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To open the color path display, click on the gear icon in the color picker display and select Fade.
To open the color path list display, press [Path] [Path], by pressing the {Color Path} icon in the
home screen, use [Tab] [3][3], or from the CIA by going to Browser > Record Target List >
Color Path.

Color paths are selected either by clicking on the drop down above the color path or by using
[Path] [n].

Note: Channels involved in the fade have to be selected before you can choose or
modify a color path.

The color path display has a drop down list of the available paths, a color path preview bar, and
control buttons. An indication line will display on the color space to show the color fade.

Available control buttons are:

•

- replays the color fade using the cue time.
•

- replays the color fade using the Go to Cue time from Setup.
•

- replays the color fade in five seconds.
•

- replays the color fade in ten seconds.
•

- pauses the color fade.
•

- plays / resumes the color fade.
•

- skips to the end of the color fade.

You can also click on the color path preview bar to scrub to any point along the fade.

Additional controls may be available based on the color path selected. For example, Color Path
7 has additional controls for Hue, Saturation, and Brightness. You can move those controls to
adjust the fade, and you'll see a representation of those changes in both the color path preview
bar and in the color space.
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Changes can be stored in the destination cue as absolute data by using [Update] or [Record].
When there's a change to the color path information, a red c will display next to the channel
number and the color path's name will display in red in the color path display. When that data
has been saved, a blue c will display. The color path's name will also display in blue in the color
path display.

You can save changes to a new color path by using [Record] [Path] [n]. That data will then be
referenced, and any changes made to that path will be used anytime that path is used Press
[Shift] & [Path] to see the values behind the referenced data.

Note: If multiple channels are selected that have different color paths assigned to
them, a + will display by the color path name in the color path preview bar.

See [About] Color Path (on page 389) and Attribute Section (on page 144) for more information.

Spectrum Tools
The Spectrum option is found by clicking on the display configuration tool (the gear icon) in the
bottom left corner of the display tab bar.

This option displays all the color parameters across the color spectrum, and allows for individual
control of each parameter. Press a color point to move it.

This display is a good visual of what the fixture is outputting.

The following screenshots show a 7 color fixture. This display will change based on the type of
fixture being used.

Note: The gray line shows the composite color of the fixture. If multiple fixtures are
selected, the gray line represents the first channel selected.

With the Gel Picker open and a gel selected, a dotted line will appear in the Spectrum display.
That line represents the selected gel.
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{Hold Color Point} allows you to adjust individual emitters and the other emitters will
automatically adjust to hold the color selected. This can only be used with fixtures that have
more than three color parameters.

If you are working outside of this display, holding down [Color] while adjusting the encoders will
cause Hold Color Point behavior.

Home
Eos is equipped with a [Home] hardkey. As with the {Home} touchbutton on the Encoder
Display (see Home (on page 197) ). This hardkey allows you to home a specific parameter.
Additionally, you may home all of a channel’s non-intensity parameters or home only a specific
category (I, F, C, B).

Homing a channel, category, parameter, or submaster will return it to the default value.

• [1] [Home] [Enter] - homes all parameters for channel 1, except intensity.
• [1] [Color] [Home] [Enter] - homes all color parameters for channel 1.
• [Group] [1] [Color] [Focus] [Home] [Enter] - homes the color and focus parameters of all

channels in group 1.
• [Sub] [1] [Home] [Enter] - homes submaster 1.
• [Sub] [1] [Thru] [Home] [Enter] - homes all submasters.

Home Preset
You can select a preset to provide home values for all non-intensity parameters (instead of
fixture library default values) when home commands are used. Store a preset with modified
home values for only the channel parameters you would like at a different value than default,
and then assign that preset to Home in Setup (see {Home Preset} (on page 169)). Any channels
that are not included in the preset assigned to Home in Setup will use their library defaults.

Multiple Intensity Channels
When a fixture with multiple intensity parameters is patched, Eos assigns it a master intensity.
The master intensity can be used to control the multiple intensities together. The master
intensity is handled in the same way as the intensity of a single intensity channel.

Levels can be set via the level wheel, from the keypad, and the encoders. The other intensities
will default to 100%.
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Control of the individual intensities of a multiple intensity channel is handled using the
parameter buttons in the CIA (see Manual Control of Non-intensity Parameters (NPs) (on
page 194)) or the encoders (see Custom Control (on page 201)). Levels assigned to the
individual intensities will act independent of each other and the master intensity.

• [1][0][0] {Intens 3} [At] [5][0] - sets intensity 3 of channel 100 to 50% intensity.
• [1][0][0] [At] [7][5] - sets the master intensity of channel 100 to 75% intensity. All

intensities for channel 100 will be mastered to 75% unless they have a separate intensity
set.

In Table view, Eos will default to showing all intensity parameters associated with the channels.

In summary view, the master intensity is shown. If one of the multiple intensities has a value, an
‘+’ will display beside the master intensity.

Multicell Fixtures
Fixtures that have multiple same-type parameters can have a multicell profile assigned to them,
as designated by MC in the fixture editor. See Patching Multicell Fixtures (on page 135) for more
information.

Multicell fixtures have a master channel with a whole number for a channel number and the
appropriate number of additional cells, which will have point numbers for their channel
numbers.

To control the whole fixture (master + cells), select the channel number.

To control individual cells, use [.] to put {Cell} on the command line.

To control just the master, use [Shift] & [.] to put {Minus Cells} on the command line. You can
also use the syntax [1] [.] [0] or [1] {Cell} [0] to only control the master.

To select the master and any or all of the cells, you can use the following syntax examples: [n]
[.] [0] [Thru] [n], [n] [.] [0] [+] [n], or [n] [.] [0] [Thru] [n] [-] [n]. The {Cell} softkey can be used
instead of the [.] hardkey.

Example:
Channel 1 is a multicell fixture with four cells.

• [1] [At] [Full] [Enter]

Sets the intensity of the master channel to full. Note that the intensity
parameter for cells defaults to full.

• [1] [.] [1] [At] [5] [0] [Enter]

Sets only cell one at 50% of the intensity of the master. Cells are a percentage
of the master level. [.] puts cell on the command line.

This can be especially useful when applying effects or palettes.

Example:
Channel 1 through 4 are multicell fixtures with four cells.

• [1] [Thru] [4] [Color Palette] [1] [Enter]

Sets channels 1 through 4 to color palette 1. All four cells of each fixture are set
to color palette 1, which is red.

• [1] [Thru] [4] [Color Palette] [1] [Thru] [4] [Enter]

Channel 1 with its four cells will be set to color palette 1, channel 2 will be set
to color palette 2, and so on.
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• [1] [Thru] [4] [.] [Color Palette] [1] [Thru] [4] [Enter]

For each of the channels, cell 1 will be in color palette 1, cell 2 in color palette
2, cell 3 in color palette 3, and cell 4 in color palette 4.

With a cell selected you can apply data to the master channel as long as the cell does not also
have that parameter. When you have selected a cell, if you apply data that does not apply to
the master, Eos understands to apply it to the cells instead. In the example above, IF the master
had color parameters, this action would apply color data ONLY to the master.

Cells will not send data to other cells. Table view is helpful for seeing which cells control what
parameters.

Example:
Cell 2 of a fixture is currently selected. You can adjust the encoders for pan and
tilt even if the master actually controls those parameters. The cell will send that
information to the master. This allows for greater ease of control.

The following are additional multicell syntax examples:

• [5] [.] [2] [+] [+] - pressing [+] twice will put channel on the command line.
• [5] [.] [Thru] - automatically puts the first cell's number on the command line before the

[Thru] command.
• [5] [.] [1] [Thru] [Enter] or [5] [.] [1] [Thru] [At] - automatically puts the last cell's number

on the command line before a [Enter] or [At] command.
• [5] [.] [-] [4] [Enter] - selects all of the cells except cell 4.
• [1] [+] [+] [2] [.] [3] [Enter] - selects all of channel 1, and only cell 3 of channel 2.
• [1] [+] [3] [.] [2] [Shift] & [.] - appending [Shift] & [.] after a cell number will post [All

Cells] to the command line, selecting all cells of channel 1, and only cell 2 of channel 3.

Offset can be very useful when applied to multicell fixtures, and can be useful for creating
subgroups. See Offset (on page 190) and Subgroups (on page 221) for more information.
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Lamp Controls
Lamp Controls (Tab 31) allow you to execute control functions of selected fixtures such as
calibrate, douse lamp, strike lamp and reset. Each fixture type has its own set of lamp control
options which are available to you when you select the fixture from Live and press the {Lamp
Ctrls} softkey. This information is also available using [About] (see Using About (on page 379)).

Example:
• [1] [1] [Enter] {Lamp Ctrls}

-or-
• [1] [1] [Enter] [About] {Lamp Controls}

If the channel is a conventional (intensity-only) fixture, no control options will be displayed.
When the selected channel is an automated fixture, options specific to the fixture type will
display for use. Available RDM functions will also display here.

Pressing any of these control options will affect the selected channel after a confirmation.

Using [+%] and [-%]
Use [+%] and [-%] keys to incrementally change parameter values.

By default, the [+%] and [-%] keys are assigned a value of 10. This can be changed in Setup.
See Manual Control (on page 178) for more information.

Channel Intensity
When channels are selected, pressing [+%] increments the intensity level by 10 (or by the value
established in Setup, see Manual Control (on page 178). Alternatively, you may press [-%] to
decrement the intensity level by 10. You may use these keys consecutively to “add to” or
“subtract from” the intensity level.

Example:
Select channels 1 through 10 and set them to an intensity level of 45% from the
keypad.

• [1] [Thru] [1] [0] [At] [4] [5] [Enter]

Change the intensity level to 65% using the [+%] key, which is set to its
default value of 10% in the setup menu.

• [+%] [+%]
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Non-Intensity Parameters
The [+%] and [-%] keys may be used to incrementally adjust non-intensity parameters as well.

Example:
• [1] {Iris} [+%] [+%]
• {Zoom} [-%] [-%]

Remainder Dim

Note: By default, [Rem Dim] will set to zero. In Setup, you can assign a remainder
dim value of something other than zero. See Manual Control (on page 178). For the
purposes of this discussion, the default value of zero will be used in examples.

[Rem Dim] temporarily provides a zero intensity to all channels except those that are currently
selected, those that are parked, or those with intensity contributions from submasters. If the
remainder dim command is reversed, the stage returns to its previous state. You may use the
following commands for remainder dim:

• [Next] and [Last]- moves through the channel list.
• [select channels] [Rem Dim] [Enter] - sets all non-selected channels to zero.
• [1] [At] [6] <0> [Rem Dim] [2][0] [Enter] - sets channel 1 to 60% and all non-selected

channels active over 20% to a rem dim level of 20.
• [Rem Dim]- clears the rem dim function and returns the stage to its previous state

Pressing [Rem Dim] again releases all channels from rem dim mode and restores the stage to its
previous state. Using the [Next] and [Last] buttons releases the current selected channel from
remainder dim mode and sets its intensity to zero, while selecting the next or last channel and
continuing rem dim operation.

Example:
Assume channels 5 through 9 are selected and set at an intensity level of 50%
and channels 10 through 15 are selected and set at an intensity level of 70%.
Select channel 9 and dim the remaining channels.

• [9] [Rem Dim] [Enter]

Channel 9 is set at an intensity level of 50% and all remaining channels are
dimmed to zero.

• [Next]

Selecting [Next] changes the channel selection to channel 10 which is set at an
intensity level of 70%, the level set in the previous state, and all remaining
channels including channel 9, are dimmed to zero.

• [Rem Dim]

Pressing [Rem Dim] again will return all channels to their previous levels.

[Rem Dim] can be used in groups including the use of [Next] and [Last] buttons to progress
through the channels within the selected group.

Example:
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Assume you have group 1 selected (includes channels 1 through 10) with an
intensity value of 50%, group 5 selected (includes channels 11 through 20) with
an intensity value of 70%, and group 7 selected (includes channels 21 through
30) with an intensity value of 100%

• [Group] [1] [At] [5] [Enter]
• [Group] [5] [At] [7] [Enter]
• [Group] [7] [At] [Full] [Enter]

Select only Group 1 and dim the remaining Groups using the [Rem Dim]
feature.

• [Group] [1] [Rem Dim] [Enter]

Channels 1 through 10 are selected with an intensity value of 50%, and all
remaining channels are at a 0% intensity. You may progress channel by
channel through the selected group (Group 1, channels 1 through 10) using the
[Next] or [Last] key. Each press of the [Next] or [Last] key cycles you through
only the channels of the selected group.

Pressing any other key terminates the [Rem Dim] mode and leaves channels at
their remainder dim value.

You can set the dim level for all remainder dim commands in Setup (see Manual Control (on
page 178)). When set to a value other than zero, all rem dim commands will bring intensity to
this level instead. However it won’t bring an intensity up. For example, if the rem dim level in
setup is set to 50%, [Rem Dim] will drop any value above 50% to 50%, but not add intensity to
any channels below 50%.

It is possible to override the dim level temporarily by specifying a level after the [Rem Dim]
command.

[Rem Dim] can also be used to remove channels from a submaster or cues during a [Record].

Example:
Using [Rem Dim] You can modify which channels are recorded in the
submaster. For this example, assume that channels 1 through 10 are at full.
You’ve recorded that to submaster one.

Using [Rem Dim], you can modify the record so only channels 1 through 5 are
recorded to the submaster.

• [1] [Thru] [1] [0] [At] [Full] [Enter]
• [Record] [Sub] [1] [Enter]
• [1] [Thru] [5] [Record] [Sub] [1] [Rem Dim] [Enter]

A [Rem Dim] command can also be used on a selective cue record. It will force any channels not
included in the record, but that are tracking forward from a previous cue, to zero.

Rem Dim
Rem Dim levels can either be an absolute value, such as Full or 50%, or a proportional value,
which would set the levels to a percentage value of their current levels. To use a proportional
value, press [/] before entering the percentage value.

Example:
Assume that channels 1 through 10 are selected and set to an intensity level of
60. Select channel 1 and dim the remaining channels.

• [1] [Rem Dim] [/] [5][0] [Enter]
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Channels 2 through 10 will be dimmed to 30.

Highlight and Lowlight
Eos can be placed in Highlight mode. Channels selected while in this mode will either go to a
default setting, or to a value provided by a highlight preset (established in setup, Manual
Control (on page 178)). Modifications can then be made to those channels. Any changes will be
maintained when the highlight mode is removed.

To place Eos in highlight mode, press [High] [Enter]. To place Eos Ti, Gio, Gio @ 5, Ion Xe, and
Element 2 in highlight mode, press [High] [Enter]. The command line will show that highlight is
currently in use.

If no highlight preset is established, or for channels that have no value stored in the highlight
preset, the following values will be applied to channels as they are selected:

• Intensity - full
• Focus parameters - no change from present state
• Color parameters - home value
• Shutter parameters - no change from present state
• Image parameters - home value
• Form parameters - no change from present state

Example:
1. [Group] [1] [High] [Enter] - places channels 1 through 5 in highlight.
2. [Next] - specifies channel 1.
• 1 is in the highlight value.
• 2 - 5 are in the lowlight value.
• All other channels go to the defined rem dim level.

You may assign both a highlight and a lowlight preset in setup (see Manual Control (on
page 178)). Any preset may be used. Channels with only one parameter included in the preset
assigned to Highlight and Lowlight will not reset other parameters back to their default highlight
values (see above).

On a command line with a channel selection, you can use [Shift] & [High] to go into Highlight
mode and send the selected channels to the default Highlight setting. This command will self
terminate the command line.

If you just use [High] , the command line will be cleared.

Lowlight Preset
The {Lowlight Preset}, which is set in Setup> User> Manual Control >Lowlight Preset, is used
to define the behavior of specified but not selected channels while using [Next]/[Last] in
highlight mode. When in highlight mode, [channel list] or [Group] [n] [Enter] [Next] will select
the channel list or group and isolate the first channel.

For example, [High] [Enter] [6] [Thru] [1][5] [Enter] [Next] specifies channels 6 through 15 but
channel 6 is the only channel selected. 6 is at the highlight level and 7 through 15 are at their
lowlight levels. Pressing [Next] again will put channel 7 at the highlight level and 6 plus 8
through 15 at their lowlight levels. If there is no lowlight preset, these channels are not affected.



214 Eos Ti, Gio, Gio @5, Ion Xe, Ion Xe 20, and Element 2 Operations Manual

Temporary Highlight Level
The highlight preset can be overridden by setting a temporary highlight level. Using [High] [At]
[5][0] [Enter] overrides the highlight preset and sets the highlight level to 50. Non-intensity
parameters are not affected and will use the default highlight setting or the highlight preset.

The temporary highlight level will remain until [High] is pressed again or the channel is no
longer selected.

Highlight/Lowlight Rem Dim
In addition to the highlight and lowlight presets, there is also a setting for {Highlight Rem Dim}
in Setup. See Manual Control (on page 178). When enabled and highlight mode is active, the
intensity for all non-selected channels are automatically set to the Rem Dim value established in
setup, if that Rem Dim value is lower than the channel’s current intensity. This can be used to
help further isolate the channels you are working with in Highlight Mode

If you do not wish to enable Rem Dim globally in Setup, you can specify a rem dim on the
command line for temporary use. Rem Dim will use the {Live Rem Dim}, as specified in setup.
See Manual Control (on page 178).

• [High_Low] [Rem Dim] [Enter]

To temporarily override the {Highlight Rem Dim} option in Setup, you can use either of the
following syntax examples:

• [channel list] [Highlight] [Rem Dim] [n] [Enter]
• [channel list] [Highlight] [Rem Dim] [/] [n] [Enter]

Sneak
The [Sneak] command (when a destination is not provided) removes manual changes from
selected channels and allows the channels to sneak back to their background states (cue or
submaster instruction, if any).Sneaking channels to their previous state is similar to the
Expression release function, except sneak has the ability to release in time.

If there is no background state from the playbacks, the channel parameters will be set to their
home position. The sneak command follows the sneak timing default established in Setup (see
Manual Control (on page 178)), unless a timing value is provided as part of the sneak command.

The playback status display will show a red counter for sneak time. If multiple sneak times are
being used, the most recently fired sneak time will be displayed. For an example of the sneak
counter, see Indicators in the Playback Status Display (on page 83).

The sneak command can also be used to send a channel parameter to a specific destination,
either with or without timing. The following examples illustrate the various methods of using the
sneak command:

• [channel list] [Sneak] [Enter] - releases manual control, setting parameters to their
background state. If there are current values for those parameters from a playback, those
are the values that will be restored. If there are no values from a playback, the parameters
are set to home (or default) position.

• [channel list] [Color] [Sneak] [Enter] - sneaks color of the selected channels to the default
or background state.

• [5] [At] [5]<0> [Sneak] [8] [Enter] - sneaks channel 5 to 50% in 8 seconds.
• [Sneak] [Enter] - when no channels are selected, restores all channels with manual values

to their background state.
• [Sneak] [Sneak]- puts {AllNPs} [Sneak] on the command line, which sneaks out all non-

intensity parameters. [Sneak] [Sneak] is a self-terminating command.



Manual Control 215

• [Sneak] <Time> [3] [Enter] - restores all channels with manual values to their background
state in 3 seconds.

• [Select Active] [Sneak] [Enter] - selects all channels with intensity above zero and
restores them to their background state, using default sneak times.

• [Group] [5] <Color Palette> [9] [Sneak] [Enter] - selects group 5 and sneaks it to color
palette 9 using default sneak time.

• [Group] [3] [At] <Color Palette> [1] [Sneak] <Time> [7] [Enter] - selects group 3 and
sneaks it to color palette 1 in 7 seconds.

• [Sub] [4] [At] [5] [0] [Sneak] [2] [Enter] - selects submaster 4 and sneaks it to 50% in 2
seconds.

Note: When recalling a reference from the direct selects to use with the sneak
command, the sneak command has to be entered before the reference.

• [Chan][1] [Sneak] {Preset 1}- selects channel 1 and sneaks it to preset 1 using default
sneak time.

• [Chan][2][Sneak]<Time>[2]{Intensity Palette 3}- selects channel 2 and sneaks it to
intensity palette 3 in 2 seconds.

• [Shift] & [Sneak] - makes any manual data unmanual. The values will remain but they
will no longer be available for [Update] or [Record Only] operations. When used with an
empty command line, this will affect any and all manual data. When used with a channel
selection, only those channels will be affected.

Staging Mode
Staging Mode allows you to preview changes temporarily, and then either commit them to Live
or Blind, or revert them.

Using Staging Mode
In either Live or Blind, enter Staging Mode by pressing [Staging Mode] or [Stage]. The
command line will append "Staging Mode." Make the desired changes. Staged data will display
in orange.

If an Augment3d tab is open, staged data will also preview there (for more information, see
Augment3d (on page 433)). The physical [Stage] key LED will illuminate when in Staging Mode.

Committing Staging Mode Changes
Press [Copy To] + [Enter] to commit changes to either Live or Blind. Pressing [Staging Mode] or
[Stage] again will place "Clear Staging Mode" on the command line. Exiting Staging Mode will
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preserve the changes without committing them. Staging Mode changes preserved without
committing them are stored in a buffer for use when Staging Mode is reentered. If the buffer has
content when exiting Staging Mode, the [Stage] key LED will blink.

Note: Staging Mode changes committed to Live will display as manual data (red),
and will still need to be recorded or updated into a cue.

Staging Mode & Highlight
Highlight (see Highlight and Lowlight (on page 213)) can be used in Staging Mode in both Live
and Blind. To enable, simply press [Highlight] while already in Staging Mode. To disable, select
[Highlight] again, or exit Staging Mode.

Select Keys
A number of select functions are available.

Select Last
The [Select Last] key allows you to reselect whatever the previous channel selection was. This
includes multiple channel selections, groups, etc. Using [Select Last] , Eos will recall your last
selection and leave it unterminated for further operation. This will work for a loop of the last five
selections.

Note: On Ion Classic and Element Classic, {Select Last} is a softkey.

Note: If any manual control action is taken immediately after a [Record], [Record
Only], or [Update] command, the previously selected channels will automatically be
reselected.

[Shift] & [At] and [Shift] & [Enter]
• [Shift] & [At] - recalls last channel(s) and parameters without terminating; does a loop of

last five commands.
• [Shift] & [Enter] - reselects the last command and leaves it unterminated; does a loop of

last five commands.

Select All
Pressing [Shift] & [Select Last] will give the additional softkey option, {Select All}. {Select All}
will select all channels.

Select Active
The [Select Active] key is used to select all channels that currently have intensity levels above
zero. Pressing [Select Active] once will capture all active levels. Pressing [Select Active] twice
will capture all active manual levels and those from playbacks except for submasters. Select
NonSub Active will post to the command line.

The following examples illustrate the how to select channels using [Select Active]:

• [Select Active] [Enter] - selects all active channels with intensity levels above zero.
• [Select Active] [Record] [Group] [x] [Enter] - records active channels to the target group.
• [Select Active] [Sneak] [Enter] - selects all channels with intensity above zero and

restores manual control to the background state, using default sneak time, if enabled.
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• [1] [Thru] [1] [0] [0] [Select Active] [Enter] - selects channels between 1 and 100 with
intensity levels above zero.

On a completed command line, using [At] or [Select Last] after [Select Active] or [Select
Manual] will post the numeric channel list to the command line.

For example, cue 1 is active, and has channels 1 through 5 at full. Using the syntax, [Select
Active] [Enter] [At] will post channels 1 through 5 onto the command line.

Another example, Channels 10 through 20 have a manual level of 75. Using [Select Manual]
[Enter] [Select Last] will put channels 10 through 20 onto the command line.

Note: On Ion Classic and Element Classic, {Select Active} is a softkey.

Select Manual
The [Select Manual] key is used to select all channels that currently have manual data. You
may use [Select Manual] combined with the parameter control keys to capture only certain
parameters of a channel with manual data.

The following examples illustrate the various methods to select channels using [Select Manual]:

• [Select Manual] [Enter] - selects all channels with manual data.
• [Select Manual] [Color Palette] [1] [Enter] - selects all channels with manual levels and

sets them to color palette 1.
• [Color] [Select Manual] [Color Palette] [1] [Enter] - selects only channels with manual

color values and sets them to color palette 1.
• [1] [Thru] [1] [0] [0] [Select Manual] [Enter] - selects channels between 1 and 100 with

manual data.
• [Select Manual] [Record] [Group] [n] Enter] - records channels with manual data to the

target group.

Note: On Ion Classic and Element Classic, {Select Manual} is a softkey.

[-] Select Manual or Select Active
[-] [Select Manual] or [-] [Select Active] can be used to modify channel selections. Using [-]
[Select Manual] will select all of the channels in the list except those that have manual data.
Using [-] [Select Active] will select all of the channels in the list except those that are active.

• [1] [Thru] [2] [0] [-] [Select Manual] [Enter] - selects channels 1 through 20 except any
channels that currently have manual data.

• [1] [Thru] [2] [0] [-] [Select Active] [Enter] - selects channels 1 through 20 except any
channels that are currently active.

Channel Check
Channel check allows you to quickly step through all of your patched channels. This is useful for
checking lamps or checking focus.

Note: Parked addresses will not be affected by the channel check feature.

The following examples illustrates how to use the channel check feature:
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• [1] [At] [7] <0> {Chan Check} [Enter] - brings channel 1 to 70% intensity.
• [Next] - channel 1 returns to its background state and channel 2 is set to 70% intensity.
• [Next] - channel 2 returns to its background state and channel 3 is set to 70% intensity.

Use [Next] or [Last] to progress through the channel list to complete the channel check. Any
other key press other than [Next] or [Last] will terminate channel check mode.

Address at Level
The [Address/Patch] key in Live is used to send level information directly to an output address.

• [Address/Patch] [5] [Full] [Enter] - sets output address 5 to full. It will return to its previous
level once the command line changes.

• [Address/Patch] [2] [/] [1] [At] [/] [2][3][0] [Enter] - sets universe 2, address 1 at DMX
value 230.

With [Address/Patch] on the command line, you can use the level wheel to adjust the level.

After using the [Address/Patch] command, [Next] and [Last] may be used to increment the
address number and set it to the same level.

Addresses return to their previous level once the command line is cleared, or [Next]/[Last] is
used to increment to the next address.

Note: This feature is useful when you want to perform an address or dimmer check.

Address Check
Address check allows you to quickly step through all of your patched addresses.

Address check differs from Address at Level (above) because it skips non-intensity parameters of
patched addresses. Since address check follows the current flexichannel state, it can be used
with all channels to identify unpatched channels, or with flexi-patched to only show the intensity
addresses of patched channels.

• [Address/Patch] [1] [At] [Full] {Check} [Enter] - brings address 1 to full intensity.

Use [Next] or [Last] to progress through the address list to complete the address check. Any key
press other than [Next] or [Last] will terminate address check mode.

Flash
Using the {Flash} softkey in Live will bring a channel or address to full, and then every other
second the level will move to 15%. That will hold for 1 second, and then the level will return to
full. The channel or address will keep flashing until either the command line is cleared, or
[Next]/[Last] is used to increment to the next channel or address.

• [1]{Flash} - will bring channel 1 to full, then to 15%.
• [Next] - channel 1 returns to its previous state and the intensity for channel 2 will flash.

• [Address/Patch][1][0]{Flash} - will bring address 10 to full, then to 15%.

Flash On & Flash Off
Pressing [Shift] & [Full] together will put all the selected channels at full and “Flash On” will be
posted to the command line.

Pressing [Shift] & [Out] together will put all the selected channels to out and “Flash Off” will be
posted to the command line.

Releasing the keys will return the channels to their previous state.
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About Groups
Groups are channel selection devices used for fast recall of specific channels. Once recorded,
they are accessible from the keypad, direct selects, and through the displays.

Recording Groups Live
Record groups of channels that you want to have available for fast recall later. Groups can be
stored as whole numbers (such as Group 5) or as decimals of tenths, hundredths, or thousandths
(such as Group 2.5, Group 7.65, Group 3.131). Only whole number groups can be stored using
the direct selects; any decimal designations for groups must be stored using the keypad.

All groups may be labeled. These labels are then displayed on the direct selects as well as in the
group list. Group numbers will not display in either until the groups have been created.

The following syntax examples illustrate the various methods and features available when
recording groups:

• [1] [Thru] [5] [Record] [Group] [7] [Enter] - records only channels 1 through 5 to group 7.
• [4] [Thru] [8] [.] [Record] [Group] [2] [Enter] - records only the cells of the selected

multicell fixtures, channel 4 through 8, to group 2.
• [Record] [Group] [7] [Enter] - records all channels with non-home values to group 7.
• [5] [Thru] [9] [Record] {Group 7} - records channels 5 through 9 to group 7 using the

direct selects.
• [3] [Thru] [8] [Record] [Group] [8] [.] [5] [2] [Enter] - records channels 3 through 8 to

group 8.52.
• [-] [3] [Record] [Group] [7] [Enter] - records all channels, except channel “3,” to group 7.
• [Group] [7] [+] [5] [Record] [Group] [9] [Enter] - records groups 7 and 5 into group 9.
• [Group] [8] [Group] [9] [Record] [Group] [1] [0] [Enter] - records groups 8 and 9 into

group 10.
• [Record] [Group] [7] [Label] [name] [Enter] - records as above and adds a label to the

group.
• [Record Only] [Group] [7] [Enter] - records channels with manual data to group 7.
• [Record Only] {Group 7} - records channels with manual data to group 7 using the direct

select.

Ordered Channels
When recording groups, channels are ordered in the group based on their selection order when
the group is stored. This ordering is useful when combined with [Next] and [Last] functions, and
when applying effects to groups.

Example:
If you record a group by selecting channels in the following order:

• [1] [+] [3] [+] [5] [Thru] [9] [Record] [Group] [1] [Enter]

Later you select Group 1 and press [Next], the channels will be accessed, one
at a time, in the same order in which they were initially selected.

If new channels are added to an ordered group using an update command, those channels are
added to the end of the channel list from an ordering perspective.

When a group is previewed using the Group List, the display defaults to showing the ordered
view. Channels can be reordered as needed from this list. Use the [Format] key to change to a
numeric listing of channels.
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Example:
• [1] [0] [Thru] [2] [Record] [Group] [1] [Enter]

This will record channels 10 through 2 to Group 1, and then if you select the
group you can cycle through the channels using [Next] starting with 10, then 9,
then 8, and so on.

The following softkeys are available:

• {Insert Before} - use to insert a new channel after the specified channel within a group.
• {Insert After} - use to insert a new channel before the specified channel within a group.
• {Reverse} - use to place a group's channels in reverse order.
• {Random} - use to place a group's channels in a random order.
• {Reorder} - use {Reorder} to rearrange the channels to numeric order in a group.
• {Offset} - See Offset (on page 190) for more information.

Subgroups
You can create subsets of channels within a group by using [Shift] & [/] to create parentheses.
The subgroups will display within those parentheses.

These subsets of channels or subgroups are treated as a single channel in the following ways:

• When applying absolute or relative effects from live, the subgroups are treated as a single
channel by the effect.

• When setting a range of step's channels on a step based effect, the subgroup will not be
spread out amongst multiple steps.

• When the group is selected and next/last is pressed, each subgroup is traversed.
• When a group has subgroups, {Reverse}, {Reorder}, and {Random} in the group editor will

affect the subgroups instead of the channels in each subgroup. {Reorder} will order the
groups based on the first channel in each subgroup.

• Subgroups can be created either in the group list or Live.

To create a subgroup in Live:

• [Shift] & [/] [1] [Thru] [4] [Shift] & [/] [Record] [Group] [2] [Enter]

To create a subgroup in the group list index:

• [Group] [2] [Enter] [Shift] & [/] [1] [Thru] [4] [Shift] & [/] [Enter]

Editing and Updating Groups in Live
Existing groups can be updated or re-recorded in Live. If you re-record an existing group, a
confirmation is required (unless disabled in Setup). By re-recording a group, you replace the
contents of the group, you do not add to it. Updating a group does not require a confirmation
and adds channels to the group, rather than replacing them.

Other editing or updating examples are:



222 Eos Ti, Gio, Gio @5, Ion Xe, Ion Xe 20, and Element 2 Operations Manual

• [Group] [x] [Label] [Label] [Enter] - clears the label.
• [Group] [x] [Label] [name] [Enter] - stores a new label.
• [1] [Thru] [5] [Update] [Group] [n] [Enter] - adds channel 1-5 to existing Group n.

For record examples, see Recording Groups Live (on page 220).

Multicell Fixtures in Groups
There are multiple different ways to create groups using multicell fixtures.

Note: The following examples are created in the group list. Groups can also be
recorded in Live. See Recording Groups Live (on page 220)

To create subgroups of the whole multicell fixtures:

• [Group] [3] [1] [Enter] [5] [0] [0] [Thru] [5] [0] [3] [Enter]

To create a group with only the cells of the selected multicell fixtures:

• [Group] [3] [2] [Enter] [5] [0] [0] [Thru] [5] [0] [3] [.] [Enter]

To create a group with only certain cells of multicell fixtures:

• [Group] [3] [3] [Enter] [5] [0] [0] [Thru] [5] [0] [1] [.] [1] [Thru] [2] [Enter]

To create a group with only the master cells:

• [Group] [3] [4][Enter] [5] [0] [0] [Thru] [5] [0] [3] [Shift] & [.] [Enter]

To create subgroups with only specific cells:

• [Group] [3] [5] [Enter] [5] [0] [0] [.] [1] [Shift] & [/] [5] [0] [1] [.] [1] [Enter]

You can also use the {Offset} softkeys to aid in create of groups and subgroups. See Offset (on
page 190) for more information.

Selecting Groups
Groups may be selected from the control keypad or the direct selects.

To select a group:

• [Group] [1] [Enter] - selects all channels in Group 1
• [Group] [1] [At] [5] <0> [Enter] - selects Group 1 and places all channels within at 50%
• {Group 1} - Selects all channels in Group 1

If [Next] is used after a group selection, it accesses the first ordered channel in that group.
Pressing it again accesses the second ordered channel in that group, and so on. [Next] - used
after the last channel in the group - accesses the first channel in the group again.

[Last] may be used with group selects similar to [Next]. Press [Select Last] to reselect the entire
group.
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Deleting Groups
When you delete a group, the group number and all contents from the Group List Index and
Direct Selects are deleted. Delete commands require a confirmation by default. This can be
altered in the default settings. If you disable confirmations, the second enter is not required in
the following examples:

Group deletion features include:

• [Delete] [Group] [5] [Enter] [Enter] - deletes group 5.
• [Delete] [Group] [3] [+] [Group] [5] [Enter] [Enter] - deletes groups 3 and 5.
• [Delete] [Group] [3] [Thru] [9] [Enter] [Enter] - deletes groups 3 through 9.
• [2] [Delete] [Group] [7] [Enter] - deletes channel 2 from group 7.

Opening the Group List
The group list allows viewing and editing of groups.

To open the group list you can:

• Press [Group] [Group]
• Press [Tab] [1] [7]

You can navigate within the group list using [Next] and [Last] or by selecting the group you want
to work with.

Ordered View and Numeric View
By default, grouped channels will be displayed in ordered view. Therefore, grouped channels
will appear in the order they were added to the group (see Ordered Channels (on page 220)). If
you wish to view the channels in numeric view, press the [Format] key and the view will be
switched (channels will appear in numeric order from lowest to highest).

This setting is important in defining [Next]/[Last] functionality within groups in Live / Blind. If left
in numeric format, when using [Next]/[Last] group selection channels will be selected in
chronological order. If left in ordered view, they will be selected based on their order of being
stored to the group.

Editing Groups from the Group List
An existing group can be modified without the need for recording or updating, as follows.

• Select the required group by pressing [Group] [n] [Enter], or using [Next] and [Last] to
navigate through the list.

The selected group is highlighted in gold.

The following actions are possible:

• [Label] [name] [Enter] - adds or modifies a group label.
• [Copy To] [Group] [7] [Enter] - copies the contents of the selected group to group 7.
• [2] {Insert Before} [9] [Enter] - inserts channel 2 into the group, placing it before channel

9 in the ordered view.
• [2] {Insert After} [5] [Enter] - inserts channel 2 into the group, placing it after channel 5 in

the ordered view.
• [2] [Delete] [Enter] - removes channel 2 from, the group.
• [+] <Chan> [1][0] [Enter] - adds channel 10 to the selected group.
• [-] <Chan> [5] [Enter] - removes channel 5 from the selected group.
• [+][Group] [1][0] [Enter] - adds group 10 to the selected group.
• [-] [Group] [5] [Enter] - removes group 5 from the selected group.
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• {Random} [Enter] - rearranges the channels in the group randomly.
• {Reverse} [Enter] - reverses the order of the channels within the group.
• {Reorder} [Enter] - reorders the channels to numeric order in the group selected.
• {Offset} - see Offset (on page 190) for more information.

Groups can be assigned an icon, which can be configured to appear on the direct select button
in Direct Selects (Tab 4) or Custom Direct Selects (Tab 39). See Icons (on page 93) for more
information.

Using Groups as a Channel Collector
[Group] can be used as a quick way to collect channels from submasters, cues, presets, and
palettes.

The following actions are possible:

• [Group] [Cue] [1] - selects all the channels in cue 1.
• [Group] [Sub] [3] - selects all the channels in submaster 3.
• [Group] [Int Palette] [5] - selects all the channels in intensity palette 5.
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About Fan
Fan provides the ability to spread parameter and timing values in a range across a channel
selection set and have those values be evenly spaced. Fan is applied by channel selection or
group order. By default, fan operation is from the start channel.

When [Fan] is pressed after a channel selection, the softkeys will repaint to the following fan
styles:

• {Center} - The middle channel in the order is set as the start and will remain unchanged,
and the first and last channels will change in different directions. The level wheel will
decrease the lower number channels and increase the higher number channels.

• {Reverse} - The selected channel order is reversed before applying the fan.
• {Mirror Out} - The middle channel in the selected order is used as the starting channel and

the first and last channels in the order are the end channels.
• [1] [Thru] [1][0] [At] [1][0] [Thru] [3][0] [Fan] {Mirror Out} [Enter] - sets channel 1 to

30%, 2 to 20%, 3 to 10%, 4 to 20%, and 5 to 30%.

• {Repeat} - The number of channels that are fanned before the pattern is repeated.
• [1] [Thru] [1][2] [At] [5][0] [Thru] [7][0] [Fan] {Repeat} [3] [Enter] - sets channels 1,4,7,

and 10 at 50%, 2,5,8, and 11 at 60%, and 3,6,9, and 12 at 70%.

• {Cluster} - The channels are put into collections, which contains channels with all of the
same value.

• [1] [Thru] [1][2] [At] [5][0] [Thru] [8][0] [Fan] {Cluster} [4] [Enter] - sets channels 1
through 3 at 50%, 4 through 6 at 60%, 7 through 9 at 70%, 10 through 12 at 80%.

• {Random} - The selected channels are put in a random order before fan is applied.

Fanning Parameter Data
Fan values can be adjusted with either an encoder or via the keypad. To adjust the fan values
with an encoder, select the required channels and provide a baseline, if necessary, followed by
[Fan]. On Element 2, you will need to use the virtual encoders in the ML display.

If no value is entered, the current values will be used. When using encoders to adjust fan, it is
not necessary to specify the parameter to be fanned. This is determined by the encoder used.

• [1] [Thru] [5] [Fan] [Enter] - selects the channels 1 through 5 and puts encoders and level
wheel into fan mode.

• [1] [Thru] [5] [At] [5] <0> [Fan] [Enter] - selects the channels 1 through 5, sets a start
level of 50% and puts encoders and level wheel into fan mode.

• [1] [Thru] [5] [Fan] {Mirror} [Enter] - selects the channels 1 through 5 and puts encoders
and level wheel into fan mode with mirror style.

Fan From the Command Line
A level or time command that uses [Thru] or a list of references is a command line fan
command.

Note: The [Fan]key is not necessary unless a fan style other than the default is
needed.

To adjust the fan values from the command line:

• [1] [Thru] [5] [At] [1] <0> [Thru] [5] <0> [Enter] - sets channel 1 to 10%, 2 to 20%, 3 to
30%, 4 to 40%, and 5 to 50%. This is the default fan adjustment and the [Fan] command
is not necessary.
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• [1] [Thru] [5] [At] [1] <0> [Thru] [3] <0> [Fan] {Mirror} [Enter] - sets channel 1 to 30%, 2
to 20%, 3 to 10%, 4 to 20%, and 5 to 30%.

Fanning References
When fanning references, such as palettes, if there are more than 2 reference lists are used then
the data will be referenced data. The fan will be repeated if there are more channels than
references.

• [1] [Thru] [5] [Int Palette] [1] [Thru] [3] [Enter] - sets channel 1 to IP1, 2 to IP2, 3 to IP3, 4
to IP1, and 5 to IP2.

If the list contains 2 or less references, fan will be set to the levels between the references as
absolute data.

• [1] [Thru] [5] [Int Palette] [1] [Thru] [2] [Enter] - (Intensity palette 1 is all channels at 0%
and Intensity palette 2 is all channels set to 100%.) sets channel 1 to 0%, 2 to 25%, 3 to
50%, 4 to 75%, and 5 to 100% as absolute data.

Fanning Timing and Delays
Fanning timing and delays work exactly like fanning parameters.

• [1] [Thru] [5] [Time] [6] [Thru] [1] [0] [Enter] - sets the discrete times for channel 1 to 6
seconds, 2 to 7 seconds, 3 to 8 seconds, 4 to 9 seconds, and 5 to 10 seconds.

• [Cue] [1] [Thru] [5] [Time] [6] [Thru] [1] [0] [Enter] - sets the times for cue 1 to 6
seconds, 2 to 7 seconds, 3 to 8 seconds, 4 to 9 seconds, and 5 to 10 seconds.

• [Cue] [1] [Part] [1] [Thru] [3] [Time] [6] [Thru] [8] [Enter] - sets the times for cue 1's parts
to part 1 to 6 seconds, part 2 to 7 seconds, and part 3 to 8.

• [1] [Thru] [5] [Delay] [6] [Thru] [8] [Fan] {Mirror} [Enter] - sets the discrete delays of
channel 1 to 8 seconds, 2 to 7 seconds, 3 to 6 seconds, 4 to 7 seconds, and 5 to 8 seconds.

Using Subgroups with Fan
Subgroups (on page 221) can be used with the Fan feature. Channels in the same subgroup will
act as a single channel when fanned.

Example:
Group 1 is made up of channels 120 thru 130. Channels 120 thru 123 are one
subgroup, channels 124 thru 126 are not in any subgroup, and channels 127
thru 130 are another subgroup.

• [Group] [1] [Fan] [Enter]

Selects group 1 and puts it into fan mode. Rolling up the level wheel creates the
following result. Channels 120 thru 123 share an intensity, channels 124 thru
126 each have different intensities, and channels 127 thru 130 share an
intensity.
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About Mark
Mark is an instruction that automates the process of presetting automated fixtures to their
required state in a cue, prior to fading intensity up. This allows your automated fixtures to
unobtrusively perform non-intensity parameter transitions in an inactive (darkened) state.

Eos provides two different methods to mark lights:

• AutoMark (below)
• Referenced Marks (on the facing page)

On Element 2, only AutoMark is available.

AutoMark
The AutoMark feature is a system default setting and can be turned on or off at a global level.
The system default for this setting is off. To change the default settings see Cue Settings (on
page 169)

When AutoMark is enabled, non-intensity parameter transitions will occur in the cue
immediately preceding the cue in which the changes are stored, if intensity in that cue is moved
from zero to any active level. Therefore, the preceding cue “executes” the AutoMark.

AutoMark information is displayed for cues or cue parts. It is not a channel instruction.
AutoMarked cues are indicated by an “M” in the M column of the playback status display.

AutoMarks will execute using the time of the cue in which the moves occur (the cue indicated
by “M”). The exceptions to this are the mark time in setup, or if discrete timing is stored with
the move instruction, in which case the discrete time will be used.

AutoMarks will display the same way in Live and in Blind.

Conditions Triggering an AutoMark
The following rules determine which channels AutoMark is applied to and how it is deployed:

• The marked cue must have a move instruction for intensity of automated fixtures above
zero or null.

• The marked cue must have a move instruction for non-intensity parameters of those
channels.

• AutoMark will not occur if the channel is receiving an intensity instruction from another
source (such as a submaster or HTP fader).

• AutoMark must be enabled for an AutoMark to occur. AutoMark is based on the current
setting of the default during playback. It does not matter what the setting is at the point
of record.

• On a “per channel” basis, an AutoMark does not occur until:
• Any parameter delay time has elapsed and
• The intensity has reached zero and the parameter has completed any previous movement.

Allowing a Live Move
When AutoMark is “On” it is possible to override it on a per cue (or cue part) basis. The override
will be available through a softkey, {AutoMark Off}. This softkey is not visible when AutoMark
is disabled in default settings.

AutoMark can be disabled on cues/cue parts.

When enabled, the cue that executes the mark will have an “M” in the flags field. If AutoMark
is disabled, allowing a live move, a “D” is displayed in the flags field of the cue or cue part
where the data is stored.
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By using AutoMark with multipart cues, it is possible to have some parameters mark and others
move live.

AutoMark and Timing
An AutoMark will happen in the time of the cue in which is moving (the “M” cue), unless the
channel has discrete timing or the mark time has been changed in setup. Discrete timing would
override the mark time option in setup. See Mark Time (on page 235) for more information. In
which case, the discrete timing will apply to the moves. Discrete timing is applied in the cue
where the move instruction is stored.

Referenced Marks
Referenced marks are user-specified marks that are manually applied to specific channels or
parameters. When AutoMarks are disabled, referenced marks may be used. AutoMark and
Referenced Marks cannot be used simultaneously.

Note: If you begin programming with AutoMark enabled, and then disable the
feature, all of the AutoMarks in the show are converted to referenced marks.

There are essentially two parts to a successful referenced mark. The first part is the cue with the
mark flag (set by the user). This is the cue in which any non-intensity parameters will change.
This cue is referred to as the marked cue.

The second part is the cue with intensity value for the channels in question. This is referred to as
the source cue. This is also the cue where the non-intensity moves are stored.

In order to use mark properly, you must specify channels to be marked in the source cue. Eos
will not assume all automated fixtures apply to any given mark.

There are two ways to apply a referenced mark. You can apply a mark flag at a cue level and
then subsequently reference that flag in a later cue, or you can apply a mark in a cue and
reference back to an earlier cue.

Referenced marks are useful because the non-intensity parameter data is stored in the cue that
actually fades the lights up. Therefore, any changes to the non-intensity parameter data is
modified in the source cue. You do not need to worry about changing it in the marked cue.

Note: When bringing up the intensity of a fixture that is in a marked state, all the
parameters of that fixture will be made manual and the current NPs settings will
display. This is done so you won’t need to use {Make Manual} when storing to a cue.

Setting Referenced Mark Flags
You can apply a mark flag by pressing:

• [Cue] [n] [Mark] [Enter]

This sets a flag (M) on a cue for later marking activity. In subsequent cues, when channels are
marked, they will preset for movement in this cue (unless told to mark elsewhere).

When you are building a cue containing channels that you want to mark, do the following:

• [select channels] [Mark] [Enter]
• Store the cue, following normal procedures. Eos will automatically look backwards in the

cue list for the first mark flag it encounters.
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Example:
Assume you had placed a mark flag on Cue 10 (this becomes the Marked Cue).

• [Cue] [10] [Mark] [Enter]

Later you store Cue 12 with a mark instruction on channels 1-10 (this becomes
the Source Cue).

• [1] [Thru] [10] [Mark] [Enter] - Note that channels 1-10 are displayed
with a red “M” in the upper right corner.

• [Record] <Cue> [1] [2] [Enter]

Since no specific mark instruction was given to the channels in cue 12, the
channels will mark back to the first “M” encountered in the preceding cues of
the cue list, provided that the intensity for those channels is “out” throughout
the duration of the mark.

When Cue 10 is played back, the non-intensity parameters of channels 1-10
will fade to the values stored in Cue 12. Then in Cue 12, the intensity will fade
up on those channels.

Mark Display Indicators
In the previous example, indications that a mark had been placed are as follows. Cue 10 would
be shown with a mark flag (M) in the cue list. In addition, when cue 10 is played back, channels
1-10 will show a green “MK” in the intensity field, while the non-intensity parameters would
show the source cue number in green “Q12” (the MK in the intensity field is green if, in cue 10,
the lights are fading to zero and then the NPs are marking. If, in cue 10, channels 1-10 were
already at zero, a magenta “MK” will be displayed).

The source cue (cue 12) would include a green “M” next to the intensity level and any non-
intensity parameter values would be displayed in green. Also, in the cue list, cue 12 would have
an “R” in the mark flags field. If a mark has been placed on a cue, but that cue is not yet
marking any lights, the “M” will be represented as “m”. You will also see an “m” if the mark is
no longer in tact.

Priority Mark
When setting mark cues, you assign a priority marking using the softkeys {High Priority} and
{Low Priority} . When marking, channels will attempt to mark to high priority cues first. Cues
that are flagged with just Mark are considered normal priority. Channels will attempt to mark to
them second if a high priority cue can not be used. Low Priority cues will be used last if a high or
normal priority cue could not be used.

Priority marked cues display indiciators in the PSD. See Mark Symbols (on the facing page) for
more information.

Applying Flags as Channels are Marked
You may also apply a mark flag to a previous cue by doing the following:

• [select channels] [Mark] [Cue] [5] [Enter]
• [Record] [Cue] [8] [Enter]

This would mark cue 5 to perform any non-intensity moves stored in cue 8. The display
indicators for this mark would be the same as shown in the previous example. As long as
intensity is at zero within the cue range, if there are any non-intensity move instructions for
these channels between these two cues, they will be removed.

It is also possible to mark only certain parameters for marked moves, while allowing live moves
for other parameters.
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Example:
If you wanted to mark only focus, and allow all other parameters to transition
while the light is fading up, you can press:

• [1] [Thru] [10] [Focus] [Mark] [Enter]

Mark Earliest
The {Earliest} command can be used with [Mark] to mark the channel into the cue after the last
intensity moved from a nonzero level to 0. The mark is stored and behaves exactly as if you had
typed the cue number instead of {Earliest}. This works in blind, or in live if you record
afterwards.

Example:
Cue 2 moves the intensity for channel 1 to 0, Cue 3 thru 4 have no intensity for
channel 1, and Cue 5 has the intensity move to full. From Cue 5:

• [1] [Mark] {Earliest} [Enter]

This will work the same as [1] [Mark] [Cue] [3] [Enter], and will mark from cue
3 to cue 5.

Note: [Mark] {Earliest} will mark through block cues or blocked intensity moves of 0,
until it finds the earliest intensity move to 0. If the cue immediately before the cue
being marked is the earliest intensity move to 0, it will mark in that cue.

{Earliest M} will mark to the earliest cue that already has a mark flag. If a mark cue doesn't
exist, {Earliest M} will behave like {Earliest} and will mark to the earliest possible cue.

Note: {Emergency Mark} can be used to automatically set a mark flag if you had not
previously done so. If using {Earliest M} and no cue with a mark flag has already been
set, {Emergency Mark} will set a mark flag. See Record Defaults (on page 177) for
more information.

Mark Symbols
The symbols that appear in the Mark flag column of the Playback Status Display and the Cue
List Index include:

Live
• MK - Indicates the channel is marked for a later cue. The cue number is indicated in the

other categories (see “Q” below).
• Q - Found in the non-intensity categories of a marked channel. The “Q” is followed by a

number indicating which cue the mark is in preparation for.
• M - Indicates a mark is placed, but manual, and must be stored. Is blue when stored.”m”

indicates cue is not marking.

Playback Status Display
• D - AutoMark is disabled.
• M or m - Indicates a marked cue. “M” indicates an AutoMark or a reference mark that is

used by a subsequent cue. “m” indicates a reference mark that is currently unused by any
subsequent cue. Found in the “Flags” area.

• R - Indicates the source cue which refers back to an earlier mark. Found in the cue display
“Flags” area.
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• + - Indicates a cue is both a marking and reference cue when displayed in the mark flag.
• - - Indicates a dark move, a cue that has any non-intensity parameters moving on channels

whose intensity is at 0.
• x - Indicates that a mark has been placed, but the mark has been broken. If possible, Eos

will AutoMark the lights.
• mh - Indicates that a cue has been flagged as high priority mark, but nothing is marking to

it yet.
• Mh - Cue has been flagged as high priority, and lights are marking to it.
• ml - Indicates that a cue has been flagged as low priority mark, but nothing is marking to

it yet.
• Ml - Cue has been flagged as high priority, and lights are marking to it.

Reference Marks and Timing
Movement of non-intensity parameters in conjunction with a mark will adhere to the following
timing rules.

If discrete timing is used for non-intensity parameters:

When channels execute a mark, the moves will use the discrete time(s) assigned to them in the
source cue.

Example:
A mark is applied to Cue 5, making it the marked cue.

• [Cue] [5] [Mark] [Enter]

Later, channels 1-10 are assigned discrete timing and a mark instruction:
• [1] [Thru] [1] [0] {Focus} [Time] [8] [Mark] [Enter]

Then, those channels are recorded into Cue 10:
• [Record] <Cue> [1] [0] [Enter]

In this instance, when Cue 5 is executed, channels 1-10 will perform their focus
parameter moves in 8 seconds, as specified in Cue 10 (the source cue, which is
the source of their move instruction).

If no discrete timing is used for non-intensity parameters or mark time is disabled:

When channels execute a mark, the moves will use the time recorded in the marked cue.

Example:
Cue 5 is recorded with a time of 10 seconds.

• [Record] <Cue> [5] [Time] [1] [0] [Enter]

A mark is applied to Cue 5 as above.
• [Cue] [5] [Mark] [Enter]

Later, channels 1-10 are assigned a mark instruction and then recorded into
Cue 10 with no discrete timing:

• [1] [Thru] [1] [0] [Mark] [Enter]
• [Record] <Cue> [1] [0] [Enter]

When Cue 5 is executed, channels 1-10 will perform their non-intensity
parameter changes in 10 seconds, as specified in Cue 5 (the marked cue).

Marked cues that are played out of sequence will fade to their marks
immediately. When firing a cue that has a linked cue, the cue will mark like
the linked cue is the next cue.The marks will fade using the active cue’s timing.



Mark 235

Mark Time
Mark time is a setup option (Setup > System > Cue Settings > Mark Time) which allows you to
set the time that mark instructions will use. When {Mark Time} is disabled, which is the default,
mark instructions will use cue timing unless overridden with discrete timing. When you enter a
mark time in setup, all NPs that mark (either through referenced marking or AutoMark) will use
this time. The only way to override setup mark time is to use discrete timing. Clearing the {Mark
Time} field sets it back to disabled. Select {Mark Time} and hit [Enter] to disable the default
mark time.

Removing Referenced Marks
Mark is a toggle state. Therefore, the first mark command sets a mark. The second removes it.

To remove a mark flag from a cue, press:

• [Cue] [n] [Mark] [Enter]

To remove a mark from a channel:

• [select channel] [Mark] [Enter]

Note: If a mark is removed from a channel in live, the corresponding cue must be
updated.

It is also possible to mark to a cue that doesn't exist, and when the mark is stored, Eos will
automatically create the cue to mark to.

Example:
If cue 2 does not exist yet:

• [select channels] [Mark][2] [Enter]

The command line will display, “Create Mark Cue?”
• [Enter]

When the cue is stored, the system will automatically create a cue 2 and mark
the lights to it.

If a light is marked and that mark is later broken (for example being used by a move instruction
stored in the mark range), Eos will attempt to repair the mark. This is done by automatically
marking in the cue previous to intensity fading up, if possible. This will be indicated in the cue
list by a “*” in the cue immediately proceeding the “R” cue.
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About Palettes
Palettes are building blocks that can be used to create presets (About Presets (on page 250)),
cues (About Single Cue List (on page 264)), and effects (About Effects (on page 340)).

Palettes are referenced data. This means that when included in presets, cues, or effects,
changes to the contents of the palette are propagated into all of the places the palette is stored.

Four types of palettes are available:

• Intensity Palettes (below)
• Focus Palettes (below)
• Color Palettes (below)
• Beam Palettes (on the facing page)

Palettes are a critical component when using automated fixtures and can save considerable
programming time when editing show data.

When recording palettes, three softkey options are available:

• {By Type} Palettes (on the facing page)
• {Absolute} Palettes (on the facing page)
• {Locked} Palettes (on the facing page)

Eos supports up to 1,000 palettes of each of the four types, which can be recorded as decimal
(up to three places, 0.001) or whole number (up to 9,999.999). Palettes are automatically
filtered into IFCB categories. Color data cannot be placed in beam palettes, intensity cannot be
included in focus palettes, and so forth. This makes the process of creating palettes easier,
faster and less work. If you need to create a reference that will include a mix of IFCB
information, presets can be used. See About Presets (on page 250).

Palettes can be mapped to faders. see Presets and Palettes Fader Properties (on page 257) for
more information.

Palette Types
There are four types of palettes:

• Intensity Palettes (below)
• Focus Palettes (below)
• Color Palettes (below)
• Beam Palettes (on the facing page)

Intensity Palettes
Intensity palettes can be created for use with all channels that have intensity parameter data.

Focus Palettes
Focus palettes can be created for all channels that have any focus parameter data.

Focus palettes store focus data including Pan and Tilt or XYZ Position. Use {Enable/Disable XYZ
Format} to toggle the format of data stored.

Color Palettes
Color palettes can be created for all channels that have any color parameter data. Color
palettes store any combination of color data, including CMY, RGB, and HS settings, color
scrollers and color wheels.
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You will find that [Record Only], filter settings and selective store commands will be very useful
when storing color palettes.

Beam Palettes
Beam palettes can be created for all channels that have any beam parameter data. It is rare
when storing beam palettes that you will wish to include all of the beam parameters for
channels. Therefore, [Record Only], filters and selective store commands will be very useful
when storing beam palettes.

Palette Options
When recording palettes, there are three softkey options:

• {By Type} Palettes (below)
• {Absolute} Palettes (below)
• {Locked} Palettes (below)

{By Type} Palettes
By Type palettes are created with 'default' channels which contain values that can be assigned
to any other channel within the same fixture type. By Type palettes can also contain discrete
channel values.

By Type palettes will display a ‘T’ in the lower corner of the direct selects and in the palette lists.
A ‘+’ will display after the ‘T’ if there are channels stored with discrete data. For more
information on by type palettes, see Using By Type Palettes (on page 247) .

{Absolute} Palettes
Absolute palettes are palettes that when recalled the data is displayed and treated like absolute
data applied to a channel. The data is never referenced.

An absolute palette will display with an ‘A’ in the lower corner of the direct selects and in the
palette lists.

{Locked} Palettes
Locked palettes are palettes that are protected from being accidentally changed in Live.

A locked palette will display a “L” in the lower corner of the direct selects and in the palette
lists.

Locked palettes can be updated by specifically calling the channels and the record target,
[channel list] [Update] [Record target] [Enter]. Using [Update] [Color Palette] [1] [Enter] would
not work in Live for a locked palette. However locked palettes are not protected in Blind.

Storing Palettes Live
Palettes may be stored in live or blind. There are a variety of methods for determining what data
is stored into a palette but [Record], [Record Only] and using filters are the most common ways.

When [Record] is used, Eos will store the relevant parameter category data (intensity, focus,
color or beam) for all channels that are not currently at their default value.

[Record Only] is a type of selective store that can be used to store only the relevant parameters
that have manual data. Filters and selective storing provide additional methods to control what
is stored into a palette.

On Element Classic, double pressing [Record] will post Record Only to the command line.
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Storing Palettes with [Record]
The most common method to create palettes is to store them from Live. Palettes can be
numbered from 0.001 through 9999.999, and each can be given a label. [Record] will store the
relevant current parameter data for all channels with non-default data for the appropriate
palette type, as modified by the filter settings.

Example:
Assume you want to create a custom color using the color picker and store that
data to a custom color palette. First you must select channels.

• [1] [Thru] [1] [1] [Enter]

Using the color picker, adjust the hue and saturation levels to the desired look.
When the color is selected, store the palette.

• [Record] [Color Palette] [4] [Label] <FOH Blue> [Enter]

Notice that when you recorded the color palette, all of the color data for
channels 1 through 11 is displayed in live with the reference “CP 4”. Because
[Record] was used, it stored all of the color parameters for those channels.

Note: [Record] will store the entire parameter category into a palette. [Record Only]
stores just the values you have adjusted manually to the target palette. See Storing
Palettes with [Record Only] (on the facing page).

When a palette is created, the channels and the parameters involved in the record action are
automatically set to the palette reference (“CP 4” in this instance). To view the absolute data
for those channels, press and hold the [Data] key.

The following methods can be used to store palettes using [Record]:

• [Record] {Color Palette 1} - records all color parameter data to color palette 1 and shows
it as the first color palette direct select. See Storing Palettes to Direct Selects (on the
facing page) for more information.

• [Record] [Focus Palette] [2] [Label] <name> [Enter] - records focus parameter data for all
channels not at their default state and adds a label to focus palette 2.

• [Record] {Color Palette} [Next] [Enter] - records data to the next sequential color palette
number.

Selective Storing Palettes with [Record]
Palettes can also be created using selective storing, which allows you to specify only the
channels and or parameters that you want to store.

The following examples illustrate various methods of selectively storing palettes using [Record]:

• [1] [Thru] [3] [Record] [Intensity Palette] [2] [Label] <name> [Enter] - records the
intensity data for selected channels 1 through 3 and adds a label to intensity palette 2.

• [Group] [2] [Record] {Beam Palette} [Next] [Enter] - records the beam parameter data for
Group 2 to the next sequential beam palette number.

• [-] [9] [Record] [Focus Palette] [5] [Enter] - stores the focus data to focus palette 5,
excluding the group or channels specified.

• [1] [Thru] [9] {Iris} {Zoom} [Record] [Beam Palette] [5] [Enter] - stores all zoom and iris
data for channels 1 through 9 to beam palette 5.

• [-] [5] [Record] [Beam Palette] [Next] [Label] <name> [Enter] - stores to the next
sequential beam palette, withholding the group or channels specified and adds a label.
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Note: When using a selective store, you must specify the channel list to be included
or excluded, identified by the [+] [-] modifier, as part of the [Record] command.
Otherwise all channels with appropriate non-default data will be stored in the new
palette.

Note: Selective storing is useful when you are doing a “one-time” selective store
action. If you are recording a series of palettes with only specific parameters, it will
save you time to set a record filter (see Using Filters with Palettes (on the next page)).

Storing Palettes with [Record Only]
[Record Only] is a selective record process that stores only manual parameter data. When used
to record palettes, only the manual parameter data for channels will be stored in the palette. As
with record, filters can further restrict stored data if they are enabled when using [Record Only].
See Storing Palettes Live (on page 239) for more information.

On Element Classic, double pressing [Record] will post Record Only to the command line.

Note: If you use [Record Only] to record to an existing palette, the data will be added
to that palette. The original palette will not be completely overwritten. Only manual
changes will be stored to the palette.

Note: It is possible to [Update] to add specific changes to the record target. See
Update (on page 244) for more information.

The following methods can be used to selectively store manual parameter data to palettes using
[Record Only]:

• [Record Only] [Color Palette] [2] [Enter]- records only the manual color parameter data
to color palette 2.

• [Record Only] [Beam Palette] [5] [Label] <name> [Enter] - records manual beam
parameter data for all channels and adds a label to beam palette 5.

• [-] [9] [Record Only] [Color Palette] [Next] [Label] <name> [Enter] - stores manual data
to the next sequential color palette, withholding the group or channels specified and adds
a label.

• [select channels] [Record Only] [Focus Palette] [2] [Enter] - stores focus palette 2, but
only includes the manual data for the specified channels and parameters.

• [1] [Thru] [9] {Iris} {Zoom} [Record Only] [Beam Palette] [5] - stores only manual zoom
and iris data for channels 1 through 9 to beam palette 5.

Storing Palettes to Direct Selects
You can store palettes efficiently using the direct selects. Rather than using the [...Palette] hard
key and the numeric keypad to specify a palette number, you can simply touch the desired
direct select for that palette from the touchscreen.

Example:
If you want to store color data to color palette 4, press:

• [Record]
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and then press the button in the bank of color palette direct selects that is
labeled in the lower right corner with a light gray “4”.

• {Color Palette Direct Select Button 4}

“Color Palette 4” will appear in the direct select, indicating a successful store.

For more information on direct select mapping, see Direct Selects (on page 86).

Using Filters with Palettes
Filters can be used to modify what data is stored to a palette by a record action. The parameters
that are active or filtered allow those parameters to be stored to record targets.

To filter a parameter:

1. Press the {Filter} button in the CIA. The {Filter} button will flash.
2. Press the touchbutton for the parameter you wish to store.
3. Press the {Filter} button to release. “Filter On” appears next to the parameter category

button.

To determine which parameter is filtered in the category:

1. Press the {Filter} button. All actively filtered parameters are highlighted in gray. You may
need to press the arrow softkey for that parameter category to page additional parameters
in the category.

Filters are a toggle state. To remove filters, press {Filter} and then press the highlighted
parameter buttons in the CIA to deactivate the filters, or use {Clear Filters}.

For more information on filters, see About Filters (on page 298).

Recalling Palettes
Palettes may be recalled from the control keypad or from direct selects.

When palettes are recalled, all data is manual and will display in red. Recalled palettes are
applied only to selected channels, therefore you must select channels before recalling a palette.
If a selected channel or parameter has no stored value in the recalled palette, it remains in its
current state. Palettes on direct selects will be highlighted if they are applicable for the current
channel selection.

You can select all the channels included in a palette by pressing [Group] [Palette] [x] [Enter].
You can also recall an entire palette by pressing [Recall From] [Palette] [x] [Enter].

Note: If enabled in Setup, you can double click on a palette direct select button to
quickly recall from the selected palette and put its content on stage. See Displays (on
page 182) for additional information.

Recalled palettes will appear as manual data for the specified channels. That data will appear as
abbreviations of the palette type (IP3 = Intensity Palette 3, FP8 = Focus Palette 8, and so on), or
as the palette label if defined/enabled in the displays settings in Setup (see Show Reference
Labels (on page 182)). To see the numeric values behind any palette (or other referenced
value), press and hold the [Data] key. To see the palette number behind the label, press
[About] + [Label].

When palettes are recalled, channels with stored data in the palette will follow that data
according to manual time settings. A manual time master fader can also affect the timing. See
Manual Time Master (on page 105) for more information.
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Palettes may also be recalled using a time specified using [Sneak] [Time]. For examples on
using [Sneak] [Time], see Sneak (on page 214)

You may also use groups to recall palettes. For example:

• [Group] [1] [1] [Beam Palette] [5] [Enter]
• [Group] [5] {Color Palette 6}

Palettes may also be recalled from the direct selects which automatically terminates the
command line. To recall only specific parameters of a palette, select channels and the required
parameters (or those not required, using the [-] key) in the command line.

The following are methods that can be used to recall palettes.

• [selected channels] {direct select} - recalls the associated (IFCB) palette data for the
selected channels.

• [selected channels] [Palette] [n] [Enter] - recalls the associated IFCB palette for selected
channels.

• [Channel List] {edge} [Beam Palette] [n] [Enter] - recalls only the edge data from the
specified beam palette for the selected channels.

• [Group] [n] [Palette] [z] [Enter] - recalls all of the data in the palette and applies it to the
selected group.

• [Intensity Palette] [y] [At] [z] [Enter] - recalls the intensity palette for selected channels
and sets all recalled intensity values to a proportioned level of their recorded states.

Note: The above example breaks the referenced link to the intensity palette. To
maintain the link, the palette must be recalled without a modified intensity value.
Calling back the intensity palette at full will also break this link.

When recalling palettes, only channels that are selected at the point of recall will be affected by
the palette recall. The data recalled from a palette is referenced. To break the reference you
may use {Make Absolute}.

• [Channel List]{Edge} {Beam Palette} [n] {Make Abs} [Enter] - recalls only the edge data
from the specified beam palette for the selected channels and makes that absolute data.

Palettes On Faders
Palettes can be mapped to faders. See Presets and Palettes Fader Properties (on page 257) for
more information.

Presets and palettes can be used to create a temporary list of content that can be played back
on a fader. See Temporary Fader Mapping (on page 261) for more information.

Editing Palettes Live
If a palette is already recorded, [Record] replaces all existing data, unless channels have been
excluded. [Record Only] is a selective store, therefore it adds data. Recording over a previously
existing palette requires a confirmation, if confirmations are enabled in Setup. See Record
Defaults (on page 177) It is also possible to [Update] to add manual changes to the record
target.

Rerecord
Rerecording follows the conventions illustrated in the [Record] and [Record Only] sections
detailed earlier in this chapter. The only exception is that a confirmation is required to record
over an existing palette.

There are two different methods for rerecording:
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• [Record] [Palette] [5] [Enter] [Enter] - overwrites the content completely.
• [Channel List] [Record] [Palette] [5] [Enter] [Enter]- merges the data.

Update
Live changes can be updated to both active and inactive palettes. When updating a parameter
in an active palette, that parameter will no longer be absolute data, but will now be in the
updated palette on stage.

The following illustrates how to update color palette 2 when no cues are active and you have
recalled channels within that palette.

• <channel list> [Update] [Color Palette] [2] [Enter] - any manual changes for channels
originally in the palette are updated in color palette 2.

• [1] [Update] [Color Palette] [2] [Enter] - adds channel 1’s manual data to color palette 2.
• [-] [3] [Update] {Color Palette 2} - withholds manual changes for channel 3 from the

update to Color Palette 2 using the direct selects.

If a channel or parameter does not have data in the palette being updated, it will not be added
to that palette unless the user specifically requests it, by specifying the channel.

Editing Palettes in Blind
All palettes can be viewed and edited in Blind. To open a palette in Blind, you can do any of the
following:

• [Blind] [Palette] [Enter] - pressing this will display the first recorded palette of the
selected type (Intensity, Focus, Color or Beam) in Blind or return to the last palette of this
type viewed in blind.

• [Blind] {Palette Select 3} or [Blind] [Palette] [3] [Enter] - pressing this will display the
specified palette in Blind.

• [Palette] [Palette] {Edit} - opens the list view of the palette type and then opens Blind
palette. You can also use the tab number to open the list view. See Editing Palettes in List
View (on page 246) for a list of tab numbers.

CAUTION: When editing palettes in Blind, changes to palettes are
automatic, therefore no update or record command is required.

Palettes can be viewed and edited in blind in the table and spreadsheet views. In Blind, the
following softkeys are available when editing palettes:

• By Type
• Absolute
• Lock
• Cleanup
• Discrete
• Offset
• Make Null
• Make Absolute
• Replace With
• Query

Entering Blind Palette from Live
• [Blind] [Palette] [Enter] - pressing this will display the first recorded palette of the

selected type (Intensity, Focus, Color or Beam) in blind or return to the last palette of this
type viewed in blind.
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• [Blind] {Palette Select 3} or [Blind] [Palette] [3] [Enter] - pressing this will display the
specified palette in blind.

• [Palette] [Palette] {Edit} - opens the list view of the palette type and then opens blind
palette.

Viewing Palettes From Blind
While in any blind mode, when no channels are selected, you can enter a palette from the
command line or direct selects. This will take you into blind channel mode for that palette.

• [Color Palette] [n] [Enter]

You may also step through the available palettes using [Next] and [Last].

Editing in Blind
The following are representative methods used for editing palettes in Blind:

• [2] {Iris} [At] [Enter] - removes the current parameter value from channel 2.
• [1] {Iris} [5] [0] [Enter] - selects channel 1 and sets iris value to 50.
• [2] [Copy To] [5] [Enter] - copies the information from channel 2 to channel 5.
• [6] [Recall From] [Focus Palette] [1] [Enter] - recalls the values for channel 6 from Focus

Palette 1 but not the reference.

You may use the encoders to set Blind levels as well.

When editing in Blind, it is possible to remove an instruction from any palette by selecting the
channel and parameter and pressing [At] [Enter] or {Make Null} [Enter].

[Recall From], [Copy To], Move To (accessed by pressing [Copy To] [Copy To]), and {Replace
With} may be used to create and edit palette data. See About Advanced Manual Control (on
page 308).

Note: While editing palettes in blind, hitting [Recall From] [Recall From] will put
[Recall From] [Palette] on the command line.

Palettes can be assigned an icon, which can be configured to appear on the direct select button
in Direct Selects (Tab 4) or Custom Direct Selects (Tab 39). See Icons (on page 93) for more
information.

Editing Palettes in Spreadsheet View
Blind Spreadsheet view shows a range of palettes along the Y axis and channels/channel
parameters along the X axis. Viewing palettes in spreadsheet view is useful when you want to
compare data between palettes. While in blind, press [Format] to access the spreadsheet. See
Spreadsheet (Blind Only) (on page 74) for more information.

After selecting a palette, you may use the [Next] or [Last] keys to move through the list or you
may select the exact palette from the keypad. You may also select a range of palettes to edit at
once. You can make changes to the palette(s) by selecting channels and altering parameter
values. In addition to normal editing functions, you may also use the following commands in this
view: [Copy To], {Make Absolute}, {Make Null}, Move To(accessed by pressing [Copy To]
[Copy To]), and {Replace With}.

The following are representative methods used for editing palettes in blind spreadsheet:

• [Color Palette] [1] [Thru] [9] [Enter] - selects color palettes 1 through 9.
• [1] {Scroller} {Make Null} [Enter] - sets channel 1 scroller value null in the selected color

palette(s).
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• [1] {Scroller} [4] [Enter] - sets channel 1 scroller value to frame 4 in the selected color
palette(s).

Here are some examples of the additional palette editing features available in spreadsheet
view:

• [palette type] [1] [Thru] [5] {Move To} <palette type> [9] [Enter] - this will move palettes
1 through 5 to palettes 9 through 14 respectively. You do not have to supply the end value
for the console to perform the move.

• [Beam Palette] [1] [Thru] [5] [Enter] {Iris} [5] [0] {Replace With} [2] [5] [Enter] - for
palettes 1 through 5, this command will replace any iris parameter values of 50 with
values of 25.

Editing Palettes in List View
When you press the specific Intensity, Focus, Color or Beam palette button twice, a list view for
the associated palette type is opened in a new tab (or brings the list view into focus if already
open). You can also open the list views from the home screen. See Workspace Layout Menu (on
page 65) for more information.

You can also open the list views by using their tab numbers. Press and hold [Tab] and type the
number to open.

• Intensity Palette - [Tab] [2] [2]
• Focus Palette - [Tab] [2] [3]
• Color Palette - [Tab] [2] [4]
• Beam Palette - [Tab] [2] [5]

Indicators for absolute (A), locked (L), and by type (T+) display to the right of the palette
number.

Note: In the by type channels column, any channel number with an asterisk indicates
that the channel does not have any by type data stored to it.

From the list view, you can select a palette for editing, which changes focus to blind channel
view, with the specified palette ready for editing. In addition, you can add palettes to your list
and edit the labels for each palette in the list.

Example:
In the list view, you can select palettes and relabel or move them.

• [1] [5] [Label] <name> [Enter]

While in the specific palette category list view, the {Edit} softkey is available for use. The {Edit}
softkey opens a blind channel view of the selected palette and changes focus from the palette
list. You can change the blind display to spreadsheet or table view by pressing the [Format] key.

To copy a specific palette to a new palette:

You can copy palettes within the list to another location in the list using [Copy To].

• <Color Palette> [2] [Copy To] [9] [Enter] [Enter] - copies the contents of color palette 2
to color palette 9. Color palette 2 will remain in the list. The second [Enter] is not required
if you have disabled confirmations in setup.

You can also use [Copy To] from presets to palettes.

To move a specific palette to a different location:
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• [1] {Move To} [3] [Enter] - moves the contents and label of the specific palette 1 to
palette 3. If palette 3 is already used, you will be asked to confirm that you want to
overwrite the existing recorded palette. You can hit [Copy To] [Copy To] to access {Move
To}.

You can also move data from a preset to a palette and vice versa. It is important to remember
that when using the {Move To} command that data is removed from its current location and
moved to its new location.

To edit any palette data from the List View:

• [1] [5] {Edit} [Enter] - selects palette number 15 and brings the blind display into focus,
with palette 15 selected for editing. You can use the [Next] and [Last] buttons to access
the other palettes, or select a new palette for editing from the keypad.

Using By Type Palettes

Storing a By Type Palette
If {By Type} is used when recording, the lowest number channel of each fixture type will be the
default channel. Generally, when storing by type palettes, you will want only one channel of
each fixture type in use. Any additional channels in that fixture type will be recorded with
discrete data.

• [1] [Thru] [5] [Record] [Int Palette] [1] {By Type} [Enter] - Channels 1 through 5 are saved
to Intensity Palette 1. Channels 1 through 5 are of the same fixture type. Channel 1 will be
the default channel and channels 2 through 5 will be saved with discrete data.

• [1] [Thru] [5] [Record] {Intensity Palette 1} [Enter] - If a by type palette is recorded
without using the {By Type} softkey and the default channel is included in the record, the
default channel’s level will change and all other changes will be discrete.

• [1] [Thru] [5] [Record] {Intensity Palette 1} {Discrete} [Enter] - If a default channel is
included in a record where {Discrete} is used and another channel is tracking it, the
default channel will be changed to having discrete data and the lowest numbered tracking
channel will become the new default channel. All other channels in the record will also
have discrete data.

Editing By Type Palettes in Blind
In Blind, the default channel’s levels will display in blue, discrete data for the other channels will
display in white, and any channels that are using the default channel value will display in
magenta.

• [3] {By Type} [Enter] - makes channel 3 the new default channel for that device type. If
another channel for that type was the default channel, its data will now be discrete.

• [1] [0] [Thru] [2] [0] {Discrete} [Enter] - changes the levels for channels 10 through 20 to
discrete. If any of those channels are default, the lowest numbered tracking channel will
become the new default channel.

• [5] [Thru] [8] [At] [Enter] - removes the discrete data for channels 5 through 8. They will
now use the default channel’s values.

• [Color Palette] [2] {Discrete} [Enter] - changes all tracking and default channels to
discrete.

• [Intensity Palette] [5] {By Type} [Enter] - makes the first channel of each device type a
default channel.

• [Beam Palette] [3] {Cleanup} [Enter] - converts palettes created in earlier versions of Eos
Family software to by type palettes. If by type channels exist in this palette, {Cleanup} will
convert any discrete levels that match their by type channel's level to tracks.
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{Make Null} can be used with by type palette when you wish to withhold a channel from
responding to a by type palette recall. The data will still display but will be in gray with a “N”.
See Using {Make Null} (on page 311).

Updating By Type Palettes
Pressing {By Type} after an [Update] command, with a channel tracking but no default channel
included in the update, will cause the lowest numbered tracking channel's level to be updated
into the default channel. The tracking channel will remain tracking. This means that when
updating a default value in a by type palette, you don’t need to know the default channel
number.

When a default channel is included in an [Update] command without using {By Type} and
another channel is tracking it, the default channel’s data will be changed to discrete. The lowest
numbered tracking channel will then become the new default channel. Any other updated
channels will be made discrete.

Removing Channels from a Palette
You can remove specific channels from a palette. This can be done from blind.

Example:
Open the palette in blind:

• [Blind] [Color Palette] [Enter]

Select the palette you wish to edit:
• [Color Palette] [5] [Enter]

Remove channels by pressing:
• [2] [+] [4] [+] [6] [Thru] [9] [At] [Enter]

You may also remove a channel or parameter from a range of presets by
pressing:

• [Beam Palette] [1] [Thru] [5] [Enter] [6] [At] [Enter]

You can remove channels from live by pressing:
• [channel list] [Delete] [Color Palette] [2] [Enter]

Deleting Palettes
To delete color palette 1, press [Delete] [Color Palette] [1] [Enter] [Enter]. When palettes are
deleted, any references in cues will be converted to absolute data.



Presets 249

Chapter 11
Presets

About Presets 250

Preset Options 250

Storing Presets Live 250

Recalling Presets 252

Effects in Presets 252

Editing Presets Live 253

Using the Preset List 253

Editing Presets in Blind 254

Using By Type Presets 256

Removing Channels from a Preset 257

Deleting Presets 257

Presets and Palettes Fader Properties 257



250 Eos Ti, Gio, Gio @5, Ion Xe, Ion Xe 20, and Element 2 Operations Manual

About Presets
Presets are very similar to palettes in that they are collections of data for specific channels to
facilitate cue creation. Presets, however, can collect all data for a given channel (intensity,
focus, color, beam) rather than just one parameter category.

Eos supports up to 1,000 presets, which can be recorded as decimal (up to three places, 0.001)
or whole number (up to 9,999.999). They can contain absolute data and/ or a mix of IFCB
palettes. Presets can not refer to other presets.

Presets can be mapped to faders. see Presets and Palettes Fader Properties (on page 257) for
more information.

Preset Options
When recording presets, there are three softkey options:

• {By Type} Presets (below)
• {Absolute} Presets (below)
• {Locked} Presets (below)

{By Type} Presets
By Type presets are created with 'default' channels which contain values that can be assigned to
any other channel within the same fixture type. By Type presets can also contain discrete
channel values.

By Type presets will display a ‘T’ in the lower corner of the direct selects and in the presets list. A
‘+’ will display after the ‘T’ if there are channels stored with discrete data.

{Absolute} Presets
Absolute presets are presets that when recalled the data is displayed and treated like absolute
data applied to a channel. The data is never referenced. An absolute preset will display with an
‘A’ in the lower corner of the direct selects and in the presets list.

{Locked} Presets
Locked presets are presets that are protected from being accidentally changed in Live.

A locked preset will display a “L” in the lower corner of the direct selects and in the presets list.

Locked presets can be updated by specifically calling the channels and the record target,
[channel list] [Update] [record target] [Enter]. Using [Update] [Preset] [1] [Enter] would not
work in Live for a locked preset. However locked presets are not protected in Blind.

Storing Presets Live
Presets can be recorded live using the keypad and/ or the direct selects. Both [Record] and
[Record Only] can be used to record presets, with or without filters. See Storing Data with
Record Filters (on page 299) for more information.

[Record] will store all channels that are not at their home values, and it will record all
information about those channels, including parameters that are still at default. Therefore
presets can contain all of the same information as a cue, but they have no timing information or
cue attributes (such as follow, delay, or cue overrides). When recorded or re-recorded, presets
are automatically recalled on stage. Presets may be individually labeled.
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Storing Presets Using [Record]
The [Record] key will store all parameter data for channels with one or more parameters not at
their home values, as modified by the filter settings in the CIA. If filters are used, only the
parameters enabled by the filters are stored.

When you record data to a preset live, the channels involved in that preset will then actually be
in that preset.

The following methods can be used to store presets using [Record]:

• [Record] [Preset] [5] [Label] [name] [Enter] - records all parameter data for all channels
not at default and adds a label to preset 5.

• [Record] [Preset] [Next] [Enter] - records data to the next sequential preset number.
• [-] [2] [Record] [Preset] [n] [Enter] - stores the preset, withholding the group or channels

specified.
• [channel list] [Record] [Preset] [6] [Enter] - stores the preset, but only the data for the

channel list supplied.
• [Record] {Preset 1}- records the preset and shows it as the first preset direct select.
• [channel list] {AllNPs} [Record] [Preset] [8] [Enter] - records all non-intensity parameters

for the selected channels to the preset.

Note: When using selective record, the user must specify the channel list to be
included (or excluded as the case may be) as part of the [Record] command.
Otherwise, all parameters of channels with non-home values will be stored in the
preset.

Note: You may also use the filters and {Make Null} as additional tools to decide what
data will be stored. For more information on these features see Using {Make Null} (on
page 311) and About Filters (on page 298) .

When you re-record an existing Preset, a confirmation will be required, unless confirmations
have been disabled in Setup.

Storing Presets Using [Record Only]
[Record Only] is a selective record process that stores only manual parameter data. Therefore,
when used to record presets, only manual data for channels will be stored in the preset. As with
[Record], filters and {Make Null} can be used to further modify what information is stored. See
Storing Data with Record Filters (on page 299).

On Element Classic, double pressing [Record] will post Record Only to the command line.

The following methods can be used to store presets using [Record Only]:

• [Record Only] [Preset] [5] [Label] [name] [Enter] - records manual parameter data for all
channels and adds a label to preset 5.

• [Record Only] [Preset] [Next] [Enter] - records manual data to the next sequential preset
number.

• [-] [3] [Record Only] [Preset] [n] [Enter] - stores the preset, withholding the group or
channels specified.

• [Channel list] [Record Only] [Preset] [6] [Enter] - stores the preset, but only the manual
data for the channel list supplied.

• [Channel list] {Color} [Record Only] [Preset] [7] [Enter] - stores only manual color data for
the specified channels to the preset.
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Recalling Presets
Channels must be selected when recalling a preset. If a selected channel or parameter has no
value in the preset, it will stay in its current position. If you want to recall all channels in a
preset, you can press [Recall From] [Preset] [x]. Presets on direct selects will be highlighted if
they are applicable for the current channel selection.

Note: If enabled in Setup, you can double click on a preset direct select button to
quickly recall from the selected preset and put its content on stage. See Displays (on
page 182) for additional information.

If you only want to recall certain parameters of the preset, select channels and enter the
required parameters (or those not required, using the [-] key) in the command line (see
command examples below).

When a preset is recalled, parameter changes will follow the manual timing defaults, if
enabled. A manual time master fader can also affect the timing. See Manual Time Master (on
page 105) for more information.

Presets may also be recalled using a time specified using [Sneak] [Time]. For examples on using
[Sneak] [Time], see Sneak (on page 214)

You may recall presets using any of the following methods:

• {Preset direct select} - recalls the associated preset data for selected channels.
• [Preset] [2] [Enter] - recalls preset 2 for selected channels.
• [Channel List] [Preset] [2] [Enter] - recalls the preset data for the channels in the selection

list.
• [Channel List] [Preset] [Enter] - recalls the last selected preset's data for the channels in

the selection list.
• [Channel List] {Color} [Preset] [5] [Enter] - recalls only the color data from the specified

preset for the specified channels.
• {Color} {Preset direct select} - recalls just the color data from the specified preset for

selected channels.
• [Recall From] [Preset] [3] [At] [5] <0> [Enter] - recalls all channels in preset 3, and sets

all intensity values at 50%. The original intensity data is still linked to the preset. If the
intensity change is desired, you must update the preset to maintain the change and the
link. Storing the data to another record target would break the link and make the data
absolute.

• [Channel List] [Preset] [7] [Enter] [At] [5] <0> [Enter] - recalls preset 7 for selected
channels. Intensity values will be recalled at 50% of their recorded state. The intensity
link is maintained. If the intensity change is desired the user either needs to update the
preset to maintain the change and the link. Storing the data to another record target
would break the link and make the data absolute.

• [Recall From] [Preset] [9] [Enter] - selects all channels with data stored in preset 9, and
sets those channels to the values in preset 9.

• [1] [Recall From] [Preset] [1] [At] [5] <0> [Enter] - recalls the intensity of channel 1 from
preset 1 at 50% of the stored value. If channel 1 was set to 50 in preset 1, it’s recalled
value would be 25.

Effects in Presets
Effects can be stored in a preset, and those presets can be used to create submasters and cues.
However, the effect's data is only copied to the submaster or cue, it is no longer referenced
through the preset.
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Note: If used with submasters and cues, the data is not referenced. So if changes are
made to the effect in the preset, the effect saved to the submasters and cues will
remain unchanged.

The preset list display has a column for effects.

For more information, see Recording an Effect to a Preset (on page 359).

Editing Presets Live
There are two ways to edit a preset in Live. You may rerecord the preset or you may use
[Update].

Rerecording Presets
Rerecording follows the conventions of [Record] and [Record Only]. The only exception is that a
confirmation is required to actually rerecord the preset.

Two different mode for rerecording:

• [Record] [Preset] [5] [Enter] [Enter] - overwrites the content completely.
• [Channel List] [Record] [Preset] [5] [Enter] [Enter] - merges the data.

Updating Presets
[Update] is used to record parameter modifications back to a preset. When updating, you must
specify the preset to be updated. You may do this using the keypad or the direct selects.

For the purposes of the following descriptions, assume that there are no active cues on stage.
Updating referenced values while cues are active is covered in Modifying Cues Live (on
page 279).

Example:
To update a preset, first recall the preset for any channels you wish to edit.

• [1] [Thru] [5] [Preset] [1] [Enter]

-or-
• [Recall From] [Preset] [1] [Enter]

Make required changes to the desired parameters using the keypad or
encoders. Once you have achieve the desired look, update the preset.

• [Update] [Preset] [1] [Enter]

-or-
• [Update] {Preset 1}

When updating a preset, only channels that are already in the preset will be updated. You need
to select channels or parameters to force new data into a preset when using [Update].

Using the Preset List
The preset list displays all recorded presets. The Preset List only allows you to change attributes;
no editing can be done directly in list view.

Opening the Preset List
Press [Preset] twice to open the list view. You can also open the list view from the home screen
or by using [Tab] + [2][6]. See Workspace Layout Menu (on page 65) for more information.
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Pressing the {Edit} softkey takes you to the blind view of the selected preset, in the last format
you used in blind. This will allow you to edit the preset. You can change the blind display to
spreadsheet or table view by pressing the [Format] key.

You can navigate the preset list using [Next] and [Last].

Indicators for absolute (A), locked (L), and by type (T+) display to the right of the preset number.

Note: In the by type channels column, any channel number with an asterisk indicates
that the channel does not have any by type data stored to it.

Copy To
You can copy presets within the list to another location in the list using [Copy To].

• <Preset> [2] [Copy To] [9] [Enter] [Enter] - copies the contents of preset 2 to preset 9.
Preset 2 will remain in the list. The second [Enter] is not required if you have disabled
confirmations in setup.

You can also use [Copy To] from palettes to presets.

Move To
You can move presets within the preset list using Move To, which is accessed by pressing the
[Copy To] button twice.

• <Preset> [3] [Copy To] [Copy To] [8] [Enter] [Enter] - moves preset 3 to preset 8. Preset
3 will be removed from the list. The second [Enter] is not required if you have disabled
confirmations in setup.

• <Preset> [1] [Thru] [5] [Copy To] [Copy To] [6] [Enter] [Enter] - moves presets 1 through
5 to presets 6 through 10.

You can also move data from a palette to a preset and vice versa. It is important to remember
that when using the Move To command that data is removed from its current location and
moved to its new location.

Editing Presets in Blind
All presets can be viewed and edited in blind. To open a preset in blind, you can do any of the
following:

• Press [Blind] {Preset x} - opens to the specific preset.
• Press [Tab] & [2][6] - opens the preset list.
• Press [Preset] [Preset] and then {Edit} when a preset is selected in the list.

CAUTION: When editing presets in Blind, changes to presets are
automatically stored. Therefore no update or record command is required.

You can change the blind display to spreadsheet or table view by pressing the [Format] key. In
blind, the following softkeys are available when editing presets:

• {By Type} Presets (on page 250)
• {Absolute} Presets (on page 250)
• {Locked} Presets (on page 250)
• Cleanup (Using By Type Presets (on page 256))
• Discrete (Using By Type Presets (on page 256))
• Offset (on page 190)
• Make Null (Editing in Table View (on the facing page))
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• Make Absolute (Editing in Table View (below))
• Replace With (Editing in Table View (below))
• Query (Using Query (on page 314)) (Element 2)

Presets can be assigned an icon, which can be configured to appear on the direct select button
in Direct Selects (Tab 4) or Custom Direct Selects (Tab 39). See Icons (on page 93) for more
information.

Editing in Table View
Table view shows the data for one preset at a time in a table. Channels are displayed on the Y
axis and parameters are shown along the X axis. Viewing presets in the table is useful if you
want to see data for numerous channels in one specific preset.

To change which preset you are viewing you may use the [Next] or [Last] keys or you may select
the exact preset from the keypad or direct selects. You can make changes to the preset by
selecting channels and altering parameter values. In addition to normal editing functions, you
may also use the following commands in this view: [Copy To], [Recall From], {Make Absolute},
{Make Null}, {Move To}, and {Replace With}.

Here are some examples of the additional preset editing features you have while editing in table
view:

• [select channels or parameters] {Make Abs} - changes the data for any palette references
within the preset into absolute data that no longer references another record target.

• [select channels or parameters] {Make Null} - removes the data for the specified channel
or parameter from the preset.

• [select channels or parameters] [At] [Enter] - removes the data for the specified channel
or parameter from the preset.

• [Preset] [5] {Move To} [Preset] [9] [Enter] - this will move the contents of preset 5 to
preset 9. Preset 9 will be created and preset 5 will be deleted.

• [Preset] [1] [Copy To] <Preset> [5] [Enter] - this will copy the contents of preset 1 to
preset 5. You may also copy ranges of presets to new locations.

• [1][Recall From][Preset][1][Enter] - will recall the contents for channel 1 in preset 1.

Note: While editing presets in blind, hitting [Recall From] [Recall From] will put
[Recall From] [Preset] on the command line.

Editing in Spreadsheet View
Spreadsheet view shows a range of presets along the Y axis and channels/channel parameters
along the X axis. Viewing presets in spreadsheet view is useful when you want to compare data
between presets.

You may select a preset from the spreadsheet using the [Next] or [Last] keys to move through
the list or you may select the exact preset from the keypad. You may also select a range of
presets to edit at once. You can make changes to the preset(s) by selecting channels and
altering parameter values.

In addition to the examples given in table view, here are some examples of the additional preset
editing features you have while editing in spreadsheet view:

• [Preset] [1] [Thru] [5] {Move To} <Preset> [9] [Enter] - this will move presets 1 through 5
to presets 9 through 14 respectively. You do not have to supply the end value for Eos to
perform the move. If presets 9 through 14 already exist you will be asked to confirm this
move.
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• [Preset] [1] [Thru] [5] [Enter] {Iris} [5] [0] {Replace With} [2] [5] [Enter] - for presets 1
through 5, this command will replace any iris parameter values of 50 with values of 25.
Range editing using {Replace With} is easiest done in spreadsheet view, but can be done
in any Blind mode.

Using By Type Presets

Storing a By Type Preset
If {By Type} is used when recording, the lowest number channel of each fixture type will be the
default channel. Generally, when storing by type presets, you will want only one channel of
each fixture type in use. Any additional channels in that fixture type will be recorded with
discrete data.

• [1] [Thru] [6] [Record] [Preset] [1] {By Type} [Enter] - Channels 1 through 6 are saved to
Preset 1. Channels 1 through 6 are of the same fixture type. Channel 1 will be the default
channel, and channels 2 through 6 will be saved with discrete data.

• [1] [Thru] [6] [Record] [Preset] [1] [Enter] - If a by type preset is rerecorded without using
the {By Type} softkey and the default channel is included in the record, the default
channel's level will change and all other changes will be discrete.

• [1] [Thru] [5] [Record] {Preset 1} {Discrete} [Enter] - If a default channel is included in a
record where {Discrete} is used and another channel is tracking it, the default channel will
be changed to having discrete data and the lowest numbered tracking channel will
become the new default channel. All other channels in the record will also have discrete
data.

Editing By Type Presets in Blind
In Blind, the default channel’s levels will display in blue, discrete data for the other channels will
display in white, and any channels that are using the default channel value will display in
magenta.

Softkeys available for editing presets in blind are {By Type}, {Discrete}, and {Cleanup}.

• [3] {By Type} [Enter] - makes channel 3 the new default channel for that device type. If
another channel for that type was the default channel, its data will now be discrete.

• [1] [0] [Thru] [2] [0] {Discrete} [Enter] - changes the levels for channels 10 through 20 to
discrete. If any of those channels are default, the lowest numbered tracking channel will
become the new default channel.

• [5] [Thru] [8] [At] [Enter] - removes the discrete data for channels 5 through 8. They will
now use the default channel’s values.

• [Preset] [2] {Discrete} [Enter] - changes all tracking and default channels to discrete.
• [Preset] [5] {By Type} [Enter] - makes the first channel of each device type a default

channel.
• [Preset] [3] {Cleanup} [Enter] - converts presets created in earlier versions of Eos Family

software to by type presets. This command will use the first channel of each type as the
default, and allow other channels of the same type to use that value upon recall.
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{Make Null} can be used with by type preset when you wish to withhold a channel from
responding to a by type preset recall. The data will still display but will be in gray with a “N”.

Updating By Type Presets
Pressing {By Type} after an [Update] command, with a channel tracking but no default channel
included in the update, will cause the lowest numbered tracking channel's level to be updated
into the default channel. The tracking channel will remain tracking. This means that when
updating a default value in a by type preset, you don’t need to know the default channel
number.

When a default channel is included in an [Update] command without using {By Type} and
another channel is tracking it, the default channel’s data will be changed to discrete. The lowest
numbered tracking channel will then become the new default channel. Any other updated
channels will be made discrete.

Removing Channels from a Preset
You can remove specific channels from a preset. This can be done from blind.

Example:
Open the preset in blind:

• [Blind] [Preset] [Enter]

Select the preset you wish to edit:
• [Preset] [5] [Enter]

Remove channels by pressing:
• [2] [+] [4] [+] [6] [Thru] [9] [At] [Enter]

Or you can remove a specific channel parameter from the preset by pressing:
• [5] [+] [7] {Color} [At] [Enter]

You may also remove a channel/ parameter from a range of presets by
pressing:

• [Preset] [1] [Thru] [5] [Enter] [1] {Color} [At] [Enter]

You can remove channels from live by pressing:
• [channel list] [Delete] [Preset] [2] [Enter]

Deleting Presets
You may delete presets in the following ways:

• [Delete] [Preset] [1] [Enter]
• [Delete] [Preset] [1] [Thru] [5] [Enter]

Presets can be deleted from any screen, at any time. A confirmation is required to delete, unless
confirmations have been disabled in Setup. See Record Defaults (on page 177)

Presets and Palettes Fader Properties
Presets and Palettes can be mapped to faders by using the fader configuration display. For
information on how to use the fader configuration display to map faders, see Fader
Configuration (on page 101)

The fader configuration display is found on Tab 36 .The Fader List (on page 104), which shows
all of the faders and their assignments, can be found in Tab 35.

Click or tap the second row of the fader page to access this properties display.

The following options are available when a fader is configured as a preset or palette fader:
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Mode
You may define your fader as additive (contributes to the live output), inhibitive (limits live
output) or an effect fader (presets only).

Master
A fader can be assigned as a Master. When it is a master, its behavior as a Proportional Master
or Intensity Master (I-Master) is drawn from this setting.

HTP
Intensity playback behavior can be set to HTP (highest takes precedence) or LTP (latest takes
precedence).

Restore
Faders can be placed into restore modes of minimum or background, which is the default. When
a fader is in the restore to background mode, the restore column of the fader list display will be
blank. When in minimum mode, 'Min' will display in the restore column.

The restore mode of background means that when the fader is returned to zero, control will be
restored to the background value, such as another fader or a cue.

The restore mode of minimum means that when the fader is faded down, control does not go to
the previous background state but to the parameters’ minimum value.

Priority
The Independent setting for faders has been changed to priority. There are 10 levels of priority
for faders. 1 is the lowest and 10 is the highest. faders can still be shielded, which means that
their content is automatically made exclusive and can't be controlled by anything other than
that fader and park, including by manual control. Shielded has a higher priority than 10.

Background
Faders can have their background states disabled. Background states are enabled by default.
When enabled, the content of the fader will act as a background or previous state for other cues
and faders.

Background Priority
Background can have a priority assigned to it.
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In previous software releases, when content was released, it always returned to the last fader
that owned it. Background priority releases to the highest priority content that previously had
ownership, provided that content has not be turned off or released.

There are 10 levels of background priority for faders. 1 is the lowest and 10 is the highest. When
LTP content is released to background, it will go to the background state with the highest
available priority.

Up Time
This is the time for the fader to fade from its home position to its target position (0 to Full if
additive, Full to 0 if inhibitive). The default time is 0.

Dwell Time
This is the time the fader look will hold before starting the downfade. This can be set to a
specified time, or to “Hold” or “Manual”. “Hold” time maintains the fader values until the
bump is pressed a second time. “Manual” time applies the fader values only as long as the
bump is held. The default is “Manual”.

Down Time
This is the time for the content on a fader to fade from its target position to its home position.
The default time is 0.

Stomp Mode
Stomp happens when all the content owned by a fader is now being controlled by other targets.
The fader is being removed from the background , and once that happens, it would not be
eligible to fade back. You can assign behavior that will happen when a fader is stomped.

• Off When Stomped - puts the content into an off state, the same behavior encountered
when pressing [Off] + [Load].

• Unload When Stomped - unloads the fader.
• Nothing When Stomped - no action happens to the fader.
• Release When Stomped -This function behaves the same as Off When Stomped.

Unmark at 0%
When this option is on, marked content controlled by the fader will automatically be released
when the fader reaches 0%. When the bump button is next pressed, the fader will fire. If this
option is off, you would need to first press the bump button to reset the fader before pressing the
bump again to fire it.

Note: This option is for faders that are set to Intensity Master.

Exclusions
Those exclusions include:

• Exclude From Record - output is not recorded into any other record target.
• Exclude From Grandmaster - content cannot be mastered by a grandmaster.
• Exclude From Inhibitive Sub - content cannot be mastered by an inhibitive submaster
• Exclude From Solo - content will ignore solo. See Fader and Button Configuration (on

page 294) for more information on solo.



260 Eos Ti, Gio, Gio @5, Ion Xe, Ion Xe 20, and Element 2 Operations Manual

Channel and Parameter Filters
Channel and Parameter Filters can be used to allow only specified data to be played back.
These are playback filters, and do not impact how data is recorded.

Tap or click on {Chan Filter} to assign channels or groups. Tap or click on {Param Filter} to open
a list of available parameters that you can filter.

When a filter has been applied, an indicator will display in the fader ribbon. C will display for
channel filter, and F is for parameter filter.

Press the red [X] to clear the channel or parameter filters listed.

Fader and Button Configuration
Click or tap on the virtual buttons or fader to see a list of available configuration options.

Button Options
The following options are available for fader buttons:

• Bump - plays back the content at 100% of the recorded level. It will continue to do so until
released, unless the fader has a time assigned or the {Hold} property set.

• Group/ Assert - selects all the channels associated with the fader, if the fader is inactive.
If active, the contents of the fader will be asserted.

• Assert - regains control of all of the channels associated with the fader.
• Group Select - selects the channels stored in the fader. This is the same as [Group] [Sub]

[n].
• Freeze - halts all effect activity on the fader.
• Off - removes the content and if the fader is set to Master, the fader will remain where it

currently is.
• Release - removes the content and if the fader is set to Master, the fader will reset to 0.
• Start Stop Effect -starts the effect while ignoring dwell times. Will stop effects if any are

running.
• Button Disabled - no action is assigned to the button.
• Solo - suppresses any intensity values not provided by the associated content while the

solo button is held down. When the button is released, intensity values are restored.
Priority and HTP are ignored. Shielded, park and pixel mapping outputs are not affected
by the solo button.

• Back - fades to the previous cue when fader is assigned to a cue list.
• Macro - allows you to assign a macro as a button action.

Fader Options
The following options are available for a fader:

• Master - fader will be a proportional master, a manual master, or an intensity master.
• Effect Rate - fader centers to home. It controls the rate of any running effects (same

behavior as using rate via the Effect Status Display). The adjusted setting from this control
cannot be stored.

• Effect Size - similar to Effect Rate but for effect size.
• Rate Master - homes to center. It adjusts the cue rate, just like rate and load.
• Fader Disabled - no action is assigned to the fade.
• Master Only - fader is used to set a level for content to fade to. The slider can be used to

live adjust levels when the fader has been activated via the bump button. See Master Only
(on page 106) for more information.

• Effect Master - masters the entry/exit mode of the effects (size, rate or both).
• Levels Only - masters the levels without mastering the effect.
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Temporary Fader Mapping
Presets and palettes can be used to create a temporary list of content that can be played back
on a fader.

Note: This list is not recorded. If the fader is unloaded, the list cannot be recalled.

To create a list, press the [Load] button of an unmapped fader. You can then select presets or
palettes to add to your list either by the command line or from the direct selects.

• [Load] {DS 1} {DS 2} {DS 2} [Enter]
• {Fader} [1][0] [Preset] [1] [Preset] [2] [Preset [3] [Enter]

Once mapped, the fader will default to Master Only mode. See Master Only (on page 106) for
more information.

The list will use the timing assigned to the fader.

A fader with temporary mapping will have the cue list options for Back From First and Go From
Last. These are Cue List Properties, see Cue List Properties (on page 291)

The list of targets will display in the Fader Configuration List (Tab 36), in the Fader List (Tab 35),
and in the Fader Ribbon.
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About Single Cue List
A cue is a record target comprised of channels with associated parameter data, discrete
(channel/parameter level) timing, cue timing, and cue attributes (such as preheat, follow or
hang instructions).

When cues are created, they are stored in a cue list.

By default, recording cues will result in a single cue list, identified as cue list 1.

While other cue lists can be recorded in Eos, this section deals primarily with working in a single
cue list.

Element 2 does not have multiple cue lists.

For more information on multiple cue lists, see About Working With Multiple Cue Lists (on
page 302)

Basic Cueing
In Setup, you determine if Eos will operate in a Cue Only or Tracking mode. See Tracking vs.
Cue Only (on page 6) By default, the system is set to tracking, therefore this section primarily
addresses working in tracking mode. The current mode is displayed in the upper left corner of
the live/blind display. It is important to know which mode you are working in, as it impacts how
cues are edited.

• If your console is set in Track mode (default), changes move forward through the cue list
until a block or a move instruction is encountered.

• If your console is set in Cue Only mode, changes to cues have no impact on subsequent
cue data.

Cue Numbering
Cues can be numbered from 0.001 - 9999.999. You can have up to 10,000 cues.

Eos provides you with multiple ways to number your cues. The most common methods are listed
below:

• After pressing record, enter a cue number which can be a whole number (1) or a decimal
number (1.1).

• After pressing record, rather than entering a cue number you may press [Next], which will
automatically number the cue with the next sequential number in the same cue list. For
example, the current cue is numbered cue 1.1, pressing [Record] [Next] will automatically
number the new cue 1.2.

• When recording decimal cues, it is not necessary to specify the leading cue number if a
cue has already been recorded. For example, if the current cue is numbered 5, when you
enter the next record command, you can just enter [.] [5] to record cue 5.5.

• Whole numbered cue - [Next] increments the next whole numbered cue.
• Tenths numbered cue (.1) - [Next] increments in tenths.
• Hundredths (.01) numbered cue - [Next] increments in hundredths.
• Thousandths (.001) numbered cue - [Next] increments in thousandths.

Recording Cues in Live
When using [Record], all parameters of any fixtures that have non-home values, either from
manual control, other cues, or submaster playback are stored in the target cue.
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Channels that have all home values, meaning they have never been changed, are not included
in the record action, unless you specifically select the channel and press {Make Manual}. See
Using {Make Manual} (on page 312) for more information.

Possible exclusions are parameters categories or individual channel parameters withheld by use
of filters (see About Filters (on page 298) ). You can also select individual parameters of
individual channels (such as Cyan and Iris) and place them in a null state using the {Make Null}
button if the values are not needed in the cue you are recording. See Using {Make Null} (on
page 311) for more information.

You could also use {Release}. Release is an extension of the {Make Null} command in Blind.
When Release is used, it behaves like Make Null, but it also releases the channel and parameter
data to its background state, if one is available, or fades out the intensity instead.

Release can be used to mask instructions in a cue after it has already been stored. The data is
not removed from the cue. See Release (on page 312) for more information.

Eos consoles are tracking, meaning once something is recorded into the cue list, the cue list will
always contain information about that channel/ parameter unless it is nulled, by using the
{Make Null} command, released by using the {Release} command, or filtered using the
parameter filters.

When cues are recorded they are automatically played back and manual values are released,
unless auto playback on record has been disabled in setup. See Auto Playback (on page 177).
Upon playback, displayed parameter levels will be color coded for clarification of the record
action:

• Blue - intensity has increased from the previous cue or a non-intensity parameter has
changed.

• Green - intensity level has decreased from the previous cue or a non-intensity parameter
has marked.

• Magenta - level has tracked from a previous cue.
• White - level has been blocked (see Block (on page 276)).

Using Record in Live
When the [Record] button is pressed the keypad defaults to cue mode; use of the [Cue] button
is optional. The following are representative examples of recording cues in Live. Once the cue
record has been specified, cue attributes such as timing can be combined and entered in any
order you wish.

• [Record] <Cue> [5] [Enter] - records all parameters of any channels with non-default data
into the specified cue number 5.

• [Record] <Cue> [5] [Label] [name] [Enter] - records the specified cue and provides an
alphanumeric label.

Note: When using the console in tracking mode or when using track editing, it is
important to understand the concept of Blocking. A cue containing a Block flag will stop
edited levels from tracking through that cue. Blocks are often placed on the cue at the
top of an act or scene, or anywhere you want to protect cues from levels that may track
in from upstream cues. Block flags should also be set on cues that you want to have
behave as blackouts (see Block (on page 276)).

Note: [+] can be used with [Record] to specify a range of cues for recording. See
Update [+] (on page 284).
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Using Record Only in Live
[Record Only] is similar to [Record] except that it selectively stores only manually set values,
preventing unwanted levels (such as from a submaster or another cue list), from being recorded
into the cue. Therefore, when used to record a cue, only the manual data for channels will be
stored in the cue. Any values in the previous cue that were unchanged will track into the new
cue.

All of the same commands used for [Record] may also be used for [Record Only].

• [Record Only] <Cue> [Next] [Enter] - stores only the manually set values into the next
cue in the list.

• [Record Only] [Cue] [3] [Enter] - stores only the manually set data into cue 3.

As with [Record], filters can further restrict stored data if deployed when using [Record Only].
See About Filters (on page 298)

Record and Record Only [+]
[+] can be used to specify a range of cues when using [Record] and [Record Only].

Example:
To record only cues 5, 10, and 15:

• [Record] <Cue> [5] [+] [1][0] [+] [1][5] <CueOnly/Track> [Enter]

To update the current cue and cue 7:
• [Record Only] [+] <Cue>[7] <CueOnly/Track> [Enter]

Note: If no cue number is entered before the [+], the current active cue will be used.

Using [Cue Only / Track]

Note: For a more detailed summary of Cue Only and Tracking modes, see Tracking
vs. Cue Only (on page 6).

In Track Mode
When you create a new cue, any channel parameter data from the previous cue is tracked into
the new specified cue. Any changes in this new cue will also track forward into subsequent cues
until a move instruction is encountered. The [Q Only/Track] key is an exception to this behavior.
When you record a cue in the middle of an existing cue list, using the [Q Only] button will
prohibit new information from tracking into the subsequent cue. When you rerecord or update a
cue, the modifications will not track forward.

Note: In the following examples, the command [Q Only] indicates the same key hit
of [Q Only/Track] which is a single button on the keypad. The system setting
determines the actual context of the button depending on the mode in which the
system is operating. For clarity, only the contextual function of the button is used in the
examples.

With system set to Track

• [Record] <Cue> [5] [Q Only] [Enter] - records cue 5. New values or changes will not track
into the subsequent cue.
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• [-] [Color] [Record] <Cue> [5] [Q Only] [Enter] - as above the recorded data will not
track forward and all color data is excluded from the record operation.

• [Record Only] <Cue> [5] [Q Only] [Enter] - records all manual data, but doesn’t allow it
to track into subsequent cues.

• [-] [5] [Record] <Cue> [6] [Q Only] [Enter] - records the specified cue, except the
contributions from channel 5. The stored data will not track forward in the list.

On Element Classic, double pressing [Record] will post Record Only to the command line.

In Cue Only Mode
When you create a new cue, any channel parameter data from the previous cue is tracked into
the new cue. The [Q Only/Track] key can be used as an applied exception to the cue only/ track
system setting.

Note: In the following examples, the command [Track] indicate the same key hit of
[Q Only/Track] which is a single button on the keypad. The system setting determines
the actual context of the button depending on the mode the system is operating. For
clarity, only the contextual function of the button is used in the examples.

With system set to Cue Only

• [Record] <Cue> [5] [Track] [Enter] - records cue 5. This data will track forward in the list
until the next move instruction or block.

• [-] [5] [Color] [Record] <Cue> [6] [Track] [Enter] - records the specified cue, except the
color data from channel 5. The data will track forward in the list until the next move
instruction or block.

• [Record Only] <Cue> [2] [Thru] [7] [Track] [Enter] - stores all manual data. The stored
data will be forced to track from cue 2 through 7 through any blocks or move instructions.
After cue 7, values will continue to track until a move instruction or block is encountered.

Selective Storing Cues in Live
Cues can also be modified using selective storing, which allows you to specify only the channels
and or parameters that you want to store. When using a selective store, you must specify the
channel list to be included or excluded, identified by [Thru], [+], [-], as part of the [Record] or
[Record Only] command.

See Using Selective Store (below) for more information.

Using Selective Store
You may use the [-] button to withhold information from a cue or use the [+] button to specify a
particular channel/ parameter to be included in the record action. These actions are both
selective stores.

For information on a selective store using filters see Partial Filters (on page 298).

Since Eos consoles are tracking, any channels not included in the selective store, but that do
have values in the previous cue will track into the recorded cue. This is true even when the
console is in Cue Only mode. To remove intensity values that would otherwise track when on a
selective store, the rem dim command can be used. See Remainder Dim (on page 211).

Using a Positive Selective Store
You may record only specified parameters into cues. If the cue has already been stored, this
action adds the specified channel parameters to the existing cue data.

To record only specific channels into a new target cue:
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• [1] [Thru] [5] [Record] <Cue> [4] [Enter] - records only channels 1 through 5 into cue 4.
• [channel list] [Record] <Cue> [5] [Rem Dim] [Enter] - stores the selected channels into

the target cue. Any channels active in the previous cue that are not in the selected
channel list will be set to zero in cue 5.

• [2] [Thru] [8] [Record Only] <Cue> [9] [Enter] - stores only the manually set data for
channels 2 through 8 into the target cue 9.

• [Group] [2] [Record Only] [Cue] [5] [Enter] - stores only the manual data from group 2
into cue 5.

To record only specific parameters into a target cue:

• [1] [Thru] [5] {Focus} {Color} [Record] <Cue> [4] [Enter] - records the focus and color
data for channels 1 through 5 into cue 4. Any other data on stage would not be stored in
the target cue.

• [selected channels] {Color} [Record Only] <Cue> [4] [Enter] - stores only the color data
for the selected channels into cue 4.

Using a selective store for a new record target will track in values from the previous cue that are
not included in the record action.

Using a selective store for an already existing cue will modify the selected data only, leaving the
rest of the cue untouched. This does not overwrite the whole cue.

Using a Negative Selective Store
It is possible to withhold data from a cue by using the [-] key as follows:

• [-] [Group] [3] [Thru] <Group> [6] [Record] <Cue> [9] [Enter] - records the specified cue,
with the exception of any channels associated with groups 3 through 6.

• [-] [3] [Thru] [6] [Record] <Cue> [9] [Enter] - records the specified cue, with the
exception of channels 3 through 6.

• [-] [Sub] [7] [Record] [Enter] - records the selected cue, without the input from submaster
7.

• [-] [Sub] [Record] [Enter] - as above, except withholds the contents of all submasters.
• - {Color} [Record] <Cue> [8] [Enter] - records cue 8 without any color data.

Timing
Cue timing can be applied in a variety of ways. At a cue level, timing categories are provided for
intensity up, intensity down, focus, color and beam transitions. Each of these times can have an
associated delay. Timing can also be applied directly to a channel or a specific parameter. This
is called discrete timing.

Time can be entered in minutes and seconds (example 10:15) with valid fade times from zero to
99:59 ( 99 minutes and 59 seconds), or seconds and tenths of seconds (example 1.3), or 100ths
of seconds (example 1.35) with valid fade times from zero to 99.99. When no time is applied at
a cue level, the defaults established in Setup are used. See Cue Settings (on page 169)

Example:
You want the time for cue 1 to be 10 minutes and 15 seconds.

• [Cue] [1] [Time] [1][0][1][5] [Enter]

The command line will show the time as Cue 1 Time 10:15.

If you want the time for cue 1 to be in seconds and tenths of a second, like 1.3
seconds, you will type using a decimal.

• [Cue] [1] [Time] [1][.][3] [Enter]
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The command line will show the time as Cue 1 Time 0:01.3.

Setting Cue Level Timing
Unless you specify otherwise, Eos assigns default fade times to any cue you record. Default
timing is designated in Setup (Cue Settings (on page 169)). Cue level timing can be applied
when a cue is recorded or can be added or modified later.

Following are some examples of record commands with cue level timing:

• [Record] <Cue> [5] [Time] [9] [Enter] - puts a time of 9 seconds on all parameter timing
categories.

• [Record] <Cue> [6] [Time] [3] [Time] [9] [Enter] -specifies the intensity up, focus, color,
and beam times at 3 seconds and the down time at 9 seconds. The first instance of [Time]
is used for intensity up fade (meaning intensity value is fading to a higher level than
previously set) and the second instance of [Time] is used for intensity down fade time
(intensity values fading to a lower level than previously set).

• [Record] <Cue> [2] [Time] [Enter] - resets time to default value defined in Setup.

Note: Unless FCB timing is specifically set, it always defaults to the up fade time
value.

Manual Timing at a Cue Level
It is possible to assign a time of manual, for manual parameter transition through the associated
fader. See Manual Timing Control (on page 330) for more information. Manual times are
assigned by using the {Manual} softkey that displays after [Time] is pressed when recording a
cue.

• [Record] <Cue> [4] [Time] {Manual} [Enter] - applies a manual time. If the cue had
previously been given split times, would apply a manual to the up fade, focus, color, and
beam times. If the cue had a single time, all of the timing would be manual and controlled
by the fader.

• [Record] <Cue> [4] [Time] [Time] {Manual} [Enter] - applies a manual intensity time to
the down fade.

• [Record] <Cue> [4] {Color} [Time] {Manual} [Enter] - applies a manual time to any color
data changes in cue 4.

Non-intensity Parameter Category Timing
Timing can be also applied for Focus, Color and Beam parameter categories at a cue level. By
default, FCB timing is the same as intensity upfade time. Once FCB timing is different than
intensity upfade time, those times are no longer affected by intensity upfade changes.

When you apply a time to an individual parameter category and that category has no
movement, the time is displayed in gray. The specified timing will remain in gray until that
category is provided with a move instruction, at which point it the timing will display in white.

• [Record] <Cue> [2] {Color} [Time] [7] [Enter] - records cue 2 with a cue level color time
of 7.

• [Record] <Cue> [2] {Color} [Time] [Enter] - resets the color time of cue 2 back to the
default value.

• [Record] <Cue> [2] [Time] [Time] [Time] [7] [Enter] - records cue 2 with a cue level focus
time of 7. In this example, each press of the [Time] key steps through each timing value
(up time, down time, focus time, color time and beam time).
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• [Record] <Cue> [2] [Time] [7] [Enter]- records cue 2 and puts a time of 7 on all
parameter categories. This only works if FCB timing was previously untouched. If
FCB timing had been changed, this syntax example would change just the upfade time to
7.

Note: It is not necessary to rerecord a cue to alter stored timing data. You can simply
redefine the time by specifying the cue and re-entering the time value(s).

• [Cue] [5] [Time] [8] [Enter] -redefines the all category times to 8 seconds. This
only works if FCB timing was previously untouched. If FCB timing had been
changed, this syntax example would change just the upfade time to 8.

• [Cue] [2] {Color} [Time] [5] [Enter] - redefines color time to 5 seconds.
• [Cue] [3] {Focus} [Time] [-] [2] [Enter] - removes 2 seconds from the current

time.
• [Cue] [7] {Beam} [Time] [+] [3] [Enter] - adds 3 seconds to the current time.

[Time][/]
The [/] key can be used with [Time] to control the intensity upfade and downfade times, and
delays.

• [Cue] [1] [Time] [/] [5] [Enter] - places a downfade time of 5 on the cue, while splitting
the upfade, which preserves its current value.

• [Cue] [2] [Time] [/] [Enter] - removes the downfade time and makes the downfade match
the upfade.

• [Cue] [3] [Time] [4] [/] [Enter] - sets the upfade time, and splits the downfade without
splitting the FCB times.

• [Cue] [5] [Time] [4] [/][3] [Enter] - sets the upfade and the downfade times.
• [Cue] [4] [Time] [2] [/] [/] [Enter] - changes only the intensity upfade time and splits the

downfade and FCB times preserving their current value.

Discrete Channel and Parameter Timing
Rather than using cue times, timing can be applied directly at a parameter or channel level. This
is referred to as discrete time.

Discrete timing can be applied to a specific channel or parameter. You must select the channels
that you want to apply the time to, otherwise the system assumes you are addressing the
selected cue.

Following are some examples of use:

• [channel list] {Color} [Time] [3] [Enter] - adds a time of 3 seconds to all of the color
parameters of the channel list that have a move instruction.

• {Focus} [Time] [7] [Enter] - assigns a time of 7 seconds for the focus attribute of all
selected channels.

• [Select Manual] {Beam} [Time] [7] [Enter] - selects channels with manual data and
applies a time of 7 to any manual beam values.

Discrete delay times can also be placed on a channel parameter.

• [1] {Color} [Time] [4] [Delay] [3] [Enter] - places a time of 4 seconds and a delay of 3
seconds on all color parameters of channel 1.

The [+] and [-] hardkeys can be used to increase or decrease discrete timing values.

• [channel list] [Time] [+] [3] [Enter] - increases the discrete timing values by 3 seconds.
• [channel list] [Delay] [-] [1] [Enter] - decreases the discrete delay value by 1 second.
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When timing has been applied to a channel parameter in live, a small red “t” will be displayed
with the channel. This indicates the timing must be stored or updated to the required cue. When
this is done, the “t” is displayed in blue. In the Playback Status Display, a “+” is displayed in the
associated parameter category time field, indicating that not all of the parameters in the cue
will use the cue timing.

[About] & [Time] can be held down to see the discrete delay /time information for channels in
Live /Blind. Delay is displayed first, followed by the timing value.

Note: Any conditions placed on channel /parameter in live (such as discrete timing,
asserts, blocks, etc) must be stored or updated to the cue.

Discrete Time as a Percentage
Discrete times can be entered as a percentage of the cue time.

• [channel list] [Time] [/] [5] [Enter] sets the time to 50% of the cue time.
• [channel list] {Focus} [Time] [/] [7][5] [Enter] - sets the discrete focus timing to 75%.

Assigning Cue Attributes
You can record cues with specific attributes to affect how cues behave when executed. Cue
attributes include Follow, Hang, Link, Loop, Delay Time, Rate, Curve, Cue Notes, Cue Labels,
and Scenes. Cue attributes can be entered when the cue is initially recorded, or they can be
added or modified at a later date.

When [Cue] is pressed, the {Attributes} softkey will display. Press {Attributes} to access the
following softkeys:

• {Rate}
• {Note}
• {Scene}
• {Curve}
• {Preheat}
• {AF/MF} (Allfade/ Move Fade)
• {Scene End}

Note: Preheat and Allfade are flags. See Preheat (on page 278) and AllFade (on
page 277) for more information.

Follow/ Hang
A follow automatically activates the next cue in the sequence when the follow time of the
associated cue has elapsed. The follow time begins counting from the moment the cue is
executed.

The hang time is also an auto-follow, but rather than counting from the moment the cue is
executed, it is calculated from the completion of the cue. You can assign a negative value to a
hang time, allowing a subsequent cue to overlap an active cue.

You can assign either a follow time or a hang time, but not both. Both features are accessed
using the [Shift] & [Delay] keys on the console or the softkey {Fw/Hg}. [Shift] & [Delay] or
{Fw/Hg} will put Follow on the command line, and [Shift] & [Delay] [Delay] or double pressing
{Fw/Hg} will put Hang.
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In the Playback Status Display, any cue that will be triggered by a follow or hang will have an
arrow before the cue number. See Indicators in the Playback Status Display (on page 83) for
more information. This indicator can be disabled in the PSD configuration menu. See Playback
Status Display Configuration (on page 85) for more information.

Following are some examples of use:

• [Record] <Cue> [5] [Shift] & [Delay] [8] [Enter] - records cue 5 and provides a follow
time of 8 seconds which impacts the start of the next cue in the list. The following cue will
automatically initiate on the same fader when the follow time has elapsed. The follow
time will begin counting down when the associated cue (Cue 5) is executed.

• [Record] <Cue> [5] [Shift] & [Delay] [Delay] [8] [Enter] - records cue 5 and provides a
hang time of 8 seconds which impacts the start of the next cue in the cue list. The
following cue will automatically initiate on the same fader when the hang time has
elapsed. The hang time will begin counting down when the associated cue (Cue 5) is
complete.

• [Record] <Cue> [5] [Shift] & [Delay] [Delay] [-] [5] [Enter] - records cue 5 and provides a
hang time of negative 5 seconds.

To remove a Follow /Hang time:

• [Cue] [x] [Shift] & [Delay] [Enter]

Link / Loop

Link
Link allows cues to be run out-of-sequence, by causing a different cue number to be loaded into
the pending file of the playback fader when the cue that carries the link instruction is activated.
If a follow or hang time is included with the cue attributes, the activation of the linked cue will
occur when the follow or hang time has elapsed.

The link can be within the cue list or to a cue in another cue list.

Cues that link to other cues will display this information in a row under the cue in the Cue List
Index and the Playback Status Display. This can be suppressed in the PSD configuration. See
Playback Status Display Configuration (on page 85) for more information.

Note: If a linked cue has a label, the label will be displayed in the link cue indicator.

Following is an example of using link:

• [Record] <Cue> [2] {Link/Loop} <Cue> [8] [Enter] - records the specified cue 2 and
provides a link to cue 8 in the cue list. When cue 2 is played back, the linked cue is loaded
into the pending queue of the associated fader.

Loop
Loop is provided as a method to link a series of cues and loop them a number of times in a
sequence. Once the sequence of cues has played back the first time, the system recognizes the
loop command and plays the sequence again, provided the target of the link is a previous cue.

If the first cue in the sequence is a cue with an assert attribute or has move instructions for
channels, values from the last cue are not allowed to track through into the first cue when it is
looped back. But without a move or assert in the first cue, values from the last cue will track into
the first cue when it loops back.

A loop specified with “0” loops the sequence indefinitely.

Following is an example of using loop:
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• [Cue] [2] {Link/Loop} <Cue> [1] {Link/Loop} [3] [Shift] & [Delay] [4] [Enter] - records a
link from cue 2 back to cue 1. Because there is a follow time, cue 1 will automatically
trigger 4 seconds after cue 2. If cue 1 also has follow time, it will automatically trigger cue
2. This sequence will run 4 times (once plus 3 loops) and then stop in cue 2. The loop
value specifies the number of times the loop instruction will be performed. Since the
sequence has run once prior to the loop command, the total number of passes will be the
specified number of loops +1.

You could apply {Go After Loop} on cue 2 to execute the next cue after a follow link/ loop
sequence has ended. See Using External Links (on page 278)

Note: All cues in a looping sequence must have Follow or Hang times in order for the
loop to play uninterrupted.

Delay Time
Delay can be useful when you do not want a parameter to change (for example - intensity down)
until other changes have begun or completed their transition.

Delay times can be added to any cue or to any specific parameter category within the cue,
which will postpone the parameter transition until the delay time has elapsed.

Following are some examples of recording with a delay:

• [Record] <Cue> [2] [Delay] [5] [Enter] - stores cue 2 with a 5 second delay on intensity.
• [Record] <Cue> [2] [Time] [9] [Delay] [3] [Enter] - records cue 2 with a 9 second fade for

all parameter categories, delayed from Go by 3 seconds.
• [Record] <Cue> [2] [Time] [7] [Delay] [Enter] - records cue 2 with a 7 second fade, and

removes delay time.
• [Record] <Cue> [2] [Delay] [/] [5] [Enter] - records cue 2 with a 5 second delay on the

downfade.

Delay can be used to affect only the parameters in the specified category.

• [Record] <Cue> [2] {Color} [Delay] [8] [Enter] - records cue 2 with a delay time of 8
seconds for the color category.

• [Record] <Cue> [2] [Time] [Time] [Time] [Delay] [7] [Enter] - records cue 2 with a cue
level focus delay time of 7. In this example, each press of the [Time] key steps through
each timing value (up time, down time, focus time, color time and beam time.

Rate
The {Rate} softkey can be used to apply a rate adjustment to all timing in the cue. The default
rate is 100%, which is real time. To slow a cue down, set the rate below 100%. To speed the
cue up, set the rate above 100%. The range rate for a cue is 0 - 2000%. A timing value of 5,
with a rate of 50% will replay in 10 seconds. A timing value of 5, with a rate of 200% will replay
in 2.5 seconds.

Following is an example of using rate:

• [Record] <Cue> [4] {Attributes} {Rate} [1] [2] [5] [Enter] - records the specified cue, and
places a rate override instruction on all timing values. The cue would now be played back
at 125% of recorded time values.
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Note: You can use the playback rate override function to determine the rate at which
you want to play the cue back, and then apply that rate to the cue. This eliminates the
need to adjust all of the timing in the cue if you only need to speed it up or slow it
down. See Using Rate Override (on page 329).

Curve
{Curve} is used to affect the percent completion of a cue or part by applying the curve’s output
level as the percent completion for all fade calculations.

When a curve is applied to cue, it impacts only the intensity transitions in that cue. When
applied to a cue part, it impacts any parameters moving in that part. For more information on
creating and using curves, see About Curves (on page 392)

Following is an example of how to assign a curve to a cue:

• [Cue] [6] {Attributes} {Curve} [5] [Enter] - applies curve 5 to cue 6.

Cue Label
[Label] is used to attach an alphanumeric label to a cue or cue part.

Following is an example of how to apply a label to a cue:

• [Record] <Cue> [7] [Label] <name> [Enter] - records cue 7 and applies the label as
entered on the alphanumeric keyboard.

• [Record] <Cue> [8] [Label] [Block] [Enter] - records cue 7 and applies the name of the
hardkey as the label

Pressing [Label], when a label has already been applied to a cue, will display the label on the
command line for editing. Pressing [Label] a second time will clear the label, or you can press
[Clear] to remove the label one character at a time.

Cue Notes
Cues can have notes attached to them.

These notes can be viewed in the Playback Status Display and the Cue List Index by hovering a
mouse over or tapping on the + in the Label column.

You can also select to view the notes or the notes for the pending cue in a horizontal bar at the
bottom of the PSD. See Playback Status Display Configuration (on page 85) for these additional
display options.

To add a note to a cue:

• [Cue] [n] {Attributes} {Notes}

To add a note to the currently selected cue, you can use [Shift] & [Label].

You can use the virtual alphanumeric keyboard or an external keyboard to enter the desired
text.

See Copy To and Move To for Labels, Scenes, and Notes (on page 309) for more information.

Scenes
Scenes are a cue organization tool that provide a visual identifier for breaks in your show.
Scenes allow for quick cue list navigation without needing to remember a cue's number.
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Scenes display in the cue list index and the playback status display as a green bar above the cue
they are associated with in the list. An end of scene can also be created, and those display as a
green bar under their associated cue.

Creating a Scene Break
You can add a scene break by using the {Scene} softkey. For example, [Cue] <1 > {Attribute}
{Scene} will add a scene to cue 1.

The virtual alphanumeric keyboard will open. You will need to label the scene before it is
created.

See Copy To and Move To for Labels, Scenes, and Notes (on page 309) for more information.

Creating a Scene End
You can specify where a scene ends by using the {Scene End} softkey. For example, [Cue] <5 >
{Attribute} {Scene End} will add a scene end to cue 5.

You can create a scene and a scene end at the same time by using [Thru]. For example, [Cue]
[1] [Thru] [5] {Scene} will add a scene to cue 1 and a scene end to cue 5.

Update Using Scene End
The {Scene End} softkey can also be used when updating the cues in a scene. For example,
[Update] <Cue> [1] [Thru] {Scene End} will put the last cue of that scene on the command line.

Note: Tracking / cue only rules still apply. If your console is in tracking mode, and you
want the update to stop at the scene end, you will need to use the [Q Only] command.

Using a Scene Break
You can recall a scene to quickly jump to a cue without needing to remember its number. To
recall a scene, use the [Go to Cue] button and select the {Scenes} softkey.

This will open up the scene selection display in the CIA. The scene's label and cue will display.
Press or click on the scene to select it.

Scenes can also be recalled by using the direct selects. See Using Direct Selects (on page 86) for
more information.
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Deleting a Scene Break
To delete a scene or scene end, you will need to use the following syntax:

• [Cue] [n] {Attributes} {Scene} [Label] [Enter] - deletes the scene.
• [Cue] [n] {Attributes} {Scene End} [Enter] - deletes the scene end.

Clearing Cue Attributes
To clear attributes from a cue:

• [Cue] [n] [Shift] & [Delay] [Enter] - removes the follow or hang time from the specified
cue “n”.

• [Cue] [n] [Label] [Label] [Enter] - removes the label from the specified cue “n”.
• [Cue] [n] {Link/Loop} [Enter] - removes the link instruction from the specified cue “n”.
• [Cue] [n] [Thru] [y] {Attributes} {Rate} [Enter] - removes the rate instruction in cues “n”

through “y”.

You may combine these to remove multiple attributes at once:

• [Cue] [n] [Shift] & [Delay] {Link/Loop} [Enter] - removes the follow time and link
instruction.

Flags
Flags can be applied to cues to change specific behaviors. Flags can be set for Block, Assert,
AllFade, Mark, and Preheat.

Block
You can apply a block to a cue, a cue part, to any channel (or group of channels), or parameter
(or group of parameters) within a cue. Block is an editing function. It has no impact on how the
data is played back.

At a Cue Level
A cue level block causes all tracked values in the cue to be treated as move instructions from an
editing standpoint, which prohibits any data changes from tracking into the cue. Parameters
that are not included in the cue are not impacted by the block instruction.

Blocks do not protect a cue, channel or parameter from being modified by a range edit, nor are
they protected from a trace instruction (see Using Trace (on page 283)). It is assumed that if you
use the trace instruction, then you really want the initial value to change. A block will stop the
trace from moving any further backwards through the cue list.

• [Cue] [5] [Block] [Enter] - “B” is displayed in the flags field, indicating a cue level block.
When this cue is recalled, all data that would otherwise appear as a tracked value, will be
displayed in white. Any changes upstream in the cue list will not impact this blocked cue
data.

• [Cue] [6] {Intensity} [Block] [Enter] - “I” is displayed in the flags field, indicating a cue
level intensity block. You could also use [Shift] & [Block] to put Intensity Block on the
command line.

At a Channel / Parameter level
Blocks can also be applied to a channel or a channel parameter. This can be done in live or
blind. When applied in live, the block instruction must be stored or updated to the appropriate
cue.

• [9] [Block] [Enter] - applies a block to channel 9. A red “B” appears near the channel in
the live display, indicating a block has been applied but is not yet stored.
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• [Group] [5] {Color} [Block] [Enter] - applies a block to all of the color parameters for
group 5.

When the block instruction has been stored or updated, any tracked values the block was
applied to will be displayed in white.

Channel level blocks are indicated in the cue list by a “b” and auto-blocks are indicated in the
cue list by a “b”, representing a partial block. To remove auto-blocks, see Auto-block Cleanup
(on page 289).

Auto-block
Eos also supports an auto-block function. Auto-block can protect your cue data from unwanted
changes. For example, in cue 5 you set channel 1 to 50%. It is stored as a move instruction.
Then, you later go back to an earlier cue and set channel 1 to 50% and it tracks forward to cue
5. Channel 1 will be auto-blocked in cue 5. Even though it is now at the same value as the
previous cue, the original concept of a move instruction is maintained.

Auto-blocks are displayed in white, with a white underscore.

Assert
Assert is a way to make a tracked or blocked value act as a move instruction on playback. It is
often used in a multiple cue list environments, or to assure that a transition happens in the
desired time. See Using Assert (on page 303) for more information on asserts in multiple cue
lists and Using Assert (Playback Button) (on page 328) for more information on using assert for
playback.

Assert can be useful in a single cue list.

Example:
Cue 10 is a blackout with a zero count. It is common practice to block blackout
cues. Let’s say though that some of the lights were fading to zero in cue 9. You
hit [Go] for cue 10 before cue 9 is finished. The lights that were fading to zero
in cue 9 will continue their downfade in the timing for cue 9 since cue 10
doesn’t provide them with a new move instruction. If you assert cue 10, the
lights will bump to black as expected.

AllFade
Any cue can have an allfade flag applied. An allfade sends the intensity for all channels not
included in the cue to zero. Submasters, any captured channels and the contribution from any
faders that are set to priority are unaffected, unless the cue executing the allfade is also set to
priority. An allfade flag “*” is identified in the cue list index and the playback status display for
the specified cue.

• <Cue> [5] {Attributes} {AF/MF} [Enter] - sends intensity for all channels not included in
the allfade cue to zero.

The allfade instruction is useful as a quick cleanup, to get back to a known state on stage,
without having to worry about what channels need to be set to zero.

Mark
The Mark flag is used to relay information about either automarks or reference marks. When
using automarks, an “M” will display in the flags field for the specific cue that will execute an
automark. A “D” is displayed when automark has been disabled for a cue or a cue part.
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When using reference marks, an “M” will display in the flags field for any cue that will execute
a referenced mark. An “R” displays when a cue is the source of a mark. See About Mark (on
page 230).

Note: Only AutoMark is available on Element 2.

Preheat
Preheat can be used to warm filaments in the cue immediately preceding an intensity upfade
from 0. Preheat values can be assigned to channels individually in patch (see Attribute Section
(on page 144)).

Preheat is assigned on a cue (or cue part) basis. If assigned, any channel in that cue with a
preheat value assigned in patch will fade to that intensity in the cue immediately preceding the
cue with the preheat flag. Cues with a preheat flag will display an “P” in the preheat flag
column (indicated by a “P” at the top of the column) in the PSD and Cue List Index.

When a channel is in a preheat state, a “Ph” is displayed in the intensity field of that channel.
When a preheat is executed, the preheat value is established using the upfade time of the
associated cue. It is possible to hold the [Data] key to see the actual preheat values.

Using External Links
External links can be used to trigger actions such as macros, show control, or snapshots.
Additionally, you can enter instructions that sync the Go of other cue lists.

When you press {Execute}, the softkeys will change to {Time Code}, {Macro}, {Relay}, {On},
{Off}, {Snapshot}, {OOS Sync}, {Go After Loop}, {MIDI Raw}, and {String}.

Note: For information about using {Relay}, {Time Code}, and {MIDI Raw}, see the
sections on Relay Outputs, Time Code, and Midi Raw.

To trigger a macro:

• [Cue] [1] {Execute} [Macro] [5] [Enter] - triggers macro 5 when cue 1 is executed.

To trigger a snapshot:

• [Cue] [3] {Execute} [Snapshot] [3] [Enter] - loads snapshot 3 when cue 3 is played back.

To trigger a relay either on or off:

• [Cue][5] {Execute} {Relay}[1] [/] [1] {On} [Enter] - triggers relay 1/1 on (ACN Group ID /
Relay Number)

To trigger a specific cue on another fader:

• [Cue] [4] {Execute} [Cue] [6] [/] [5] [Enter]

To trigger cue lists press:

• [Cue] [1] {Execute} {Cue} [4] [/] [Enter]
• [Cue] [1] {Execute} {Cue} [2] [/][Enter]

When cue list triggers are set, the system will automatically execute same numbered cues on
the associated cue list. For example, assume that the last instruction above was applied to cue
list 1, cue 1. When cue 1/1 is executed, any cues numbered “1” in cue list 2 will be executed
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accordingly. If there is not a cue 1 in that list, no action is taken. If there are cue numbers on
secondary cue lists that are not in cue list 1, those cues are skipped and the subsequent cue
taken as an “out-of-sequence” cue when triggered.

When cues are taken on the primary list out of sequence, only like-numbered cues on the
secondary lists will be replayed. For example, if you go to cue 12 on the primary list, and there is
a cue 12 on the secondary list, cue 12 on all lists is executed. However, if cue 12 does not exist
in the secondary list, that list will be unaffected by the go to cue command. Out of sequence
sync can be enabled to make sure secondary lists assume the same position in the show as they
would on linear playback.

OOS Sync
{OOS Sync} can be used to change that behavior per cue list.

When OOS Sync is enabled, any out of sequence cue fired from a cue list that is synced with
another cue list will trigger the earliest cue that exists if the correct cue does not.

{OOS Sync} is disabled by default. When enabled, OOS Sync will display in the cue list index's
external links column. {OOS Sync} should be enabled in the secondary lists, not on the list that
contains the execute command.

Example:
Cue list 1 is synced with cue list 2. Cue 1/3 is fired. Since cue 2/3 does not exist,
cue 2/2 will fire instead. If OOS Sync was disabled, a cue in cue list 2 would
only fire if it has the same cue number as cue list 1.

Go After Loop
{Go After Loop} will execute the next cue after a follow link/loop sequence has ended. By
default, the loop will end with the last cue in the sequence. {Go After Loop} will use the follow
time assigned to the last cue in the sequence.

• [Cue] [5] {Execute} {Go After Loop} [Enter] - assigns the {Go After Loop} command to
cue 5. Go After Loop will display in the Ext Links Column of the Cue List index and the
PSD. After Cue 5 has completed all loops, it will execute the next cue.

Removing an External Link
To remove an external link:

• [Cue] [5] {Execute} {external link option} [Enter]

Modifying Cues Live
Recorded cues can be modified live. Assigning Cue Attributes (on page 271) (such as link, loop,
label and so on) may be edited as well. The cue does not need to be active (played back) to
change cue attributes. You may also change cue attributes for a range of cues if you wish.

[Recall From], [Copy To], and Move To may be used to create and edit cue data.

See Using [Recall From] (on page 309), Using [Copy To] (on page 308), Move To (on page 287)
for more information.

Using [At] [Enter]
A useful feature when editing cues is [At] [Enter]. This is a simple feature which allows you to
select any channel or parameter, or several of them, and remove their move instructions,
allowing the value from the previous cue to be manually recalled.
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[At] [Enter] is essentially a “recall from the previous cue” command.

Example:
Cue 5 is active in Live.

• [Group] [1] [Focus] [At] [Enter]

This command lifts the current move instructions for Group 1 focus, and recalls
the focus data for those lights from the immediately preceding cue. It is now
manual, and can be stored or updated as required.

You may use [At] [Enter] to affect only certain channels or parameters by selecting them
specifically:

• [2] [At] [Enter] - this will remove the changes for channel 2 only.
• [2] {Color} [At] [Enter] - this will remove only the color data changes for channel 2.
• [2] [Thru] [5] [+] [9] [+] [1] [1] [Thru] [1] [5] [-] [1] [2] [-] {Zoom} [At] [Enter] - removes

the changes for only the selected channels for all parameters except zoom.

Modifying Using Record
You may modify a cue by re-recording it entirely. After making changes to channels/
parameters:

• [Record] [Enter] [Enter] - will replace any data in the active cue with the current stage
settings.

• [Record] [Cue] [x] [Enter] [Enter] - will replace the any data in cue “x” with the current
stage values.

Using selective storing will modify the existing cue without overwriting it. For more information,
see Using Selective Store (on page 267)

• [1] [Record] [Cue] [2] [Enter] [Enter] - will only record the changes to channel 1.

Note: Using [Record] will store all parameters of all non-default channels onstage.
This means that all other cue data and submaster data will be included in the record
action. This is a common method when working with a single cue list. When working
with multiple cue lists and/ or submasters, [Record Only] is a useful tool.

Modifying Using Record Only
Modifying existing cues using [Record Only] is considered a “selective store” function. As such,
it adds or modifies only manual data to the target cue, but leaves any other data that was
already in the cue intact and does not include playback values from other cue lists or
submasters. [Record Only] is a good way to modify existing cues without including contributions
from other playbacks in the cue. In that way, it is very similar to [Update] (below).

All of the same commands used for Record may also be used for Record Only.

• [Record Only] [Enter] [Enter]- adds the current manual data to the selected cue.
• [Record Only] [Cue] [x] [Enter] [Enter] - adds the current manual data to cue “x”.

[Update]
Update is a powerful feature, and also very versatile. Using a combination of [Q Only], [Track],
[Trace], and {Make Absolute}, the number of ways you can update specific information and
manual data is virtually endless. Data can be updated to various record targets either at once, or
individually.
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Update Dialogue Box
When you press [Update], a dialogue box will open in the CIA. Update styles and modifiers for
those styles will be divided in the Update Dialogue Box.

Note: Default Update Modes are set in Setup>User>Record Defaults. See Record
Defaults (on page 177) for more information.

Note: {By Type} is available as a softkey. See Updating By Type Presets (on
page 257) for more information.

Update Styles
• {All} - this button will update the target cue and all references stored to that cue (nested

and otherwise).
• {Make Absolute} - this button will update the target cue and convert all levels to absolute

values, thereby removing any references.
• {Ref Only} - this button will only update the palettes or presets used in the cue, but will not

update the cue itself. If a manual reference was used before using {Ref Only}, the last
manual reference will be updated.

Update Modifiers
• {Last Ref} - this button will update using the last reference that was applied.
• {Break Nested} - this button will update the target cue and any presets used, but breaks

the reference to any palettes nested in a preset. For example, if cue 1 channel 1
references preset 3, and preset 3 was built using color palette 5. When updated with this
option, preset 3 would be updated, color palette 5 would not, and the reference to CP5
would be broken in preset 3.

• {Reset Update} - this button will clear any commands after the [Update] command to
quickly undo pending changes before [Enter] is pressed.

The dialogue box also provides you with a listing (by record target) of what channels/parameters
will be impacted by the update instruction. If the channel contains a reference in the cue, it is
indicated. Channels that have been manually added to the stage output, but are not overrides of
an active cue will update to the selected cue list.

Once you have made a selection from the available options, press [Enter] and the target will be
updated.
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Targets may be deselected from the dialogue box, excluding them from the update without
specifying the target number, for example, [Update] [Color Palette] [Enter]. Selecting a line by
clicking or pressing it can also be used to deselect a target.

Updating to References
When a cue is active, it is possible that various record targets (palettes or presets) will be played
back within that cue. As changes are made to the data in that cue, as well as to the individual
palettes or presets, updating both the cue and references within that cue is simple. When you
have overridden a reference in a cue, the data is displayed in red with a red “R” in superscript
next to the channel’s intensity.

By default, Eos updates any referenced data that was included in the cue.

Example:
Cue 5 is recalled Live. It contains references to color palette 1 and preset 2.
You make changes to channels included in these record targets. To update both
the cue and the palettes/presets, press:

• [Update] [Enter]

This will automatically take the manual changes and update them to color
palette 1 and preset 2. Therefore cue 5 now references these new values, and
the modifications to CP1 and PR2 have propagated through all of the show
data.

If you had made changes to other channels that were not included in the
palettes/presets used in cue 5, those values would also be updated to the cue
as absolute data.

Updating Without References (Make Absolute)
If you want to record your changes to the cue without updating the references, you may use
{Make Absolute} to break the association to the reference. The {Make Absolute} command can
be applied to the channels/parameters required before the update instruction, or they can be
applied during the update.

• [Update] {Make Absolute} [Enter] - this will break the references for any parameters
which have been changed and update the cue with the changes. The referenced target
will no longer be displayed in the channels which were made absolute. All of the data
updated in cue 5 will now be shown as absolute data.

• [5] [Thru] [9] [Update] {Make Absolute} [Enter] - this will break only the references for
channels 5-9 and record their manual values to the cue. Other manual values will not be
included in this update.

You may also use [Record Only] to break references.

Example:
Cue 5 is active and onstage. Channels 5 through 20 are currently referencing
preset 1. You make changes to channels 5 through 9. The data for these
changes is now manual. Press:

• [Record Only] [Enter] [Enter]

If there were other changes on stage, you could have used:
• [5] [Thru] [9] [Record Only] [Enter] [Enter]
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Only the manual data will be recorded as an update to cue 5. The reference to
preset 1 for channels 5 through 9 is broken and now the cue will display the
absolute data rather than the reference indicator.

Update Using Cue Only/Track
The [Q Only/Track] key can be used as an applied exception to the cue only/track system
setting. Therefore if the system is set to Cue Only, the key behaves as a [Track] command.
Alternatively, if the system is set to Track, the key behaves as a [Q Only] button.

For a more detailed summary of Cue Only and Tracking modes, see Tracking vs. Cue Only (on
page 6).

[Q Only/Track] can be used in conjunction with record or update functions. Following are some
examples of use:

Note: In the following examples, the commands [Q Only] and [Track] indicate the
same key hit of [Q Only/Track] - a single button on the keypad. The system setting
determines the actual context of the button. For clarity, only the contextual function of
the button is used in the examples.

With system set to Track
• [Record] <Cue> [5] [Q Only] [Enter] [Enter] - rerecords cue 5. This will make the changes

to cue 5 only. The changes will not track forward through the list.
• [-] [Color] [Record] <Cue> [5] [Q Only] [Enter] [Enter] - as above, but changes to color

parameters will not be included in the record and all data that was included will not track
forward. Color data in the cue remains unchanged.

• [Update] <Cue> [5] [Q Only] [Enter] - updates cue 5 with only those manual parameters
that were receiving their instructions from that cue. The changes will not track forward in
the list. Note that if the data being updated were referenced, this action updates the
referenced target as well.

• [-] [5] [Record] <Cue> [7] [Q Only] [Enter] [Enter] - rerecords the specified cue, except
the contributions from channel 5. The changes will not track forward in the list.

With system set to Cue Only
• [Record] <Cue> [5] [Track] [Enter] [Enter] - rerecords cue 5. This will force the changes

to track forward in the list until the next move instruction or block.
• [-] [5] [Color] [Record] <Cue> [7] [Track] [Enter] [Enter] - rerecords the specified cue,

except the color data from channel 5. The recorded changes will track forward in the list.
• [Update] <Cue> [3] [Thru] [7] [Track] [Enter] - updates cues 3 through 7. Range updates

are subject to the normal rules of track/cue only in determining impact on subsequent
cues.

Using Trace
[Trace] works just as Track does, except it allows changes to be tracked backwards through the
cue list, until it sees a move instruction. A trace will track into, but not beyond, a blocked
instruction.

For a more detailed summary of Trace, see Using Trace (on page 7)

Following are some examples:

• [Update] <Cue> [5] [Trace] [Enter] - updates cue 5, and tracks changes backward until a
move instruction is encountered. If the system is in tracking mode, the change will track
forward in the cue list until the next move instruction or block. If in cue only mode, this has
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• no impact on subsequent cues.
• [Update] [Trace] [Cue Only/Track] [Enter] - updates the selected cue and tracks changes

backward until a move instruction is encountered. If the system is in tracking mode, the
change is prohibited from tracking forward in the list. If in cue only mode, the change is
allowed to track forward.

When a channel that is inactive (at zero or null) in the cue list receives an active level, if
update trace is used, that channel will not trace the current setting into previous cues.
To force that channel's new value to go backward in the cue list, [Trace] [Trace] can be
entered.

Updating the Current Cue
The current cue is updated by simply pressing [Update] [Enter].

When only one cue list is active, this update will include any changes to all channels.

Updating a Source Cue
To update the source of a level in the current cue (therefore, a move instruction in a prior cue)
you must specify a trace for the desired channel(s). See Using Trace (on the previous page)

• [5] [Update] [Trace] [Enter] - Updates any manual changes for channel 5 in the current
cue. Any tracked values for channel 5 are traced back to the source of the value (the
original move instruction) and changed to the new value. The value for traced changes in
the current cue will be magenta indicating it is a tracked value.

• [Trace] [Trace] - If a channel was inactive in the cue (either because it had not previously
been used in the cue list, or it was a tracked zero) and is set to a new level, by default the
new level will not track back. You can force it by pressing [Trace] twice.

Updating a Non-Active Cue
It is possible to use the same update commands as current (Updating the Current Cue (above))
and source cues (Updating a Source Cue (above)) to update inactive cues (cues not live
onstage). In these situations, if the updated cue is not the source of a channel’s live value,
manual data will remain manual. If the updated cue is the source of the current value, the
values will change to magenta (indicating tracked) when the update is completed.

Update [Thru]
Using [Update] [Thru] allows you to update from a current cue to a destination cue without first
entering the current cue's number.

Example:
If you are currently in cue 5 and you want to update through cue 10, you would
use the following syntax:

• [Update] [Thru] <Cue> [10] <CueOnly/Track> [Enter]

Update [+]
[+] can be used to specify a range of cues for updating. [+] can also be used with [Record] and
[Record Only].

Example:
To update only cues 5, 10, and 15:
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• [Update] <Cue> [5] [+] <Cue> [1][0] [+] <Cue> [1][5]
<CueOnly/Track> [Enter]

To update the current cue and cue 7:
• [Update] [+] <Cue>[7] <CueOnly/Track> [Enter]

Note: If no cue number is entered before the [+], the current active cue will be used.

Recording and Editing Cues from Blind
When you press blind, the selected cue will be displayed. You can make changes to cues in the
blind display using either the summary, table, or spreadsheet views.

CAUTION: Edits in blind take effect immediately. [Record] or [Update]
commands are not required in blind.

Note: To force blind to the selected cue, press [Blind] [Blind].

If changes are made in the blind display to an active cue, these changes will not impact the
current stage state. To make blind changes active you can press [Assert] & {Load} button for the
fader associated with the cue, or you can use [Go To Cue] [Enter].

Move instructions can be removed from a cue by selecting the channel and pressing [At]
[Enter]. This allows all values from the previous cue to track into the current cue. You can also
use this command for specific parameters as well.

Example:
Suppose you are in blind cue 5 and you make changes to channels 1 through 5:

• [1] [Thru] [5] [At] [5] <0> {Iris} [3] [5] [Enter]

Intensity goes to 50% and Iris to 35%. You decide to remove the Iris instruction:
• {Iris} [At] [Enter]

The Iris value from the previous cue tracks in. Then you remove the intensity
change as well:

• {Intensity} [At] [Enter]

All values from the previous cue track in.

Instead of using multiple commands, you can, in one command, return the
channels to their values from the previous cue:

• [1] [Thru] [5] [At] [Enter]

The impact of blind edits on subsequent cues is determined by the default setting of Track/ Cue
Only mode. In track mode any changes will track forward until the next move instruction, unless
[Q Only] is pressed. In cue only mode any changes will apply only to the selected cue. If you
want values to track forward, the [Track] button will allow it. The track/cue only instruction
must be applied when a value is entered. [Trace] can also be used to have changes trace back
to the initial move instruction. Such as:

• [1] [Thru] [5] [At] [5] <0> [Q Only/Track] [Enter]
• {Intensity} [At] [Q Only/Track] [Enter]
• [1] [Thru] [5] [At] [5] <0> [Q Only/Track] [Trace] [Enter]
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To Live From Blind
From blind, a softkey {Live} is posted when you press [Recall From] or [Copy To] to allow you to
copy to or recall information from live. The following examples only work with the {Live}
softkey, not the [Live] hard key.

• [1] [Recall From] {Live} [Enter]
• [2] [Copy To] {Live} [Enter]

Editing From Summary or Table Views
Use the [Format] key to cycle through the available views.

Summary view allows you to see the greatest number of channels at once, though parameter
data is somewhat truncated. Channels with focus, color, or beam data are indicated with +
symbols beneath the level data. This view is useful for viewing lots of channel data at once or for
editing primarily intensity values.

Table view grants you greater visibility of parameter data and a reduced number of visible
channels. This view displays channels along the y axis and parameters along the x axis.
Parameter categories are always visible (I, F, C, and B).

You can also view specific parameters by pressing and holding the [Params] button and then
pressing the category softkey(s) for the parameters you wish to view. This will expand the
category to show any parameters used in the show. You can also deselect the parameters you
do not wish to see. This is remembered the next time you go to table view.

Both summary and table views allow you to make changes to channels/parameters.

Editing From the Blind Spreadsheet
The blind spreadsheet is another useful blind view of cue data. While in blind, press [Format] to
access the spreadsheet. See Spreadsheet (Blind Only) (on page 74) for more information.

In spreadsheet view, cues are listed on the y axis and channels/ parameters are displayed on the
x axis. This view is useful for showing a limited number of channels over a span of numerous
cues. This is the only view where channel data of multiple cues can be viewed at once. This
makes spreadsheet view useful for viewing overall trends in channel and parameter data.

Pressing [Params] & {parameter tiles} will expand or collapse information shown.

Editing cue ranges is possible in spreadsheet view. To select all of the cues, you can press [Cue]
[Home] [Thru] [Enter].

Replace With
{Replace With} is used to select channels that have certain specified values and then provide
new instructions for those values.

Example:
Select a range of cues:

• [Cue] [1] [Thru] [9] [Enter]

Select a range of channels that are used throughout these cues and enter a
change instruction:

• [1] [Thru] [7] <At> [Color Palette] [5] {Replace With} <Color Palette>
[3] [Enter]
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This instruction finds all instances of channels 1 through 7 in cues 1 through 9
that are in color palette 5 and replace Color Palette 5 with Color Palette 3. Be
aware of the track/ cue only settings when using this command.

Note: [Cue] [Home] [Thru] [Enter] will select all stored cues within the selected cue
list. [Thru] [Enter] can be used with all record targets.

The range of possibilities of potential {Replace With} commands is virtually endless and can be
applied to single cues or channels, ranges of cues or channels, parameters of any type, or timing
data.

Move To
Move To is used to move cues from one location in a cue list to another location in the same or
a different cue list.

On Element 2, Move To is used to move cues from one location in a cue list to another location
in the list.

Note: To put Move To on the command line, press [Copy To] twice.

When cues are moved, values that were tracks or move instructions and now match the
previous cue will be auto-blocked by the system. The impact on subsequent cues is based on
track/cue only settings as described above. Below is an example of Move To:

• [Cue] [2] Move To <Cue> [9] [Enter] - the contents of cue 2 moves to cue 9. Cue 2 is
deleted. If cue 9 already existed, a confirmation will be required (unless confirmations
have been disabled in setup). Any contents of cue 9 will be replaced entirely.

In the above example, if running in cue only mode, any tracked values in cue 2 become blocks
(see Block (on page 276)) or moves in cue 9, as well as any move instructions which now match
the previous cue. Cues after cue 9 are affected based on the default setting of track/ cue only.
Any values in the cue after cue 2 that tracked from moves in cue 2 are changed to move
instructions.

Ranges of cues can be moved as well. You can also move cues to other cue lists. In either of
these situations if any cue is to be overwritten, a confirmation is required.

See Using Move To (on page 309) for more information.

Using Encoders in Blind
The encoders are disabled by default in blind. Press an [encoder paging key] prior to moving the
encoders, and they will function while you remain in Blind.

When a cue is specified, you can select channels and alter parameters using the encoders. [Q
Only/Track] can be placed on the command line after a selection to determine how these
changes will impact subsequent cues.

Deleting Cues
Cues, lists of cues, or ranges of cues can be deleted. When deleting cues, the track/ cue only
setting of the console will determine how subsequent cues are affected. The [Q Only /Track]
button can be used to modify the default behavior as needed.

Some examples of cue deletion are:
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• [Delete] <Cue> [5] [Enter] [Enter] - deletes cue 5. Subsequent cues in the list are
affected depending on the console default setting.

• [Delete] <Cue> [6] [Q Only/Track] [Enter] [Enter] - deletes cue 6, making exception to
the default setting.

• [Delete] <Cue> [7] [Part] [1] [Enter] [Enter] - deletes part 1 of cue 7. Deleting a part
does not delete any move instructions. Those will be moved to the main cue. See Deleting
a Part from a Multipart Cue (on page 337)

• [Group] [1] [Delete] <Cue> [2] [Enter] - deletes any channels in group 1 from cue 2. Cue
2 remains in the cue list and any channels not in group 1 are unaffected.

• [Delete] <Cue> [2] [Thru] [8] [Q Only/Track] [Enter] [Enter] - deletes cues 2 through 8,
making exception to the default setting.

Deleting In Track Mode
When the console is in track mode, deleting a cue also removes any move instructions provided
by the cue. For example, assume you have stored cues 1 through 10 and cue 5 contains move
instructions for channels 1 through 5. If cue 5 is deleted, the move instructions are deleted as
well and the values from cue 4 will track directly into cue 6 and beyond.

In this instance, if you used the [Q Only] button in the delete instruction, cue 5 would be
deleted, but the tracked values in cue 6 that originated in cue 5 would remain and be converted
to move instructions.

Deleting In Cue Only Mode
When the console is in cue only mode, any subsequent tracked values are not eliminated, but
are converted to move instructions instead.

In the example above, deleting cue 5 (in cue only mode) would result in any tracked values in
cue 6, that originated in cue 5, being converted to move instructions.

If you apply the [Track] button to the delete instruction, the move instructions from cue 5 are
deleted and the values from cue 4 would then track into cue 6 and beyond.

Using the Cue List Index
The cue list index is a blind display list which shows the cue list you are working with, the cue
status, cue list properties, any other stored cue lists, and what (if any) faders the lists are loaded
onto.

When the cue list index is in focus, the following softkeys are available for editing the cue list:
{Partition}, {Autoblock Clean}, {Solo Mode}, {Execute} ,{Properties}, and {Edit}.

Opening the Cue List Index
You can access the cue list index by pressing [Cue] [Cue],[Tab] [1][6], or you can navigate
within the browser to Record Target Lists > Cue List Index and press [Select].

Cue list properties determine how the cue list will interact. Assigned properties will display at
the top of the cue list as well as any currently active show control triggers.

The top half of the cue list index displays all stored cues, including cue list properties, for the
selected cue list. The bottom half of the cue list index displays all stored cue lists and their
properties. The selected cue list is highlighted.

Using the mouse, you can move the barrier between the stored cue display (top) and the stored
list display (bottom). Hover the mouse arrow over the list boundary until it changes to the move
boundary icon. Then click and drag the boundary up or down to the desired height.



Single Cue Lists 289

Command Line Behavior for Cue List Index
The command line while in the Cue List Index defaults to cue list selection. The softkeys that
display will default to cue list control.

[Next] and [Last] will select the next or last cue list if no cue list or a cue list but no cue is on the
command line.

When a specific cue is selected, [Next] and [Last] will move through the cues in that same list,
and the softkeys will change to be for a single cue control.

Partitions on Cue Lists
A partition (About Partitioned Control (on page 496)) may be assigned to a cue list. If a partition
has already been applied to a cue list, any channels not in the cue list's partition will not be
included in cues when they are stored or replayed.

Any data for a cue list that already existed before a partition is applied, will be maintained,
including data for channels not included in the partition. If data existed before the partition was
assigned, in blind, channels that are not in the partition will display without a channel graphic,
any levels will be in gray, and a small superscript N will display with it.

Assigned partitions will display at the top of the cue list index and in the PSD.

To assign a partition to a cue list:

• [Cue] [n] [/] {Partition} [n] [Enter]

To remove a partition from a cue list:

• [Cue] [n] [/] {Partition} [Enter]

Solo Mode

Note: This feature is not available on Element 2.

The {Solo Mode} softkey is useful in multiple programmer situations. {Solo Mode} is used to pull
a cue list out for editing purposes after it has been synced with other cuelists.

Example:
Cue List 1 is being used by one programmer and Cue List 2 was programmed by
a second programmer. For the run of the show, the lists are synced so they run
together. But if changes need to be made to Cue List 2 and not be affected by
the playback of Cue List 1, {Solo Mode} can be used.

• [Cue] [2] [/] {Solo Mode} [Enter] - places Cue List 2 into solo mode.

{Solo Mode} is a toggle state. So if Cue List 2 is already in solo mode, and [Cue] [2] [/] {Solo
Mode} [Enter] is used again, that list will no longer be in solo mode.

Auto-block Cleanup
{Autoblock Clean} is used to remove all auto-blocks from a single cue, cue range or entire cue
list. {Autoblock Clean} is a softkey that will be posted when a cue list and / or cue number are
on the command line in the Cue List Index, Live, and Blind. A range of cues or a cue list can be
specified with this command. For more information about auto-blocks, see Auto-block (on
page 277)

• [Cue] [1] [/] {Autoblock Clean} [Enter] - clears all auto-blocks from cue list 1. Only blocks
displayed with the white underscore are removed. If the [Block] key was previously used,
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• this command will not unblock it.
• [Cue][1] [/] [1][0] [Thru] [1][0][0] {Autoblock Clean} [Enter] - clears the auto-blocks just

from cues 10 through 100 of cuelist 1.

Edit
The {Edit} softkey opens a blind channel view of the selected cue and changes focus from the
cue list index. You can change the blind display to spreadsheet or table view by pressing the
[Format] key. You can edit any of the cue attributes for the cue selected in the index, but the
cue contents must be edited in the blind display. See Recording and Editing Cues from Blind (on
page 285).

Cue List Index Configuration
The Cue List Index has a configuration menu, which is accessed by first selecting the Cue List
Index tab and then double clicking on the tab to open the menu. With the Cue List Index
selected, you can also select the gear icon, which is located by the tabs, to open the
configuration menu.

The following options are available in this configuration menu:

• Display Cue Parts - displays the individual parts of a part cue. When not enabled, the
number of parts for that cue will display as a superscript number beside the cue's number.

• Display Cue Links - displays the Link / Loop information.
• Display Scenes - displays cue scene information.
• Display PSD Time Countdown - displays the cue category times countdown in the PSD as

a cue is fading.
• Display Cues - displays the top half of the cue list index, which shows all the stored cues.

This option is not available on Element 2.

Reorder Columns
Reorder columns allows you choose what data displays in the top and bottom halves of the Cue
List Index and what order it displays in. To make changes to the top half, select {Cues}. To make
changes to the bottom half, select {Cue List}.

By default, all columns except notes will be displayed. The arrow keys on the right can be used
to move columns around. Columns with multiple options are moved in groups. To select a
column header to move, click or tap the name. The check boxes suppress or enable. When an
item is enabled to display, a check mark will be in the corresponding box.
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Default
The Cue List Index takes its default settings from the Playback Status Display. The default is
identified with parentheses. See Playback Status Display Configuration (on page 85) for more
information.

• Reset to Default - returns the settings to the default state that you created.
• Reset to Eos Default - returns all settings to the Eos defaults.

Cue List Properties
When the cue list index is open, the cue list properties dialogue box will display in the CIA. The
cue list properties determine how the cue list will interact.

On Element 2, the cue list cannot be assigned to a fader. These settings will only impact the
master fader pair.

Cue list properties include:

• Master type (Proportional, Manual Master, or Intensity Master)
• Intensity HTP or LTP setting (default is LTP)
• Assert
• Priority
• Background
• Background Priority
• Phantom
• Back from 1st
• Go from Last
• Stomp
• Exclude
• Channel Filters
• Parameter Filters

Faders can be mapped to a cue list in the fader configuration display or by using [Load], see
Selected Cue for more information. If a fader has been configured for default mapping ( see
Fader Configuration (on page 101) for more information), the fader will receive its configuration
from the Cue List Index. Changes made to a cue list in the cue list index will be shared with any
default mapping faders loaded with that cue list. If changes are made to a fader set to default
mapping in the fader configuration display, those changes will also happen in the Cue List Index.
If set to Local, any changes made in the fader configuration display will impact only that
instance of the content.

Master
A fader can be assigned as a Master. When it is a master, its behavior as a Proportional Master,
Manual Master or Intensity Master (I-Master) is drawn from this setting.

• Proportional faders, when the slider is set to zero prior to the execution of a cue, will
withhold playback of intensity data until the fader is raised. Intensity data will then be
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• played back proportionally according to the level of the fader. Once the fader reaches full,
the cue is considered complete and the cue is released from the manual fader. If the fader
is at any value other than zero when the cue is executed, intensity values will play back
normally. If the slider is returned toward zero, intensity in the cue will fade to the previous
level.

• Intensity Masters will master the intensity level for cues during playback. Therefore,
intensity masters set below 100% will proportionally limit playback of intensity data
relative to the level that the fader is set. All non-intensity parameters are unaffected by
the fader. Once the fader has reached full, control of intensity is retained. If the fader is
moved toward zero, intensity will proportionally fade toward zero (not the previous state
as per proportional faders).

• In Manual Master mode, cues are triggered manually by faders without using the [Go]
button. With a cue list on a fader set to manual master, a cue will fire in manual time
when the fader is moved from 0% or from Full. Timing is scaled. So, if color has a 5 count
delay, and the duration of the cue is 10, the color transition will not begin until the faders
manually reach 50%. Follow and hang times will be ignored when firing a cue with a
manual master fader.

HTP
Intensity playback behavior can be set to HTP (highest takes precedence) or LTP (latest takes
precedence). For cues, it defaults to LTP.

Assert
Assert can be turned on or off at the fader level. This property sets the entire cue list to be
asserted on playback (even track instructions are replayed).

Priority
Priority is used to protect values from being affected by submasters or playback faders that have
a lower priority level. They will, however, still be impacted by manual control, grandmaster,
blackout, park instructions, or other playback faders and submasters at the same or higher
priority.

There are 10 levels of Priority that cue lists can have. 1 is the lowest level and 10 is the highest.
The default priority level is 4.

Background
Background can be enabled or disabled at the fader level. When enabled, the content of the
cue list will act as a background or previous state for other cues and submasters. When a cue list
has its background state disabled, a “D” will display in the Cue List Index background column.

Background Priority

Background can have a priority assigned to it.

In previous software releases, when content was released, it always returned to the last fader
that owned it. Background priority releases to the highest priority content that previously had
ownership, provided that content has not be turned off or released.

There are 10 levels of background priority. 1 is the lowest level and 10 is the highest. The
default background priority level is 4.

Phantom
When a cue list is set to Phantom, pressing [Go] will not change the selected cue on the
command line, or an unlocked playback status display.
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Back From First
Back From First controls the behavior that happens when you press the [Back] button while in
the first cue.

The following are Back From First options:

• Do Nothing - keeps the first cue active.
• Cue Out(Default Setting) - only fades out channels in that cue list. Other channels will

remain. Intensity and non-intensity parameters will be homed. This setting uses the Back
time for fading.

• Wrap - puts the last cue in the list in pending, and fires said cue.
• Restore Background - any background cue, submaster, and effect levels are restored

following background priority. Manual levels will not be restored. This setting uses the
Release time set in Setup. See Manual Control (on page 178) for more information.

Go From Last
Go From Last controls the behavior that happens when you press the [Go] button while in the
last cue.

The following are Go From Last options:

• Do Nothing (Default Setting) - keeps the last cue in the list active.
• Cue Out - only fades out channels in that cue list. Other channels will remain. Intensity

levels will go out. Non-intensity parameters will remain. This setting uses the Go to Cue
timing for fading.

• Wrap - puts the first cue into pending, and fires it.
• Restore Background - any background cue, submaster, and effect levels are restore

following background priority. Manual levels will not be restored. This setting uses the
Release time. The pending cue will be set to the first cue in the list. If there is no
background state, the non-intensity parameters will not fade.

Stomp Mode
Stomp refers to when all the content owned by a cue is now being controlled by other targets.
The cue is being removed from the background, and once that happens, it would not be eligible
to fade back. You can assign behavior that will happen when a cue is stomped.

The following are Stomp Mode options:

• Off When Stomped - puts the content into an off state, the same behavior encountered
when pressing [Off] + [Load].

• Unload When Stomped - unloads the fader.
• Nothing When Stomped (Default Setting) - nothing happens.
• Release When Stomped - resets a cue list to the top of the list.

Exclusions
Those exclusions include:

• Exclude From Record - output is not recorded into any other record target.
• Exclude From Grandmaster - content cannot be mastered by a grandmaster.
• Exclude From Inhibitive Sub - content cannot be mastered by an inhibitive submaster
• Exclude From Solo - content will ignore solo button mode. See Fader and Button

Configuration (on the next page) for more information on solo.
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Channel and Parameter Filters
Channel and Parameter Filters can be used to allow only specified data to be played back.
These are playback filters, and do not impact how data is recorded.

For cue lists, channel and parameter filters can be set in the following areas:

• Cue List Index using the {Properties} softkey
• In Fader Configuration (Tab 36)
• In Live using the {Properties} softkey

Tap or click on {Chan Filter} to assign channels or groups. Tap or click on {Param Filter} to open
a list of available parameters that you can filter.

Note: Filters will travel with their assigned cue lists wherever they are mapped.

When a filter has been applied, an indicator will display in the fader ribbon. C will display for
channel filter, and F is for parameter filter.

Press the red [X] to clear the channel or parameter filters listed.

Fader and Button Configuration
Click or tap on the virtual buttons or fader to see a list of available configuration options.

Button Options
The following options are available for playback buttons:

• Go - executes the cue currently in the pending file of the associated fader.
• Stop Back - instantly stops all fader activity. Pressing twice will fade to the previous cue on

that fader.
• Assert - can be used to re-run the active cue on that fader, to regain control of all cue

contents, to apply a newly set higher priority state to the associated fader, or make any
changes in blind to an active cue on stage.

• Group Select - selects the channels stored in the cue.
• Freeze - halts all effect activity on the fader. Press Freeze again to resume effect activity.
• Off - removes the content and if the fader is set to Master, the fader will remain where it

currently is.
• Release - removes the content and if the fader is set to Master, the fader will reset to 0.
• Start Stop Effect - starts the effects while ignoring dwell times. Will stop effects if any are

running.
• Button Disabled - no action is assigned to the button.
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• Solo - plays back the content and suppresses any intensity values not provided by the
associated content while the solo button is held down. When the button is released,
intensity values are restored. Priority and HTP are ignored. Shielded, park and pixel
mapping outputs are not affected by the solo button. This is unrelated to Solo Mode.

• Back - fades to the previous cue.

Fader Options
The following options are available for a playback fader:

• Master - fader will be a proportional master, a manual master, or an intensity master,
depending on the cue list property.

• Effect Rate - fader centers to home. It controls the rate of any running effects (same
behavior as using rate via the Effect Status Display). The adjusted setting from this control
cannot be stored.

• Effect Size - similar to Effect Rate but for effect size.
• Rate Master - homes to center. It adjusts the cue rate, just like rate and load.
• Down Fade - same as the default behavior of the master option.
• Fader Disabled - no action is assigned to the fader.
• Master Only - fader is used to set a level for content to fade to. The slider can be used to

live adjust levels when the fader has been activated via the bump button. See Master Only
(on page 106) for more information.

• Effect Master - masters the entry/exit mode of the effects (size, rate or both).
• Levels Only - masters the levels without mastering the effect.



296 Eos Ti, Gio, Gio @5, Ion Xe, Ion Xe 20, and Element 2 Operations Manual



Filters 297

Chapter 13
Filters

About Filters 298

Record Filters 298

Partial Filters 298

Clearing Filters 299

Storing Data with Record Filters 299



298 Eos Ti, Gio, Gio @5, Ion Xe, Ion Xe 20, and Element 2 Operations Manual

About Filters
Filters are used to determine which parameters can be stored to cues, palettes, and presets. The
filter selection tool in the CIA affects record operations as long as the filters are set.

Note: Channel and parameter filters can be applied to faders and submasters. Those
type of filters affect playback and not record functions.

Record Filters
Record filters are used to select specific parameter data to store to record targets. When no
filters are selected, all parameters can be stored, as appropriate to the [Record], [Record Only],
and selective record action used.

Note: When storing show data, applied filters are highlighted and allow the
associated parameters to be stored in record targets.

Note: When filters are deselected (not highlighted), they prohibit storing the
associated parameters.

Note: There is no difference between having all filters selected and having no filters
selected (default). In either state, all parameters are available for recording.

Record filters are applied from the CIA using the following buttons: {Filter}, the parameter
buttons in the CIA, and the parameter category buttons.

The parameter category buttons can be used to select filters, as follows:

• Intensity (enables recording intensity data)
• Focus (enables recording pan and tilt)
• Color (enables recording color data)
• Beam (enables recording all beam data)

To apply record filters by category:

1. Press and hold {Filter}. The parameter buttons change to display filter selection.
2. Press the parameter category softkey {Intensity/Focus/Color/Beam} for the category you

want to include in the record target. All parameters in that category will be highlighted
and “Filter On” will appear above the softkey.

3. Release {Filter}. The buttons return to their normal appearance.

In subsequent record functions, only the filtered categories will be recorded. You may apply
multiple category filters at once. Remember that applying all filters and no filters yields the
same effect.

Partial Filters
If you do not want an entire category to be recorded, you may apply parameter specific filters
(partial filters) instead.

To apply partial filters:

1. Press and hold {Filter}. The parameter buttons change to display filter selection.
2. Press the parameter button (for example {Zoom}) for the parameter you want to include in

the record target. That parameter will be highlighted and “Filter On” will appear above
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the softkey.
3. Release {Filter}. The buttons return to their normal appearance.

In subsequent record functions, only the filtered parameters will be recorded. You may apply as
many partial filters at once, as you wish. Any unfiltered parameters will not be included in
record actions. In Live, unfiltered parameter data is displayed in gray, with an “N” (indicating
null data) in the upper right corner of the parameter’s field.

Clearing Filters
Applying filters is a toggle state. To clear any filter, simply repeat the application process
described above. When pressed again, any applied filter will be removed.

To clear all filters at once:

1. Press and hold {Filter}. The parameter buttons change to display filter selection. {Clear
Filters} appears in the upper left corner of the parameter buttons.

2. Press {Clear Filters}. Any applied filters will be removed and the highlights will turn off.
3. Release {Filter}. The buttons return to their normal appearance. All parameters are now

available to record functions.

Storing Data with Record Filters
If a record target is stored with filters in place, the filters allow only associated parameter data
to be recorded in the target. Non-filtered data is not included when you record.

The various record targets are affected by filters in the following ways:

• Palettes - Palettes by definition are already filtered. The color and beam filters can be
used to further modify what is stored in the color and beam palettes, however.

• Presets - Active filter settings impact what is stored in presets.
• Cues - Active filter settings impact what is stored in cues, even when using “record only”

commands.
• [Recall From] - Recall from instructions are not affected by the filters.
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About Working With Multiple Cue Lists
Eos provides many useful tools to allow you to work efficiently and simultaneously with multiple
cue lists. These topics focus on the features and methods used when working with more than
one cue list.

Note: This feature is not available on Element 2.

Solo Mode and Cue List Properties are topics covered in the Single Cue List chapter that are also
useful when working with multiple cue lists. Additional information about working with a cue list
can be found in About Single Cue List (on page 264).

Partitions can be especially useful when working with multiple cue lists. See About Partitioned
Control (on page 496) for more information.

Recording to a New Cue List
When recording cues, cue list 1 is initially used as the default cue list. Cue list 1 is displayed with
only the cue number. It does not have a lead cue list number or a “/”. To record to another cue
list, that list must be specified. Cues will then be recorded to that cue list until another list is
specified, or until the selected cue is changed in Live.

You may record up to 999 cue lists in an Eos show file.

The cue list that you are storing to is always determined by the selected cue, unless you specify
a different cue list. The selected cue is displayed in the command line, in the PSD, and at the
bottom of the Live/ Blind screen.

The selected cue is the last cue that you affected in Live. This includes a record, an update, a
playback action such as [Go], [Back], a [Go To Cue] instruction, or simply changing a cue
attribute.

Note: It is very useful to keep an eye on the selected cue.

Pressing [Live] will resync to the active cue.

Using Record
[Record] will record all parameters of any channels that have non-home values to a specified
cue.

To record to a new cue list press:

• [Record] <Cue> [2] [/] [5] [Enter] - this will create cue list 2 and will record the data to
cue 5 in that cue list.

Any cues recorded after this will automatically record to cue list 2 until another cue list is
specified or the selected cue changes the cue list number.

Record Via Load
You can record a cue 1 to the next unused cue list by using the [Load] button for an unmapped
fader. [Record] [Cue] [Load] will create a cue 1 in a new cue list and will map that cue list to
the fader. Subsequent cues can also be recorded with [Record] [Load], which will record to the
next available cue within that cue list



Multiple Cue Lists 303

Using Record Only
[Record Only] can be used to create a new cue list instead of [Record]. [Record Only] stores
only manual data to the specified cue.

To record to a new cue list press:

• [Record Only] <Cue> [2] [/] [5] [Enter] - this will create cue list 2 and will record all
manual data to cue 5 in that cue list.

The cue list display will change to show only data from cue list 2. Any cues recorded after this
will automatically record to cue list 2 until another cue list is specified or the selected cue
changes the cue list.

Make Manual
This softkey can be used to convert live cue or submaster data into manual values, allowing
them to be included in the [Record Only] operation. Therefore data from other cues or lists can
be selectively converted to manual data and then stored to another cue/list using [Record Only].

For more information on {Make Manual}, see Using {Make Manual} (on page 312).

Using Assert
Note: There are two [Assert] buttons. This section uses the [Assert] button that is located in
the main control keypad.

By default, channel parameters only respond to move instructions during playback . The [Assert]
function allows tracked or blocked data from a cue to be replayed, even when another cue list
has taken control of that channel/ parameter (see Cue List Ownership (on page 8)).

Assert can be applied to cues, cue parts, channels, channel parameters, or to entire cue lists.
Asserted channels will play back their tracked and blocked values, regardless of cue list
ownership, when the associated cue is replayed.

At a Cue Level
When applied at a cue level, [Assert] ensures that all data in the cue, both moves and tracks,
will be played back at their stored values.

To place an assert on a cue:

• [Cue] [x] [/] [y] [Assert] [Enter] - the cue will assert all of its channels upon playback. An
“A” will be displayed in the “A” column of the cue attributes (cue index, playback status,
and so on); indicating the cue has been asserted.

Assert can also be used from the command line to manually replay portions of a cue without
having to replay the entire cue. Assert in this mode can only be used with cues that are currently
active.

To place an assert on a portion of a cue:

• [Group] [6] [Assert] [Enter] - asserts the instructions for the channels in group 6 in cue 4.

This would then need to be stored using either [Record] or [Update].

At a Cue List Level
When applied at the cue list level, [Assert] ensures that all values in all cues in that list are
asserted on playback. When a cue list has been asserted, the playback status display will show
an "A" in the assert column for every cue in that list.

To place an assert on a cue list:
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• [Cue] [x] [/] [Assert] [Enter]

At a Channel Level
When applied at a channel or parameter level, assert ensures that the entire channel or the
specified parameter will be played back at its stored value.

To place an assert on a channel or group of channels:

1. [select channels] [Assert] [Enter] - a red “A” will appear next to all of the channels’
parameters in the Live/ Blind display. This indicates the assert is placed, but not yet
recorded to a cue.

2. [Record] <Cue> [x] [Enter] - the red “A” turns to blue in the Live/ Blind display, indicating
the assert has been recorded. In the cue x row of the playback status display or the cue list
index, a lower case ‘a’ appears in the “A” column, indicating that a partial assert is
included in cue x.

You may also store this assert using [Update] or you can apply it in Blind.

To place an assert on specific parameters:

1. [select channels] {Intensity / Focus / Color / Beam} or {parameter buttons} [Assert]
[Enter] - places an assert on the specific parameters of the selected channels.

2. [Record] <Cue> [x] [Enter] - the assert is recorded to cue x. In the cue x row of the
Playback Status Display or Cue List Index, a lower case “a” appears in the “A” column,
indicating that a partial assert is included in cue x.

Assert is a very useful tool allowing channels that have been seized by other cue lists to be
repossessed by the associated cue list, while still allowing the asserted channel data to be
treated as tracked instructions.

Using Allfade
Allfade is a cue attribute that commands any intensity values on stage that are not provided by
the associated cue to fade to zero intensity when the cue is played. The allfade will adhere to
the downfade time of the associated cue.

This is useful in conjunction with assert, so you can regain control of channels from other cue
lists and fade other channels from that cue list out.

Note: Channels with tracked values in the associated cue will not fade out in
response to an allfade. These tracked values are part of the associated cue and
therefore will be played back.

To assign an allfade to a cue:

• [Record] <Cue> [2][/][5] {Attributes} {AF/MF} [Enter] - records cue 2/5 as an allfade cue,
thereby forcing any channels not in the cue to fade to zero on playback.

Like many other cue attributes, allfade is a toggle state. To remove the allfade flag, specify the
cue and press {Attributes} {AF/MF} [Enter].

For more information on allfade, see AllFade (on page 277)

Changing the Active Cue List
The active cue list will be displayed in detail on the Playback Status Display and the Cue List
Index.

This view is changed by the following actions:
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• Recalling another cue list in the command line - [Cue] [3] [/] [Enter]
• Recording a cue to another cue list - [Record] <Cue> [3] [/] [8] [Enter]
• Playing back a cue from the fader of another cue list - press [Go] for the associated fader.

Note: The split Playback Status Display allows detail for two cue lists. Both or either
of these can be locked. Playback Status Display (on page 81)

Note: For information on using out of sequence sync, {OOS Sync}, see OOS Sync (on
page 279).

Most Recently Activated Cue
Use [Cue] [n] [/] [Enter] to select the most recently activated cue from that cuelist. If there is no
active cue from that list, the first cue in the cuelist will be used.

Using [Go To Cue] with Multiple Cue Lists
[Go To Cue] defaults to the currently selected cue list. [Go to Cue] is a live function. It can not
be used to change cues in blind. [Go to Cue] instructions can be executed from any operating
mode, without returning to live.

By default, a Go to Cue instruction is an out-of-sequence cue and will follow the rules of such
(see Out-of-Sequence Cues (on page 322)).

For examples of how to use [Go To Cue] in playback, see Go To Cue (on page 322).

Using Go To Cue 0
[Go To Cue] [0] is a command line instruction that resets all intensity values not owned by
another fader to default, including any manual values that are not an override to another active
fader value. [Go To Cue] [0] [Enter] also resets the selected cue list to the top of the list, with
the first cue pending.

To [Go To Cue] [0] on another cue list, press:

• [Go To Cue] [2] [/] [0] [Enter]

Note: Eos has an added intensity parameter for LED fixtures, that by manufacturer
default have only RGB parameters but no intensity parameter. With this added control,
the LED fixture will respond to the [Go To Cue] [0] command.

Captured channels, priority values and values from other faders running a different cue list are
not affected by a [Go To Cue] [0] command.

When [Go To Cue] [0] is executed, any intensity values owned by the associated cue will fade
out, while all non-intensity parameters remain in the current state. A [Go To Cue] [0] instruction
does not impact the input from other programmers using partitioned control, unless the
channels/parameters are shared.

[Go To Cue 0] & [Load]
The [Go To Cue 0] , located with the playback controls, in conjunction with a fader load button
to send a specific cue list to cue 0. This action does not use the command line. On the desired
fader, simply press:

• [Go To Cue 0] & [Load]
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Using Go To Cue Out
To reset all parameters to their default state (unless they are controlled by a submaster) and
reset all cue lists that are loaded to faders so that the first cue of each list is pending, press:

• [Go To Cue] [Out] [Enter]

Note: The [Go to Cue] [Out] command will not affect a cue list that is in Solo Mode
(on page 289)
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About Advanced Manual Control
This section describes some advanced features for manual control functions. These features can
save you valuable programming time.

For additional manual control functions, see About Manual Control (on page 188) .

Using [Copy To]
[Copy To] allows you to copy all data from one channel to another, either within the current
working mode or to a different record target. [Copy To] works much like [Recall From], but in
the opposite direction, [Copy To] forces data to a channel from the selected channel, whereas
[Recall From] pulls it from a channel to the selected channel. For information on using [Recall
From], see Using [Recall From] (on the facing page)

By using the IFCB category buttons or parameter buttons, you may copy subsets of channel data.
Entire cues, cue ranges and cue lists can be copied to other locations. To only copy over intensity
and parameter levels, use the {Only Levels} softkey. This will exclude discrete timing
information.

To copy over data from only active channels, use the {Only Active} softkey.

When referenced data is copied, if the copy target also has data in the reference that is being
copied, the target will be placed in that reference (such as, color palette 1), at its stored values.
If the copy target is not included in the reference, absolute data will be copied to the target, and
not the reference.

Below are some examples of copy commands from record targets. This command is very
versatile and the following list is far from exhaustive:

• [2] [Copy To] [Cue] [5] [Enter] - copies all information for channel 2 to cue 5.
• [2] [-] {Focus} [Copy To] [Cue] [5] [Enter] - copies all parameter data for channel 2, other

than focus, to cue 5.
• [Group] [3] [Copy To] [Preset] [6] [Enter] - copies current information for group 3 to

preset 6.
• [3] [Copy to] [6] [Cue] [8] [Enter] - copies the data from channel 3 to channel 6 in cue 8.
• [3] [Copy to] [4] [Thru] [9] [Enter] - copies the data from channel 3 to channels 4 through

9.
• [3] [Copy to] [8] [Cue] [2] [/] [1] [Cue Only/Track] [Enter] - copies the data from channel

3 to channel 8 in cue 2/1 and takes exception to the track/ cue only settings in regard to
subsequent cues in cue list 2.

• [Cue] [2] [/] [Copy to] [Cue] [7] [/] [Enter] - copies all of the contents of cue list 2 to cue
list 7.

• [Cue] [1] [/] [1] [Thru] [1] [0] [Copy To] [Cue] [5] [/] [5] [Enter] - copies cues 1 through
10 from cue list 1 to cue list 5, starting with cue 5.

• [1] [Copy To] [2] [0] {Only Levels} [Enter] - copies only the intensity and parameter
information from channel 1 to channel 20.

• [1] [Copy To] {DMX} [2] - copies the DMX value from channel 1 to channel 2.
• [1] [Copy To] [2] {From Absolute} [Enter] - sets channel 2 to channel 1's absolute level.
• [1] [Copy To] {Live} [Enter] - copies channel 1's level to the live output.

In Live, you can use [Sneak] with [Copy To] to fade in the change.

Example:
• [1][2] [Copy To] [2] [Sneak] <Time> 7 [Enter]
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Copies the recorded data from channel 12 to channel 2 and sneaks it in 7
seconds.

Using the {HTP} softkey with [Copy To] will cause any intensity levels to be ignored if they are
less than or equal to the copied value.

Example:
Channels 1 and 2 are at 50% in cue 10, and in cue 11 channel 1 is at 10% and
channel 2 is at full. If you are in cue 11, and use the syntax:

• [1] [Thru] [2] [Copy To] [Cue] [1][0] {HTP} [Enter]

Channel 1 will remain at 50% and channel 2 will go to full.

Using Move To
While technically not a manual control instruction, Move To will be very useful when managing
record target data stored from manual control.

When a Move To command is given, data is removed from its current location and moved to its
new location. If the new location already contains data, a confirmation is required by Eos (unless
disabled in Setup). See Record Defaults (on page 177). Existing data in the new location will be
completely overwritten if a Move To command is confirmed.

Press [Copy To] [Copy To] to access Move To.

The following are examples of using Move To:

• [Color Palette] [1] Move To <Color Palette> [5] [Enter]
• [Preset] [3] Move To <Preset> [8] [Enter]
• [Cue] [9] Move To <Cue> [2] [Enter]
• [Snapshot] [4] Move To <Snapshot> [7] [Enter]
• [Preset] [1] Move To [Color Palette] [3] [Enter]
• [Int Palette] [5] Move To [Preset] [1] [0] [Enter]

When using Move To to convert a preset into a palette, all information not relevant for that
palette will be removed.

Copy To and Move To for Labels, Scenes, and Notes
The [Copy To] and Move To ([Copy To][Copy To]) commands can be used to copy or move
labels between any target types that can have labels. A {Labels Only} softkey will display.

• [Sub] [1] [Copy To] [Sub] [3] {Labels Only} will copy submaster 1's label to submaster 3.

Labels, scenes, and notes can be copied or moved between cues. The {Labels Only}, {Scene
Only}, and {Notes Only} softkeys will display.

• [Cue] [3] Move To [Cue] [6] {Notes Only} will move the note from cue 3 to cue 6.

Using [Recall From]
[Recall From] is similar to [Copy To], except that it retrieves data from other locations, and can
be used only for a channel list recalling from the same channel list but in a different location (for
example, a cue). [Recall From] is essentially a “copy from” command. For information on using
[Copy To], see Using [Copy To] (on the previous page)

All parameter data for selected channels will be recalled, or by using the IFCB category buttons
or parameter buttons, you may recall subsets of channel data. To recall only levels and not
effect, timing, mark or other non-level data, use the {Only Levels} softkey.
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To recall data from only the active channels, use the {Only Active} softkey.

In Live, you can use [Sneak] with [Recall From] to fade in the change.

Below are some examples of recall commands from record targets:

• [2] [Recall From] [Cue] [5] [Enter] - recalls all recorded data from cue 5 for channel 2.
• [2] [-] {Focus} [Recall From] [Cue] [5] [Enter] - recalls all data for channel 2 from cue 5,

except focus (pan/tilt - XYZ) data.
• [Group] [3] {Color} {Focus} [Recall From] [Preset] [6] [Enter] - recalls the color and focus

information from preset 6 for the channels in group 3. Could also be used with a channel
selection set instead of a group.

• [Group] [3] {Color} [Recall From] [Cue] [7] {Make Absolute} [Enter] - recalls color data
for group 3 from cue 7 and breaks any references to record targets.

• [2] [Recall From] [Sub] [4] [Enter] - recalls all recorded parameter data from sub 4 for
channel 2.

• [Recall From] [Intensity Palette] [1]- recalls all of the values stored in intensity palette 1.
• [1][0] [Recall From] [Cue] [2] [Sneak] <Time> 7 [Enter] - would recall the recorded data

that cue 2 has for channel 10 and sneak it in 7 seconds when used in live.
• [Recall From] [Cue] [1][0] {Only Active} [Enter] - recalls data from only the active

channels, which are those channels with intensities above 0, if no channel selection had
been previously made.

• [Recall From] [Cue] [2] [Enter] - would result in a selection of the channels used in that
cue and their values. Any channels that are used in the cue list but do not currently have
an intensity in the recalled from cue will be set to zero. Pressing [At] afterwards would
post a numeric list of those channels to the command line.

In Live or Blind, hitting [Recall From] [Recall From] will put [Recall From] [Cue] on the
command line.

Using the {HTP} softkey with [Recall From] will cause any intensity levels to be ignored if they
are less than or equal to the recalled value.

Example:
Channels 1 and 2 are at 50% in cue 10, and in cue 11 channel 1 is at 10% and
channel 2 is at full. If you are in cue 10, and use the syntax:

• [Recall From] [Cue] [1][1] {HTP} [Enter]

Channel 1 will remain at 50% and channel 2 will go to full.

Recall From Park
You can use [Recall From] [Park] to set a channel or parameter to the same level as the current
park value.

Example:
Channels 1 through 5 are parked at 55. To recall that level to channels in live or
blind, use the following syntax:

• [1] [Thru] [1][5] [Recall From] [Park] [Enter]

Channels 1 through 5 will be set to 55 and channels 6 through 15 will be
unaffected.

For more information about using Park, see About Park (on page 364)

Note: This does not release the Park buffer.
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Using {Make Null}
The {Make Null} softkey can be used to withhold parameter data from record or update actions
in live, and remove parameter data from record targets in Blind. {Make Null} is applied using
channel selection and can impact entire channels, individual parameters, or parameter
categories.

Make Null In Live
When you apply a {Make Null} instruction to channels or parameters in Live, channel data is still
visible onstage, but that data is essentially rendered invisible to record commands. Similar to
filters (see Record Filters (on page 298)), {Make Null} acts as an “ignore” instruction in Live, not
a remove instruction. When channel data is nulled, the values for that data in the live display
turn grey and an “N” appears next to the data field.

{Make Null} differs from Park in that you can still manipulate data onstage (through manual
control or through playback) but that data will be unavailable for record actions.

Some examples of using {Make Null} in Live are:

• [1] [Thru] [5] {Make Null} [Enter] - converts all parameters of channels 1 through 5 into
null data.

• [2] {Color} {Make Null} [Enter] - changes only color data for channel 2 to null data.
• [9] [Thru] [5] {Pan} {Make Null} [Enter] - changes only the pan data for channels 5

through 9 to null.

Null instructions are lifted in two different ways. First, as {Make Null} is a toggle state, it is
possible to reselect the channel and parameter followed by {Make Null} [Enter]. This lifts the
null state.

Additionally, a [Go To Cue] instruction will remove the null state.

Make Null In Blind
When applied in Blind, {Make Null} can be used to mask instructions in a cue after it has
already been stored. A {Make Null} instruction can also be applied to channels/ parameters in
palettes, presets, and submasters, thereby removing the data from the target entirely, in the
same way that [At] [Enter] does.

When applied to channels/ parameters in cues, {Make Null} doesn’t remove the data from the
cue, it simply makes it unavailable for playback. It has the same effect on move instructions that
it has on tracked values.

Some examples of using {Make Null} in Blind are:

• [Color Palette] [1] [Enter] [3] {Magenta} {Make Null} [Enter] - removes all magenta
parameter data for channel 3 from color palette 1.

• [Preset] [5] [Thru] [9] [Enter] {Intensity} {Make Null} [Enter] - removes all intensity data
for all channels in presets 5 through 9.

• [Cue] [8] [Enter] [2] [Thru] [7] {Make Null} [Enter] - nulls all data for channels 2 through
7 in cue 8.

• [Cue] [9] [Enter] {Intensity} {Make Null} [Enter] - nulls all intensity data for all channels in
cue 9.

In the cue scenarios above, {Make Null} differs from using [At] [Enter] in that instead of
allowing values established in previous cues to track in, {Make Null} both restricts the recorded
data from playing back and prevents other values from tracking in. Therefore, if the cue were
executed as an out-of-sequence cue or asserted, no data would play back or track in for any
nulled values.
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Release
Release is an extension of the {Make Null} command in Blind. When Release is used, it behaves
like Make Null, but it also releases the channel and parameter data to its background state, if
one is available, or fades out the intensity instead.

Release can be used to mask instructions in a cue after it has already been stored. The data is
not removed from the cue.

Release is applied in Blind by using the {Release} softkey or by using the [Release] hardkey.

• [Cue] [3] [Enter] [2] {Release} [Enter] - releases all data for channel 2 in cue 3.
• [Cue] [2] [Enter] [3] {Color} [Release] - releases the color data for channel 3 in cue 2.

Note: Release tracks forward through a cue list until the Release command is
removed or a move instruction happens.

When release has been applied, the released content will display in gray with a R in Blind.

A Release flag will also appear in the Playback Status Display and the Cue List Index.

Using {Make Manual}
The {Make Manual} softkey can be used to convert cue or submaster data into manual values,
allowing it to be included in [Record], [Record Only], and [Update] operations.

• [5] {Make Manual} [Enter] - selects channel 5 and makes all of its current parameter
settings manual data.

• [8] {Focus} {Make Manual} [Enter] - selects channel 5 and makes all of its focus data
manual.

• [9] [Thru] [3] {Color} {Intensity} {Make Manual} [Enter] - selects channels 3 through 9
and makes their color and intensity values manual.

Using {Make Absolute}
Referenced data can be transformed into absolute data using the {Make Absolute} softkey. This
softkey is available in Live or Blind. Referenced data is channel/ parameter data that is derived
from a palette or preset. {Make Absolute} can be used to leave a parameter unchanged, but
break its palette or preset reference.

The following examples illustrate how to change referenced data into absolute data.

• [4] {Make Absolute} [Enter] - selects channel 4 and makes any referenced data for that
channel absolute data.

• [7] {Color} {Make Absolute} [Enter] - selects channel 7 and makes its color data absolute.
• [3] [Thru] [9] {Color} {Intensity} {Make Absolute} [Enter] - selects channels 3 through 9

and makes their color and intensity data absolute.

In each of these examples, the channel display will change to show the result of the command.
Wherever the reference was previously indicated (IP, FP, CP, BP, Pr), an absolute value
(numerical) will be seen.
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In Live, data that is changed to absolute is also made manual, thereby requiring a record or
update instruction if the results are to be maintained.

{Make Absolute} can also be used in conjunction with an update command, allowing a cue to
be updated while also breaking the reference to palettes or presets that were manually
modified.

Example:
• [Update] {Make Absolute} [Enter]

Updates the active record target. Any manual values that were modifications to
a palette or preset stored in the cue will be updated as absolute data in the
cue. The reference will be discarded.

Using [Capture]
Capture is a manual priority state. Any captured channel parameter data will be unaffected by
playback, but will respond to manual control operations.

When channels are selected, [Capture] [Enter] captures all parameters of those channels. They
will remain unavailable for playback or submaster override until they are released from the
captured state. Capture is a toggle state, so to release parameters from a captured state, press
[Capture] [Enter] again.

Example:
• [1] [Thru] [9] [At] [Full] [Capture] [Enter]

A “C” is displayed next to the captured parameters (intensity) in the channel
display. The selected channels are now captured and are unavailable for
playback or submaster instructions until they are released from capture.

You may also capture specific parameters of a channel using the parameter buttons in the CIA.

Example:
• [7] {Focus} [Capture] [Enter]

If a group of channels are selected, and some of those channels are captured and some are not,
the first press of [Capture] releases all channels from the captured state and the second press
captures all manual settings for the selected channels.

Uncaptured channels remain at their current values until restored to previous values or a new
instruction is provided. You may restore channels to their background or default state using the
[Sneak] [Enter] feature (see Sneak (on page 214)). Or you may leave them in a manual state
until a new instruction is received.

It is also possible to latch capture on. This will automatically capture all manual changes as they
are made. Pressing [Capture] [Capture] [Enter] automatically captures subsequent manual
changes. The command line will read “Capture Enable " and the Capture hardkey will
illuminate. To remove the capture latch, press [Capture] [Capture] [Enter] again.

Note: Capture Latch works on a user by user basis.
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Using Query
[Query] is used to select channels that meet criteria specified by you. These selections are
conditional, based on what type of fixture a channel is or what that channel is doing, isn't doing,
can do or cannot do. These criteria are established in the command line using the softkeys, the
keypad, and the direct selects.

Query Softkeys
When [Query] is used, the following softkey conditions are available:

• Is In
• Isn’t In
• Can Be
• Can’t Be
• Or
• Moves Only
• Unpatched
• Mark (cue where the intensity is active)
• Less Than (includes equal to)
• Greater Than (includes equal to)
• Broken Mark
• Marking (future cue)
• Track
• Up Moves
• Down Moves
• Live Moves
• Dark Moves
• Autoblock
• Block
• Assert
• Part
• Park
• Time
• Delay
• Capture

Note: Unless otherwise specified, Eos assumes that a query will apply to current
output. Therefore use of the {Is In} softkey is optional.

The CIA also repaints to display all of the available softkeys by which you can search. These can
be used in defining your query criteria.

Default

Includes the query softkeys along with additional query conditions.
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Text

• {Keywords} - displays buttons for all the text used in the text 1 through 10 fields and all of
the default keywords in Patch.

• {Gel} - displays all of the gels used in the current show file.
• {Text 1} - {Text 10} - displays only the text used in that text field.

See also Renaming Text Fields in Patch (on page 147) for more information.

Fixture Types

Displays buttons for all of the fixture types used in the current show file.

Using Query
As a query is defined in the command line, channels will be specified in the Live/ Blind display.
When an [Enter] command is used to end the query, the remaining channels of the query will be
selected.

Example:
You wish to find channels which are in color palette 2 and have an intensity of
50%:

• [Query] <Is In> [Color Palette] [2] [At] [5] [0] [Enter]

In the Live/ Blind display, any channels meeting this criteria will be selected.

You may use [Next] and [Last] to cycle through the query selection, one
channel at a time to control only a specific channel.

Other examples of using a query are:

• [Query] {Isn’t In} [Beam Palette] [2] [5] [Enter]
• [Query] {Accessory} {Can Be} [Color Palette] [8] [Enter]
• [Query] {Unpatched} [Delete] [Enter] [Enter](Only works while in Patch.)
• [Query] {Fixture Type} {Revolution} {Can Be} [Focus Palette] [6] {Isn’t In} [Cue] [4]

[Thru] [9] [Enter]
• [Next] [Next] [Enter] - selects one channel from the query result

Additionally, in Patch you can define up to ten query keywords for each channel. These
keywords can be used to create a query condition as well (See Adding Keywords in Patch (on
page 147)).
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Keywords defined in Patch will appear in the CIA when [Query] is pressed. They can then be
used in a query like this:

• [Query] {Your keyword} {Can’t Be} {Beam Palette 5} [Enter]

Hardkeys on the face panel, such as [Time] can also be used to construct a query.

Using [Undo]
Undo is a method to revert certain operations performed in the software. You can use [Undo] to
reverse any command that results in a change to data that would be saved to the show file or
any command that changes manual levels in Live.

If there are any commands in the command line, pressing [Undo] once clears the command line.
Once the command line is empty, pressing [Undo] will start the undo process.

When [Undo] is pressed from an empty command line, the command history display will open in
the CIA and the most recent completed command is highlighted in gold. If you press [Enter], you
will undo your last command. [Shift] & [Clear] can be used to clear the command line as well. If
the most recent completed command is grayed out, it cannot be undone. Pressing [Undo] again
will select the first command which can be undone.

You may use the page arrow keys or a mouse to select multiple commands. When [Enter] is
pressed, an advisory is posted. When [Enter] is pressed again, all highlighted commands will be
undone and subsequently removed from the command history. When removing more than one
command, a confirmation is required.

After an Undo has been performed, a {Redo} button will appear in the command history. You
may press this button followed by [Enter] and the last undo will be “redone” to reinstate the
removed commands

In a multiple user environment, each user is only able to undo the changes that they made. In
the undo command history, the user will only see the commands that they used.

Note: Not all commands can be undone including playback actions, manual
attributes placed on channels or encoder actions, and Augment3d model edits.

Command History
Command histories are kept for each editing session, which begins when:
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• a console logs on to the network
• a new show file is loaded
• a show file is opened, merged, or imported

Each user builds an individual command history, specific to the commands they have entered.

You can open the command history at any time by pressing [Displays] <More Sk> {Cmd
History}.

Note: Commands that do not affect manual input or record targets (loading a cue,
running a cue, or moving a submaster) are not included in the command history.

Pressing [Undo] [Undo] will scroll to the most recent undo-able command in the command
history display. To undo the command, press [Enter].
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About Cue Playback
Eos, Eos Ti, and Gio each have one master fader pair and 10 motorized faders with 100 pages
for configurable cue lists, submasters, grand masters, IFCB Palette/ Presets lists, or individual
instances. Gio @ 5 has one master fader pair and 5 motorized faders with 100 pages. Ion Xe has
one master fader pair. Ion Xe 20 has one master fader pair and 20 faders with 100 pages.
Element 2 has one master fader pair and 40 faders with 100 pages. You can define how each of
the faders will function. There is no default setting for faders, which allows you the freedom to
define each fader's function in the fader configuration display or you can configure them while
programming, as the contents of those targets are stored.

Note: Element 2's cue list cannot be assigned to a fader. It can only be loaded on the master
playback fader pair.

The master playback fader pair is located to the right of the motorized fader array, near the
control keypad. The master is a split crossfader pair.

You cannot page the master fader as it is permanently paired and always available for use.

The two buttons beneath the master fader pair are [Go] and [Stop/ Back]. The [Load] button
and playback display are located just above the faders.

Note: On some consoles, the [Load] button for the master playback fader pair is actually
labeled as [Master].

You can page the motorized faders using the [Fader Page] button alone, combined with the
numeric keypad, or with the wheel directly below the [Fader Page] button. As pages are
changed, the faders will reset to the last position they were in on the associated page. Also,
each individual fader is provided with a [Load], [Go], and a [Stop/Back] button for operation
and playback. These buttons behave differently when the fader is a submaster or grandmaster,
and can be changed in the fader configuration display.

Fader Display and Ribbon
On Element 2, this information is displayed in the fader status display. See Indicators in the
Element Fader Status Display (on page 103)

The fader display is located on the bottom of the PSD, and the fader ribbon is located directly
above the faders. Both areas provide information about each fader including the fader
designation (S = submaster with the designation of the submaster number, L = playback with
designation of the cue list and cue number that is loaded, GM = grandmaster, PR = preset with
designation of the preset number, and IP, FP, BP, CP = palettes with designation of the palette
number).

Each area uses the fader color coding that is used in the fader configuration tools.

Grandmasters and inhibitive submasters are in red, additive submasters are yellow, playback
faders display in green, and presets and palettes are orange.

.

Playback Controls
It is important to familiarize yourself with the playback controls and their locations on your
console.

see the appropriate console layout topic for more information:

• Eos Titanium (Ti) Overview (on page 12)
• Gio Overview (on page 18)
• Gio@5 Overview (on page 24)
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• Ion Xe Overview (on page 30)
• Element 2 Overview (on page 36)

Selected Cue
When in Live or Blind, if you press [Live] or [Blind] respectively, the selected cue will be the last
executed cue. This cue will appear on the command line.

When working in Live, the selected cue is always the last cue you recorded, edited, updated or
played back. When entering Blind for cues, the selected cue will be selected and displayed.
Changing the selected cue in Blind will cause the playback status display to change as well,
unless preserve blind cue has been enabled in Setup, which will not synchronize the Blind
display to the currently selected cue but rather shows the last cue selected in Blind. When you
return to Live, the selected cue is synchronized to the currently active cue.

The attributes of the selected cue (such as timing, attributes, label and external links) are shown
at the bottom of the Live / Blind display.

In Live
To load a new cue to a fader, place the cue on the command line and press [Load] for the
desired playback. When the [Go] button is pressed, the activated cue is the selected cue.

Example:
Assume you have cue list 1 already loaded to the master playback faders. Now you
want to load cue 2/1 to a fader.

• [Cue] [2] [/] [1] [Load]

If you press the [Load] button above the master playback fader, it will load cue 2/1 into
the pending file. You could also press the [Load] button above any other playback fader
to load the cue into that fader’s pending file.

In this example, the last cue executed from cue list 1 is still the active cue, while cue
2/1 is pending. When [Go] is pressed, 2/1 will be executed.

You can also load cue list 2 by pressing [Cue] [2] [/] [Load]. This will load the first cue
of list 2 into pending.

The selected cue is changed by go, record, or update instructions as well as cue modification
and selecting a cue on the command line. When you execute a cue that has a follow or hang
time, the next cue will become the selected cue when activated.

In Blind
While in Blind, changing the selected cue will change the playback status display to show
information surrounding that cue.

CAUTION: When editing in blind, changes to cues are automatically stored,
therefore no update or record command is required.

While working in blind mode, cues can be executed in live using [Go], [Back], and [Go to Cue],
but this does not change the cue you are working with in blind.
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Loading a Cue With Temporary Time
A cue can be loaded with a temporary time.

• [Cue] [3] [Time] [6] [Load] - loads cue 3 with the manual time of 6.

Note: For multipart cues, the temporary time will be applied to the entire cue, not
just the part on the command line. For cues with discrete timing, its parameters will use
the temporary time instead of the assigned discrete timing.

Out-of-Sequence Cues
An out-of-sequence cue is any cue that is played back in one of the following ways:

• Cue is executed using a [Go To Cue] command. (Go To Cue (below))
• Cue is executed by a link instruction. (Link / Loop (on page 272))
• Cue is loaded into a fader’s pending file. (Selected Cue (on the previous page))
• Cue is re-executed using [Assert] & [Load] or is asserted from the command line. (Using

Assert (Playback Button) (on page 328))

Generally, when an out-of-sequence cue is executed, the entire contents of the cue will be
played back (move instructions and tracked values).

Example:
Cue 1 sets channel 1 to full. That value is tracked forward until cue 10. The
programmer plays back cue 1. She then sets channel 1's intensity to 50% manually. If
she executes cue 2, channel 1 remains at 50%, as it is a channel parameter that is not
receiving a move instruction from the incoming cue.

However, if she presses [Go to Cue] [5] [Enter] (an out-of-sequence execution), even
though the value for channel 1 in Cue 5 is a tracked value, channel 1 will fade from the
manual value of 50%, to full in the Go-to-cue time.

Go To Cue
[Go to Cue] instructions can be executed from any operating mode. By default, a [Go to Cue]
instruction is an out-of-sequence cue and will follow the rules of such (see Out-of-Sequence
Cues (above)).

Following are examples of [Go To Cue]:

• [Go To Cue] [5] [Enter] - all parameters with values in cue 5 are faded to those values,
even if they are tracked.

• [Go to Cue] [6] [At] [5] [Enter] - takes you to cue 6 at 50% of its fade completion. Hitting
[Go] would finish the cue.

• [Go To Cue] [Next] [Enter] - takes you to the next cue in the active list.
• [Go To Cue] [Last] [Enter] - takes you to the previous cue in the active list.

When a [Go To Cue] instruction is executed, any null states applied with {Make Null} are
removed. To maintain the make null setting, you should use [Capture] for the required
channels. For more information, see Using {Make Null} (on page 311) andUsing [Capture] (on
page 313).

Go To Cue Timing
[Go To Cue] uses go-to-cue timing established in Setup Manual Control (on page 178). You can
use a [Go To Cue] instruction with different timing options as follows:
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Note: A cue can be loaded with a temporary timing. See Loading a Cue With
Temporary Time (on the previous page).

• [Go To Cue] [2] [Time] [1] [Enter] - this command would take you to cue 2 in one second.
• [Go To Cue] [3] [Time] [4] [/] [3] [Enter] - this command would take you to cue 3 and all

up fades and NP moves would have a time of four seconds and down fades of 3.
• [Go to Cue] [Next] [Time] [3] [Enter] - this command would take you to the next cue in

the selected list in three seconds.
• [Go to Cue] [Last] [Time] [2] [Enter] - this command would take you to the previous cue

in the selected list in two seconds.
• [Go To Cue] [8] [Time] [Enter] - this command would take you to cue 8 using all timing

values stored in cue 8.

Other Go To Cue Options
When [Go to Cue] is pressed, the softkeys in the CIA change to provide Go to Cue modifiers to
enhance your playback ability.

From these softkeys, you can specify that when going to a cue, only some elements of that cue
will be played back. Specifically you can choose to play back:

• Manual control using a fader

• [Go to Cue] [6] {Manual} [Enter]

• Scenes opens the Scenes (on page 274) selection display.
• [Go To Cue] {Scenes} - press or select a scene to go to that cue.

• Move instructions only
• [GoTo Cue] [3] {MovesOnly} [Enter]

• Withhold any links (follow, hang, execute instructions)
• [GoTo Cue] [4] {MinusLinks} [Enter]

• Use marks
• [GoTo Cue] [5] {Use Marks} [Enter] - delays channels from marking until their intensities

have reached zero.

• Complete a cue
• [Go To Cue] [4] {Complete} [Enter] will go to cue 4 and if that cue has a follow/ hang,

any following cues in the sequence will also fire. This may look like you are going straight
to the last cue in the sequence but each cue will fire to make sure that any external links
are fired.

• [Go To Cue] [2] [At] [5][0] {Complete} [Enter] will go to cue 2 at 50% of its completion.

• [Go to Cue] [5] [Time] [Go to Cue] will go to cue 5 using cue times, and append
[Complete] to the command line.

• Single parameter channels only (conventionals)
• [GoTo Cue] [1] {SingleParam} [Enter]

• Multiple parameter channels only (automated fixtures)
• [GoTo Cue] [2] {MultiParam} [Enter]

Note: Double pressing [Go To Cue] will post Go To Cue Complete to the command
line. You can then select the appropriate cue number and level of completion.

The following are additional modifiers that can be used with [Go To Cue]:
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• Homes a cue list to its first cue
• [Go to Cue] [Home] [Enter] homes the currently selected cue list to its first cue. [Go to

Cue] [x] [/] [Home] [Enter] homes a cue list to its first cue.

• Takes a cue list to its last cue
• [Go to Cue] [Shift] [Home] [Enter] homes the currently selected cue list to its last cue.[Go

to Cue] [x] [/] [Shift] [Home] [Enter] will take you to the last cue in a cue list.

• Go to Cue Out
• [Go to Cue] [x] [/] [Out] [Enter] allows you to use the [Go to Cue] [Out] command on a

list specific basis. [Go to Cue] [Out] continues to affect all active cue lists.

Note: [Go to Cue] [x] [/] [Out] is similar to [Go to Cue] [x] [/] [0] except that any
NPs on the fader will fade to their home level.

• Time
• [Go to Cue] [5] [Time] [Enter] will go to cue 5 using cue times, and also uses any

associated follow/hang times to automatically trigger the subsequent cue. To go to a cue
in cue time, but not trigger the follow/hang, you would use [Go to Cue] [5] {Minus Links}
[Time] [Enter].

Note: If you want to specify a time or use the cue time, the [Time] command must
always be entered after any other commands, such as {Minus Links} or {SingleParam}.
The exception to this rule is {Manual}.

These can be combined within the command line as well:

• [Go To Cue] [1] {MultiParam} {MovesOnly} [Enter]

Virtual Faders
You can have access to additional faders by using the virtual faders (see Virtual Fader Module
(on page 107)).

Assigning Faders
Cue playbacks, submasters, grandmasters, palettes, and presets are targets that can be
assigned to faders.

Note: Element 2's cue list cannot be assigned to a fader. It can only be loaded on the master
playback fader pair.

Faders can be assigned in a number of different ways.

• The fader configuration display
• The fader list
• The cue list index
• The submaster display
• Manually using the [Load] button

With Auto Playback Enabled
Auto Playback is a record function enabled in Setup > User > Record Default, that automatically
executes cues recorded in live on playback faders. When the cue is executed on the playback
fader, any manual parameters involved in the record operation are automatically released to the
cue and all other values stored in the cue are owned by that cue.
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When the first cue is stored on Eos, the cue list of that cue automatically loads on the master
fader. Any subsequent cue lists stored will load to the next available fader.

Assigning Faders Manually
The location of playbacks, submasters, palettes, and presets on faders can also be defined as
the contents of those targets are stored.

Note: You cannot define grandmasters in this manner, they must be defined in fader
configuration display or the fader list. See Grandmaster Configuration (on page 105) for
more information.

Note: Element 2's cue list cannot be assigned to a fader. It can only be loaded on the
master playback fader pair.

If a fader is unmapped, a target can be loaded to that location by selecting the target from the
command line and pressing the associated [Load] key. The fader will then be automatically
assigned that target.

Once a cue list is loaded to a fader, storing to that cue list automatically plays the cue back on
the appropriate fader, when auto playback on record is enabled in Setup>User>Record
Defaults.

If a fader has been configured for default mapping ( see Fader Configuration for more
information), the fader will receive its configuration from the Cue List Index. Changes made to a
cue list in the cue list index will be shared with any default mapping faders loaded with that cue
list. If changes are made to a fader set to default mapping in the fader configuration display,
those changes will also happen in the Cue List Index. If set to Local, any changes made in the
fader configuration display will impact only that instance of the content.

To load a new cue into the pending file of a playback fader, when auto playback is disabled in
setup, or when you want to move a cue list to a different fader, first place that cue or list
number on the command line then press the associated [Load] button for the destination
playback fader.

• [Cue] [4] [Load] - changes the selected cue and loads it to the associated fader. This
action assumes cue 4 is from the same cue list as is currently selected.

• [Cue] [3] [/] [Load] - changes the selected cue list and loads it to the associated fader.
• [Cue] [5] [/] [6] [Load] - changes the selected cue list and loads it to the associated fader

with cue 6 as the pending cue.

Changing Fader Pages
Navigation changes to fader banks and wings in the same paging group will advance all the
fader pages in the group. See Wing Paging Groups (on page 181).

When fader pages are changed, motorized faders assume the last position the faders were in on
that page. This includes homing submasters to their required home position if needed.

Paging Forwards
Pressing [Fader Page], or [+] on an external wing, will advance through the available pages of
faders.

If pressed on a fader page with content, the pages will advance through subsequent pages with
content until a blank page is reached. After that blank page, the remaining blank pages will be
skipped, and the next page with content will be displayed. Pages will loop infinitely.
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Example: Pages 1, 2, and 5 are populated on a 1x10 fader wing. From page
1, pages will be advanced in the order 1, 2, 3, 5, 6, back to 1, and so on.

Paging Backwards
Pressing [Shift] & [Fader Page], or [-] on an external wing, will decrement through fader pages
using the same logic as above. The first blank page chronologically after a page with content
will still be used in reverse order. Pages will loop infinitely.

Example: Pages 1, 5, 6, and 8 are populated on a 1x10 fader wing. From
page 1 , pages will decrement in the order 1, 9, 8, 7, 6, 5, 2, back to 1, and so
on.

Accessing Specific Pages
You can access a specific fader page at any time, by holding [Fader Page] and pressing the
number of the page you wish to access.

Specific pages can also be accessed by holding [Fader Page] and using the bump buttons on an
external wing.

Element 2 and Classic Paging
On Element 2 and Element Classic, you can page the faders by holding down the {Page Subs}
softkey in the Live display. The bump buttons will light up in green, and the bump buttons that
correspond to the currently selected pages will flash. Press the corresponding bump button to go
to that page. The fader status display will change to show the fader pages. See Paging
Submasters (on page 368) for more information.

On Ion Classic, holding down [Fader Control] to use the bump buttons on an external wing.

Playback Fader Controls
The following buttons are found in the Master Fader controls or in the Fader Page controls area
of your console. See Playback Controls (on page 320)

In Ion Classic and Element Classic, many of the buttons mentioned below exist as softkeys. In
order to have access to some of these keys, press [Fader Control] (Ion Classic) or [Live] {Fader
Control} (Element Classic). The softkeys will change to display the fader control keys. You may
press [More SK] if the green LED is illuminated, to view additional fader control buttons.

The following controls are available:

• Load (Selected Cue (on page 321))
• Go (Using [Go] (on the facing page))
• Stop/ Back (Using [Stop/ Back] (on the facing page))
• Blackout (Using Blackout and Grandmaster (on the facing page))
• Grandmaster (Using Blackout and Grandmaster (on the facing page))
• Go To Cue 0 ([Go To Cue 0] (on page 328))
• Assert (Using Assert (Playback Button) (on page 328))
• Timing Disable (Using Timing Disable (on page 328)
• Freeze Using Freeze (on page 329))
• Stop Effect (Using Stop Effect (on page 329))
• Rate Override (Using Rate Override (on page 329))
• Manual Override (Manual Override (on page 331))
• Off (Releasing Content From a Fader (on page 331))
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• Release (Releasing Content From a Fader (on page 331))
• Fader Page (Changing Fader Pages (on page 325))

Using [Go]
The [Go] button is used to execute the cue currently in the pending file of the associated fader.
When [Go] is pressed, all parameters assume their required positions in the recorded times,
unless they have been recorded with manual timing. When a cue has manual timing values
stored with it, the fader will set itself to zero when [Go] is pressed, or you may set the fader to
zero before you press [Go].

If a channel parameter is in a transition state when a new cue is activated on the same playback
fader, that parameter will continue its initial instruction in its remaining time unless it receives a
new move instruction in the incoming cue. If a new instruction is provided, the parameter will
calculate its new target and the time to get there for a seamless course adjustment. If a
parameter in transition has no new instruction in the incoming cue, it will continue its fade,
using the original timing provided.

If a channel parameter is in a transition state when a new cue is activated on a different
playback fader, and that parameter receives a move instruction, even if it is exactly the same
instruction the parameter currently has, it will recalculate the destination and arrival time
according to the information from the new cue.

For information on manual timing, see Manual Timing Control (on page 330) and for manual
master, see Master (on page 291)

Using [Stop/ Back]
All fader activity can be instantly stopped mid-transition by pressing the [Stop/Back] button for
the required fader. To resume the cue, press the [Go] button. To fade to the previous cue on
that fader, using default “back” timing, press the [Stop/Back] button again from this state.

When you have gone to the previous cue using the [Stop/Back] button, the cue should look just
like it did before you hit the [Go] button, if the cue still has ownership of all of its channels. If a
different cue list has taken ownership of some of the channel parameters within that cue in the
interim, those specific channel parameters will not respond to the [Stop/Back] command.

If a cue is recorded or rerecorded when a fade is stopped, the contents of that fader will be
recorded as absolute data in the new record target. If a cue is updated with the fader in a
stopped state, all references in the cue will be updated accordingly.

When a cue on the playback fader is complete, pressing [Stop/Back] will step backwards
sequentially through the cue list from that point. [Stop/Back] uses default back time as
established in Setup, see Manual Control (on page 178). Or you can back into the previous cue
using specific timing with [Go to Cue] [Last] [Time] [n] [Enter].

Using Blackout and Grandmaster
Blackout is a console function allowing you to immediately set all lighting levels to zero.

A grandmaster is type of fader that inhibits all live intensity values. Any fader on an Eos Family
console or connected wing can be configured as a grandmaster. See Grandmaster Configuration
(on page 105) for more information.

Note: Ion Classic and Element Classic have physical grandmasters.
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If a grandmaster is set to a value other than 100%, a grandmaster button with the set value will
be shown at the top of each display. If blackout is currently on, a blackout button will be shown
at the top of the displays.

Clicking on either button will open a new display which will allow you to turn off blackout and
set the grandmaster to a different level.

[Go To Cue 0]
Note: On Eos, the button is [GoTo Q0] .

You can use the [Go To Cue 0] button, located with the playback controls, in conjunction with a
fader load button, to send a specific cue list to cue 0. This action does not use the command
line. Simply press:

• [Go To Cue 0] & [Load] for the desired fader

On Element 2, you can use the [Go To Cue] [0] [Enter] command to send the cue list to cue 0.
This drives all cue intensities to zero, while leaving non-intensity parameters as currently set but
no longer under cue control.

For more information on this action, see Using Go To Cue 0 (on page 305)

Using Assert (Playback Button)
Note: There are two [Assert] buttons. This section uses the [Assert] button that is located in
the playback fader controls area.

Note: On Element 2, you will need to use the {Fader Control} softkey, which displays when
[Live] is pressed.

Use [Assert] & [Load] for the associated fader to re-run the active cue in that fader, following
the same rules as [Go To Cue]. Assert can be used to regain control of all cue contents, apply a
newly set priority state to the associated fader, or make any changes in blind to an active cue on
stage.

When [Assert] & [Load] are used together, the entire contents of the cue are replayed. You can
assert just certain elements of a cue by using the command line. See Using Assert (on page 303)

Using Timing Disable
The [Timing Disable] button, used with [Load], causes timing data to be ignored for any cues
that are activated on the associated playback fader. When a playback fader is in timing disable
mode, you will notice “TD” in the associated fader display, and the [Timing Disable] button will
be red.

To release the playback fader from time disable mode, press [Timing Disable] & [Load] again.
You can also cut the next cue in by pressing [Timing Disable] & [Go] or the last cue by pressing
[Timing Disable] & [Back].

On Element 2, you will need to press [Live] {Fader Control} to see {Timing Disable}.
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Note: [Shift] & [Go] and [Shift] & [Back] can be used to cut to the next cue in the
same way as [Timing Disable] & [Go] and [Timing Disable] & [Back].

Cues will snap from move instruction to the next move instruction in a time of zero, which is the
default time. To set a different time for Timing Disable, go to Setup>User>Manual
Control>Timing Disable. See Manual Control (on page 178) for more information.

Using Freeze
[Freeze] can be used to halt all effect activity on any active faders. To activate a freeze for only
a specific fader, press [Freeze] & [Load].

Note: On Element 2, you will need to use the {Fader Control} softkey, which displays
when [Live] is pressed.

There are two ways to remove the freeze command:

• press [Freeze] & [Load] again for the specific faders to unfreeze the activity.
• press [Assert] & [Load] or [Go] or [Stop/Back] for the specific faders to resume the

activity.

You may freeze and unfreeze effects from the command line.

• [Effect] [2] [Freeze] [Enter] - to freeze effect 2. Freezing a specific effect is different from
stopping an effect. Freeze will stop the effect exactly where it is.

• [Effect] [6] [Thru] [9] [Freeze] [Enter] - to freeze a specified range of effects.
• When an effect is in freeze mode, you can use the same command to unfreeze:
• [Effect] [2] [Freeze] [Enter]
• [Effect] [6] [Thru] [9] [Freeze] [Enter]

Using Stop Effect
The [Stop Effect] button can be used to stop all effects from operating on any or all faders, or it
may be used with the control keypad to stop a specific effect.

• To stop all effects on a fader, press [Stop Effect] & [Load] of the associated fader.
• To stop a specific effect regardless of the fader it is operating on, press [Stop Effect] [2]

[Enter].
• To stop an effect on a specific channel, press [5] [Stop Effect] [Enter].

When an effect is stopped, all impact of the effect is removed and the stage output is as though
the effect has never been activated. This behavior is influenced by the exit behavior of the
effect. See Exit (on page 344)

Using Rate Override
To collect a playback fader for rate control, press [Rate] & [Load] for the required fader. When
[Rate] is pressed without [Load], it always collects the master fader for rate control. A subset of
faders can be collected by pressing and holding [Rate] while pressing the [Load] button for the
associated faders you would like to add.

Use the rate wheel to adjust the rate dynamically. The default is 100%, which is real time
(example: 5 seconds = 5 seconds). Decrease the percentage to slow the cue down. Setting the
rate to 0% will stop the cue. Increase the percentage to speed up the event.
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On Element 2, press [Live] {Fader Controls} {Rate} to collect the master fader pair for rate
control. Use the level wheel to adjust the rate dynamically. The default is 100%, which is real
time (example: 5 seconds = 5 seconds). Decrease the percentage to slow the cue down. Setting
the rate to 0% will stop the cue. Increase the percentage to speed up the event.

Following are some examples of rate:

• A 50% decrease rate applied to a 5 second event will play the cue in 10 seconds.
• A 200% increase rate applied to a 5 second event will play the cue in 2.5 seconds.

The top rate adjustment is 2000%. All timing values associated with a cue (including any follow
or hang times) are affected by the rate modification proportionally.

If a cue is complete, any rate adjustment applied affects the cue in the pending file. When that
cue is subsequently activated, the adjusted rate is used to direct timing. Pressing [Rate] again
will turn rate control off and reset to 100%.

Using Manual Control
There are four types of manual control for playbacks:

• Cues can be stored with manual timing. When cues have stored manual timing, the
default behavior of the fader is to control those manual values.

• Cues can be captured for manual intensity control only. This is possible only when the
associated cue has no manual timing values.

• Cues can be manually overridden using the [Man Override] & [Load] feature which
captures all parameter transitions. On Element 2, you will need to press [Live]
{Fader Control} to see {Man Override}.

• The fader can be set to manual master mode. See Master (on page 291) for more
information.

In each of these cases, follow time counts down from [Go]. The hang time will be kicked off
when the fader reaches full or when the last parameter reaches its end state from timing,
whichever comes last.

Note: The Fader Ribbon and the Fader Display Format of the Playback Status Display
are useful displays when using manual control. On Element 2, since playbacks cannot
be assigned to faders, these displays are not available.

Manual Timing Control
Manual timing can be set for any parameter or group of parameters. A fader is then used to
control the progress of a transition.

Example:
Assume the active cue contains an instruction to set red at 40 for channel 1.

The pending cue contains an instruction to set color for channel 1 to blue and
the color parameter has a manual time. Press [Go] to activate the cue.

Channel 1 color does nothing.

As you move the fader up manually, channel 1 color moves proportionally from
red to blue. Any parameters with timing will start their moves at the press of
[Go] and be unaffected by the manual control.

To program a channel manual time:

• [1] {Color} [Time] {Manual} [Enter] - assigns a manual time to channel 1. This must be
recorded or updated to a cue, when in Live.
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Manual timing can also be set at a cue level:

• [Record] [Cue] [5] [Time] {Manual} [Enter]

Manual timing can also be set at a cue category level:

• [Record] [Cue] [6] {Color} [Time] {Manual} [Enter]

Manual Intensity Override
An intensity transition may be taken over manually and the transition captured by dropping the
fader down until it reaches the percentage of cue completion (i.e. if the cue is 50% complete,
when the fader is manually dropped to 50%, the intensity transitions will be captured and the
intensity portion of the cue completed by moving the fader manually between 50% and full or
anywhere in between). If the fader is dropped below 50%, the fader will fade all intensity values
proportionally from their captured values to their previous values.

If a fade is captured and the faders are not reset to 100% prior to the next press of the [Go]
button, the fader will automatically reset to 100% upon cue execution. Alternatively, you can
set the fader to 0% before executing the next cue to capture the cue for manual intensity
control when the [Go] button is pressed if the fader is set to proportional control. Intensity
control is released from the fader when the cue is considered complete (when the fader is
brought back to 100%). If the fader is set as an Intensity Master, the intensity control is
maintained, even when the cue has completed.

If a pending cue has any manual control properties, you may either preset the fader to zero or
the console will automatically set the fader to zero when the [Go] button is pressed.

Manual intensity override is not possible if there is any manual timing in the cue, as the fader is
already occupied with that control.

Manual Override
Manual override allows the associated fader to control all parameters in a transition state on
that fader. When [Man Override] & [Load] are pressed, all activity on that fader is frozen and
the motorized faders move to match the current fade progression.

The fader is used to manually complete the cue transition for all parameters. If the fader is
operating in a paired mode, the left fader controls the intensity upfade and all non-intensity
parameters, while the right fader controls all intensity downfade actions. Manual control
override automatically releases when the cue is complete.

A group of faders can be collected for manual override by pressing [Man Override] & [Load]
(continue adding faders by pressing the associated [Load] buttons).

Releasing Content From a Fader
There are a few ways to release content from a playback fader:

• [Off] & [Load] - returns control to the background fader, either a cue or a submaster, and
stops any effects that are running on that fader. If there is no background value, the
intensities will just fade out. On Element 2, press {Fader Control} to see {Off}.

Note: Associated pending and current cues will remain when using [Off] & [Load].

Note: Pressing [Go] will run the cues in their current sequence.
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• [Release] & [Load] - behaves like [Off] & [Load] except that it sets the pending cue to the
first cue in the list and removes the active cue. On Element 2, press {Fader Control} to see
{Release}.

• [Shift] & [Load] - behaves like Release & [Load] except that it additionally removes the
content entirely from the fader. Pressing [Shift] & [Load] on an empty playback fader will
unmap the fader.

• [Escape] & [Load] - unmaps all instances of the target (cue list, submaster, palette, or
preset) on a selected fader.

The [Go To Cue] [Out] [Enter]command can be used to fade out all intensities, reset all cue lists
to the top, and to clear out all background LTP fader values.
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About Multipart Cues
Cues can be divided into up to 20 parts. Each part can have its own channels or parameters,
levels, and timing information. Multipart cues can be stored in Live or Blind using the same
conventions to record a standard cue.

There are three basic ways to create a multipart cue:

• Building a multipart cue part-by-part in Live
• Breaking an existing cue into multipart cues in Live
• Breaking an existing cue apart in Blind.

Multipart cues can be used to organize automated fixture data so that you can apply different
times to different moves (focus moves slowly, but color snaps after a short delay). You can also
use multipart cues instead of many individual cues triggered by wait times to create a series of
fades.

A channel or parameter can only be provided an instruction once in a multipart cue. For
example, it isn't possible to adjust color for channel 1 in cue 1 part 1 and then also provide a
different instruction for channel 1 color in cue 1 part 8.

Default part timing is drawn from the cue level timing defaults established in Setup ( see Cue
Settings (on page 169)); you may also assign discrete timing to channels in each part as you
would for a single part cue.

Record a Multipart Cue in Live
Storing a multipart cue in Live is accomplished in similar fashion to storing a single part cue.
However, rather than storing the entire cue, you select and store just the channels that you want
in each part.

Note: There are a variety of different ways and different orders to go about creating a
multipart cue. The examples in these topics represent some, but not all, of those ways.

Creating a New Multipart Cue in Live
There are two ways to create a multipart cue in Live. You can either build it part-by-part, or by
building parts from the cue end state.

Build Part-By-Part
Make desired changes to the stage state. If all of the changes that you have made are to go into
a part, press:

• [Record Only] [Cue] [2] [Part] [1] [Enter]

Continue making changes and storing parts as you go.

Build Parts From Cue End State
In most instances, you will create the end state of the cue and then break it into parts. To do
this, you use selective storing commands, as follows:

• [channel/parameter selection] [Record] (or [Record Only]) [n] [Part] [a] [Enter]
• [channel/parameter selection] [Record] (or [Record Only]) [Part] [b] [Enter]

Each part can contain its own cue level timing and other attributes. Follow/Hang, Link and Loop,
and Allfade commands can be placed at the cue level only - they cannot be placed on a part.
Also, through the channel selection, you can put channel parameters into different parts.
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Also, you can put channel parameters into different parts by including them after the channel
selection but before the [Record] command.

• [1] [Thru] [1] [0] {Focus} [Record] [Part] [3] [Enter] - places pan and tilt parameters for
channels 1 through 10 into part 3.

Part 1 of any multipart cue is where all unassigned move instructions will reside. Therefore, if
the body of the cue (which is the normal behavior) is to be in part 1, you can simply select the
channel/parameter list that you wish to place in parts 2 and higher.

Setting Multipart Attributes and Flags
Cue attributes include Follow, Hang, Link, Loop, Delay Time, Rate, Curve, Cue Notes, Cue
Labels, and Scenes. They are stored and function exactly as they do in single part cues.

Flags can be set for Block, Assert, AllFade, Mark, and Preheat.

On Ion Classic, flags can be set for Block, Assert, AllFade, Mark, and Preheat.

On Element Classic, flags can be set for Block, Preheat, and Moves.

For more information, see Assigning Cue Attributes (on page 271) and Flags (on page 276).

Cue part attributes can be defined as the parts are recorded, or they can be added after the part
has been created.

Example:
• [Record] [Cue] [2] [Part] [1] [Delay] [8] [Enter]
• [Cue] [4] [Part] [3] {Color} [Time] [6] [Enter]
• [Cue] [8] [Part] [9] {AutoMark Off} [Enter]
• [Record Only] [Cue] [5] [Part] [2] [Assert] [Enter]

Using Update in Live for Multipart Cues
Updating a multipart cue is generally the same process as updating a single part cue, except you
will provide a specific part cue number in the update command.

Various referenced data, such as palettes or presets, can be assigned to build a multipart cue. If
you have made changes to referenced data within a multipart cue, thereby creating manual
data, pressing [Update] [Enter] updates both the multipart cue and any referenced data with
the new levels, as it does with single part cues.

You can update a part of a multipart cue with only selected parameters as well.

Example:
You have written cue 1, which is a multipart cue and is active. Part 2 includes
channels 1 through 5 referencing intensity palette 2 which is set at 25%. Select
channels 1 through 5 and change the intensity value to 21%. The data in Live
will indicate the new levels in red, and an “R” is displayed to indicate the
reference has been broken.

To update cue 1 part 2, including the new intensity levels, breaking the
reference to the intensity palette, press:

• [1] [Thru] [5] {Make Absolute} [Enter]
• [Update] <Cue> <1> [Part] [2] [Enter]

To update cue 1 part 2 and the referenced palette with the new levels:
• [1] [Thru] [5] {Intensity} [Update] <Cue> <1> [Part] [2] [Enter]
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Example:
When cue 2 is active, select channels 1 through 5 and set new levels for the
color scrollers. Update only part 4 of the multipart cue 2 with the new scroller
levels.

• [1] [Thru] [5] [Scroller] [Update] [Part] [4] [Enter]

Storing a Multipart Cue in Blind

CAUTION: Edits in Blind take effect immediately, they do not require a
[Record] or [Update] command.

Changing a Single Part Cue to a Multipart Cue
When working in Blind, often you will be breaking a single part cue into a multipart cue.

It is quite possible to create a new cue in Blind and follow the exact same process, except in
addition to pulling channel parameters into parts, you will also be providing them with move
instructions or block commands. It is worth noting that tracked instructions do not belong to any
specific part of a multipart cue.

Select the cue you wish to break apart and specify the first part you wish to create. Part 1 is
generally where the body of the cue resides. Therefore, if you specify any part other than part 1,
all of the move instructions in the cue are placed in part 1.

Begin by selecting any channels that you wish to move into some part other than part 1.

• [1] [Thru] [5] [Part] [2] [Enter]
• [6] [Thru] [1] [0] {Intensity} [Part] [3] [Enter]
• [6] [Thru] [1] [0] {Color} [Part] [4] [Enter]

As you create each part, that part is now selected. It is possible to select the channel parameter
you want and press [Part] [Enter] to pull that data into the selected part.

Note: When breaking a cue into a multipart cue in blind, the [Part] button is a
required instruction. Channel selection will not automatically assign a channel into a
part. Use of the [Part] key allows you to add only specific channel parameters to the
part. For example: [5] [Thru] [9] {Color} [Part] [Enter].

Changing a Multipart Cue to a Standard Cue
To change a multipart cue to a standard cue, delete all of the parts of the cue.

Example:
Cue 4 is a 3 part cue that include channels 1 through 20. To change cue 4 back
to a standard single cue:

• [Delete] [Part] [1] [Thru] [3] [Enter]

Creating Multiple Cue Parts in a Range
[Thru] [Thru] can be used in blind to create multiple cue parts in a range.

• [Cue] [1] [Part] [1] [Thru] [Thru] [4] [Enter] will create parts 1 through 4.

If you were to use just [Thru] instead of [Thru] [Thru], you would create parts 1 and 4.
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Deleting a Part from a Multipart Cue
When you delete parts of a multipart cue, any move instructions in the deleted part are moved
to the first available part. If you want to delete move instructions out of a cue part, you have to
select the channels and [At] [Enter] or null them.

• [Delete] <Cue> [1] [Part] [1] [Enter] [Enter]
• [Delete] <Cue> [6] [Part] [1] [Cue Only/Track] [Enter] [Enter]
• [Delete] [Part] [1] [+] [2] [Enter] [Enter]
• [Delete] [Part] [1] [Thru] [3] [Enter] [Enter]
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About Effects
Effects are a method within Eos to provide dynamic, repetitive action to channels.This chapter
explains the different types of effects, and how to use them.

Effects are manual control functions that can be applied to a channel parameter and then
included in presets, cues, or submasters. Cues can contain both standard transitions for some
channels/parameters and effects for the same or other channels/parameters.

Intensities can have different effects running at the same time but they must be from different
sources. You can have an intensity effect running on a cue and those same channels can be
impacted by an intensity effect on a submaster. See Multiple Intensity HTP Effects (on page 354)

Effects have user defined properties and attributes which are applied to the effects whenever
they are used in cues. Effects also have cue level overrides, which allow you to use an effect in
multiple locations, and modify its size, shape and / or rate in individual cues. See Effect Channel
Display (on page 347) for more information.

Effects are broken up into three fundamental behavior types:

• Step Effects - are chases for one or more parameters. Intensity is the default. Step effects
are On/ Off behavior. The ON value determines what the associated channel should do
when the step is active, while the OFF value determines what the channel should do when
the step is not active. See Step Effects (on page 348)

• Absolute Effects - are progressive behavior, rather than on/ off states of step effects.
However, unlike relative effects, which are also progressive, you are determining exactly
the behavior that you want to have for each transition in the effect. See Absolute Effects
(on page 350)

• Relative Effects - are math based effects that provide a continuous offset from the current
parameter value. There are three different types of relative effects: Focus, Linear and
Color. See Relative Effects (on page 354)

There are four different displays for viewing and editing effects:

• Effect List - displays all of the recorded effects. See The Effect List (below)
• Effect Editor - displays in the CIA when the Effect List is open. The editor will display the

attributes and properties of a selected effect for editing. See Effects Editor (on the facing
page)

• Effect Status - displays information in the CIA about the currently running effects. See
Effect Status Display (on page 345)

• Effect Channels - displays all of the channels in the currently running effects so you can
override certain effect properties. The effect status display will also open while in the
effect channel display. See Effect Channel Display (on page 347)

The Effect List
At any time you may press [Effect] [Effect] or [Tab] [1][3] to view the effect list. Any recorded
effects will be displayed here. The effect list is a blind view and any changes made in this view
are automatically stored; a record command is not required.

You can also use the command line search to see a list of effect names while in live or blind. See
Command Line Search (on page 55) for more information.

Notice that there are effects existing in this list prior to any being recorded. Effects 901-918 are
preprogrammed relative effects that are automatically available to you (see Relative Effects (on
page 354)).
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To navigate this list use the navigation keys as described in Display Control and Navigation (on
page 64) or select the effect number you wish to work with. Notice that when you select the
effect list, the CIA changes to display the information for the currently selected effect.

Effects can be assigned an icon, which can be configured to appear on the direct select button in
Direct Selects (Tab 4) or Custom Direct Selects (Tab 39). See Icons (on page 93) for more
information.

Effect List Navigation
Using the [Next]/ [Last] keys will only move between effects in the effect list display. To
navigate the effect editor, you will need to use the page arrow keys.

You can use [Page t] or [Page u] when in the effect list display to begin navigating in the
effect editor. This only works for step or absolute effects. You can press [Escape] to return focus
to the effect list display.

Effects Editor
When viewing the effect list, the selected effect is displayed in the CIA. The effect
properties/attributes are shown in categorized buttons in the CIA. To change any
property/attribute, press the corresponding button and enter data as required.

Note: Some effect properties, such as rate and size, can only be modified in the
Effect Status Display and in the Effect Channel Display.

The properties display of the effects editor is shown below and definitions of properties follow:
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Type
Defines the effect type: step-based, absolute, or relative (linear, focus, or color). To change the
type, press {Type} and then press the desired effect type in the buttons to the left.

• <Effect> [1] {Type} {Step based} [Enter]

Scale
Applies only to relative effects. This modifies the amount the pattern is offset from the current
parameter values. The scale is expressed as a percentage increase or decrease (25 = 25% of the
programmed value).

• {Scale} [3] [0] [Enter] or you may adjust this using the “Scale” encoder.

Cycle Time
Provides a cumulative time to complete one full iteration of an effect. In relative effects, the
cycle time determines the length of time required for one channel to complete the cycle.

In absolute and step-based effects, the cycle time determines the time required to complete one
full iteration of the effect. In these effect types, modifying the cycle time changes the timing
values proportionally within the effect itself.

To change the cycle time, press {Cycle Time} and then enter the desired time (in minutes and
seconds) from the keypad, followed by [Enter]. This can also be adjusted from the encoder.

Duration/Cycle
This determines the length of time an effect will run. To specify, press {Duration/Cycle} and
then choose the desired method from the buttons that appear to the left. The options are:

• {Infinite} - for step and absolute effects, the effect will run until the channel is provided a
new instruction or the effect is stopped,. Relative effects with an infinite duration will run
until a stop flag is applied.

• {Duration} - the effect will run for a set amount of time given in minutes and seconds.
Enter the time from the keypad.

• {Num cycles} - the effect will run for a set number of iterations. Enter the number using
the keypad.

• {Duration/Cycles} {Num Cycles} [1] [0] [Enter]

When an effect with duration is running in a cue, the effect will display in light blue while it is
running and dark blue when it has finished. This is only displayed in the Live Summary View.

Parameters
This allows you to select which parameters will be involved in the selected effect, by default. By
entering a value here, you do not need to specify the required parameter when placing an effect
on a channel group.
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To add/ remove parameters to the effect, press {Parameters} and then select the desired
parameters from the buttons that appear to the left.

• {Parameters} {Iris} [Enter]

Attributes
These determine the basic behavior of the effect. Attributes include behaviors such as forward,
reverse, bounce, positive, negative, and random grouping/ random rate. The attributes are
slightly different between step, absolute, and relative effects.

• Bounce - effect will run first in forward, then in reverse. Subsequent passes alternate
between forward and reverse.

• Forward - the effect will run in the programmed direction (the arrow on the pattern editor
indicates “forward” for pattern effects, and step/ absolute effects will follow numerical
order).

• Reverse - effect will run in the opposite direction of forward or reverse numerical
direction. Forward and Reverse are mutually exclusive settings.

• Random Group- channel distribution or step order (depending on the type of effect) is
applied in a continuously random fashion. Enables Random Modifier (below).

• Random Rate - This overrides the cycle time of the effect. Random Rate is applied in a
range (for example 5 through 150). Enables Random Modifier (below).

• Continuous Run - the effect will keep running until there is a stop effect command. By
default, {Continuous Run} is disabled for all step and absolute effects. It is enabled by
default for relative effects. See Assigning a Stop Effect Command (on page 358) for more
information.

• Repeat on Go - the effect will not restart unless {Repeat on Go} is used.
• Build - keeps values at their on-state, even when the step is no longer active.
• Positive - effect will run the steps (on state and off state) as programmed. Step effects

only.
• Negative - inverts the on state and off state for the effect. Step effects only.
• Break Mode - mimics a scroll across a static background. All but the last action scroll one

channel at a time across the selection. The final action appears on all channels not
affected by the other actions. Absolute effects only.

• Bounce Channels - runs the effect on the channels first in forward, then in reverse.

Play with these behaviors to see how they alter your effect.

Random Modifier
Random Modifier is an optional parameter that offers additional control over the behavior of
effects that have Random Group or Random Rate attributes applied.

• Continuously Random - a "true random" option, which selects a different random
modifier value each time the effect plays back.

• 1 - 9999 - each value provides a unique random behavior that is preserved between
effects. This value can also be modified in Live to audition different random behaviors.

Entry
Establishes at what time and how channels will enter the effect. To change the entry method
press {Entry} and then choose a method from the buttons to the left. Entry modes vary by effect
type. The options are:

• {Cascade} - channels enter the effect according to the trail and cycle time values (if
applicable).

• {Immediate} - all channels enter the effect instantaneously.
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• {Fade by Size} - The effect will achieve its full value as allowed by the pattern or
step/absolute values using the In Time.

• {Fade by Rate} - increases the rate of the effect as it enters. If an effect submaster has an
entry mode of {Fade by Rate}, the submaster will control the rate between 0 to 100.

• {Fade by Size and Rate} - the effect will achieve its full value as allowed by the pattern or
step/absolute values and ramp up to full speed using the In Time.

Exit
Establishes at what time and how channels will exit the effect. To change the exit method press
{Exit} and then choose a method from the buttons to the left. Exit modes vary by effect type and
how the effect is stopped. The options are:

• {Fade by Size} - when the effect is exited, values will return to their background state
while still running using the exit time.

• {Fade by Rate} - decreases the rate of the effect as it exits.
• {Fade by Size and Rate} - when the effected is exited, channels will stop running the

effect and return to their background state using the exit time.
• {Stop and Fade} - when the effected is exited, channels will stop running the effect and

return to their background state using the exit time.
• {Stop and Hold} - when the effect is exited, channels will halt exactly where the effect left

them.

Time (Entry or Exit)
These fields establish the length of time for channels to enter/exit the effect. It can be entered in
minutes and seconds from the keypad. These timing values are applied to the entry and exit
modes. Cue level timing is the default for these. Press {EnterTime} [Enter] or {Exit Time}
[Enter]. To reset to defaults, press [Time] [Enter].

Grouping
Grouping is used only in relative and absolute effects. This determines how channels currently
running the effect will be grouped throughout the pattern. To change this press {Grouping} and
then enter the number of lights you want grouped together.

Grouping defaults to {Spread}. This means that every light the effect is applied to will act as an
individual element, moving through the effect sequentially based on the channel selection
order, cycle time, and trail times. You can enter any number from 1 through 2000. A grouping of
2 means that every other light in the selection list when the effect is applied will move together
through the effect. Grouping of three means every third light, and so on.

Your options are 1 through 84 or {Spread} which will distribute each channel in the effect evenly
and treat it as a separate group.

• {Grouping} [2] - every other channel (in a range of channels) will be grouped when
running the effect.

When an effect is applied to a group in live, that group is distributed by order, using this
grouping function. If a group list is created and an effect applied, each group is considered an
individual element within the effect.

Trail
Trail is applicable to relative and absolute effects. Trail determines how channels are to follow
each other through the effect; it is a percentage of the cycle time. Trail can be any value from 0-
200%, even, or solo. The default is even. For example:
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• {Even} - The groups will be distributed evenly throughout the pattern. This is calculated by
dividing the cycle time of the effect by the number of groups of channels.

• {10%}-{200%} - When the first group is 10% through the effect, the second group will
start the effect, and so on through the remaining groups. Therefore, the groups will trail
n% behind each other, as a percentage of the cycle time.

• {Solo} - The first group will execute the entire pattern. When done, the second group will
execute the entire pattern, and so on.

Effect Editor Navigation
To navigate the effect editor, you will need to use the page arrow keys.

You can use [Page t]or [Page u] when in the effect list display to begin navigating in the
effect editor. This only works for step or absolute effects. You can press [Escape] to return focus
to the effect list display.

Confirming Effect Changes
When using [Page ▼ ] to create a new effect step/ action in the Effects Editor display, you will
first be asked to confirm the new step/ action number before continuing. This is to prevent new
step/ action from being created by mistake.

Using Encoders With the Effect Editor

Note: This feature is not available on Element 2.

When any effect is specified in the command line, the encoder display automatically repaints to
display the following properties:

• Cycle Time - Default is 5 seconds for relative effects
• Scale
• Shape (Vertical or Horizontal as defined by the {Mode} button)
• Axis

At any time, you may use the encoders to adjust these properties within the effects editor for the
specified effect.

Effect Status Display
To view the effects currently running, you may press [Displays]>{Effect Status} to open the
effect status display in the CIA.

This display shows you any currently running effects and gives you the ability to edit the effect
while running. When an effect is selected, the encoders and encoder screen change to allow
you to manipulate the effect according to rate, size, horizontal form, vertical form, and axis.

Example:
To edit an effect, select the effect using the command line or select it directly
from the CIA.

• [Effect] [9] [0] [2] [Enter]

The encoder screen and softkeys will repaint so that they now control the five
attributes in the columns of the effect status display:
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• Rate - modifies cycle time. Default is 100% and can be modified from
0%-2000%.

• Size - modifies scale. Default is 100% and can be modified from 0%-
2000%.

• Shape (Vertical or Horizontal as defined by the {Mode} button) - Default
is 100% and can be modified from 0%-2000%.

• Axis - Default is 0° and can be modified by +/- 180°.

Use the encoders or softkeys to adjust the effects while watching the effect on
stage.

Example:
Effect 1 is a step effect with the On State set to 50 and the Off State set to 10.
If Size is set to 50, the On State will be set to 50% of 50 and the Off State will
be 50% of 10. So On would be 25 and Off would be 5.

The effect itself can be accessed for editing from this display by pressing {Edit} - any changes
made directly in the effect status display are made to the effect itself and must be stored. Cue
level overrides also must be stored or updated to the required cue, but do not impact the basic
effect itself.

Effect attributes modified in the effect status display can be reset to their previous values using
the softkeys:

• {Rate} [Enter] - resets the rate to the previous value.

The properties of an effect that can be modified at a cue or sub level will display at the bottom
of the Effect Status display and in the Effect Channel Display (on the facing page) (which is
access by pressing [Shift] & [Effect]). Click on a column to make changes from a list of available
options.

Several color indicators are used in the Effect Status Display. Those colors and their meanings
are:

• Grey - property is drawn directly from the effect.
• Red - property has been manually modified but not stored.
• Blue - property is an override to the saved effect.
• Magenta - property is tracking from a previous cue.

Clicking on the Attributes column will open the Effect Attribute Override display. From that
display, you can access most of the same properties as those found in the Effect Editor. This
display allows you to make modifications to properties, and store those modifications in a cue or
submaster.
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{Restart Effect} is an atrribute that can only be accessed from this display. When enabled,
{Restart Effect} will cause an effect to restart whenever the cue is fired. This attribute is applied
to the cue that the effect is stored in and not in the effect itself.

Note: {Repeat on Go} is similar to {Restart Effect} but it is applied to the effect. For
more information on {Repeat on Go}, see Effects Editor (on page 341).

Effect Channel Display
In the Effect Channels Display, you can override certain effect properties per channel at the cue
level. To open this display, press [Shift] + [Effect], [Tab] [8], or select the effect channel icon
from the display management home screen.

The following properties can be overridden:

• Rate
• BPM
• Size
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• Axis (Focus Effects Only)
• H Form (Focus Effects Only)
• V Form (Focus Effects Only)

Note: To add a channel level override, first you will need to be in the Effect Channel
display with the effect running.

[2][6]<Effect><1>{Rate}[6][Enter] - to change the rate for just channel 26. With the effect
running, the console will default to the running effect number. You may need to select the
effect first ([Effect] [n] [Enter]). This will open the effect status display, and you will have access
to the effect softkeys.

In the effect status display, an “+” will display by any effect property that has a channel level
override.

You can then store these channel overrides in a cue by using [Record] or [Update].

Step Effects
In step effects, each step contains an on-state and an off-state. The on-state is the action the
channels in the step should take when the step is active. The off -state is the action the channels
in the step should take when the step is not active. Step effects are a quick and easy way to
build simple chases.

When building step effects, channels must be defined for each step. This is different from
absolute and relative effects.

Once complete, you may play back the effect on all channels embedded in it by pressing [Recall
From] [Effect] [x] [Enter]. Or you may specify only certain channels to play back from the
embedded channel list.

A step effect is displayed in a chart with the following columns:

• Step - indicates the step numbers.
• Channels - displays the channel(s) in the step.
• Param - displays the parameter (if other than intensity) controlled by the step.
• Step Time - time from triggering the associated step to triggering the next step.
• In Time - the length of time for the channels to fade to the “on-state”.
• Dwell Time - the length of time the step remains in an “on-state”.
• Decay Time - the length of time it takes for the channels to fade to the “off-state”.
• On State - the parameter level (in%), or referenced data to be used for the on-state.
• Off State - the parameter level (in%) or referenced data to be used for the steps off-state.

If you want the “off-state” to be the background state from playback, select the column
and press [At] [Enter].

All times are entered from the keypad in minutes and seconds, tenths and hundredths.
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If an effect step is on the command line or indicated in the blue text to the left of the command
line, entering a number on the command line will default to selecting a step for the current
selected effect.

If no step is displayed, the command line will default to an effect number.

Programming a Step Effect
Below is the process used to program a step effect.

Example:
To open the effects list press:

• [Effect] [Effect]

Establish the number of the effect by pressing:
• <Effect> [1] [Enter]

The CIA will repaint with unpopulated fields for the new effect. Assign the
effect as “step” by pressing:

• <Type> {StepBased}

The effect will appear in the list and the CIA will repaint with the default
entries for the effect and a step chart for the effect. Define the number of steps
by pressing:

• {Step} [1] [Thru] [6]

The steps will populate the chart and will remain selected. To make identical
changes to all steps at once, you may now use the page arrow keys to navigate
the chart. To make changes to only a single step, specify only one step in the
command line, default values are drawn from the previous step.

After paging to the “Channels” column, specify the channels for the effect.
• [1] [Thru] [1] [2] [Enter]

Channels 1 through 12 will be broken up and distributed through the steps in
the chart. Choose the parameter you would like in the effect by pressing:

• {Parameters} <Intensity> (Intensity is assumed unless another parameter
is specified)

All steps are now intensity based. Use the page arrows to access the “Step
time” column. Enter the desired step time:

• [1]

Page arrow to the Dwell Time (In time is left at 0) column and enter a dwell
time:

• [1]

Page arrow to the Decay Time column and enter a decay time:
• [.] [2] [5]

Page arrow to the On State column and enter the on state percentage:
• [1] [0] [0]

Page arrow to the Off State column, or use the softkeys to go to the desired
field, and enter the off state percentage:

• [5]

Adjust any of the effect details on the right side of the CIA by pressing the
appropriate detail button and making changes (see Effects Editor (on
page 341)).
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Note: The cycle time is an aggregate of all of the timing in the effect and indicates
how long it will take to make one full pass through the effect. If the cycle time is
modified by the keypad or the encoder, it proportionally adjusts all of the timing within
the effect.

Range for On State and Off State
You can apply a range of levels to the on state and off state for the steps. You can either apply a
range using the percentage or by using a palette.

Example:
Using the above example, select steps 1 through 6.

• {Steps} [1] [Thru] [6] [Enter]

Page arrow to the On State column and enter the on state range:
• [1][0] [Thru] [1][0][0] - assigns the range starting at 10 and ending at 100

to steps 1 through 6. The range between 10 and 100 will be evenly
divided between the available steps.

-or-
• [Intensity Palette] [1] [Thru] [5] - assigns intensity palettes 1 through 5 to

the steps 1 through 6. Steps 1 through 5 will be assigned to palettes 1
through 5. Step 6 will be assigned to intensity palette 1. The range will
wrap to fill any available steps.

Inserting a Step
To insert a step anywhere in the effect, specify the step you wish the new step to be inserted
before.

• [Effect] [1] {Step} [4] {Insert} [Enter] - Inserts a new step before step 4. If step four does
not exist, it also creates the steps necessary to have “step 4” and then places a step
ahead of it as well.

Inserted steps result in all succeeding steps to be bumped one place lower in the effect. In the
above example, by inserting before step 4, step 4 would become step 5, step 5 would become 6
and so on. The inserted step would become the new step 4.

Deleting a Step
To delete a step from a step-based effect, specify the effect in the command line and press
delete:

• [Effect] [1] {Step} [4] [Delete] [Enter] [Enter]
• [Effect] [1] {Step} [4] [Thru] [8] [Delete] [Enter] [Enter]

Absolute Effects
Absolute effects are a listing of sequential actions that channels are to take. They differ from
step effects in that there is no on/ off state, rather they define progressive behavior from one
action, to the next, to the next, and so on. The best example of this is that palettes and presets
can be used as actions in absolute effects.

Absolute effects differ from relative effects (which are also progressive) in that you are
specifying exactly what actions you want the lights to take, rather than mathematical offsets
from the current state (relative effects).
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Absolute effects also do not contain an embedded channel list. Therefore, the effect must be
applied to channels in order to be played back.

Absolute effects are displayed in a chart with the following columns:

• Action - displays the action number.
• Param - displays the parameter (if other than intensity) controlled by the action.
• Step Time -time from triggering the associated action to triggering the next action.
• Time - the time for the action to fade in.
• Dwell - the duration of the action before moving to the next action.
• Level - indicates either the level of the parameter specified in the effect, or the referenced

value for the channel(s) to perform (Palette or preset as defined in the command line).

In the above image, actions 1 through 7 indicate referenced values in the “Level” column
(palettes or presets), though these values can be absolute data as well.

If an effect action is on the command line or indicated in the blue text to the left of the
command line, entering a number on the command line will default to selecting a action for the
previous selected effect.

If no action is displayed, the command line will default to an effect number.

Default step times will display in gray and in parentheses, and assigned step times will display in
white without parentheses.

Note: The default step time is the time value plus the dwell value.

If no step time has been assigned, the action will begin once the fade and dwell times for the
previous action have completed. If a step time has been assigned, the next action will begin
after that set amount of time has elapsed.

You can also define specific parameters for Absolute effect actions. To apply a parameter to a
specific action, click in the Param column and select the desired parameter.

Programming an Absolute Effect
Below is the process used to program an absolute effect.

Example:
To open the effects list press:

• [Effect] [Effect]

Establish the number of the effect by pressing:
• [Effect] [8] [Enter]

The CIA will repaint with unpopulated fields for the new effect. Assign the
effect as absolute by pressing:
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• <Type> {Absolute}

The effect will appear in the list and the CIA will repaint with the default
entries for the effect and an action chart for the effect. Define the first action
by pressing:

• {Action} [1] [Enter]

The action will populate the chart and will remain selected. You can also create
a range of actions at once, using the [Thru] button, if desired. Use the page
keys to navigate to the different columns

After arrowing to the “Time” column (or using the softkeys), specify the fade in
time for the actions.

• [5] [Enter]

Page arrow to the Dwell column and enter a dwell time:
• [5] [Enter]

Page arrow to the Level column and enter the desired referenced target:
• [Color Palette] [5]

Page arrow down and a new action will be created. All fields default to the
values in the previous action. Page to the next action in the Level column and
enter the referenced target:

• {Color Palette 8}

Page arrow down to the next action in the Level column and enter the
referenced target:

• [Color Palette] [2]

Page arrow down to the next action in the Level column and enter the
referenced target:

• {Color Palette 4}

Adjust any of the effect details on the right side of the CIA by pressing the
appropriate detail button and making changes (see Effects Editor (on
page 341)).

Range for Level
You can apply a range of levels to the actions. You can either apply a range using the
percentage or by using a palette.

Example:
Using the above example, select actions 1 through 6.

• {Actions} [1] [Thru] [6] [Enter]

Page arrow to the level column and enter the range:
• [1][0] [Thru] [1][0][0] - assigns the range starting at 10 and ending at 100

to actions 1 through 6. The range between 10 and 100 will be evenly
divided between the available actions.

-or-
• [Color Palette] [1] [Thru] [3] - assigns color palettes 1 through 3 to the

actions 1 through 6. Actions 1 through 3 will be assigned to palettes 1
through 3. Action 4 will be assigned to color palette 1. The range will
wrap to fill any available actions.

Effect Background Value Modification
For Step and Absolute effects, you can use [+], [-], and [/] to adjust the background value .
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Note: When using [-], you will need to preface the command with [+] if you want to
remove from the current value.

Note: [/] is used to scale the value by a percentage. See the example below.

Example:
• Effect 1 is a step effect with the on state set to 100 and the off state set

to - 50% for all steps. To set the step off state to -50%, you would use
the following syntax [Effect][1] [Step] [1], click on the Off State column
in the Effects editor, then type [+] [-] [/] [5] <0> [Enter]. If the channels
in the effect have a background value of 50, the off state for each step
would be 25.

• Effect 2 is an absolute effect. To set a level at + 20 of the background,
you would use the following syntax, [Effect][2] {Action} [1], click the
Level column in the Effects editor, then type [+] [2]<0> [Enter]. If the
channels in the effect have a background value of 50, the level 1 in the
effect would be at 70.

Beats Per Minute
For step-based and absolute effects, you can set a beats per minute (BPM). For step-based
effects, BPM affects the Step, In, Dwell, and Decay times, and for absolute effects, this affects
the time/ dwell. Note that BPM impacts the effect directly.

There are two different ways for assigning BPM to effects:

Directly setting BPM
If you know the BPM, you can assign that directly to the effect by using the {BPM} softkey,
which is available when in the effect editor display.

• [Effect] [1] {BPM} [1][9][0] [Enter] - sets the BPM of effect 1 to 190. The step times will
be adjusted for step-based effects, or the time/ dwell will be adjusted for absolute effects.

The BPM will display on the right side of the effect editor beside the effect number/ label.
Editing the cycle time, the step time for a step-based effect, or the time/ dwell for an absolute
effect will remove the BPM.

Learning BPM
If you don't know the desired BPM, you can learn the BPM.

From Live, with the effect running:

• [Effect] [1] [Learn] [Time] - posts Effect 1 Learn Time Sample BPM to the command line,
and opens the effect editor display.

While in this mode, press [Enter] to establish the BPM. The console will use an average of the
last three times you press [Enter] in this mode to calculate the BPM. Pressing [Learn] again will
stop this mode.

In this mode, every time the BPM changes, a live running effect will be modified accordingly
without stopping.
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Learning Discrete Step Time
In learning discrete step time mode, every time you press [Enter], the time since the last press of
[Enter] is used to set the next step's step time for a step-based effect, or the next step's fade/
dwell time of an absolute effect.

• [Effect] [1] [Learn] [Time] [Time] - posts Effect 1 Learn Time Discrete Steps to the
command line, and opens the effect editor display.

Pressing [Learn] again will stop this mode.

Instead of pressing [Enter], you can press [At] while in this mode to add new steps to the end of
the effect. Pressing [Enter] will send you back to the first step in the effect.

BPM as a Cue Level Override
BPM can be applied to an effect or individual channels as only a cue level override in Live and
Blind. As a cue level override, the effect step/ action times will not be affected.

Note: The effect editor cannot be open when applying a cue level override. The
effect status display does need to be open though. You can open the effect status
display from the home screen or by pressing [Effect] while in live.

With an effect recorded into a cue and playing back in live, [Effect] [1] {BPM} [3][0] [Enter] will
change the BPM of the effect running. This change will happen immediately but the step or
action times will not change. You can see the BPM value, which will be in red, in the Effect
Status display.

When the cue is updated or recorded with the new BPM, an “*” will appear next to the effect
number in the Ext Links column of the PSD and the cue list. The BPM value in the effect status
display will now be displayed in blue.

[1] [Effect] [1] {BPM} [3][0] [Enter] will only change the BPM for channel 1. A “+” will display
in the BPM column of the effect status display, and the BPM will display in red in the effect
channel display.

Once the cue is updated or recorded, the BPM will display in blue in the effect channel display.
The “+” will still be displayed in the effect status display, and an “*” will appear next to the
effect number in the Ext Links column of the PSD and the cue list.

Multiple Intensity HTP Effects
Multiple intensity HTP effects are either step or absolute effects running on HTP submasters or
cue lists. For multiple intensity HTP effects to run correctly, they must be recorded and played
back from different sources.

For example, you create three separate step effects. Each effect impacts the same channels. For
the three separate effects to run correctly you need to record them to three separate effect
submasters or cues in separate cue lists. Either method will allow for each effect to run together
according to the rules of HTP. But, for example, if you were to have three separate effects
running on three separate effects submasters and you try to record that into one cue, the cue
will only run the effects that were currently at the highest level at the moment of the record.

Relative Effects
A relative effect is an offset from the current state of a channel parameter. There are three
different types of relative effects: Focus Effects (on the facing page), Color Effects (on the facing
page) , and Linear Effects (on page 356). Each of the these effect types have a graphic editor
designed specifically for the parameters involved.
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Relative effects have many of the same properties and attributes as step-based and absolute
effects.

Eos Family consoles are preprogrammed with relative effects which represent some of the most
commonly used patterns and parameters. These are automatically visible in the effects list and
can be manipulated using the encoders to conform to your needs. You may also custom build
relative effects.

Note: As you learn to use the effects editor with relative effects, it is recommended
that you experiment with the preprogrammed effects until you understand the
fundamentals and how effects can be altered.

Focus Effects
Focus effects are designed to impact a channel’s pan and tilt parameters. These are represented
in the horizontal and vertical axes of the graph in the effects editor. They can be created from
live or blind and the properties can be set in the effects editor as any other effect (see Effects
Editor (on page 341)).

New focus effects default to a circle. You can clear this and draw your own shape by pressing
{Edit}>{Clear} and drawing on the graph with your finger or the mouse. Press {Apply} when you
are done. Other pre-made focus effects can be modified in the same manner. The green arrow
indicates default direction of motion, which can be modified in attributes.

When adjusting the form of a focus effect, you can hold down [Shift] while using the horizontal
encoder to change the vertical form.

Color Effects
Color effects impact only color parameters. Hue and saturation offsets can be used which are
represented in the horizontal and vertical axes of the graph in the effects editor. The
{Parameters} key within a color effect displays the various color mechanisms used in any
patched channels.

New color effects default to a circle. You can clear this and draw your own shape by pressing
{Edit}>{Clear} and drawing on the graph with your finger or the mouse. Press {Apply} when you
are done. Other pre-made color effects can be modified in the same manner. The green arrow
indicates default direction of color shift, which can be modified in attributes.
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Linear Effects
A linear effect does not have to be parameter specific. Rather it can simply be a reference to a
linear diagram which can be applied to any parameter. You can redraw the linear diagram for
an existing linear effect by pressing {Edit}>{Clear} and then tracing the diagram on the graph
with the mouse or your finger. Press {Apply} when you are done.

Define a Pattern Shape
Shapes can be defined for any relative effect (focus, color, or linear). You can either draw a
pattern from scratch or use one of preexisting patterns as a starting point.

To define a shape, press the {Edit} softkey beneath the pattern editor. The softkeys will change
to {Apply}, {Restore}, {Clear}.

1. Press {Clear} to clear the pattern.
2. Draw a new pattern using your finger (or the mouse), or select a preexisting pattern. If you

want to return to the original pattern, press {Restore} before pressing apply.
3. When you have the proper pattern drawn, press {Apply}. The pattern will be applied to

the effect.

Note: If you delete a preprogrammed effect (for example, after making changes to it)
the effect will return to its default value. You can also copy effects to another effect
location and modify them from there. This will leave the original effect untouched.

• [Effect] [904] [Copy To] [8] [Enter]

The following tools are also available to edit the curve with the mouse or touchscreen:

• Draw - draw a new line for linear effects or append points to focus effects
• Select - select points of the curve (if no points are selected, all are changed)
• Move - move selected points, can also phase-shift the curve of linear effects in steps of 30

degree (only if no partial selection was made)
• Form - freehand scale the curve horizontally and / or vertically
• Scale - proportionally scale the curve (focus effects only)
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• Gamma - apply a log function to the curve (linear effects only)
• Size - scale focus effects on both axis
• Rotate - rotate focus effects around the center of the selected points

The following actions are available when editing the curve:

• Clear Selection - selects all points at once
• Smooth - smooths the selected points
• Mirror Hor. / Vert. - mirrors the curve
• Subdivide - adds one point on each selected segment (useful to move that point or change

the behavior of smooth)
• Remove - removes the selected points
• Undo - undoes the last operation
• Redo - redoes the last operation

Programming a New Relative Effect
Below is the process used to program a new relative effect.

Example:
To open the effects list press:

• [Effect] [Effect]

Establish the number of the effect by pressing:
• [Effect] [4] {Type} {Linear/Focus/Color} [Enter]

The effect will appear in the effect list and the CIA will repaint with the effect
details visible. Manipulate the effect using the encoders, effect graph, and / or
property fields so that the effect meets your needs (see Effects Editor (on
page 341) for details on effect properties and encoders).

Preprogrammed Rainbow Effects
Two preprogrammed rainbow linear effects are available in the effect list. Effect 917 is a
Rainbow RGB effect, and effect 918 is a Rainbow CMY effect. These effects are for a rainbow
on native color parameters that will fade hue from 0 to 360 with saturation at full, when the
parameters are at their default levels. 0 is the default for CMY, and Full is the default for RGB.

Apply an Existing Effect
Once an effect has been created, it will appear in the effects list. To apply an existing effect,
press:

• [Select Channels] [Effect] [x] [Enter]

or using the direct selects

• [Select Channels] {Effect x}

The selected channels will begin their changes as programmed in the effect.

Note: Since step based effects have an embedded channel list, those effects can be
recalled by [Recall From] [Effect] [n] [Enter] without selecting channels.

Editing Effects Live
To edit an effect while it is running, press:

• [Displays] {Effect Status}
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The effect status display will open in the CIA and any currently running effects will be visible in
the display. Selecting the effect number in the status display will select the effect for editing.
Select the effect you want to edit live by pressing:

• [Effect] [x] [Enter]

Adjust the attributes as described in Effect Status Display (on page 345). Adjustments are cue
overrides and don’t impact the core effect. Changes made to effects in the effect status display
impact only that instance of the effect. The changes will then need to be recorded or updated.

To edit other properties of the effect in live, press {Edit} and the effects editor will open (See
Effects Editor (on page 341). Changes made in the editor will impact the effect itself and all
instances in which the effect is used.

Stop an Effect
Pressing [Stop Effect] [Enter] will stop all running effects.

To stop a specific effect, press: [Stop Effect] [x] [Enter] or [Effect] [x] [At] [Enter].

You may also stop effects on specific channels by [selecting channels] [Effect] [Enter].

You may also remove an effect instruction by [selecting channels] [Effect] [At] [Enter]. This
command will work in live or blind. You can also stop the whole effect by pressing [Effect] [x]
[At] [Enter].

On Element 2, you will need to press [Live] {Fader Control} to see {Stop Effect}.

Assigning a Stop Effect Command
A [Stop Effect] command can be assigned to a list of channels in a cue without an effect
tracking into it, or to a list of channels in a submaster. See Freeze and StopEffect on Submasters
(on page 376) for more information. On Element 2, you will need to press [Live]
{Fader Control} to see {Stop Effect}.

• <channel> [1] [Stop Effect] [Enter] - will create a stop effect instruction for all selected
parameters, if there isn't an effect running on any of the parameters.

• <channel> [1] [Effect] [Enter] - will only stop the currently running effect.

Query and Group Effect
You can use [Query] [Effect] [n], [Query] [Effect], and [Group] [Effect] [n] to select the
channels currently running in the selected effect.

Using [Query] will select the channels in numeric order. [Group] will select the channels in the
order that they were originally selected.

[Query] [Effect] will select all channels currently running effects.

On Element 2, {Query} is a softkey.

Example:
• [3][1] [+] [2][6] [+] [3][0] [+] [2][7] [+] [2][9] [+] [2][8] [Effect] [1] [Enter]

Using [Query] [Effect] [1] will select the channels currently running effect 1. Using
[Next], the channels will be selected in numeric order starting with channel 26.

Using [Group] [Effect] [1] will select the channels currently running effect 1. However,
pressing [Next], the channels will be selected in the order they were originally selected.
In this example, channel 31 would be first, then channel 26.
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Replace With
{Replace With} allows you to replace an effect with another one. All overrides will be preserved.

• [Effect] [1] {Replace With} <Effect> [2] - all channels that were running effect 1 will now
be running effect 2.

Deleting an Effect
To delete an effect, press [Delete] [Effect] [n] [Enter] [Enter]. If you delete one of the default
effects (901 through 918), that effect will return to its default values.

Recording an Effect to a Preset
Effects can be stored in a preset, and those presets can be used to create submasters and cues.
However, the effect's data is only copied to the submaster or cue, it is no longer referenced
through the preset.

For more information, see Effects in Presets (on page 252).

To apply an existing effect, press:

• [Select Channels] [Effect] [x] [Enter]

Recording to a preset, press:

• [Record] [Preset] [x] {Plus FX} [Enter]

Pressing [Effect] after [Record] [Preset] [x] will append {Plus FX} to the command line.

• [Record] [Preset] [x] [Effects] [Enter]

Recording an Effect in a Cue
To apply an existing effect, press:

• [Select Channels] [Effect] [x] [Enter]

Recording to a cue, press:

• [Record] [Cue] [x] [Enter]

Recording to a cue part, press:

• [Record] [Cue] [x] [Part] [x] [Enter]

Effects on Faders
Channels running effects can be loaded onto a submaster. By default pressing the bump button
of the submaster starts or stops the effect.

For the submaster to control the rate and/ or size of the effect, it can be configured as an effects
submaster. To configure an effects submaster, see Submaster Properties (on page 369).

CAUTION: When a submaster is defined as effect, only the effect
information is stored.

There are several submaster button and fader configuration options that affect how effects run.
See Submaster Fader and Button Configuration (on page 373) for more information about those
options.

Configuring an Effect Submaster
To configure an effect submaster, press:
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• [Sub] [x] {Properties} [Enter]

Note: The {Properties} softkey will open the submaster properties display in the CIA.
For more information, see Submaster Properties (on page 369).

Recording an Effect to a Submaster
To apply an existing effect, press:

• [Select Channels] [Effect] [x] [Enter]

Recording to a submaster, press:

• [Record] [Sub] [x] [Enter]

A submaster can be configured to be an effect submaster. You can configure at the same time
as you record the submaster. Before you hit [Enter], hit the softkey for {Properties} to open the
submaster properties display in the CIA. Select Effect as the mode. For more information, see
Submaster Properties (on page 369).

Running an Effect from a Submaster
The way effects are played back from a submaster depends on its mode, and whether the
submaster is set to be a proportional fader or an intensity master.

Below is an example of four different submasters, in different modes, with the same effect
stored to them.

Effect on an Additive/ Proportional Submaster
The submaster contains the intensity, pan/tilt data, along with the effect. Pressing the bump
button starts the effect. The fader controls values not affected by the effect. Pressing the bump
button again stops the effect.

Effect on an Additive/ Intensity Master Submaster
Pressing the bump button marks the lights, and starts the effect. The fader brings up any
intensities stored in the submaster. Pressing the bump button again stops the effect.

Effect on an Effect/ Proportional Submaster
Pressing the bump button starts the effect. The fader controls the rate and/ or size based on the
effect’s entry behavior. Pressing the bump button again stops the effect.

Effect on an Effect/ Intensity Master Submaster
Pressing the bump button starts the effect. The fader controls the rate and/ or size based on the
effect’s entry behavior. Pressing the bump button again stops the effect.

In other words, there is no difference between a proportional fader and an intensity master
when the submaster is configured to be an effect submaster.

Global Effects Fader
A fader can be mapped as global effects in the fader configuration display, [Tab] [3][6]. This
fader type is used to master all effects or specific effects based off of the current filtering applied
to the fader.

Note: You can use multiple global effects faders.



Effects 361

The following filters can be applied to effects running on:

• Cue lists - you can specify certain cue lists or select {All} or {None}. Not available on
Element 2.

• Submasters - you can specify certain submasters or select {All} or {None}.
• Channels - you can specify certain channels that will be affected by the global effects

fader. See Channel and Parameter Filters on Faders (on page 106)
• Parameters - you can specify certain parameters that will be affected by the global effects

fader. See Channel and Parameter Filters on Faders (on page 106)
• Effects - you can specify certain effects or select {All} or {None}.
• Manual - when on, the global effects fader will only affect manually run effects. By

default, this is off.

Note: If no filters have been applied, the fader will master all effects.

Fader Options
The following fader options are available for a global effects fader:

• Effect Rate - fader centers to home. It controls the rate of any running effects (same
behavior as using rate via the Effect Status Display). Min is 0, and Max is 200.

• Effect Size - similar to Effect Rate but for effect size. Min is 0, and Max is 200.
• Fader Disabled - no action is assigned to the fader.
• Effect Master - masters the entry/ exit mode of the effects (size, rate or both).

Button Options
The following options are available for global effect buttons:

• Bump - plays back the effect at 100% of the recorded level. It will continue to do so until
released.

• Freeze - halts all effect activity on the fader.
• Start Stop Effect -starts the effect while ignoring dwell times. Will stop effects if any are

running.
• Button Disabled - no action is assigned to the button.
• Macro - allows you to assign a macro as a button action.

Delaying Effects
A delay can be placed on an effect in a cue or submaster by using the syntax [Effect] [n] [Delay]
[n] [Enter]. [Effect] [n] [Delay] [Enter] removes the delay.

Note: If an effect delay is set in live, the cue or submaster must be recorded to
include the delay.

The Effect Status display has a delay column to show when a delay has been applied to an
effect. When an effect is in delay mode, the column will display the countdown for the delay.

When an effect is delayed, a “*” will display by the effect number in the playback status display
FX column.

Effects Variables
Eos v3.0.0 introduced variables for StepBased and Absolute effects, which give additional
options for altering effects on the fly.
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Using Variables in Effects
First, insert one or more variables into a StepBased or Absolute effect using the {Variable}
softkey. Available fields are Timing, On State, and Off State for StepBased effects, and Level
and Timing for Absolute. A maximum of ten variables can be used.

Variables can be substituted for any number in an effect, including for relative timing, and to
define the number of a target, such as a Color Palette. Variables can also be used more than
once in the same effect.

Variables need to be defined before the effect can be run. This can be done in the Effects editor
by selecting the Attributes field.

Define your variables by selecting each one and giving them a value.

Altering Effects in Progress
Variables can also be defined in the Effects Status Display (ESD) before an effect is run, or
redefined after an effect is already running.

Select {Attributes} to define or redefine variables. If variables are redefined in an already-
running effect, the ESD will show the effect in red, with an asterisk (*) next to the effect number
to indicate that it was modified. Store any manual changes using [Record] or [Update] as
normal.
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About Park
The park instruction allows you to set a channel or parameter to a specific value and have it
remain at that level on stage (live mode), prohibiting manual control override, cue or submaster
playback modification. Park may also be used to place a scaling instruction on the intensity
output of a channel.

Note: A parked channel intensity is not impacted by grandmaster or blackout
operations.

Parked values are withheld from all record targets, but you can manually set levels for parked
channels and parameters and store those values into record targets. Keep in mind that the
values set and stored in live do not actually output to the system if the parameter is parked.

When channels or parameters are parked, the LED on the [Park] button illuminates and the live
display will indicate “Parked Channels” or “Parked Dimmers” in the top right corner. In
addition, any parked channel or parameter will be indicated with a white channel number and a
“P” will be visible in the channel. When the parked channel or parameter is unparked, it reverts
to the level the console is currently providing, or its default value if there is no current
instruction.

Park instructions are not subject to partition control. Any programmer/ operator may park and
unpark channels/ parameters as needed. Parked parameters set by radio focus remotes (RFR)
will automatically unpark when the associated device goes offline.

Channels, parameters and outputs can be parked and unparked from live and from the park
display.

Note: Output from parked channels or parameters is not displayed in Augment3d (on
page 433).

Park Display
You can access the park display by pressing [Park] [Park] or [Tab] [2][0]. The park display
shows all parked channels and parameter values on the top half of the screen and all parked
addresses (dimmers) on the bottom half of the screen. Parked channels displayed on the top of
the screen can be displayed in the summary and table views seen in live /blind by using the
[Format] key.

When a channel intensity is parked, the parked value will be indicated in white text. When a
channel has a non-intensity parameter that is parked, that parameter will also be indicated with
white text. The display also provides detail of which user parked the channel and /or parameter
(when multiple users are on the system).

When an address is parked, it will appear in the bottom half of the park display. The address,
parked value, affected channels and parameters are indicated.

Parked Values in Live
Channels and parameters may be parked and unparked from the live display. Following are
some examples:

Note: To park a channel to a specific dimmer intensity level must be accomplished
from the Parked Channel display. Access the Parked Channel display by pressing [Tab]
[2][0] or {Park}[Park][Park] twice.
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Note: Parked values will be displayed in the park display and in [About] & [Park].

To park a channel, parameter, or group from live:

• [2] [At] [5] [0] [Park] [Enter] - parks channel 2 intensity at 50%
• [2] {Intensity} [Park] [Enter] - parks the intensity of channel 2 at its current value
• [2] [Park] [Enter] - parks all parameters of channel 2 at their current settings

Note: If a channel list is constructed in which some channels are parked and some
are unparked, [Park] [Enter] will unpark them all. A confirmation will be required.

• [2] [At] [Park] [Enter] - if channel 2 is unparked, this command parks intensity at the
current value. If the intensity for channel 2 is parked, this command unparks intensity.

• [2] [Color Palette] [8] [Park] [Enter] - parks the color for channel 2 in color palette 8.
• [Group] [Cue] [6] [Park] [Enter] - parks all the channels stored in cue 6 at their current

levels.
• [Park] [Enter] - clears all parked channels and scaled park instructions (see Scaled Parked

Values in Live). A confirm is required. When a channel is unparked, it reverts to the level
the console is currently providing, or its default value if there is no current instruction. A
confirmation will be required.

You can use [Recall From] [Park] to set a channel or parameter to the same level as the current
park value. See Recall From Park (on page 310) for more information.

Scaled Parked Values in Live
A scaled parked value allows the intensity output (only) to be modified proportionally in live.
Scaled park values are ignored when storing a record target. The setting on the display indicates
what should be stored, not the actual scaled value. An example of how to set a scaled parked
value in live includes:

• [3] [At] [/] [1] [2] [5] [Park] [Enter] - sets a scaled value of 125% on channel 3 intensity.
In other words, whenever channel 3 is active, it will be active 25% higher than its current
setting.

• [3] [At] [/] [8] [5] [Park] [Enter] - sets a scaled value for channel 3. Whenever channel 3 is
active, it will playback 15% lower than its current setting.

Remove the scaled parked value:

• [3] [Park] [Enter] - unparks a scaled intensity for channel 3.
• [Park] [Enter] - unparks all parked channels.

A channel can have both a scaled parked value and a parked intensity value. Keep in mind that
the parked intensity has priority over (and overrides) scaled park values.

Parked Addresses in Live
DMX addresses can be parked in Live. Below are some examples of parking an address in Live:

• [Address/Patch] [5] [At] [5] [0] [Park] [Enter] - parks output 5 at 50% intensity.
• [Address/Patch] [5] [Park] [Enter] - unparks output 5.
• [Address/Patch] [Park] [Enter] - unparks all parked outputs.
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Park Values from the Park Display
You can park and unpark channel parameters or addresses from the park display. Open the
display by pressing [Park] [Park] or [Tab] [2] [0]. While in this display, it is assumed that you
want to park channels or parameters, therefore the use of the [Park] key is not necessary when
parking, but is used for unparking. You can also use [At] [Enter] to unpark.

Following are examples for parking channel parameters from the park display:

• [3] [At] [4] [5] [Enter] - parks channel 3 at 45%.
• [3] [Color Palette] [4] [Enter] - parks color for channel 3 at color palette 4.

You can use the {Offset} softkey to aid in channel selection. For a list of the {Offset} options,
see Offset (on page 190).

Following are examples for clearing parked values while in the park display:

• [Select Active] [Park] [Enter] - clears all parked channel parameter values.
• [channel list] [Park] [Enter] - unparks channels in the list.
• [channel list] [At] [Enter] - unparks channels in the list.

Below are examples for parking addresses in the park display:

• [Address/Patch] [5] [At] [5] [0] [Enter] - parks address 5 at 50% intensity.
• [Address/Patch] [5] [At] [Enter] - unparks address 5.

Note: When parking a range of addresses in Park, using [Thru] will only park the
intensities. If you want to park all of the addresses and parameters within the selected
range, you will need to use [Thru] [Thru].
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About Submasters
Submasters can store any parameter data for channels. When storing from Live, Record Only
and Record can both be used to determine what contents are stored. You can copy cues,
presets, or palettes to a submaster as well. Channels running effects can be loaded onto a
submaster. See Effects on Faders (on page 359)

Submasters can be controlled by faders or by the keypad. Faders can be configured as
submasters (see Submaster Properties (on the facing page) ) or they can be defined while
programming.

Note: You can record up to 1000 submasters.

In Blind, submasters can be created by using the [Thru] [Thru] syntax.

• [Sub] [1] [Thru] [Thru] [1] [0] [Enter] - will create subs 1 through 10.

When set as a submaster, the bottom buttons beneath the fader can be configured for different
functions. See Submaster Fader and Button Configuration (on page 373) for more information.

It is possible to program upfade, dwell, and downfade times in association with the submaster
bumps. See Submaster Properties (on the facing page) for more information.

What does a Blinking LED Mean?
When a submaster bump LED is blinking, it means that the submaster must be homed due to
either changes to its content or to its mode. In either case, reset the submaster by dropping it to
zero and the moving it back to the desired position. The LED will also blink when the submaster
is in a “Hold” state via bump button timing.

Paging Submasters
Element 2 has a total of 1000 submasters. The fader position switch can be placed in faders 1-40
or 41-80 modes. Element 2 will default to the first 80 faders. To page through the available
submasters, hold down the {Page Subs} softkey in the Live display. The bump buttons will light
up in green, and the bump buttons that correspond to the currently selected pages will flash.
Press the corresponding bump button to go to that page. The fader ribbon will change to show
the submaster pages.

Recording a Submaster
You can record current stage contents directly to a submaster. To do this, set levels in live as
needed then record them to the submaster. See the following examples:

• [Record] [Sub] [5] [Enter] - records all current values to submaster 5.
• [Record Only] [Sub] [5] [Enter] - records the manual values of the current stage state to

submaster 5.
• [Record Only] [Sub] [5] [Label] [xxxx] [Enter] - as above, with a label.
• [Record] [Sub] [5] {Properties} - opens the submaster properties window so you can select

properties while recording your submaster.
• [Record] [Load] - records all current values to the fader associated with the load button.

Submaster will be stored with the number associated with the chosen fader.
• [Record] [Both Bump Buttons] - records all current values to the fader associated with the

bump buttons. Submaster will be stored with the number associated with the chosen
fader.
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You can also record selected channel data to submasters as well.

• [Channel List] [Record] [Sub] [5] [Enter] - records all data for the channel list to submaster
5.

• [Channel List] [Record Only] [Sub] [5] [Enter] - records manual data for the channel list to
submaster 5.

Submasters can also be recorded using selective storing, which allows you to specify only the
channels that you want stored.

• [6] [Thru] [1][0] [Record] [Sub] [3] [Enter] - records only channels 6 through 10 to
submaster 3.

• [1] [Thru] [5] {Blue} [Record] [Sub] [6] [Enter] - records only the blue color for channels 1
through 5.

• [1] [Thru] [1][0] {Offset} {Odd} [Record] [Sub] [4] [Enter] - records channels 1, 3, 5, 7, 9
into submaster 4. For more information on using {Offset}, see Offset (on page 190)

If a submaster already has data stored to it, selective store will act as a merge function. Using
the above example of channels 6 through 10 stored to submaster 3, if you were to then store
channel 5 to submaster 3, that would be added to the current content so that channels 5 through
10 are now stored.

If you don't want the data to merge, you can either first delete the submaster to remove the
original content (see Deleting a Submaster (on page 378)), or you can selective store while using
[Rem Dim].

• [5] Record] [Sub] [3] [Rem Dim] [Enter] - records channel 5 to submaster 3 and removes
any previous data from the submaster.

Submaster List
You can access the submaster list by pressing [Sub] [Sub], [Tab] [1][5] or through the browser
(Record Target Lists>Submaster List>[Select]). Either of these commands will open a new tab
for the submaster list or if it is already open on a tab, will bring focus to the list.

The list view includes a list of all submasters including their labels and all properties. You can
navigate within the list by using the [Next] and [Last] buttons or by selecting the desired
submaster from the command line.

Editing Submasters
While in the Submaster list, if you want to edit the contents of the submaster, you can select the
submaster and press {Edit}. This changes focus to the Live/ Blind tab and places you into the
Blind edit mode for the specified submaster. You may also press [Blind] and select the required
submaster from the command line.

Any changes made in this screen are automatically stored. A [Record] or [Update] command is
not required.

Submaster Properties
Faders can be mapped to a submaster in the fader configuration display, or by recording or
loading a submaster. See Fader Configuration (on page 101), Recording a Submaster (on the
previous page), or Loading Submasters (on page 375) for more information.

If a fader has been configured for default mapping in the fader configuration display, the fader
will receive its configuration from the Submaster List. Changes made to a submaster in the
submaster list will be shared with any default mapping faders loaded with that submaster. If
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changes are made to a fader set to default mapping in the fader configuration display, those
changes will also happen in the Submaster List. If set to Local, any changes made in the fader
configuration display will impact only that instance of the content.

The following options are available when a fader is configured as a submaster:

Mode
You may define your submaster as additive (contributes to the live output), inhibitive (limits live
output) or an effect submaster. Eos defaults to submasters being additive.

Additive submasters are indicated by a green LED and a yellow fader icon in the fader ribbon.

Inhibitive submasters display these indicators in red. Channels mastered by an inhibitive
submaster are indicated with an “I” next to the intensity value in the channel display in live.
Inhibitive submasters do not provide levels to the stage picture, they limit them (similar to a
grandmaster). It is possible to put non-intensity parameters onto an inhibitive submaster, but it
must be done from blind.

For more information about effect submasters, see Effects on Faders (on page 359).

Master
A fader can be assigned as a Master. When it is a master, its behavior as a Proportional Master
or Intensity Master (I-Master) is drawn from this setting.

Proportional Master
When a submaster is proportional, the slider will control all contents of the submaster (intensity
and non-intensity parameters) when moved from zero. When a proportional sub is returned
toward zero, channel will be returned to their previous level.

The bump button can be used to bump all values to their recorded levels in the submaster, or, by
assigning timing values, fade the contents of the submaster up or out. Eos defaults to
submasters as proportional.

Intensity Master
When set to intensity master, the slider will control intensity only. The bump button can be used
to preset (mark) non-intensity parameters stored to the submaster. If the bump is not pressed
before the slider is moved, the slider will snap the non-intensity-parameters to their target
values. Once the non-intensity-parameters are at their end state, the slider only controls
intensity. When dropped toward zero, controlled intensities will be faded toward zero.

When non-intensity parameters on a intensity master submaster have been marked using the
bump button, the LED on its bump button will blink to tell you that the non-intensity parameters
have been marked.



Submasters 371

Pressing the bump button for an intensity master submaster that is currently bumped will release
the non-intensity parameters using the bump button timing. Its bump button LED will also be
turned off.

Note: For channels that have been set to GM Exempt in Patch, Intensity Master
control will not impact the intensity of those channels. See Attribute Section (on
page 144) for more information.

HTP
Intensity playback behavior can be set to HTP (highest takes precedence) or LTP (latest takes
precedence). Non-intensity parameters are always LTP. Eos defaults all submasters to HTP. For
more information on HTP and LTP see HTP vs. LTP (on page 9).

Restore
Submasters can be placed into restore modes of minimum or background, which is the default.
When a submaster is in the restore to background mode, the restore column of the submaster
list display will be blank. When in minimum mode, 'Min' will display in the restore column.

The restore mode of background means that when the submaster is returned to zero, control will
be restored to the background value, such as another submaster or a cue.

The restore mode of minimum means that when the submaster is faded down, control does not
go to the previous background state but to the parameters’ minimum value.

Priority
There are 10 levels of priority for submasters. 1 is the lowest and 10 is the highest. The default
priority level is 4.

Shielded
Submasters can be shielded, which means that their content is automatically made exclusive
and can't be controlled by anything other than that submaster and park, including by manual
control. Shielded has a higher priority than 10.

Channels stored to shielded submasters will display in yellow with a superscript ‘s’ beside it.

If channel parameters stored to shielded submasters were previously stored to cues or other
submasters, those instructions will be ignored on playback.

If the same channels are assigned to more than one shielded submaster, control of those
channels will be shared on either a LTP or HTP basis depending on the settings for the
submasters.

Background
Submasters can have their background states disabled. Background states are enabled by
default. When enabled, the content of the submaster will act as a background or previous state
for other cues and submasters.

When a submaster has its background state disabled, a “D” will be displayed in the Submaster
List background column.

Example:
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Cue 1 has channel 10 at 25%. Submaster 1 is raised and has channel 10 at
50%. Submaster 2 is then brought up and has channel 10 at Full. When
submaster 2 is lowered to zero, control will be returned to submaster 1. If
submaster 1 is lowered to zero, control will return to cue 1.

Using the above example, if submaster 1 has its background state disabled,
which makes its content unavailable as a background state, then when
submaster 2 is lowered to zero, control would return to cue 1 and not to
submaster 1.

Background Priority
Background can have a priority assigned to it. Background priority releases to the highest priority
content that previously had ownership, provided that content has not be turned off or released.

There are 10 levels of background priority for submasters. 1 is the lowest and 10 is the highest.

Up Time
This is the time for the submaster to fade from its home position to its target position (0 to Full if
additive, Full to 0 if inhibitive). The default time is 0.

Dwell Time
This is the time the submaster look will hold before starting the downfade. This can be set to a
specified time, or to “Hold” or “Manual”. “Hold” time maintains the submaster values until the
bump is pressed a second time. “Manual” time applies the submaster values only as long as the
bump is held. The default is “Manual”.

Down Time
This is the time for the submaster to fade from its target position to its home position. The
default time is 0.

Stomp Mode
Stomp happens when all the content owned by a submaster is now being controlled by other
targets. The submaster is being removed from the background , and once that happens, it would
not be eligible to fade back. You can assign behavior that will happen when a submaster is
stomped.

The following are Stomp Mode options:

• Off When Stomped - puts the content into an off state, the same behavior encountered
when pressing [Off] & [Load].

• Unload When Stomped - unloads the fader.
• Nothing When Stomped - no action happens to the submaster.
• Release When Stomped -This function behaves the same as Off When Stomped.

Unmark at 0%
When this option is on, marked content controlled by the submaster will automatically be
released when the fader reaches 0%. When the bump button is next pressed, the submaster will
fire. If this option is off, you would need to first press the bump button to reset the submaster
before pressing the bump again to fire it.

Note: This option is for submasters that are set to Intensity Master.



Submasters 373

Exclude
Those exclusions include:

• Exclude From Record - output is not recorded into any other record target.
• Exclude From Grandmaster - content cannot be mastered by a grandmaster.
• Exclude From Inhibitive Sub - content cannot be mastered by an inhibitive submaster
• Exclude From Solo - content will ignore solo. See Submaster Fader and Button

Configuration (below) for more information on solo.

Channel and Parameter Filters
Channel and Parameter Filters can be used to allow only specified data to be played back.
These are playback filters, and do not impact how data is recorded.

For submasters, channel and parameter filters can be set in the following areas:

• Submaster List
• In Live using the {Properties} softkey

Tap or click on {Chan Filter} to assign channels or groups. Tap or click on {Param Filter} to open
a list of available parameters that you can filter.

Note: Filters will travel with their assigned submasters wherever they are mapped.

When a filter has been applied, an indicator will display in the fader ribbon. C will display for
channel filter, and F is for parameter filter.

Press the red [X] to clear the channel or parameter filters listed.

FX Off 0
Starts the effect when master fader is moved from 0, stops the effect when it is moved to 0. This
is enabled by default.

Submaster Fader and Button Configuration
Click or tap on the virtual buttons or fader to see a list of available configuration options.

Button Options
The following options are available for submaster buttons:

• Bump - plays back the submaster at 100% of the recorded level. It will continue to do so
until released, unless the submaster has a time assigned or the {Hold} property set.
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• Group/ Assert - selects all the channels associated with the submaster, if the submaster is
inactive. If the submaster is active, the contents of the submaster will be asserted.

• Assert - regains control of all of the channels associated with the submaster.
• Group Select - selects the channels stored in the submaster. This is the same as [Group]

[Sub] [n].
• Freeze - halts all effect activity on the fader.
• Off - removes the content and if the fader is set to Master, the fader will remain where it

currently is.
• Release - removes the content and if the fader is set to Master, the fader will reset to 0.
• Start Stop Effect -starts the effect while ignoring dwell times. Will stop effects if any are

running.
• Button Disabled - no action is assigned to the button.
• Mark NPs - If no non-intensity parameters are owned by the submaster, it will fade the

parameters on any dark channels in bump up time. If any non-intensity parameters are
owned by the submaster, it releases the non-intensity parameters in bump down time.
Dwell time and mode are ignored.

• Solo - suppresses any intensity values not provided by the associated content while the
solo button is held down. When the button is released, intensity values are restored.
Priority and HTP are ignored. Shielded, park and pixel mapping outputs are not affected
by the solo button.

• Back - fades to the previous cue when fader is assigned to a cue list.
• Macro - allows you to assign a macro as a button action.

Fader Options
The following options are available for a submaster fader:

• Master - fader will be a proportional master, a manual master, or an intensity master.
• Effect Rate - fader centers to home. It controls the rate of any running effects (same

behavior as using rate via the Effect Status Display). The adjusted setting from this control
cannot be stored.

• Effect Size - similar to Effect Rate but for effect size.
• Rate Master - homes to center. It adjusts the cue rate, just like rate and load.
• Fader Disabled - no action is assigned to the fader.
• Master Only - fader is used to set a level for content to fade to. The slider can be used to

live adjust levels when the fader has been activated via the bump button. See Master Only
(on page 106) for more information.

• Effect Master - masters the entry/exit mode of the effects (size, rate or both).
• Levels Only - masters the levels without mastering the effect.

Submaster Information
In the window above any programmed submaster, you will see the following:

On Element 2, you will see this information in the fader status display. See Indicators in the
Element Fader Status Display (on page 103)

Note: Inhibitive submasters display in red and additive submasters in yellow.

• Submaster number
• Submaster label (if any)
• Priority flag (if any)
• I-Master flag (if any)
• Current submaster value
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Labeling a Submaster
Submasters can be labeled using the [Label] key.

• [Sub] [6] [Label] [xxxx] [Enter] - labels submaster 6.
• [Sub] [6] [Label] [Label [Enter] - removes the label.

Note: If you would like your label to word wrap, use || to create a line break between
words.

Loading Submasters
Faders can also be loaded with cues, presets, or palettes. You can convert an empty fader to a
submaster without configuring it in fader configuration display. Any fader can be configured and
loaded with a submaster if:

• the fader is not configured

-or-

• the fader is configured as a playback but has no cue list loaded to it

-or-

• the fader is configured as a submaster, but that submaster is empty.

Regardless of the fader configuration, if the above conditions are met, the fader can be loaded
with the submaster or target specified on the command line.

If data already occupies the fader, that fader must be unloaded before another target can be
loaded. See Releasing Content From a Submaster (on page 377)

• [Sub] [5] [Load] - loads submaster 5 to the fader associated with the load button.
• [Int Palette] [1] [Load] - loads intensity palette 1 to the fader associated with the chosen

load button.
• [Cue] [5] [Load] - loads cue 5 to the fader associated with the chosen load button.

Using Bump Button Timing With Submasters
Each submaster bump can have three different timing values: Up fade, Dwell, and Down fade
(see Submaster Properties (on page 369)). The default timing is set so that the bump functions
as an “on” flash key for additive submasters and an “off” flash key for inhibitive submasters.
Effects on submasters will follow submaster timing, unless timing has been placed in the effect
itself.

Note: At any time, the fader can be used to manually override fade progression or a
submaster triggered with time.

To add bump button timing live:

• [Sub] [8] [Time] [3] [Time] [4] [Time] [3] [Enter] - adds a 3 second up fade, 4 second
dwell and 3 second down fade to submaster 8.

• [Sub] [2] [Time] [Time] {Manual} [Time] [3] [Enter] - adds a manual dwell time and a 3
second down fade time to submaster 2. When the bump is pressed and held, it will flash
on and stay on until the button is released. It will then begin the down fade.

• [Sub] [4] [Time] [3] [Time] {Hold} [Enter] - adds a 3 second up fade time, and a hold
dwell time. When the bump is pressed, the up fade starts. Once at the target value it will
remain there until the button is pressed again. The down fade will bump to zero.
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• [Sub] [3] [Time] [Enter] - resets all time for submaster 3 to default (Up = 0, Dwell =
Manual, Down = 0).

Controlling Subfades Manually
It is possible to take control of submasters even if they have recorded time. To capture the fade,
you must push the fader past the current fade level. Once this is done, control is transferred to
the fader for full manual control.

You may then use the fader to increase or decrease the submaster level as needed.

Execute List
The execute list for submasters can be used to trigger actions such as macros, snapshots, MIDI
Raw, Serial Strings, and cues. This works similar to the External Links for cues.

There is an {Execute} softkey that is available after you press the [Sub] button in either Live,
Blind, or the sub list display.

When you press {Execute}, the softkeys will change to {String}, {Macro}, {Relay}, {On}, {Off},
{Snapshot}, and {MIDI Raw}.

Note: Macros can also be assigned as a button action. See Submaster Fader and
Button Configuration (on page 373)

Triggering an Action
Pressing the bump button of a submaster will trigger any actions assigned to its execute list.

Adding a Trigger
• [Sub] [1] {Execute} {Macro} [2] [Enter] - triggers macro 2 when submaster 1's bump

button is pressed.

Removing a Trigger
• [Sub] [1] {Execute} {Macro} [Enter] - removes the trigger from submaster 1's execute list.

Freeze and StopEffect on Submasters

Freeze
[Freeze] can be used to halt all effect activity on any active submaster. To activate a freeze for
only a specific submaster, press [Freeze] & [Load].

Note: On Element 2, you will need to use the {Fader Control} softkey, which displays when
[Live] is pressed.

There are two ways to remove the freeze command:

• Press [Freeze] & [Load] again for the specific faders to unfreeze the activity.
• Press [Assert] & [Load] or [Go] or [Stop/Back] for the specific faders to resume the

activity.

StopEffect
The [Stop Effect] button can be used to stop all effects from operating on any or all faders, or it
may be used with the control keypad to stop a specific effect.

Note: On Element 2, you will need to use the {Fader Control} softkey, which displays when
[Live] is pressed.
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• To stop all effects on a fader, press [Stop Effect] & [Load] of the associated fader.
• To stop a specific effect regardless of the fader it is operating on, press [Effect] [2]

[StopEffect] [Enter].

When an effect is stopped, all impact of the effect is removed and the stage output is as though
the effect had never been activated.

Moving and Copying Submasters
You can move a submaster using Move To. Press [Copy To] twice to put Move To on the
command line.

Example:
• [Sub] [2] Move To [Sub 9] [Enter][Enter] - moves the contents, label,

and timing data from submaster 2 and places it in submaster 9.
Submaster 2 is removed.

You can copy the contents of a submaster by using the [Copy To] button.

• [Sub] [2] [Copy To] [Sub 9] [Enter][Enter] - copies the contents, label, and timing data
from submaster 2 and places it in submaster 9.

• [Sub] [2] [Copy To] [Sub 9] {Attrs Only} [Enter][Enter] - copies all of the submaster
properties from submaster 2 and places it in submaster 9. Levels, effects, and labels are
not copied when using the {Attrs Only} softkey.

• [Sub] [2] [Copy To] [Sub 9] {Labels Only} [Enter][Enter] - copies only the label from
submaster 2 and places it in submaster 9.

Releasing Content From a Submaster
To release content from a submaster, use one of the following methods:

Note: On Element 2, you will need to use the {Fader Control} softkey, which displays
when [Live] is pressed.

• [Off] & [Load]- stops any running effects and fades out according to the {Restore} mode of
the submaster.

• [Release] & [Load] - behaves in the same way as [Off]. [Release] no longer unmaps the
fader.

• [Shift] & [Load] - behaves like [Off] and [Release] except that it will also unmap the
fader.

• {Fader Control} {Off} & [Load]- stops any running effects and fades out according to the
{Restore} mode of the submaster.

• {Fader Control} {Release} & [Load] - behaves in the same way as {Off}. {Release} no
longer unmaps the fader.

• [Shift] & [Load] - behaves like {Off} and {Release} except that it will also unmap the
fader.

Note: When a submaster on a motorized fader is released or turned off, the fader will
home.

Updating a Submaster
It is possible to make changes to a submaster in Live mode. [Update] is used to store changes to
a submaster.
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• [Update] [Sub] [5] [Enter] - updates submaster 5 to include changes in live output only for
channels already in submaster 5. You can also press the bump button for submaster 5 to
select it.

• [Channel list] [Update] [Sub] [5] [Enter] - adds only the specified channels to submaster
5.

Deleting a Submaster
You can delete a submaster using the [Delete] key. When a submaster is deleted, the fader
remains configured as a submaster, but it will be empty, unless the {Unmap Faders} softkey is
used.

• [Delete] [Sub] [5] [Enter] [Enter] - deletes the contents of submaster 5.
• [Delete] [Sub] [5] {Unmap Faders} [Enter] [Enter] - deletes the contents of submaster 5

and unmaps any faders that are currently mapped to submaster 5.
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About [About]
[About] provides detailed information regarding selected elements.

Pressing [About] puts the console in about mode, which allows you to examine about
information indefinitely, simply by selecting the element you are interested in. When opened, it
appears in the CIA and remains open until closed or until another action forces it to close.

You can also open an About display in a tab by using [Tab] [2][9].

Press the Link icon to break the link to the command line for the current About display. When
the link is broken, the About display will be forced to keep showing the type of information
currently being displayed, such as channel, address, or presets. When linked, the About display
will be linked to the command line, and will updated based on which target is selected.

Press {.a[A]} to zoom. There are three zoom sizes: small, medium, & large. Medium is the
default size.

When in about mode, selecting a channel will reveal information about that channel. Below are
examples of the Current Values view (see below) of information that is presented when
selecting conventional or automated fixtures. For more information about the About Channel
display, see [About] Channel (on page 382)

[About]
When [About] is pressed when the command line is clear, the CIA presents the following
information:

• System address count
• Software version
• Fixture library version
• Copyright notifications
• Device name
• Assigned as (Primary/Backup/Client/Offline)
• User ID
• Priority (ACN and Net2)
• IP Address(es)
• Number of defined parameters
• Number of patched addresses
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• Number of unpatched defined parameters
• Number of pixel mapping addresses
• Number of patched channels
• Number of cues (The number of cues is a count across all cue lists. Multipart cues are only

counted once.)
• Allowed output addresses

There are also buttons for {What's New} (below) and [About] System (below).

Parameters and Addresses
The defined parameters field references the number of parameters that have been defined in
patch. This includes parameters that have been patched to output addresses and those that
have not.

The field below defined parameters, patched addresses, only calculates the number of
addresses that have been used in patch (which counts toward available outputs).

The unpatched defined parameters field is useful because even unpatched, but defined,
parameters must be displayed and calculated in the fade engine. If you are running a large
show, it is helpful to delete defined, but unpatched channels. This is where the [Query]
{Unpatched} command is helpful.

Allowed Output Addresses
Allowed Output Addresses is a range or ranges of addresses that can be assigned to limit the
number of output addresses. Allowed Output Addresses is a setting in the ECU. Go to
Settings>Network>Output Protocols>Allowed Output Addresses to make changes if needed.

Note: If you have created ranges for the Allowed Output Addresses, those will display
in [About] as well.

{What's New}
In the [About] display, tap on the {What's New} button to open the user documentation on the
console. The documentation will open in Tab 100.

Note: Only one instance of the documentation can be open at a time.

[About] System
When {About System} is pressed, the CIA displays a list of all network devices that are
connected to Eos. These network devices include:

• Consoles
• RPU and RPU3
• Net3 RVI and RVI3
• ETCnomad and ETCnomad Puck
• Net3 Show Control Gateways
• Net3 I/O Gateways
• Legacy Unison CMEi processors
• Unison Paradigm processors
• CEM+, CEM3, FDX 2000/ 3000
• Net3 Gateways
• ETCNet2 Nodes
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Each network device will display the following information:

• Device Type
• Name/Component
• Status
• Connected
• IP Address

Note: Devices may appear more than once in this list if they have multiple roles on
the network.

Note: If any errors or warnings are present at the rack, the CEM+ / CEM3 will display
in red.

Clicking on a CEM+ / CEM3 in the {About System} list will open the About Rack display, which
shows the following information about the rack:

• Rack Name (displays as the title)
• Type
• Ambient Temperature
• Phase A,B,C Voltages
• Frequency
• System Number
• IP Address
• Software Version
• Rack Errors

Note: Clearing CEM+ / CEM3 errors from Eos will be temporary unless the errors
have been fixed at the CEM+ / CEM3. Errors displayed on Eos will clear on their own
once they have been cleared from the CEM+ / CEM3. Some CEM+ / CEM3 errors can
only be cleared at the CEM+ / CEM3.

Clicking on a FDX rack in the {About System} list will open the About Rack display, which shows
the following information about the rack:

• Rack number
• Rack Type
• Phase A,B,C Voltages
• Frequency
• System Number
• IP Address
• Software Version

Buttons available in the About Rack screen are {Activ. Preset}, {Deactiv. Preset}, and {Clear
Errors}.

[About] Channel
Press [About] to put the CIA into About mode. When a channel is selected, the information
below is displayed. You can select the information you wish to view from the buttons located on
the right side of the CIA. The buttons are:

{Current Value} displays information that indicates:
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• Channel number
• Device Type
• Most recent intensity move (cue number)
• Next intensity move
• What the channel is inhibited by (if anything)
• Keywords
• Notes
• A list of all parameters on the channel showing the current value and its source, the DMX

value, the absolute value, delay and timing information, marking information, and any
parked values.

{Background} displays similar information:

• Channel number
• Device Type
• Keywords
• Notes
• A list of all parameters on the channel showing the background value and its source,

which shows what the parameters will go to if the current control source is removed. The
background data will be represented by the standard color coding scheme.

{Moves} displays information that shows:

• Parameters
• Previous move in the cue list that currently has ownership
• Value of the previous move (preset, palette, or absolute data)
• Next move
• Value of the next move (preset, palette, or absolute data)

{Usage} displays information on how the channel is used, such as:

• Maximum Intensity
• Cue lists it is used in
• Total number of cues it appears in (based on intensity)
• Total number of intensity moves
• List of submasters that include the channel
• List of cues that have move instructions for the channel
• List of cues with dark moves for the channel
• List of cues that the channel is active in
• List of groups that include the channel

Note: While in the {Usage} screen for About Channel, if another channel is selected,
you will need to hit the {Refresh Usage} button to see the information for the new
channel.

{Patch} displays the following information:

• Address range
• Proportional patch level
• Curve (if any)
• GM exempt
• Preheat information (if any)
• Swap/invert pan/tilt status
• Keywords
• Notes



384 Eos Ti, Gio, Gio @5, Ion Xe, Ion Xe 20, and Element 2 Operations Manual

• List of all parameter values with their address, home value, snap parameter, DMX value,
and parked value (if any)

{Fixture Notes} displays information found in the fixture library such as:

• Revision Number
• Release Date
• Alternate Names
• Usage Notes

{Lamp Controls} displays controls for the lamp, available RDM commands, or other parameters
of the device (if it is an automated fixture).

[About] Address
Press [About] to put the CIA into About mode. When an address is selected, the information
below is displayed. You can select the information you wish to view from the buttons located on
the right side of the CIA. Additional buttons may display based on RDM and Sensor Feedback if
enabled. The buttons are:

{Address} displays the following information:

• Address number (displayed as straight address and port/ offset)
• Dimmer label (if any)
• Associated channel number, which is a hyperlink to the [About] channel display.
• Part number (if any)
• Notes
• Output value (sACN, Net2, ArtNet, Avab UDP, or DMX)
• Current output value and source of output
• Parameter controlled by the address
• Home Value
• Basic patch information
• Extended patch information (if available)
• If it is a scroller, color/ gobo wheel, the assigned scroll or wheel is indicated
• Information stored in the Text 1 through10 and the Notes fields in Patch > Database

{Next Part} and {Last Part} will advance to the next part or go back to the previous part. This
only displays for addresses with parts.

{Go To Patch} is a shortcut to edit the patch for the address selected. This will open up the patch
display.

{Fixture Notes} displays the following information:

• Revision number
• Release date
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• Open issues list (if available)
• Usage notes including switch settings and configuration (if available)
• Alternate fixture names (if any)

{Lamp Controls} displays controls for the lamp or other parameters of the device (if it is an
automated fixture).

{Next/ Last Unpatched} will allow you to see what addresses closest to the current address are
currently unpatched.

{Dimmer Feedback} - appears when the current address is patched to a dimmer in an ETC
Sensor rack with a CEM+ or CEM3. Sensor feedback must be enabled. See Interface Protocols
(on page 523) and Errors and Warnings (on page 151) for more information.

Note: For Sensor feedback, the CEM+ must be running software version 3.0 or later.

{Dimmer Feedback} displays the following information:

• Name (dimmer name)
• Module type
• Rack/Position
• Rack dimmer level (displayed as a percentage)
• Rack dimmer source
• Recorded load
• Actual load

{Dimmer Feedback} displays the following information, which can be modified by clicking on
the value and entering in a new value:

• Firing Mode
• Control Mode
• Curve
• Threshold
• Scale Minimum
• Scale Maximum
• Preheat Enable
• Preheat Timing
• Advanced Features (AF) Enable

The following softkey commands are supported from this display:

• {Ignore Errors}
• {Clear Errors}

Note: Clearing CEM+ or CEM3 errors will be temporary unless the errors have been
fixed at the CEM+ or CEM3. Errors displayed will clear on their own once they have
been cleared from the CEM+ or CEM3. Some CEM+ or CEM3 errors can only be
cleared at the Sensor rack.

{Device Details} - appears when the current address is patched to a RDM device. RDM devices
must be enabled through the ECU and discovered through the patch. See RDM (on page 524) ,
Patch Section (on page 143), and Errors and Warnings (on page 151).

{Device Details} displays the information that it receives from the device and allows some
changes to be made to:
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Note: Changes may take a few seconds to make. They will propagate to the RDM
device and then back to the console’s patch and about displays.

• Device Label (displayed at the top by the address number)
• DMX Address (can be changed in this display by clicking on the property or value)

Note: Changing the address can not cause any part of the fixture to move to a
different universe or communication with the device may be lost. The universe is set
into the gateways port configuration.

Note: Details displayed will vary based on the device.

• DMX Label (same as the device label, but the label can be changed here by clicking on
the property or value)

• Type
• Manufacturer
• Device ID
• Footprint
• Version
• Lamp State
• Lamp Hours
• Head DC Voltage
• Lamp On/Off
• Gel Distance Traveled
• Gel2 Distance Traveled
• Fan RPM
• Ambient Temperature
• Gel Temperature
• Device Errors (will only display if there are current errors)
• Clear Errors

Device Errors are displayed in four different colors depending on severity.

Note: Color severity is determined by the device manufacturer.

• Gray - unknown or not an error
• White - Advisory
• Yellow - Warning
• Red - Error

[About] Cuelist
The following information will be displayed when a cue list is selected:

• Cue List Attributes
• Active Cue
• The number of cues in the list (Multipart cues are only counted once)
• First cue in the list
• Last cue in the list
• Partition
• Playback number and physical fader location of the cue list
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• Channels currently controlled in live by the cue list
• Channels with any intensities above 0 in the cue list
• Channels with Parameters stored in the cue list but no intensities

[About] Cue

The following information will be displayed when a cue is selected:

• the cue number
• timing data for the cue (including discrete timing)
• flags
• attributes
• number of moves per IFCB provided by the cue
• current status of the cue
• intensity moves
• live NPs moves
• dark NPs moves.
• any effects running
• external links
• all the channels in that cue that have discrete or delay times

[About] Curves
When a curve is selected, the following information will be displayed:

• curve number
• the curve label (if any)
• the channels that use the curve in patch
• the channels that use the curve as a fan curve
• the cues/cue parts that use the curve

[About] Effects
When an effect is selected, the following information will be displayed:

Note: To view About Effect in live, the effect must be running.

• effect number
• effect label (if any)
• list of submasters that use the effect
• list of cues that use the effect
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Note: Any cues or submasters that have overrides, such as rate, for the effect will
display an *.

[About] Groups
When a group is selected, the following information will be displayed:

• group number
• the group label (if any)
• the channels in the group

The {Ordered} and {Numerical} softkeys can be used to change the display view in About
Groups.

[About] Submaster
The following information will be displayed when a submaster is selected:

• The submaster number
• Label (if any)
• Current value
• Mode (additive, inhibitive, or effectsub)
• Fader (proportional or intensity master)
• HTP or LTP
• Exclusive
• Priority
• Timing
• Fader Pages
• Channels in Submaster
• Effects assigned

[About] Macro
[About] Macro display shows a list of cues that will execute a selected macro. To view this
display, you must be in the Macro Editor Display. While in that display, press [About] and then
select the macro by using a mouse or touchscreen.

[About] IFCB Palettes
The following information will be displayed when an intensity, focus, color, or beam palette is
selected:

• the number of cues the palette is used in
• the number of presets the palette is used in
• the number of channels
• the first cue the palette is used in
• the last cue the palette is used in
• the number of cue lists that use the palette

{Usage} displays the following information about palettes:

• Number of cues that move
• List of channels that use the palette in a cue
• List of channels stored in the palette that are not used in a cue
• List of cues in which the palette have a move instruction
• List of effects that use the palette
• List of presets that the palette is stored in
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[About] Presets
When a preset is selected, the following information will be displayed:

• the number of channels
• the first cue the preset is used in
• the last cue the preset is used in
• the number of cue lists that use the preset

{Usage} displays the following information about presets:

• Number of cues that move
• List of channels that use the preset in a cue
• List of channels stored in the preset that are not used in a cue
• List of cues in which the preset have a move instruction
• List of effects that use the preset

[About] Color Path
The following information will be displayed when a color path is selected:

• The color path number
• Label (if any)
• Channels that use the color path
• Cues that have moves that use the color path
• Number of cue lists the color path is used in

See Color Path (on page 204) for more information.

[About] Live
Pressing [Live] while holding [About] will display currently active DMX values, instead of a
percentage value.

Double-tapping [Live] while holding [About] will latch this view. Press [About] to disable it
again.
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About Curves
A curve is a relationship between the timing of a fade and the output level of a cue, cue part or
dimmer at each point of time during that fade. By using a non-linear curve, you can create of
variety of effects, accommodate variations and deficiencies in your lighting equipment, alter the
transition ramp and protect equipment from stress.

You may apply curves to dimmers in patch. Curves may also be applied to cues, to cue parts,
and to scroller fans. When applied to a cue, the curve impacts only the intensity moves in that
cue. When applied to a cue part, the curve impacts all parameter moves stored in that cue part.

When applied in patch, the intensity transition will follow the ramp defined by the curve during
its fade. This value is determined by referencing the output value of the curve at that
percentage and outputting the curved level rather than the percent level. Up to 100 points of
delineation can be established in a curve, each with its own intensity value if desired.

When applied to a cue, the “percent completion” of the cue is determined by applying the
curve’s output level as the percent completion for all fade calculations. For single-part cues, the
calculation applies only to intensity. For multipart cues, however, the curve applies to all
parameters in the part.

When applied to a scroller fan, the output of the fan will be controlled by the intensity of the
channel.

Curves can also be applied to fixtures with non-intensity parameters (NPs). When a channel with
NPs is selected in Patch > Attributes > Curve, individual buttons for each available parameter
will be displayed in the CIA. Click one or more buttons to apply a curve to the desired parameter
(s).

Eos provides ten pre-programmed, commonly used curves. They can be edited or copied to a
new curve location. When a pre-established curve is deleted, it will return to its original state.

The curve editor can be accessed by pressing [Tab] [2] [1] or [Displays] {Curve} or from the
browser, Browser > Record Target Lists > Curves. When selected, the curves list will open as a
separate tab and the CIA will show the graphical output of the first curve in the list.

You can scroll through the list using the [Next] and [Last] keys, or you can specify a curve in the
command line.

• {Curve} [9] [0] [4] [Enter] - selects curve 904 from the list and displays its shape in the
CIA.
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Creating a Curve
When you have opened the curves display (see About Curves (on the previous page)), you can
select a curve or create a new curve by pressing:

• {Curve} [x] [Enter]

If the curve is already stored, the contents are displayed in the CIA. If this is a new curve, a
linear curve is displayed.

Editing Curves

Using the Keypad
Once selected and displayed in the CIA, you can edit a curve from the keypad. Points are
established in increments of five. You can add more points from the keypad.

• [3] [At] [1] [Enter] - adds control input point “3” and sets its curve level at 10%.
• [7] [7] [At] [Full] [Enter] - adds control input point “77” and sets its curve level at full.

You can specify points and adjust their levels in the command line or you may use the keys
below to alter the curve:

• [Page u] - selects the next fade completion point.
• [Page t] - selects the previous fade completion point.
• [Level Wheel] - adjusts the output level of the selected point.
• [Page p] - raises the selected point’s output by 1%.
• [Page q] - lowers the selected point’s output by 1%.
• [Full] - sets the selected point’s output to full.
• [Out] - sets the selected point’s output to zero.
• [+%] - raises the selected point by the amount for [+%] established in setup.
• [-%] - lowers the selected point by the amount for [-%] established in setup.

Using a Touchscreen
Once a curve is displayed in the CIA, you can press {Edit} to edit the curve in the editor display.

In the curve editor you can trace the desired shape of the curve using your finger or a mouse on
the touchscreen. As you progress through drawing the curve, intensity values will be added for
existing points on the curve. If you add points to the curve (from the keypad) those points will be
adjusted as well.

You can also toggle between an “interpolated” or “stepped” curve shape. Eos defaults to
“interpolated”. To switch to “stepped”, press the {Stepped} softkey. Once pressed, this softkey
changes to {Interpolated}, which allows you to switch back.

Below are two examples of the same curve. The first is stepped and the second is interpolated.
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Clearing the Curve
At any time, you can clear a curve from the curve editor display by pressing the {Clear Points}
softkey. This will return the curve to its original linear shape or to its default shape if it is a pre-
established curve.

Applying a Curve To Channels In Patch
Curves can be applied to any intensity parameter in patch. Once added, the curve number
appears in the channel’s “Curve” column of the patch display. Pressing {Curve} in Patch >
Attributes will display a list of available curves.

Note: You can also access the patch display by pressing [Address/Patch] twice.

• [Patch] {Attributes} [1] {Curve} [9] [0] [1] [Enter] - applies curve 901 to channel 1
intensity.

• [Patch] {Attributes} [2] [Thru] [8] {Curve} [2] [Enter] - applies curve 2 to intensity for
channels 2 thru 8.

• [Patch] {Attributes} [1] {Curve} [At] [Enter] - removes the curve from channel 1.

When a curve is applied to a Focus, Color, or Beam parameter, an F, C, or B indicator will
appear.

Curves Applied to Cues
Curves can also be applied to cues or cue parts in Live/ Blind. This affects the percent
completion of the cue/ part by applying the curve’s output level as the percent completion for all
fade calculations. Once added to a cue, the curve number appears in the cue’s “Curve” column
of the cue list in the playback status display.

• [Cue] [5] {Attributes} {Curve} [4] [Enter] - applies curve 4 to cue 5.
• [Cue] [4] [/] [6] [Thru] [9] {Attributes} {Curve} [9] [0] [6] [Enter] - applies curve 906 to

cues 4/6 through 4/9.
• [Cue] [5] {Attributes} {Curve} [At] [Enter] - removes any curve from cue 5.
• [Cue] [8] [Part] [3] {Attributes} {Curve} [6] [Enter] - applies curve 6 to part 3 of cue 8.
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Applying a Curve To Scroller Fans
Curves can also be applied to a scroller fan. When applied to a scroller fan, the output of the fan
will be controlled by the intensity of the channel. To apply a curve to a scroller fan, go to
Patch>Attributes>{Fan Curve}. See Scroller Fan Curves (on page 140)

Delete a Curve
While in the curve display, you can delete a curve in the following ways:

• [Delete] {Curve} [3] [Enter] [Enter] - deletes curve 3 from the list.
• [Delete] {Curve} [9] [0] [1] [Enter] [Enter] - since curve 901 is a pre-established curve,

this command will return curve 901 to its default state, thereby removing any edits to it.
• [Delete] [Enter] - deletes the currently selected curve.
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About Snapshots
Snapshots are record targets that store the current state of the Eos control surface and external
monitor configuration. These can then be recalled to instantly reset the console and displays to
the state stored in the snapshot. You can choose which parts of the front panel and displays you
wish to store as a part of the snapshot.

When you record a snapshot, aspects of the Eos user-interface, based on user-preference, are
stored so that you can recall them in the future. This allows you to bring the console back to a
desired state quickly.

Snapshots can be used on RPUs or RVIs to change what is currently displayed on the external
monitors and how that information is displayed.

Snapshots contents are global. They can be stored and recalled on any control interface, other
than Net3 RFRs. When recorded, they store the relevant settings of the device initiating the
record. When recalled, they recall only the controls that are appropriate on the device the
snapshot is recalled.

Note: Snapshots that store the faders do not include the active cue in a fader. They
only include pending cues and fader attributes.

Snapshots of just a single monitor can also be recorded. See Recording Snapshots (below) for
more information.

Recording Snapshots
To store the current state of the console, record a snapshot.

• [Record] [Snapshot] [1] On Element 2, you will need to use the {Snapshot} softkey.

When recording a snapshot, you will see a preview of all of the displays as they will be recorded
in the snapshot. You can choose to select/ deselect various components, monitors, frames, etc
from your snapshot.

From the snapshot menu, the following options are available:

• Visible Workspaces - includes only the visible workspaces.
• All Workspaces - include all workspaces, including those not visible at the time of

recording.
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• Faders - captures the current content or state of the faders including: fader page
mapping, position of all submasters, and pending cues based on configuration.

• Encoders - records the current page of the encoders.
• Filters - records the current setting of the record filters.
• Direct Selects - when used without visible workspaces selected, this option will recall all

direct select tabs and their settings.
• Favorite - the snapshot will display in the quick access window. See Quick Access for

more information.
• Color - assign colors ({Red}, {Green}, or {White}) or {Dark} to a snapshot. {Dark} assigns

no color to the snapshot. The colors will display beside the snapshots name in a direct
select, and / or if that snapshot has been assigned to one of the customizable hardkeys on
Eos Ti, Gio, Gio @ 5, and RPU.

• Reset - sets the menu back to its defaults.

Note: The Faders and Encoders options are not available on Element 2.

You may also check or uncheck to include or exclude any of the following:

• Monitors - any of your console's internal or external monitors
• Frames - any of the open frames on that monitor

• Tabs - any of the open tabs in that frame

• Master Fader Pair - the two master playback faders
• Content Mapping - the page and location of the content assigned to the faders
• Content State - the state or level of the content

• Faders - any other internal or external faders
• Content Mapping
• Content State
• Wing Group - which page the wing group is currently displaying

• Top Bar Timecode List - which timecode list is currently displayed in the top bar display

When one or more sublevel items are excluded, a minus (-) icon will appear next to the top level
item to indicate that not every available option will be saved. A checkmark icon will display
when every sublevel item will be saved.
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Monitors and frames can also be selected or deselected in the preview area. Use
{Frames/Monitors} in the top right to toggle between monitor or frame numbers. Deselected
monitors and frames will be greyed out. Deselected frames will also display a slashed red circle
icon.

Recalling Snapshots
When snapshots are recorded, you can view them in the snapshot list. To view the list:

• Press [Snapshots] [Snapshots] On Element 2, press {Snapshots} {Snapshots}
• Press [Tab] [1] [9]
• Navigate to Browser > Record Target Lists > Snapshots.
• Select the Pop-up Snapshot Browser from the top-right menu icons

Snapshots can be recalled in the following ways:

• From the keypad/ command line - [Snapshots] [5] [Enter]/ {Snapshots} [5] [Enter]
• From cues using the execute list
• From a recorded macro instruction
• From the direct selects - {Snapshot 4}

Since snapshots can be recalled from any device (except RFRs) on the Eos Family network,
snapshots may be affected by the type of device they are recalled on. If the recalling device
does not have the same physical layout or has other limitations that differ from the recording
device, Eos will map the snapshot to the best of its ability.

Note: In a system with multiple users, it is recommended that you allot discrete
snapshot numbers for each user. Since snapshots are global and can be recorded/
recalled from most devices, assigning numbers for each user will ensure their snapshots
are stored and edited properly for their device.

Editing Snapshots
To edit or preview the contents of a snapshot, open the snapshot list.

• press [Snapshot] [Snapshot]
• On Element 2 and Element Classic, press {Snapshot} {Snapshot}

-or-

• press [Tab] [1] [9]

-or-

• navigate to Browser > Record Target Lists > Snapshots.

You can use [Next] and [Last] to navigate the list or you may specify a snapshot in the command
line.

Once a snapshot is specified, the list displays five columns, one for each element. You may
change the enabled elements by pressing the CIA buttons or the softkeys found beneath the
CIA. If an element is added to the command line using the softkeys, it will be enabled when
[Enter] is pressed. All other elements will be disabled.

Snapshots can be labeled in the snapshot list by selecting the snapshot and pressing [Label] or
by selecting the Label column.

Example:
• <Snapshots> [3] {Monitors} [Enter]
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This command will enable the monitors for snapshot 3 and disable any other
elements.

Snapshots can be assigned an icon, which can be configured to appear on the direct select
button in Direct Selects (Tab 4) or Custom Direct Selects (Tab 39). See Icons (on page 93) for
more information.

Deleting Snapshots
You may delete snapshots using the following syntax:

• [Delete] [Snapshots] [2] [Enter] / [Delete] {Snapshots} [2] [Enter]
• [Delete] {Snapshot 5} - selects a snapshot from the direct selects to delete it.
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About Macros
Eos provides you with the ability to record macros, which allow you to compose a series of
programming actions and be able to execute them later by recalling the macro.

Macros are comprised of any series of button presses (both hard and softkeys), screen
commands and events. Eos provides you with the macro feature to simplify complex or repetitive
console programming and operating tasks that you perform often.

When you record the series of button presses to a new macro, you can later play it back by
simply pressing the macro direct select button, running it from a linked cue, accessing it from a
connected show control system, remotely triggering the macro, or running it from another
recorded macro.

You may create up to 99,999 macros either from live, using the macro [Learn] mode to record a
sequence of keystrokes as you perform the operation, or you can create a macro from within the
macro editor display, entering and editing keystrokes into the macro content editor without
actually executing the instructions.

The macro editor display contains a listing of all recorded macros including labels and the
contents of the macros stored. All macro editing is accomplished from the macro editor display.

Store a Macro from Live
The most effective way to store a macro is from live mode using the macro [Learn] mode to
record a sequence of button presses as you enter them. You can include any button press on the
console (hard key or soft key), except [Macro], the arrow keys, [Escape], [Select], and [Learn].

Using the [Learn] Key
Pressing the [Learn] key while in live mode places the console in macro learn mode. The [Learn]
key flashes and the CIA displays “Learning” above the command line. Assign a number
identifier (from 1 to 99,999) to the Macro using the control keypad and press [Enter]. The CIA
flashes “Learning Macro ####” above the command line. This indicates that the console is
ready to record the macro.

Note: It is helpful if you plan your macro content in advance of the macro record
process. While in learn mode, each button press is recorded as content, even the
[Clear] button if you have mistaken a keystroke. There is no way to fix a content error
in live mode, but you can rerecord the macro as needed, or you can edit the recorded
macro in the macro editor, removing any unneeded commands. See Edit an Existing
Macro (on page 407)

Begin writing the sequence of button presses and events for the macro record. When you have
finished with the series of events and button presses, press the [Learn] key again to exit macro
learn mode.

Examples of a macro record function include:

• [Learn] [1] [Enter] [Go To Cue] [Out] [Time] [0] [Enter] [Learn] - records macro 1 with
the go to cue out command.

• [Learn] [5] [Enter] [1] [Full] {Chan Check} [Enter] [Learn] - records macro 5 with channel
1 at full in channel check mode. To check the next channel in the list, press [Next].

• [Learn] [4] [Enter] [-] [Sub] [Record] [Learn] - records macro 4 with instructions to record
a target excluding all submaster data.

• [Learn] [2] [Enter] [-] [Group] [6] {Color} [Record] [Learn] - records macro 2 with
instructions to record a target excluding the color data from group 6.
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You can also create a macro in live that bumps submasters across fader pages but first you must
have content assigned to the submasters.

Example:
Write submasters 1 through 5 and 15 through 17, each with its own channel
selections at 100%. Then press:

[Learn] [1] [Enter] [Bump1] [Bump2] [Bump3] [Bump4] [Bump5]

[Fader Page]

[Bump15] [Bump16] [Bump17] [Learn]

Once you have created the macro from Live in [Learn] mode, you can easily edit the sequence
from the macro editor display. See Macro Editor Display (below).

Macro Editor Display
Macro editing is accomplished from the macro editor display. As an alternative to recording your
macro in live, you may create it from this display instead. Open the macro editor display by
pressing [Macro] [Marco], from the browser by navigating to Record Target Lists > Macro
Editor, or press [Tab] [1] [8].

The display is divided horizontally, the top portion displays the macro contents in detail while
the bottom portion lists all macros, including the label and contents.

While in the macro editor display, any numeric entry on the command line is assumed to be a
macro number. If the macro number entered already exists and [Enter] is pressed, the macro list
will page to the selected macro and the macro content detail section will display all of the
contents of the selected macro. If the macro number entered does not exist in the list and
[Enter] is pressed, an empty macro will be created with the specified macro number.

While in the macro editor display, the following functions may be performed using the control
keypad and softkeys:

• [Label] - when a macro is selected and [Label] is pressed, the alphanumeric keypad will
display on the CIA. Label the macro and press [Enter].

• [1] [Label] <name> [Enter] - labels macro 1

• {Icon} - macros can be assigned an icon, which can be configured to appear on the direct
select button in Direct Selects (Tab 4) or Custom Direct Selects (Tab 39). See Icons (on
page 93) for more information.

• {Color} - assign colors ({Red}, {Green}, or {White}) or {Dark} to a macro. {Dark} assigns no
color to the macro. The colors will display beside the macro name in a direct select, and/
or if that macro has been assigned to one of the customizable hardkeys on Eos Ti, Gio,
Gio @5, and RPU.
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• There is also a {Toggle Blink} softkey. By default a customizable hardkey will blink when
the macro assigned to it is running. This softkey will turn off the blinking if it is enabled
and a BD will display in the color column when blinking is disabled.

• [Delete] - when a macro is selected and [Delete] [Enter] is pressed, you will be prompted
to confirm the deletion of the selected macro. To confirm press [Enter], to abort press
[Clear].

• [1] [Delete] [Enter] [Enter] - deletes macro 1 from the list.

• [Copy To] - when a macro is selected and [Copy To] is pressed, you will be prompted to
enter the macro number that you want to copy the contents of the selected macro to. You
will be prompted to confirm the copy process, press [Enter] to confirm or [Clear] to abort
the copy to process.

• [1] [Copy To] [6] [Enter] [Enter] - copies the entire contents of macro 1 to macro 6.

• {Edit} - when a macro is selected and {Edit} is pressed, you will have entered edit mode
for the selected macro. See Edit an Existing Macro (on the facing page) for more
information. Three notable changes to your macro editor display include:

• a blinking cursor in the macro content detail portion (top) of the display.
• ”Press [Select] to save or [Escape] to cancel changes”displays above the command line.

• {Move To} - allows you to move and reorganize your macros anywhere in the macro list
numerically. You can access {Move To} by pressing [Copy To] twice.

• For instance, if you have macros 1 through 5 in the list, and you want to move/ change
macro 1 to macro 6 so that your most commonly used macros are first in the list, you
would press [1] {Move To} [6] [Enter]. This leaves only macros 2 through 6 in the list.

• {Mode} - allows you to assign different modes for the macro to run in. There are three
modes: background, foreground, and default.

• {Default}
• When a macro in default mode is run manually, it runs in the foreground(i.e., the

command line) on the device that fired it. When a macro in default mode is executed by a
cue or via show control, it runs in the background on the master device.

• Running a macro on a master device only matters when the macro changes the displays of
the device it runs on such as snapshot and flexichannel macros.

• {Background}
• When a macro in background mode is run manually, it runs on the device that fired it but

will not affect its command line.
• A macro in background mode that is run from a cue or via show control will run on the

master device but will not affect the master's command line.
• When a background macro is running and includes a link to another macro, or is currently

waiting, pressing the [Macro] button will stop it.

• {Foreground}
• When a macro in foreground mode is run manually, it runs on the device that fired it and

affects its command line.
• If a foreground mode macro is fired via show control, it runs on the master device and will

affect its command line.
• If a cue fires the macro, it will run on the device whose user last pressed [Go] on that

playback. If a foreground macro is fired from a cue that is executed from another cue list,
the macro will run on the device that last pressed [Go] on the cue’s playback but not the
playback that triggered the executed cue.

• {Target Device} - A macro can have a Target Device assigned to it. This allows a cue to
execute a macro only on a certain console.



Macros 407

• The Target Device can be a device name or User ID. These are assigned to a macro in the
Macro Display by using the {Target} softkey and either selecting {Device} and {User}.
Pressing {Target} will also display a list of connected devices and additional target
options.

{SC Learn} - enables or disables excluding specific macros from being learned as show
control events. See Adding Events using Learn Mode (on page 543) for more information.

Create a New Macro from the Display
From the macro editor display, enter any unrecorded macro number from 1 to 99,999 and press
[Enter]. Your new macro number will display in the macro list in numerical order but will not
have a label or any contents.

To store the macro contents, select the macro and press {Edit}. A cursor appears flashing in the
macro content detail portion of the display, ready for you to add the macro content.

Example:
Create macro 3. Write the instruction to set all active channels to 50%, then
sneak them to their original levels over 10 seconds and last, link to macro 5.

• <Macro> [3] [Enter]
• {Edit}
• [Select Active] [At] [5] [Enter]
• [Sneak] [Time] [1] [0] [Enter]
• [Macro] [5] [Enter]
• [Select]

While in macro edit mode, all keys are entered as content except the macro editor softkeys,
arrow keys, [Escape], [Select] and [Learn] keys.

Edit an Existing Macro
When you have created a macro using macro learn mode from live or otherwise, you can edit
the content of your macro by removing or adding commands and special macro softkey
functions (such as wait, loop, and so on).

From the macro editor display, select an existing macro number and press [Enter]. The selected
macro contents will display the detail section. Press {Edit} to make changes to the content.

When in edit mode, the CIA changes to display all softkeys available for the system that would
otherwise be difficult to find when recording a macro. You can also choose from a list of the
most common macro commands.

Next to the softkeys display are paging buttons to page through the available softkeys. When
used, these paging buttons will not be stored as content in your macro.

In addition, a new set of macro editor softkeys are displayed while in edit mode including:
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• {Loop Begin} - inserts a start command for a loop with a limited number of iterations. An
infinite loop is assigned when you use “0” for the iterations.

• {Loop End} - inserts a loop end command.
• {Wait} - inserts a pause for a period of time. This needs to be followed with a whole

number of seconds.
• {Delete} - removes commands from the macro.
• {Wait for Entr} - inserts a pause in the macro that waits for the [Enter] key. Pressing

[Enter]will resume the macro.
• {Wait for Input} - inserts a pause in the macro to allow you to enter data. The pause lasts

until you press the [Macro] key again. Then the remainder of the macro will be
completed.

• {Done} - exits macro edit mode. You may also use the [Learn] key to enter and exit edit
mode.

In edit mode, the cursor in the macro content detail section of the display provides use of the
arrow keys to navigate through the existing content list. Use of the arrow keys will not be stored
to the macro content.

To add content, place the cursor in the section that you want to insert, then add the command.
To delete a command, place the cursor ahead of the content to be deleted, then press the
{Delete} softkey.

Press [Select] when you have completed all editing. Press [Escape] to abort.

Note: Macros for options with a toggle action between enable and disable, such as
AutoMark in setup, can use the {Enable} and {Disable} softkeys for creating absolute
actions instead of toggles.

Play a Macro
You can play a macro from the command line, from the direct selects, run it from a linked cue,
or from another macro.

To play macro 5 from the command line press [Macro] [5] [Enter]. “Running Macro 5” displays
above the command line in live while the macro is running.

To run macro 5 from the macro direct selects simply press {Macro 5}. “Running Macro 5”
displays above the command line in live while the macro is running.

To run macro 5 from cue 1 press:

• [Cue] [1] {Execute} [Macro] [5] [Enter]

If you would like to run multiple macros from cue 1, press:

• [Cue] [1] {Execute} [Macro] [6] [Enter]
• [Cue] [1] {Execute} [Macro] [7] [Enter]

Each macro has to be entered individually. The previous example would result in macros 5
through 7 being executed from cue 1.

To run a macro from another macro, see the example under Create a New Macro from the
Display (on the previous page).

Stop a Macro
If you need to stop a Macro while running (for example, during an infinite loop) you may press
[Escape] and the macro will stop.
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Delete a Macro
You can delete a macro from the Macro Editor display by selecting the macro and pressing
[Delete] [Enter]. You will be prompted to confirm the deletion. Confirm by pressing [Enter]
again, or abort by pressing [Clear].

Example:
Delete macro 5 from the macro list.

• [5] [Enter]
• [Delete] [Enter] [Enter]

Or from any display:
• [Delete] [Macro] [5] [Enter]
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About Magic Sheets
Magic Sheets are user created interactive displays that offer customizable views for displaying
data and programming. Magic Sheets are comprised of objects that are tied to show data, such
as channels and palettes.

The following are two examples of magic sheets. For additional examples, see Examples of
Magic Sheets (on page 430).

Magic Sheet Browser
Open the magic sheet browser by pressing [Tab] [3], or by selecting the magic sheet browser
icon from the home screen.

If no magic sheets exist in the show file, the magic sheet browser will be blank except for the
New Magic Sheet icon. Click on the icon to open the magic sheet editor.
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After you have created a magic sheet, you can recall a specific magic sheet, by pressing
[Displays] {Magic Sheet} [#] [Enter] or you can navigate to Displays> Record Targets>Magic
Sheet and press [Select] to open the magic sheet list (see Magic Sheet List (below)).

All available magic sheets will also be shown in the magic sheet browser.

Direct Selects
Magic Sheets can also be accessed from the direct selects. Clicking on a magic sheet direct
select will open the Magic Sheet tab and display the selected magic sheet. Pressing a different
magic sheet direct select will change the displayed sheet. See Direct Selects (on page 86)

Magic Sheet List
The magic sheet list can be opened by double pressing {Magic Sheet}, pressing [Tab] [1] [4],
navigating within the browser to Displays> Record Targets> Magic Sheet and pressing [Select]
, or using CTRL+M on an external keyboard. The magic sheet list displays a list of all created
magic sheets, their labels, and how many views have been saved for each magic sheet. See
Display Tools (on the next page) for more information about views.

To label a magic sheet, use the syntax {Magic Sheet} [#] [Label] <name> [Enter].
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Pressing [Label], when a label has already been applied to a magic sheet, will display the label
on the command line for editing. Pressing [Label] a second time will clear the label, or you can
press [Clear] to remove the label one character at a time.

Magic sheets can be assigned an icon, which can be configured to appear on the direct select
button in Direct Selects (Tab 4) or Custom Direct Selects (Tab 39). See Icons (on page 93) for
more information.

Display Tools
The display tools for Magic Sheets are available by either right-clicking or double tapping on the
Magic Sheet's tab. The tab will also indicate if the Magic Sheet is in Live or Blind.

Note: You can click and hold or tap and hold on the Magic Sheet's tab to do a zoom
to all of the Magic Sheet display.

These tools include:

• Add View - different views of the same magic sheet can be saved and recalled. Zoom and
pan the display to change the view, and then click {Add View} to save. To change views,
you can use the arrows in the display tools or multi-touch gestures. You can also press
{Magic Sheet} [1] [/] [2] [Enter] to view Magic Sheet 1, View 2. See Multi-Touch
Gestures (on page 416)

• Save Screenshot - saves a .png screenshot of the magic sheet to a hard drive or an
attached USB drive.

• Magic Sheet Browser - opens the magic sheet browser, which displays thumbnail images
and labels for the created magic sheets. The browser can also be opened using multi-
touch gestures. See Multi-Touch Gestures (on page 416)

• Lock - locks the magic sheet so it cannot be zoomed or panned. This is useful for a
customized direct select layout, where you want the buttons to always be in the same
spot.

• Zoom to All - zooms to show all objects.
• Zoom to Selection - zooms to show all selected objects.
• Center on Selection - centers the display on the selected objects without changing the

zoom level.
• Show Reference Labels - when enabled, channel objects that reference record targets

(such as presets or palettes) with labels will have their labels displayed in the Magic Sheet
rather than their target type and number. [About] & [Label] can be used to temporally
toggle between views.
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• Limited Expand Mode - allows a magic sheet to be displayed at fullscreen. See Limited
Expand Mode (on page 429) for more information.

The following options are only available while in Limited Expand Mode:

• Disable Keyboard Input - disables input from the face panel and an external keyboard.
Fader and macro buttons will still work.

• Lock Fader Page - locks the fader page to the currently displayed one.

Navigating a Magic Sheet
Magic sheets can be navigated using a mouse, a keyboard, a touchscreen, or a multi-touch
touchscreen. The drag and drop function for placing objects is a single touch action or done
using a mouse.

Additional mouse commands include:

• Left Click - selects an object.
• Right Click - pans the display.
• Wheel - zooms the magic sheet.
• [Shift] & Wheel - provides a fine zoom of the magic sheet.

Selecting from left to right will open the blue window selection box. This selects any object that
is completely inside the box. This can be done with a single touch or using a mouse.

Selecting from right to left will open the green crossing selection box. This selects any object
that either crosses the boundary line of the box or is completely inside of it. This can be done
with a single touch or using a mouse.
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Multi-Touch Gestures
The following multi-touch gestures can be used with an external multi-touch touchscreen or the
on-board monitors on Eos Ti, Gio, and Gio @ 5. Multi-touch is not available on the on-board
monitors of Eos.

• Scroll - touch with two fingers to move around the page.
• Zoom Out - touch with two fingers and then move your fingers toward each other.
• Zoom In - touch with two fingers and then move your fingers away from each other.
• Zoom to All - double tap with two fingers.

The following multi-touch gestures can be used with monitors that support 3 or more
simultaneous touches:

• Jump to Previous View - use three fingers to swipe upwards or to the right.
• Jump to Next View - use three fingers to swipe downwards or to the left.
• Magic Sheet Browser - tap with three fingers to open the browser.

Keyboard Shortcuts
With an external alphanumeric keyboard attached, the following keyboard shortcuts can be
used:

• ARROW KEYS - move selected item or navigate when nothing is selected.
• SHIFT - move/rotate item without snapping to grid.
• SHIFT + mouse wheel - provides a fine zoom of the magic sheet.
• ALT + M - double tap to open the magic sheet list.
• CTRL + A - select all
• CTRL + C - copy
• CTRL + V - paste
• CTRL + X - cut
• CTRL + G - group
• CTRL + SHIFT + G - ungroup
• DELETE - delete
• ESC - finish line/polygon creator or close tab.

Creating and Editing Magic Sheets
Pressing the edit button on the right hand side of the magic sheet display will open the editing
tools.
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The main area of the magic sheet will display a grid to aid with layout. The editing tools will be
displayed on the right side of the magic sheet. The editing tool window is divided up into three
areas: layout tools, the MS Object Library, which is made up of four tabs that contain the MS
Objects, and the MS Object Properties.

Note: To see a description of a tool or object, hover your cursor over it. Its title will
display after a second or two.

You can drag and drop objects onto the magic sheet, or you can use the layout tools to create
arrays of objects.

Note: Holding down [Shift] while placing an object will bypass the snap to grid
behavior.

Quick Save
Clicking on the {Quick Save} button allows you to save an undo restore point for
the magic sheet you are working on. Once saved, a green check mark will
temporarily appear next to the {Quick Save} button.

It is recommended that you click {Quick Save} before making any major changes to the magic
sheet that you think you might want to undo. [Undo] [Enter] will take the magic sheet back to
the last undo restore point. An undo restore point is also set whenever you exit the editor.

Quick saving a magic sheet will also send any changes made to the magic sheet to all the
devices in a multi-console system.

Layout Tools
The layout tools are divided into four areas:

• Edit Mode (below)
• Zoom (on the next page)
• Alignment (on the next page)
• Ordering (on page 421)

Edit Mode
Clicking on the arrow will open the edit mode options, which include:

• Grid Enabled - toggles between a grid being displayed and no grid. With the grid enabled,
the magic sheet will also have a snap to grid behavior when placing objects.

•

Normal - allows for dragging and dropping of objects from the object list.
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•

Quick Layout - allows you to place more instances of a selected object.When finished,
click the {Done} button or change the layout mode to normal.

•

Quick Target - used to quickly change the target and / or number of an object. While
in quick target mode, clicking on an object will assign the selected target and increment
the numbers as specified in the target section of edit mode.

Target

Target is used to specify the object, starting target number, and incrementation for use in quick
target mode.

• Object - assigns the object from the list.
• Start - assigns the starting target number.
• Increment - assigns what incrementation the target numbers will use after the start

number.

Example:
When incrementing multicell fixtures on a magic sheet, the following methods
can be used:

• Start: 1.1 Increment: 1
• Gives you these channel numbers: 1.1, 2.1, 3.1...

• Start: 1.1 Increment: 0.1
• Gives you these channel numbers: 1.1, 1.2, 1.3...

• Start: 1.1 Increment: 1.1
• Gives you these channel numbers: 1.1, 2.2, 3.3...

Zoom
Clicking on the magnifying glass will open the zoom mode options, which include:

• Reset Zoom - sets the zoom level to 1:1 and centers the magic sheet.
• Zoom to All - zooms to show all objects.
• Zoom to Selection - zooms to show all selected objects.
• Center on Selection -centers the display on the selected objects without changing the

zoom level.

Alignment
Clicking on the alignment icon will open the alignment options menu.
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Create Array

Allows you to create arrays of objects. After placing one object of your choice, click on {Create
Array} to open an additional window for choosing what array type you want to use.

Rectangle

Lays out a rectangle array of objects. You can define the rows, columns, and spacing.

Circle

Lays out a circle array of the objects. You can define the numbers of objects and the size of the
circle.

Align Settings

Allows you to align objects either to the left, center, right, or top, middle, bottom.
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Align Rotation

Allows you to select multiple objects and align their rotation to the first object selected.

Distribute Horizontally

Allows you to distribute objects horizontally at an equal distance apart between two objects.

Set the distance you would like by placing the first and last objects. Then with all objects
selected that you wish to distribute (including the first and last ones you positioned), click the
{Distribute Horizontally} button.

Distribute Vertically

Allows you to distribute objects vertically at an equal distance apart between two objects.

Set the distance you would like by placing the first and last objects. Then with all objects
selected that you wish to distribute (including the first and last ones you positioned), click the
{Distribute Vertically} button.

Distribute Rotation

Allows you to distribute objects at an equal rotation between two objects.

Set the level of rotation you would like by placing the first and last objects at a rotation. Then
with all objects selected that you wish to rotate (including the first and last ones you positioned),
click the {Distribute Rotation} button.

Flip

Allows you to flip objects horizontally or vertically. You have the option of also flipping the text
position and / or the target field positions.
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Ordering
The objects can either be placed on their own or stacked on top or beneath of each other.

Clicking on the order icon will open the ordering options, which include:

• Group - allows you to group objects together so they can be moved and rotated like a
single object.

• Ungroup - removes grouping.
• Send Backward - will send an object back.
• Bring Forward - will send an object up.
• Send to Bottom - will send an object beneath all other objects.
• Bring to Top - will stack an object on top of all other objects

Magic Sheet Object Library
The objects section of the editing tools has four tabs:

• Magic Sheet Objects (below)
• Fixture Symbols (on page 423)
• Magic Sheet Icon Library (on page 424)
• Background Settings (on page 424)

Magic Sheet Objects
The following table contains the various magic sheet objects located in the first tab, and a brief
description of what they do. Settings for objects can be adjusted in the MS Object Properties (on
page 426) area.

Channel acts as a direct select for a channel.

Group acts as a direct select for a group.

Preset acts as a direct select for a preset.
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Palettes acts as a direct select for a palette.

Macro acts as a direct select for a macro.

Blank can be assigned a target.

Tombstone
mirrors the channel indicators from
the live/blind summary view.

Fader
assigns a virtual fader. If the virtual
fader is assigned to an existing one,
their settings will be the same.

Command
Line

mirrors the command line. Can be
assigned to mirror the command line
for any user. Multiple command lines
for different users can be used.

Text
places descriptive text on the sheet.
The text can also be assigned a
target.

Clock adds a clock.

Response

Analog IO

displays the status of a connected
Response Analog IO gateway.

TimeCode
displays the status of a specified event
list's time code.

sACN
Input

displays the sACN input values.

Foundation
Motor

Adds a Foundation Motor item to sync
with an actual Foundation.

Line
draws a line. Examples of use could
be as a pipe for fixtures or a divider
between buttons.

Truss places truss.

Shapes
draws shapes that can have a target
assigned to them or could be used to
represent set pieces.

Points
allows for free form creation of
objects.
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Fixture Symbols

From the second tab, fixture symbols can be placed on a magic sheet. The symbols can be tied
to a channel number. Information about that channel can be displayed with the symbol, such as
intensity, FCB data, and error indicators. See MS Object Properties (on page 426) for more
information on the customizing options available.

Importing Fixture Symbols

Additional fixture symbols can be imported. The symbol must be saved as a .svg image file, and
needs to be tagged properly. These tags can be linked to the channel’s color, intensity or both.

The outline section needs to be tagged as etc_symbol_outline0, etc_symbol_outline, and / or
etc_symbol_outline2. The base section needs to be tagged as etc_symbol_base0, etc_symbol_
base, and / or etc_symbol_base2. Tags can be layered, and they will render in the order listed
below:

• etc_symbol_base0 - uses fill color intensity link (not color)
• etc_symbol_base - uses fill color and intensity link
• etc_symbol_base2 - uses fill color intensity link (not color)
• etc_symbol_outline0 - uses outline intensity link (not color)
• etc_symbol_outline - uses outline color and intensity link
• etc_symbol_outline2 - uses outline intensity link (not color)

Tags that only link to intensity will cause the base or outline to dim based on the channel’s
intensity.

The edits to the tags in the .svg file can be made in any text editor program, such as Notepad, or
in a .SVG editor program, such as Inkscape.

See Magic Sheet Icon Library (on the next page) for import steps.
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Magic Sheet Icon Library
Images can be added from the icon library on the third tab and used as objects or background
images.

For more information on icons and the icon library, see Icons (on page 93).

Using Icons with Magic Sheets

To use an image as an object, drag it onto the magic sheet. You can then configure it like any
other magic sheet object. See Editing Objects on the Magic Sheet (on page 429).

Background images are set and configured in the background settings tab. See Background
Settings (below).

Background Settings
In the fourth tab, you can adjust the settings for the background. Three options are available for
background types; you can either use a solid color, a gradient of two colors, or a image.

Interactive

Toggles interactivity on or off for the entire magic sheet. If toggled on, all objects will respect
their per-object settings for interactivity. If toggled off, no objects will be interactive, regardless
of their per-object settings.

Display Behavior

The following display behaviors are available:

• Normal Display - The display will behave the same as a Display Tab.
• A locked tab will not be skipped.
• A single click on the tab will draw focus to that tab.
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• Channel Display - This mode uses the following rules:
• When focus is drawn to the playback status display, a magic sheet channel display will

be brought to the front.
• Using [Shift] & [Live] cycles through the magic sheet channel displays as well as the Live

channel displays.
• Pressing [Live] or bringing a Live tab into focus will restore your last focused magic sheet

channel display.
• Magic sheet channel displays in the locked frame will not be skipped when using the

[Tab] key to cycle through tabs.

• Control - The display will behave the same as a Controls Tab.
• Locked tabs will be skipped.
• A single click will not draw focus.
• A double click will draw focus to the tab.

Live and Blind Backgrounds

You can select live and blind backgrounds for magic sheets. These backgrounds can either use a
solid color, gradient of two colors, or an image. One of these backgrounds will be used when
editing a magic sheet. Select the {Use While Editing} button to use either the live or blind
background.

Solid
When solid is selected, you will have the chance to select a color for the magic sheet
background. You can either click on the color square in the tab, which opens a color selection
window, or you can manually enter the RGB values.

Gradient
When gradient is selected, you will have the chance to select a two color gradient for the magic
sheet background. You can either click on the color squares in the tab, which open a color
selection window, or you can manually enter the RGB values.

Image
With image selected, you can adjust the size, opacity, and invert the colors of the selected
background image.

You can select or import an image directly from this tab by pressing the choose a background
image icon, if no previous image had been chosen, or by pressing the thumbnail icon of the
selected image to change it.

Exporting and Importing Magic Sheets
Magic Sheets can be exported and imported in .xml format. The export and import icons are
located at the bottom of the background settings tab.
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MS Object Properties

You can customize MS objects and fixture symbols in numerous ways found in the MS Object
Properties area. With an object selected, you can modify its options.

Color
The object’s outline width, outline and fill colors can be adjusted here. The object can be linked
to the target’s color and / or intensity.

Note: If any object's outline color is set to Link to Channel Intensity, the brightness of
the outline color will be tied to the DMX level of the address. The higher that the DMX
value is the brighter the outline color will be.

Font
The font used for a text object can be changed and adjusted as needed here. You can select font
type, size, color, bold, italic, underline, and justification.

Change Type
Allows you to quickly change the type of one or more selected objects.

Target
Selects the target of the object. Most objects default to a target type, but that can be changed.
The targets available are:

• None
• Address
• Beam Palette
• Channel
• Channel (by Address)
• Color Palette
• Cue
• Cue - Active
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• Cue - Pending
• Effect
• Fader
• Focus Palette
• Group
• Intensity Palette
• Macro
• Magic Sheet
• Pixel Map
• Preset
• Response IO Relay
• Scene
• Snapshot
• Submaster
• User
• Console Button
• Softkey
• Command
• Zoom

• When clicked, the view will zoom in to show all object within that object’s group.

• Selection
• When clicked, all other objects within that object’s group will be selected.

Note: Only applicable targets for the specified object type will display in the Target
selection dropdown menu.

Text
Changes the text for a text object.

Command
Assigns a command to be executed. The target type needs to allow command options.

Fields
Up to six different fields of custom information can be displayed per objects.

Orientation

The orientation of fields around the object can be adjusted by pressing the field orientation icon.
You can also choose to keep text upright by pressing the icon to the right of the orientation icon.

There are three options for orientation:
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• Exterior Bounds - fields will be exterior to the object and will remain at a position
regardless of the rotation of the object.

• Interior - fields will be in the interior of the object. This orientation is useful for console
buttons.

• Exterior Shape - fields will be exterior to the object and will move in relation to the
object's rotation.

Other Field Properties

The justification of each field around the object can be adjusted. If multiple fields have the same
justification, they will be stacked in field order. The text and color used for each field can also
be adjusted. A scroller indicator bar can be added. Fields can display the following data:

• Target ID
• Fixture Type
• Target Name
• Label
• Text 1 through 10
• Text Gel
• Intensity
• Intensity Bar
• Color Swatch
• Summary
• Focus
• Color
• Beam
• Status
• Prev Move
• Next Move
• Channel
• Address
• Port/ Offset
• DMX
• DMX Bar

Interactive
This checkbox toggles whether or not the object is interactive. Interactive objects can be
selected in the same way as a direct select or virtual fader. Objects set to not-interactive cannot
be selected, and will only display information.This checkbox is unavailable for any inherently
non-interactive objects (such as a command line).

Position
Shows the position of the object on the magic sheet. Position can be manually entered here.

Size
Shows the size of the object. Size can be manually entered here.

Rotation
Shows the rotation of the object. Rotation can be manually entered here.
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Items
Refers to the number of objects selected for editing. Multiple objects can be edited at the same
time.

Editing Objects on the Magic Sheet
In addition to using the editing tools, objects can be manipulated on the magic sheet using a
touchscreen or a mouse. For selection methods for multiple objects, see Navigating a Magic
Sheet (on page 415).

• The blue handles are used to resize objects without keeping the object's aspect ratio.
• The green handles are used to resize an object while preserving the aspect ratio.
• The white handles are used to rotate the object.

Limited Expand Mode
Limited Expand Mode allows for a magic sheet to be viewed fullscreen. To enter into this mode,
you can either select it from the magic sheet display tools (Display Tools (on page 414)) or you
can use [Shift] & [Displays]. [Shift] & [Displays] is also used for exiting this mode.

While in this mode, the monitor with the magic sheet will not display a tab number, command
line, or status bar. If there were other tabs open on that monitor, they will close when the magic
sheet goes into limited expand mode. If tabs 1 or 2 are open, they will move to a different
monitor.

Limited Expand Menu
Magic sheets are not editable in this mode, but certain options are available from the gear
menu in the lower-left.

The following options are available in this menu:
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• Disable Keyboard Input - disables input from the face panel and an external keyboard.
Fader and macro buttons will still work.

• Lock Fader Page - locks the fader page to the currently displayed one.
• Hide Menu Button - hides the gear menu. When the icon is hidden, [Shift] [Displays] is

the only way to exit Limited Expand Mode.
• Record Snapshot
• Close Menu
• Exit Limited Expand Mode
• Exit Eos

Limited Expand
The monitor will display a three dot heartbeat indicator in the top right hand corner. The
indicator will move between three dots to show that your console is operating as expected.

The following indicator colors will be used for multi-console activity:

• Yellow - system is operating as expected.
• Red - master or backup has gone offline.
• Green - master or backup has reconnected.

Examples of Magic Sheets
The following are examples of magic sheets created using the magic sheets feature. These
examples use a variety of objects provided in the software along with user-generated images.
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About Augment3d
Augment3d is an Eos tool that allows you to configure and focus virtual representations of your
fixtures in a 3D environment, as well as program and visualize looks.

Hardware and Software Requirements

Console
Augment3d on Eos Family consoles requires Eos Family Software v3.0 or greater, and a console
with at least one Display Port connector.

PC / Mac
For the most up-to-date specifications for Augment3d on PC or Mac, please visit
etcconnect.com/etcnomad/performance/.

iOS / Android
Augment3d includes a feature inside of the iRFR and aRFR mobile apps. iRFR requires iOS 11 or
later. aRFR requires Android OS 7.0 (Nougat, sdk 24) or later.

Note: Focus wand also requires ARKit/ARCore functionality. Check your device's
specifications to ensure compatibility, or reference the Augment3d Reality Support field
in the app's About menu.

Running Augment3d

Console / PC / Mac
Eos Family consoles and computers that meet the hardware and software requirements can run
Augment3d natively (see Hardware and Software Requirements (above)).

Either open a new tab and select {Augment3d} from the Displays list, or hold down [Tab] and
type [38].

Note: In console implementation, Augment3d render quality is limited to Low or
Medium.

PC / Mac (Tether Mode)
You can also run Augment3d on a separate computer, connected to a console using tether
mode. Augment3d tether is an extension of the console it is connected to, rather than a
standalone client.

The setup for this mode is identical to that of an ETCnomad client computer in a networked
system of consoles. An ETCnomad dongle is not required for Augment3d tether.

https://etcconnect.com/etcnomad/performance
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Note: ETCnomad Puck is considered a console, and is subject to the console
restrictions above.

1. Ensure the computer is running the version of ETCnomad that matches the software
version installed on the connected console.

2. On the console, enable Augment3d for your user number. In the CIA, navigate to Setup
> System Settings > Users.

3. Connect your computer using an Ethernet cable through a network switch. Ensure that the
computer's network information is in a compatible range with the console.

4. Launch ETCnomad and select {Augment3d Tether}. Augment3d will launch in its own
window, and try to connect to the console.

5. Choose the correct tether device on the console (see Augment3d (on page 177)).

To exit tether mode, click the {X} in the corner. To exit when in Edit mode, choose File > Exit.

Tether Command Line

A command line can be displayed on the tethered device, which will mirror the command line
on the connected console.

With the keyboard button toggled on, both Eos and Augment3d commands will be sent from the
tether to the console. When toggled off, only Augment3d commands will be sent.

Click the {X} to disable the tether command line entirely, or toggle it from Window > Command
Line.

Standalone ETCnomad
Augment3d can be run on a PC or Mac in a local tab as part of ETCnomad v3.0.0+ and used
without a connected Eos Family console. Once ETCnomad v3.0.0+ is installed, no additional
installation is necessary.
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Navigation in Augment3d

Keyboard
In Augment3d Control Mode (on the facing page), use the standard arrow keys to move the
camera around the Augment3d space. In Augment3d Edit Mode (on page 438), both the
standard arrow keys and WASD keys may be used.

• W / UP - moves the camera up.
• SHIFT + W / UP - moves the camera forwards in the direction it is current facing.
• A / LEFT - moves the camera to the left.
• S / DOWN - moves the camera down.
• SHIFT + S / DOWN - moves the camera backwards in the direction it is currently facing.
• D / RIGHT - moves the camera to the right.

Tap any key to increment or decrement the camera position, or hold the key down to move
smoothly.

Mouse
• RIGHT MOUSE - drag to rotate the camera to look around the model.
• CENTER MOUSE - drag to pan the camera in the current perspective.
• ALT + RIGHT MOUSE - drag for orbital control.
• CTRL + RIGHT MOUSE - drag to pan the camera in the current perspective.

Note: Use keyboard and mouse controls simultaneously for optimal navigation
control.

Eos Snapshots
Camera view and other Augment3d settings can be saved directly in Eos Snapshots for quick
playback. 
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Augment3d Control Mode
Control Mode is the default Augment3d view, allowing for visualization and navigation of your
space, fixtures, and objects.

Collectively, the Augment3d virtual environment is referred to as the model. All fixtures and
objects must be part of the model in order to be configured.

In Control Mode, a command line can be toggled on or off on a connected Augment3d tether.
For more information, see Tether Command Line (on page 435).

Toolbar
Limited toolbar options are available in Control Mode:

• Camera Tool (on page 453)
• Focus Tool (on page 454)
• Labels Tool (on page 454)
• Sticks Tool (on page 455)
• Light Tool (on page 455)
• Options Tool (on page 455)
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Augment3d Edit Mode
Edit Mode is the secondary Augment3d view, allowing for editing and configuration of your
space, fixtures, and objects.

Surrounding the central workspace are primary windows to assist in fixture and object
manipulation: the Library, Materials, Preferences, Hierarchy, and Inspector. These windows can
be freely dragged, rearranged, re-sized, and closed.

Using Edit Mode
To enter Edit Mode, press the {Edit} button in the upper-right corner.

Note: Only one console in a multi-console system can be in Edit Mode at a time.

To exit Edit Mode, select {Done}. Choose whether to apply the changes you have made to the
Augment3d model, or revert them and exit without saving changes.

In a multi-console system, only one console can edit the Augment3d model at once. If a
connected console is already in Edit Mode, the option to force revert changes appears. This
option will revert all changes made by the console currently in Edit Mode and exit all consoles
from Edit Mode. It is not possible to undo or recover reverted changes.
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CAUTION: Do not use Eos Undo operations via the command line while
editing an Augment3d model, as it can alter your show data unexpectedly.
Full Undo options for Augment3d will be implemented in a future Eos
software release.
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XYZ & Origin
In Edit Mode, Augment3d models are arranged around three axes; horizontal X (red) and Y
(green), and vertical Z (blue).

The point at the intersection of these axes (0,0,0) is the origin. This virtual point in Augment3d
must correspond to a real point in your space, ideally on the floor. This could be in the center of
your stage, in a corner, or any convenient point.

All other measurements in Augment3d reference the origin. To improve the accuracy of your
model, choose a physical point that is easily accessible for measurements.

Units
By default, Augment3d measures distance in metric (meters). This can be changed in Setup
> System Settings > Augment3d.

Available options are meters, decimal feet, or feet and inches.
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Library
The Library contains all of the non-fixture items in an Augment3d project and comes preloaded
with a large number of stock objects for your convenience. You can also import your own
Augment3d objects (see Importing Augment3d Objects (on page 475)).

Drag objects to add them from the Library into your model at the origin. Use the Search function
to quickly locate specific items. Create folders from the dropdown to organize Library items.

Library Items
Objects

Any objects contained in the Stock folder can be added to an Augment3d model (see
Augment3d Objects (on page 473)).

Any custom objects imported into Eos will also appear here (see Importing Augment3d Objects
(on page 475)).

Nodes

Nodes can be associated with one or more Augment3d objects in the Hierarchy (on page 449).
This allows those objects to be controlled together; for example, as patched scenic elements (for
more information, see Scenic Elements (on page 474)).

Scenic elements can be given intensity values, moved, rotated, etc. This allows you to change
the visibility and position of Augment3d objects using cues, submasters, and so on.

Groups

A group is an Augment3d object designed to be the parent of other objects which have their
own unique coordinates. Fixtures that have a group parent will display their relative coordinates
in Patch.

A group cannot be scaled, but can be moved and / or rotated. Moving or rotating the group
node will move or rotate all of its child objects.

Labels

Labels are floating text that can be positioned anywhere in your Augment3d model.

Materials
Materials in Augment3d are collections of assets that can be applied to objects. Materials can
affect aspects of an object's appearance like color, texture, reflectiveness, and so on.

CAUTION: Augment3d materials are referenced data, meaning any material
edits will be reflected across all objects with those materials applied.
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Materials Library

Navigating to Window > Materials will open a window with the materials library, containing all
stock materials, along with any you have created or imported.

Note: Stock materials cannot be edited or deleted. To alter a stock material,
duplicate it and make changes to the copy.

Search for materials using the search bar. The dropdown menu allows you to create folders for
further organization, or create new materials.

Materials can be dragged from the materials library into the Augment3d scene, and dropped
onto objects or object subcomponents to apply the material directly.

Selecting a material in the library will display the following options:
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• Name - the name of the material.
• Duplicate - this button creates a copy of the selected material.
• Base Color - the underlying color used for the material.
• Base Color Image - the texture for the material. If transparent, the base color will show

through.

Color materials only contain a base color. Texture materials have an additional base color
image, for which the following properties are available:

• Metallic - adjusts the reflectiveness between dielectric / absorbing some light (0) to pure
metal / reflects all light (1).

• Smoothness - adjusts the texture between roughest (0) and polished (1).
• Rotate - rotates the base color image in degrees.

• Quick buttons are also available to rotate the material 90° CCW and CW, mirror
left/right, and mirror top/bottom.

• Alignment - changes the texture's alignment on the object along the X and Y axes of the
object's UV map (0-0.9).

• Repeat - alters the texture's size by setting how many times it repeats along the X and Y
axes between fewest repeating patterns (1) and most repeating patterns (100).

Accurately editing the properties above may rely on knowing the UV mapping of an object, the
2D representation of how materials are applied to the 3D surface. To aid in this, duplicate the
stock UV Map texture (Stock > Textures > Miscellaneous > UV Map) and temporarily apply it
to your object to see the stock mapping. Edit the properties above to test how your changes will
be applied to the object with a different texture.

Materials in the Inspector

Selecting an object in the Hierarchy will display associated information in the Inspector.
Selecting in the Materials field will show a list of all materials currently applied to that object.

Note: Complex objects can be expanded to view and edit the materials for the
object's component parts.

Select the material to open a dropdown version of the materials library. New color materials can
quickly be created using the color picker and material name options at the bottom of the
dropdown.

To save changes and close the materials list, use the checkmark button. To discard changes, use
the trashcan button.

Custom Materials
Custom materials can be created by adding JPG or PNG images to a zipped folder. The images
must match the following naming conventions:
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• Base Color image - filename_base_color.jpg/png
• Normal Map image (optional) - filename_normal_map.jpg/png

If a map image is not included, the stock mapping will be used.

Materials can be imported via the Eos browser. Navigate to File > Import > Augment3d Scenic
Materials, and select the desired file. A confirmation will appear for successful imports.

If a tether and a console are connected, materials can also be imported from the tether device
by entering Edit Mode and navigating to File > Import to Library > Materials.

Additional materials resources are also available on the ETC website, etcconnect.com.

CAUTION: Custom materials must be applied to an object in order to be
saved with the show file. Custom materials not applied are shown in darker
text and will be deleted on the shutdown of Augment3d.

http://www.etcconnect.com/
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Augment3d Preferences
Preferences contains all the settings for your Augment3d model.

Note: Many of these options can also be changed from the toolbar. For more
information, see Augment3d Toolbar (on page 453).

Editor

Grid

Toggles the grid on or off. Also available in Toolbar > Grid.

Width / Height

Sets the overall dimensions of the grid.

Snap

Toggles object placement snapping to the grid on or off. Also available in Toolbar > Snap.

Snap Distance

Sets the distance increment for the spacing of the grid, along with object placement snapping
(in the chosen global unit).

Angle

Sets the angle increment for object placement snapping (in degrees).

Focus Height

Sets the Focus Height offset. Also available in Toolbar > Focus.

Origin

Toggles the origin point marker on or off.

Show Refresh Rate

Toggles visible frame rate monitoring on or off.

Graphics
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Quality

The following graphics quality options are available:

• Low - no realtime lighting, simple beam indicator, low-texture resolution, no anti-aliasing,
no shadows

• Medium - realtime lighting, low beam quality, medium-texture resolution, no anti-
aliasing, no shadows

• High - realtime lighting, medium beam quality, high-texture resolution, anti-aliasing,
medium-resolution hard shadows

• Ultra - realtime lighting, high beam quality, high-texture resolution, anti-aliasing, high-
resolution soft shadows

Note: In console implementation, Augment3d render quality is limited to Low or
Medium.

Refresh Rate (FPS)

The maximum refresh rate attempted by Augment3d. By default, this is set to 30 frames per
second. This can be adjusted higher or lower in a range from 5 - 60 FPS, but will be ultimately
limited by the graphics processor on the device running Augment3d.

Resolution Scale

Note: This option is only available in ETCnomad on Windows and macOS.

This following options are available to adjust the Augment3d resolution:

• 100% - full resolution
• 75% - 75% of the full resolution, scaled up to fit the tab frame
• 50% (Fastest) - 50% of the full resolution, scaled up to fit the tab frame

The latter two options may result in improvements to Augment3d performance.

Lighting

The following lighting options are available:

• Pass-Through - light passes through objects. Least resource-intensive.
• Approximated (default) - light will pass through an object if all corners of the beam do not

hit that object. Moderately resource-intensive.
• Realistic - accurately-modeled light. Most resource-intensive.

Note: Console output will stay consistent regardless of Augment3d performance.

Light

Sets the overall intensity of the simulated light. Also available in Toolbar > Light.

Note: This only affects the intensity of the simulated light beams in Augment3d, not
the intensity values of the fixtures themselves.

Haze

Sets the overall haze level. Also available in Toolbar > Light.
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Smoke

Toggles animated haze smoke particles on or off.

Ambient Light

Sets the color and level of ambient light. Also available in Toolbar > Light.

Bloom*

Controls the amount that simulated light in the scene reflects on objects to make them glow.
Also available in Toolbar > Light.

Bloom Diffusion*

Adjusts the concentration of the bloom effect. Also available in Toolbar > Light.

Saturation*

Sets the overall saturation of colors in the Augment3d model.

Contrast*

Sets the overall contrast of the Augment3d model.

Note: Settings marked with an asterisk (*) are only applied in High and Ultra quality
settings.

View

Camera Follow Mode

Toggles Camera Follow Mode between Off and Fixture POV, which switches the camera view to
that of the first selected fixture. Also available in Toolbar > Camera.

Camera View

Toggles between Perspective and Orthographic view. Also available in Toolbar > Camera.

Animate Camera Presets

Toggles animation while moving between camera presets.

Animate Pan/Tilt Movement

Toggles animation of automated fixtures. Also available in Toolbar > Focus.

Fixture Labels

Toggles labels over the fixture body for all, automated, selected, and / or active fixtures. Also
available in Toolbar > Labels.
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Beam Center Labels

Toggles labels in the center of the simulated beam for all, automated, selected, and / or active
fixtures. Also available in Toolbar > Labels.

Focus Handles

Toggles beam-end handles for all, automated, selected, and / or active fixtures, and text labels
for each handle. Also available in Toolbar > Labels.

Stick Beams

Toggles Stick Beams for all, automated, selected, active, and / or inactive fixtures. Also
available in Toolbar > Labels.

Light Beams

Toggles beams for all, automated, or selected fixtures. Also available in Toolbar > Light.

Cue Preview Mode

Toggles Cue Preview between Default (off) and Pending Cue. Pending Cue mode allows
Augment3d to display a virtual preview of the look used in the next upcoming cue. Also
available in Toolbar > Options.

Reset

Reset Settings to Default

Resets all settings in Preferences back to defaults.

Reset UI to Default

Resets the Augment3d window size and layout back to defaults.
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Hierarchy
The Hierarchy lists the objects and fixtures currently in your Augment3d model. This includes all
objects that have been manually added and all fixtures automatically added via Patch.

The dropdown menu allows you to add query folders, as well as the option to create new objects
and groups without using the Library.

The search bar allows you to search for objects by name or tag. This is useful for editing large,
complicated models, which can have hundreds of objects and fixtures.

Right-clicking a hierarchy object allows you to change its color swatch.

Note: Color swatches are for identification only, and do not alter the color of the
associated object.

Groups
To create a new group, use the dropdown menu to add a new group folder. Items added to this
folder from elsewhere in the hierarchy will be considered part of the same group, and can be
moved, scaled, and rotated in unison. To remove an item from the group, remove it from the
folder.

Query Folders
Query folders are smart folders that update their contents automatically. Once a query folder is
created from the Hierarchy, the Inspector (on page 451) will display options for the folder.

Available options are:

• Include Types (Fixture, Group, Model, FPE Calibration Point, Label, Dynamic,
Reference Point) - toggling any combination of these options will include all objects of
that type in the folder.
• Dynamic objects (currently Pipes, Trusses, and Curtains) proportionally adjust to scaling.
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• Include Names - includes all objects of a specific name in the folder.
• Include Tags - includes all objects with a specific tag in the folder.

Refining Query Folders

You can further refine the Names and Tags options using wildcards. An asterisk (*) will replace
multiple characters, and a question mark (?) will replace single characters. For example, three
Person 1 objects have been added to the model, named "Alex," "Chris," and "Kim." A search
for "*i*" will return Chris and Kim, (which both contain an "i"), while a search for "?i?" will
only return Kim, the only three-character option containing an "i."

Sorting and Reordering
Use the Sort button next to the dropdown button to organize the contents of the Hierarchy
between A-Z, Z-A, and unsorted. In unsorted mode, Hierarchy objects can be freely dragged and
reordered. This order is temporarily stored, but may not be maintained.

Triangle Count

This button provides an overview of the objects using the most triangles, along with information
about their impact on Augment3d. Reducing the number of triangles used in a model will
improve processing performance.

Nesting Objects
Nesting objects within the Hierarchy associates multiple "child" objects with a "parent,"
allowing you to create sets of objects that can be moved, shown, and hidden in unison. Nest
objects to a Scenic Element or Scenic Element Movable Channel so that they can be moved,
shown, and hidden during cue playback.

To nest objects, select the desired child objects in the Hierarchy by clicking while holding SHIFT
(for consecutive objects) or CTRL (for individual objects). Once selected, simply drag them over
the parent object in the Hierarchy and release when the parent is highlighted to nest them
underneath. Select and drag child objects out from under their parent to separate them again.

Position data for nested objects is relative to their parent, rather than the world position. For
more information, see Position, Rotation, & Scale (on page 452).

Expanding and Collapsing Objects

Complex objects added to the Hierarchy may be expanded into a series of nested objects by
right-clicking on them and choosing "Expand." Child objects may be selectively recombined by
right-clicking a child object at any level and choosing "Collapse."
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Inspector
The Inspector window contains a variety of controls for modification of any selected objects.

Name
Sets the name for the object.

Materials
Allows you to edit the materials assigned to the object. A preview of the applied material or a
mosaic of multiple applied materials is shown to the right. For more information, see Materials
(on page 441).

Lock
Locks objects to prevent them from being altered in the Inspector.

Note: Locked objects may still be moved, scaled, or rotated by selecting them in the
Hierarchy.

Visibility
Controls object visibility in the Augment3d scene.

Focus
Sets object focus behavior between the following options:

• Always Focus - if this object is clicked on, it is used as the point for click-to-focus.
• Never Focus - this object is ignored when using click-to-focus.
• Selective Focus - object is used as the point for click-to-focus. If CTRL is held while

clicking, the object is ignored.

Rotation
These icons rotate the selected object counterclockwise (CCW / left) or clockwise (CW / right)
about the X, Y, and Z axes respectively.
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Move to Ground Plane
Aligns the selected object with the ground plane of the Augment3d model.

Position, Rotation, & Scale
Allows you to manually enter the position, rotation, and scale data for the selected object.
Values can be adjusted by typing in the corresponding box, or by dragging left or right on the
box labels.

Position refers to the physical location where the item is placed in the space in relation to the
origin, if the item is not nested to any other object. If the item is nested to another object, the
position data represents the physical location where the item is placed in relation to its parent's
origin.

World
Information about the world position and size of the selected object. The world position is
always the physical location where the item is placed in the Augment3d scene in relation to the
origin of the model. Values can be adjusted by typing in the corresponding box, or by dragging
left or right on the box labels.

Bounds
Information about the size of the selected object.

Tags
You can add tags to objects in this field. In large or complicated models, this makes them easier
to search for via the Hierarchy.
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Augment3d Toolbar
The toolbar contains different options for altering Augment3d fixtures and objects.

Note: Certain tools are only available in Edit Mode. See Edit Mode-Only Tools (on
page 456).

Camera Tool
Camera provides several options to change your view and position in Augment3d. Reset all
options to default by clicking Restore Camera Mode Defaults.

Note: In a multi-console system, the Augment3d camera view is synced between
devices assigned to the same user ID. All other Augment3d settings are set and
adjusted per-device.

Home
Returns you to the default camera position. This can be updated to the current position by
holding down the Home bookmark, or reset by clicking Restore View Defaults.

Bookmarks
You can record up to five custom camera positions as bookmarks. Like Home, these can be
updated by holding, or reset by clicking Restore View Defaults. Updated bookmarks can be
stored and recalled using Eos Snapshots that include the Augment3d tab or tether (see About
Snapshots (on page 398)).

Look
The Look buttons provide shortcuts to different camera positions, oriented around the current
camera position.

Zoom
Zooms the camera view to whatever fixtures or objects are currently selected in Augment3d.

Fixture POV
Positions the camera from the point of view (POV) of the gate of the first selected fixture. Exiting
POV mode returns the camera to its previous position. When enabled, a Fixture POV symbol will
overlay the Camera icon. Also available in Preferences.
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Mode
Toggles between Perspective and Orthographic camera modes. In Perspective mode, objects
that are further away are smaller than nearby objects. In Orthographic mode, all objects are the
same scale. Also available in Preferences.

Move
Toggles between Fly and Orbit camera modes. In Fly mode (indicated by a Fly symbol overlaying
the Camera icon), the mouse alters the angle of the camera. In Orbit mode (indicated by an
Orbit symbol overlaying the Camera icon), the mouse moves the camera around a center point.
Movement is still possible via keyboard controls in either mode. Hold ALT to temporarily reverse
the behavior.

Focus Tool

Provides options to edit the Focus Offset height and toggle automated fixture animation on or
off. LEFT MOUSE + CENTER WHEEL will also adjust the height. Also available in Preferences.

Labels Tool
Labels provides options to toggle various informational overlays on or off. Reset all options to
default by clicking Restore Label Defaults. All label options are also available in Preferences.

Fixture Labels
Toggles labels overlaying fixture bodies for all, automated, selected, and / or active fixtures.

Beam Center Labels
Toggles labels overlaying fixture beams for all, automated, selected, and / or active fixtures.

Focus Handles
Toggles focus handles for all, automated, selected, and / or active fixtures. Spherical handles
may be moved to proportionally refocus automated fixtures. Cubic handles indicate a
conventional fixture, but cannot be used to refocus. Labels overlaying focus handles can also be
toggled.
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Sticks Tool
Stick beams can be toggled to see where a fixture is pointed (even if it is not currently
outputting), or for differentiating between multiple fixtures focused on the same location.

Toggle stick beams for all, moving, selected, active, or inactive fixtures. Reset all options to
default by clicking Restore Stick Defaults. Also available in Preferences.

Light Tool
Provides options to configure the simulated light in an Augment3d model. Reset all options to
default by clicking Restore Beam Defaults. All light options are also available in Graphics.

Beams
Toggles simulated light beams for all, moving, or selected fixtures.

Light
Intensity adjusts the overall intensity of the simulated light. This option does not alter the actual
intensity values of fixtures themselves.

Glow and Diffusion control the degree to which objects in the scene glow. These options only
apply in High and Ultra quality.

Beam Intensity
Toggles between low, medium, and high intensity simulated beams. Toggle Haze on to increase
the realism of the beams.

Ambient Light
Toggles between no, low, medium, and high overall ambient light levels in the Augment3d
model.

Options Tool

Pending Cue Mode
This mode allows Augment3d to display a virtual preview of the look used in the next upcoming
cue.
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Reset Cue Preview by clicking Cue Preview Mode Defaults. An eye will appear on the Options
icon when in Cue Preview mode. Also available in Preferences.

Quality

Allows you to adjust the quality of the Augment3d render, the Refresh Rate, and the Lighting
mode. ETCnomad for Windows and macOS offers an additional option to adjust
Resolution Scale. Also available in Preferences. See Graphics (on page 445).

Note: Augment3d render quality on consoles is limited to Low or Medium.

Edit Mode-Only Tools

Grid Tool

Toggles the grid on or off. Also available in Preferences.

Snap Tool

Toggles object snapping to the grid on or off. Also available in Preferences.

Move Tool

Allows you to move objects along the X/Y/Z axes. Handles have conical ends.

Scale Tool
Allows you to resize objects along the X/Y/Z axes. Handles have cubic ends. Use the
center handle to resize all dimensions proportionally.
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Rotate Tool

Allows you to rotate objects around the X/Y/Z axes.

Local Tool
Toggles Move and Rotate object tools between global XYZ orientation and object
XYZ orientation. Scale is always performed relative to the object's Local
XYZ orientation.

• On the left barrel, Local is toggled off, so the Move tool orients itself based on the
Augment3d model.

• On the right, Local is toggled on, so the Move tool orients itself relative to the position of
the barrel itself.

Performance Indicator
This color-coded dot on the toolbar indicates Augment3d's current quality and performance
level.

• High - 25 FPS and higher
• Medium - 20 to 24 FPS
• Low - 15 to 19 FPS
• Very Low - 10 to 14 FPS
• Poor - 10 FPS and lower
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Fixtures in Augment3d
Fixtures must be patched in Eos and then added to an Augment3d model before they can be
displayed and controlled.

Adding Fixtures Manually
If fixture position and orientation data is already known, fixtures can be manually added via the
Augment3d tab in the Eos Patch screen.

For more information, see Manually Adding Fixtures (on the facing page)

Adding Fixtures Automatically
Alternatively, if fixture position data is not available, Augment3d can calculate the rotation and
XYZ position of fixtures using calibrated points placed at known locations throughout your
space.

For more information, see Fixture Position Estimation (FPE) (on page 462).

Adding Fixtures from Vectorworks
Finally, fixtures can be imported into an Augment3d model from a Vectorworks file. For more
information, see Vectorworks Augment3d Plug-in (on page 477).
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Manually Adding Fixtures
If you already know the position and orientation of your fixtures, you can manually add them to
Augment3d through the Eos Patch screen on a channel-by-channel basis.

In Patch, certain fixtures will appear with the Augment3d "3d" logo next to them. This symbol
indicates profiles with an Augment3d model. Fixtures without the "3d" logo will use a default
fixture model based on the closest fixture type. To change the model used by the fixture type,
see Physical Data Editor (on page 165).

Note: Fixtures requiring a profile update will display with an asterisk (*). For more
information, see Update Profile (on page 152).

Note: Moving Mirror fixtures are not currently supported.

Position and Orientation Data
Position

Position data is either local or world. For more information, see Inspector (on page 451).

In the above example, the fixture patched to Channel 184 is -2 meters offset on the X axis, -13
meters offset on the Y axis, and 7.5 meters offset on the Z axis.

Orientation

Orientation data reflects how the fixture is rotated. The values for X, Y, and Z represent a
rotation in degrees around that axis in relation to the global XYZ axes.

The above left example shows the default orientation of 0/0/0, or pointing straight down. The
center shows a rotation of 180° about the X axis, pointing the fixture straight up. The final
example shows a rotation of 90° about the Y axis, pointing the fixture to the side.
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Adding Fixtures Manually

Under the Augment3d section in Patch, fixtures have fields for XYZ Position and Orientation. If
the fixture is nested, this data is relative to the parent. World Position and Orientation are
absolute, relative to the scene overall. If nested, an arrow indicator will apear next to the
position and orientation fields. For more information about nesting, see Nesting Objects.

You can also edit the following additional properties:

• Beam Angle - set the beam angle from 1-179 degrees
• 0 will reset back to the default (36 degrees) and clear the field

• Shutters - see Shutter Graphic (on page 199)
• Gobo Rotate - set the gobo rotation
• Beam Edge - set the beam edge from 0-100 (empty/default is 50)
• FPE Set - see FPE Sets (on page 463)
• Hide Beam - when enabled, the fixture's beam will not appear in Augment3d

Entering Fixture Position & Orientation Data

Select the channel of a fixture for which you have position and orientation data, and navigate to
the Position & Orientation section of the Augment3d tab in Patch. Selecting one of the position
or orientation fields opens a keypad to input specific values.

Alternatively, keyboard syntax can be used. Use [/] to separate X, Y, and Z when typing in
multiple values, and [Thru] to enter information for multiple fixtures at once.

• [Chan] [1] [Select] [5] [/] [5] [/] [5] [Enter] sets the position of Channel 1 to 5,5,5.
• [Chan] [1] [Select] [/] [2] [/] [Enter] sets the Y coordinate of Channel 1 to 2. No changes

are made to the X and Z coordinates.
• [Chan] [1] [Select] [+] [3] [/] [/] [Enter] adds 3 to the current X coordinate of Channel 1.

No changes are made to the Y and Z coordinates.
• [Chan] [1] [Select] [+] [/] [1] [/] [-] [5] [Enter] adds 1 to the current Y coordinate of

Channel 1, and subtracts 5 from the Z coordinate. No change is made to the X coordinate.
• [Chan] [1] [Thru] [5] [Select] [0] [/] [0] [/] [5] [Thru] [10] [/] [10] [/] [5] [Enter] sets the

position of Channel 1 to 0,0,5 and the position of Channel 5 to 10,10,5. The positions of
Channels 2, 3, and 4 are evenly distributed between the two.

• [Group] [10] [Select] [5] [/] [/] [Thru] [10] [/] [/] [Enter] distributes the X coordinate of all
channels in Group 10 between 5 and 10. No changes are made to the Y and Z
coordinates.

All trailing slashes are optional. [Chan] [1] [Thru] [10] Position [5] [Thru] auto-completes to
[Chan] [1] [Thru] [10] Position [5] [/] [*] [/] [*] [Thru].

The corresponding fixture is automatically added to the Augment3d model. Repeat the process
for any additional channels or fixtures, or edit fixture position and rotation using tools available
in the toolbar or the Inspector.

Position [@] [Enter] will remove the pose (position and orientation) of the selection. Orientation
[@] [Enter] will reset the orientation of the selection to (0,0,0).
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Editing Fixture Position and Rotation
Fixture position and rotation can also be edited in Augment3d Edit Mode (on page 438) using
tools available in the toolbar or in the Inspector.

Any changes made to fixture position in Augment3d will automatically update the values in
Patch. Similarly, any change made via Patch will automatically update the fixtures in
Augment3d.

Setting Orientation for Conventional Fixtures in Patch
The Orientation property for conventional (non-automated) fixtures is used to aim static lighting
fixture at the correct point.

1. Navigate to Patch.

2. Select conventional fixtures via the command line, or by selecting them in Augment3d.
The fixtures will light up to indicate their selection.

Note: You do not need to enter Augment3d Edit Mode to select fixtures.

3. Aim the fixtures at their intended target using a long selection, or SHIFT + left mouse.
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Fixture Position Estimation (FPE)
Eos can automatically configure the location and orientation of automated fixtures in
Augment3d using a process called Fixture Position Estimation (FPE).

Setting Up FPE
FPE associates four or more points in your space with corresponding Focus Palettes in order to
estimate the location and rotation of your automated fixtures.

If you are setting up your fixtures for the first time, it is generally easier to choose FPE points first
and then record Focus Palettes for each one. However, if you have existing Focus Palettes it may
be possible to use those focus locations for your FPE points instead.

FPE Points

Each point is a known physical location in a space, measured in relation to the XYZ & Origin (on
page 440). It is recommended to choose at least four points on the floor encompassing the origin
and as much of your space as possible.

For best results, the four points should be on the same plane (have the same Z coordinate). If
differing Z coordinates must be used, list the points in a clockwise direction from the point of
view of the fixtures. While four points is the minimum requirement, additional points may
increase FPE accuracy.

1. Determine the X and Y coordinates of these points by measuring outwards from the origin
point.

Once you have your points chosen and measured, enter the coordinates for each point.

2. Navigate to the Eos Patch screen. Click the Augment3d tab and select the FPE section.
3. Enter the measured coordinates of each point. Augment3d will automatically place an FPE

Point at each location.

Updating XYZ coordinates in Patch will alter the FPE Point's location in the Augment3d model.

An error will appear if the points chosen are suboptimal. For help, see Troubleshooting FPE (on
page 464).

Focus Palettes

Once you have chosen, measured, and entered the coordinates of your points, associate each
point with a Focus Palette.

1. Focus your fixtures at one of your FPE points and record a Focus Palette.

Note: Fixture beams must be centered on the FPE point. Focusing fixtures one at a
time, sharpening the beam edge, and narrowing the iris to create a smaller-sized beam
may help you center the beam. Using a gobo with an easily-identifiable center point
(such as a crosshair) may also help.
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2. In Patch, enter the Focus Palette number into the "FP#" column that corresponds with the
point on which you focused.

3. Repeat this process until all your FPE points have associated Focus Palettes.

This association between FPE Points and Focus Palettes is crucial to the accurate rendering of
fixtures in Augment3d.

FPE Sets

If multiple sets of FPE calibration data are needed, FPE Points can be arranged in up to ten sets.
Each set has its own FPE Points, allowing you to maintain FPE data for multiple spaces within the
same Eos showfile. Each FPE set can then be assigned to a channel or range of channels. The
fixtures patched to those channels will then use the FPE Points in that set for their calibration
and focusing.

Multiple FPE sets can be useful for consoles that control more than one space, or for touring
shows working in multiple venues. This can also be useful if all the fixtures in your space cannot
focus on the same set of FPE points.

Calculating FPE
Once you have at least four FPE Points matched to Focus Palettes, you are ready to calculate
FPE.

Press Realculate FPE , then Confirm FPE to commit your changes.

A window will appear summarizing any FPE changes and / or a table of errors.

Note: Any errors must be resolved before proceeding. It is not possible to undo an
FPE calculation.

Press Accept FPE Changes to proceed.

If calculating FPE for the first time, this will automatically generate fixtures in your Augment3d
model. You can also make subsequent FPE edits or recalculations the same way.

Selective FPE

With nothing selected in the command line, FPE will recalculate positions for all patched fixtures
in a show file. If specific fixtures or ranges of fixtures are selected, the FPE calculation will only
affect the selection.
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Troubleshooting FPE
Accuracy

There are several ways to calculate the positions and rotations of the fixtures in your show.
There are several factors that can also impact the accuracy of this estimation, including:

• Fixture profile inaccuracy
• Poor FPE point selection
• FPE point measurement error
• Slack in automated fixture belts
• Asymmetry about the tilt axis
• Fixture-to-fixture pan / tilt variations

FPE accuracy is dependent on profile information and user-supplied data. If the data is
inaccurate, the computation will either fail or give poor results. Adequate care should be taken
to ensure that profiles do not have errors and that the positions of FPE points are accurately
measured.

Best Practices

There are many ways to select FPE Point positions. The preferred method is to use at least 4
points close to the bounds of your space, as in the example above. Larger angles between points
reduces the possibility of redundant information being used in the calculation. It may help to
think of the points as outlining the base of a 3D shape that should cover as much of your space
as possible.
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One example of a poor configuration is shown above, with all FPE points in a line. The two
center points are redundant, as they are part of the line from the two end points. Additionally,
there is no coverage of the stage space possible with all points arranged in a line.

A better (but still problematic) configuration is pictured above. Since one of the points is in a line
between two others, the data from that point is redundant and cannot be used to calculate the
fixtures' positions.

Troubleshooting

If fixture response is inaccurate or if fixtures are not generated correctly in Augment3d, check
the following:

• Ensure your fixture profiles are up to date, and update if not (see Update Profile (on
page 152)).
• This is likely to fix the problem if fixtures of one type respond accurately and fixtures of

another type do not.

• Ensure the measured ground points in your space match how they were entered in Eos,
and that the X and Y coordinates were not accidentally swapped.

• Verify you are using the correct units of measurement.
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• Replay your Focus Palettes.
• Did they record correctly?
• Were they assigned to the correct Reference Point?
• Do any of the fixtures pan more than 180 degrees? If so, press {Flip} and re-record (or

update) the Focus Palette

• Add an additional FPE Reference Point and Focus Palette. Recalculate FPE. Is fixture
response more accurate?

Other Common Issues

The following are some of the issues that most often affect the FPE calculation.

Beam Centering
The calculations expect the optical center of the beam to be at the measured ground points. If
this is hard to see with the naked eye, using a crosshair gobo (or any gobo with an easily
identifiable center point) can aid in lining up the beam more accurately over the ground point.

Fixture Profiles
Some automated fixtures may have pan and / or tilt settings that are incorrectly calibrated in
their profile. These profiles must be corrected in order to accurately work with FPE. For more
information, see Fixture Profile Correction (below)

User-Definable Pan / Tilt
Some fixtures have user-definable pan / tilt ranges that may cause inaccuracies. Check the
settings of your fixture and ensure any parameter ranges set on the fixture match the ranges set
in the fixture profile.

Fixtures
Some automated fixtures may be subject to mechanical defects that cause them to behave
inaccurately when compared to their profile or other fixtures of the same model. Unless a
custom profile is created that matches the specifications of that fixture, it will not work correctly
with FPE.

Fixture Profile Correction
If FPE has been checked and run correctly, continuing issues may be due to inaccuracies in a
fixture profile or the physical fixture itself.

Before continuing, please ensure that your fixture profile library is updated to the current version
(see Update Profile (on page 152)).

Note: If you correct inaccuracies in a fixture profile, please report the necessary
updates via the ETC Augment3d forums at community.etcconnect.com. When possible,
please include a copy of the fixture manual .

Pan / Tilt Inversion

If a fixture in Augment3d pans and / or tilts in the opposite direction as it does in the real world,
either parameter may be inverted.
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Note: Many fixtures have a setting to invert and/or swap pan and/or tilt within the
fixture firmware. Ensure that these are not enabled before testing for inversion as
described below.

Testing for pan / tilt inversion
1. Set the fixture’s pan to 0° and tilt to +90°. Increment the pan in either direction. Does the

virtual fixture rotate in the same direction as the physical fixture?
2. Set the fixture's pan and tilt to 0°. Increment the tilt in either direction. Does the virtual

fixture point in the same direction as the physical fixture?

Correcting pan / tilt inversion
If you find that the pan or tilt value did not move in the correct direction, use the range editing
tools in the Fixture Editor (on page 153) to invert the DMX range, or swap the DMX and User
Min/Max at the same time.

Pan Range

If the pan direction is correct, but the virtual fixture pans further in either direction than the real
fixture, the fixture's physical pan range or values may not match its profile.

Testing pan range
1. Aim your fixture at a point on your stage. Press the “Flip” button. Does the fixture return

to the same point? If so, pan is mapped correctly. If not, set the fixture's tilt to +90°,or
until the fixture is pointing forwards.

2. Test with pan values of -90°, 0°, and +90°. The fixture should point to the left, straight
forwards, and to the right, respectively. If so, pan is mapped correctly. If not, follow the
steps below to correct the pan range in the Fixture Profile Editor.

Correcting pan range
1. First, find the correct DMX home value for pan.

a. Set pan to 0° and tilt to +90°.
b. Increase or decrease pan, using the smallest value possible, until the optics are

pointed away from the UI of the fixture.
c. Using About (on page 379), find the raw DMX values for pan (including course and

fine), and note them.

d. Set this new raw DMX level as your pan DMX home value in the Fixture Editor (on
page 153).
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2. Then, using the new DMX home value, calculate the maximum.
a. Set your pan value to the minimum DMX value (likely 0) and select a tilt value that

targets a point in your venue.
b. Increase your pan value 360° until the fixture is pointing at the same point again and

note this DMX value as your found pan value.
c. Note the minimum allowed DMX value for pan (likely 0) and the maximum allowed

DMX value for pan (likely 255 or 65535).
d. Calculate the User Min and Max Degree values:

• min pan value = (360 ÷ (found pan - minimum pan)) * (minimum pan - pan
DMX home value)

• max pan value = (360 ÷ (found pan - minimum pan)) * (maximum pan - pan DMX
home value)

3. Set the output of this calculation as your new user minimum and maximum.
4. Recalculate FPE (see Calculating FPE (on page 463)) and test for accuracy.

Tilt Range

If the tilt direction is correct, but the virtual fixture tilts further in either direction than the real
fixture, the fixture's physical tilt range or values may not match its profile.

Testing tilt range
1. Aim your fixture at a point on your stage. Press the “Flip” button. Does the fixture return

to the same point? If so, tilt is mapped correctly. If not, set the fixture's pan and tilt to 0°.
2. Pan the fixture in a circle. Does the fixture beam remain stationary, pointed straight

down? If so, tilt is mapped correctly. If not, follow the steps below to correct the tilt range
in the Fixture Profile Editor.

Correcting tilt range
First, find the correct DMX home value for tilt.

1. Set your tilt to 0°. Pan clockwise 360°, then counterclockwise 360°, and repeat.
2. Slowly increase or decrease your tilt value until the fixture spins with no wobble in the

beam during the sweep.
3. Set the raw DMX value as your tilt DMX home value in the Fixture Editor (on page 153).

Then, using the new DMX home value, calculate the maximum.

1. Set your tilt to your new DMX home value.
2. Begin increasing tilt until the fixture head is approximately perpendicular to its base and

record this DMX value as your found tilt value.
3. Not ethe minimum allowed DMX value (likely 0) and the maximum allowed DMX value

(likely 255 or 65535) for tilt.
4. Calculate the user min and max degree values:

a. min tilt value = (90 ÷ (found tilt - tilt DMX home value)) * (minimum tilt - tilt DMX
home value)

b. max tilt value = (90 ÷ (found tilt - tilt DMX home value)) * (maximum tilt - tilt DMX
home value)

5. Set the output of this calculation as your new user minimum and maximum.
6. Recalculate FPE (see Calculating FPE (on page 463)) and test for accuracy.

Fixture Defects

If none of the troubleshooting or profile correction steps help, there may be an issue with the
fixture itself.
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Certain mechanical defects may cause an automated fixture to behave inaccurately when
compared to their profile or other fixtures of the same model. Unless a custom profile is created
that matches the specifications of the fixture, it will not work correctly with FPE.

For more information, see Creating a New Fixture (on page 153).
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Working with Fixtures
Once fixtures are added to your model, you can begin using Augment3d to focus and control
them. There are a variety of tools available to help with this.

Fixture Selection & Focus
Selecting Fixtures

To select fixtures in Augment3d, either select them via the Eos command line or use a mouse.
Click on a fixture to select it. You can also drag, or hold shift to select multiple fixtures.

There are three colors used for selection:

• Gold - fixtures selected in Eos
• Blue - fixtures selected in Augment3d Edit Mode
• Pink - fixtures selected in both Eos and Augment3d

Focusing with Click-To-Focus

Selecting and holding on an object or plane in your Augment3d model will focus the selected
fixture on that spot. Pressing SHIFT + LEFT MOUSE will also activate Click-To-Focus. You can
also drag around the model to move the fixtures. Fixtures without pan / tilt parameters must be
selected while in Patch for Click-to-Focus to work.

Other Useful Tools
Labels Tool

Fixture Labels display the channel number of the fixture. This can be useful in identifying which
fixture is creating a particular beam of light.
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Focus Handles create a controllable point at the end of the beam of an automated fixture, which
can be dragged to focus a single fixture, or multiple fixtures together while maintaining their
spatial relationships.

For more information, see Labels Tool (on page 454).

Sticks Tool

Stick Beams draws a line from the fixture to wherever the beam lands. Stick Beams do not
require intensity and can be used to focus a fixture that is not currently outputting.

For more information, see Sticks Tool (on page 455).

Focus Tool

Use the Focus Height feature to set a vertical offset from the location that is being focused on, in
order to adjust focus to an actor's chest or face, instead of on the floor where they are standing.

For more information, see Focus Tool (on page 454).

Augment3d with Magic Sheets & Pixel Maps
Right-click on the Augment3d tab to reveal the context menu, which contains options for
working in tandem with pixel maps (see About Virtual Media Server (on page 482)) and magic
sheets (see About Magic Sheets (on page 412)).

Augment3d with Pixel Maps

Set Channel Locations From Pixel Map
This option allows you to pull fixture locations from an existing pixel map in your show file.

Specify the pixel map number and any X/Y/Z constraints. Select {Confirm} to place fixtures in
your show at the same locations they exist in the pixel map.

Create Pixel Map From Channel Locations
This option allows you to use your existing Augment3d fixture locations to create a pixel map.
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Specify the camera direction that the fixture locations will be pulled from and a pixel map
number. Select {Confirm} to create a pixel map with fixtures at the same locations they exist in
the Augment3d model.

Note: This option is governed by fixture selection. If no fixtures are selected, all
fixtures in the Augment3d model will be added to the pixel map.

Create Pixel Map From Magic Sheet
This option allows you to create a Pixel Map from an existing magic sheet.

Specify the pixel map to create and the magic sheet to pull from. Select {Confirm} to create a
pixel map with fixtures at the same locations they exist in the magic sheet.

Augment3d with Magic Sheets

Create Magic Sheet From Pixel Map.
This option allows you to create a magic sheet from an existing pixel map.

Specify the magic sheet to create and the pixel map to pull from. Select {Confirm} to create a
magic sheet with fixtures at the same locations they exist in the pixel map.

Set Channel Locations From Magic Sheet
This option allows you to pull fixture locations from an existing magic sheet in your show file.

Specify the magic sheet number and any X/Y/Z constraints. Select {Confirm} to place fixtures in
your show at the same locations they exist in the magic sheet.

Create Magic Sheet From Channel Locations
This option allows you to use your existing Augment3d fixture locations to create a magic sheet.

Specify the camera direction that the fixture locations will be pulled from and a magic sheet
number. Select {Confirm} to create a magic sheet with fixtures at the same locations they exist
in the Augment3d model.

Note: This option is governed by fixture selection. If no fixtures are selected, all
fixtures in the Augment3d model will be added to the magic sheet.
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Augment3d Objects
Objects are any non-fixture element of your Augment3d model.

Adding Objects
There are two ways to add an object to the Augment3d model.

From the Library
Objects can be dragged from the Library (on page 441) and placed into the model.

Note: Objects are created with a (0,0,0) position on the XYZ axes when added to the
model.

From the Hierarchy
To add objects from within the Hierarchy, right-click, select Create, and choose the object you
wish to add.

Copying Objects
Objects can be copied and pasted by selecting the object in the Hierarchy (on page 449) and
using CTRL + C to copy. Use CTRL + V to paste the object. You can also duplicate selected
objects using CTRL + D. If working in macOS, use CMD instead of CTRL.

Modifying Augment3d Objects
The Position, Scale, and Rotation of any object in an Augment3d model can be modified using
one of the associated tools in the toolbar (see Edit Mode-Only Tools (on page 456)).

Selecting one of the modification tools from the toolbar puts the selected object or objects into
the corresponding modification mode (Move, Scale, and Rotation, as seen left-to-right below).

These parameters can also be modified using the quick buttons in the Inspector (on page 451).

Position
Select the Move tool. Drag on any of the X/Y/Z axes to move the object in that direction.
Objects that have been moved away from their 0,0,0 default position will display a trail and
distance measurement back to the Origin.

Scale
Select the Scale tool. Drag on any of the X/Y/Z axes to enlarge the object in that direction. Drag
on the white center box to scale all dimensions proportionally.
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Rotation
Select the Rotate tool. Drag on any of the X/Y/Z axes to rotate the object in that direction.

Scenic Elements
You may wish to change the visibility and position of Augment3d objects using cues,
submasters, and so on. Two new profiles are available in Patch in order to accomplish this,
under {Type} > {Manufctr} > {ETC Fixtures} > {Scenic Element}.

Scenic Element
Objects nested to a channel and patched as Scenic Element can be given intensity values to
show or hide them on a cue-by-cue basis.

An example would be an object that is onstage in Act I but is removed for Act II. Instead of
removing the object from Augment3d, simply hide it by giving it a 0 intensity value in the Act II
cues.

Scenic Element Movable (SEM)
Objects nested to a channel and patched as Scenic Element Moveable can be given intensity
values, but also have the option to have their position, orientation, and rotation changed from
cue-to-cue.

An example would be an object that remains onstage for the duration of the show, but changes
position between Acts I and II.

Position, orientation, and rotation of SEM channels and any objects nested to them are
controlled entirely from Eos and not from the Augment3d tab. Relative positions are maintained
when objects are nested to the SEM channel; to reflect the world position of the nested object
with the SEM parameters, place both the object and SEM at 0,0,0 before nesting.

Note: Objects patched as Scenic Elements are exempt from Grandmaster and [Select
Active] control.
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Importing Augment3d Objects
Custom 3D objects can be imported into the Augment3d object library from the Using the
Browser via File > Import > Augment3d Scenic Models.

For a full list of supported 3D file types, see Supported 3D File Formats (on page 477).

Note: Custom objects can only be deleted from the Library if they are not used in the
current model.

If a tether and a console are connected, objects must be imported from the tether device. Enter
Edit Mode, and navigate to File > Import to Library > 3D Model to proceed with object import.

Import Options
After a file is selected via the file browser, the Import Options panel will display.

Use the available options to configure the import to correctly represent your file in Augment3d.

Scale

Select the desired units to use for the size of the object being imported.

Origin Position

Determines the position of the object relative to the origin when added to the model from the
Library.
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• As Model - the object will be placed using the origin point defined in the object model.
• Center - the object will be centered on the origin.
• Ground - the object's base will be aligned with the origin.
• Top - the object's top will be aligned with the origin.

Model Orientation

Unlike some 3D modeling software, Augment3d uses the Z plane for up / down positioning.

Automatic uses the coordinate assignments from the source software. Z-Up assigns Z to up /
down.

Note: If your model imports sideways, reimport using Z-Up.

Optimization

Provides options for optimizing the object for better Augment3d performance. Neither option
can be undone after import is complete.

• Combine Meshes - combines all meshes in the object.
• Remove Small Meshes - removes meshes from the object below a specified size.

After Importing
Once imported, the file will appear in the Library. Drag it into your workspace to add it to your
model.

Note: Vectorworks converts objects to metric on export even when drawn in imperial.
It is best to select meters on import, but check scaled values for accuracy.

CAUTION: Custom objects imported into the Library but not added to the
Augment3d model will be removed upon shutdown of Augment3d.
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Supported 3D File Formats

Optimal 3D Formats
These file formats have been found to work optimally for import into Augment3d:

• .dae
• .zae
• .fbx

DAE files, also known as Collada files, are the optimal export format for Augment3d from
AutoCAD and Vectorworks.

Note: SKP imports from SketchUp will include colors and models only, and exclude
materials.

All Compatible 3D Formats
This is a comprehensive list of all 3D file formats compatible with Augment3d:

.3d

.3ds

.3mf

.ac

.ac3d

.acc

.amf

.ase

.ask

.assbin

.b3d

.blend

.bvh

.cob

.csm

.dae

.dxf

.enff

.fbx

.glb

.gltf

.hmp

.ifc

.ifczip

.irr

.irrmesh

.lwo

.lws

.lxo

.md2

.md3

.md5anim

.md5camera

.md5mesh

.mdc

.mdl

.mesh

.mesh.xml

.mot

.ms3d

.ndo

.nff

.obj

.off

.ogex

.pk3

.ply

.pmx

.prj

.q3o

.q3s

.raw

.scn

.sib

.smd

.stl

.skp

.ter

.uc

.vta

.x

.x3d

.x3db

.xgl

.xml

.xml

.zae

.zgl

Vectorworks Augment3d Plug-in
This installation guide provides information on the installation and setup of the Augment3d Plug-
in for Vectorworks 2019, 2020, and 2021, intended for use with Eos v3.0.0 and later.

This is an ETC-made plug-in for the Vectorworks program intended to export fixtures from
Vectorworks for import into Augment3d.
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Vectorworks System Requirements
For the most up-to-date requirements, please reference vectorworks.net/sysreq.

Installing the Vectorworks Augment3d Plug-in
1. Download the plug-in bundle from etcconnect.com, and extract it. The folder will contain

a copy of these instructions, and two zipped plug-ins for Windows and Mac. Do not
extract these plug-in .zip files.

2. Open Vectorworks and navigate to Tools > Plug-ins > Plug-in Manager > Third-party
Plug-ins.

3. Select {Install} and choose the appropriate plug-in .zip file for your operating system.
4. Restart Vectorworks when prompted. After relaunch, the installed plug-in will appear in

the Built-in Plug-ins tab.

Configuring Vectorworks to use the Augment3d Plug-in
1. Launch Vectorworks.
2. Configure your Vectorworks workspace.

a. Open the Workspace Editor. Navigate to Tools > Workspaces > Edit Current
Workspace.

b. Expand the ETC node in the Commands panel:

c. Drag "Export to ETC Augment3d" to the Spotlight node.
d. Select {OK} to close the Workspace Editor.

https://www.vectorworks.net/sysreq
http://www.etcconnect.com/
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3. In Vectorworks 2019, you must map the information you want to export to Augment3d.
(Vectorworks 2020 and later do not have this option; skip to step 4.) If exporting for the
first time, or to change export preferences, navigate to File > Document Settings
> Spotlight Preferences.
a. Select Edit Visualizer Data Mapping. Recommended mapping below:

b. Select {OK} to close the Data Mapping window.
4. Navigate to Spotlight > Export to ETC Augment3d and follow the prompt.

Vectorworks will export a .a3d file containing your information for import into Augment3d.

CAUTION: Layers containing lights must be visible in the Vectorworks file in
order to export to Augment3d. If no lights are visible, a pop-up will notify
you that the file is empty, and cannot be exported.

Importing to Augment3d
1. In Eos, navigate to File > Import > Augment3d (from Vectorworks), and select your .a3d

file.
2. Click {Map Devices}.

3. Select a device from the Source File column and choose its matching Eos fixture profile.

4. Click {Link Devices}.

5. Repeat steps 3 and 4 until all devices have been associated with fixture profiles.
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6. When complete, click {Done}, then {OK}.Your devices and their associated position
information will now appear in Patch and Augment3d.

Options
The following options are available before import:

• Starting / Ending Channel - defines a specific range of channels to be imported
• Overwrite - overwrites the data in the show file when enabled, and merges the data when

disabled
• Do not update fixture types - disables the updating of fixture types in the show file
• Only import Augment3d XYZ location - enables import of just Augment3d location data
• Import Text/Notes/Labels/Gels Only - enables import of just the patch database text

Exporting Scenery
The Vectorworks Augment3d Plug-in only supports the export of fixtures.

Follow the steps below if you have scenery in your Vectorworks file that you would also like to
export.

1. Hide all fixtures in the Vectorworks workspace.
2. Expose only the scenery you wish to export, then export as a Collada file by navigating to

File > Export > Export COLLADA (3D Only).
3. In Augment3d, import the Collada file. For more information on importing Augment3d

objects, refer to the Eos Family Operations Manual chapter on Augment3d.
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About Virtual Media Server
The virtual media server feature of Eos is comprised of two areas, the virtual media server and
its virtual layers, and pixel maps. These areas are completely dependent on each other.

The virtual media server is a feature used to create layouts of fixtures, known as pixel maps,
which then applies media content (images, movies, text, and procedurally generated effects) by
way of virtual media layers to the pixel map.

A pixel map is a layout of fixtures onto a grid, which determines order of playback and how the
data will be interpreted and outputted to create the desired image or effect. A pixel map creates
relationships among the channels in an X-Y grid so that the channels and their parameters can
be associated with pixels in an image.

A virtual media layer contains one piece of media content. A pixel map can contain up to 12
virtual media layers, which can be stacked on top of each other or used separately.

Media Content
Image, video, HTML, and text files can be applied to a pixel map. A stock library of media can
be obtained by installing the Eos Family Pixel Mapping Installer.

Importing Media Content
Additional media content can be added via the following methods:

• Import All Pixel Map Media - an automatic method for importing media. Files can be
automatically numbered during the import process.

• File Manager - a manual method for importing media. Files should be numbered manually
prior to import.

• Import Show Pixel Map Media - an automatic method of importing all media needed for
the current show file used by backup and client consoles. For more information on
synchronizing media content, see Synchronizing Media Archives (on page 494).

Files must follow the naming convention filenumber_filename; for example, 002_Volcano.mov.

Size, resolution and length of any imported content should be as minimal as possible. For
example, stock video content is under 10MB, under 320x180 resolution, and between 2-20
seconds.

Supported Media Formats

Image
• .gif
• .jpg
• .png
• .svg
• .tiff

Video
The following video formats are recommended:

• .gif
• .mov (.H264 encoding)
• .mp4

For a full list of supported video formats, please consult etcconnect.com.

https://www.etcconnect.com/
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HTML & Text
• .htm
• .html
• .txt

Using Import All Pixel Map Media
To import go to Browser>File>Import> Pixel Map Media>All Pixel Map Media and select the
device with the media on it.

Options in this display include:

• {Library (1-255)} - selects the library to import media.
• {File (0-255)} - selects the file number.
• {Reorder Libraries} - specify whether or not the library on the source device will be

renumbered. If the source device’s library is not numbered, it will be assigned the
specified library number.

• {Reorder Files} - specify whether or not the file(s) on the source device will be
renumbered. If the source device’s file(s) is not numbered, it will be assigned the specified
file number.

• {Overwrite} - overwrite the existing media files.
• {Start Import} - begins the import process. A progress bar will appear to indicate the status

of the import process. When finished, click {Done}.
• {Cancel} - stops the import, and exits the display.

Importing with the File Manager
To import go to ECU>Settings>Maintenance>File Manager.

Note: Make sure your files follow the naming convention of file number_filename. If
the files do not, they will not be recognized as media files. You can always import using
Import All Pixel Map Media instead.

Select the device with the media on it in one window and in the other window select the
MediaArchive folder. Inside the MediaArchive folder, you will see numbered folders. Those
folders correspond to libraries. You can copy or move files.
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Exporting Media Content
There are two ways to export media. Those methods are:

• Export Pixel Map Media - An automatic method for exporting media.
• File Manager - A manual method for exporting media.

Using Export Pixel Map Media
This is an automatic method of exporting all the media used in the current show file. This
includes any pixel map media stored in cues, presets, submasters, etc.

To export, go to Browser>File>Export>Show Pixel Map Media. Select the device you want to
export the media content to.

There are only two options available in this display:

• {Start Export} - begins the export process. A progress bar will appear to indicate the status
of the import process. When finished, click {Done}.

• {Cancel} - stops the export and exits the display.

Using File Manager
Exporting with the file manager is very similar to importing with it. You select the files in the
MediaArchive folder that you wish to export, and you can either copy or move them to your
device.

Setting Up Pixel Maps
A pixel map is a layout of fixtures onto a grid, which determines order of playback and how the
media content will be interpreted and output to create the desired image or effect. A pixel map
creates relationships among the fixtures in an X-Y grid so that the channels and their parameters
can be associated with pixels in an image.

Limitations of pixel maps include:

• 40 pixel maps per show file
• 12 layers per pixel map
• 16,384 pixels per pixel map grid

Open up the pixel map display via [Displays] > {More SK} > {Pixel Maps}. The display can also
be opened from the home screen, or by using [Tab] [9].

Note: Hovering your cursor above the pixel map will display the column and row
location for the pixel.

In the pixel map display, any numeric entry is assumed to be a pixel map. Each pixel map must
have a unique number.

To create a pixel map, type in the number you want to assign to it and hit [Enter].

Assigning Layers
The virtual media server and layer(s) need to be assigned to the pixel map.
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Using the softkeys, select {Server Chan}, {Media Layer Chan}, and {Effect Layer Chan}, and
associate them with the channels you want to patch. If those channels are unassigned, Eos will
automatically patch them accordingly. An error will appear if any channels are assigned to a
different device type.

If you prefer to assign Pixel Map layers in Patch first, profiles are available under {Type} >
{Manufctr} > {ETC Fixtures} > {Virtual}.

Note: No addresses need to be assigned in Patch for the pixel map layers.

In this display you can also label the pixel map, assign the interfaces it will use, and adjust the
width and height. Column and row guides can be created numerically in either the pixel map or
in the Edit displays. The guides can aid in viewing a pixel map.

Setting Pixel Map Features
After layers have been patched, press the {Edit} softkey to select the fixtures.

In the Edit screen, you will be able to define the array and types of fixtures. To do this, you can
select pixels from the map by using a touchscreen or by holding down the left button on a mouse
and dragging across the pixels you wish to select.

Once the pixels have been selected, you need to select their fixture type and then assign the
starting address or starting channel.

• When either {Starting Channel} or {Starting Address} is selected, both fields will be
cleared.

• Address-based pixels can not overlap with channel-based pixels. This includes the entire
DMX fixture footprint.

• If using {Starting Channel}, any overlapping channel-based pixels will be removed and
any overlapping address-based fixtures will be unpatched.

• If using {Starting Address}, any overlapping address-based pixels will be removed and any
overlapping channel-based fixtures will be unpatched.

• When the [Data] key is latched, the address for channel-based pixels will display.
• When [Format] is pressed, the address will toggle between port/offset and address

number.

By default, the addresses will be organized in rows starting from the left to the right and top to
bottom. The edit screen shows a representation of the current mapping. The pixels are color
coded based on if they have been patched or not. A color coding guide is provided on the
screen.

Note: Any pixel can have its size adjusted for better representation of the actual
fixtures. This is done by selecting the pixel and then dragging the vertical and / or
horizontal borders.

Note: A pixel map can be moved within the edit display by holding down the right
mouse button. The map can be zoomed either by using a mouse wheel or by holding
down [Format] and moving the level wheel.

Options available for changing the mapping:

• {Horizontal Order} - toggle state from left to right to right to left
• {Vertical Order} - toggle state from top to bottom to bottom to top
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• {Direction} - toggle state from rows to columns
• Click the {Apply} button to see the changes made while still in the edit display.

In the edit display, the softkeys will repaint to the following mapping options:

Note: To see the changes made by using the softkey mapping options, you don't
need to press {Apply}.

• {Rotate 90}
• {Flip V}
• {Flip H}
• {Invert}

The {Flash} button can be used to check the address output while still in the edit display. {Flash}
works the same as it does in Live.

When editing is finished, press the {Done} softkey to exit the edit display.

Working with the Virtual Media Server
Before you begin working with the Virtual Media Server, you will want to open the Pixel Map
Preview display from the home screen or by using [Tab] [1][0]. For manipulating the pixel maps,
you can use either the encoders or the ML Controls, which can be opened from the home
screen, by using [Tab] [5], or by using the quick access tools.

Note: For any output, the Server Channel must be set to a level along with any layers
you are using.

Note: You can use Park and Address Check for Virtual Media Server outputs.

Server Channel Controls
When working with the Server Channel, the following controls will be available:

• {Intensity}
• {Pan} and {Tilt} - used to adjust layers within the frame.
• {Color} - filters color for all layers.
• {FoView} - field of view, or perspective. This only affects media when {X Rotate} and/or {Y

Rotate} are not set to 0.
• {Crossfade} - used to adjust the priority when devices in the pixel map are also used as

console channels. -100 gives the pixel map priority, and +100 give the console channel
priority. At 0 (the default) the output is calculated using HTP. The Virtual Media Server
crossfade parameter level will display in subscript beside the intensity.

• {Blend} - a smoothing function for crossfades. It is a linear parameter that defaults to zero.
• {Inactive Media Behavior} - sets the layer behavior when intensity is at 0 to one of the

following options:
• Stop / Unload Layers - stops the media, and unloads it from memory
• Pause Layers - stops the media, but leaves it loaded in memory
• Let Layers Play - media continues playing with 0 intensity

• {Scale} - adjusts scale of all layers.
• {Aspect Ratio} - adjusts aspect ratio of all layers.
• {XYZ Rotation Controls} - rotation control for all layers
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Layer Channel Controls
When working with the Layer Channels, the following controls will be available:

• {Intensity}
• {Pan} and {Tilt} - used to adjust the image of the individual layer within the frame.
• {Color} - filters the color of the content. For example, if all the colors are set to full, the

content will play all colors normally. However if blue is at 0, then only the red and green
pixels of the content will play. The color and gel pickers can be used to select color
filtering quickly.

• {Negative On/Off} - with negative on, the output is the negative of the content. With it
off, the content plays back normally.

• {Image Brightness} - this varies from intensity. The following images illustrates the
differences between image brightness and intensity.

Note: All Virtual Media Layers operate in 16-bit color mode.

• {Playback Mode 1}:
• {Display Centered}
• {Display In Frame}
• {Display Out Frame}
• {Play Loop Forward}
• {Play Loop Reverse}
• {Play Once Forward}
• {Play Once Reverse}
• {Stop}

• {Playback Speed}
• {In Point} - determines where in the clip (frame number) you want to enter in.
• {Out Point} - determines where in the clip (frame number) you want to exit.
• {Mix Modes} - sets how the layers will interact. The following table shows the various

mixer modes available. To illustrate the modes, the following layers were used:
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Mode Description Result

{Over} (Default)
Top layer blended
with bottom layer

{In}

Top layer with
opacity reduced by
opacity of bottom
layer

{Out}

Top layer with
opacity reduced by
inverse opacity of
bottom layer

{Atop}

Top layer with
opacity reduced by
opacity of bottom
layer and then
blended with bottom
layer

{Add}

Top and bottom
layers color and
opacity added
together

{Subtract}

Top and bottom
layers color and
opacity subtracted
from each other
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Mode Description Result

{Multiply}

Top and bottom
layers color and
opacity multiplied
together

{Screen}

Top and bottom
layers colors inverted
and then multiplied
together

{Overlay}

Does a multiply or
screen effect based
on the lightness or
darkness of the
bottom layer

{Lighten}

Top layer’s color
merges with bottom
layer’s color, with
the lighter color
winning

{Darken}

Top layer’s color
merges with the
bottom layer’s color,
with the darker color
winning

{Dodge}
Bottom layer’s color
brightened to reflect
top layer’s color
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Mode Description Result

{Burn}
Bottom layer’s color
darkened to reflect
the top layer’s color

{Hard Light}

Does a multiply or
screen effect on the
lightness or darkness
of the top layer

{Soft Light}
Darkens or lightens
colors depending on
the top layer

{Xor}

Top layer with
opacity reduced by
inverse opacity of
bottom layer, and
then blended with
the bottom layer with
opacity reduced by
the inverse opacity of
the top layer

• {Library} - selects the image library.
• {File} - selects the media file within the selected library.
• {Mask On/Off} - masks takes a lower layer and a higher layer, finds only the non-

transparent pixels they have in common, and then displays the common pixels of the
higher layer.

• {FoView} - perspective. This only affects media when {X Rotate} and/or {Y Rotate} are not
set to 0.

• {Loop In} - sets the starting point of a gradient.
• {Loop Out} - sets the ending point of a gradient.
• {Scale} - changes the scale of the content to either be larger or smaller than the standard

content playback.
• {Aspect Ratio} - stretches or shrinks the content only along the X axis, making it wide or

squished looking. Z Rotate can be used to modify the aspect ratio along the Y axis.
• {XYZ Rotation Controls} - rotation control for all layers.
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Effect Layers
The Virtual Media Server allows you to use procedurally generated content. This is content that
is created algorithmically in real time, instead of rendering file based media.

In order to use procedurally generated content, you must patch the pixel map layer as a virtual
effect layer instead of a virtual media layer. Setting up the pixel map is the same as for using
virtual media layers. There are two versions of the effect layer, {Effect Layer Ver 1.0} and
{Effect Layer Ver 1.1}.

Types of Effects

There are three main effect types:

• Two color gradients - adjustable gradients with start and end colors
• Rainbow gradients - fixed gradient, full hue spectrum
• Perlin noise - good for animating random color effects, adjustable gradients

The effects are stored in file 1. File 1:0 is a home position of no effect. 1 through 3 are perlin
noise effects, 4 is a perlin noise/ rainbow gradient, 5 through 9 are rainbow gradients, and 10
through 19 are two color gradients.

Effects have various options of additional control.

Using Two Color Gradients
For the effects that use two color gradients (two color and perlin noise), there are several
options for control of the gradients. The two colors are known as the start and end colors. Those
options include:

• {Intensity} and {Intensity 2} - specifies the opacity of the start and end colors respectively
for Virtual Effect Layer 1.0. If you want to fade a two color effect using this layer, you will
need to fade both {Intensity} and {Intensity 2}.

• {Intensity 2} and {Intensity 3}- specifies the opacity of the start and end colors
respectively. {Intensity} is a master opacity control for the entire layer. This is for Virtual
Effect Layer 1.1. If you want to fade a two color effect using this layer, you can just fade
the {Intensity}.

• {Red}, {Green}, {Blue} or {Hue} and {Saturation} - specifies the start color. You can also
use the Start Color picker.

• {Red 2}, {Blue 2}, and {Green 2} - specifies the end color. You can also use the End Color
picker.

• {In Point 1} and {Out Point 1} - changes the distribution of the two colors in the gradient.
In Point 1 moves the start color position closer to the end color. Out Point 1 moves the end
color position closer to the start color.

• {Playback Mode 1} - basic animation, forward or reverse.
• {Playback Speed 1} - speed of animation.
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• {Layer Effect} - adjusts the number of repeats in the gradient. Layer Effect has a range of -
100% to 100%. At the home value of 0%, one full gradient is shown. Moving toward 0%,
you will see less of the gradient and moving toward 100%, you will see up to four
repetitions of the gradient.

Note: The button {Layer Effect 2} is for use with perlin noise effects.

Using Rainbow Gradients
For Rainbow Gradients, the colors cannot be adjusted. But the number of repeats can be
adjusted by using {Layer Effect}. {Playback Mode 1} and {Playback Speed 1} work in the same
way as for two color gradients.

Using Perlin Noise
For perlin noise effects, there are different options for control:

• {Playback Mode 1} - basic animation of noise, forward or reverse.
• {Playback Speed 1} - speed of animation.
• {Layer Effect} - adjusts the amount of noise. -100% equals very little noise, and 100%

equals a lot of noise.
• {Layer Effect 2} - adjusts the horizontal scrolling speed. -100% equals a fast left scroll, 0%

equals no scrolling, and 100% equals a fast right scroll.

Effects Color Pickers
The effect layers have a two color pickers for selecting the start and end colors.

Using the buttons located between the two color pickers, you can also copy the start color to the
end color, swap the start color and the end color, or copy the end color to the start color.

Pixel Mapping in a Multi-Console System
When using file based media in a multi-console environment, the primary console should be
used as the ‘base’ media archive.

Media can be imported to the primary, and the backup console and / or any other clients can
then synchronize their own, local media archives with the primary. The backup must
synchronize media with the primary in the event that the backup must take control as the
master. For clients, synchronizing the media is optional but useful if you wish to see the media
playing back in the Pixel Map Preview display.
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Steps for Configuring a Multi-Console System
Once the Eos Family Pixel Mapping Installer has been installed on all consoles, follow these
steps to configure your multi-console system:

Setting up the Primary

1. On the primary console, exit to the Eos Configuration Utility (ECU).
2. Press the {Settings} button.
3. Press {General} if needed.
4. Make sure that the {Share Media Archive} box is checked. This will allow for sharing of

the primary’s media archive. Copy the path name, you will need it to setup the backup
and / or client.

5. Setting up the Backup and Clients
6. On the backup or client, exit to the Eos Configuration Utility (ECU).
7. Press the {Settings} button.
8. Press {Maintenance}.
9. Press {Network Drives}.

10. In the Network Drives display, click the {Add} button.
11. In the Add Network Drive display, choose a drive letter for {Local Drive}.

12. Enter in the {Network Path}. The path name is listed next to the primary’s {Share Media
Archive} checkbox.
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13. Select the appropriate console type for the {Network Path Type}.

14. Click {Ok}. You will now be able to access the primary’s media archive from the backup or
client. This new drive will appear in the browser like a USB drive.

15. Click {Done} and launch the Eos application.

Synchronizing Media Archives
To view media playback in the Pixel Map Preview display, you will need to first import the
required media into your backup and / or client’s local media archive. This is done from the
browser. There are two options for importing media:

• Import Show Pixel Map Media - This import function should be used by the backups and
clients. It is the easiest way to ensure that your console will have all of the media required
by the current show file.

• Import All Pixel Map Media - This import function should be used by the primary to load
the base media content and later to load media on the fly as required. This import function
provides more complex options, like targeting which Library and File the media data will
be imported into. See Media Content (on page 482).

Steps for Synchronizing Show Pixel Map Media

1. On the backup or client, navigate to the browser.
2. Expand File>Import>Import Pixel Map Media>Import Show Pixel Map Media.

3. Select the appropriate network drive.
4. The Import Show Media display will open. Press the {Start Import} button.
5. A progress bar will appear to indicate the status of the import process. When finished,

click {Done}. You will now be able to see the media playing in the Pixel Map Preview
display on the backup and / or clients.
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About Partitioned Control
Partitioned control allows discrete control and programming of channels between multiple
programmers.

When multiple programmers are working on an Eos Family system, partitioned control can be
used to restrict a specific user’s access to certain channels. This can help avoid overlapping
control of channels by multiple programmers at once.

Channels can be included in more than one partition.

How to Use Partitions
The primary use of partitioned control is to allow more than one programmer to work on a show
file at the same time without the risk of one user storing data for another user’s partitioned
channels.

The most common example of this situation is when one user is programming automated
fixtures while another user programs conventional fixtures. Partitioned control allows these users
to divide the channels between them so they may work simultaneously. If one user stores data
using record or record only, partition control will guarantee that only data for their partitioned
channels will be stored. Data for channels not in their partition will be ignored when performing
any store commands.

Setting Up Partitioned Control
Partitioned Control is enabled or disabled in Setup>System>Partitions (see System Settings (on
page 168).) Partition defaults to “Disabled”. Enabling or disabling partitioned control is a
system-wide setting.

Partition List
To view the partition list display, press the {Partitions} button in Setup>System. This display lists
all existing partitions. There are four pre-programmed partitions in Eos, they are:

• Partition 0 - No channels and no fader control. This is the default for all users when
partitioned control is enabled for the first time on a show. To gain control, you must select
a different partition.

• Partition 901 - All channels. Allows the user access to all channels.
• Partition 902 - Single Parameter Channels. Allows the user access to only channels with a

single parameter.
• Partition 903 - Multiple Parameter Channels. Allows the user access to only channels with

multiple parameters.

To select a partition in the list, enter it in the command line.

• {Partition} [9][0][2] [Enter]

If partitioned control is enabled, this will now be your assigned partition.

Creating New Partitions
To create a new partition, press:

• {Partition} [x] [Enter] - where “x” is a number that does not yet exist in the partition list.

This will create a new partition, highlight it in the list, and (if partition is enabled) assign it as
your partition.

To assign channels to that partition, enter them in the command line:

• [1] [Thru] [9] [6] [Enter]
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You can also use [+], [-], and [Group] to further modify the channels in the partition. When
adding/ subtracting channels to a partition, if you do not use [+] or [-] before channel numbers,
the numbers will replace the channels in the partition, rather than adding to or subtracting from
them. This overwriting does require a confirmation (if enabled in setup).

Deleting Partitions
To delete any partition, simply type the syntax in the command line:

• [Delete] {Partition} [5] [Enter] [Enter] - deletes partition 5 from the list.

Preprogrammed partitions cannot be deleted.

Using Partitions
Partitions are set on a user level. See Assigning User ID (on page 503) for more information.

When partitions are enabled and a partition is selected, you may only control and record data
for the channels included in the partition, with the exception of parking and unparking channel
parameters or playing back cues. If you try to control a channel that is not in your partition, Eos
will post an advisory that this channel is outside of the partition, and you must confirm that you
want to control that channel. You will not, however, be able to store information for that
channel.

When you record a target (cue, preset, palette), only those channels that are partitioned to you
are recorded. Other programmers’ record actions to the same target can add to it (they do not
replace it) unless channels are shared. When shared, the last value provided at the point of the
record action will be stored.

Partitions in Playback
In Eos, how faders are configured and what is loaded to those faders is shared across all control
devices, with the exception of the master playback. As such, if the leftmost fader on page 1 is
configured as submaster 1, all devices will display and control submaster 1 on that fader.

When content is played back from any device, it will be recalled in its entirety. If you wish to
limit playback on cues, partitions can be assigned to cue lists. See Partitions on Cue Lists
(below) for more information. Additionally, filters can be placed directly on the playbacks to
restrict what is recalled on that fader. Filters are system wide.

Eos allows each user to assign different cue lists to their master fader pair. Using this feature,
programmers can work within their partitions, using the master fader pair for their specific cue
list, without affecting the cue list that is loaded to the master fader of another user.

Element 2 is limited to one cue list.

Partitions on Cue Lists
A partition may be assigned to a cue list. If a partition has already been applied to a cue list, any
channels not in the cue list's partition will not be included in cues when they stored or replayed.

Any data for a cue list that already existed before a partition is applied, will be maintained,
including data for channels not included in the partition. If data existed before the partition was
assigned, in blind, channels that are not in the partition will display without a channel graphic,
any levels will be in gray, and a small superscript N will display with it.

Assigned partitions will display at the top of the cue list index and in the PSD.

To assign a partition to a cue list:

• [Cue] [n] [/] {Partition} [n] [Enter]

To remove a partition from a cue list:
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• [Cue] [n] [/] {Partition} [Enter]

Flexichannel in Partitioned Control
When partitioning is enabled, a flexi mode, “Partitioned” is available as a softkey. When this is
enabled, the flexi mode is limited to only those channels defined in the current partition. This
mode may be further modified by use of the remaining flexi states. See Using Flexichannel (on
page 79) and Flexichannel Views in Patch (on page 127) for more information.



Multi-Console 499

Chapter 29
Multi-Console

About Multi-Console 500

Definition of terms 500

Multi-console Setup 500

Synchronized Backup 503

Mirror Mode 506



500 Eos Ti, Gio, Gio @5, Ion Xe, Ion Xe 20, and Element 2 Operations Manual

About Multi-Console
This chapter outlines the procedures required to use multiple Eos Family control devices
simultaneously on a network. It outlines the setup, configuration, and behavior that is entailed
in an Eos Family multi-console scenario.

Note: Only Intel-based Macs can connect as a client.

Multi-console functionality is also used to provide synchronized backup of your show while
running multiple devices on the network.

Definition of terms
Familiarize yourself with these terms prior to setting up a multi-console system.

Note: Eos Ti, Eos, Gio, Gio @ 5, Ion Xe, Element 2, Ion, and Element consoles, RVIs,
RPUs, ETCnomad Puck, or ETCnomad may all be considered active units on an Eos
Family network. For the sake of brevity, the term Eos is used to represent any /all of
these options in the following descriptions.

Note: Net3 RVIs can not be configured to be a primary or a backup.

• Primary - When an Eos is configured as a primary, other Eos devices can connect and
synchronize with it. If using a backup processor, the primary is the Eos that will be backed
up. By default, all Eos Family consoles will start up as a primary. Should a primary fail and
a backup takes control, then the backup will be acting as the primary.

• Backup - The Eos capable of taking control of the system if the primary fails. You may
input data and run your show from a backup. There can only be one backup in an Eos
network and you must specify which primary it is backing up.

• Client - Any online Eos that is not the primary or backup is a client. Client data is sent and
received over the network, and clients will synchronize with a designated primary.

• Offline - Any Eos controller that is disconnected from the Eos network. Changes to show
data performed on an offline Eos will not affect the rest of the Eos network or the lighting
system.

• Tracking - Any device that is synchronized with a primary is tracking. Once a backup
takes control it becomes a primary and is no longer tracking.

• User - A user is an Eos defined by a user ID. If it has a unique user ID, the Eos will operate
separate from other Eos devices on the network, but still track show data. If it shares a
user ID, Eos will synchronize with like IDs. See About User ID (on page 502)

• System - One primary Eos, one backup Eos, and (if available) multiple clients
synchronized together.

• Mirror Mode - A mode for mirroring the displays of another device. See Mirror Mode (on
page 506)

Multi-console Setup
When using multiple Eos devices on the network, you should adjust some of the settings to
ensure optimal functionality.

Additional requirements for multi-console setup include:

• Software versions must match exactly between all devices.
• All devices have to use the same fixture library. See Update Profile (on page 152).



Multi-Console 501

• The language settings in the ECU must match. See Language (on page 513)
• The keyboard language setting in the ECU must match. See Keyboard (on page 513)

Note: It is recommended that you perform the following setting changes before
connecting your device(s) to the network. After the changes are complete, connect to
the network and reboot the device.

Designate Primary
By default, all Eos devices will boot as a primary. When using multiple Eos devices on the
network, only one should be designated as a primary. Other Eos devices should be configured as
the backup (only one per system) or clients.

To change this setting, you must exit the Eos software (Browser>Exit) and then designate the
Eos device as primary, backup, or client in the ECU Welcome Screen (see Welcome Screen (on
page 510)).

DHCP Server
DHCP server supplies IP addresses to network devices. Only one Eos device (typically the
Primary) on the network is necessary to do this properly. Therefore you should disable the DHCP
server on all Eos devices except for the intended primary.

To disable the DHCP server on your Eos device, go to ECU > Settings > Network > DHCP
Service. See Local Area Connection (on page 519) for more information.

Change Device Name
To easily identify your Eos on the network, change the device name to be representative of the
device (such as “Booth Primary” or “Tech Backup”). This is done in ECU > Settings > General.
See General Settings (on page 512) for more information.

Backup Auto Switch
Switches to the backup automatically if the primary should go offline. This is enabled in ECU >
Settings > Network > Output Protocols. See Backup Automatically Takes Control (on
page 523) for more information.

Backup at Higher Priority
This enables the backup device in a multi-console system to take over at one priority higher than
the master if the master goes offline. This is enabled in ECU > Settings > Network > Output
Protocols. See Backup Takes Over At Higher Priority (on page 523) for more information.

Network Type
This setting adjusts the timeout period before a backup device will take control from the master.
This is done in ECU > Settings > Network > Interface Protocols. See Network Type (on
page 523) for more information.

• Standard - After five seconds of no response from the master, the backup will assume the
master has disconnected and will then take control.

• Engineered - After 1.6 seconds of no response from the master, the backup will assume
the master has disconnected and will then take control.
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Change IP Address
Each Eos device on the network should be given a unique IP address. If running multiple devices
of the same type (for example - two consoles, or two RPUs), you must alter the default static IP
addresses to ensure proper functionality. For a list of the default IP addresses for Eos devices,
see IP Address (on page 519)

Changing the static IP address is done through the ECU (see Network Settings (on page 518) ).
Manually change the IP address of any non-master Eos device by clicking in the IP Address field
and entering the new number from the keyboard. When done, press [Enter].

Note: It is recommended that you alter the very last digit of the static IP address by an
increment of one for each additional Eos device on the network. Therefore, if the
master ends in “101”, change the backup to end is “102”, a client to end in “103” and
so on.

Output in Client Mode
Consoles in client or backup mode by default will not output on their local DMX ports. This
option is found in Setup > System > Output. Click on {Output in Client mode} to enable the
ability to output.

Multiple Users
Eos Family consoles can be set to act as a separate user from other consoles in the system, or it
can be set to act as the same user as another console. This is done by changing the user ID.

Element 2 can be set to act as a separate user from other Element 2 consoles, RVIs, ETCnomad,
and ETCnomad Pucks in the system, or it can be set to act as the same user as another Element
2, RVI, ETCnomad, or ETCnomad Puck. This is done by changing the user ID.

About User ID
When multiple users are on the Eos Family network, they can all act as one combined user, as
all separate users, or any of the varying degrees between.

Any Eos, Eos Ti, Gio, Gio @ 5, Ion Xe, and Ion console, RPU,RVI, ETCnomad, and ETCnomad
Puck can be a separate user on the Eos Family network. Certain devices work well as
independent users while others are intended to share a user ID with another device. For
example, consoles and RPUs are likely candidates for working with a unique user ID while RVIs
and client PCs can be useful sharing an ID with another device to track programming
information from a second location.

Note: Element 2 can be set to act as a separate user from other Element 2 consoles,
RVIs, ETCnomad, and ETCnomad Pucks in the system, or it can be set to act as the
same user as another Element 2, RVI, ETCnomad, or ETCnomad Puck.

Set in the Setup (see Users (on page 176)), User ID is an Eos-specific identifier that can be set
uniquely for each Eos device or can be shared between multiple devices allowing for certain
data to be shared between consoles. The user ID can be set anywhere from 1 to 99.

The decision to share a user ID is based on the desire to share a common work environment and
command line. It is often common for a designer to be the same user as a programmer so his
displays and operating modes follow a programmer, and his command line mimics the
programmer's. Alternatively, mirror mode of a user can be called. It is also possible to set the
designer up as a completely separate user, adding a command line object to a magic sheet to
allow a view into programming activities.
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Devices sharing User IDs will share certain data, while those with different IDs will not. Below
are the differences in multi-console data depending on User ID.

Data shared between Eos Family devices with the same User ID
• command line
• null channels in live
• selected channels
• filters
• selected cue
• live/ blind mode
• Setup>User

Data specific to the Eos Family device, regardless of User ID
• current fader page
• current encoder page
• focus on displays without command line
• display configuration (layout, format, visible parameters, flexichannel)
• paging without changing selected target or channels

Data identical between all Eos Family devices, regardless of User ID
• all stage levels and edits
• all data stored in the show file
• playback, fader and grandmaster contents and progress

The default User ID for any Eos Family device is 1. You may change this based on your
preference to allow/ restrict the functionality described above.

Note: After you have completed the setting changes described above, connect your Eos
device to the network and reboot the device.

Assigning User ID
User ID can be defined in Setup>System>Users, see Users (on page 176) for more information.

To quickly change the User ID, you can click on the User ID displayed above the CIA. A pop-up
window will open with the available User ID options.

When multiple programmers are working on the system, partitioned control can be used to
restrict a specific user’s access to certain channels. This can help avoid overlapping control of
channels by multiple programmers at once.

For more information on partitioned control, see Using Partitions (on page 497)

About Multi-console Backup
Within an Eos system, you have the added bonus of show data backup. The backup on the
system will receive all show data updates and stage levels so that, in the event of a primary
failure, the backup will be capable of taking control of the system without a loss of show data or
live output. Saving occurs across the whole network.

Synchronized Backup
Once you have changed settings to facilitate a multi-console system on the network, you may
activate synchronized backup to ensure show data security.

Eos synchronized backup is designed so that during normal operation the primary device controls
the lighting system, and any device configured as backup or client synchronize with the primary.
The following activities will synchronize between consoles when operating in a backup system:
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• Playback
• Record operations
• Manually set data
• Show file and data

Setting Up Synchronized Backup
Before backup is possible, you must have at least two non-RVI Eos devices connected to the
network. One must be assigned as primary and one as a backup.

To assign a backup to a primary:

1. Exit the Eos environment (Browser> Exit Eos) on the console you wish to act as the
backup. This will send you to the ECU welcome screen.

2. Touch or click on the {Backup} button in the welcome screen. The console will then
startup the Eos software, this time in backup mode. Eos will try to connect to a primary
console. The CIA will say “Waiting for Master. One moment please...”.

3. If the backup doesn’t connect after a few moments, press the {Troubleshoot} touchbutton
in the CIA. This will open the network configure screen in the CIA.

Note: If this is the first time that a backup is connecting to this master,
you will need to press {Troubleshoot} and select the master.

4. Select a primary console from the list on the right. If no masters are available in the list, a
primary console is not connected to the network.

5. Press {Change Master}. The backup Eos will synchronize with the master.

You will see the console's current status above the softkeys display.

If the primary goes offline for any reason, the backup will automatically takeover as the master
if backup auto switch has been enabled, see Backup Automatically Takes Control (on
page 523). Whenever master control changes between the primary and the backup, there will
be a dialog window that will be displayed that must be dismissed by the user.

When master control moves between the primary and backup device, any clients in the system
will automatically connect to the current master. Clients will also display a message, but the
message will be dismissed after a short period of time. The device status above the CIA icons
will also change.

Note: A backup may take up to 5 seconds to determine that connection with the
master has been lost. This timing can be adjusted based on network type selected in
the ECU. See Network Type (on page 501) for more information.

If you enter the Network>Configure screen, it will have changed to show that your backup is
now acting as the master and is controlling the lighting system.

Note: If the primary comes back online, it will not retake control of the lighting
system. The primary will wait until it is re-designated as the master and the backup is
reassigned to it. You can force the backup to release control back to the primary by
going to Browser>Network>Configuration and pressing the {Release Control} button.
You can also force the primary to take control away from a backup by going to
Browser>Network>Configuration and pressing the {Take Control} button.
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Backup Scenarios

Console and console
Two consoles can be used to provide backup. Either can be configured as the primary or the
backup. If the primary console fails, the second console will take control with full show data
intact.

This is a useful scenario for touring multi-user applications.

RPU and console
One RPU and one console can be used as a backup option. In this configuration, it is
recommended that you set the RPU as the primary and the console as the backup. In this
scenario, should the RPU go offline, you will still have the full functionality of the console user-
interface at your disposal.

RPU and RPU
Two RPUs may serve as primary and backup also. A backup system of this type can support
many client consoles at once, which you may turn on and off as needed without the need to
reset to a different master each time.

This application is ideal for permanent installations requiring synchronized backup.

Remote Software Installation
Within a multi-console system, you can remotely install software to all devices.

Note: All devices must be upgraded to version 1.9 before remote software
installation is available.

In the ECU, go to Setting> General> Automatically Update Software to enable. Once enabled,
the devices can be remotely updated with the next version of software. Devices will receive the
software update from the Primary. When you install software on the Primary, the software will
first be copied to its hard drive.

With the devices synchronized with the Primary, install the new version of software onto the
Primary. All devices will lose their connection with the Primary at that time. When the Primary
comes back online after installing the software, all the connected devices will be forced to
update their software before they can reconnect with the Primary.

Remote Power On/Off
In a multi-console system, it is possible to power on and off devices remotely. Remote Power On
and Remote Power Off must be enabled on each device before it can receive the power on and
off commands. In the ECU go to Settings> Network> Enable Remote Power Off and Enable
Remote Power On. The default setting for both is “Disabled”.

Note: Original Eos consoles cannot be remotely powered on.

The Remote Power commands are sent from the browser. The command for Power On is sent
from Browser> Network> Power On MultiConsole System, and the command for Power Off is
from Browser> Network> Power Off MultiConsole System.
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Note: Only devices that synchronize with the Primary will be available for Remote
Power On and Off.

Mirror Mode
Mirror Mode is used to mirror the displays of another device. When a device is in mirror mode,
the only action allowed from that device is paging via the page keys and shut down/start up.
When a device in mirror mode pages, it also pages the host.

Mirror mode is intended primarily to allow a designer or assistant to see the exact same displays
as a programmer on the system. It can be used on any device on the network, including the
primary processor. Any device being mirrored is referred to as the Host.

The is no limit to the number of mirrored devices a host can have. But a console currently in
mirror mode cannot be mirrored.

A device that is currently in mirror mode can select which user number it is mirroring by using
the alphanumeric keyboard shortcut ALT +F1. ALT + F2 can be used to leave mirror mode.

Note: If a device is not currently in mirror mode, pressing M on an alphanumeric
keyboard will post Macro to the command line.

Using Mirror Mode on a Client without a Dongle
A client without a dongle can connect to the network. When this is done, the client can only
operate in mirror mode, and it will always connect to the primary processor. No other options
will be available.

Configuring Mirror Mode
Configuring a device to connect in Mirror mode is done from the Displays menu in the Browser.
When [Displays] is pressed, a {Mirror} softkey will be displayed. Pressing {Mirror} will open up a
list of potential hosts in the CIA.

The mirror display can be navigated using the arrow keys or a mouse. When the required host is
highlighted, press [Enter] or double click with a mouse to confirm the selection. This display can
also be opened with the keyboard shortcut of ALT + F1.

Note: While in Mirror mode, the display will also have options for exiting and
powering off the device.

Mirror Mode Displays
When a device is placed in mirror mode, monitor 1 on the mirroring device matches external
monitor 1 on the host, and monitor 2 matches external monitor 2 on the host. A client will mirror
as many monitors as it has available.

All formats used on the host device are shown on the mirroring device including flexichannel
states, column widths, chosen parameters, and pages.

Note: Desk settings are not mirrored.
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The CIA will open on monitor 1. The CIA on the device in mirror mode can be locked open or
closed. When left unlocked, the CIA will expand and close as normal. Not all CIA displays
shown on the device in mirror mode. The following CIA displays are synchronized:

• About
• Effects
• Effects Status
• Color Picker
• Curves
• Undo

The CIA can be completely hidden when locked by pressing the [Displays] key. Pressing
[Displays] again will display and unlock the CIA.

Exiting Mirror Mode
Exiting mirror mode can be done by selecting {Stop Mirroring} in the mirror display or using the
keyboard shortcut ALT + F2. When exiting mirror mode, the device will return to its normal,
working state.

Note: Clients without a dongle cannot exit mirror mode.

Shutdown/Start Up in Mirror Mode
When a device is shut down in mirror mode, it will restart in mirror mode mirroring the same
host as before. If the host has changed settings, mirror mode will need to be reselected on
startup.

Macros
Macros can be created to configure a device for mirror mode and to exit the mode.

The face panel button configuration in the ECU allows the face panel buttons on Eos Ti, Gio,
Gio @5, RPU, and RVI to be populated with these macros.

Note: An alphanumeric keyboard will be needed to create this macro.

To create a macro to place a device in mirror mode:

1. Set the User ID of all devices to match the Primary.
2. Press ALT + F1 to open the mirror mode display.
3. Highlight the device to mirror.
4. Press [Learn] [x] [Enter] to record the macro.

To create a macro to exit mirror mode:

1. With the console in mirror mode, press [Learn] [x] [Enter]
2. Press ALT + F2.
3. Press [Learn] to finish recording the macro.

Once the macros are created, you should save the show and set all User IDs back.
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About the Eos Configuration Utility
This section covers the Eos Configuration Utility (ECU) and its uses for both system configuration
and performing basic level test functions. This section illustrates how to use the utility, but does
not specify what changes to make as these are based on your preferences and can be changed
to suit your control needs.

Eos Configuration Utility Reference
You can force the console to boot into the utility instead of the main console application. During
the boot process, a countdown timer will appear. You will have 5 seconds to click the timer or to
hold down “e”, “o” and “s” at the same time on the connected alphanumeric keyboard.

Otherwise, you can enter the ECU from the Eos application by choosing Browser > Exit.

If you want the console to always boot into the utility, make sure {Open in Shell E.C.U} is
checked. See Open in Shell E.C.U (on page 513).

Welcome Screen

This is the starting screen of the utility. From here you can choose to boot the console in one of
several different modes, change various settings, or shutdown the console.

Primary
Starts the console in Primary mode.

Backup
Assigns the console as a backup to a console in Primary mode. Consoles in this mode will not
have control of the lighting system unless the Primary goes offline.

Client
Assigns the console as a client to a console in Primary mode.
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Settings
Opens the ECU Settings.

Offline
Puts the console in Offline mode. Consoles in this mode cannot connect with other devices on
the same network.

Shutdown
Powers the console down following a confirmation.

Primary
This is the mode for using a single console in non-networked or networked applications. On a
system with multiple consoles, the primary is the console that client and backup consoles
synchronize with, making it the source of all information a client or backup console sees on the
network.

Primary mode can be run on Eos Ti, Eos, Gio, Gio @ 5, Ion, Ion Xe, Element 2, Element,
ETCnomad Puck, ETCnomad with dongle, and RPUs (Remote Processor Unit).

Backup
Backup mode requires a primary device be online to synchronize. Once this is done, a backup
console intakes all show data for use in the event that it needs to assume control of the lighting
system.

The main difference between backup and client modes is what happens in the event of primary
processor failure. If the primary fails, a backup will ask if you want it to take control as the
master of the system or if you want to troubleshoot the problem. You can set the backup to
automatically take control. (Backup Automatically Takes Control (on page 523)) When the
primary remains in control, the backup will behave as a client would.

Backup mode can be run on Eos Ti, Eos, Gio, Gio @ 5, Ion, Ion Xe, Element 2, Element,
ETCnomad Puck, and RPUs. For more information on backup systems, see Multi-Console (on
page 499)

Client
A device set to client mode can act as a remote controller or remote video station for a system.
A client device cannot output to the lighting system. Only a primary or backup processor can do
this.

User ID determines some interaction between the client and other devices. If the client and the
primary console have the same User ID, they will act as one. If they have different User IDs, they
will have separate command lines. See About User ID (on page 502)

Client mode can be run on Eos Ti, Eos, Gio, Gio @ 5, Ion, Ion Xe, Element 2, Element,
ETCnomad Puck, and ETCnomad with a dongle. Without a dongle, a client can connect in
mirror mode. See Mirror Mode (on page 506)

Consoles in client or backup mode by default will not output on their local DMX ports. This
option is found at Setup > System > Outputs. Click on {Output in Client Mode} to enable the
ability to output.

CAUTION: ETC does not recommend the use of wireless for show critical
functions.
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Offline
Offline mode puts the software in a state where there is no network activity, no control, no
connections with other consoles or any other network devices.

This mode is primarily intended for offline editing of a show file.

Offline mode can be run on Eos Ti, Eos, Gio, Gio @ 5, Ion, Ion Xe, Element 2, Element,
ETCnomad Puck, and ETCnomad.

Offline w/ viz mode is available when running ETCnomad software without a dongle. This mode
is only intended to be used with visualizer software, and does not output DMX.

General Settings
The following options are available in this display :

• Device Name (below)
• 24 Hour Format Clock (below)
• Time (below)
• Date (on the facing page)
• Time Zone (on the facing page)
• Language (on the facing page)
• Keyboard (on the facing page)
• Use Shift As Eos Shift (on the facing page)
• Open in Shell E.C.U (on the facing page)
• Automatically Update Software (on the facing page)
• Fullscreen ETCnomad (on the facing page) (ETCnomad only)
• High DPI Display Scaling (on page 514)
• Show Archive Path (on page 514)
• Media Archive Path (on page 514)
• Share Show Archive (on page 515)
• Share Media Archive (on page 515)
• Latitude (on page 515)
• Longitude (on page 515)
• Calibrate Elo Touchscreens (on page 515)
• Calibrate ETC Touchscreens (on page 515)
• Monitor Arrangement (on page 516)
• Software Update (on page 517)

Device Name
This specifies the name the console will use to identify itself on the network to other devices.
Examples might be Booth Desk and Tech Table.

24 Hour Format Clock
The time is displayed in a 24-hour format as HH : MM : SS. By default this is disabled. Click to
enable.

Time
The time the console is using. This can be changed manually (direct data-entry) or via SNTP
(Simple Network Time Protocol) time service. see Network Settings (on page 518) for more
information.
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The time defaults to 12 hour format. To use 24 hour format, make sure {24 Hour Clock} is
checked. See 24 Hour Format Clock (on the previous page).

Date
The date the console is using. This can be changed manually (direct data-entry) or via SNTP
(Simple Network Time Protocol) time service. see Time Service (SNTP) (on page 525) for more
information.

The date is displayed as DD / MM / YYYY.

Time Zone
The time zone the console is using. This is an offset from Greenwich Mean Time (GMT). Each
setting in the pull-down list displays the offset, the name of the time zone and a couple of cities
in that time zone.

Language
Allows you to select the display language of Eos. Choices include English, Catalan, Bulgarian,
German, Spanish, French, Italian, Slovak, Turkish, Japanese, Korean, Russian, Chinese -
simplified, and Chinese - traditional.

Keyboard
Allows you to select the language for the alphanumeric keyboard within Eos. A wide variety of
keyboards are supported.

The keyboard can also be changed in the application when the virtual keyboard is open. Click
on the flag icon to see a language drop-down menu.

Press {Sym} to switch the keyboard from alphanumeric to symbols. When in symbol mode, press
{Abc} to return to the alphanumeric keyboard.

Use Shift As Eos Shift
Allows the SHIFT key on an alphanumeric keyboard to be used as the console's [Shift] key. If
not selected, the Z key on an alphanumeric keyboard will function as the [Shift] key.

Open in Shell E.C.U
When this is checked, the console will boot into the Configuration Utility every time instead of
booting directly into the main application.

Automatically Update Software
When this is checked, the console will receive software updates from the primary if used in a
multi-console system.

Fullscreen ETCnomad
ETCnomad has an additional ECU setting for Fullscreen ETCnomad mode (enabled by default).
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When the"Fullscreen ETCnomad" box is checked, ETCnomad will automatically launch
fullscreen, on all connected monitors of your computer. Select "1" in the "Windows Per
Fullscreen Display" dropdown to show a single fullscreen ETCnomad display on each monitor, or
"2" to subdivide each fullscreen display into 2 ETCnomad windows.

When Fullscreen ETCnomad mode is disabled, ETCnomad will launch in a standard windowed
display. The "ETCnomad Windows" dropdown allows you to choose to open up to 6 separate
windows.

High DPI Display Scaling
When using a High DPI 4k display, you can set the display scaling to make small text more
legible.

The following options are available:

• Default Resolution - the software will be scaled up to appear larger on high DPI displays -
depends on monitor and Windows support for auto-detecting such displays. This is the
default setting.

• High Resolution - keeps the software at its native sizes and scaling, which will appear to
be very small on High DPI displays.

Show Archive Path
This is the default location to save show files. The full path must be typed in and specified in a
legal Windows format. The default location is a folder on the D: drive.

If you decide to change this setting, it is recommended that you keep this location on the D:
drive.

Media Archive Path
This is the default location to save media files. The full path must be typed in and specified in a
legal Windows format. The default location is a folder on the D: drive.

If you decide to change this setting, it is recommended that you keep this location on the D:
drive.
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Share Show Archive
Checking this box will enable you to share the show archive folder on the console with another
console or computer via Windows File Sharing (SMB).

Share Media Archive
Checking this box will enable you to share the media archive folder on the console with another
console via Windows File Sharing (SMB).

Latitude
Allows you to select the latitude the console is using.

Longitude
Allows you to select the longitude the console is using.

Calibrate Touchscreens
This will launch a screen calibration utility to guide you through the process of re-calibrating the
touchscreens. This should be used if the pointer is consistently offset from where you are
touching the screens. You can choose to calibrate the on-board left, right, and small
touchscreens.

Each screen is calibrated independently.

Calibrate Elo Touchscreens

Note: Before you calibrate your external touchscreens, you may need to first use the
External Monitor Arrangement display. See Monitor Arrangement (on the next page)

Allows you to calibrate an Elo touchscreen. With the touchscreen connected, press the
{Calibrate Elo External Touchscreen}.

The first display will have you touch some targets, and the second will have you touch various
parts of the display to make sure the cursor follows your finger. If that works fine, press the
green checkbox. If you need to return to the previous display, press the blue arrow button.

Calibrate ETC Touchscreens

Note: Before you calibrate your external touchscreens, you may need to first use the
External Monitor Arrangement display. See Monitor Arrangement (on the next page)

Allows you to calibrate an ETC touchscreen. With the touchscreen connected, press the
{Calibrate ETC External Touchscreen}.

The first display will have you touch various parts of the display to make sure the cursor follows
your finger and the second will have you touch some targets.
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Monitor Arrangement

Note: The selected monitor will display in yellow. External monitors can be dragged
to any of the surrounding black boxes to mimic actual monitor layout. Internal monitors
are locked in relationship to each other and cannot be changed.

The Monitor Arrangement Tool will dictate how and where the pointer moves from one
screen/monitor to another. Generally speaking, you will want the logical placement on this
screen to match your physical placement.

Buttons available in the External Monitor Arrangement display are:

• {Calibrate} - see Calibrate Touchscreens (on the previous page).
• {Reset Calibration} - restores default calibration data for selected display.
• {Identify} - displays the video ports that your monitors are connected to on the physical

monitors to confirm where you have placed them.
• {Enabled} - When checked, the monitor is available for use. The console will display the

{Enabled} box checked for any monitors it recognizes.
• {Primary} - selects which monitor will display the Eos Configuration Utility and Central

Information Area (CIA). On Eos, the primary is locked to the right touchscreen on the
console.

• {Resolution} - sets how many pixels the monitor will display.
• {Color Depth} - sets how many colors will be displayed.
• {Refresh Rate} - sets the number of times in a second the monitor refreshes.
• {Orientation} - sets the monitor layout.
• {Apply} - will save and use your settings. A window will open asking if you want to {Keep

Changes} or {Revert} back to the defaults. {Revert} will be selected within 15 seconds if
nothing else has been selected first.

• {Close} - will close the display. {Close} will not save any settings if {Apply} has not been
used.

• {Configure Touchscreens} - is used to map the touchscreens to the displays.
• {Elo Monitor Settings} - opens the properties window for the monitor. See Calibrate Elo

Touchscreens (on the previous page).
• {ETC Monitor Settings} - opens the properties window for the monitor. See Calibrate ETC

Touchscreens (on the previous page)
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Note: Only supported options will display. Monitor options may vary. While it is
possible to assign a resolution lower than the minimum (1280x1024), it is
recommended to be at 1280x1024 or higher.

Note: The settings for the on-board monitors are read only.

Software Update
Software Update allows the installation of Eos Family Software and other ETC-approved
software (GCE and NCE). Updating Eos Family Software does not affect or update the software
in any other networked device such as a Net3 Gateway.

When you click on {Software Update}, the console looks at the root directory of any connected
USB drive for an Eos Family console software update file. You will be shown the names of any
updater files found on the drive. Select the file you would like to install and click the {Install}
button, or click {Cancel}. The software will first save to the hard drive before opening the
installer.

You will also receive a message if no software update file can be found.

Installer Archive
Eos has an installer archive, which saves selected installers directly onto the console's local hard
drive. You can save multiple software versions onto your console's hard drive in case you wish to
downgrade.

While installing the software, you can archive the installer used. Check the Archive Installer box
for the selected version, and it will archive while installing the software. If you would like to
archive installers without installing their software, you can do that by using the File Manager
utility in ECU > Settings > Maintenance.

You can also retrieve these versions from the archive to save them to a USB drive by using the
File Manager.

Note: On new consoles, some versions are preselected to be archived when it initially
ships from ETC. This includes the version of software that is currently installed from the
factory as well as any patches to that version (if available). For future release, you will
need to download the Eos Family software from the ETC website, etcconnect.com.

http://www.etcconnect.com/
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Fixture Library Updates
{Software Update} also recognizes .zip files provided by ETC, which contain fixture library files.

Fixture library update files are distributed as a .zip file, which can be installed on Eos Family
consoles, ETCnomad PC, and ETCnomad Mac devices.

Updating with a .zip file
1. Select the desired .zip file from the Software Update window.
2. You will be asked to confirm that you want to install the selected file. Click {Yes} to

continue or click {No} or {Cancel} to return to the Software Update window.
3. A window will open showing the progress of extracting the .zip file. The installer will then

launch after the file has been extracted.

Switch Software Versions
Eos v3.0.0 introduced the ability to switch between v2.9.X and v3.0.0 and later. If v2.9.X is
already installed, installing v3.0.0 or later automatically retains the previous version of software.

Use the "Switch to" button to alternate between versions. A restart will be required before any
changes can take effect.

Note: If a console is updated to v3.0.0 or later from a version prior to v2.9.X, you will
be able to revert from v3.0.0 or later to the prior version. However, you will be unable
to return to v3.0.0 or later without first updating to v2.9.X.

Network Settings
The following options are available in this display :

• Local Area Connection
• Enable Remote Startup/ Shutdown
• Network Interface Delay
• Ping
• Output Protocols
• Interface Protocols
• DHCP Service
• Update Service (TFTP)
• Time Service (SNTP)
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Local Area Connection
These are the settings that determine the method to get an IP address and / or the actual IP
address information that Eos uses for network communication.

Note: The number of ports varies depending on how many Network Interface
Controllers (NICs) your console has. For more information, refer to the Console
Overview (on page 11) chapter.

Status
This reports if the port is “Online” (configured, connected to a network and operational). It
reports as “Offline” if any one of the above conditions is not true.

Obtain an IP Automatically

Note: ETC recommends the use of a static IP address for compatibility with other ETC
devices, though the needs of your particular installation may vary.

Clicking in the enable box will set the console to get its IP address dynamically from a DHCP
server. While the console is starting, it will ask for an IP address from a DHCP server. If one
responds, it will use the assigned IP address.

If no DHCP server is available, the console will default to a self-generated link-local IP address in
the range of 169.254.x.y. The IP address used by the console in this configuration may change
dynamically as needed. A change should typically only occur when there are changes to the
network configuration or to resolve an IP address conflict.

Enabling or disabling the DHCP setting will require you to reboot the console for the new setting
to take affect.

Note: You cannot set the console to receive an IP address via DHCP and act as a
DHCP server at the same time. It can either send dynamic addresses or receive them,
but not both at the same time.

IP Address
If DHCP is disabled, you set the IP address here. This is a static IP address and will remain set
until changed by a user.

The following is a list of the default IP addresses:

Console Port 1 Port 2
Eos 10.101.90.101 NA
Eos RPU 10.101.95.101 NA
RVI 10.101.85.101 NA
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Console Port 1 Port 2
Eos Ti 10.101.92.101 192.168.92.101
Gio 10.101.91.101 192.168.91.101
Gio @ 5 10.101.98.101 192.168.98.101
RPU3 10.101.93.101 192.168.93.101
RVI3 10.101.86.101 192.168.86.101
Ion 10.101.100.101 NA
Ion Xe 10.101.100.20 192.168.100.20
Ion Xe 20 10.101.100.30 192.168.100.30
Ion Xe RPU 10.101.96.201 192.168.96.201
Element 10.101.97.101 NA
Element 2 10.101.99.101 192.168.99.101

If DHCP is enabled, this field will display the IP address that is being used by the console
(whether it is served via DHCP or a self-generated link-local IP address).

Subnet Mask
If DHCP is disabled, you set the subnet mask here. This is a static setting and will remain set
until changed by a user. The default subnet mask is 255.255.0.0.

If DHCP is enabled, this field will display the subnet mask that is being used by the console
(whether it is served via DHCP or a self-generated link-local IP address).

Gateway
If DHCP is disabled, you set the gateway IP address here. This is a static gateway IP address and
will remain set until changed by a user.

Eos consoles controlling a Net2 system should use the IP address as the default gateway. All
other consoles should default to 10.101.1.1.

If DHCP is enabled, this field will display the gateway IP address that is being used by the
console (whether it is served via DHCP or a self-generated link-local IP address).

Physical Address
The physical address is the MAC address. This address is a unique identifier and cannot be
modified.

Network Interface Delay
When {Required} is enabled, the console will wait for the network connection to be fully
initialized before launching the Eos application.

Note: This option is not available on ETCnomad.
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When enabled, a launching window will display on start-up. If a network connection is not
made, you will have the option to {Start Anyway}, {Start Offline}, or to {Cancel}.

• {Start Anyway} - launches without a network interface. Only User 1 is displayed above the
CIA.

• {Start Offline} - starts in offline mode.
• {Cancel} - remains in start-up without launching into the Eos application.

Disable All ETC Protocols

Using this button will disable all currently-enabled output, interface, DHCP, and SNTP protocols
for the selected network port.

Enable Remote Startup/ Shutdown
It is possible to remotely power on and off some devices, such as RVIs, RPUs, and client
consoles.

{Remote Startup} and {Remote Shutdown} must be enabled on each device before it can
receive the power on and off commands. The default setting for both is Disabled.

The Remote Power commands are sent from the browser. The command for Power On is sent
from Browser>Network>Power On MultiConsole System, and the command for Power Off is
from Browser>Network>Power Off MultiConsole System.

Note: Only devices that synchronize with the Primary will be available for Remote
Power On and Off.

Ping
Ping is used to test the network connection between two devices.
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1. Click the empty box on the left, and enter the IP address of the device you want to ping.
2. Press Start. You will either see replies from the device, or "response timed out," indicating

the device is not responding to the ping.

Output Protocols
This is for selecting which protocols the console will output and which ones are included in the
default.

Note: sACN can be output on both ports. All other output protocols can only be
output on a single NIC.

sACN
This sets the control priority and the starting address for sACN data from your console. The valid
range for this setting is 1 (lowest) to 200 (highest). This is the reverse of EDMX.

Eos allows you to use any sACN universes from 1-63,999.The address range equals 1 to
32,767,488, which is 63,999 times 512.

Eos and the Net3 Gateways support two versions of sACN, the draft version and the final ratified
version. The ratified version is outputted by default unless this is selected.

Net2-EDMX
This sets the control priority for EDMX data from this console. The valid range for this setting is
20 (lowest) to 1 (highest). This is the reverse of sACN.

Note: ETCnomad software does not support Net2.

AVAB UDP
This sets the subnet for AVAB UDP data from this console. The priority levels range from 0-200.
The default is 0, which is no priority level. 1 is the lowest priority level and 200 is the highest.
When set to no priority level (0), the data will merge according to HTP.

A backup console will receive its AVAB UDP priority level from the primary. The backup will
then output at one priority higher than the primary, unless the primary was set to the highest
priority of 200.
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Note: ETCnomad software does not support AVAB UDP.

ArtNet
This sets the subnet for ArtNet data from this console. The valid ArtNet Start range for this
setting is 0-255.

Broadcast Type
• Directed Broadcast - Broadcast packets are directed to a subnet based on the IP address

and subnet mask of the sender.
• Limited Broadcast - The limited broadcast address is 255.255.255.255. It is limited

because routers will never forward datagrams with that destination address. This means
that datagrams with the limited broadcast address are confined to the particular network
segment on which they originate.

Backup Takes Over At Higher Priority
This enables the backup device in a multi-console system to take over at one priority higher than
the master if the master goes offline.

Backup Automatically Takes Control
Switches to the backup automatically if the primary should go offline.

Allowed Output Addresses
A range or ranges of addresses that can be assigned to limit the number of output addresses.
The default setting is to allow addresses 1 through 32767488.

Interface Protocols

MultiConsole
Clicking in the enable box will allow for multi-console communication on the selected port. See
Multi-Console (on page 499).

Network Type

This setting adjusts the timeout period before a backup device will take control from the master.

• Standard- After five seconds of no response from the master, the backup will assume the
master has disconnected and will then take control.

• Engineered - After 1.6 seconds of no response from the master, the backup will assume
the master has disconnected and will then take control.

File Transfer

This settings adjusts the show file transfer speed between devices. The default setting is Fast File
Transfer.

Note: If you are experiencing connection issues between devices, you can change the
setting to Normal File Transfer for a slower transfer speed.

Enable Sensor/ FDX3000 Feedback
Clicking in the enable box will allow your console to receive feedback over the network from a
CEM+, a CEM3, or FDX3000. This option is “Enabled” by default. See [About] Address (on
page 384) for more information.
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RDM
RDM can be enabled to allow Eos to perform RDM functionality including device discovery for
each ethernet port on a console. By default, RDM is enabled.

See Patch Section (on page 143) and [About] Address (on page 384) for more information.

Note: RDM requires use of a Net3 or Response Gateway. Net3 Gateways must be
using version 5.1 or higher.

FDX2000 Feedback
Clicking in the enable box will allow your console to receive FDX2000 dimmer feedback over
the network.

Broadcast Type
• Directed Broadcast - Broadcast packets are directed to a subnet based on the IP address

and subnet mask of the sender.
• Limited Broadcast - The limited broadcast address is 255.255.255.255. It is limited

because routers will never forward datagrams with that destination address. This means
that datagrams with the limited broadcast address are confined to the particular network
segment on which they originate.

WiFi Remote
Select to allow WiFi RFRs, like the iRFR or aRFR, to connect to Eos.

UDP Strings and UDP OSC
Clicking in the enable box will allow the selected port to send UDP and OSC strings.

TCP OSC
Select the OSC TCP mode. By default, OSC 1.0 is selected.

Note: Check the documentation for the OSC device you wish to use over a TCP
connection to see which mode it supports.

• OSC 1.0 (packet-length headers)
• OSC 1.1 (SLIP)

Third Party OSC
Enables or disables dedicated server port 3037 for use with third-party OSC applications.

DHCP Service

Note: All settings in this section require a reboot of the console before they will take
effect.

If this section is grayed out, or you are unable to change any settings, you don’t have Net3
Services installed on your console. Net3 Services are installed by the installer for ETC's Gateway
Configuration Editor (GCE) software. GCE is available for download from the ETC website.

Eos can provide a DHCP (Dynamic Host Configuration Protocol) address server. DHCP is a
TCP/IP protocol that dynamically assigns an IP address to a network device when it requests
one.
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This is a small and simple DHCP server that is intended to be used on non-routed networks. It
will not serve IP addresses across a router.

CAUTION: There should only be a single DHCP server active on a network. It
is possible to start more than one DHCP server on a single network (nothing is
built-in to DHCP servers to prevent this from happening). If this occurs, it will
result in unstable conditions and possibly result in network communications
failures.

Clicking in the enable box will start the DHCP server in the console. It will use the settings below
to determine which IP addresses it gives out.

• First IP Address- This sets the starting IP address of the range of IP addresses the DHCP
server will give out.

• Number of Addresses - This sets how many IP addresses the DHCP server will give out. A
setting of 500 means it will give out IP addresses to the first 500 devices that ask for an IP
address.

• Subnet Mask - This sets the logical network size vs. the device address. ETC’s default is
255.255.000.000 (class B). This is the subnet mask that the DHCP server will give to
network devices.

• Routed - If checked, you can use the default gateway box, below, to specify the gateway
you would like DHCP devices to use. If unchecked, the DHCP server will serve the same
value for both the devices IP address and gateway, which is a suitable configuration for
non-routed networks.

• Default Gateway- This specifies the IP address of a router if one is present on your
network. This is the gateway IP address that the DHCP server will send to network devices
to use. If you are on a flat or non-routed network, the Gateway IP address should match
the IP address of the device. In order to configure this DHCP server to send out matching
gateway IP addresses, configure this gateway IP address to match the IP Address field.
Then the DHCP server will give out a gateway IP address that matches the IP address.

Learn Network Devices
Clicking this button will trigger the DHCP service to search the network for existing devices, and
add them to its table of known addresses. If you have equipment with statically assigned IP
addresses in your network, this will ensure the DHCP service does not serve out any IP addresses
which conflict with those devices.

Update Service (TFTP)
Clicking in the enable box will start the TFTP (Trivial File Transfer Protocol) server.

• Update File Path - This sets the directory where files are to be served through TFTP. This
must be the full path to the directory, including drive letter. For example: C:\etc\nodesbin

Time Service (SNTP)
Clicking in the enable box will start the SNTP (Simple Network Time Protocol) service. You
determine if the service is running as a client (receiving time messages) or as a server (sending
time messages).

• Client/ Server - When configured as a client, a console will attempt to synchronize its
time with the rest of the devices in the system, by listening for time information and
altering its own clock. When configured as a server, a console will serve out time to other
devices on the network, acting as a time “master”
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• ETC Net2 Time - With ETC Net2 Time enabled, the time server will periodically broadcast
(as a server) or receive (as a client) the current time, which is required by devices running
the ETCNet2 protocol, for example, Legacy Unison systems.

• External Time Server - The External Time Server option allows you to synchronize your
console to a third party time system at a specific IP address using the NTP or SNTP
protocols. This allows use of a specific time clock for time sync. This requires a high
accuracy time clock on your network.

• External Server IP - If External Time Server is enabled, you will need to specify the IP
address of your external NTP or SNTP time server in this field.

Maintenance
The following options are available in this display:

• Deep Clear
• Save Logs
• Backup Show Archive
• Restore Show Archive
• Backup and Restore System Settings
• Face Panel Test
• Classic Peripheral Test
• File Manager
• GCE
• Concert
• UpdaterAtor
• Touchscreen Test
• Upgrade Console
• Upgrade I/O Firmware
• Network Drives
• Shared Folders
• Log Off
• Firmware Update

Deep Clear
{Deep Clear} functions in much the same way that “New” does from the File menu or “Reset
System” does from the Clear menu (both are found within the Browser). A deep clear is
automatically performed when new software is installed. Sometimes it is useful to perform a
deep clear between updates.

The advantage of deep clear is that you can clear all console data before reloading the console’s
current state during boot. This is helpful if you are moving a new console onto the network and
don’t want it to suddenly take control of a system or if you somehow end up with a corrupt show
file that is causing issues upon boot.

It’s worth noting that Deep Clear (like Reset System and File>New) does not reset any of the
settings in the Eos Configuration Utility (ECU) like its operational mode or IP address settings.
Everything in the ECU remains as it was last configured.

Save Logs
Clicking on the {Save Logs} button displays a dialog box prompting you to save the console log
files for troubleshooting purposes. You have the option to select/ deselect any of the various
individual log files to be saved.

By clicking on the {Advanced} button, you can select or deselect any of the various individual
log files to be saved.
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Clicking {Next} you will be able to provide additional information, the date, and time of the
issue.

Clicking {Next} again you will see a drop down menu to select the target export location from
any available write-enabled removable media such as a USB drive.

If you experience software problems with your system that we are unable to reproduce, sending
these log files to ETC Technical Services (see Help from ETC Technical Services (on page 3)) can
help us isolate the issue.

Backup Show Archive
{Backup Show Archive...} allows you to either backup the most current version of each show
file or every version of each file to a USB drive.

Restore Show Archive
{Restore Show Archive...} allows you to restore show files from a USB drive.

Backup and Restore System Settings
These settings allow you to backup and restore all of the ECU system settings, including Net3
services.

This is useful for sharing settings between consoles, including ETCnomad.

Backup System Settings
{Backup System Settings} will open a window that allows you to save .ini file to a selected
drive. To backup settings, select a drive from the drop down menu, and press {Accept} to save
or {Cancel} to exit without saving.

Restore System Settings
{Restore System Settings} will open a window that allows you to select a saved.ini file. Select
the desired file and press {Ok} to restore settings. Press {Cancel} to close the window without
restore settings.

Face Panel Test
{Face Panel Test} provides a way to verify the functional state of all of the keys, encoders, and
faders on the console. Press/ move every key, encoder, and fader to verify that those events
register on the diagnostic test screen.

Classic Peripheral Test
{Peripheral Test} allows you to test peripherals such as fader wings.

File Manager
{File Manager} provides a way to manage show files. You can create and delete new folders,
move, and copy files between the console and USB drives.

The file manager display will show the ShowArchive folder on your console as well as any
external USB drives that are detected. The display is split into two windows, so you can see two
different folders at the same time for copying or moving data between them.
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GCE
If installed on your console, the {Gateway Configuration Editor (GCE)} button will display.

Concert
If installed on your console, the {Net3 Concert} button will display.

UpdaterAtor
If installed on your console, the {UpdaterAtor} button will display.

Touchscreen Test
{Touch Screen Test} opens an application for testing your touchscreens.

Upgrade Console
{Upgrade Console...} is used for upgrading the console's outputs.

Upgrade I/O Firmware

Note: This option is for use with older I/O cards.

{Upgrade I/O Firmware} is used to upgrade the firmware in the console’s I/O card.
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When you first open the I/O Downloader, it will look for the connected console. This may take a
second or two.

Once the console is found, the downloader will search for the needed files. If it finds the file, it
will list it and you can click {Download}. If it doesn't find the file, you can use {Browse} to look
for the needed file and selected it. Once finished, click {Exit}.

Network Drives
{Network Drives...} allows you to select an alternative show file storage location on another
console or computer. After setting this location, it will appear as an option within the save and
open dialogs in Eos.

In the {Network Drives...} dialog box, there is a {Add} button for mapping a network drive. In
the In the Add Network Drive dialog box, select the drive letter that is appropriate, the network
path, and the path type. The network path can use either the IP Address or the Device Name.
(Example: \\10.101.90.101\ShowArchive or \\YourDeviceName\ShowArchive) The network path
type can be Eos, Eos Ti, Gio, Gio @ 5, Ion, Ion Xe, Ion Xe 20, Ion Xe RPU, Element, Element 2,
or ETCnomad Puck. If Other is selected, you will have additional fields to fill out for Username
and Password.

Shared Folders
{Shared Folders...} allows you to see if any folders are currently being shared by the console.
You can select the folder and click {Don’t Share} if you no longer want to share the folder. By
selecting {Don’t Share} here, you will also uncheck the box for Share Show Archive (on
page 515) in the General tab.

Log Off
This will log off the current user. This should only be done under the direction of ETC Technical
Services for administrative purposes.

Firmware Update
The firmware update window will display any detected devices that use firmware and may
require an update. Devices that need to be updated will display in red.

When a device is selected, the {Update} button will display in yellow if the device can be
updated using this window. This includes devices that do not currently need to be updated. If the
button is grayed out, the device can not be updated using this window.
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Buttons

RPU Face Panel Buttons
This area is for configuring the buttons on the front of a RPU or RVI. Clicking on a button will
open a dialog window for selecting what type of button, macro, hardkey, or none, you wish to
assign.

If hardkey is selected, a list of the various hardkeys on your console will be available to select
from. If macro is selected, a list of available macros will display. Selecting none will assign no
action to the selected button.

{Import} allows you to import a RPU/RVI button configuration file. {Export} allows you to export a
RPU/RVI button configuration file. {Restore Defaults} will restore the factory defaults for the
RPU/RVI buttons.

For more information, see the Setup Guide for your RPU. Setup Guides can be downloaded from
the ETC website, etcconnect.com.

Face Panel Buttons
This area is for configuring the buttons the customizable hardkeys on the Eos Ti, Gio, and Gio @
5 face panels.

Clicking on a button will open a dialog window for selecting what type of button, macro,
hardkey, or none, you wish to assign.

If hardkey is selected, a list of the various hardkeys on your console will be available to select
from. If macro is selected, a list of available macros will display. Selecting none will assign no
action to the selected button.

{Import} allows you to import a button configuration file. {Export} allows you to export a button
configuration file. {Restore Defaults} will restore the factory defaults for the buttons

RFR
This screen is used for setting up the Radio Focus Remote (RFR) to work with Eos.

Note: These settings need to match between the console and the RFR.

High Frequency Channel
The frequency that the RFR is using. There are 1-12 channels.

http://etcconnect.com/
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Network ID
The Network ID is a separate digital channel on a single high frequency (HF) setting. There are
1-99 IDs available.
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Chapter 31
Show Control

Eos Family consoles support a variety of show control protocols. Specific information about using
each type of show control can be found in each type’s section.
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About Eos Family Show Control
The following is an overview of the show control types and general setup information.

The Eos Family can use the following show control protocols:

• SMPTE - An analog signal indicating time (subdivided into hours, minutes, seconds, and
frames) that is used to sync events between multiple devices. Eos Family consoles receive
SMPTE from a Net3™ Show Control Gateway. The consoles will only receive SMPTE, and
do not send it.

• MIDI Time Code (MTC) - A digital version of SMPTE sent over MIDI. MTC can be received
through a local MIDI In port or through a Net3 Show Control Gateway. The consoles will
only receive MTC, and do not send it.

• Real Time Clock (RTC) - Events can be triggered from the date and time on the console.
With the correct location information, this includes astronomical events like sunrise and
sunset.

• Analog - 0-10VDC inputs or contact closure inputs through a variety of interfaces. 0-
10VDC inputs are received through a Net3™ I/O Gateway. Contact closures can be
received through the built-in closures on the console (when available) and through a Net3
I/O Gateway.

• Relays - Normally closed and normally open contact closure outputs (SPDT). One relay is
available on consoles that have built-in I/O ports. Multiple relays are available on Net3 I/O
Gateways.

• MIDI Show Control - A standardized subset of MIDI System Exclusive (SysEx) commands
used for show control. Eos Family devices can send or receive these messages. MIDI can
be sent through the built-in MIDI ports (when available) and through a Net3 Show Control
Gateway.

• ASCII String Interface (Serial (RS232)/Network Serial)- ASCII text strings, also known as
plain text strings. These can be sent or received on the network via a UDP message, or
sent via RS232 serial on a Net3 I/O Gateway.

• MIDI Raw - Also known as MIDI Strings, MIDI Notes, or Channelized Event Data.
Originally intended for communication between musical instruments, MIDI has been
adapted for a variety of uses between devices. Eos Family consoles can send or receive
MIDI messages through the built-in MIDI ports (when available). A Net3 Show Control
Gateway supports only MIDI Time Code and MIDI System Exclusive messages (including
MSC).

• Open Sound Control (OSC) - A network protocol using UDP/IP or TCP/IP over wired or
wireless networks. It is used for communication between varying audio, video, and
lighting devices. OSC can be sent and received from the console.

• sACN Input - These incoming levels can be used to trigger show control actions. The
console combines all incoming sACN levels for an address and uses the level from the
highest priority source. If there are multiple sources at the same priority, it uses the
highest level (HTP). The console will include its own sACN levels.

Most protocols that are received need to be configured in a Show Control list in the show control
display. These include MTC, SMPTE, Analog Inputs, RTC, MIDI Notes, Serial Strings, and sACN
Input. The Show Control list is accessed by pressing [Displays]>{Show Control}. See Show
Control Display for more information.
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Show Control Settings
In [Setup] > {System} > {Show Control}, you can adjust settings for MIDI Show Control, time
code (MIDI or SMPTE), analog, and serial functions. See Show Control (on page 170).

Port Setup Options
Eos Ti, Gio, Eos RPU3, Gio @5, Ion Xe, Element 2, Ion, Ion RPU, Element, and Eos Programming
Wing have additional ports and connectors located on the rear panel for show control.
Additional setup options for these ports and connectors are in the Setup > System > Show
Control.

Note: The built-in I/O ports on these devices will not broadcast information over the
network and are only used in a local console system.

MIDI Rx and MIDI Tx Group IDs
Allows you to set the group number for the MIDI In and MIDI Out ports. Group numbers can be
from 1-32. Default for both ports is 1.

To receive MIDI from the built-in ports, the ACN MIDI Rx ID in Setup > System > Show Control
must match the MIDI Rx Group ID. To transmit MIDI from the local ports, the ACN MIDI Tx ID in
Setup > System > Show Control must match the MIDI Tx Group ID.

Note: While Gio@5 has contact closure ports, it does not have local MIDI ports. A
Show Control gateway is required for MIDI input.

Contact Closure (Remote Trigger Connector)
Allows you to set the Group and Address In values for the remote trigger input on the back of
your console. The contact closure only reports on/off even though it is considered an analog
input.

Note: The contact closures require DC voltage, which is supplied by the console on
pins 14+15. See the diagram in Relay Out (remote trigger connector) (below).

Relay Out (remote trigger connector)
Allows you to set the Group and Address In values for the remote trigger port on the back of
your console.
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Interface Protocols
Additional settings are found in the ECU>Settings>Network.

See Open Sound Control (OSC) for more information.
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Show Control Display
The Show Control Display allows for the creation of event lists, which are comprised of events.
An event list defines how incoming show control events are processed by the console – any
protocol that can be received by the console is handled here. Each event list is assigned a type
of show control (time code, analog inputs, RTC, or network). Specific information about setting
up events for each show control type can be found later in this guide.

The show control display can be accessed by pressing {Show Control} on the Display
Management Home Screen.

Settings
In addition to the show control display, your console provides additional user-definable settings
for show control which can be accessed by pressing [Displays]>{Setup}>{System}>{Show
Control}. For more information, see the Show Control Settings .

Events
The upper portion of the show control display shows the specific events that are contained in
each event list. An event consists of an input condition, such as a timestamp, real time, an
address, or input value, and an action. An event plays back (or “fires”) when the input condition
is met (for example, the timecode passes the given timestamp, or a contact closure at the given
address changes). Multiple events can be fired at the same time; however a single action can
only be placed in each event.

Eos Family consoles support three event actions:

• Cues can be run.
• Submasters can be bumped, faded (via analog only), and turned on and off.
• Macros execute without interaction with the command line, unless the macro is set to

foreground mode.

Note: If another macro is fired before the first macro completes, the first macro will
finish its action before the second is started.

Note: If a macro is selected as the intended action, it will fire using the macro mode
specified. see Macro Editor Display (on page 405) for information on macro modes.

Softkeys are available for the various event options:
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• Event - is the event number, used to select or create a specific event from the command
line. Can also use [Next]/[Last] to select/navigate through the events.

Note: The event number is not fixed, it is just provided as a way to select an event.
For example, in time code lists, the events are always chronological. The event number
will change to match the chronology.

• Time/Address - used to specify the conditions when the event should trigger the action.
This could be time code, time of day, sACN levels, MIDI input, string input, OSC input, or
an address used for analog inputs.

Note: Time can be assigned to a list of events by using a range.
• {Event}[1] [Thru] [1][0] [Time] [1] [Thru] [1] [0] [Enter]

• Date- used to specify when the event should trigger the action, used only for RTC. See
Real Time Clock (RTC) .

• Action - is what the event is going to trigger; can be a cue, submaster, macro, or level by
address,which sets the parameter at the assigned address to the incoming level manually .
• {Event} [1] [/] [1] {Action} {Level By Address} [2] [/] [1] [Enter]

• Label - names a specific event.

Event List
The lower portion of the show control display contains the event lists used in the console. Events
are contained within a specific event list (like cues within a cue list). Each event list has a
specific show control protocol type that it uses: MIDI, SMPTE, Analog, or RTC. Getting started
with an event list is the same regardless of which show control protocol you are using.

Softkeys are available for the various event list options:

• List - is the event list number.
• <Event> [1][/][Enter] - creates event list 1.

• Label - names the event list.
• Type - sets which type of show control protocol to use; MTC, SMPTE, Analog, Network, or

RTC. Only one protocol can be used at a time per list.
• Source - should match the Group ID used in the connected Net3 Show Control, I/O

Gateway, or the built-in ports (when available).
• Internal - enables the list to use internal timing sources. See Internal vs. External Time .
• External - enables the list to use external timing sources. See Internal vs. External Time .
• First Time - sets the first time that the console will use when using internal timing.
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• Last Time - sets the last time that the console will use when using internal timing.
• FPS - sets how many frames per second (FPS) will be used; 30, 25, 24.
• Status - current status of the event list.

Internal vs. External Time
Time code (MIDI or SMPTE) is typically received from an input source, like a show control
gateway. This timing source is referred to as external time, since it is coming from a source
external to your console.

If the external time source is not available for any reason, each time code event list within your
console has an internal timing source which will assume control, if enabled. This internal timing
source requires three pieces of information to determine how to generate its timing: first time,
last time, and frame rate. When the internal clock reaches the last time, it will reset to the first
time and continue running.

Note: External timing sources may run faster or slower than the console’s internal
clock.

Real Time Clock uses internal time only, but the clock can sync with an external time server
using SNTP. Whether using internal time from the console or using external time from a time
server, it is important that all the correct information for time zone, latitude, and longitude are
properly setup. Refer to the Configuration Utility appendix in your console’s manual for setup
information.

Analog inputs and network inputs use the external setting only as a way to enable and disable
the entire list.

Creating an Event List
Getting started with an event list is the same regardless of which show control protocol you are
using.

To program an event list, you first must open the show control display.

• [Displays]><More SK>>{Show Control}

Create an event list by specifying it in the command line.

• <Event> [1] [/] [Enter]

Specify what the list will respond to (MIDI, SMPTE, Analog, or RTC).

• <Event> [1] [/] {Type} {MIDI} [Enter]

Define the group or source.

• <Event> [1] [/] {Source} [8] [Enter]

Activate the internal and / or external timing functions (see Internal vs. External Time ). These
functions are toggle on/off states.

• <Event> [1] [/] {Internal} {External} [Enter]

When defining an event list, it is feasible to enter multiple commands in the same command
line. This can speed up your programming of an event list. For example:

• <Event> [2] [/] {Type} {MIDI} {Source} [5] [Enter]

Once the list is created, you will then need to create the specific events. Those steps will vary
depending on what protocol is being used.
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Time Code
Eos Family consoles can receive internal or external time code to execute event lists.

Time code lists can receive timing data from either SMPTE or MIDI sources. Eos Family consoles
accept up to 32 SMPTE sources and 32 MIDI Time Code (MTC) sources (each are numbered
from 1-32). Up to 64 sources can be received simultaneously.

Enabling Time Code
Eos Family consoles have global settings to enable or disable reception of MIDI Time Code and
SMPTE. These are found in setup, See Show Control Settings .

If the MIDI Time Code setting is disabled, all MTC event lists are disabled as well. Each event
list can be enabled/disabled individually using the internal and / or external field. Off is disabled,
regardless of the global setting in the setup screen. The same is true for SMPTE.

Timing Data
Timing data is given in the form of (hours) : (minutes) : (seconds) : (frames). Therefore a timing
value of 06:25:15:24 would be 6 hours, 25 minutes, 15 seconds, 24 frames.

The number of frames per second is determined by the timing source and the event list must be
set to this same number of frames when programming. Number of frames can be 24, 25, or 30.

Color Coding

The color of the time in the Status column of the event list display indicates the source of the
timing data. The colors and indications are:

• Green - Valid external timing is being received.
• Red - The internal clock is the data source and is running.
• Gray - No timecode is being received from internal or external sources.

Time Code Indicator
You will see an indicator in the upper portion of the main display if valid internal or external time
is seen.
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Select the indicator to see a dropdown menu of all active time code sources. The menu shows
the List number, list label (if any), current time (if any), a symbol for MIDI/SMPTE, subscript for
framerate, and the list group ID.

Selecting {Show Last Active Source} will display the last active time code source in the upper
portion of the main display after the dropdown is closed. The selected list can be stored in a
snapshot (see About Snapshots (on page 398)).

Timing and Clocks
The internal and external clocks can be enabled separately for each time code list. If you enable
the external clock only, events will play back as long as valid timing data is received from an
external source. When the timing data stops, the events will stop.

When you enable the internal clock only, it starts running immediately and triggers events
appropriate to the time.

When both internal and external clocks are enabled, the internal clock does not start running
until the first valid external time is received. After that, it will run whenever the external time
source is absent.

Loop Times
First and last times define the overall loop. Times can be set anywhere from 00:00:00:00 to
23:59:59:29. When external time is being received, your console ignores these times. However,
you should still set them to match whatever loop times the external clock is using. When using
internal timing, it is important to set the first and last times. These set the start and stop or loop
points of the sequence.

Internal Clock
You can set the internal clock at any time by selecting the event list (<Event List> [1] [/]),
pressing [Time], and entering a time.

To reset the internal clock, select the event list and press [Time] [Enter].

Programming a Time Code Event List
Open the show control display.

• [Displays] > <More SK> > {Show Control}

Create a new event list.
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• <Event> [1] [/] [Enter]

Define the type of input.

• <Event> [1] [/] {Type} {MIDI} [Enter]

Define the source of input (this is the source ID number of the Gateway 1-32).

• <Event> [1] [/] {Source} {1} [Enter]

Specify if internal and / or external timing is enabled.

• <Event> [1] [/] {Internal} {External} [Enter]

Define the first time and last time for the event list (times are given as 00:00:00:00).

• <Event> [1] [/] {FirstTime} [2] [0] [1] [5] [Enter]
• <Event> [1] [/] {LastTime} [2] [0] [4] [5] [1] [5] [Enter]

Specify the number of frames per second (FPS) used by the timing source (24, 25, or 30).

• <Event> [1] [/] {FrameRate} [2] [5] [Enter]

When working in Live, to show the Time Code times in the Cue List, go to the Cue List Display.

• [Cue] [Cue]

Select the Cue List to be triggered.

• [Cue] [1] [/]

Now associate the Event List to the Selected Cue List.

• [Cue] [1] [/] {Execute} {Timecode} {1} [Enter]

Both the Event List and the Cue List are ready for events to be added. There are three ways that
events can be added into the Event List.

Note: You will notice as events are added in the Event List that the time code will
display on the Playback Status Display.

Note: This is the same process for MIDI and SMPTE Time code.

Adding Events from the Show Control Display
Events can be added directly from the show control display, however a new event number must
be specified for each event action.

Open the show control display.

• [Displays]><More SK>>{Show Control}

Select the event list.

• <Event> [1] [/] [Enter]

Specify a new event number.

• <Event> [1] [Enter]

Add the action that the event should execute.

• <Event> <1> [Cue] [1] [Enter]

Define the time code position of the event.
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• <Event> <1> [Time] [2][0][1][5] [Enter]

It is possible to enter multiple commands in the same command line. This can speed up your
programming.

• <Event> [2] [Cue] [1.5] [Time] [2][4][1][3] [Enter]

Event timing can also be modified within a range. Let's say an additional 5 frames needs to be
added to multiple events.

• <Event> [1] [Thru] [4] [Time] [+] [5] [Enter]

Note: You will notice as events are added to the event list, the time code will display
on the Playback Status Display.

Adding Events From Live
Events can be added directly from live using the same conventions used in the Show Control
Display. The advantage to doing this from Live is there is no need to specify the event number,
as the console automatically assigns the number.

From the Live Display Select the cue to execute.

• [Cue] [3]

Now define the time code location.

• [Cue] [3] {Execute} {Timecode} [3][2][1][5] [Enter]

Note: You will notice as events are added to the event list, the time code will display
on the Playback Status Display.

Adding Events using Learn Mode
If you select an event list within the show control display, you can press the [Learn] hardkey to
activate learn mode for that event list. When in learn mode, an event is created with the current
list time whenever a cue is activated, a submaster bump is pressed, or a macro is run. Once in
learn mode, the [Learn] key will remain lit to indicate that it is in learn mode. If the show control
display is exited, the console remains in learn mode until deactivated.

Multiple time code lists can be in learn mode simultaneously, each with their individual times. It
is recommended that you associate the event list and cue list together, so events will be learned
into the intended time code list.

To exit learn mode, the console must be in the show control display. Once there, select the
event list then press [Learn] again. If [Learn] is pressed while viewing any other screen than the
show control display an empty event will be placed on all event lists that are in learn mode.

Open the show control display.

• [Displays]<More SK>{Show Control}

Select the event list to enable learning on.

• <Event> [1] [/]

Press the [Learn] key.

• <Event> [1] [/] [Learn]

In the Status column it now says Learning, and the [Learn] button is illuminated.
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A {Learn Events} softkey is available in the event list. This macro-able item allows you to enable
and disable show control learn mode. Macros containing this softkey will not be included in
learned events. Other Macros can be learned as events in an Event List. Use {SC Learn} softkey
in the Macro Editor to enable/ disable excluding specific Macros from being learned as events.
See Macro Editor Display (on page 405)

Execution While Editing
If the internal or external clock is running, events will fire, even if you are in the edit screen. As
soon as an event is created, the event list is resorted, and the new event is eligible for playback.

Silent Mode
When a time code list is in silent mode, its clock can run without firing its events. This can be
useful when learning event without firing exisiting events.
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Real Time Clock (RTC)
Eos Family consoles have the ability to run Real Time Clock (RTC) events. RTC events are used
to run a cue, submaster, or macro at a specific time on specific days. RTC events can run at a
certain time of day, like 5:00pm on Tuesdays, a certain date, or at a time based off of
astronomical events, such as sunrise and sunset.

Enabling Real Time Clock
For astronomical (sunrise and sunset) events to work properly, time zone, latitude, and longitude
must be set up correctly. Those settings are found under the General tab in the Eos
Configuration Utility (ECU).

Note: In the ECU >Network >Time Service (SNTP), you can configure the
SNTP server or client so that the console can synchronize time across the network with
other devices, such as Paradigm®.

For all RTC events, the option for internal must be set to on within the show control display. As
long as the internal option is set to on, the RTC events will execute. However if internal is set to
off, then the events will not trigger. The status in the show control list will indicate whether it is
on or off. There is no way to disable a single event from triggering within the event list; you can
only remove the event number.

Real Time Clock Events
RTC events are created using the Show Control Display . RTC events consist of a time field, a
day or date field, and an action. Time for RTC events can be specified as local time or as time
relative to the astronomical events, sunrise and sunset. Local time is displayed in the 24 hour
format. For example, if you want an event to run at 2:50pm, you would need to set it for 14:50.

Programming Real Time Clock Events
Open the show control display.

• [Displays] <More SK> {Show Control}

Create a new event list.

• <Event> [1] [/]

Specify the event list as RTC.

• <Event> [1] [/] {Type} {RTC} [Enter]

Enable the RTC.

• <Event> [1] [/] {Internal} [Enter]

Define the Time and Date for each event. A Date must be entered for the event to run.

Note: Commands cannot be combined on the same command line.

• <Event> [1] [Time] [1] [5] [0] [0] [Enter] - sets the time for 3:00pm.
• <Event> [1] {Days} {Mon} {Wed} {Fri} [Enter] - adds on Mondays, Wednesdays, and

Fridays.
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Note: Days of the week can either be entered in from their softkeys, or you can enter
them in from the keypad using the conventional modifiers (+, -, thru). Monday is 1.

Define the Astronomical Time and Date.

• <Event> [2] [Time] {Before Sunset} [3] [0] [Enter] - sets the time for 30 minutes before
sunset.

• <Event> [2] {Days} [1] [+] [2] [+] [3] [+] [6] [Enter] - adds on Monday, Tuesday,
Wednesday, and Saturday.

Note: To run an event daily, each day of the week must be added to the event.

Define the Astronomical Time and Date.

• <Event> [3] [Time] {After Sunrise} [6] [0] [Enter] - sets the time for an hour after sunrise.

Note: The events will renumber themselves to be in the correct order of execution
throughout the day. Event 3 is now listed as Event 1. The command line will change to
Event 1 automatically.

• <Event> [1] {Date} [2] [1] {Month} [1] [0] {Year} [2] [0] [1] [5] [Enter] - sets the date to
October 21, 2015.

Creating the action for each event is the same as time code. Select the event and specify either
cue, submaster, or macro.

• <Event> [1] [Cue] [1][2] [Enter]
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Analog Inputs
Eos Family consoles can accept analog input through a variety of interfaces. 0-10VDC inputs are
received through a Net3 I/O Gateway. Contact closures can be received through the built-in
remote trigger port on the console (when available) and through a Net3 I/O Gateway. The I/O
Gateway can be set up through the Net3 Concert software. For more information, please refer
to the Net3 I/O Gateway Setup Guide. For setting up your console’s local ports, including the
pin-out of the connector, see Show Control (on page 170).

Analog inputs are programmed through the show control display, where each analog event in
the event list consists of a port address and an action. Each event list source references a
specific Group ID, which needs to match the ACN Group ID of the I/O Gateway or the Group ID
of the built-in remote trigger port, and the events themselves are assigned addresses for the
individual addresses or inputs within the gateway.

To enable the analog event list, the external time option must be enabled. This is an
enable/disable function for the entire event list. There is also a global enable for all analog
inputs found in Setup; for more information, see Show Control (on page 170).

Analog Input Events
There are two types of analog input events – contact closures and 0-10VDC inputs.

Contact closures will fire an event the input circuit is closed. Events that can be triggered this
way include running a cue, controlling a submaster, and firing a macro. The event is only
triggered as the closure occurs. It will not be triggered again as the circuit is opened.

0-10VDC inputs can be used to control a submaster fader proportionally, where 0VDC represents
0% on the fader and 10VDC represents 100% on the fader. When assigned to a contact closure
style of event, like a Sub Bump, the event will be triggered when the input passes 6.67VDC. The
input must then pass below 3.3VDC and then above 6.67VDC to trigger the event again. This is
designed to prevent the event from firing too many times, in case the input has noise that causes
the voltage to fluctuate.

Create an Analog Event List
Open the show control display.

• [Displays]<More SK>{Show Control}

Create a new event list.

• <Event> [4] [/] [Enter]

Define the type of input.

• <Event> [4] [/] {Type} {Analog} [Enter]

Define the source of input.

• <Event> [4] [/] {Source} {1} [Enter] (This is the Source ID# of the Gateway.)

Specify the event list to be active.

• <Event> [4] [/] {Internal} [Enter]

Create an analog input event where an input on address 1 will fire cue 10.

• <Event> [4] [/] [1] {Analog Address} [1] [Cue] [1] [0] [Enter]
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Actions
Cues, macros, and submasters can all be triggered from analog inputs (contact closure or analog
voltage above 6.67V) or sACN Input.

Cues
Execute the cue with its programmed cue timing.

Create an event where an input on address 2 will fire cue 11.

Analog input:

• <Event> [4] [/] [1] {Address} [2] [Cue] [1] [1] [Enter]

sACN input:

• <Event> [4] [/] [1] {sACN} [2] [Cue] [1] [1] [Enter]

Macros
Triggers the macro and begin execution immediately.

Create an event where an input on address 3 will fire macro 1.

Analog input:

• <Event> [4] [/] [1] {Address} [3] [Macro] [1] [Enter]

sACN input:

• <Event> [4] [/] [1] {sACN} [3] [Macro] [1] [Enter]

Submasters
There are four modes: On, Off, Bump, and Fader.

On

The submaster will act as if the bump button was pressed and held down. This will toggle, or
release the same state, when activated again.

Create an event where an input on address 4 will set Sub 1 to On.

Analog input:

• <Event> [4] [/] [1] {Address} [4] [Sub] [1] {On} [Enter]

sACN input:

• <Event> [4] [/] [1] {sACN} [4] [Sub] [1] {On} [Enter]

Off

Used to release the submaster’s bump button when triggered from a Sub On action elsewhere in
a show control action

Create an event where an input on address 5 will set Sub 1 back Off.

Analog input:

• <Event> [4] [/] [1] {Address} [5] [Sub] [1] {Off} [Enter]

sACN input:

• <Event> [4] [/] [1] {sACN} [5] [Sub] [1] {Off} [Enter]



Show Control 549

Bump

Acts as if the input is directly controlling the bump button. If the submaster is set to have a dwell
time of Man (manual), then it will instantly flash and turn back off. It is generally recommended
to set the submaster to have a dwell time of Hold or a specified time. The first trigger will turn
the submaster On. If the submaster is set to a dwell time of Hold, the second trigger will turn the
submaster Off.

Create an event where an input on address 6 will bump Sub 1.

Analog input:

• <Event> [4] [/] [1] {Address} [6] [Sub] [2] {Bump} [Enter]

sACN input:

• <Event> [4] [/] [1] {sACN} [6] [Sub] [2] {Bump} [Enter]

Fader

Acts as if the input is directly controlling the fader on the submaster. A contact closure will move
the fader from 0 to 100% instantly. A 0-10VDC input will fade the value proportionally, where
0VDC is the fader at 0%, and 10VDC is the fader at 100%.

Create an event where an input on address 7 will control the fader for Sub 3.

Analog input:

• <Event> [4] [/] [1] {Address} [7] [Sub] [3] {Fader} [Enter]

sACN input:

• <Event> [4] [/] [1] {sACN} [7] [Sub] [3] {Fader} [Enter]
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Relay Outputs
Eos Family consoles can trigger relay outputs on Net3 I/O Gateways and on the built-in relay
output (when available). Relay outputs are also often called remote triggers, contact closures, or
contact outputs. Relay outputs are controlled by external links in cues and submasters only.

Example:
• [Live] [Cue] [1] {Execute} {Relay} [1] [/] [2] {On} [Enter] - 1 is the ACN

Group ID of the I/O Gateway or built-in relay output and the 2 is the relay
output address.

Note: You enter relay information in the live or blind displays. This is not a Show
Control display function.
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sACN Input
Eos Family consoles can receive streaming sACN level information from itself and other devices
on the lighting control network. Similar to Analog Inputs, these received sACN input levels can
then be used in Show Control events to execute certain actions.

sACN allows for multiple sources to be present on the network. These sources (configured at the
transmitting device) are each given a priority. The valid priority range is 1 (lowest) to 200
(highest) with 100 as the default. When determining the winning level for an address, the level
with the highest priority will be used. If the sources have the same priority, the highest level will
be used (also known as Highest-Takes-Precedence, or HTP).

sACN Inputs can be assigned to events. These events can run a cue, control a submaster, or fire
a macro. Submasters can be turned On, Off, trigger the Bump button, or control the fader. See
Actions.

With the exception of a submaster fader and bump, sACN Input will fire an event when the level
rises above 50% (DMX 127). It does not fire again when the level drops below 50% (DMX 127).
It only fires again when the level drops below 50% and then rises above 50%.

Submaster bump will act as if the bump button was pressed when the level rises above 50%
(DMX 127), and acts as if the bump button was released when the level drops below 50%.

sACN Input Events

Using sACN Input

Run a Cue Based on sACN Input
Open the Show Control Display

• [Displays] > <More SK>> {Show Control}

Create a new event list

• <Event> [8] [/] [Enter]

Define the type of input

• <Event> [8] [/] {Type} {Network} [Enter]

Create a new event

• <Event> [1] [Enter]

Assign the sACN address using universe/address format

• {sACN} [4] [/] [1] [Enter]

Add the action to execute. Actions can be either a cue, submaster, or macro

• {Action} {Cue} [1] [Enter]

Control a Submaster Fader Based on sACN Input
Open the Show Control Display

• [Displays] > <More SK> > {Show Control}

Create a new event list

• <Event> [8] [/] [Enter]

Define the type of input

• <Event> [8] [/] {Type} {Network} [Enter]
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Create a new event

• <Event> [2] [Enter]

Assign the sACN address using universe/address format

• {sACN} [4] [/] [2] [Enter]

Add the action to execute. Actions can be either a cue, submaster, or macro

• {Action} {Sub} [1] {Fader} [Enter]
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MIDI Show Control
Eos Family consoles can receive MIDI Show Control (MSC) data from Net3 Show Control
Gateways and the built-in MIDI ports on a console or programming wing (when available). There
can be up to 32 sources, and these sources can be assigned Group IDs between 1 and 32. MIDI
Show Control is one of many different types of MIDI signals – MIDI Time Code and MIDI Notes
are supported, but described elsewhere in this document.

Eos Family consoles can also transmit MIDI Show Control data.

MIDI Show Control Devices
MIDI Show Control data carries a device ID (MIDI channel) within the data packet. MSC setup,
see Show Control Settings , allows you to specify two device IDs: one for reception and one for
transmission. This is different than the ACN Group Tx and Rx IDs, which are the show control
gateway source ID and transmitting ID. The show control gateway, assigned an ACN Group Tx
and Rx ID, can send MIDI messages to and from several Device IDs all on the same MIDI line.

Only MSC data that matches the MSC Receive Channel in Setup, or an All Call ID (127), will be
interpreted by your console.

All outgoing MSC data contains the specified transmit device ID, as specified in Setup, see
Show Control Settings .

Eos Family Command Interpretation
MIDI Show Control commands contain a Command Format, or device type that is intended to
receive a message. Eos Family devices will respond to Lighting—General messages. All other
command formats are ignored.

Eos Family consoles can receive the following MSC commands:

• Go - runs a cue.
• Stop - pauses a cue.
• Resume - resumes a paused cue.
• Set - controls a submaster, playback, or Grandmaster.
• Fire - runs a macro.

In addition to the command and command format, the MSC commands also contain places for
transmitting devices to provide additional data, or data fields, which further specify the intended
action, like a submaster number. When Eos Family consoles output MSC, these fields cannot be
edited and correspond to the cue, submaster, or macro that is being executed.

The cue-related commands (go, stop, resume) have three fields – Cue Number, Cue List, and
Cue Path. Cue Path is not used by the console. Cue Number and Cue List are optional fields – if
they are not provided, the console runs the next cue on the master fader on the console. The
Cue List and Cue Number field, if provided, should match a cue list and / or cue number on the
console.

In the command/ effect tables below, if a field is present in the MSC data, the name is indicated
(such as “Cue”). If it is not present in the data, a “-” is indicated.

Go
When accompanying a MIDI “Go” command, data for the following fields will result in the
following actions:

Cue Data Field List Data Field Action
Cue List Runs the specified cue in the specified cue list



554 Eos Ti, Gio, Gio @5, Ion Xe, Ion Xe 20, and Element 2 Operations Manual

Cue Data Field List Data Field Action
Cue - Runs the specified cue in cue list 1
- List Runs the next cue in the specified list
- - Runs the next cue in cue list 1

Stop
When accompanying a MIDI “Stop” command, data for the following fields will result in the
following actions:

Cue Data
Field

List
Data

Field Action

Cue List Stops the specified cue & list (if running)
Cue - Stops the running cue in cue list 1
- List Stops the current cue from the specified list

- -
Stops the running cue on the master fader of the console that received
the command

If a cue is not currently running (or already stopped), the Stop command will trigger Back, fading
back to the previous cue.

Resume
When accompanying a MIDI “Resume” command, data for the following fields will result in the
following actions. If there are no stopped cues, this action is ignored.

Cue Data Field List Data Field Action
Cue List Resumes the specified cue & list (if stopped)
Cue - Resumes the specified cue in the default cue list
- List Resumes the current cue in the specified list
- - Resumes all stopped cues

Set
The “Set” command allows MSC to control specific faders using both a numeric control value
(which specifies the fader number) and a data field (which controls the level: 0-100). Control
values are as follows:

Control Value Data Field Indication
1-127 0-100 Submaster 1-127
128 0-100 Primary playback in
129 0-100 Primary playback out
510 0-100 Grandmaster

All other control values are ignored.

Note: See Hexadecimal and MIDI Show Control Formatting for information on
formatting MIDI messages.

Fire
This command fires a macro. MSC supports macros 1 through 127 only. Therefore a numeric
value of 1 through 127 followed by 00 (in hex) would accompany this command.
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Sending MIDI Show Control
When MSC Transmit is enabled in Setup (see Show Control Settings ), the console will send
MIDI Show Control commands to the specified MSC Transmit Channel (or Device ID) that
correspond to the console’s current action. For example, if Cue 1 in List 2 is executed, the
console will send a MSC Go command for Cue 1 List 2. 

The console will send the following MSC commands:

• Go - runs a cue
• Stop - pauses a cue
• Resume - resumes a paused cue
• Fire - runs a macro

Set commands (for submasters, the playback pair, and grandmaster) are not transmitted from
Eos Family devices.

Hexadecimal and MIDI Show Control Formatting
When configuring other devices to send or receive MIDI Show Control, you may need to
consider the hexadecimal data that is sent as a part of a MIDI Show Control command. Many
software packages manage this formatting for you, but some instances require you to enter this
manually. The following notes are intended as a quick reference for common use cases. For a
more exhaustive reference on MIDI Show Control message formatting, please refer to the book
referenced at the beginning of this guide – Show Networks & Control Systems by John
Huntington.

Structure
A MIDI Show Control string can be written as a short hexadecimal message.

An example string would be:

• F0 7F 01 02 01 01 31 00 31 F7

There is a structure to these strings – this is what the same string looks like with the parts that
can be modified identified in brackets:

F0 7F [device_ID] 02 [command format] [command] [command_data] F7

Note: For Eos Family products, the command format field is always 01, for Lighting –
General.

The following commands discussed earlier in this document have the following command codes:

• Go - runs a cue = Command 01
• Stop - pauses a cue = Command 02
• Resume - resumes a paused cue = Command 03
• Set - controls a submaster, playback, or Grandmaster = Command 06
• Fire - runs a macro = Command 07

The other parts of the string are standardized. F0 7F and the ending F7 are parts of the standard
MIDI System Exclusive message format. The 02 specifies the protocol is MIDI Show Control.

Go, Stop, Resume
The cue commands can target any available cue on the console. Hexadecimal doesn’t natively
handle decimal numbers, so the numbers are sent in a different format (ASCII text encoding).

There are four simple rules for formatting:
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1. Specify the cue number first, and then the cue list
2. Place a “3” in front of every digit of the number
3. Place a “2E” wherever there is a decimal
4. Place a “00” when separating a cue number from the cue list

Examples include:

• Eos - Cue 1/54
• MSC Formatted - 35 34 00 31

• Eos - Cue 4/101
• MSC Formatted - 31 30 31 00 34

• Eos - Cue 10/55.6
• MSC Formatted - 35 35 2E 36 00 31 30

• Eos - Cue 3/   (no cue number provided – play next cue in list 3)
• MSC Formatted - 00 33

• Eos- Cue 1 (no cue list provided – assumes cue list 1)
• MSC Formatted -31 00

For example, sending Device ID 3 a GO command for cue 5.4 in list 99 would be formatted as
follows:

F0 7F 03 02 01 01 35 2E 34 00 39 39 7F

Setting Submasters, Playback Masters, or Grandmasters
Submasters from 1-127 are represented as values 01 to 7F

The master playback “up” fader (128) is represented as two hexadecimal numbers in a row - 00
01.

The master playback “down” fader (129) is represented as two hexadecimal numbers in a row –
01 01.

The grandmaster fader (510) is represented as two hexadecimal numbers in a row – 7E 03.

There are three simple rules for formatting:

1. Level values are sent as 0-100 in decimal form, which would be sent as 00-64 in
hexadecimal

2. Submasters – send the fader number, followed by 00 (in hex), then the level value, and
finally 00 (in hex). For example, sending submaster 1 to 100% would be sent as 01 00 64
00.

3. Playback Masters and Grandmasters – send the fader number, followed by 00 (in hex),
and then the level value. You do not need to end the command with 00. For example,
setting the grandmaster to 75% would be sent as 7E 03 00 4B

For example, sending Device ID 3 a SET command for sub 4 to 0% would be formatted as
follows:

F0 7F 03 02 01 06 04 00 00 00 7F

As a second example, sending Device ID 10 a SET command for the playback master “up” fader
to 100% would be formatted as follows:

F0 7F 0A 02 01 06 00 01 00 64 7F
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Firing Macros
Macros are relatively simple. Only macros 1-127 can be triggered, represented by one
hexadecimal byte.

• Eos - Macro 12
• MSC Formatted - 0C

For example, sending Device ID 5 a FIRE command for macro 17 would be formatted as follows:

F0 7F 05 02 01 07 11 F7
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String Interface
RS232, UDP serial strings, ACN EPI strings, and OSC commands can be sent and received from
the console.

Enabling Serial
You can configure sending and receiving the various serial protocols supported by the console in
Setup, see Show Control Settings . Most string protocols are disabled by default.

The Eos Configuration Utility, or ECU, also contains settings that control which network
interface is allowed to send and receive UDP, ACN Strings, and OSC messages. See
ECU>Settings>Network>Interface Protocols for more information.

Receiving Eos Serial Commands – RS232, UDP, and ACN EPI
Strings
All text will be queued up until either a carriage return (hex 0D), a “\r”, or a “#”, is encountered
in the string to show the end of the command.

Command Line
If the text begins with a “$”, the text that follows until the carriage return (hex 0D), a “\r”, or a
“#” will be sent to the command line for user 0 and processed as if that user had typed it.
Commands can be directed to a specific user command line by adding <UX> at the beginning of
the string, where X is replaced by the intended user number. The carriage return (hex 0D), a
“\r”, or a “#” will also act as the [Enter] key for the command line.

Example:
• $ Chan 1 Color Palette 1# - puts channel 1 into color palette 1 on the

background user (User 0).
• <U2> $ Chan 1 Thru 10 At Full /r - sets channels 1 through 10 to full

manually on User 2’s command line.

Note: It is best practice to place spaces after both the <UX> and the $ symbol to
ensure the command is interpreted properly.

Note: Command line text needs to use the same language as your console. Language
settings are found in ECU>General.
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Event Handler (Non-Command Line)
All other text that doesn’t start with a “$” will be sent to the console’s event handler. Here are a
few examples:

• Go 1 - fire cue list 1
• Cue 1 2 - run cue 2 from list 1, on the appropriate fader
• Cue 1 - fire pending cue from list 2
• GoCue 0 1 - clear cue list 1 (fires cue 0)
• Back_CueList 1 - run previous cue from cue list 1
• Release 1 - release cue list 1
• Off 1 - turn cue list 1 off
• Resume 1 - resume cue list 1
• Assert 1 - assert cue list 1
• Stop 1 - stop playback 1
• Stop Cue 1 2 - stop cue 2 from list 1 if it is running
• Stop - stops all
• Resume Cue 1 2 - resume cue 2 from list 1 if it is stopped
• Resume - resumes all
• SubAssert 1 - assert submaster 1
• SubUnload 1 - unload sub 1
• SubDown 5 - presses sub 5’s bump button down
• SubUp 5 - releases sub 5’s bump button

Note: Faders are accessed by adding 1000 to the fader number. This would affect any
palettes or presets assigned to the fader. Subs must be used with their sub number only.

Example:
• SubMove 1 25 - moves Sub 1 to 25%
• SubMove 1001 50 - moves Fader 1 to 50%
• SubMove 1011 75 - moves Fader 11 (fader 1 on page 2) to 75%
• SubDown 1101 - presses Fader 101’s bump button down (fader 1 on page

10)

• FaderMove_CueList 1 50 - sets cue list 1’s playback fader to 50 percent
• Grandmaster 1 100 - set Grandmaster 1 to full (there’s currently only 1 Grandmaster)
• Macro 1 - fires Macro 1

Note: Text requires either a carriage return (hex 0d), “\r”, or “#” to terminate the
command line.

Receiving UDP Strings
UDP strings must be sent to the console’s IP address (unicast) and designated port to be
processed. Multicast and broadcast UDP strings are not supported. To find your console’s IP
address, clear the command line and press [About]. For more information on About see the
About section of your console’s manual. The UDP Rx port is configured in Setup. see Show
Control Settings for more setup information.

Receiving ACN Strings
To receive ACN strings, {String RX} must be enabled in Setup > System > Show Control.
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Bidirectional ACN Strings (Send and Receive)
To send and receive ACN strings from devices such as a Net3 Gateway, both {String TX} and
{String RX} must be enabled, and the device's IP address must be set in the {String TX IP
Address} field.

If you have multiple devices sending or receiving strings, separate each entry in the {String TX IP
Address} field with a comma or semicolon.

Note: If you have multiple devices sending or receiving strings, separate each entry in
the {String TX IP Address} field with a comma.

Receiving via the I/O Gateway
For your console to receive serial data from a Net3 I/O Gateway, the Serial Port Group ID
assigned at the gateway must match the String RX Source ID in Setup > System > Show
Control, and the String RX setting must be Enabled. See Show Control Settings .

Receiving Serial Commands to Trigger Events
All text will be queued up until either a carriage return (hex 0D), a “\r”, or a “#”, is encountered
in the string to show the end of the command. The custom string is case-sensitive.

RS232, UDP, and ACN Strings
The sending device needs to add SC (case-sensitive) to the beginning of the string in order for it
to be correctly processed.

Example:
• SC Hello# - sends the string “Hello” to the show control display via

RS232, UDP, or ACN

OSC Strings
For OSC commands that are intended to be processed by the Show Control display, the sending
device needs to start the string with /eos/sc/ in order for the console to correctly process it.

Example:
• /eos/sc/Hello – sends the string “Hello” to the show control display via

OSC

Event Commands
When a command is received that starts with the prefixes listed above, the console will look for
a matching serial event defined in a Show Control List. Custom string input from any serial
source (RS232, UDP, ACN, OSC) can be used to trigger the following actions:

• Cue - fire a cue
• Submaster - bumps a submaster, turns a submaster on or off, sets a submaster to a fader

percentage. (Note that OSC cannot be used to set fader levels via custom serial
commands).

• Macro - fire a macro

Programming Serial Events
Open the show control display.
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• [Displays]><More SK>>{Show Control} or [Tab] + [1][1]

Create a new event list.

• <Event> [9] [/] [Enter]

Specify the event list as Network.

• <Event> [9] [/] {Type} {Network} [Enter]

Enable the list (External only).

• <Event> [9] [/] {External} [Enter]

Select Input String and type the appropriate UDP or OSC command

• {Input String} Hello [Enter]

Example: OSC

Type in the command you want the console to listen for.
• The sending device needs to start the command with /eos/sc/ in order for

the console to listen to it. For example, type Hello in the Input String
field. On your OSC sending device, have it send /eos/sc/Hello.

Example: UDP

Type in the string you want the console to listen for.
• The sending device needs to add “SC” (case-sensitive) to the beginning

of the string in order for it to be correctly processed.
• The string needs to be terminated with a carriage return (hex 0D), \r, or

#. For example, type Hello in the Input String field. On your UDP sending
device, have it send SC Hello#

• To set the submaster fader percentage using UDP, you need to include a
number (0-100) after the string. For example, blue 50#.

Then add the action to execute. Actions can be a cue, submaster, or a macro.

• {Action} {Cue} [1] [Enter]

Sending Serial Commands – RS232, UDP, and ACN Strings
Eos Family consoles have the ability to send strings, which can be used to send commands to
other devices, such as Paradigm®, Crestron®, and media servers. The ability to send and
receive strings can be done via RS232 ports (via a Net3 I/O Gateway), network UDP messages,
and ACN String EPI. see Show Control Settings for more setup information.

Note: The console can be configured to send either ACN strings or UDP strings, as
they share the String Tx IP Address field. A combination of device names for ACN and
IP addresses for UDP is not supported. Combinations of I/O Gateways and either UDP or
ACN Strings are allowed.

Note: If you are trying to control Paradigm via UDP, ACN Strings, or RS-232, please
reference the Paradigm Serial Access Protocol document for additional information.

Sending Strings
There are three ways that your console can send strings: from cues, macros, or user events.
String TX must be set to Enabled in Setup for any strings to be sent.
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Termination Characters

All strings are appended with CR LF unless the string contains an escape character (in which
case no default termination is appended).

Escape Characters

Non-printable ASCII characters can be placed in the string using the escape characters “\x”
followed by the hexadecimal character code. To place a carriage return (CR) in the string, type
“\x0D”.

If an escape character is embedded in the string (in any position), then the default termination is
not applied.

• [Cue] [1] {Execute} {Strings} “macro on” – sends “macro on” with the default CR LF
termination

• [Cue] [1] {Execute} {Strings} “macro on\x0A” – sends “macro on” with a line feed (LF)
termination

• [Cue] [1] {Execute} {Strings} “macro\x0Don” – sends “macro <CR> on” with a carriage
return in the middle and no termination

• [Cue] [1] {Execute} {Strings} “\x02\x03” – sends ASCII characters 0x02 and 0x03 with no
termination

Sending from Cues

Cues can be assigned specific user-defined strings to send. When the cue is executed, the string
will be sent to all enabled string interfaces. To assign the string, select the cue and press the
{Execute} softkey. A {String} softkey will be displayed. When {String} is pressed, the
alphanumeric keyboard will display. Enter the desired string, press [Enter] and text entered will
be displayed in the external links field of the playback status display.

If there is already a string linked to the selected cue, the string will be displayed for editing.
When [Cue] [n] {Execute} {String} is on the command line, pressing [Next] / [Last] will step
through all the strings used in that show file. You can then modify the displayed string to simplify
the process of entering similar strings.

Sending a String to Paradigm

Select the cue that should be executing the string.

• [Cue] [1]

Press the {Execute} softkey.

• [Cue] [1] {Execute}

New softkeys will appear, press the {Strings} softkey.

• [Cue] [1] {Execute} {Strings}

Define the serial string, in this case we will trigger a Macro On in Paradigm.

• [Cue] [1] {Execute} {Strings} macro on Lights1 [Enter]

Sending from Macros
A {Send String} softkey is available in the Macro Editor display. Any text entered after the string
command in the macro will be sent to all enabled string interfaces when that macro is fired.

Sending From User Events
{String MSC TX} is an option in Setup > System > Show Control. See Show Control Settings .
When {String MSC TX} is enabled, MIDI Show Control messages will be sent as serial string
messages when certain actions happen at the console.
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Those actions are:

• A cue is fired.
• Cue 1/2 is triggered. The console will send Cue 1 2.

• A cue is stopped.
• Cue 3/1 is stopped. The console will send Stop Cue 3 1.

• A cue is resumed.
• Cue 3/1 is resumed. The console will send Resume Cue 3 1.

• A sub’s bump button is held down.
• Sub 5’s bump button is pressed down. The console will send SubDown 5.

• A sub’s bump button is released.
• Sub 5’s bump button is pressed down. The console will send SubUp 5.

• A macro is fired.
• Macro 1 is fired. The console will send Macro 1.

Note: String MIDI Tx is restricted by {MIDI Cue List} in Setup. See Show Control
Settings .

Sending UDP Strings
UDP strings will be sent from the console on an ephemeral (always changing) port number to the
destination port specified in Setup. UDP strings sent to multicast IP addresses are not supported.

Note: The console can be configured to send either ACN strings or UDP strings, as
they share the String Tx IP Address field. A combination of device names for ACN and
IP addresses for UDP is not supported.

Sending ACN Strings
To send ACN strings, {String TX} must be enabled in Setup > System > Show Control, and the
device's IP address must be set in the {String TX IP Address} field.

If you have multiple devices sending or receiving strings, separate each entry in the {String TX IP
Address} field with a comma or semicolon.

Note: The console can be configured to send either ACN strings or UDP strings, as
they share the String Tx IP Address field. A combination of device names for ACN and
IP addresses for UDP is not supported.

Sending via the I/O Gateway
For your console to send serial data to a Net3 I/O Gateway, the Serial Port Group ID assigned at
the gateway must match the String TX Group ID in Setup, and String TX setting in Setup must be
Enabled. See Show Control Settings .
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MIDI Raw
Also known as MIDI Strings, MIDI Notes, MIDI Messages, or Channelized Event Data. Originally
intended for communication between musical instruments, MIDI has been adapted for a variety
of uses between devices. Eos Family consoles can send or receive MIDI messages through the
built-in MIDI ports (when available).

Net3 Show Control Gateways do not support MIDI RAW Note On/Off, Program Change, and
Control Change functions. Those functions are only supported through the local I/O cards.
System exclusive (SysEx) messages, including MSC, do work with a Show Control Gateway.

Receiving MIDI
Eos Family consoles can be configured to respond to specific MIDI messages or messages
matching a specific pattern. These are configured in an Event List in the Show Control Display.

Strings are configured in the MIDI String configuration display, shown below:

MIDI Message Types
The following MIDI messages can be received:

• MIDI Note Events (Note On/Note Off)
• Program Change Events
• Control Change Events
• System Events (MIDI Show Control)

MIDI Note Events (Note On/Note Off)

Note On and Note Off commands simulate activating (on) and releasing (off) a musical note.
The MIDI data that is expected to be received is shown above the Note selection area, with ‘N’
shown where any valid number will be considered a match. This display will change as
configuration options are selected. When finished configuring a Note On or Note Off event,
press {OK} to store the event. Otherwise, press {Cancel} to undo the changes.

Message Structure
Note On has a structure of 9A CC DD, where 9 represents the Note On command, A represents
the channel number, CC represents the note value, and DD represents the velocity.
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Note Off has a structure of 8A CC DD, where 8 represents the Note Off command, A represents
the channel number, CC represents the note value, and DD represents the velocity.

Options
The following options are available:

{Note}

You can choose any musical note name (C-B, chromatic), or use Raw MIDI to manually enter a
value.

{Octave}

You can choose the specific octave for the note (octaves 0-10), or chose Any, and the console
will respond when any octave of the selected note is received.

{Channel}

This should match the MIDI Channel for the note command (1-16 or 0-F). If set to Any, the
console will respond when any MIDI channel is sent a note command.

{Velocity} and {Velocity Threshold}

In MIDI, the velocity represents the relative loudness or intensity of the note, where 1 (01) is very
soft, or ppp, and 127 (7F) is very loud, or fff. (A MIDI Note On with a velocity of 0 is a special
case and is treated as a Note Off command).

The Velocity setting specifies the exact velocity in the MIDI Note message that must be received
for the action to be executed. Whenever the exact velocity is received, regardless of threshold,
the event will fire.

The Threshold is an optional way to specify the minimum velocity that must be received for the
action to be executed. In other words, the MIDI note velocity must be greater than or equal to
the threshold value. If the threshold is 0, this parameter is ignored, unless the "Threshold at 0 =
Disabled?" box is unchecked.

Example:
• Velocity 127, Threshold 0, box checked – The console is looking for an

incoming MIDI note with a velocity of 127 (7F). The threshold is ignored.
• Velocity 127, Threshold 0, box unchecked – The console is looking for an

incoming MIDI note with a velocity that is greater than or equal to 0. The
velocity is redundant, as 127 is greater than 0.

• Velocity 127, Threshold 50, box checked – The console is looking for an
incoming MIDI note with a velocity that is greater than or equal to 50

• Velocity 127, Threshold 50, box checked – The console is looking for an
incoming MIDI note with a velocity that is greater than or equal to 50
(hex 32)

• Velocity 1, Threshold 50, box checked – The console is looking for an
incoming MIDI note with a velocity that is greater than or equal to 50
(hex 32). If the note with a velocity of 1 is received, the event will also
fire as it matches the velocity parameter.

• Velocity 0, Threshold 50, box checked - The console is looking for an
incoming MIDI note with a velocity that is greater than or equal to 50
(hex 32). If the note with a velocity of 0 is received, the event will also
fire as it matches the velocity parameter.

• Velocity 0, Threshold 0, box checked – The console is looking for an
incoming MIDI note that has a velocity of 0. Threshold is ignored.
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Program Change Events

Program Change commands typically represent a change in the MIDI voice or instrument type
that should be used for a particular MIDI channel. Similar to MIDI Note commands, the MIDI
data that is expected to be received is shown in the CIA and changes as you select event
parameters. When finished configuring the program change event, press {OK} to store the
event. Otherwise, press {Cancel} to undo the changes.

Message Structure
Program change messages have the structure CN XX, where N represents the MIDI channel
number and XX represents the program number.

Options
The following options are available:

{Channel}

This should match the MIDI Channel for the note command (1-16, 0-F). If set to Any, the console
will respond when any MIDI channel is sent a note command.

{Program Number}

The program number is any value between 0-127 (0-7F). Many devices will display this as 1-128
– if this is the case for your other device, subtract one from the desired program number.

Control Change Events

Control Change commands were designed to represent specific actions on MIDI devices, like
pedals actuations and effects. For example, the Damper Pedal on a keyboard is often
represented by controller number 64 (hex 40). Similar to MIDI Note commands, the MIDI data
that is expected to be received is shown in the CIA and changes as you select event parameters.
When finished configuring the control change event, press {OK} to store the event. Otherwise,
press {Cancel} to undo the changes.

Message Structure
Program change messages have the structure BN XX YYY, where N represents the MIDI channel
number, XX represents the controller number, and YY represents the data byte.
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Options
The following options are available:

{Channel}

This should match the MIDI Channel for the note command (1-16, 0-F). If set to Any, the console
will respond when any MIDI channel is sent a note command.

{Controller Number}

The controller number is any value between 0-127 (00-7F). Many devices will display this as 1-
128 – if this is the case for your other device, subtract one from the desired controller number.

{Data}

The data parameter is any value between 0-127 (00-7F). Many devices will display this as 1-128
– if this is the case for your other device, subtract one from the desired data byte.

System Events (MIDI Show Control)

System commands allow you to specify specific MIDI Show Control messages that can be
received and interpreted by the console. While any MIDI Show Control command that matches
the configured Device ID will be executed normally, this type of event setup allows you to
respond to messages sent to different device IDs, or take additional actions based on a show
control command.

The MIDI data that is expected to be received is shown in the CIA and changes as you select
event parameters. When finished configuring the system event, press {OK} to store the event.
Otherwise, press {Cancel} to undo the changes.

Message Structure
see Hexadecimal and MIDI Show Control Formatting for more information on the show control
message structures.

Options
The following options are available:

{Commands}
• Go, Stop, Resume - represents triggering a cue, stopping a cue, and resuming a cue,

respectively. The following fields are available:
• Device ID - the MIDI Show Control device ID that should respond to the message
• List ID - the cue list
• ID - the cue number

• Set - represents controlling a fader. The following fader targets are available:
• Subs
• Grandmaster
• Master Fader Up - the level of the Up fader on the master playback pair
• Master Fader Down - the level of the Down fader on the master playback pair
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Example: The following fields are available for the fader targets:

• Device ID – the MIDI Show Control device ID that should respond to the
message

• ID (subs only) – the number of the submaster fader
• Level – the specified level of the fader from 0-100% (0-127 decimal, 00-

7F hex)

• Fire – represents executing a macro. The following fields are available:
• Device ID – the MIDI Show Control device ID that should respond to the message
• ID - the macro number to be fired

Creating a MIDI Event List and Event
Open the Show Control Display

• [Displays]>[More SK]>{Show Control}

Create a new Event List and choose the Network type

• <Event> [6] [/] {Type} {Network} [Enter]

Enable the list to respond to {External} sources

• <Event> [6] [/] {External} [Enter]

Creating a Note On Event
Create a new event and open the MIDI String configuration screen

• <Event> [1] [More SK] {MIDI String}

Select the {Note On} type

• {Note On}

Select the MIDI Note value, for example, Bb (B-flat)

• {A#/Bb}

Select the MIDI Note octave or leave it as Any. In this example, we’ll choose Any.

• <Octave> {Any}

Select the MIDI channel

• <Channel> {1}

Select the velocity

• <Velocity> {127}

Optionally, select the velocity threshold so that the event will be triggered if the message is
above this level. To disable velocity threshold, leave it at zero.

• <Velocity Threshold> {0}

Press {OK} to save the event

• {OK}

Specify the action for the event

• <Event> [1] [Macro] [1] [Enter]
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Creating a Note Off Event
Create a new event and open the MIDI String configuration screen

• <Event> [2] [More SK] {MIDI String}

Select the {Note Off} type

• {Note Off}

Select the MIDI Note value, for example, Bb (B-flat)

• {A#/Bb}

Select the MIDI Note octave or leave it as Any. In this example, we’ll choose Any.

• <Octave> {Any}

Select the MIDI channel

• <Channel> {1}

Select the velocity

• <Velocity> {0}

Optionally, select the velocity threshold so that the event will be triggered if the message is
above this level. To disable velocity threshold, leave it at zero.

• <Velocity Threshold> {1}

Press {OK} to save the event

• {OK}

Specify the action for the event

• <Event> [2] [Macro] [2] [Enter]

Creating a Program Change Event
Create a new event and open the MIDI String configuration screen

• <Event> [3] [More SK] {MIDI String}

Select the {Program Change} type

• {Program Change}

Select the MIDI channel

• <Channel> {7}

Select the program number

• <Program Number> {3}{2}

Press {OK} to save the event

• {OK}

Specify the action for the event

• <Event> [3] [Cue] [1][0] [Enter]

Creating a Control Change Event
Create a new event and open the MIDI String configuration screen

• <Event> [4] [More SK] {MIDI String}
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Select the {Control Change} type

• {Control Change}

Select the MIDI channel

• <Channel> {7}

Select the controller number

• <Controller Number> {6}{4}

Specify the data value

• <Data> {1}{2}{7}

Press {OK} to save the event

• {OK}

Specify the action for the event

• <Event> [4] [Sub] [1] {On} [Enter]

Sending MIDI
MIDI messages can be sent from cues and subs (using {Execute}) or from a Macro.

Cues and Submasters
After selecting a cue and pushing {Execute}, the {MIDI Raw} softkey becomes available. Notes
can either be input using hexadecimal values (00 through FF) or decimal (0 through 255) values
depending on the connected device. The console will default to hexadecimal format. To use
decimal format, begin the MIDI string with “D” (D followed by a space).

The string will be sent any time the cue is executed or the submaster is bumped.

Sending a MIDI Raw String from a Cue or Submaster

Hexadecimal Format
Select a cue or sub.

• [Cue] [1]

Press the {Execute} softkey.

• [Cue] [1] {Execute}

New softkeys will appear, press the {MIDI Raw} softkey.

• [Cue] [1] {Execute} {MIDI Raw}

Define the MIDI string, in this case we will use Hexadecimal to send a Note On command for
note C3 to channel 2 with a velocity of 127.

• [Cue] [1] {Execute} {MIDI Raw} 91 3C 7F [Enter]

Decimal Format
Select a cue or sub.

• [Sub] [1]

Press the {Execute} softkey.

• [Sub] [1] {Execute}

New softkeys will appear, press the {MIDI Raw} softkey.
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• [Sub] [1] {Execute} {MIDI Raw}

Define the MIDI string, in this case we will use decimal to send the same command as before - a
Note On command for note C3 to channel 1 with a velocity of 127.

• [Sub] [1] {Execute} {MIDI Raw} D 145 60 127 [Enter]

Macros
A {MIDI Raw} softkey is available in the macro editor display. Any text entered after the string
command in the macro will be sent to all string interfaces when that macro is fired. The same
syntax applies in macros as they would in cues – either hexadecimal or decimal values can be
entered.
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Open Sound Control (OSC)
Open Sound Control (OSC) is a protocol that uses network communication (wired or wireless) to
communicate between varying audio, video and lighting devices.

Using OSC
An OSC command consists of a method, and an optional list of arguments. A device that
receives an OSC string will process the command as if the current user on that device typed the
command.

OSC Method Arguments Examples/Comments Action

/eos/chan
Integer defining the channel
number

/eos/chan=1 [Chan] [1]

/eos/chan/1/full /eos/chan/1/full [Chan] [1] [At] [FL]

/eos/chan/1/at
Integer defining the desired
level

/eos/chan/1/at=50
[Chan] [1] [At]
[50]

/eos/user/5/chan
Integer defining the channel
number

/eos/user/5/chan=1
[Chan] [1] (as User
5)

Note: When setting the Eos User ID via an OSC command, that user ID remains as
specified until changed again.

Method
The OSC method defines the action the command will take.

All OSC commands directed to an Eos console must begin with /eos/. To direct an OSC string to
a particular user for a single command, the command must begin with /eos/user/<number>/.

Arguments
OSC arguments are additional data for a command that can be appended to the string following
the method.

Eos uses the = character in OSC strings to separate the method from any subsequent arguments.
Third-party OSC software often requires a different character, and may not be able to interpret
incoming strings that use =. Consult the documentation for your OSC software to determine the
appropriate character to append arguments.

Configuring OSC

UDP and TCP
Eos supports sending and receiving OSC through a TCP or UDP connection. The specific type
used will depend on the other OSC device or software that you intend to use with Eos. You will
need to check that documentation to confirm the connection types supported.

The console can be set to receive and / or transmit OSC messages. This is configured in
Setup>System>Show Control>OSC with the {OSC RX} and {OSC TX} touchbuttons.

In addition, you must enable the {UDP Strings & OSC} option for the network interface you wish
to use in the ECU>Settings>Network>Interface Protocols.
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TCP
The preferred method for transmitting and receiving OSC packets is over a TCP connection. Eos
will listen for incoming TCP connections on Port 3032. TCP communication still requires that
{OSC RX} and {OSC TX} is enabled in the Show Control section of Setup.

In the ECU>Settings>Network>Interface Protocols, there is an option for changing the OSC
TCP mode. By default, OSC 1.0 is selected. There are two TCP modes available – OSC 1.0
(packet-length headers) and OSC 1.1 (SLIP). Check the documentation for the OSC device you
wish to use over a TCP connection to see which mode it supports.

UDP
UDP connections can be used but are not preferred, as messages may be dropped or delivered
out of order. When using UDP, the appropriate IP address and ports must be configured in the
Show Control section of Setup. For systems without specific networking requirements, ETC
recommends UDP port assignments in the range 4703 to 4727 or 8000 and 8001.

The UDP port settings are configured in Setup>System>Show Control. In addition to the OSC
TX (Transmit) and RX (Receive) ports, you may wish to set the OSC TX IP address to match the
OSC device you are using with your Eos system so that it can receive OSC messages from the
console. Multiple TCP ports can be added using + or , to separate them.

Local
OSC commands entered in the console (via the Magic Sheet command object) that begin with
local: will be looped back into the console.

Example:
• local:/eos/chan/1/at/50

When executed, the console will send itself the OSC command to set Channel 1 to 50%.

Ping
Once you believe that the OSC connection has been established, you can test the connection by
sending a ping message to Eos and it will respond on its configured port. See Implicit OSC
Output (on page 591) for more information.

OSC Method Arguments Examples/Comments
Send a ping command

/eos/ping
None required, any number of arguments
can be sent

/eos/ping

/eos/ping=”abcde”

/eos/ping=”abcde”,4

Ping response - see Implicit OSC Output (on page 591) for more information
/eos/out/ping Same number of arguments that were sent /eos/out/ping
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OSC Method Arguments Examples/Comments
/eos/out/ping=”abcde”

/eos/out/ping/=”abcde”,4

Supported OSC Input
All OSC commands must begin with “/eos/...” or “/eos/user/<number>/...”.

Note: All of the command examples given can also use the
“/eos/user/<number>/...”. variant.

OSC Channel
Channel commands allow you to select Eos channels. You can directly change the channel level
information in the same command, or use this as a selection tool for other controls.

Note: OSC channel selection behaves the same way as channel selection via the
tombstone icons or direct select buttons, leaving the command line unterminated.

OSC Method Arguments Examples/Comments
Select a channel
/eos/chan number for channel to select /eos/chan=1

/eos/chan/<number> number for channel level

/eos/chan/1=75 (useful for
mapping to an

OSC slider)
Set channel intensity levels

/eos/chan/<number>/out
number for button edge:
1.0=down, 0.0=up (optional)

/eos/chan/1/out

/eos/chan/<number>/home
number for button edge:
1.0=down, 0.0=up (optional)

/eos/chan/1/home

/eos/chan/<number>/remdim
number for button edge:
1.0=down, 0.0=up (optional)

/eos/chan/1/remdim

/eos/chan/<number>/level
number for button edge:
1.0=down, 0.0=up (optional)

/eos/chan/1/level

/eos/chan/<number>/full
number for button edge:
1.0=down, 0.0=up (optional)

/eos/chan/1/full

/eos/chan/<number>/min
number for button edge:
1.0=down, 0.0=up (optional)

/eos/chan/1/min

/eos/chan/<number>/max
number for button edge:
1.0=down, 0.0=up (optional)

/eos/chan/1/max

/eos/chan/<number>/+%
number for button edge:
1.0=down, 0.0=up (optional)

/eos/chan/1/+%

/eos/chan/<number>/-%
number for button edge:
1.0=down, 0.0=up (optional)

/eos/chan/1/-%

Set parameter or DMX information
/eos/chan/<number>/dmx number for channel DMX level /eos/chan/1/dmx=255

/eos/chan/<number>/param/

<parameter>
number for parameter level

/eos/chan/1/param/pan=90
(useful for mapping to an
OSC slider)

/eos/chan/<number>/param/ number for all parameter levels
/eos/chan/1/param/pan/
tilt=90
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OSC Method Arguments Examples/Comments

<parameter 1>/<parameter
2>/... multiple numbers for each

parameter level

(set channel 1 pan & tilt to
90)

/eos/chan/1/param/pan/
tilt=45,90

(set channel 1 pan to 45 & tilt
to 90)

/eos/chan/<number>/param/

<parameter>/dmx

number for parameter DMX
level

/eos/chan/1/param/pan/
dmx=255

/eos/chan/<number>/param/

<parameter 1>/<parameter
2>/.../ dmx

number(s) for parameter DMX
level(s)

/eos/chan/1/param/pan/tilt/
dmx=255

Channel Output Information – see Implicit OSC Output (on page 591) for more information

/eos/out/active/chan
String with active channels
(selected) and current value
from first channel

/eos/out/active/chan=”1-2
[100]”

OSC Absolute Levels
Absolute level commands are used when there is an existing target already selected on the
command line of the OSC user.

OSC Method Arguments Examples/Comments
Set levels

/eos/at number for the level (0-100)
/eos/at= 75 (useful for
mapping to an OSC fader)

/eos/at/out
number for the button edge
1.0=down, 0.0=up
(optional)

/eos/at/out

/eos/at/home
number for the button edge
1.0=down, 0.0=up
(optional)

/eos/at/home

/eos/at/remdim
number for the button edge
1.0=down, 0.0=up
(optional)

/eos/at/remdim

/eos/at/level
number for the button edge
1.0=down, 0.0=up
(optional)

/eos/at/level

/eos/at/full
number for the button edge
1.0=down, 0.0=up
(optional)

/eos/at/full

/eos/at/min
number for the button edge
1.0=down, 0.0=up
(optional)

/eos/at/min

/eos/at/max
number for the button edge
1.0=down, 0.0=up
(optional)

/eos/at/max

/eos/at/+%
number for the button edge
1.0=down, 0.0=up /eos/at/+%



576 Eos Ti, Gio, Gio @5, Ion Xe, Ion Xe 20, and Element 2 Operations Manual

OSC Method Arguments Examples/Comments
(optional)

/eos/at/-%
number for the button edge
1.0=down, 0.0=up
(optional)

/eos/at/-%

Set parameter or DMX information

/eos/at/dmx number for the DMX level

/eos/at/dmx/128 (useful for
mapping to an

OSC slider)

/eos/param/<parameter> number for the level
/eos/param/pan=270 (useful
for mapping to an OSC slider)

/eos/param/<parameter>/out
number for the button edge
1.0=down, 0.0=up
(optional)

/eos/param/pan/out

/eos/param/<parameter>/home
number for the button edge
1.0=down, 0.0=up
(optional)

/eos/param/pan/home

/eos/param/<parameter>/level
number for the button edge
1.0=down, 0.0=up
(optional)

/eos/param/pan/level

/eos/param/<parameter>/full
number for the button edge
1.0=down, 0.0=up
(optional)

/eos/param/pan/full

/eos/param/<parameter>/min
number for the button edge
1.0=down, 0.0=up
(optional)

/eos/param/pan/min

/eos/param/<parameter>/max
number for the button edge
1.0=down, 0.0=up
(optional)

/eos/param/pan/max

/eos/param/<parameter>/+%
number for the button edge
1.0=down, 0.0=up
(optional)

/eos/param/pan/+%

/eos/param/<parameter>/-%
number for the button edge
1.0=down, 0.0=up
(optional)

/eos/param/pan/-%

/eos/param/<parameter 1>/

<parameter 2>

number for all parameter
levels

multiple numbers for each
parameter level

/eos/param/pan/tilt=45 (set
pan & tilt to 45)

/eos/param/pan/tilt=45,90 (set
pan to 45 & tilt to 90)

OSC Color

OSC Method Arguments Examples/Comments

/eos/color/hs
Argument 1: Hue (0.0-
360.0) Argument 2:
Saturation (0.0-100.0)

/eos/color/hs=330.0, 75.0 (pink color with 75% saturation)

/eos/color/hsxy
Argument 1: X (0.0-1.0)
Argument 2: Y (0.0-1.0)

For simulating the Hue/Saturation wheel in a 2D XY graph
where bottom-left corner is (0.0, 0.0) and top-right corner
it (1.0, 1.0) /eos/color.hsxy=0.82, 0.31 (pink color with
75% saturation)
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OSC Method Arguments Examples/Comments

/eos/color/rgb

Argument 1: Red (0.0-
1.0) Argument 2: Green
(0.0-1.0) Argument 3:
Blue (0.0-1.0)

/eos/color/rgb=1.0, 0.25, 0.63 (pink color with 75%
saturation)

/eos/color/xy
Argument 1: x (0.0-1.0)
Argument 2: y (0.0-1.0)

For setting (x, y) chromaticity point in the CIE 1931 xyY
color space /eos/color/xy=0.464, 0.254 (pink color with
75% saturation)

/eos/color/xyz
Argument 1: X Argument
2: Y Argument 3: Z

For setting (X, Y, Z) color point in XYZ color space
/eos/color/xyz=0.851, 0.466, 0.516 (pink color with 75%
saturation)

OSC Wheel
A wheel can be used to adjust channel levels and parameters.

OSC Method Arguments Examples/Comments

/eos/pantilt/xy
Argument 1: X (0.0-1.0)
Argument 2: Y (0.0-1.0)

For 2D Pan/Tilt graph where
bottom-left corner is (0.0, 0.0) and
top-right corner if (1.0, 1.0)

Level Wheel

/eos/wheel/level

number for wheel ticks
for the specified wheel
mode (positive or
negative)

/eos/wheel/level=1.0 (increase
value)

/eos/wheel/level=-1.0 (decrease
value)

/eos/wheel/level=4.0 (increase
value rapidly)

(defaults to Coarse mode, but
wheel mode can be changed with
the /eos/wheel command below)

/eos/wheel
number for wheel
mode: 0=coarse, 1=fine

/eos/wheel=1.0

Wheel Output - see Implicit OSC Output for more information

/eos/out/wheel
number for current
wheel mode: 0=coarse,
1=fine

/eos/out/wheel=1.0

/eos/out/active/wheel/# /eos/out/active/wheel=4

/eos/out/pantilt
Current pan/tilt values of selected
channel

Indexed Wheels - see Active Parameters

/eos/wheel/<index>/level

number for wheel ticks
for the specified wheel
mode (positive or
negative)

/eos/wheel/2/level=1.0 (increase
value)

/eos/wheel/2/level=-1.0 (decrease
value)
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OSC Method Arguments Examples/Comments

/eos/wheel/2/level=4.0 (increase
value rapidly)

(defaults to Coarse mode, but
wheel mode can be changed with
the /eos/wheel command below)

/eos/wheel/<index>
number for wheel
mode: 0=coarse, 1=fine

/eos/wheel=1.0

Parameter wheels and encoders

/eos/wheel/<parameter>
number for wheel ticks
(positive or negative)

/eos/wheel/pan=1.0

/eos/wheel/<parameter 1>/

<parameter 2>/...

number for wheel ticks
(positive or negative)

/eos/wheel/pan/tilt=1.0

/eos/wheel/fine/<parameter>
number for fine wheel
ticks (positive or
negative)

/eos/wheel/fine/pan=1.0

/eos/wheel/fine/<parameter 1>/

<parameter 2>/...

number for fine wheel
ticks (positive or
negative)

/eos/wheel/fine/pan/tilt=1.0

/eos/wheel/course/<parameter>
number for coarse
wheel ticks (positive or
nega tive)

/eos/wheel/coarse/pan=1.0

/eos/wheel/course/<parameter
1>/

<parameter 2>/...

number for coarse
wheel ticks (positive or
negative)

/eos/wheel/coarse/pan/ tilt=1.0

OSC Switch

Note: Switch is a variant of Wheel with the added functionality of continuously
repeating wheel ticks until a subsequent OSC switch command sets the wheel ticks to
zero.This may be used to continuously tick a wheel while a button is held down, for
example. The expected argument range is -1.0 to 1.0, which affects the tick rate
accordingly, but can be a smaller or larger range for more subtle or rapid movement.

OSC Method Arguments Examples/Comments
Switch/Wheel Level
/eos/switch/level X level wheel ticks
/eos/switch Set OSC wheel mode 0 = Course, 1 = Fine
Switch Mode Output – see Implicit OSC Output (on page 591) for more information
/eos/out/switch Current OSC wheel mode /eos/out/switch=1.0
Swich/Wheel and Encoder Levels

/eos/switch/<parameter>
X OSC wheel mode ticks for specified
parameter (ex: pan)

/eos/switch/<parameter 1>/

<parameter 2>/...

X OSC wheel mode ticks for specified
parameters (ex: red, green, blue)

/eos/switch/fine/<parameter>
X fine wheel ticks for specified
parameter (ex: pan)
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OSC Method Arguments Examples/Comments
/eos/switch/fine/<parameter 1>/

<parameter 2>/...

X fine wheel mode ticks for specified
parameters (ex: red, green, blue)

/eos/switch/course/<parameter>
X course wheel ticks for specified
parameter (ex: pan)

/eos/switch/course/<parameter
1>/

<parameter 2>/...

X course wheel mode ticks for
specified param- eters (ex: red,
green, blue)

OSC Active Parameters

Note: The parameter <index> is a 1-based index referencing the list of current
parameters for the selected channel(s).Eos will send the parameter name and current
value for each active parameter, so that the wheels on your OSC-enabled device may
be labeled appropriately.

OSC Method Arguments Examples/Comments
Wheel

/eos/active/wheel/<index>

number of wheel
ticks for the specific
wheel mode
(positive or nega-
tive)

/eos/active/wheel/1=1.0 (increase
value)

/eos/active/wheel/1=-1.0 (decrease
value)

/eos/active/wheel/1=4.0 (increase
value rapidly)

(defaults to Coarse mode, but wheel
mode can be changed with the
/eos/wheel command)

/eos/active/wheel/fine/<index>
number of fine
wheel ticks (positive
or nega- tive)

/eos/active/wheel/fine/1=1.0

/eos/active/wheel/course/<index>
number of coarse
wheel ticks (positive
or nega- tive)

/eos/active/wheel/coarse/ 1=1.0

Switch

/eos/active/switch/<index>

number of wheel
ticks for the specific
switch mode
(positive or nega-
tive)

/eos/active/switch/1=1.0 (increase
value)

/eos/active/switch/1=-1.0 (decrease
value)

/eos/active/switch/1=4.0 (increase
value rapidly)

/eos/active/switch/1=0.25 (increase
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OSC Method Arguments Examples/Comments
value slowly)

(defaults to Coarse mode, but wheel
mode can be changed with the /eos/
switch command)

/eos/active/switch/fine/<index>
number of fine
wheel ticks (positive
or nega- tive)

/eos/active/switch/fine/1=1.0

/eos/active/switch/coarse/<index>
number of coarse
wheel ticks (positive
or nega- tive)

/eos/active/switch/coarse/ 1=1.0

Active Wheel Data Sent by Eos - see Implicit OSC Output (on page 591) for more information

/eos/out/active/wheel<number>

2 arguments:String
with parameter
name and current
value from first
channel

/eos/out/active/wheel/1=”Intensity”,
100

OSC Subscribe to Specific Parameters
Once subscribed, Eos will reply with an OSC packet per parameter as they change.

For example:

• /eos/out/param/pan

See Implicit OSC Output (on page 591) for more information.

OSC Method Arguments Examples/Comments

/eos/subscribe/param/<parameter>
1=subscribe,
0=unsubscribe

/eos/subscribe/param/red=1

/eos/subscribe/param/<parameter
1>/<parameter 2>/...

1=subscribe,
0=unsubscribe

/eos/subscribe/param/pan/tilt=1

OSC Direct Selects
OSC direct selects are virtual buttons and are mapped separately than direct selects visible on
the console. To use direct selects, you must first send one of the direct select creation
commands. Direct selects are mapped as a single target type.

Note: Eos will send the description and button labels for all OSC direct selects. See
Implicit OSC Output for more information.

OSC Method Arguments Examples/Comments
Direct Select Creation

/eos/ds/<index>/<target
type>/

<button count>

/eos/ds/1/chan/10 (create OSC
direct select bank #1 with 10
channel

buttons)

/eos/ds/2/group/25 (create
OSC direct select
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OSC Method Arguments Examples/Comments
bank #2 with 25 group but-
tons)

/eos/ds/<index>/<target
type>/ flexi/<button count>

/eos/ds/1/chan/flexi/10 (create
OSC direct select bank #1 with
10 channel buttons, in flexi
mode)

/eos/ds/<index>/<target
type>/

<page number>/<button
count>

/eos/ds/1/chan/3/10 (create
OSC direct select bank #1 with
10 channel buttons on page 3)

Can also be used to quick jump
to a specific page

/eos/ds/<index>/<target
type>/ flexi/<page
number>/<button count>

/eos/ds/1/chan/flexi/3/10
(create OSC direct select bank
#1 with 10 channel buttons on
page 3, in flexi mode)

Can also be used to quick jump
to a specific page

Direct Select Paging

/eos/ds/<index>/page/<delta> number for page delta

/eos/ds/1/page/1 (page down
by 1)

/eos/ds/1/page/-1 (page up by
1)

/eos/ds/1/page/10 (page down
by 10)

Using Direct Selects

/eos/ds/<index>/<button
index>

number for button edge:
1.0=down, 0.0=up (optional)

/eos/ds/1/1=1.0 (press first
button of OSC

direct select bank #1)

/eos/ds/1/1=0.0 (release first
button of OSC

direct select bank #1)
Direct Select Information sent by Eos – see Implicit OSC Output (on page 591) for more
information

/eos/out/ds/<index>

String argument containing
descriptive text for direct
select at <index>: target
name, page number, mode

/eos/out/ds/1/1=”Channels
[1]”

/eos/ds/1/1=”Groups [1 –
Flexi]”

/eos/out/ds/<index>/<button
index>

String argument containing
target description
(name/number)

/eos/out/ds/1/1=“Cyc [1]”

Note: <index> is a 1-based index of any number of OSC direct select banks you wish
to create. <target type> may be one of the following:

• Chan
• Group
• Macro
• Sub
• Preset
• IP (intensity palette)
• FP (focus palette)
• CP (color palette)
• BP (beam palette)
• MS (Magic Sheet)
• Curve
• Snap (snapshot)
• FX (Effects)
• Pixmap
• Scene
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OSC Fader Banks
Fader banks share fader mapping with Eos, but since an OSC Fader Bank can have any number
of faders per page, the paging will be different. Like Direct Selects, you must first send one of
the OSC Fader Bank creation commands before the fader pages will work. Faders will be
mapped to the same fader number as Eos.

Example:

• Create an OSC fader bank with 10 faders per page /eos/fader/1/config/10
• OSC Fader 1/1 is the same as console fader 1/1.
• OSC Fader 2/1 (Fader 11) is the same as console fader 2/1.

Another example:

• Create an OSC fader bank with 5 faders per page /eos/fader/1/config/5
• OSC Fader 2/1 (Fader 6) is the same as console fader 1/6 (Fader 6)
• OSC Fader 3/1 (Fader 11) is the same as console fader 2/1 (Fader 11)

Note: <index> is a 1-based index of any number of discrete sets of OSC fader banks
you wish to create. Eos will send the description and fader labels for all OSC fader
banks. See Implicit OSC Output (on page 591) for more information.

Note: Use an <index> of zero to reference the master fader.

OSC Method Arguments Examples/Comments
Fader Page Creation
/eos/fader/<index>/config/<fader
count>

none
/eos/fader/1/config/10 (create OSC
fader bank #1 with 10 faders)

/eos/fader/<index>/config/<page
number>/<fader count>

none

/eos/fader/1/config/2/10 (create
OSC fader bank #1 with 10 faders
on page 2) Can also be used to
quick jump to a specific page

Fader Controls

/eos/fader/<index>/config/<page
number>/<fader count>

none
/eos/fader/1/config/2/10 Jump to a
specific fader page (OSC Fader Map
1, Page 2 of 10 faders)

/eos/fader/<index>/page/<delta> none

/eos/fader/1/page/1 (page down by
1)

/eos/fader/1/page/-1 (page up by 1)

/eos/fader/1/page/10 (page down
by 10)

/eos/fader/<index>/<fader index>
floating point
number to set
sub percent to

/eos/fader/1/2=0.75 (set the second
fader in OSC

fader bank #1 to 75%)
/eos/fader/<index>/<fader index>/
load

none /eos/fader/1/2/load

/eos/fader/<index>/<fader index>/
unload

none /eos/fader/1/2/unload

/eos/fader/<index>/<fader index>/ none /eos/fader/1/2/stop
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OSC Method Arguments Examples/Comments
stop
/eos/fader/<index>/<fader index>/
fire

none /eos/fader/1/2/fire

/eos/fader/<index>/<fader index>/
out

none /eos/fader/1/2/out

/eos/fader/<index>/<fader index>/
home

none /eos/fader/1/2/home

/eos/fader/<index>/<fader index>/
min

none /eos/fader/1/2/min

/eos/fader/<index>/<fader index>/
max

none /eos/fader/1/2/max

/eos/fader/<index>/<fader index>/ full none /eos/fader/1/2/full
/eos/fader/<index>/<fader index>/
level

none /eos/fader/1/2/level

/eos/fader/<index>/<fader index>/

+%
none /eos/fader/1/2/+%

/eos/fader/<index>/<fader index>/-

%
none /eos/fader/1/2/-%

Fader Status Information – see Implicit OSC Output (on page 591) for more information

/eos/out/fader/<index>/<fader>/name
String argument
with fader label
for OSC fader

/eos/out/fader/1/1=“S 1 Label” Sub
1 with a label “Label”

/eos/out/fader/1/2=“IP 1 Label” IP 1
fader labeled “Label”

/eos/out/fader/<index>/<fader>/name

Floating point
argument for
fader percent
(0.0-1.0)

/eos/out/fader/1/1=0.75

/eos/out/fader/1/2=0.0

/eos/out/fader/<index>

String
argument,
descriptive text
for OSC fader
bank at index

/eos/fader/1=“1”

OSC Key

Note: For a list of supported key names, see Eos OSC Keys.

OSC Method Arguments Examples/Comments

/eos/key/<name>
number for button edge:
1.0=down, 0.0=up (optional)

/eos/key/select active=1.0 (press
[Select Active] but- ton)

/eos/key/select active=0.0 (release
[Select Active] but- ton)

/eos/key/go 0

(press & release [Go] button)
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Note: For the slash key, use a backslash /eos/key/\

OSC Address

OSC Method Arguments Examples/Comments
Selection

/eos/addr
number for address to
select

/eos/addr=513

Set Levels (Parks address while on the OSC command line)

/eos/addr/<address>
number for level to set
address to (0-100)

/eos/addr/513=100 (useful for
mapping to an OSC slider)

/eos/addr/<address>/dmx
number for DMX level to set
address to (0-255)

/eos/addr/513/dmx=255 (useful for
mapping to an OSC slider)

OSC Magic Sheet

OSC Method Arguments Examples/Comments
/eos/ms number of the magic sheet to open /eos/ms=1
/eos/ms/<ms
number>

number of the magic sheet view to open
(optional)

/eos/ms/1=2

OSC Group
Selects and controls channels in groups.

Note: Same syntax and behavior as Channel.

OSC Method Arguments Examples/Comments

/eos/group
number for group to
select

/eos/group=1

/eos/group/<number>
number for channel
level

/eos/group/1=75

/eos/group/<number>/out
number for button
edge:1.0=down,
0.0=up(optional)

/eos/group/1/out

/eos/group/<number>/home
number for button
edge:1.0=down,
0.0=up(optional)

/eos/group/1/home

/eos/group/<number>/level
number for button
edge:1.0=down,
0.0=up(optional)

/eos/group/1/level

/eos/group/<number>/full
number for button
edge:1.0=down,
0.0=up(optional)

/eos/group/1/full

/eos/group/<number>/min
number for button
edge:1.0=down,
0.0=up(optional)

/eos/group/1/min

/eos/group/<number>/max
number for button
edge:1.0=down,
0.0=up(optional)

/eos/group/1/max

/eos/group/<number>/+% number for button /eos/group/1/+%
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OSC Method Arguments Examples/Comments
edge:1.0=down,
0.0=up(optional)

/eos/group/<number>/-%
number for button
edge:1.0=down,
0.0=up(optional)

/eos/group/1/-%

/eos/group/<number>/dmx
number for dmx
level1.0=down, 0.0=up
(optional)

/eos/group/1/dmx=127

/eos/group/<number>/param/

<parameter>

number for parameter
level

/eos/group/1/param/pan=90

/eos/group/<number>/param/

<parameter 1>/<parameter
2>/...

number(s) for
parameter levels

/eos/group/1/param/pan/tilt=90,75

/eos/group/<number>/param/

<parameter>/dmx

number for parameter
dmx level

/eos/group/1/param/pan=255

/eos/group/<number>/param/

<parameter 1>/<parameter
2>/.../ dmx

number(s) for dmx
parameter levels

/eos/group/1/param/pan/tilt/dmx=255

OSC Macro
Selects and fires (executes) macros.

OSC Method Arguments Examples/Comments
/eos/macro number for macro to select /eos/macro=1
/eos/macro/fire number for macro to run /eos/macro/fire=1

/eos/macro/<number>/fire
number for button edge:
1.0=down, 0.0=up (optional)

/eos/macro/1/fire=1.0

OSC Submaster

OSC Method Arguments Examples/Comments
Select Submaster
/eos/sub number for sub to select /eos/sub=1
Control Submaster

/eos/sub/<number>
floating point number to set sub
percent to

/eos/sub/1=0.75 (useful for
mapping to an

OSC slider)

/eos/sub/<number>/out
number for button edge: 1.0=down,
0.0=up (optional)

/eos/sub/1/out

/eos/sub/<number>/home
number for button edge: 1.0=down,
0.0=up (optional)

/eos/sub/home

/eos/sub/<number>/level
number for button edge: 1.0=down,
0.0=up (optional)

/eos/sub/1/level

/eos/sub/<number>/full
number for button edge: 1.0=down,
0.0=up (optional)

/eos/sub/1/full

/eos/sub/<number>/min
number for button edge: 1.0=down,
0.0=up (optional)

/eos/sub/1/min

/eos/sub/<number>/max
number for button edge: 1.0=down,
0.0=up (optional)

/eos/sub/max
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OSC Method Arguments Examples/Comments
/eos/sub/fire number for sub to bump /eos/sub/fire=1

/eos/sub/<number>/fire
number for button edge: 1.0=down,
0.0=up (optional)

/eos/sub/1/fire=1.0 (bump
sub 1 on)

/eos/sub/1/fire=0.0 (bump
sub 1 off)

OSC Preset

OSC Method Arguments Examples/Comments
Select Preset
/eos/preset number of preset to select /eos/preset=1
Recall Preset
/eos/preset/fire number of preset to recall /eos/preset/fire=1

/eos/preset/<number>/fire
number for button edge: 1.0=down, 0.0=up
(optional)

/eos/preset/1/fire

OSC Intensity Palette

OSC Method Arguments Examples/Comments
Select Intensity Palette
/eos/ip number of intensity palette to select /eos/ip=1
Recall Intensity Palette
/eos/ip/fire number of intensity palette to recall /eos/ip/fire=1

/eos/ip/<number>/fire
number for button edge: 1.0=down, 0.0=up
(optional)

/eos/ip/1/fire

OSC Focus Palette

OSC Method Arguments Examples/Comments
Select Focus Palette
/eos/fp number of focus palette to select /eos/fp=1
Recall Focus Palette
/eos/fp/fire number of focus palette to recall /eos/fp/fire=1

/eos/fp/<number>/fire
number for button edge: 1.0=down, 0.0=up
(optional)

/eos/fp/1/fire

OSC Color Palette

OSC Method Arguments Examples/Comments
Select Color Palette
/eos/cp number of color palette to select /eos/cp=1
Recall Color Palette
/eos/cp/fire number of color palette to recall /eos/cp/fire=1

/eos/cp/<number>/fire
number for button edge: 1.0=down, 0.0=up
(optional)

/eos/cp/1/fire

OSC Beam Palette

OSC Method Arguments Examples/Comments
Select Beam Palette
/eos/bp number of beam palette to select /eos/bp=1
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OSC Method Arguments Examples/Comments
Recall Beam Palette
/eos/bp/fire number of beam palette to recall /eos/bp/fire=1

/eos/bp/<number>/fire
number for button edge: 1.0=down, 0.0=up
(optional)

/eos/bp/1/fire

OSC Cue

OSC Method Arguments Examples/Comments
Select Cue or Cue Parts

/eos/cue
Number of cue to
select

/eos/cue=1.5

/eos/cue/<list number>
Number of cue to
select (in the specified
cue list)

/eos/cue/1=1.5

/eos/cue/<list number>/<cue number>

Number of cue part to
select (in the specified
cue list and cue
number)

/eos/cue/1/1.5=2

Run Cues
/eos/cue/fire Number of cue to run /eos/cue/fire=1

/eos/cue/<cue number>/fire
Number for button
edge: 1.0=down,
0.0=up (optional)

/eos/cue/1.5/fire

/eos/cue/<list number>/<cue
number>/fire

Number for button
edge: 1.0=down,
0.0=up (optional)

/eos/cue/1/1.5/fire

/eos/cue/<list number>/<cue
number>/<part number>/fire

Number for button
edge: 1.0=down,
0.0=up (optional)

/eos/cue/1/1.5/2/fire

Cue Information Sent by Eos – see Implicit OSC Output (on page 591) for more information

/eos/out/active/cue/<list>/<cue>

Float argument with
percent
complete0.0=started,
1.0 complete

/eos/out/active/cue/5/1=0.75

Updated once per second

/eos/out/active/cue

Float argument with
percent
complete0.0=started,
1.0 complete

/eos/out/active/cue=0.75

Updated once per second

/eos/out/active/cue/text
String argument with
descriptive text about
active cue

/eos/out/active/cue/text=
“1/1 Label 5.00 100%”

/eos/out/pending/cue/<list>/<cue> None /eos/out/pending/cue/5/1.5

/eos/out/pending/cue/<list>/<cue>/text
String argument with
descriptive text about
active cue

/eos/out/pending/cue/text=
“1/1.5 Label 5.00”
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OSC Cue List Banks

Note: <index> is a 1-based index of any number of OSC cue list banks you wish to
create. Eos will send the cue list label and cue information for all OSC cue list banks.
See Explicit OSC Output for more information.

OSC Method Arguments Examples/Comments

/eos/cuelist/<index>/config/<cue
list number>/<num prev
cues>/<num pending cues>

/eos/cuelist/1/config/2/3/6 (create OSC cue
list bank #1 for cue list 2, showing 3 previous
cues, the current cue, and 6 pending cues)

NOTE: set <cue list number> to zero to follow
the current cue list

/eos/cuelist/<index>/config/<cue
list number>/<num prev
cues>/<num pending
cues>/<offset>

/eos/cuelist/1/config/2/3/6/10 (create OSC
cue list bank #1 for cue list 2, showing 3
previous cues, the current cue, and 6 pending
cues, starting at offset 10 into the cue list)
offset is a zero-based index into the entire
cue list, where each cue counts as one item
and each cue part counts as one item

NOTE: set <cue list number> to zero to follow
the current cue list

/eos/cuelist/<index>/page/<delta>

/eos/cuelist/1/page/1 (page OSC cue list bank
down 1 row)

/eos/cuelist/1/page/-1 (page OSC cue list
bank up 1 row)

/eos/cuelist/1/page/0 (jump back to the
current cue and follow it)

/eos/cuelist/<index>/select/<cue
number>

/eos/cuelist/1/select/100.4 (jump to cue
100.4)

OSC Softkey

Note: <index> is 1-based index into the softkey list. There are 6 softkeys and 2
pages, so valid <index> numbers are 1-12.

OSC Method Arguments Examples/Comments

/eos/softkey/<index>
number for button edge: 1.0=down,
0.0=up (optional)

/eos/softkey/1=1.0 (press 1st
softkey)

/eos/softkey/1=0.0 (release
1st softkey)

OSC XYZ Coordinates

OSC Method Arguments Examples/Comments

/eos/xyz XYZ coordinates
Set XYZ position of selected
channel

/eos/chan/#/xyz XYZ coordinates
Set XYZ position of a specific
channel

/eos/out/xyz Current position of selected
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OSC Method Arguments Examples/Comments
channel

/eos/cmd
Channel number, XYZ_Format Enable#,
XYZ_Format Disable#

/eos/cmd=Chan 1 XYZ_Format
Enable#

/eos/cmd=Chan 1 XYZ Format
Disable#

Enables or disables XYZ
formatting for Channel 1

Note: OSC XYZ coordinates are measured in decimal meters, regardless of the unit
selected in Setup > System Settings > Augment3d.

OSC Staging Mode

OSC Method Arguments Examples/Comments
/eos/key/staging_
mode

Send once to activate Staging Mode. Send again to clear
Staging Mode.

OSC Other Targets - Selection

OSC Method Arguments Examples/Comments
/eos/curve number of curve to select /eos/curve=1
/eos/fx number of effect to select /eos/fx=1
/eos/snap number of snapshot to recall /eos/snap=1
/eos/pixmap number of pixel map to select /eos/pixmap=1

OSC User
Use this command to set the OSC user ID. User 0 represents the background user (used in
Background macros and elsewhere). User -1 represents the current user on the console receiving
OSC commands.

OSC Method Arguments Examples/Comments

/eos/user number for OSC user ID

/eos/user=1

(set OSC user ID to 1)

/eos/user=-1

(set OSC user to match con- sole)

/eos/user=0

(set OSC user as background
user)

Current User ID Output – see Implicit OSC Output (on page 591) for more information

/eos/out/user
number for current OSC user
ID

/eos/out/user=1
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OSC Command Line
Command line instructions can be sent directly. String substitution with arguments is also
allowed. To add a substitution, add %1 (or %2, %3, etc…) where the number given is the
argument number where the actual value should be found.

Example:
• “Chan %1 At FL”, 101 - Eos will substitute 101 in place of %1, meaning

the command is interpreted as Chan 101 At FL
• “Chan %1 At %2”, 75, 50 - Eos will substitute 75 in place of %1 (as it is

the first argument), and 50 in place of %2. The command is interpreted
as Chan 75 At 50.

OSC Method Arguments Examples/Comments
Direct command line entry

/eos/cmd string with command line text

/eos/cmd=”Chan 1 At 75"
(unterminated command)

/eos/cmd=”Chan 1 At
75#” (terminated
command)

/eos/cmd=”Chan 1 At 75
Enter”

(terminated command)

/eos/cmd

in-line command line /eos/cmd=”Chan 1 At

arguments

%1#”, 75
(results in command line
“Chan 1 At 75#”
/eos/cmd=”Chan %1 At
%2#”, 1, 75

/eos/cmd/<text>/<text>/<text>/...
in-line command line
arguments (optional)

/eos/cmd/Chan/1/At/75

/eos/cmd/Chan/%1/At/

%2#=1, 75
Clear command line each time

/eos/newcmd
Same behavior as /eos/ cmd,
but it resets the command line
first

Direct event entry

/eos/event
Same behavior as /eos/ cmd,
but treated as con- sole event

/eos/newevent
Same behavior as /eos/ cmd,
but it resets the command line
first

Command Line Output - see Implicit OSC Output (on the facing page) for more information

/eos/out/user/<number>/cmd
String with current command
line text for current console
user

/eos/out/cmd String with current command



Show Control 591

OSC Method Arguments Examples/Comments
line text

OSC Other

OSC
Method

Arguments Examples/Comments

/eos/reset

clears any active switches resets all persistent OSC set- tings (like OSC
user ID & wheel modes)

send ALL implicit OSC out- put commands

Explicit OSC Output
OSC outputs exactly like Serial String outputs, but the string must start with an OSC address (ex:
“/ device/fader”).

Optionally, you may add arguments by adding “=” to the string, followed by a comma-delimited
list of arguments.

For example, to send a Playback fire command to a ColorSource AV console:

/cs/playback/1/fire=1 would send “/cs/playback/1/fire” as the command and 1 as the first (and
only) integer argument

Numeric arguments with a decimal are treated as 32-bit floating point numbers. Numeric
arguments without a decimal are treated as 32-bit integer numbers. Non-numeric arguments are
treated as strings.

Examples:

• “/device/command” No arguments
• “/device/command=1” One integer argument
• “/device/command=1.5” One floating point argument
• “/device/command=1.5,3.0” Two floating point arguments
• “/device/command=1.5,3.0,text” Two floating point arguments, one string argument

Implicit OSC Output
When UDP transmit is enabled, certain OSC commands are sent out as appropriate. These
events are typically generated as the target changes or in response to user input.

OSC Command Lines
OSC Method Arguments/Comments

/eos/out/user/<number>/cmd
String argument with current command line text for the current console
user

/eos/out/cmd String argument with current command line text

OSC Settings
OSC Method Arguments/Comments

/eos/out/user Integer argument with current OSC user ID
/eos/out/wheel Float argument with current OSC wheel mode: 0.0=Coarse, 1.0=Fine
/eos/out/switch Float argument with current OSC wheel mode: 0.0=Coarse, 1.0=Fine

OSC Active Channels and Parameters
OSC Method Arguments/Comments

/eos/out/active/chan
String argument with active channels and current value from the 1st
channel
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OSC Method Arguments/Comments

/eos/out/active/wheel/<number>
String argument with parameter name and current value from the
1st channel: 0=Null/Unassigned, 1=Intensity, 2=Focus, 3=Color,
4=Image, 5=Form, 6=Shutter

Note: This allows you to create a ML Controls style interface via OSC. For example,
on the OSC-enabled device, setup 10 wheels (/eos/active/wheel/<1-10>) with
matching labels. If using in conjunction with “/eos/active/switch/<number>”, you
should still use “/ eos/out/active/wheel/<number>” to display feedback for that switch.

OSC Active Cue

Note: Updated once per second.

OSC Method Arguments/Comments
/eos/out/active/cue/<cue list
number>/<cue number>

Float argument with percent complete (0.0-1.0)

eos/out/active/cue Float argument with percent complete (0.0-1.0)

/eos/out/active/cue/text
String argument with descriptive text about the active cue,
ex: “1/ 2.3 Label 0:05 75%"

/eos/out/pending/cue/<cue list
number>/<cue number>

/eos/out/pending/cue/text
String argument with descriptive text about the pending cue,
ex: “1/2.4 Label 0:30"

OSC Direct Select Banks
OSC Method Arguments/Comments

/eos/out/ds/<index>
String argument with descriptive text for the OSC direct select at
<index>: target name, page number, and mode

/eos/out/ds/<index>/<button
index>

String argument with button label for OSC direct select at <index> for
button <button index>

OSC Fader Banks
OSC Method Arguments/Comments

/eos/out/fader/<index>
String argument with descriptive text for the OSC fader bank at
<index>

/eos/out/fader/<index>/<fader
index>/name

String argument with fader label for OSC fader bank at <index> for
fader <fader index>

/eos/fader/<index>/<fader
index>

Floating point number for fader percent: 0.0-1.0

Note: Eos will delay sending fader levels for faders that have been moved via OSC
commands for 3 seconds. If you move a fader on an OSC remote control, Eos will send
the actual fader level 3 seconds later.

OSC Show Control Events
Show control events are fired as the console executes the corresponding action, much like MIDI
Show Control output events.
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OSC Method Arguments/Comments
/eos/out/event/cue/<cue list number>/<cue
number>/fire
/eos/out/event/cue/<cue list number>/<cue
number>/stop

/eos/out/event/sub/<sub number>
Integer argument: 0=Bump Off,
1=Bump On

/eos/out/event/macro/<macro number>
/eos/out/event/relay/<relay number>/<group
number>

Integer argument: 0=On, 1=Off

/eos/out/event Used for Time Code learn

OSC Show File Information
OSC Method Arguments/Comments

/eos/out/show/name String argument with show title
/eos/out/event/show/saved String argument with file path
/eos/out/event/show/loaded String argument with file path
/eos/out/event/show/cleared

OSC Miscellaneous Console Events
OSC Method Arguments/Comments

/eos/out/event/state Integer argument: 0=Blind, 1=Live

Note: When Eos receives the command “/eos/ping” it will reply with “/eos/out/ping”.
You may optionally add any number of arguments and Eos will reply with the same
arguments. This may be useful for testing latency.
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Eos Family Show Control Capabilities

Note: Net3 Show Control Gateway has been abbreviated to SC GW for this table.

Device
Hardware
MIDI
Connections

MIDI Show

Control
(MSC)

MIDI Time
Code (MTC)

MIDI Notes SMPTE

Eos Titanium (Ti) Yes, In/Out

Local

In/Out

Also via SC

GW

Local

In Only Also
via SC GW

Local

Out Only Also
via SC GW

Via SC
GW In
Only

Eos Console No Via SC GW
Via SC GW
In Only

Via SC GW
Out Only

Via SC
GW In
Only

Eos RPU No Via SC GW
Via SC GW
In Only

Via SC GW
Out Only

Via SC
GW In
Only

Gio Yes, In/Out

Local

In/Out

Also via SC

GW

Local

In Only Also
via SC GW

Local

Out Only Also
via SC GW

Via SC
GW In
Only

Gio @ 5 No Via SC GW
Via SC GW
In Only

Via SC GW
Out Only

Via SC
GW In
Only

Ion Yes, In/Out

Local

In/Out

Also via SC

GW

Local

In Only Also
via SC GW

Local

Out Only Also
via SC GW

Via SC
GW In
Only

Ion RPU & Eos Family
RPU3

Yes, In/Out

Local

In/Out

Also via SC
GW

Or

Programming
Wing

(Win7 only)

Local

In Only Also
via SC GW

Or

Programming
Wing

(Win7 only)

Local

Out Only Also
via SC GW Or

Programming

Wing (Win7
only)

Via SC
GW In
Only

Element Yes, In/Out

Local

In/Out

Also via SC

GW

Local

In Only Also
via SC GW

Local

Out Only Also
via SC GW

Via SC
GW In
Only

ETCnomad (PC/Mac) No Via SC GW Via SC GW Via SC GW Via SC



Show Control 595

Device
Hardware
MIDI
Connections

MIDI Show

Control
(MSC)

MIDI Time
Code (MTC)

MIDI Notes SMPTE

and ETCnomad Puck

Or

Programming
Wing

In Only 

Or

Programming
Wing

Out Only 

Or

Programming
Wing

GW In
Only

Eos Programming
Wing

Yes, In/Out

Local 

In/Out 

Also via SC
GW

Local 

In Only Also
via SC GW

Local 

Out Only Also
via SC GW

Via SC
GW In
Only

Net3 Show Control
GW

Yes
In/Out/Thru

Yes In/Out Yes In Only Yes Out Only
Yes In
Only

Net3 I/O GW n/a n/a n/a n/a

Device Analog Contact Closure Relay Out RS-232
UDP

Strings

Eos Titanium (Ti)
Via I/O
GW

4 closures,
others via I/O

1 local SPDT,
others via I/O

Via I/O
GW

Rx &
Tx

Eos Console
Via I/O
GW

Via I/O GW Via I/O GW
Via I/O
GW

Rx &
Tx

Eos RPU
Via I/O
GW

Via I/O GW Via I/O GW
Via I/O
GW

Rx &
Tx

Gio
Via I/O
GW

4 closures,
others via I/O

1 local SPDT,
others via I/O

Via I/O
GW

Rx &
Tx

Gio @ 5
Via I/O
GW

4 closures,
others via I/O

1 local SPDT,
others via I/O

Via I/O
GW

Rx &
Tx

Ion
Via I/O
GW

4 closures,
others via I/O

1 local SPDT,
others via I/O

Via I/O
GW*

Rx &
Tx

Ion RPU & Eos Family RPU3
Via I/O
GW

4 closures,
others via I/O

1 local SPDT,
others via I/O

Via I/O
GW*

Rx &
Tx

ETCnomad (PC/Mac) and
ETCnomad Puck

Via I/O
GW

Via I/O GW Via I/O GW
Via I/O
GW

Rx &
Tx

Eos Programming Wing
Via I/O
GW

4 closures,
others via I/O

1 local SPDT,
others via I/O

Via I/O
GW

n/a

Element
Via I/O
GW

4 closures,
others via I/O

1 local SPDT,
others via I/O

Via I/O
GW

Rx &
Tx

Net3 Show Control GW n/a n/a n/a n/a n/a

Net3 I/O GW

Yes

24 shared circuits- analog or
digital

Yes 16 SPDT
relays

Yes
n/a

*Ion consoles that have a DVI splitter and any Ion RPU have a local RS-232 port that is not
enabled.  For questions, please contact ETC Technical Services. See Help from ETC Technical
Services (on page 3) to find the office closest to you.
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Advanced OSC

OSC List Convention
The OSC List convention is used to send OSC commands that may exceed 512 bytes of data.

To add an OSC List of items to an OSC Command, append the OSC Command Path with
/list/<index>/<count>, where <index> is the zero-based index offset into the entire list and
<total> is the total number of elements in the entire list.

Example:
• OSC List that fits in a single packet

/eos/out/get/curve/901/list/0/3 = <uint32: 0> <string: 0DF9082C-4A39-40FC-
9532-6C3AC01BC6B5> <string: IES Square>

• OSC List that spans 2 packets

/eos/out/get/curve/901/list/0/3 = <uint32: 0> <string: 0DF9082C-4A39-40FC-
9532-6C3AC01BC6B5> /eos/out/get/curve/901/list/2/3 = <string: IES Square>

OSC UID
UIDs uniquely identify each show data target, and are preserved in the show file.  This allows
you to synchronize with a show file once and then again at a later time, even if changes were
made in between.

UIDs will be specified as strings in the following format:

XXXXXXXX-XXXX-XXXX-XXXX-XXXXXXXXXXXX

Example:
• B0BAE0A0-3BBE-4004-888B-F61CA125D0B0

OSC Numbers and Number Ranges
OSC Arguments that contains numbers or number ranges will be sent as follows:

Eos target numbers will be sent as 32-bit integers when possible.  If they are not whole numbers
(ex: Cue 1.23), they will be sent as strings.

Example:
• 10
• “1.23"

When a range numbers contains 2 or more consecutive whole numbers, they will be represented
as strings in the following format:

X-Y

Example:
• “1-100”

OSC Gel
Gels will be represented as strings in the following format:
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<Gel Manufacturer Abbreviation><Gel Number>

Example:

“AP1150” (Apollo 1150)
“G101”  (Gam 101)
“L2” (Lee 2)
“R80”  (Rosco 80)
“SG1”  (Rosco Super Gel 1)
“E194”  (Rosco E Color 194)
“T12” (TokyoBS Poly Color 12)

Integrating Your App with Eos
There are four steps to integrating an OSC App with Eos.

Those steps are covered in the following topics:

• Integrating Your App with Eos: Step 1 – Request Eos Software Version (below)
• Integrating Your App with Eos: Step 2 - Synchronize (below)
• Integrating Your App with Eos: Step 3 – Staying in Sync (on page 599)
• Integrating Your App with Eos: Step 4 – Modifying Eos Show Data (on page 601)

Integrating Your App with Eos: Step 1 – Request Eos Software Version
Request the version number of the Eos by sending the following command: /eos/get/version.

Eos will reply with:

/eos/out/get/version = <string: X.X.X.X>

Example:
• <string: 2.3.0.111>

Note: This is useful if future versions of Eos software change the way OSC
integration commands are handled.

Integrating Your App with Eos: Step 2 - Synchronize
Request the number of items of a specific type of data you are interested with one of the
following commands:

• /eos/get/patch/count
• /eos/get/cuelist/count
• /eos/get/cue/<cue list number>/count
• /eos/get/group/count
• /eos/get/group/displayed/count
• /eos/get/macro/count
• /eos/get/sub/count
• /eos/get/preset/count
• /eos/get/ip/count (ip = Intensity Palette)
• /eos/get/fp/count (fp = Focus Palette)
• /eos/get/cp/count (cp = Color Palette)
• /eos/get/bp/count (bp = Beam Palette)
• /eos/get/curve/count
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• /eos/get/fx/count (fx = Effect)
• /eos/get/snap/count (snap = Snapshot)
• /eos/get/pixmap/count
• /eos/get/ms/count (ms = Magic Sheet)
• /eos/get/3dserver/count

Eos will reply with the matching command:

• /eos/out/get/patch/count = <uint32: count>
• /eos/out/get/cuelist/count = <uint32: count>
• /eos/out/get/cue/<cue list number>/count = <uint32: count>
• /eos/out/get/group/count = <uint32: count>
• /eos/out/get/group/displayed/count = <uint32: count>
• /eos/out/get/macro/count = <uint32: count>
• /eos/out/get/sub/count = <uint32: count>
• /eos/out/get/preset /count = <uint32: count>
• /eos/out/get/ip/count = <uint32: count>
• /eos/out/get/fp/count = <uint32: count>
• /eos/out/get/cp/count = <uint32: count>
• /eos/out/get/bp/count = <uint32: count>
• /eos/out/get/curve/count = <uint32: count>
• /eos/out/get/fx/count = <uint32: count>
• /eos/out/get/snap/count = <uint32: count>
• /eos/out/get/pixmap/count = <uint32: count>
• /eos/out/get/ms/count = <uint32: count>
• /eos/get/3dserver/count = <uint32: count>

Now you can request detailed information for each item from index 0 to count as follows:

• /eos/get/patch/index/<index number>
• /eos/get/cuelist/index/<index number>
• /eos/get/cue/<cue list number>/index/<index number>
• /eos/get/group/index/<index number>
• /eos/get/group/displayed/index/<index number>
• /eos/get/macro/index/<index number>
• /eos/get/sub/index/<index number>
• /eos/get/preset/index/<index number>
• /eos/get/ip/index/<index number>
• /eos/get/fp/index/<index number>
• /eos/get/cp/index/<index number>
• /eos/get/bp/index/<index number>
• /eos/get/curve/index/<index number>
• /eos/get/fx/index/<index number>
• /eos/get/snap/index/<index number>
• /eos/get/pixmap/index/<index number>
• /eos/get/ms/index/<index number>
• /eos/get/3dserver/index/<index number>

Eos will reply with the matching command: (detailed OSC arguments for each data type listed
below)

• /eos/out/get/patch/<channel number>/<part number>/list/<list index>/<list count> =
<uint32: list index> <string: UID> ...

• /eos/out /get/cuelist/<cue list number>/list/<list index>/<list count> = <uint32: list
index> <string: UID> ...
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• /eos/out /get/cue/<cue list number>/<cue number>/<cue part number>/list/<list
index>/<list count> = <uint32: list index> <string: UID> ...

• /eos/out/get/group/<group number>/list/<list index>/<list count> = <uint32: list index>
<string: UID> ...

• /eos/out/get/group/displayed/<group number>/list/<list index>/<list count> = <uint32:
list index> <string: UID> ...

• /eos/get/macro/<macro number>/list/<list index>/<list count> = <uint32: list index>
<string: UID> ...

• /eos/get/sub/<sub number>/list/<list index>/<list count> = <uint32: list index> <string:
UID> ...

• /eos/get/preset/<preset number>/list/<list index>/<list count> = <uint32: list index>
<string: UID> ...

• /eos/get/ip/<ip number>/list/<list index>/<list count> = <uint32: list index> <string:
UID> ...

• /eos/get/fp/<fp number>/list/<list index>/<list count> = <uint32: list index> <string:
UID> ...

• /eos/get/cp/<cp number>/list/<list index>/<list count> = <uint32: list index> <string:
UID> ...

• /eos/get/bp/<bp number>/list/<list index>/<list count> = <uint32: list index> <string:
UID> ...

• /eos/get/curve/<curve number>/list/<list index>/<list count> = <uint32: list index>
<string: UID> ...

• /eos/get/fx/<fx number>/list/<list index>/<list count> = <uint32: list index> <string:
UID> ...

• /eos/get/snap/<snap number>/list/<list index>/<list count> = <uint32: list index>
<string: UID> ...

• /eos/get/pixmap/<pixmap number>/list/<list index>/<list count> = <uint32: list index>
<string: UID> ...

• /eos/get/ms/<ms number>/list/<list index>/<list count> = <uint32: list index> <string:
UID> ...

• /eos/get/3dserver/<3dserver number>/list/<list index>/<list count> = <uint32: list
index> <string: UID> ...

Integrating Your App with Eos: Step 3 – Staying in Sync
Your app can now request all of the show data from Eos, but if a user is editing show data, your
app would become out of sync.  The solution to this is to subscribe to Eos show data changes
with the following command: /eos/subscribe = <uint32: X> (where 0=unsubscribe, 1=subscribe)

While subscribed, Eos will send the following commands when Eos show data changes:

In the reply, the first argument will be a sequence number, followed by a list of the targets that
changed.  The targets are specified OSC Numbers and / or OSC Number Ranges

• /eos/out/notify/patch/list/<list index>/<list count> = <uint32: sequence number>, ...
• /eos/out/notify/cuelist/list/<list index>/<list count> = <uint32: sequence number>, ...
• /eos/out/notify/cue/<cue list number>/list/<list index>/<list count> = <uint32: sequence

number>, ...
• /eos/out/notify/group/list/<list index>/<list count> = <uint32: sequence number>, ...
• /eos/out/notify/macro/list/<list index>/<list count> = <uint32: sequence number>, ...
• /eos/out/notify/sub/list/<list index>/<list count> = <uint32: sequence number>, ...
• /eos/out/notify/preset/list/<list index>/<list count> = <uint32: sequence number>, ...
• /eos/out/notify/ip/list/<list index>/<list count> = <uint32: sequence number>, ...
• /eos/out/notify/fp/list/<list index>/<list count> = <uint32: sequence number>, ...
• /eos/out/notify/cp/list/<list index>/<list count> = <uint32: sequence number>, ...
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• /eos/out/notify/bp/list/<list index>/<list count> = <uint32: sequence number>, ...
• /eos/out/notify/curve/list/<list index>/<list count> = <uint32: sequence number>, ...
• /eos/out/notify/fx/list/<list index>/<list count> = <uint32: sequence number>, ...
• /eos/out/notify/snap/list/<list index>/<list count> = <uint32: sequence number>, ...
• /eos/out/notify/pixmap/list/<list index>/<list count> = <uint32: sequence number>, ...
• /eos/out/notify/ms/list/<list index>/<list count> = <uint32: sequence number>, ...

When your app receives a notification that Eos show data has changed, you should then request
detailed information about the modified show data.  You may request detailed show data via
target number or UID.  (From the initial sync, you should be able to build a mapping of each type
of show data to correlate target number with UID)

Request detailed show data information via target number:

• /eos/get/patch/<channel number> (Eos returns ALL parts)
• /eos/get/patch/<channel number>/<part number> (specific channel part)
• /eos/get/cuelist/<cue list number>
• /eos/get/cue/<cue list number>/<cue number> (Eos returns base cue and ALL parts)
• /eos/get/cue/<cue list number>/<cue number>/0 (base cue)
• /eos/get/cue/<cue list number>/<cue number>/<cue part number> (specific cue part)
• /eos/get/group/<group number>
• /eos/get/macro/<macro number>
• /eos/get/sub/<sub number>
• /eos/get/preset/<preset number>
• /eos/get/ip/<ip number>
• /eos/get/fp/<fp number>
• /eos/get/cp/<cp number>
• /eos/get/bp/<bp number>
• /eos/get/curve/<curve number>
• /eos/get/fx/<fx number>
• /eos/get/snap/<snap number>
• /eos/get/pixmap/<pixmap number>
• /eos/get/ms/<ms number>

Request detailed show data information via UID:

• /eos/get/patch/uid/<UID>
• /eos/get/cuelist/uid/<UID>
• /eos/get/cue/uid/<UID>
• /eos/get/group/uid/<UID>
• /eos/get/group/displayed/uid/<UID>
• /eos/get/macro/uid/<UID>
• /eos/get/sub/uid/<UID>
• /eos/get/preset/uid/<UID>
• /eos/get/ip/uid/<UID>
• /eos/get/fp/uid/<UID>
• /eos/get/cp/uid/<UID>
• /eos/get/bp/uid/<UID>
• /eos/get/curve/uid/<UID>
• /eos/get/fx/uid/<UID>
• /eos/get/snap/uid/<UID>
• /eos/get/pixmap/uid/<UID>
• /eos/get/ms/uid/<UID>
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Eos will reply with the same command as if the detailed information were requested via index as
shown in Step 2.

Integrating Your App with Eos: Step 4 – Modifying Eos Show Data
You can modify Eos show data. Typically you should build Eos command lines and send them
with the command /eos/cmd or /eos/newcmd. 

However, you can use the following convenience commands for editing the most common show
data attributes:

• /eos/set/patch/<channel number>/label = <string: text> (include part number in the path
when necessary)

• /eos/set/patch/<channel number>/text1 = <string: text>
• /eos/set/patch/<channel number>/text2 = <string: text>
• /eos/set/patch/<channel number>/text3 = <string: text>
• /eos/set/patch/<channel number>/text4 = <string: text>
• /eos/set/patch/<channel number>/text5 = <string: text>
• /eos/set/patch/<channel number>/text6 = <string: text>
• /eos/set/patch/<channel number>/text7 = <string: text>
• /eos/set/patch/<channel number>/text8 = <string: text>
• /eos/set/patch/<channel number>/text9 = <string: text>
• /eos/set/patch/<channel number>/text10 = <string: text>
• /eos/set/patch/<channel number>/notes = <string: text>
• /eos/set/patch/<channel number>/gel = <string: text>
• /eos/set/cuelist/<cue list number>/label = <string: text>
• /eos/set/cue/<cue list number>/<cue number>/label = <string: text> (base data)
• /eos/set/cue/<cue list number>/<cue number>/<cue part number>/label = <string:

text> (part data)
• /eos/set/group/<group number>/label = <string: text>
• /eos/set/macro/<macro number>/label = <string: text>
• /eos/set/sub/<sub number>/label = <string: text>
• /eos/set/preset/<preset number>/label = <string: text>
• /eos/set/ip/<ip number>/label = <string: text>
• /eos/set/fp/<fp number>/label = <string: text>
• /eos/set/cp/<cp number>/label = <string: text>
• /eos/set/bp/<bp number>/label = <string: text>
• /eos/set/curve/<curve number>/label = <string: text>
• /eos/set/fx/<fx number>/label = <string: text>
• /eos/set/snap/<snap number>/label = <string: text>
• /eos/set/pixmap/<pixmap number>/label = <string: text>
• /eos/set/ms/<ms number>/label = <string: text>

Detailed Information Packet Contents

Note: < index> is only valid when detailed information is requested via /index (for
performance reasons)

PATCH (1 OF 2):

/eos/out/get/patch/<channel number>/<part number>/list/<list index>/<list count> =

<uint32: index>

<string: OSC UID>

<string: label>
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<string: fixture manufacturer>

<string: fixture model> 

<uint32: address>

<uint32: address of intensity parameter> (useful for monitoring streaming output to see live
levels)

<uint32: current level>

<string: OSC Gel>

<string: text 1>

<string: text 2>

<string: text 3>

<string: text 4>

<string: text 5>

<string: text 6>

<string: text 7>

<string: text 8>

<string: text 9>

<string: text 10>

<uint32: part count>

Example:
/eos/out/get/patch/1/1/list/0/20 = 0, “00000000-0000-0000-0000-
000000000000”, “My Fixture Label”, “ETC_Fixtures”, “S4_LED_S2_Lustr_
Direct”, 1, 1, 0, “R80”, “My_Text_One”, “My_Text_Two”, “My_Text_Three”,
“My_Text_Four“, “My_Text_Five”, “My_Text_Six”, “My_Text_Seven”, “My_
Text_Eight”, “My_Text_Nine”, “My_Text_Ten”, 1

PATCH (2 OF 2):

/eos/out/get/patch/<channel number>/<part number>/notes =

<uint32: index>

<string: OSC UID>

<string: notes>

Example:
/eos/out/get/patch/1/1/notes = 0, “00000000-0000-0000-0000-
000000000000”, “My Notes”

CUELIST (1 OF 2):

/eos/out /get/cuelist/<cue list number>/list/<list index>/<list count> = <uint32: index>

<string: OSC UID>

<string: label>

<string: playback mode>
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<string: fader mode> <bool: independent>

<bool: HTP>

<bool: assert>

<bool: block>

<bool: background>

<bool: solo mode>

<uint32: timecode list>

<bool: OOS sync>

Example:
/eos/out/get/cuelist/1/list/0/13 = 0, “00000000-0000-0000-0000-
000000000000”, “My Cue List One Label”, “Master”, “Proportional”, True,
False, True, False, False, False, 1, False

CUELIST (2 OF 2):

/eos/out /get/cuelist/<cue list number>/links/list/<list index>/<list count> =

<uint32: index>

<string: OSC UID>

<OSC Number Range: linked cue lists list>

Example:
/eos/out/get/cuelist/1/links/list/0/3 = 0, “00000000-0000-0000-0000-
000000000000”, 2

CUE (1 OF 4):

/eos/out /get/cue/<cue list number>/<cue number>/<cue part number>/list/<list index>/<list
count> =

<uint32: index>

<string: OSC UID>

<string: label>

<uint32: up time duration (ms)>

<uint32: up time delay (ms)>

<uint32: down time duration (ms)>

<uint32: down time delay (ms)>

<uint32: focus time duration (ms)>

<uint32: focus time delay (ms)>

<uint32: color time duration (ms)>

<uint32: color time delay (ms)>

<uint32: beam time duration (ms)>

<uint32: beam time delay (ms)>
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<bool: preheat>

<OSC Number: curve>

<uint32: rate>

<string: mark>

<string: block>

<string: assert>

<OSC Number: link> or <string: link> (string if links to a separate cue list)

<uint32: follow time (ms)>

<uint32: hang time (ms)>

<bool: all fade>

<uint32: loop>

<bool: solo>

<string: timecode>

<uint32: part count> (not including base cue, so zero for cues with no parts)

<notes>

<scene (text)>

<bool: scene end>

<cue part index> (-1 if not a part of a cue, the index otherwise)

Example:
/eos/out/get/cue/1/1/0/list/0/27 = 0, “00000000-0000-0000-0000-
000000000000”, “My Cue One Label”, 0, 0, 0, 0, 0, 0, 6000, 0, 0, 0, True,
901, 90, “”, “B”, “A”, 3, 0, 0, True, 1, False, “00:00:00:02”, 0

CUE (2 OF 4):

/eos/out /get/cue/<cue list number>/<cue number>/<cue part number>/fx/list/<list
index>/<list count> =

<uint32: index>

<string: OSC UID>

<OSC Number Range: effect list>

Example:
/eos/out/get/cue/1/1/0/fx/list/0/3 = 0, “00000000-0000-0000-0000-
000000000000”, “1-3”

CUE (3 OF 4):

/eos/out /get/cue/<cue list number>/<cue number>/<cue part number>/links/list/<list
index>/<list count> =

<uint32: index>

<string: OSC UID>
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<OSC Number Range: linked cue lists list>

Example:
/eos/out/get/cue/1/1/0/links/list/0/3 = 0, “00000000-0000-0000-0000-
000000000000”, 2

CUE (4 OF 4):

/eos/out /get/cue/<cue list number>/<cue number>/<cue part number>/actions/list/<list
index>/<list count> =

<uint32: index>

<string: OSC UID>

<string: ext link action>

Example:
/eos/out/get/cue/1/1/0/actions/list/0/3 = 0, “00000000-0000-0000-0000-
000000000000”, “Chan 90 At Full”

GROUP (1 OF 2):

/eos/get/group/<group number>/list/<list index>/<list count> =

<uint32: index>

<string: OSC UID>

<string: label>

Example:
/eos/out/get/group/1.2/list/0/3 = 0, “00000000-0000-0000-0000-
000000000000”, “My Group One Point Two Label”

GROUP (2 OF 2):

/eos/get/group/<group number>/channels/list/<list index>/<list count> = <uint32: index>

<string: OSC UID>

<string: label>

Example:
/eos/out/get/group/1.2/channels/list/0/5 = 0, “00000000-0000-0000-0000-
000000000000”, “1-100”, 200, 300

MACRO (1 OF 2):

/eos/get/macro/<macro number>/list/<list index>/<list count> =

<uint32: index>

<string: OSC UID>

<string: label>

<string: mode>
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Example:
/eos/out/get/macro/1/list/0/4 = 0, “00000000-0000-0000-0000-
000000000000”, “My Macro One Label”, “”

MACRO (2 OF 2):

/eos/get/macro/<macro number>/text/list/<list index>/<list count> =

<uint32: index>

<string: OSC UID>

<string: command text>  (split into multiple packets via OSC List convention if necessary)

Example:
/eos/out/get/macro/1/text/list/0/3 = 0, “00000000-0000-0000-0000-
000000000000”, “Go_To_Cue Out Time 0”

SUB (1 OF 2):

/eos/get/sub/<sub number>/list/<list index>/<list count> =

<uint32: index>

<string: OSC UID>

<string: label>

<string: mode>

<string: fader mode>

<bool: HTP>

<bool: exclusive>

<bool: background>

<bool: restore>

<string: priority>

<string: up time>

<string: dwell time>

<string: down time>

Example:
/eos/out/get/sub/3/list/0/13 = 0, “00000000-0000-0000-0000-
000000000000”, “My Sub Three Label”, “Additive”, “Proportional”, True,
False, True, False, “”, “0”, “Man”, “0”

SUB (2 OF 2):

/eos/get/sub/<sub number>/fx/list/<list index>/<list count> =

<uint32: index>

<string: OSC UID>

<OSC Number Range: effect list>
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Example:
/eos/out/get/sub/3/fx/list/0/3 = 0, “00000000-0000-0000-0000-
000000000000”, 10

PRESET (1 OF 4):

/eos/get/preset/<preset number>/list/<list index>/<list count> =

<uint32: index>

<string: OSC UID>

<string: label>

<bool: absolute>

<bool: locked>

Example:
/eos/out/get/preset/10/list/0/5 = 0, “00000000-0000-0000-0000-
000000000000”, “My Preset Ten Label”, True, True

PRESET (2 OF 4):

/eos/get/preset/<preset number>/channels/list/<list index>/<list count> =

<uint32: index>

<string: OSC UID>

<OSC Number Range: channel list>

Example:
/eos/out/get/preset/10/channels/list/0/3 = 0, “00000000-0000-0000-0000-
000000000000”, “1-5”

PRESET (3 OF 4):

/eos/get/preset/<preset number>/byType/list/<list index>/<list count> =

<uint32: index>

<string: OSC UID>

<OSC Number Range: by type channel list>

Example:
/eos/out/get/preset/10/byType/list/0/2 = 0, “00000000-0000-0000-0000-
000000000000”

PRESET (4 OF 4):

/eos/get/preset/<preset number>/fx/list/<list index>/<list count> =

<uint32: index>

<string: OSC UID>

<OSC Number Range: effect list>
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Example:
/eos/out/get/preset/10/fx/list/0/0 = 0, “00000000-0000-0000-0000-
000000000000”

PALETTE (1 OF 3):

/eos/get/<palette type>/<palette number>/list/<list index>/<list count> =

<uint32: index>

<string: OSC UID>

<string: label>

<bool: absolute>

<bool: locked>

Example:
/eos/out/get/ip/1/list/0/5 = 0, “00000000-0000-0000-0000-000000000000”,
“My IP One Label”, False, False

PALETTE (2 OF 3):

/eos/get/<palette type>/<palette number>/channels/list/<list index>/<list count> =

<uint32: index>

<string: OSC UID>

<OSC Number Range: channel list>

Example:
/eos/out/get/ip/1/channels/list/0/3 = 0, “00000000-0000-0000-0000-
000000000000”, 1-5(s)

PALETTE (3 OF 3):

/eos/get/<palette type>/<palette number>/byType/list/<list index>/<list count> =

<uint32: index>

<string: OSC UID>

<OSC Number Range: by type channel list>

Example:
/eos/out/get/ip/1/byType/list/0/2 = 0, “00000000-0000-0000-0000-
000000000000”

CURVE (1 OF 1):

/eos/get/curve/<curve number>/list/<list index>/<list count> =

<uint32: index>

<string: OSC UID>

<string: label>
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Example:
/eos/out/get/curve/901/list/0/2 = 0, “00000000-0000-0000-0000-
000000000000”, “IES Square”

EFFECT (1 OF 1):

/eos/get/fx/<fx number>/list/<list index>/<list count> =

<uint32: index>

<string: OSC UID>

<string: label>

<string: effect type>

<string: entry>

<string: exit>

<string: duration>

<uint32: scale>

Example:
/eos/out/get/fx/901/list/0/8 = 0, “00000000-0000-0000-0000-000000000000”,
“Circle”, “Focus”, “Immediate”, “Immediate”, “Infinite”, 25

SNAPSHOT (1 OF 1):

/eos/get/snap/<snap number>/list/<list index>/<list count> =

<uint32: index>

<string: OSC UID>

<string: label>

Example:
/eos/out/get/snap/1/list/0/2 = 0, “00000000-0000-0000-0000-
000000000000”, “My Snap One Label”

PIXEL MAP (1 OF 2):

/eos/get/pixmap/<pixmap number>/list/<list index>/<list count> =

<uint32: index>

<string: OSC UID>

<string: label>

<uint32: server channel>

<string: interface>

<uint32: width>

<uint32: height>

<uint32: pixel count>

<uint32: fixture count>
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Example:
/eos/out/get/pixmap/1/list/0/9 = 0, “00000000-0000-0000-0000-
000000000000”, “My Pixmap One Label”, 100, “sACN”, 32, 32, 1024, 1024

PIXEL MAP (2 OF 2):

/eos/get/pixmap/<pixmap number>/channels/list/<list index>/<list count> =

<uint32: index>

<string: OSC UID>

<OSC Number Range: layer channel list>

Example:
/eos/out/get/pixmap/1/channels/list/0/3 = 0, “00000000-0000-0000-0000-
000000000000”, “101-105”

MAGIC SHEET (1 OF 1):

/eos/get/ms/<ms number>/list/<list index>/<list count> =

<uint32: index>

<string: OSC UID>

<string: label>

Example:
/eos/out/get/ms/1/list/0/2 = 0, “00000000-0000-0000-0000-000000000000”,
“My MS One Label”

OSC Troubleshooting
In Eos, open the Diagnostics tab (Hold [Tab] and press [9][9]). Click {Incoming OSC} to enable
logging of incoming OSC commands and {Outgoing OSC} to log outgoing OSC commands.

To verify that basic OSC communication is working, you may send the command /eos/ping and
Eos will reply with /eos/out/ping.  You may also add any number of arguments to the command,
for example, if you want to measure latency.
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Eos OSC Keys
The following is a list of the supported key names for use with OSC:

/eos/key/ Internal Eos Command
( CHAN_SUBGROUP_BEGIN
) CHAN_SUBGROUP_END
+ PLUS
- MINUS
. POINT
\ SLASH
: COLON
@ AT
+% PLUS10
-% MINUS10
0 0
1 1
2 2
3 3
4 4
5 5
6 6
7 7
8 8
9 9
100_channel_display 100_CHANNEL_DISPLAY
_last SLOTLAST
_next SLOTNEXT
a DIMMER_A
about ABOUT
absolute ABSOLUTE_EFFECT
acn_device_disconnect ACN_DEVICE_DISCONNECT
action ACTION
add_favorite PATCH_ADD_FAVORITE
addfiltercat ADD_FILTER_CAT
addfilterparam ADD_FILTER_PARAM
additive ADDITIVE
address ADDRESS
after_sunrise RTC_AFTER_SUNRISE
after_sunset RTC_AFTER_SUNSET
all UPDATE_ALL
all_speed ALL_SPEED_PARAMS
all_workspaces ALL_WORKSPACES
allfade ALLFADE
allnps ALL_NIPS
alternate ALTERNATE
always_absolute ABSOLUTE_PALETTE
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/eos/key/ Internal Eos Command
analog ANALOG
analog_input ANALOG_INPUT
and AND
apply EFFECT_PATTERN_APPLY
arrow_down ARROW_DOWN
arrow_left ARROW_LEFT
arrow_right ARROW_RIGHT
arrow_up ARROW_UP
artnet ARTNET_INTERFACE
ascii_case ASCII_CASE
ascii_delims ASCII_DELIMS
ascii_levels ASCII_LEVELS
ascii_manuf ASCII_MANUF
assert ASSERT
asserttime ASSERT_TIME
at AT_TEXT
attach ATTACH_DEVICE
attribute_mode CIAPATCH_ATTRIB_MODE
attributes EFFECT_ATTRIBUTES
attributewheel ATTRIBUTE_WHEEL
auto_dim COLOR_FADE_AUTO_BRIGHTNESS
autoblock_clean AUTOBLOCK_CLEANUP
automark AUTO_MARK
automark_off AUTOMARK_OFF
autoplayback AUTOPLAYBACK
autosave AUTOSAVE
autosavetime AUTOSAVE_TIME
avab/udp AVAB_INTERFACE
axis AXIS
b DIMMER_B
back BACK
background BACKGROUND_FADER
background_mode MACRO_BACKGROUND
backspace BACKSPACE
backtime BACK_TIME
beam BEAM_CAT
beam_palette BEAM_PALETTE
before_sunrise RTC_BEFORE_SUNRISE
before_sunset RTC_BEFORE_SUNSET
blackout BLACKOUT_BUTTON
blackout_enable BLACKOUT_ENABLE
blind PREVIEW
block BLOCK
bounce BOUNCE
bpm BPM
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/eos/key/ Internal Eos Command
break_nested BREAK_NESTED
break_nested_off BREAK_NESTED_OFF
build BUILD
bump SC_BUMP
bump_1 BUMP01
bump_10 BUMP10
bump_2 BUMP02
bump_3 BUMP03
bump_4 BUMP04
bump_5 BUMP05
bump_6 BUMP06
bump_7 BUMP07
bump_8 BUMP08
bump_9 BUMP09
by_type BY_TYPE_PALETTE
calibrate CALIBRATE
can't_be CANT_BE
can_be CAN_BE
cancel_command CANCEL
capture CAPTURE
cascade_entry CASCADE_ENTRY
cascade_exit CASCADE_EXIT
center FAN_CENTER
chan CHAN
chan_per_group FAN_CHANNELS_PER_GROUP
channel_filter CHANNEL_FILTER
channelfader CHANNEL_FADER
channelparam CHANNEL_PARAM
check CHANNEL_CHECK
cia_softkey1 CIA_SOFTKEY1
cia_softkey2 CIA_SOFTKEY2
cia_softkey3 CIA_SOFTKEY3
cia_softkey4 CIA_SOFTKEY4
cia_softkey5 CIA_SOFTKEY5
cia_softkey6 CIA_SOFTKEY6
cie_xyy COLOR_FADE_CIE_XYY
cleanup CLEANUP_PALETTE
clear CLEAR_DATA
clear_all CLEAR_ALL
clear_all_tabs CLEAR_ALL_TABS
clear_all_visible_tabs CLEAR_ALL_VISIBLE_TABS
clear_all_workspace_tabs CLEAR_ALL_WORKSPACE_TABS
clear_calibration CLEAR_CALIBRATION
clear_cmd CLEAR
clear_cmdline RESET_COMMAND_LINE
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clear_effect EFFECT_PATTERN_CLEAR
clear_errors DIMRACK_CLR_ERRS
clear_filters CLEAR_FILTER_COMMAND
clear_hold_color_point_origin CLEAR_HOLD_COLOR_POINT_ORIGIN
clear_midi CLEAR_MIDI
clear_module SS_CLEAR
clear_patch CLEAR_PATCH
clear_rig_check DIMRACK_CLR_RIG_CHK
clear_show CLEAR_SHOW
clear_smpte CLEAR_SMPTE
clear_subs_1to1_ CLEAR_SUBS_1TO1
clear_targets CLEAR_TARGETS
clear_text CLEAR_TEXT
close OFFSET_CIA_CLOSE
close_fader_controls CLOSE_FADER_CONTROLS
cluster FAN_CLUSTER
cmy COLOR_FADE_CMY
color COLOR_CAT
color_effect COLOR_EFFECT
color_fade_times COLOR_FADE_TIMES
color_fade_type COLOR_FADE_TYPE
color_gel COLOR_GEL
color_gel_match_hybrid COLOR_GEL_MATCH_HYBRID
color_gel_match_spectrum COLOR_GEL_MATCH_SPECTRUM
color_palette COLOR_PALETTE
color_path COLOR_PATH
color_scrub COLOR_SCRUB
color_scrub_replay COLOR_SCRUB_REPLAY
column_move_left COLUMN_MOVE_LEFT
column_move_right COLUMN_MOVE_RIGHT
column_resize_larger COLUMN_RESIZE_LARGER
column_resize_smaller COLUMN_RESIZE_SMALLER
command_history OPENCMDHISTORY
commandline_on_psd CMDLNONPSD
complete GOTO_CUE_COMPLETE
confirm_command CONFIRMED
continuous_run CONTINUOUS_RUN
control CONTROL_CAT
control_cat CONTROL_FILTER
copy_to COPY_TO
create_type NEW_EFFECT_TYPE
create_virtual_hsb CREATE_VIRTUAL_HSB
cue CUE
cue_beam_time SETUP_CUE_BEAM_TIME
cue_color_time SETUP_CUE_COLOR_TIME



Show Control 615

/eos/key/ Internal Eos Command
cue_down_time SETUP_CUE_DOWN_TIME
cue_focus_time SETUP_CUE_FOCUS_TIME
cue_list SFF_CUELIST
cue_sheet CUE_SHEET
cue_up_time SETUP_CUE_UP_TIME
cueonly Q_ONLY
cueonlytrack CUE_ONLY_TRACK
cues SFF_CUES
curve CURVE
curve_edit EDIT_CONTROL
curves SFF_CURVES
cycles NUM_CYCLES
cycletime CYCLE_TIME
data DATA
data_mode_latch DATA_MODE_LATCH
database_mode CIAPATCH_DB_MODE
date RTC_DATE
days RTC_DAYS
decaytime EFFECT_STEP_OUT_TIME
default DEFAULT_INTERFACE
default_mode MACRO_DEFAULT_MODE
degrees_per_rev ENCODER_DEGREES_PER_REVOLUTION
delay DELAY
delete DELETE
delete_device DELETE_DEVICE
delete_effect DELETE_EFFECT
deleteconfirm DELETE_CONFIRM
console_settings DESK_SETTINGS
detach DETACH_DEVICE
device_clear_errors DEVICE_CLEAR_ERRORS
device_dimmers CIAPATCH_DEVICE_DIMMERS
device_disconnected DEV_DISCONNECT
device_discovered DEV_DISCOVERED
device_discovery RDM_DISCOVERY_ENABLED
device_errors DEVICE_ERRORS
device_ignore_errors DEVICE_IGNORE_ERRORS
device_lamp_controls DEVICE_LAMP_CONTROLS
device_mode CIAPATCH_DEVICE_MODE
device_properties DEVICE_PROPERTIES
device_rdm CIAPATCH_DEVICE_RDM
device_sensors DEVICE_SENSORS
device_system CIAPATCH_DEVICE_SYSTEM
dimmer_double_offset DIM_DOUBLE_OFFSET
direct_selectdc_recall_from DIRECTSELECTDCRECALLFROM
direct_selects SNAPSHOT_DIRECT_SELECTS
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disable DISABLE
disconnect_macro DISCONNECT_MACRO
discrete DISCRETE_PALETTE
display_beam_palettes SS_DISPLAY_GX_PALETTES
display_channels SS_DISPLAY_CHANNELS
display_color_palettes SS_DISPLAY_COL_PALETTES
display_color_path DISPLAY_COLOR_PATH_MODE
display_color_path_mode_latch DISPLAY_COLOR_PATH_MODE_LATCH
display_effects SS_DISPLAY_RCES
display_focus_palettes SS_DISPLAY_POS_PALETTES
display_groups SS_DISPLAY_GROUPS
display_intensity_palettes SS_DISPLAY_INT_PALETTES
display_macros SS_DISPLAY_MACROS
display_magic_sheets SS_DISPLAY_MAGICSHEETS
display_palettes SS_DISPLAY_PALETTES
display_presets SS_DISPLAY_PRESETS
display_snapshots SS_DISPLAY_SNAPSHOTS
display_time_mode_latch DISPLAY_TIME_MODE_LATCH
display_timing DISPLAY_TIME_MODE
displays DISPLAYS
dmx DMX_LEVEL
dmx_ DMX_INTERFACE
dmx_patch SFF_DMXPATCH
done DONE
douse DOUSE
down DOWN
duration EFFECT_DURATION
duration DURATION_NUM_CYCLES
dwell DWELL
earliest EARLIEST
earliest_m EARLIEST_MARK_CUE
edit EDIT
edit_frame EDIT_FRAME
edit_mode EDIT_MODE
edit_target TARGET_EDIT_EVENT
edmx EDMX
effect EFFECT
effect_axis_wheel EFFECT_AXIS_WHEEL
effect_edit EFFECT_PATTERN_EDIT
effect_form_horizontal_wheel EFFECT_FORM_HORIZONTAL_WHEEL
effect_form_vertical_wheel EFFECT_FORM_VERTICAL_WHEEL
effect_rate_wheel EFFECT_RATE_WHEEL
effect_rotate_wheel EFFECT_ROTATE_WHEEL
effect_scale_wheel EFFECT_SCALE_WHEEL
effect_shape_horizontal_wheel EFFECT_SHAPE_HORIZONTAL_WHEEL
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effect_shape_vertical_wheel EFFECT_SHAPE_VERTICAL_WHEEL
effect_size_wheel EFFECT_SIZE_WHEEL
effect_time_wheel EFFECT_TIME_WHEEL
effects SFF_EFFECTS
effectsub EFFECT_SUB
element_bump_1 ELEMENT_BUMP_1
element_bump_10 ELEMENT_BUMP_10
element_bump_11 ELEMENT_BUMP_11
element_bump_12 ELEMENT_BUMP_12
element_bump_13 ELEMENT_BUMP_13
element_bump_14 ELEMENT_BUMP_14
element_bump_15 ELEMENT_BUMP_15
element_bump_16 ELEMENT_BUMP_16
element_bump_17 ELEMENT_BUMP_17
element_bump_18 ELEMENT_BUMP_18
element_bump_19 ELEMENT_BUMP_19
element_bump_2 ELEMENT_BUMP_2
element_bump_20 ELEMENT_BUMP_20
element_bump_21 ELEMENT_BUMP_21
element_bump_22 ELEMENT_BUMP_22
element_bump_23 ELEMENT_BUMP_23
element_bump_24 ELEMENT_BUMP_24
element_bump_25 ELEMENT_BUMP_25
element_bump_26 ELEMENT_BUMP_26
element_bump_27 ELEMENT_BUMP_27
element_bump_28 ELEMENT_BUMP_28
element_bump_29 ELEMENT_BUMP_29
element_bump_3 ELEMENT_BUMP_3
element_bump_30 ELEMENT_BUMP_30
element_bump_31 ELEMENT_BUMP_31
element_bump_32 ELEMENT_BUMP_32
element_bump_33 ELEMENT_BUMP_33
element_bump_34 ELEMENT_BUMP_34
element_bump_35 ELEMENT_BUMP_35
element_bump_36 ELEMENT_BUMP_36
element_bump_37 ELEMENT_BUMP_37
element_bump_38 ELEMENT_BUMP_38
element_bump_39 ELEMENT_BUMP_39
element_bump_4 ELEMENT_BUMP_4
element_bump_40 ELEMENT_BUMP_40
element_bump_41 ELEMENT_BUMP_41
element_bump_42 ELEMENT_BUMP_42
element_bump_43 ELEMENT_BUMP_43
element_bump_44 ELEMENT_BUMP_44
element_bump_45 ELEMENT_BUMP_45
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element_bump_46 ELEMENT_BUMP_46
element_bump_47 ELEMENT_BUMP_47
element_bump_48 ELEMENT_BUMP_48
element_bump_49 ELEMENT_BUMP_49
element_bump_5 ELEMENT_BUMP_5
element_bump_50 ELEMENT_BUMP_50
element_bump_51 ELEMENT_BUMP_51
element_bump_52 ELEMENT_BUMP_52
element_bump_53 ELEMENT_BUMP_53
element_bump_54 ELEMENT_BUMP_54
element_bump_55 ELEMENT_BUMP_55
element_bump_56 ELEMENT_BUMP_56
element_bump_57 ELEMENT_BUMP_57
element_bump_58 ELEMENT_BUMP_58
element_bump_59 ELEMENT_BUMP_59
element_bump_6 ELEMENT_BUMP_6
element_bump_60 ELEMENT_BUMP_60
element_bump_7 ELEMENT_BUMP_7
element_bump_8 ELEMENT_BUMP_8
element_bump_9 ELEMENT_BUMP_9
element_pos_1 ELEMENT_POS_1
element_pos_2 ELEMENT_POS_2
element_pos_3 ELEMENT_POS_3
element_pps_4 ELEMENT_POS_4
enable ENABLE
encoder_1 ENCODER1
encoder_2 ENCODER2
encoder_3 ENCODER3
encoder_4 ENCODER4
encoder_5 ENCODER5
encoder_6 ENCODER6
encoder_category_color ENCODER_CAT_COLOR
encoder_category_custom ENCODER_CAT_CUSTOM
encoder_category_focus ENCODER_CAT_SPARE
encoder_category_form ENCODER_CAT_BEAM
encoder_category_image ENCODER_CAT_GRAPHIC
encoder_category_intensity ENCODER_CAT_OTHER
encoder_category_shutter ENCODER_CAT_SHUTTER
encoder_ext_1 ENCODER_EXT_1
encoder_ext_2 ENCODER_EXT_2
encoder_ext_3 ENCODER_EXT_3
encoder_ext_4 ENCODER_EXT_4
encoder_ext_5 ENCODER_EXT_5
encoder_ext_6 ENCODER_EXT_6
encoder_flexi ENCODER_FLEXI
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encoder_lockout ENCODER_LOCKOUT
encoder_mode_1 ENCODER_MODE_1
encoder_mode_2 ENCODER_MODE_2
encoder_mode_3 ENCODER_MODE_3
encoder_mode_4 ENCODER_MODE_4
encoder_mode_5 ENCODER_MODE_5
encoder_wheel_move ENCODER_WHEEL_MOVE
encoders SNAPSHOT_ENCODERS
end_query QUERY_COMPLETE
enter ENTER
entry ENTRY_MODE
entrytime ENTRY_TIME
escape ESCAPE
even EVEN
even_effect EFFECT_EVEN
event SC_EVENT
eventlist SC_EVENT_LIST
exclusive EXCLUSIVE
execute EXECUTE
exit EXIT_MODE
exittime EXIT_TIME
expand EXPAND
expand_collapse_left EXPAND_COLAPSE_LEFT
expand_collapse_up EXPAND_COLAPSE_UP
expand_down EXPAND_DOWN
expand_right EXPAND_RIGHT
export_file EXPORTFILE
export_folder EXPORTFOLDER
export_media EXPORTMEDIA
external EXTERNAL
external_relationship EXTERNAL_RELATIONSHIP
fade_by_rate FADE_BY_RATE
fade_by_size FADE_BY_SIZE
fade_by_size_and_rate FADE_BY_SIZE_AND_RATE
fader SC_SUB_FADER
fader_1 FADER01
fader_10 FADER10
fader_2 FADER02
fader_3 FADER03
fader_4 FADER04
fader_5 FADER05
fader_6 FADER06
fader_7 FADER07
fader_8 FADER08
fader_9 FADER09
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fader_ab FADER_AB
fader_assert SLIDER_ASSERT
fader_control FADER_CONTROLS
fader_display FADER_DISPLAY
fader_mode FADER_MODE
fader_off FADER_OFF
fader_page_back FADER_PAGE_BACK
fader_pages FADER_PAGES
fader_rate FADER_RATE
fadermodule_1_connected SLIDER_MODULE1_CONNECTED
fadermodule_2_connected SLIDER_MODULE2_CONNECTED
fadermodule_3_connected SLIDER_MODULE3_CONNECTED
faderpagepress FADER_PAGE_DOWN
faderpagerelease FADER_PAGE_UP
faders SNAPSHOT_SLIDERS
faderwing_page FADER_PAGE_WING
fan_ FAN
fan_curve FAN_CURVE
feedback_errors SFF_ERRORS
filter FILTER
filter_mode FILTER_MODE
filters SNAPSHOT_FILTERS
fine FINE
finewheel FINE_WHEEL
finewheelandencoderbutton FINE_WHEEL_AND_ENCODER_BUTTON
first_time START_TIME
fixtures SFF_FIXTURELIST
flash DIMMER_FLASH
flash_off FLASH_OFF
flash_on FLASH_ON
flexi_all FLEXI_ALL
flexi_channel_partition_toggle FLEXI_PARTITION_TOGGLE
flexi_in_use FLEXI_ACTIVE
flexi_manual FLEXI_MANUAL
flexi_moved FLEXI_MOVED
flexi_patch FLEXI_PATCH
flexi_selected FLEXI_SEL
flexi_show FLEXI_SHOW
flexi_time FLEXI_TIME
flexichannel_mode FLEXI_MODE
flip FLIP
flip_h PIXELMAP_FLIP_HORIZONTAL
flip_v PIXELMAP_FLIP_VERTICAL
focus FOCUS_CAT
focus_effect FOCUS_EFFECT
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focus_palette FOCUS_PALETTE
follow FOLLOW
force_grandmaster_move FORCE_GRANDMASTER_MOVE
foreground_mode MACRO_USER
form FORM_CAT
format FORMAT
forward FORWARD
frame_rate FRAME_RATE
freeze PLAYBACK_FREEZE
friday RTC_FRIDAY
full FULL
gel DB_GEL
gel_ COLOR_FADE_GEL_SIM
gel_match_setting_brightest GEL_MATCH_BRIGHTEST_SETTING
gel_match_setting_hybrid GEL_MATCH_HYBRID_SETTING
gel_match_setting_spectrum GEL_MATCH_SPECTRUM_SETTING
gio_encoder_display GIO_ENCODER_DISPLAY
global GLOBAL_PALETTE
gm_exempt GM_EXEMPT
go PLAYBACK_GO (Master Fader)
go_0 GO (Master Fader)
go_to_cue GO_TO_CUE
go_to_cue_0 FADER_GO_TO_CUE_0
gocue0 PLAYBACK_CUE_ZERO
gotocue PLAYBACK_GOTOCUE
gotocuetime GOTO_CUE_TIME
grandmaster GRANDMASTER_MOVE
greater_than GREATER_THAN
group GROUP
group_channels_by_5 GROUP_CHANNELS_BY_5
grouping GROUPING
groups SFF_GROUPS
hang HANG
haptic_encoder_wheel_move HAPTIC_ENCODER_WHEEL_MOVE
haptic_level_wheel_move HAPTIC_LEVEL_WHEEL_MOVE
haptic_rate_wheel_move HAPTIC_RATE_WHEEL_MOVE
hard_poweroff HARD_POWEROFF
height PIXEL_HEIGHT
help HELP
hform HORIZ_FORM
hide_cia CIA_HIDE
hide_mouse HIDE_MOUSE
high_contrast_displays HIGH_CONTRAST_DISPLAYS
highlight HIGHLIGHT
highlight_append HIGHLIGHT_APPEND
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highlight_preset HIGHLIGHT_PRESET
highlight_remdim HIGHLIGHT_REM_DIM
hold HOLD
home HOME
home_preset HOME_PRESET
hs COLOR_FADE_HS
htp HTP
htp_ ONLY_HTP
image IMAGE_CAT
import_all_media IMPORTALLMEDIA
import_ascii_file IMPORTASCIIFILE
import_asciifile_custom IMPORTASCIIFILE_CUSTOM
import_file IMPORTFILE
import_gobo IMPORTGOBO
import_path IMPORT_PATH
import_show_media IMPORTSHOWMEDIA
in_time TIME_EFFECT
include_color_fade INCLUDE_COLOR_FADE
independent INDEPENDENT
infinite EFFECT_INFINITE
inhibitive INHIBITIVE
input_string SC_INPUT_STRING
insert INSERT
insert_after INSERT_AFTER
insert_before INSERT_BEFORE
insert_channel INSERT_CHANNEL
int INT
intensity INTENSITY_CAT
intensity_block INTENSITY_BLOCK
intensity_master INTENSITY_MASTER
intensity_palette INTENSITY_PALETTE
intensitydown INTENSITY_DOWN
intensityup INTENSITY_UP
interface INTERFACE
interleave FAN_INTERLEAVE
internal INTERNAL
interpolate INTERPOLATE
intime EFFECT_STEP_IN_TIME
intime_effect INTIME_EFFECT
invert PIXELMAP_SELECT_INVERT
invert_pan INVERT_PAN
invert_tilt INVERT_TILT
ion_encoder_1 ION_ENCODER_1
ion_encoder_2 ION_ENCODER_2
ion_encoder_3 ION_ENCODER_3
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ion_encoder_4 ION_ENCODER_4
is_in IS_IN
isn't_in ISNT_IN
jump FAN_JUMP
keyboard_shortcuts KEYBOARD_SHORTCUTS
keywords KEYWORDS
label LABEL
lamp_control LAMP_CONTROLS
lamp_controls_edit CIAPATCH_LAMPCMDS
lamp_ctrls LAMP_CONTROL_KEYS
lamp_on LAMP_ON
landscape LANDSCAPE
last LAST
last_ref LAST_REF
last_ref_off LAST_REF_OFF
last_time END_TIME
layer_chan LAYER_CHAN
ld_flags PATCH_LD_FLAGS
learn LEARN
learn_time_discrete_steps LEARN_DISCRETE_TIME
learn_time_sample_bpm LEARN_TIME
left_side_sk_1 LEFT_SIDE_SK_1
left_side_sk_2 LEFT_SIDE_SK_2
left_side_sk_3 LEFT_SIDE_SK_3
left_side_sk_4 LEFT_SIDE_SK_4
left_side_sk_5 LEFT_SIDE_SK_5
left_side_sk_6 LEFT_SIDE_SK_6
left_side_sk_7 LEFT_SIDE_SK_7
less_than LESS_THAN
level LEVEL
level_ VALUE
level_wheel_move LEVEL_WHEEL_MOVE
lightwright LW_FIELDS
linear LINEAR_EFFECT
link LINK
list_partition CUE_PARTITION
listview LIST_VIEW
live LIVE
live_ FROM_LIVE
live_remdim_level REM_DIM_LEVEL
load LOAD_PLAYBACK
loadcue LOAD
loadforgo LOAD_AS_ENTER
lock LOCKED_PALETTE
loop LOOP
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lowlight_preset LOWLIGHT_PRESET
ltp LTP
luminaire LUMINAIRE
macro MACRO
macro_1 MACRO1
macro_2 MACRO2
macro_3 MACRO3
macro_4 MACRO4
macro_5 MACRO5
macro_6 MACRO6
macro_7 MACRO7
macro_8 MACRO8
macro_801 MACRO_801
macro_802 MACRO_802
macro_803 MACRO_803
macro_804 MACRO_804
macro_805 MACRO_805
macro_806 MACRO_806
macro_807 MACRO_807
macro_808 MACRO_808
macro_809 MACRO_809
macro_810 MACRO_810
macro_811 MACRO_811
macro_812 MACRO_812
macro_813 MACRO_813
macro_814 MACRO_814
macro_815 MACRO_815
macro_816 MACRO_816
macro_817 MACRO_817
macro_818 MACRO_818
macro_819 MACRO_819
macro_820 MACRO_820
macro_button MACRO_STAR
macro_entry_delete MACRO_ENTRY_DELETE
macro_loop_begin MACRO_LOOP_BEGIN
macro_loop_end MACRO_LOOP_END
macro_loop_num MACRO_LOOP_NUM_BEGIN
macro_mode MACRO_MODE
macro_wait MACRO_WAIT
macros SFF_MACROS
magic_sheet MAGIC_SHEET
magic_sheet_apply MAGICSHEET_APPLY
magic_sheet_edit MAGICSHEET_EDIT
magic_sheet_recall MAGICSHEET_RECALL
magic_sheets SFF_MAGICSHEETS
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make_absolute MAKE_ABSOLUTE
make_manual MAKE_MANUAL
make_null MAKE_NULL
manual MANUAL
manual_master MANUAL_MASTER
manual_override MANUAL_OVERRIDE
mark MARK
mark_cue_designation MARK_CUE_DESIGNATION
mark_time MARK_TIME
marks DELAY_MARKS
media SFF_RESOURCELIST
midi MIDI
midi_cue_list MIDI_CUELIST
midi_raw MIDI_STRING
miditimecode MIDI_TC
min MIN
minimum RESTORE_MINIMUM
minus_links MINUS_LINKS
mirror_in FAN_MIRROR_IN
mirror_mode MIRROR
mirror_out FAN_MIRROR_OUT
module_1_connected MODULE1_CONNECTED
module_1_disconnected MODULE1_DISCONNECTED
module_2_connected MODULE2_CONNECTED
module_2_disconnected MODULE2_DISCONNECTED
module_3_connected MODULE3_CONNECTED
module_3_disconnected MODULE3_DISCONNECTED
monday RTC_MONDAY
month RTC_MONTH
more_softkeys MORE_SOFTKEYS
move_to MOVE_TO
movefade MOVEFADE
moves_only MOVES_ONLY
msc_acn_rx_ids MSC_ACN_RECEIVE
msc_acn_tx_id MSC_ACN_TRANSMIT
msc_receive MSC_RECEIVE
msc_transmit MSC_TRANSMIT
multi_param MULTI_PARAM
multiconsole_power_off MULTICONSOLE_POWEROFF
multiconsole_power_on MULTICONSOLE_POWERON
native COLOR_FADE_NATIVE
negative NEGATIVE
new_keyword NEW_KEYWORD
new_show NEW_SHOW
next NEXT
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next_blind_display NEXT_BLIND_DISPLAY
next_live_display NEXT_LIVE_DISPLAY
no_priority NO_PRIORITY
notes NOTES
num_groups FAN_NUM_GROUPS
numofchannels NUM_OF_CHANS
odd ODD
off BUMP_OFF
offline OFFLINE
offset OFFSET
offstate OFF_STATE
on BUMP_ON
only_active ONLY_ACTIVE
only_labels ONLY_LABELS
only_levels ONLY_LEVELS
only_show ONLY_SHOWDATA
only_text ONLY_TEXT
onstate ON_STATE
oos_sync OOS_SYNC
open_bp_blind OPEN_BEAM_PALETTE_PREVIEW
open_browser OPENBROWSER
open_chan_effect_display OPEN_CHAN_EFFECT_DISPLAY
open_color_path_blind OPEN_COLOR_PATH_PREVIEW
open_color_picker OPENCOLORPICKER
open_cp_blind OPEN_COLOR_PALETTE_PREVIEW
open_cue_blind OPEN_CUE_LIST_INDEX
open_curve_preview OPEN_CURVE_PREVIEW
open_dmx_patch OPEN_DMX_PATCH
open_effect_blind OPEN_EFFECT_PREVIEW
open_effect_status OPENEFFECTSTATUS
open_fader_config OPENSLIDERCONFIGURATION
open_file OPENFILE
open_fp_blind OPEN_FOCUS_PALETTE_PREVIEW
open_group_blind OPEN_GROUP_PREVIEW
open_ip_blind OPEN_INTENSITY_PALETTE_PREVIEW
open_macro_preview OPEN_MACRO_PREVIEW
open_magic_sheet_blind OPEN_MAGIC_SHEET_PREVIEW
open_mirror_dialog OPEN_MIRROR_DIALOG
open_ml_controls OPEN_ML_CONTROLS
open_park_blind OPEN_PARK_PREVIEW
open_partition_preview OPEN_PARTITION_PREVIEW
open_pattern_effects OPEN_PATTERN_EFFECTS
open_preset_blind OPEN_PRESET_PREVIEW
open_setup OPEN_SETUP
open_sub_blind OPEN_SUBMASTER_PREVIEW
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or OR
ordered_view ORDERED_VIEW
osc OSC_ENABLED
osc_rx_port_number OSC_RX_PORT_NUMBER
osc_tx_ip_address OSC_TX_IP_ADDRESS
osc_tx_port_number OSC_TX_PORT_NUMBER
out OUT
page_column_1 PAGE_COLUMN_1
page_column_2 PAGE_COLUMN_2
page_column_3 PAGE_COLUMN_3
page_column_4 PAGE_COLUMN_4
page_column_5 PAGE_COLUMN_5
page_column_6 PAGE_COLUMN_6
page_column_7 PAGE_COLUMN_7
page_down PAGE_DOWN
page_encoders_down PAGE_ENCODERS_DOWN
page_encoders_up PAGE_ENCODERS_UP
page_mode SCROLL_MODE
page_up PAGE_UP
palettes SFF_PALETTES
paper_size_a2 PAPER_SIZE_A2
paper_size_a3 PAPER_SIZE_A3
paper_size_a4 PAPER_SIZE_A4
paper_size_legal PAPER_SIZE_LEGAL
paper_size_letter PAPER_SIZE_LETTER
paramcategory PARAM_CAT_PRE_v1_9_8
parameter_view PARAM_VIEW
parameters PARAMETERS
park PARK
part PART
partition PARTITION
partitionedcontrol PARTITIONED_CONTROL
patch PATCH
patch_1_to_1 RESET_PATCH
patch_done CIAPATCH_DONE
patch_manu_tab PATCH_MANU_TAB
patch_mode CIAPATCH_PATCH_MODE
patch_show_tab PATCH_SHOW_TAB
patch_user_tab PATCH_USER_TAB
path COLOR_PATH
pattern PATTERN
pdv_point PDV_POINT
pdv_time PDV_TIME
percent_per_rev ENCODER_PERCENT_PER_REVOLUTION
pixel_map_apply_check PIXELMAP_APPLY_CHECK



628 Eos Ti, Gio, Gio @5, Ion Xe, Ion Xe 20, and Element 2 Operations Manual

/eos/key/ Internal Eos Command
pixel_map_column_guides PIXELMAP_COLUMN_GUIDES
pixel_map_delete PIXELMAP_DELETE
pixel_map_direction PIXELMAP_DIRECTION
pixel_map_done PIXELMAP_APPLY
pixel_map_edit PIXELMAP_EDIT
pixel_map_file PIXELMAP_FILE
pixel_map_flash PIXELMAP_FLASH
pixel_map_horizontal_order PIXELMAP_HORIZONTAL_ORDER
pixel_map_last PIXELMAP_LAST
pixel_map_library PIXELMAP_LIBRARY
pixel_map_mask PIXELMAP_MASK
pixel_map_next PIXELMAP_NEXT
pixel_map_overlay PIXELMAP_OVERLAY
pixel_map_overwrite PIXELMAP_OVERWRITE
pixel_map_reorder_files PIXELMAP_REORDER_FILES
pixel_map_reorder_libraries PIXELMAP_REORDER_LIBRARIES
pixel_map_row_guides PIXELMAP_ROW_GUIDES
pixel_map_snapshot PIXELMAP_SNAPSHOT
pixel_map_start_address PIXELMAP_START_ADDRESS
pixel_map_vertical_order PIXELMAP_VERTICAL_ORDER
pixel_maps SFF_PIXELMAPS
pixelmap PIXELMAP
playback_clear_cues PLAYBACK_CLEAR_CUES
playbackassert PLAYBACK_ASSERT
playbackmanual PLAYBACK_MANUAL_OVERRIDE
playbackmove PLAYBACK_MOVE
playbackoff PLAYBACK_OFF
playbackrate PLAYBACK_RATE
playbackrelease PLAYBACK_RELEASE
plus_patch PLUS_PATCH
plus_show ENTIRE_SHOW
popup_virtual_keyboard POPUP_VIRTUAL_KEYBOARD
port_offset PORT_OFFSET
portrait PORTRAIT
positive POSITIVE
post_select_softkeys POST_SELECT_SOFTKEYS
power_off POWEROFF
preheat PREHEAT
preheat_off PREHEAT_OFF
preheat_time PREHEAT_TIME
preserve_blind_cue PRESERVE_BLIND_CUE
preserve_native_on_patch_change PRESERVE_NATIVE_ON_PATCH_CHANGE
preset PRESET
presets SFF_PRESETS
prev_channels RESTORE_CHANNEL_LIST
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previous RESTORE_PREVIOUS
print_color_printout PRINT_COLOR_PRINTOUT
print_feedback_errors PRINT_FEEDBACK_ERRORS
print_file PRINTFILE
print_folder PRINTFOLDER
print_summary_view PRINT_SUMMARY_VIEW
print_tracked_levels PRINT_TRACKED_LEVELS
priority SOURCE_PRIORITY
properties PROPERTIES
proportion PROPORTION
proportional_master PROPORTIONAL_MASTER
psd_time_countdown DISPLAY_FADING_CUE_TIME
query QUERY
quit QUIT
random RANDOM
random_groups RANDOM_GROUPS
random_rate RANDOM_RATE
rate RATE
rate_wheel_move RATE_WHEEL_MOVE
ratewheel RATE_WHEEL
rce_channels EFFECT_CHANNELS
rce_insert EFFECT_INSERT
rce_on_off EFFECT_ON_OFF
recall_from RECALL_FROM
receivechan MSC_RECEIVE_CHAN
record RECORD
record_only RECORD_ONLY
record_rig_check DIMRACK_REC_RIG_CHK
recordconfirm RECORD_CONFIRM
redo REDO
ref_only REFERENCES_ONLY
relay RELAY
relay_output RELAY_OUTPUT
release RELEASE_FADER
rem_dim REM_DIM
remfiltercat REM_FILTER_CAT
remfilterparam REM_FILTER_PARAM
remove_favorite PATCH_REMOVE_FAVORITE
reorder REORDER
repeat FAN_REPEAT
repeat_last_command REPEAT_LAST_COMMAND
repeat_on_go EFFECT_REPEAT
replace REPLACE_ADDRESS
replace_with REPLACE_WITH
request_file REQUESTFILE
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reset_all_tabs RESET_ALL_TABS
reset_columns RESET_COLUMNS
reset_console_settings RESET_DESK_SETTINGS
reset_show_settings RESET_SHOW_SETTINGS
reset_system RESET_SYSTEM
reset_update UPDATE_CLEAR
restart_effect REFIRE_EFFECT
restore RESTORE_MODE
resume RESUME
resyncframes RESYNC_FRAMES
reverse REVERSE
reverse_steps REVERSE_STEPS
rfr RFR_ENABLE
rgb COLOR_FADE_RGB
rotate_90 PIXELMAP_ROTATE_90
rpu_1 RPU_1
rpu_10 RPU_10
rpu_11 RPU_11
rpu_12 RPU_12
rpu_13 RPU_13
rpu_14 RPU_14
rpu_15 RPU_15
rpu_16 RPU_16
rpu_17 RPU_17
rpu_18 RPU_18
rpu_19 RPU_19
rpu_2 RPU_2
rpu_20 RPU_20
rpu_21 RPU_21
rpu_3 RPU_3
rpu_4 RPU_4
rpu_5 RPU_5
rpu_6 RPU_6
rpu_7 RPU_7
rpu_8 RPU_8
rpu_9 RPU_9
rtc RTC
rtc_time RTC_TIME
run_cue RUN_CUE
run_rig_check DIMRACK_RUN_RIG_CHK
rvi_settings RVI_SETTINGS
sacn ACN
sat_adjust COLOR_FADE_SAT
saturday RTC_SATURDAY
save SAVE



Show Control 631

/eos/key/ Internal Eos Command
save_file SAVEFILE
save_folder SAVEFOLDER
save_show SAVE_SHOW
scale SCALE
scroller_frame SCROLLER_FRAME
second_action SECOND_ACTION
security_settings SECURITY_SETTINGS
select SELECT
select_active SELECT_ACTIVE
select_all SELECT_ALL
select_last SELECT_LAST
select_last_params SELECT_LAST_PARAMS
select_live_cue_blind SELECT_LIVE_CUE_BLIND
select_live_cue_live SELECT_LIVE_CUE_LIVE
select_manual SELECT_MANUAL
select_nonsub_active SELECT_NONSUB_ACTIVE
send_midi_raw SEND_MIDI_STRING
send_string SEND_SERIAL_STRING
server_chan MAIN_LAYER_CHAN
set_chan_level SET_CHAN_LEVEL
setup SETUP
shield SHIELDED_SUB
shift SHIFT
show_channels SFF_SHOWCHANNELS
show_control SFF_SHOWCONTROL
show_control_action SC_ACTION
show_park_buffer SHOW_PARK_BUFFER
show_ref_labels SHOW_REF_LABELS
show_reference_labels SHOW_REFERENCE_LABELS
show_settings SHOW_SETTINGS
show_source_data SHOW_SOURCE_DATA
show_stored_data SHOW_STORED_DATA
shutdown_fixture SHUTDOWN_LAMP
shutdown_macro SHUTDOWN_MACRO
shutter SHUTTER_CAT
single_param SINGLE_PARAM
size SIZE
slider_move SLIDER_MOVE
smpte SMPTE
smptetimecode SMPTE_TC
snap CIAPATCH_SNAP
snapshot SNAPSHOT
snapshot_recall SNAPSHOTRECALL
snapshots SFF_SNAPSHOTS
sneak SNEAK
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softkey_1 SOFTKEY1
softkey_2 SOFTKEY2
softkey_3 SOFTKEY3
softkey_4 SOFTKEY4
softkey_5 SOFTKEY5
softkey_6 SOFTKEY6
softkey_7 SOFTKEY7
softkey_8 SOFTKEY8
solo EFFECT_SOLO
solo_mode SOLO_MODE
solo_status SOLO_STATUS
source SOURCE
spacebar_go SPACEBAR_DISABLE
split_cue_time SPLIT_CUE_TIME
spread EFFECT_SPREAD
spreadsheet SPREADSHEET
startup_macro STARTUP_MACRO
status EFFECT_STATUS
step STEP
stepbased STEPBASED_EFFECT
steptime STEP_TIME
stop STOP
stop_1 STOP01
stop_10 STOP10
stop_2 STOP02
stop_3 STOP03
stop_4 STOP04
stop_5 STOP05
stop_6 STOP06
stop_7 STOP07
stop_8 STOP08
stop_9 STOP09
stop_all STOP_ALL_EFFECT
stop_and_fade STOP_AND_FADE
stop_and_hold STOP_AND_HOLD
stop_effect STOP_EFFECT
stop_effect_button STOP_EFFECT_BUTTON
stopback PLAYBACK_STOP_BACK
stopeffect STOP_EFFECT
string SERIAL_STRING
string_and_osc_rx SERIAL_RX_ENABLE
string_and_osc_tx SERIAL_TX_ENABLE
string_midi_tx SERIAL_MIDI_TX
string_rx_group_ids SERIAL_RX_GROUP_IDS
string_rx_port SERIAL_RX_PORT_NUMBER
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string_tx_group_ids SERIAL_TX_GROUP_IDS
string_tx_ip_address SERIAL_TX_IP_ADDRESS
string_tx_port SERIAL_TX_PORT_NUMBER
sub SUBMASTER
subassert SUB_ASSERT
subdown SUB_BUMP_DOWN
subfreeze SUB_FREEZE
submasters SFF_SUBMASTERS
submove SUB_MOVE
suboff SUB_OFF
subrelease SUB_RELEASE
subtype SUB_TYPE
subup SUB_BUMP_UP
sunday RTC_SUNDAY
sw_go_1 SW_GO_1
sw_go_10 SW_GO_10
sw_go_11 SW_GO_11
sw_go_12 SW_GO_12
sw_go_13 SW_GO_13
sw_go_14 SW_GO_14
sw_go_15 SW_GO_15
sw_go_16 SW_GO_16
sw_go_17 SW_GO_17
sw_go_18 SW_GO_18
sw_go_19 SW_GO_19
sw_go_2 SW_GO_2
sw_go_20 SW_GO_20
sw_go_21 SW_GO_21
sw_go_22 SW_GO_22
sw_go_23 SW_GO_23
sw_go_24 SW_GO_24
sw_go_25 SW_GO_25
sw_go_26 SW_GO_26
sw_go_27 SW_GO_27
sw_go_28 SW_GO_28
sw_go_29 SW_GO_29
sw_go_3 SW_GO_3
sw_go_30 SW_GO_30
sw_go_31 SW_GO_31
sw_go_32 SW_GO_32
sw_go_33 SW_GO_33
sw_go_34 SW_GO_34
sw_go_35 SW_GO_35
sw_go_36 SW_GO_36
sw_go_37 SW_GO_37
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sw_go_38 SW_GO_38
sw_go_39 SW_GO_39
sw_go_4 SW_GO_4
sw_go_40 SW_GO_40
sw_go_5 SW_GO_5
sw_go_6 SW_GO_6
sw_go_7 SW_GO_7
sw_go_8 SW_GO_8
sw_go_9 SW_GO_9
sw_stop_1 SW_STOP_1
sw_stop_10 SW_STOP_10
sw_stop_11 SW_STOP_11
sw_stop_12 SW_STOP_12
sw_stop_13 SW_STOP_13
sw_stop_14 SW_STOP_14
sw_stop_15 SW_STOP_15
sw_stop_16 SW_STOP_16
sw_stop_17 SW_STOP_17
sw_stop_18 SW_STOP_18
sw_stop_19 SW_STOP_19
sw_stop_2 SW_STOP_2
sw_stop_20 SW_STOP_20
sw_stop_21 SW_STOP_21
sw_stop_22 SW_STOP_22
sw_stop_23 SW_STOP_23
sw_stop_24 SW_STOP_24
sw_stop_25 SW_STOP_25
sw_stop_26 SW_STOP_26
sw_stop_27 SW_STOP_27
sw_stop_28 SW_STOP_28
sw_stop_29 SW_STOP_29
sw_stop_3 SW_STOP_3
sw_stop_30 SW_STOP_30
sw_stop_31 SW_STOP_31
sw_stop_32 SW_STOP_32
sw_stop_33 SW_STOP_33
sw_stop_34 SW_STOP_34
sw_stop_35 SW_STOP_35
sw_stop_36 SW_STOP_36
sw_stop_37 SW_STOP_37
sw_stop_38 SW_STOP_38
sw_stop_39 SW_STOP_39
sw_stop_4 SW_STOP_4
sw_stop_40 SW_STOP_40
sw_stop_5 SW_STOP_5
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sw_stop_6 SW_STOP_6
sw_stop_7 SW_STOP_7
sw_stop_8 SW_STOP_8
sw_stop_9 SW_STOP_9
swap SWAP
swap_address SWAP_ADDRESS
swap_pan/tilt SWAP_FIXTURE
system_settings SFF_SYSTEMSETTINGS
tab SHEET
tab_down TAB_DOWN
tab_up TAB_UP
tb_pan_swap TB_PAN_SWAP
tb_tilt_swap TB_TILT_SWAP
tb_xy_swap TB_XY_SWAP
test_fixture TEST_LAMP
text1 TEXT1
text10 TEXT10
text2 TEXT2
text3 TEXT3
text4 TEXT4
text5 TEXT5
text6 TEXT6
text7 TEXT7
text8 TEXT8
text9 TEXT9
thru THRU
thursday RTC_THURSDAY
time TIME
time_code CUE_TIME_CODE
time_template TIME_TEMPLATE
timing_disable TIMING_DISABLE
timing_disable_back TIMING_DISABLE_BACK
timing_disable_go TIMING_DISABLE_GO
timing_disable_time TIMING_DISABLE_TIME
timingdisable PLAYBACK_TIMING_DISABLE
toggle_accel ENCODER_TOGGLE_ACCELERATION
toggle_effect_shape_mode_for_encoder EFFECT_ENCODER_SHAPE_MODE_TOGGLE
toggle_effects TOGGLE_EFFECTS
trace TRACE
track TRACK
tracking TRACKING_MODE
trail TRAIL
transmitchan MSC_TRANSMIT_CHAN
trckbll_on/off TRACKBALL_PAN_TILT_TOGGLE
tuesday RTC_TUESDAY
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type TYPE
undo UNDO
undouble DIMMER_UNDOUBLE
unown UNOWN
unpatch UNPATCH
unpatched UNPATCHED_QUERY
up UP_TIME
update UPDATE
update_lin UPDATE_LIB
update_mode UPDATE_MODE
user_id USER_ID
utilization_reports SFF_UTILREPORTS
vform VERT_FORM
view MAGICSHEET_VIEW
view_channels FLEXI_VIEW_CHANNELS
visible_workspaces SNAPSHOT_MONITORS
vplaybackmove VPLAYBACK_MOVE
vsubmove VIRT_SUB_MOVE
wait_for_enter MACRO_PAUSE_FOR_ENTER
wait_for_input MACRO_PAUSE_FOR_INPUT
wednesday RTC_WEDNESDAY
wheel WHEEL
wheel0 WHEEL0
wheel1 WHEEL1
wheel2 WHEEL2
wheel3 WHEEL3
wheel4 WHEEL4
wheel5 WHEEL5
wheel6 WHEEL6
wheel7 WHEEL7
wheel8 WHEEL8
wheel9 WHEEL9
wheelandencoderbutton WHEEL_AND_ENCODER_BUTTON
white_point PATCH_WHITE_POINT
white_point_xyz PATCH_WHITE_POINT_XYZ
width PIXEL_WIDTH
year RTC_YEAR
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Face Panel Shortcuts

Overview
The following is a list of button pushes: single, maintained, or combined. It is highly
recommended that you read and familiarize yourself with this list.

For keyboard shortcuts, see Hotkeys .

Displays
• [Data] (maintained press) - toggles the display to show data living under referenced data.

Keep [Data] depressed to page. [Data] & [Data] locks this display.
• [About] & [Data] - locks the display to the absolute data display.
• [Time] (maintained press) - toggles the display to show discrete timing. Keep [Time]

depressed to page.
• [About] & [Time] - locks the display to discrete time display. Press [About] & [Time]

[Time] to unlock, or temporarily display discrete time.
• [Data] & [Focus] / [Color] / [Beam] - to expand/ suppress categories on displays. (Ion)
• [Data] & {Parameter Tiles} - to suppress/ display individual parameters from the display

when not in summary view. (Ion)
• [Params] & [Focus] / [Color] / [Beam] - to expand/ suppress categories on displays. (Ti/

Eos/ Gio)
• [Params] & {Parameter Tiles} - to suppress/ display individual parameters from the display

when not in summary view. (Ti/ Eos/ Gio)
• [Displays] & [Level Wheel] - controls the Main slider in Brightness Settings.
• [Displays] [Displays] - resets the CIA to the browser.
• [About] & [Path]/{ Color Path} - toggles the display to show the color paths.
• [Shift] & [Select] - reset display columns.
• [Shift] & [Tab] - clear all tabs on the current monitor (but keep locked frames) (Does not

clear tab 1 and 2).
• [Shift] & [Tab] [Tab] - clear all tabs on all monitors (but keep locked frames) (Does not

clear tab 1 and 2).
• [Shift] & [Tab] [Tab] [Tab] - clear all tabs on all monitors (including locked frames) (does

not clear tab 1 and 2).
• [Shift] & [Label] - opens the cue note for the selected cue. Adds a note to a currently

selected cue if one doesn't already exist.
• [About] & [Label] [Label] - double press to lock reference labels on. Press [About] &

[Label] again to unlock.
• [Shift] & [Live/ Blind] - advances the displays to the next instance of Live or Blind.
• [Live] (when already in Live) - resyncs the selected cue to the most recently activated cue.
• [Blind] (when already in Blind) - resyncs the selected cue to the live selected cue (when

blind cue has been changed or when preserve blind cue has been enabled).
• [Flexi] & [Time] - to invoke flexi time view on displays.
• [Format] & [Level Wheel] - zooms the display in focus.
• Left Mouse Button & Scroll - zooms the display in focus on a PC.
• Scroll with two fingers - zooms the display in focus on a Mac.
• [Tab] & [Up/Down Arrow] - cycle workspaces.
• [Tab] & [Left/Right Arrow] - move displays.
• [Tab] & [number] - open or focus specific displays.
• [Flexi] & [.] - turns on Flexi multicells off mode. Press again to turn off.
• [About] & [Live] - displays the DMX values.
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• [About] & [Mark] - displays the mark cue used by the channels.
• [About] & [Next]/[Last] - displays the next cue that the channels move in or the last cue

that the channels moved in.
• [About] & [Park] - displays the parked levels.
• [About] & [Part] - displays the cue part number for each parameter.

Face Panel
• [Shift] & [Escape] - to lock and unlock face panel.
• Encoder Paging Keys & [Number] - pages to the desired encoder control page.
• [Escape] & Encoder Paging Keys - locks the encoders. Press any encoder page button to

unlock.
• [Flexi] & Encoder Paging Key - to invoke flexi encoder states.
• [Fader Controls] & [Bump Button] - select a fader page on wings.
• [Fader Page] & Rate Wheel - rolls the selected fader page. (Ti/Eos/Gio)
• [Fader Page] & [number] - select a fader page on integral faders. (Ti/Eos/Gio)
• [Fader Page] - increments the fader page by 1.(Ti/Eos/Gio)
• [Shift] & [Fader Page] - decrements the fader page by 1. (Ti/Eos/Gio)
• [Learn] & [Load] - opens the selected fader's configuration tools.
• [Off] & [Load] - releases control of content, restoring to background and leave cue list

with pending cue in tact.
• [Release] & [Load] - releases control of content, restoring to background, and resets cue

list to top.
• [Shift] & [Go] or [Shift] & [Back] - cuts the pending cue or the previous cue.
• [Shift] & [Load] - to remove content from a fader.
• [Shift] & [Stage] - toggles Scroll Lock on and off.

Operations
• [At] [Enter] - removes move information from selected channel/parameters.
• [At] [At] - set to Level (as defined in Setup).
• [Color] (Encoder Paging Key) & Encoder Movement - hold Color Point while adjusting

parameters.
• [Copy To] [Copy to] - posts Move To on the command line.
• [Full] [Full] - sets selected channels intensity to “full” and self terminates.
• [Label] [Label] - appended to a record target command, clears the current label, this

includes show file labels.
• [Recall From] [Recall From] - posts Recall From Cue to the command line.
• [Record] [Record] - posts Record Only to the command line.
• [Select Active] [Select Active] - Select Active minus submaster contributions.
• [Shift] & [Select Active] - posts Select Non-Sub Active.
• [Shift] & [Enter] - repeats last command line, unterminated; does a loop of last five

commands.
• [Shift] & [At] - recalls last channel(s) and parameters without terminating; does a loop of

last five commands.
• [Shift] & [Enter] - reselects the last command and leaves it unterminated; does a loop of

last five commands.
• [Shift] & [Block] - posts Intensity Block to the command line.
• [Shift] & [Clear] - clears the command line.
• [Shift] & [Delay] - posts follow.
• [Shift] & Encoder Paging Key - posts the category to the command line. For beam

subcategories, press Image, Form or Shutter twice to post Beam. (Ion/Gio)
• [Shift] & Encoder Movement - accesses fine mode.
• [Shift] & Encoder Push/ Toggle - posts the parameter to the command line. (Ion)
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• [Shift] & Gel Tile - cycles through three modes of Brightness.
• [Shift] & [Full] or [Shift] & [Out] - flash on or flash out.
• [Shift] & [+] or [Shift] & [-] - +% or -%.
• [Shift] & [Highlight] - appends highlight to the current channel selection.
• [Shift] & [Select Last] - posts additional channel selection options to the softkeys.
• [Shift] & [Sneak] - makes manual data unmanual.
• [Shift] & [Update] - shortcut to Save.
• [Shift] & restore manual faders - reset faders to zero without asserting control.
• [Shift] & {Direct Select} - posts DS to the command line without terminating.
• [Shift] & [Next] or [Shift] & [Last] - advances the cue without changing channel selection.
• [Sneak] [Sneak] - releases NPs of selected channels and self terminates.
• [Timing Disable] & [Go] or & [Back] - cuts the next cue or cuts the last cue.
• [Thru] [Thru] - [Thru] command accesses only channels displayed in the current flexi-state

(unless the range specified is NOT in the current display). [Thru] [Thru] selects the range
regardless of the flexi mode.

• [Trace] [Trace] - forces a previously inactive light to track its new intensity setting
backwards.

• [Undo] - clears an unterminated command line. Otherwise opens undo controls.
• [Update] & [Sub Bump] - to update a specific submaster.
• [n] [At] [/] [/] [m] [Enter] - sets direct DMX value (m) for channel (n).
• [Shift] & [Delay] [Delay] - posts hang to the command line.
• [Shift] & [About] - opens a command line search window.
• [Shift] & [.] - posts minus cells to the command line. This is for use with multicell fixtures.
• [.] - posts cells or cells only to the command line when used after channel number(s). This

is for use with multicell fixtures.
• [Shift] & [Int Palette] - posts preset on the command line (Element & Element 2).
• [Displays] & [Record] - puts a marker in the log file.
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Hotkeys

To enable Eos functions on macOS Function keys:

• Open System Preferences
• Go into the Keyboard section
• Enable the “Use all F1, F2,etc... keys as standard function keys” setting.

Note: Some international keyboards require “Use Shift Key As Eos Shift” to be
disabled in Setup > Device > Face Panel > Input Devices. Use Z as shift to access
shortcut functions in these cases.

Console Function PC Keyboard Shortcut
Shortcut List Alt /

?
0 0
1 1
2 2
3 3

4 4

5 5

6 6

7 7

8 8

9 9

. (decimal) . (decimal)

- (minus) - (minus)

+ (plus) =

+

+% Shift =

Control Alt =
-% Shift -

Control Alt -

/ /

A3D Camera Up Up Arrow
A3D Camera Up (Edit Mode) W
A3D Camera Forwards Shift Up Arrow
A3D Camera Forwards (Edit Mode) Shift W
A3D Camera Left Left Arrow
A3D Camera Left (Edit Mode) A
A3D Camera Down Down Arrow
A3D Camera Down (Edit Mode) S
A3D Camera Backwards Shift Down Arrow
A3D Camera Backwards (Edit Mode) Shift S
A3D Camera Right Right Arrow
A3D Camera Right (Edit Mode) D
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About Y

Address / Dimmer Alt A

All NPs Control N

Assert Control W

Assert (Playback) Control Alt A

At A

@

*

Back (ECU) Escape
Beam Filter Control B

Beam Palette Alt B

Blind F2

Control 2

Block B

Capture Control Alt P

Clear Backspace

Clear Command Line Shift Backspace

Control Alt Backspace

Clear Label Control Backspace

Color Filter Control C

Color Palette Alt C

Color Path Control Alt W

Copy To C

Cue Q

Cue Only / Track X

Data Control D

Data Mode Control Shift D

Delay D

Delete Delete

Delete (macOS) Fn Delete

Displays F9

Control 9

Effect Alt E

Effects Softkeys Alt Shift E

Encoder Display (Gio) Control Alt \

Encoder Page Color ^ Control Alt [

Encode Pager Focus ^ Control Alt ,

Encoder Page Form ^ Control Alt ;

Encoder Page Image ^ Control Alt ]

Encoder Page Intensity ^ Alt .

Encoder Page Shutter ^ Alt ,

Enter Enter

Escape Escape

Expand F5

Control 5
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Fader Page V

Fan W

FlexiChannel F3

Control 3

Focus Filter Control F

Focus Palette Alt F

Follow / Hang Shift D

Control Alt D

Format F4

Control 4

(Scroller) Frame Control Alt C

Freeze Control Alt F

Full F
Go Spacebar

Go To Cue Control G

Go To Cue Zero Control Alt G

Group G

Help Alt /

Highlight \

Control Alt H

Home Home

Control H

Home (macOS) Fn Left Arrow

Intensity Block Shift B

Control Alt B

Intensity Filter Control I

Intensity Palette Alt I

Label / Note L

Last Page Up

Control ,

Last (macOS) Fn Up Arrow

Learn Alt L

Level Control V

Live F1

Control 1

Load Control Alt L

Macro M

Macro 801* Control Alt 1

Macro 802* Control Alt 2

Macro 803* Control Alt 3

Macro 804* Control Alt 4

Macro 805* Control Alt 5

Macro 806* Control Alt 6

Macro 807* Control Alt 7

Macro 808* Control Alt 8
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Macro 809* Control Alt 9

Macro 810* Control Alt 0

Magic Sheet Alt M

Manual Override Control Alt M

Control Alt N

Mark K

Control Alt K

Mirror Start Alt F1

Mirror Stop Alt F2

ML Controls F7

Control 7

More Softkeys (More SK) Alt 7

Next Page Down

Control .

Next (macOS) Fn Down Arrow

Off Control Alt O
Offset Control O

Out O

Page Left Left Arrow

Page Right Right Arrow

Page Up Up Arrow

Page Down Down Arrow

Parameters (Display) Control D

Park Alt K

Part P

Patch ;

Pixel Map Alt X

Preset Alt P

Query Control Q

Rate Control Alt R

Recall From E

Record R

RecordOnly Control R

Release Control Alt S

Rem Dim H

Scroll Lock Control 6

Select Control Enter

Select (ECU) Return

Select Active Control A

Select Last Control L

Select Manual Control M

Setup Alt S

Shift Z

Snapshot Control S
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Sneak N

Softkey 1 Alt 1

Softkey 2 Alt 2

Softkey 3 Alt 3

Softkey 4 Alt 4

Softkey 5 Alt 5

Softkey 6 Alt 6

Spacebar Disable Alt G

Staging Mode F6
Stop / Back Control Spacebar

Control Alt Q

Stop Effect Control Alt E
Submaster S

Tab Tab

Time I

Time (Displays) Control Alt I

Timing Disable Control Alt T

Toggle Hotkeys F8

Control 8

Trace J

Thru T

Undo Control X

Update U

Virtual Keyboard Control K

Workspace ] or [

*Some Shortcut Key combinations are not available on all physical keyboard layouts.

^Alternatively use Encoder Display + category to change the encoder pages.
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